Madrid Analytics, Intelligence, and Reporting

Last updated: January 22, 2020
Some examples and graphics depicted herein are provided for illustration only. No real association or connection to ServiceNow products or services is intended or should be inferred.

If you have comments about this documentation, submit your feedback to: docfeedback@servicenow.com
# Table of Contents

## Analytics, Intelligence, and Reporting

- Performance Analytics ................................................................. 4
  - Get started with Performance Analytics ............................................ 4
  - Performance Analytics Admin Console ............................................... 5
  - Dependency Assessment ..................................................................... 35
  - Visualize Performance Analytics data .................................................. 38
  - Performance Analytics data architecture .............................................. 50
  - Integrate Performance Analytics ......................................................... 50
  - Performance Analytics diagnostics ....................................................... 344
  - Performance Analytics for mobile devices ........................................... 374
  - Ranking records with Spotlight .......................................................... 375
  - Interactive Analysis ........................................................................... 403

## Reporting

- Getting started with reports .............................................................. 407
  - Distribute reports .............................................................................. 418
  - Creating reports ................................................................................ 430
  - Differences between Report Builder and Report Designer .................. 678
  - Advanced reporting .......................................................................... 682
  - Administering reports ....................................................................... 716
  - Interactive Analysis ........................................................................... 757
  - Interactive Filters ............................................................................ 770

## Dashboards

- Create and use dashboards ................................................................. 795
  - Administering dashboards ................................................................. 838
  - Performance Analytics Solution Library ............................................. 861

## Agent Intelligence

- Get started with Agent Intelligence .................................................... 865
  - Create and train a classification solution ............................................. 871
  - Create and train a similarity solution ................................................... 877
  - View solution training progress .......................................................... 883
  - Activate solution version ................................................................. 887
  - Export trained solutions to production ............................................... 890
  - Review classification prediction results over time .................................... 891
  - Test a classification solution prediction ............................................... 891
  - Preserve ML solutions during a system clone ....................................... 894
  - Domain separation and Agent Intelligence ......................................... 895
  - Configuration tips for Agent Intelligence ............................................. 895

## Virtual Agent

- Implementing Virtual Agent ............................................................... 898
  - Transferring Virtual Agent conversations to a live agent ..................... 902
  - Virtual Agent Designer ..................................................................... 939
  - Virtual Agent conversation states ....................................................... 946
  - Virtual Agent scripts ......................................................................... 1015
  - Virtual Agent localization ................................................................. 1016
  - Out-of-the-box Performance Analytics Solutions for Virtual Agent .......... 1019

## Index

- Out-of-the-box Performance Analytics Solutions for Virtual Agent ............. 1021
- Index .................................................................................................. 1026
Analytics, Intelligence, and Reporting

Analytics, Intelligence, and Reporting includes ServiceNow® Performance Analytics and Reporting, Predictive Intelligence, and Virtual Agent.

Use Performance Analytics with reports and dashboards to visualize data from your instance so that you can anticipate trends, prioritize resources, and guide continual service improvement.

Use Predictive Intelligence to automatically categorize tasks, increase agent productivity, and decrease resolution times and errors. Virtual Agent allows you to lower costs by automating routine interactions between your customers and agents.

Tip: Bookmark the following links to the Analytics, Intelligence, and Reporting landing pages so you can quickly navigate to all needed resources for these applications.

Performance Analytics

ServiceNow® Performance Analytics is an in-platform Analytics application for ServiceNow customers that need to create management dashboards, report on KPIs and metrics, and answer key business questions to help increase quality and reduce the costs of Service Delivery.

Explore
- Get Started with Performance Analytics (Customer Success Center)
- Performance Analytics and Reporting release notes
- Upgrade to Madrid
- Watch Performance Analytics videos
- Domain separation and Performance Analytics

Data Architecture
- Indicators
- Breakdowns
- Data collection and cleanup

Visualizing Data
- Analytics Hub
- Performance Analytics widgets
- Create and use dashboards

Use
- Try out Complimentary Performance Analytics for Incident Management
- Get licensed Performance Analytics
- Out-of-the-box Performance Analytics Solutions

Develop
- Performance Analytics API
- Developer training
  - Performance Analytics Objectives
- Developer documentation

Troubleshoot and get help
- Ask questions and share your expertise
- Search the HI Knowledge Base
- Contact ServiceNow Technical Support
- Performance Analytics Training
  - Performance Analytics Essentials
  - Performance Analytics Fundamentals
  - Performance Analytics Advanced

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Get started with Performance Analytics

Review the Performance Analytics use cases, components, and architecture. Try out the Complimentary version. Activate the features and content to which you are entitled and begin to implement the product.

The single system of record approach within the ServiceNow platform enables you to measure and drive performance faster and easier within and across all service request management processes. Provide time-based perspectives of relevant data and focus on trend anomalies to prompt action.

**Important:** Set up and test Performance Analytics on a sub-production instance before you set it up on a production instance. You do not need a Performance Analytics subscription on a sub-production instance.

With Performance Analytics, companies can:

- **Drive performance**
  Provide actionable insight on each level and for every role using key indicators, the mobile-enabled Analytics Hub, time charts, analytics, drill-downs, and dashboards.

- **Establish a single version of truth**
  Share clear, up-to-date visualizations of performance across teams and organizations, establishing a single version of truth as the basis for objectively discussing service delivery and driving behavioral change.

- **Realize fast time-to-value**
  Implement business intelligence within the base ServiceNow system within days, instead of months, and make better use of the time and money that currently go into labor-intensive manual reporting.

Benefits of using Performance Analytics include:

- Aligning the organization with company goals.
- Decreasing time required to create strategic or operational changes by communicating the changes through a new set of goals.
- Increasing overall quality of services.
- Lowering cost of services.
- Improving availability of services.

Watch this five-minute video to familiarize yourself with ServiceNow Performance Analytics concepts.

This 30-minute podcast episode discusses Performance Analytics indicators, the role of time in Performance Analytics, troubleshooting, and using Performance Analytics breakdowns in dashboards.

**Performance Analytics concepts**

Performance Analytics uses terms and concepts that can differ from industry norms due to the unique nature of the ServiceNow platform.

**Note:** Performance Analytics is used by other applications, such as Benchmarks. The information below describes the core Performance Analytics functionality. For information...
Performance Analytics includes the following concepts and components:

Key components

Indicators

define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time. Businesses track these scores to measure current conditions and to forecast trends.

Key characteristics of indicators include:

- Indicator scores can be generated automatically from a set of records defined in an indicator source, entered manually, or calculated from other indicators.
- Indicator scores can be viewed or analyzed in the Analytics Hub or presented, via widgets, on dashboards.

For convenience, you can organize indicators thematically into an indicator group.

Synonyms: Metrics, business metrics, KPIs

Indicator sources

define filtered sets of records to evaluate when collecting indicator scores. An indicator source configuration specifies a table, such as Incident (incident), and it specifies the frequency with which to collect data from that table. An indicator source cannot specify a rotated table. Multiple indicators can use the same indicator source.

Typically, an indicator tracks the situation on a certain date. The indicator source conditions usually include a date-related filter, such as (Opened)(on)(Today). Indicators collected less frequently might specify a larger date range, such as (Closed)(on)(This month).

Breakdowns and elements

enable you to group or filter indicator scores for more detailed analysis, such as to show separate scores for each assignment group. You can apply a breakdown on the Analytics Hub and on dashboards.

For example, you can look at the Number of Open Changes by Assignment Group. Or you can see the Number of New Changes by Priority.

The values for each breakdown are called breakdown elements. For example, the Priority breakdown may have the elements Critical, High, and Low. Breakdowns are categorized as automated, manual, or external, depending on where these elements come from. Automated breakdown elements are specified in breakdown sources. Manual breakdowns have their elements entered manually to define an organization. Lastly, an external breakdown specifies the JDBC data source and SQL statement for retrieving breakdown elements.

Synonyms: dimensions, drill-downs

Breakdown sources

specify which unique values, called breakdown elements, a breakdown contains. A breakdown source is defined as a set of records from a table or database view or as a bucket group. Multiple breakdowns can use the same breakdown source. For example, instead of seeing ALL assignment groups for the Number of Open Changes indicator, you can limit the element list to just those groups that are part of the change process by configuring the Breakdown Source.
Breakdown mappings

specify the relationships, or ‘map,’ breakdowns to indicator sources. A breakdown mapping either specifies a field on the indicator source or specifies a script that queries the indicator source. The latter is sometimes called a scripted breakdown mapping, and a breakdown with such a mapping is called a scripted breakdown.

Data collector

is the engine that collects the process and service performance data that are presented through indicators and breakdowns. You can set up data collector jobs to run automatically according to a schedule. Usually set a job schedule to match the frequency in the indicator source. You can also set up jobs that run manually, such as historical jobs, which you run only when collecting data for a new indicator.

Visualizations

Analytics Hub

is the central interface where you assess, compare, and predict the performance of an indicator over time. Set on the indicator record whether that indicator is to be included in the Analytics Hub.

The Analytics Hub was previously named the Scorecard.

Dashboards

are single-screen displays of multiple Performance Analytics, reporting, and other widgets. Dashboards can be responsive or non-responsive. To create or share a responsive dashboard, you need at least one role, but this can be any role. You can drag to move and resize widgets on responsive dashboards. Non-responsive dashboards use less flexible drop zone layouts, and require Performance Analytics roles to view, create, and edit.

Time series

can refer to either of the following items:

- A type of widget that aggregates and shows multiple scores of an indicator collected over a period.
- A statistical function applied to collected indicator scores over a time period in the Analytics Hub or in a widget, also called an aggregator.

Targets

are goals your organization wants to achieve, operationalized as indicator scores. Targets enable you to visualize the difference between the desired score at a certain date and the actual score of an indicator.

A target can be personal or global. A personal target is visible only to the user that created it and appears as a light line. A global target is visible to all users and appears as a dark line. Personal targets appear only on Analytics Hubs, whereas global targets appear on Analytics Hubs and time series widgets.

Thresholds

define a normal range of scores for an indicator and alert you when certain events occurs, such as when a score reaches an all-time high or low.

When a threshold is triggered, the instance generates an email notification. This message is associated with the indicator and the message is directly available via the Analytics Hub.
A threshold can be personal or global. A personal threshold is visible only to the user that created it and appears as a light gray dotted line. A global threshold is visible to all users and appears as a dark gray dotted line. Personal thresholds appear only on Analytics Hubs, while global thresholds appear on both Analytics Hubs and time series widgets.

**Widgets**

are reusable graphic visualizations for use on dashboards. In Performance Analytics, widgets show the scores of one or more indicators. For example, a widget can display the evolution of an indicator over time, how an indicator can be broken down, or how several indicators look side by side. Many variations are possible. Widgets are visible only when added to a dashboard.

**Other concepts**

**Aggregate/Aggregation**

can refer to either of the following functions:

- The Performance Analytics function of aggregating, or collecting, indicator scores over time. The indicator configuration includes the frequency with which indicator scores are collected.
- Statistical functions applied to collected indicator scores over a time period. For example, you can apply a 3-month SUM to indicator scores. Aggregation functions can be added either in the indicator form or later in the Analytics Hub or widget. Aggregation functions in the Analytics Hub or widget are named *time series*.

**Bucket groups**

are used to recategorize data so it can be used as a breakdown, for example by grouping a range of values into discrete buckets.

To work with a bucket group, create a breakdown source that uses Bucket (pa_buckets) as the facts table and specifies the bucket group in a condition. If a breakdown built on this source uses a breakdown mapping with a script, the breakdown groups the values that the script returns into buckets. If the breakdown mapping specifies a field instead of using a script, the breakdown groups the values of the mapped field into buckets.

In the data architecture, bucket groups are defined in Bucket Group (pa_bucket_groups) records and buckets in Bucket (pa_buckets) records. Each Bucket (pa_buckets) record contains a Bucket Group field that is a reference to a Bucket Group (pa_bucket_groups) record.

**Day**

A day in Performance Analytics is always defined as 24 hours. Performance Analytics does not use the concept of ‘business days.’

**Scripted breakdown**

is a breakdown that uses a script to query the *indicator source* as its *breakdown mapping*.

**Snapshots**

are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with *Collect records* selected.

The snapshot/list of records can be retrieved in the Analytics Hub. Snapshots are kept for the main indicator and for first level breakdowns. Second level breakdown snapshots are derived as an intersection of the two first level breakdown snapshot lists.
Try out Complimentary Performance Analytics for Incident Management

Complimentary Performance Analytics for Incident Management is a limited version of Performance Analytics that is included in the base system, enabling you to become familiar with the functionality. License Performance Analytics for complete functionality.

Note: As an alternative to using Complimentary Performance Analytics for Incident Management, you can activate a plugin with the full features of Performance Analytics without a subscription on a non-production instance.

Complimentary Performance Analytics for Incident Management has the following features and limitations:

- Comes with an Incident Management dashboard and predefined indicators
- Indicators cannot be added or deleted
- A maximum of 180 days of historic scores are visualized
- Is usable only in the global domain

To try out Complimentary Performance Analytics for Incident Management, navigate to Performance Analytics > Guided Setup and launch the Incident Management guided setup. This setup takes you on a tour of indicators, breakdowns, their sources, data collection, and viewing results.

You can also try out the Spotlight feature with Complimentary Performance Analytics for Incident Management. Spotlight helps prioritize work by evaluating records against multiple weighted criteria. Without a license you can only use Spotlight with incident records and you cannot access the Spotlight interactive analysis. To try out Spotlight, activate the Performance Analytics - Spotlight - Incident Spotlight plugin and follow the guided setup at Spotlight > Guided Setup. The admin role is necessary to activate the plugin.

The free two-hour course Performance Analytics Essentials provides an introduction to PA components and concepts you can use with Complimentary Performance Analytics for Incident Management. (Registration required.)

Get licensed Performance Analytics

For unlimited access to all Performance Analytics features, purchase a subscription to the licensed Performance Analytics. After you purchase the subscription, activate the plugin associated with that subscription within the production instance.

All ServiceNow instances are provisioned with a complimentary version of Performance Analytics that has configuration limitations. If you attempt to use functionality that is outside those limits, you get a warning that a license is required.
Cannot create record

New Performance Analytics configuration records cannot be created with the complimentary version of Performance Analytics. To create this record, your business must license Performance Analytics. Contact your sales representative for more information.

Note: A subscription is necessary only on the production instance. You can activate a licensed Performance Analytics plugin on a development or test instance without purchasing a subscription.

The licensed Performance Analytics enables the following functionality beyond what is available on the complimentary version:

- Creating new Performance Analytics indicators, breakdowns, widgets, or other configuration records
- Ability to use out-of-the-box solutions besides Incident Management and Spotlight - Incident Management
- Preserving scores for longer than 180 days
- Creating in-form analytics
- Creating interactive filters and using interactive analysis
- Creating reports using a Microsoft Excel data source as part of the Report Designer report creation workflow
- Creating text analytics widgets
- Using Performance Analytics with external data

A complete guide to getting started with the licensed version of Performance Analytics is available at [Getting Started with Performance Analytics](#) in the ServiceNow Community pages. This guide includes the procedure for activating the licensed version of Performance Analytics and setting it up afterwards. The Customer Success Center also guides you through beginning to use Performance Analytics. The document you are currently reading contains only basic instructions for activating the relevant plugin.

Subscriptions and corresponding plugins

When you purchase a subscription to a Performance Analytics product line, you are entitled to activate the corresponding plugin.

After purchasing a subscription, you receive an email from welcometopa@servicenow.com with the name of the product line. As an administrator, you can also view the subscriptions on your production instance by navigating to Subscription Management > Subscriptions.

Important: Set up and test Performance Analytics on a sub-production instance before you set it up on a production instance. You do not need a Performance Analytics subscription on a sub-production instance.
Product lines and corresponding plugin names

<table>
<thead>
<tr>
<th>You have purchased:</th>
<th>Plugin name for activation</th>
<th>Plugin ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics for Now Platform Custom Application</td>
<td>Performance Analytics - Premium</td>
<td>com.snc.pa.premium</td>
</tr>
<tr>
<td>Performance Analytics for APM</td>
<td>Performance Analytics for APM</td>
<td>com.snc.pa.premium.apm</td>
</tr>
<tr>
<td>Performance Analytics for CSM</td>
<td>Performance Analytics Premium for Customer Service</td>
<td>com.snc.pa.premium.cs</td>
</tr>
<tr>
<td>Performance Analytics for HR</td>
<td>Performance Analytics Premium for Human Resource Management</td>
<td>com.snc.pa.premium.hr</td>
</tr>
<tr>
<td>Performance Analytics for ITBM</td>
<td>Performance Analytics Premium for Business Management</td>
<td>com.snc.pa.premium.itbm</td>
</tr>
<tr>
<td>Performance Analytics for ITOM</td>
<td>Performance Analytics Premium for IT Operations Management</td>
<td>com.snc.pa.premium.itom</td>
</tr>
<tr>
<td>Performance Analytics for IT Operations Suite</td>
<td>Performance Analytics Premium for IT Operations Suite</td>
<td>com.snc.pa.premium.itos</td>
</tr>
<tr>
<td>Performance Analytics for Project Portfolio Management</td>
<td>Performance Analytics Premium for Project Portfolio Management</td>
<td>com.snc.pa.premium.ppm</td>
</tr>
<tr>
<td>Performance Analytics for Security Incident Response</td>
<td>Performance Analytics Premium for Security Incident Response</td>
<td>com.snc.pa.premium.sir</td>
</tr>
<tr>
<td>Performance Analytics for Service Management</td>
<td>Performance Analytics Premium for Service Management</td>
<td>com.snc.pa.premium.service_management</td>
</tr>
<tr>
<td>Performance Analytics for Service Strategy</td>
<td>Performance Analytics Premium for Business Management</td>
<td>com.snc.pa.premium.itbm</td>
</tr>
<tr>
<td>Performance Analytics for Software Asset Management</td>
<td>Performance Analytics Premium for Software Asset Management</td>
<td>com.snc.pa.premium.sam</td>
</tr>
</tbody>
</table>

Activate the plugin for licensed Performance Analytics

When you have purchased a Performance Analytics license and identified the associated plugin, activate that plugin as follows.

**Important:** Set up and test Performance Analytics on a sub-production instance before you set it up on a production instance. You do not need a Performance Analytics subscription on a sub-production instance.

Role required: admin

1. Navigate to **System Definitions > Plugins**.
2. Search for plugins with **performance analytics premium** in the name.
3. Find the Performance Analytics premium plugin that matches your entitlement and click **Install**.
   The Activate Plugin dialog opens.
4. In the Activate Plugin dialog, click **Activate**.

A progress bar shows you the progress of the plugin activation, after which you have several options of what to view.
When the process is complete, consider installing out-of-the-box solutions, which include preconfigured dashboards and all necessary underlying components. For more information, see Out-of-the-box Performance Analytics Solutions.

Also consider activating Spotlight. Spotlight helps prioritize records by evaluating them against multiple weighted criteria. For more information, see Ranking records with Spotlight.

Out-of-the-box Performance Analytics Solutions

Out-of-the-box Performance Analytics Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

**Note:** Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. You must have Performance Analytics to collect scores for indicators.

Out-of-the-box solutions contain pre-configured dashboards that track and analyze key processes and metrics.

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

**Important:** Set up and test Out-of-the-box Performance Analytics Solutions on a sub-production instance before enabling them in production. You can set up and test Performance Analytics on a sub-production instance without a subscription.

**Note:**
- Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
- Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. Customize these records for use in your production environment.

Required Performance Analytics entitlement

To enable an Out-of-the-box Performance Analytics Solution, you must be entitled to use Performance Analytics with the relevant ServiceNow® product. For example, to enable the Out-of-the-box Customer Service Management - Advanced Performance Analytics Solution, you must be entitled to use Performance Analytics for Customer Service Management.

Domain separation and 'Run As' user

By default, System Administrator is the Run As user for data collection jobs in the OOTB Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the data that is collected. If domain separation is enabled, ensure that you set an appropriate Run As user in each domain.
Available Performance Analytics Solutions

Performance Analytics Solutions with preconfigured dashboards, indicators, and other configuration records are available for multiple applications.

Individual solutions

Solutions are available for the following applications. The ID for each plugin is listed in parentheses.

- **Advanced Work Assignment (com.snc.pa.awa)**
- **Application Portfolio Management (com.snc.pa.apm)**
- **Application Portfolio Management and Change Management (com.snc.pa.apm.change_request)**
- **Application Portfolio Management and Problem Management (com.snc.pa.apm.problem)**
- **Change Management (com.snc.pa.change)**
- **Communities (com.snc.pa.communities)**
- **Configuration Management (CMDB) (com.snc.pa.cmdb)**
- **Content Analytics (com.snc.pa.premium.content_analytics)**
- **Content Automation (com.snc.pa.premium.content_automation)**
- **Customer Service (com.snc.pa.customer_service)** - Includes a Spotlight Group and reports. Activation also activates the Spotlight plugin. See [Activate Out-of-the-box Spotlight solutions](#).
- **Customer Service Management - Advanced (com.snc.pa.customer_service_advanced)** has the contents of the older OOTB Customer Service Performance Analytics Solution, and also supports the following features:
  - Major Issue Management
  - Customer Service Case Action Status
  - Customer Service with Request Management
  - Customer Service with Service Management
  - Agent Chat
  - Advanced Work Assignment for CSM
  - Performance Analytics - Content Pack - Advanced Work Assignment
- **Discovery (com.snc.pa.discovery)**
- **Event Management (com.snc.pa.em)**
- **Field Service Management (com.snc.work_management_pa)**
- **Financial Management (com.snc.pa.fm)**
- **Financial Management for Customer Service (com.snc.pa.fm.csm)**
- **Financial Management for Field Service Management (com.snc.pa.fm.fsm)**
- **Financial Management for Financial Planning (com.snc.pa.financial_planning)**
- **GRC: Audit Management**
- **GRC: Policy and Compliance Management**
- **GRC: Risk Management**
- **Human Resources Scoped App (com.sn_hr_pa)**

**Note:** The solution for the unscoped version of Human Resources, com.snc.pa.hr_core, is deprecated. If you are using the unscoped version of Human Resources and want to activate its solution plugin, contact customer support.

- **Human Resources Lifecycles Events Scoped App (com.sn_hr_lifecycle_pa)**
- **Incident Management (com.snc.pa)**
Note: Incident management content is available by default with Performance Analytics in a limited version.

- Incident SLA (com.snc.pa.sla)
- ITSM Dashboards (com.snc.pa.itsm_dashboards)
- Knowledge Management (com.snc.pa.knowledge_v2): New version in London onward
- Major Incident Management (com.snc.pa.incident.mim)
- Problem Management (com.snc.pa.problem)
- Project Portfolio Suite (com.snc.pa.ppm)
- Project Portfolio Suite Dashboards (com.snc.pps_dashboards) (also activates Project Portfolio Suite)
- Request Management (Requested Item) (com.snc.pa.request)
- Request Management (Requests) (com.snc.pa.request2)
- Service Desk Chat (com.snc.pa.chat)

Out-of-the-box Performance Analytics Solutions for Service Level Management
- Virtual Agent (com.glide.cs.pa)
- Vulnerability Response (com.snc.vulnerability.analytics - in Store)

Note: For Performance Analytics Spotlight solutions, see Out-of-the-box Spotlight solutions.

ITSM Dashboard solutions

The ITSM Dashboards plugin (com.snc.pa.itsm_dashboards) activates the following solutions, along with a set of additional dashboards:

- Change Management (con.snc.pa.change)
- Problem Management (com.snc.pa.problem)
- Request Management (Requested Item) (com.snc.pa.request)
- Knowledge Management (com.snc.pa.knowledge)
- Incident SLA (com.snc.pa.sla)
- Incident Management (com.snc.pa)

Note: Incident management content is available by default with Performance Analytics in a limited version.

Activate a solution using guided setup

Activate and set up a Performance Analytics solution quickly and consistently using the guided setup for that solution.

Role required: admin

The guided setup for a Performance Analytics solution provides a sequence of tasks that help you activate the solution and configure the records for that solution. After you complete guided setup, collect data, then view indicator scores on the Analytics Hub and on the preconfigured Solution dashboards.
Important: Set up and test Out-of-the-box Performance Analytics Solutions on a sub-production instance before enabling them in production. You can set up and test Performance Analytics on a sub-production instance without a subscription.

Note: If a guided setup is not available for a Solution, you can install that Solution from the Plugins list. If the Solution is not on the Plugins list, look for it on the ServiceNow Store.

1. Navigate to Performance Analytics > Guided Setup.
2. Click Get Started.
3. Scroll to the application you want to set up a solution for, such as Incident or Customer Service.
4. If the plugin is not yet active, guided setup is locked until you activate the solution plugin.

Note: A user must have the admin role to complete these steps.

   a) Click View plugins.
   b) Click the Activate/Upgrade related link.
   c) Click Activate.
      Activating a Performance Analytics solution plugin also activates any plugins for the associated application if they are not already active. For example, activating the Performance Analytics - Content Pack - Customer Service plugin also activates the Customer Service plugin, if it is not already active.
   d) After the plugin is activated, close the plugin window to return to guided setup.

5. Click Get Started for the application you are setting up.
6. Follow the guided setup instructions to review the provided records such as indicators, breakdowns, widgets, and dashboards and to begin collecting Performance Analytics scores. As you perform each step, additional information appears in the right-side Help menu.

Configure Out-of-the-box Performance Analytics Solutions

Out-of-the-box Performance Analytics Solutions come configured with the expectation that you keep your Now Platform data in a standard set of tables and fields. If you are using different fields, configure the Solutions to point to the correct locations.

Run diagnostics

After you install any Out-of-the-box Performance Analytics Solutions, run all diagnostics on all records, as described in Run a diagnostic for all applicable records. These diagnostics can catch many mismatches between the configuration of your Out-of-the-box Performance Analytics Solutions and your tables.

Domain separation and ‘Run As’ user

By default, System Administrator is the Run As user for data collection jobs in the Out-of-the-box Performance Analytics Solutions. Verify that this user exists on the instance, and whether this user has the appropriate level of access. An inappropriate Run As user can cause errors or limit the
data that is collected. If you have Domain Separation enabled, ensure you set an appropriate Run As user in each domain.

Review the indicator sources

Determine which fields contain the data you are looking for in each application you are enabling for Performance Analytics.

You have enabled Performance Analytics according to your entitlement. You have also installed the relevant Out-of-the-box Performance Analytics Solutions, and run diagnostics.

Role required: pa_admin, admin

Most transactional applications, such as Incident, HR, or Customer Service Management, involve three indicator sources of interest. These three indicator sources segment the data into smaller data sets that the indicators can process:

**<Application>.New**

This indicator source determines which records for that process were created on a specific day. This indicator source should be pointed to the time stamp field on the record that defines its creation day. In Out-of-the-box Performance Analytics Solutions, the indicator source looks at the Opened field for Incident Management and Change Management. For Problem Management, the indicator source looks at the Created field. Verify whether these fields are the correct time stamp fields for your process. (In other words, is a new record measured in your organization by the Created time stamp or the Opened time stamp?)

**<Application>.Open**

This indicator source determines which records were open on a specific day. This data drives statistics around your work backlog. You know whether a record was open on a specific day by looking at the date it was new and the date it was closed. In the Out-of-the-box Performance Analytics Solutions, the indicator sources look at Created, Opened, Resolved, or Closed to determine whether the record was open on a given day. Verify whether the fields that come with the Out-of-the-box Performance Analytics Solution indicator sources provide the correct measurements for your organization’s processes.

**<Application>.Closed**

This indicator source determines which records were resolved on a specific day. This indicator source should be pointed to the time stamp field on the record that defines when the record was closed. In Out-of-the-box Performance Analytics Solutions, the indicator source looks at the Closed field for Incident, Problem, and Change Management. Some Out-of-the-box Performance Analytics Solutions also contain an <Application>.Resolved indicator source that looks at the Resolved timestamp.

Ensure that the indicator sources that Out-of-the-box Performance Analytics Solutions contain point at the correct fields for you to measure the performance of your processes.

1. Navigate to Performance Analytics > Sources > Indicator Sources.
2. Click on an indicator source to see its details.
   - The time stamp fields that the indicator source utilizes are listed in the Source section of the record.
In this screenshot of the Incident.New indicator source, you can see that the source uses the **Opened** field.
3. If necessary, change the field or modify the condition from the lists in the Condition Builder.
4. Click **Update** to save your changes.

**Update Performance Analytics scripts**

Out-of-the-box Performance Analytics Solutions include Performance Analytics scripts to perform calculations on records. These scripts use the time stamp fields from the indicator sources. If you change the time field stamps in an indicator source, also modify the related scripts.

**Important:** If you did not update any indicator sources in your Out-of-the-box Performance Analytics Solutions, skip this task.

Role required: pa_admin, admin

1. Navigate to **Performance Analytics > Automation > Scripts.**
2. Click a script to open its details.
   For example, the Change.CloseTime.Hours script record contains the following script:
   ```javascript
   var diff=function(x,y){return y.dateNumericValue() - x.dateNumericValue();};
   var hours=function(x,y){return diff(x,y)/(60*60*1000);};
   hours(current.opened_at, current.closed_at);
   ```
3. In the Source section, click the lock icon next to the list of Fields.

   **Source**

   Select the facts table to which the script will be applied.

   Facts table: Change Request
   Fields: Opened, Closed

   The Fields selector opens.

4. Move the desired fields into the fields that are **Selected** for the script, and remove fields that are not appropriate.
   For example, if your organization uses the **Created** time stamp field to define a new change, replace **Opened** with **Created.**
5. In the Script field, replace the references to disused fields with references to the fields you just selected.
   In this example, references to the *Opened* field are replaced by references to *Created*.

   ```javascript
   var diff = function(x, y) { return y.dateNumericValue() - x.dateNumericValue(); };
   var hours = function(x, y) { return diff(x, y) / (60 * 60 * 1000); };
   hours(current.opened_at, current.sys_created_on, current.closed_at);
   ```

6. Click **Update** to save your changes.

**Review the breakdown sources**

Breakdown sources represent the elements that you use to examine a KPI in more detail. Modify the breakdown source to limit the element list to only those items that are meaningful for the data analysis.

Role required: pa_admin, admin

For example, the Assignment Group automated breakdown uses the Groups breakdown source. This breakdown source returns ALL active groups in your instance, and the system uses all these groups to examine your data. If you look at the Number of Open Changes indicator, and you examine the Assignment Group breakdown, you see all groups in your instance instead of just the groups that are actually working on your Change requests.

Restricting the number of elements that a breakdown source returns has the following benefits:

- Smaller element lists make it easier for consumers to find the data they need. Sorting through a list of 25 groups associated with a particular process is easier than trying to sort through thousands of groups.
- Smaller element lists lead to less data collection and more efficient use of data. Instead of the data collector crunching through 1,000 different groups, the data collector can analyze the 25 groups that are meaningful to the process.
Note: You probably do not need to change the breakdown sources in Out-of-the-box Performance Analytics Solutions. However, you may find it helpful to review and understand exactly what is being measured in your processes.

1. Navigate to Performance Analytics > Sources > Breakdown Sources.
2. Click a breakdown source to see its details.
3. In the Source tab, examine the definition for the breakdown elements, including the table that contains the unique list of sys_ids. For example, in the Change.Impact breakdown source, the unique values contained in the Change Request Impact field come from the Choice (sys_choice) table. The conditions provide additional filters to ensure that the
query returns only the Change Impact fields from the Choice (sys_choice) table.

4. Click Preview to see the number of elements that the query returns. In the example, the query returns three impact elements.
5. Click **x records match condition** to see the specific values that the query returned. In the example, clicking **3 records match condition** opens a new browser tab with a filtered list of records from the Choice (sys_choice) table.

6. Verify that the list of records match what you expect to see in the breakdown element list.

7. If the records were not what you expected, modify the conditions in the Source tab of the breakdown source to match your environment and repeat steps 4-6 until you are satisfied.

8. Click **Update** to save your changes.

You are now ready to collect data, as described in *Collect data for Out-of-the-box Performance Analytics Solutions*.

**Collect data for Out-of-the-box Performance Analytics Solutions**

After you install an Out-of-the-box Performance Analytics Solution and ensure that it points at the correct data structures in your instance, collect the data for the indicators and breakdowns.

Whenever you activate an Out-of-the-box Performance Analytics Solution, you automatically install Data Collector jobs for that Solution. These Data Collector jobs collect analytics information for the indicators and breakdowns in the Solution. After the jobs run, you can see the data in the widgets and dashboards for the Solution. Technically, the Data Collector jobs do the following actions:

- Run periodically, usually daily
- Read your operational tables
• Measure the data for the period (usually a day) against the definitions that the indicators and breakdowns specify
• Store the resulting measurement scores and (optionally) raw data in Performance Analytics tables.

The plugin or ServiceNow Store application for an Out-of-the-box Performance Analytics Solution usually installs the following two jobs:

**Historic Data Collection**

Run the historic Data Collector job when you first install an Out-of-the-box Performance Analytics Solution. By default, the historic Data Collector job collects the last 60 days of data for the indicators specified in the job. If you want to go back further in time, you can configure the job to collect more historic data. A historic Data Collector job overwrites all data for the period of collection. Therefore, run it only once, when you first install the Analytics and Reporting Solution. Run a periodic Data Collector job for all subsequent data.

**Periodic Data Collection (usually daily)**

This job populates the Performance Analytics tables with data going forward. Schedule the periodic data collector to run with the same periodicity as the frequency of the indicators for which it collects data. Most indicators have a Daily frequency, so most Data Collector jobs also run daily. After you schedule the job, verify that it is Active, or it will not run.

**Run historical data collection for an Out-of-the-box Performance Analytics Solution**

After you activate an Out-of-the-box Performance Analytics Solution, run a historical data collection job. This job gives you immediate insight from your existing data.

Role required: pa_admin, admin

1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Filter the list of jobs for those containing the word 'Historic'.
3. Locate and open the historic job that corresponds to your new Out-of-the-box Performance Analytics Solution.
4. Go to the Collection Parameters section, and set the **Relative start** and **Relative start interval** fields to collect data from as far back as you want.
   The Data Collector runs a number of times equal to the number of days (or other collection periods) specified in the form. For example, the default configuration of 60 days causes the Data Collector to run 60 times in succession. The Data Collector starts at T-60 days and examines all records as if the date were 60 days ago. After processing those records, the Data Collector runs again at T-59 days. The Data Collector repeats the process until it gets to the current date.

   Each day's collection may take a minute or two to complete depending on the size of your tables. A historic data collection over multiple months may take some time to complete.

   If the product or application for which you installed the Out-of-the-box Performance Analytics Solution is new, you might not have much historical data. In this case, you can shorten the relative start interval. If you have not yet used the product or application, you can skip collecting historical data altogether.

5. Ensure that the user specified in the **Run as** field exists.
   If you are using domain separation, you collect only records from domains which the **Run as** user can view. However, the ACL permissions of the **Run as** user do not affect data collection.
6. Verify that the **Run As tz** time zone is appropriate for your company.
   Database queries based on this indicator source use this time zone. This time zone affects the timestamps for the data collection job. This time zone also defines what day is "Today" for conditions like \([\text{Created}(\text{on})(\text{Today})]\).
7. Click **Execute Now** to run the job.
8. Navigate to **Data Collector > Job Logs**.
9. Look at the **State** of the job you are running.

Refresh the view periodically until the job completes. If the job is successful, the **State** changes to **Collected**.

### Collecting historical data for newly installed Out-of-the-box Performance Analytics Solution

You have just installed a set of Out-of-the-box Performance Analytics Solutions. You want to run the initial historical data collection job on them, so you navigate to **Performance Analytics > Data Collector > Jobs**. To find the historic jobs for Out-of-the-box Performance Analytics Solutions, you filter the list on 

```
((Name)(contains)(Historic))
```

**Tip:** When you start to create your own historical data collector jobs, include the word ‘Historic’ in their names.
Scheduled Data Collection

Name contains historic

[PA Knowledge] Historic Data Collection

[PA Requested Item] Historic Data Collection

[PA Change] Historic Data Collection

[PA Problem] Historic Data Collection

[PA Analytics] Historical Data Collection

[PA Incident SLA] Historic Data Collection

[PA Incident] Historic Data Collection

Benchmark Historical Data Collection
You decide to run the job for the Knowledge Management solution first. To ensure that nobody has run the knowledge management historical job yet, you navigate to Data Collector > Job Logs and filter the list on (Job)(contains(\[knowledge\])).

No records to display.
In this case, you see that the job has not been run since the last zBoot. So you navigate back to the **Jobs** list and open **(PA Knowledge) Historic Data**

**Collection parameters**

Provide the score collection parameters. When collecting in the past do not go beyond the number of days that scores and snapshot data is retained, because scores and snapshot data is then removed automatically. See the Performance Analytics properties.

- **Operator**: Relative
  - **Relative start**: 00
  - **Relative end**: 1
  - **Relative start interval**: days ago
  - **Relative end interval**: days ago

**Job parameters**

Specify when to run the scheduled data collection job.

- **Run as**: System Administrator
- **Run as tz**: System(America/Los_Angeles)
- **Active**: 
- **Run**: On Demand
- **Collect**: Both scores and text index
In the form, you verify the following details:

1. The **Relative start** field is set for the default 60 days, which is fine for you.

2. The **Run as** user exists on your instance. Otherwise, you would have to choose a different user.

3. The time zone is appropriate for your company.

You are satisfied with the settings for the historical job, so you click **Execute Now**. After a few minutes, the job is shown as **Collected** in the job logs.

### Schedule data collection for an Out-of-the-box Performance Analytics Solution

Enable the periodic data collection job for your Out-of-the-box Performance Analytics Solution. Check that the time that it runs is correct.

Role required: `pa_admin`, `admin`

Every Out-of-the-box Performance Analytics Solution includes a periodic data collection job.

1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Filter the job list on `(((Run) is not one of) (Once | On Demand)) AND ((Active) (is) (false))`. 
You now see only periodic data collection jobs that have not been activated.

3. Open the periodic data collection job for your Out-of-the-box Performance Analytics Solution.

The following steps refer to the Job Parameters section of the job record.

4. Ensure that the user specified in the Run as field exists.
   If you are using domain separation, you collect records only from domains that the Run as user can view. However, the ACL permissions of the Run as user do not affect data collection.

5. Verify that the Run As tz time zone is appropriate for your company.
   The database queries created for this job use this time zone, which is reflected in the logs for this job. This time zone also determines what day is "Today" for indicator conditions like [(Created) on] (Today).

6. Select Active to enable the scheduled run of the job.
   Scheduling options are now available.

7. Ensure that the time that the job runs is during your company downtime.
   - The Time value is based on the time zone for your user session, not the Run as tz time zone.
   - To get an accurate measurement for a day, the day must have completed. Therefore, for a Daily job, the Time value should equate to a time between midnight and 6 am in the
Run as tz time zone, to collect for the previous day. For example, if you are logged in from New York and want to run the job at 5 am in the System/Los Angeles time zone, set Time to 08:00:00.

- For a Monthly job, you also set the day that you want to run the job on. Generally set it to run on the first day of the month, soon after midnight in the Run as tz time zone. This setting gets all the data for the preceding month, regardless of the length of the month.

After the next collection period, the dashboards and widgets should show scores from that period.

Check the Job Logs to see if the job ran successfully after the next period.

**Performance Analytics roles**

Assign roles to ensure that users can perform all necessary actions.

**Roles and personas**

<table>
<thead>
<tr>
<th>Role</th>
<th>Authorizations</th>
<th>Typical persona</th>
</tr>
</thead>
<tbody>
<tr>
<td>No role</td>
<td>• View Performance Analytics visuals on the Service Portal.</td>
<td>Naive requester who does not need any access to Performance Analytics beyond certain visualizations of results</td>
</tr>
<tr>
<td></td>
<td>• View dashboards that have been shared with this user.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Some dashboards require a subject matter related role for viewing, such as sn_hr_core_basic for the HR Agent OOTB dashboard.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Dashboard owners and administrators can also restrict dashboard access by role. For more information, see Dashboard permissions.</td>
<td></td>
</tr>
<tr>
<td>Any role (not necessarily a Performance Analytics role)</td>
<td>• Create dashboards.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Restrict access by role to a dashboard they create.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Share dashboards they own.</td>
<td></td>
</tr>
<tr>
<td>pa_viewer</td>
<td>• View Analytics Hub.</td>
<td>Requester who needs and understands the details of key performance indicators</td>
</tr>
<tr>
<td>Contained by: All roles except pa_contributor</td>
<td>• Create thresholds and targets for indicators.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Read, Update, and Delete thresholds and targets that they created.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View text analytics widgets on dashboards.</td>
<td></td>
</tr>
<tr>
<td>Role</td>
<td>Authorizations</td>
<td>Typical persona</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sn_pa_diagnostics.pa_diagnostic</td>
<td>• Read from the Diagnostics tables.</td>
<td>No specific persona, but this role would typically be assigned to individual business analysts or groups of fulfillers.</td>
</tr>
<tr>
<td>Contained by: pa_admin</td>
<td>• Activate or deactivate a diagnostic.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Run diagnostics.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Delete message records and diagnostic logs.</td>
<td></td>
</tr>
<tr>
<td>pa_contributor</td>
<td>For indicators for which the user is designated as a <strong>Contributor:</strong></td>
<td>No specific persona, but this role would typically be assigned to individual fulfillers or groups, who are allowed to set indicator scores manually</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read and update scores in scoresheets.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View the Analytics Hub.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This user can also read dashboards that have been shared with them.</td>
<td></td>
</tr>
<tr>
<td>pa_target_admin</td>
<td>• Create targets.</td>
<td>Manager who knows what targets to set but may not have any further input to Performance Analytics</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read, update, and delete all targets, including those that they do not own.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign targets to indicators.</td>
<td></td>
</tr>
<tr>
<td>pa_threshold_admin</td>
<td>• Create thresholds.</td>
<td>Manager who knows what thresholds to set but may not have any further input to Performance Analytics</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read, update, and delete all thresholds, including those that they do not own.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Assign thresholds to indicators.</td>
<td></td>
</tr>
<tr>
<td>pa_analyst</td>
<td>• CRUD text analytics keywords, phrases, and stop words</td>
<td>No specific persona, but this role would be assigned to individual fulfillers or groups whose expertise includes keywords, phrases, and stop words for word clouds.</td>
</tr>
<tr>
<td>Contained by: pa_power_user, pa_admin</td>
<td>• Read indicator sources.</td>
<td></td>
</tr>
<tr>
<td>pa_power_user</td>
<td>• CRUD indicators and breakdowns.</td>
<td>Business analyst. Understands the business use cases for Performance Analytics and the requirements for indicators and breakdowns.</td>
</tr>
<tr>
<td>Contained by: pa_admin</td>
<td>• CRUD widgets</td>
<td></td>
</tr>
<tr>
<td>The pa_power_user role contains the</td>
<td>• Add Performance Analytics widgets to dashboards.</td>
<td></td>
</tr>
<tr>
<td>pa_viewer, pa_contributor,</td>
<td>• CRUD text index configurations for text analytics.</td>
<td></td>
</tr>
<tr>
<td>pa_target_admin, pa_analyst, pa</td>
<td>• CRUD bucket groups.</td>
<td></td>
</tr>
<tr>
<td>threshold_admin</td>
<td>• CRUD indicator groups</td>
<td></td>
</tr>
</tbody>
</table>
## Role hierarchy

Certain roles such as pa_power_user and pa_admin include other roles. For example, pa_power_user includes pa_contributor. This diagram shows the role hierarchy.

<table>
<thead>
<tr>
<th>Role</th>
<th>Authorizations</th>
<th>Typical persona</th>
</tr>
</thead>
</table>
| pa_data_collector     | • CRUD, schedule, and run data collection jobs  
                        • CRUD indicator and breakdown sources  
                        • Read some system properties  
                        • CRUD system units  
                        • CRUD scripts and automated notifications  
                        • CRUD bucket groups             | Technical expert who understands the underlying database record structure of        |
| pa_admin              | The pa_admin role contains the pa_power_user, sn_pa_diagnostics.pa_diagnostic, and pa_data_collector roles.  
                        | • Edit Performance Analytics properties.  
                        • Access Admin Console  
                        • Launch Dependency Assessment | Performance Analytics technical expert who also understands business needs.          |
| admin                 | The system administrator role. Users with the admin role can perform all pa_admin functions, create database views, CRUD any dashboard, and assign ownership to dashboards. | System administrtator                                                             |
### Required roles for actions

<table>
<thead>
<tr>
<th>Module</th>
<th>Action</th>
<th>Minimal required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin Console</td>
<td>Access</td>
<td>pa_admin</td>
</tr>
<tr>
<td>Automated indicators</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Automation schedules</td>
<td>Read and delete (other security restrictions likely apply)</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Automation scripts</td>
<td>CRUD</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Breakdowns and elements, including breakdown relations</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Bucket groups</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Color schemes for charts and targets</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Create a dashboard. Update a dashboard they created, including restricting access by role.</td>
<td>Any roles necessary to access the data to display, or any one role</td>
</tr>
<tr>
<td>Module</td>
<td>Action</td>
<td>Minimal required role</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Add Performance Analytics widgets to dashboards you own.</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Read a dashboard that has been shared with you</td>
<td>No role by default, but dashboards can require roles to view their data. For more information, see <a href="#">Dashboard permissions</a>.</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Update, delete, or share a dashboard that you own.</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Dashboards</td>
<td>Update, delete, or share any dashboard. Reassign ownership of any dashboard.</td>
<td>admin (and dashboard role dashboard_admin)</td>
</tr>
<tr>
<td>Data collector jobs</td>
<td>Read, write, execute</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Dependency assessment</td>
<td>Launch dependency assessment from indicator or breakdown form</td>
<td>pa_admin</td>
</tr>
<tr>
<td>External indicators and breakdowns</td>
<td>CRUD</td>
<td>pa_data_collector or pa_power_user</td>
</tr>
<tr>
<td>Formula and manual indicators</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Indicator Groups</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Sources, either indicator or breakdown</td>
<td>CRUD</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Indicator targets</td>
<td>Read and edit targets that you do not own</td>
<td>pa_target_administrator</td>
</tr>
<tr>
<td>Indicator targets or thresholds</td>
<td>Create new. Read or edit ones you own.</td>
<td>pa_viewer</td>
</tr>
<tr>
<td>Indicator thresholds</td>
<td>Read and edit thresholds that you do not own</td>
<td>pa_threshold_administrator</td>
</tr>
<tr>
<td>In-form analytics</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Lists in all applications</td>
<td>Access an interactive analysis</td>
<td>No role by default, but some interactive analyses require roles to view their tables</td>
</tr>
<tr>
<td>Manage diagnostics</td>
<td>Read, execute, delete</td>
<td>sn_pa_diagnostics, pa_diagnostic</td>
</tr>
<tr>
<td>Scheduled email summary jobs</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Scorecards</td>
<td>View</td>
<td>pa_viewer</td>
</tr>
<tr>
<td>Scoresheets</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Service Portal</td>
<td>View Performance Analytics visuals</td>
<td>No role</td>
</tr>
<tr>
<td>System Properties</td>
<td>Edit</td>
<td>pa_admin</td>
</tr>
<tr>
<td>System Properties</td>
<td>Read</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>System Units</td>
<td>CRUD</td>
<td>pa_data_collector</td>
</tr>
<tr>
<td>Text Analytics</td>
<td>Set up text index configurations</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Text Analytics</td>
<td>View a text widget on a dashboard</td>
<td>pa_viewer</td>
</tr>
<tr>
<td>Module</td>
<td>Action</td>
<td>Minimal required role</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Text analytics keywords, phrases, or stop words</td>
<td>CRUD</td>
<td>pa_analyst</td>
</tr>
<tr>
<td>What's on the Move News Rules and Statistics Generators</td>
<td>Read, edit</td>
<td>pa_power_user</td>
</tr>
<tr>
<td>Widgets</td>
<td>CRUD</td>
<td>pa_power_user</td>
</tr>
</tbody>
</table>

**Supported browsers for Performance Analytics**

ServiceNow supports Performance Analytics in UI15 and UI16. Performance Analytics supports all browsers that are supported by the UI15 and UI16 interfaces.

**Performance Analytics Admin Console**

From a single console, administrators can manage out-of-the-box content, manage Performance Analytics widgets and dashboards, diagnose and resolve errors, view usage analytics, modify configuration settings and access ServiceNow help.

Users with the admin or pa_admin roles can navigate to Performance Analytics > Admin Console. If Performance Analytics is not enabled, click Learn More for information about activating it.
Guided Setup for the Out-of-the-box Performance Analytics Solutions.

Click **Plugin List** to show a list of available system plugins for inactive Out-of-the-box Performance Analytics Solutions.

**Note:** You must have the admin role to see the list of plugins.

Click **Guided Setup** to launch guided setup for Out-of-the-box Performance Analytics Solutions.
Explore and Manage

A single place where you can quickly identify and manage the relationships between your Performance Analytics elements and gauge the impact of change. For example, you can identify all the reports, indicators, and interactive filters in a dashboard group that are affected if you change a field name.

Click **Dashboards** to explore all of the dashboards in your instance sorted by group. Expand the group to view the individual dashboards.

Click **KPIs** to create and manage your **Analytics Hub**.

Use **Dependency Assessment** to view, analyze, and manage your Performance Analytics components.

Troubleshoot

The **Troubleshoot** panel enables you to utilize diagnostics delivered by the ServiceNow application to investigate tests that result in an Error warning and failed data collection jobs. Out-of-the-box diagnostics run on a schedule, but can also be executed on demand. The Scheduled Data Collection list filters out jobs that are run only once and jobs that are run only on demand.

**Note:** If either of the numbers on the Troubleshoot card are greater than 0, there may be something wrong with your Performance Analytics implementation.

- Click **Diagnostic Errors** to view the Diagnostic Executions list, a summary of how many diagnostic tests were run, and how many issues were found. Use the **State** field to track which issues have been resolved. For more information on diagnostic executions, see **Performance Analytics diagnostics**.

- Click **Failed Jobs** to view the Scheduled Data Collection list. A failed job is a scheduled job for which the latest complete run is in the state **collected_error**. For more information on data collection, see **Performance Analytics data collection and cleanup**.

Usage

Dashboards with statistics about data collection jobs and report usage.

- Use the **Data Collection Overview** dashboard to track and manage data collection. Note that data collection jobs are not run by default. dashboard widgets do not show data until you run the associated data collection jobs. For more information, see **Performance Analytics data collection and cleanup**.

- Use the **Reports Usage** dashboard to track and manage report usage. For more information, see **Report statistics**.

Advanced Configuration

Quick links to advanced configuration settings.

- **Performance Analytics properties**
- **Reporting properties**
- **Responsive dashboard properties**
Help

The community, product documentation, and the video tutorials on the ServiceNow YouTube channel provide additional insights into Performance Analytics functionality.

Dependency Assessment

Dependency Assessment enables you to view, analyze, and edit your performance analytics components including widgets, indicators, and breakdowns, from a single view. By viewing the hierarchy of components and the relationships between them, you can see immediately who is impacted by a change and what the effects of your changes are.

Dependency Assessment consists of several components:

Top-down tree view

The top-down tree view shows the components of a performance analytics entity in a hierarchical view. If you launch dependency assessment on a dashboard, for example, the top-down tree view shows nodes for each of the dashboard tabs. When you select a dashboard tab, the tree view expands to show nodes that represent each of the widgets on the dashboard.

Bottom-up tree view

The bottom-up tree view shows where a performance analytics entity is used in your instance. If you select Show Used By from the context menu of a tree view component, the tree view shows all the places where that entity is used. Click the reset icon to return to the top-down tree view.

Component summaries

Click the info icon to see a summary of the component.

Other actions

Click the context menu icon in any component to view the actions available for that component. These include editing the component, viewing the schema map of the component, and previewing a widget.

Note: The tree view is persistent. When you return to Dependency Assessment, the tree view shows the same configuration as on the last visit.

Launch Dependency Assessment

Use the Dependency Assessment tree view to view and edit your performance analytics components including widgets, indicators, and breakdowns, from a single view. You can see the effects of your changes immediately. The tree view opens in the same browser window from which you launched it. Edit windows open in pop-ups so that you do not have to navigate between browser windows or lose context.

Role required: pa_admin

This task describes how to launch Dependency Assessment from the Dashboards list. You can also navigate to any of the following locations, select an item from the list, and click Launch Dependency Assessment in the Related Links:

- Performance Analytics > Widgets
• Performance Analytics > Scripts
• Performance Analytics > Indicators > Automated Indicators
• Performance Analytics > Indicators > Manual Indicators
• Performance Analytics > Sources > Indicator Sources
• Performance Analytics > Breakdowns > Automated Breakdowns
• Performance Analytics > Breakdowns > Manual Breakdowns
• Performance Analytics > Sources > Breakdown Sources
• Performance Analytics > Scorecards

Note: From an Analytics Hub, click the context menu and select Launch Dependency Assessment.

1. Navigate to Performance Analytics > Dashboards or Self-Service > Dashboards.
2. Select the dashboard you want to analyze.
3. From the context menu, select Launch Dependency Assessment.

You can also select Dashboard Properties and click Launch Dependency Assessment in the related links.

The tree view of the selected dashboard opens.
Dependency Assessment tree view

The tree view enables admin users to see the relationships between PA entities and to know the impact of changes made to any node in the tree view hierarchy.

The Dependency Assessment tree view consists of a variety of possible nodes and a legend. The nodes represent Performance Analytics entities. Point to a node and the node’s type is highlighted in the legend. When you click on a node in the tree view, the child nodes open. If there are more than eight nodes in a level of the tree view, then six are shown and a seventh node indicates how many nodes are not shown. Click this node to view a list of the other nodes.

The tree view header contains choice lists for changing the PA entity type and a value. The tree view updates according to your choices. Click the reset button (⟳) to return the tree view to the starting point with just the first level parent and its immediate child nodes.

Each node has a context menu (≡) where you can choose from a number of actions. Choose Show Used By to change the tree view to show where a node is used in your instance. See Bottom-up tree view for more information.
The figure below gives an example of the top-down tree view, starting from a dashboard at the top level, its tabs on the second level, the widgets of one of the dashboard tabs on the third level, and so on. The tree view in the example shows all breakdowns and supporting indicators as they are defined in the Breakdown form.
**Bottom-up tree view**

You can see where any element in the tree view is used. This is useful when you want to change an element such as an indicator or breakdown and see the effect of your change on other PA elements.

Role required: admin

1. **Launch Dependency Assessment** on the Performance Analytics entity you want to investigate. For example,
   a) Navigate to Performance Analytics > Dashboards.
   b) Select the dashboard you want to investigate or the dashboard that uses the entity you want to investigate. In this example, we start with the Usage by Requestor dashboard.
   c) From the context menu ( ), select Launch Dependency Assessment.

2. Expand the tree view to locate the entity you want to investigate.
3. Click the context menu ( ) of the entity and select **Show Used By**

4. The top-down tree view is replaced with a view which shows all of the entities which use the selected entity. In this case, the API Transactions Requestor Stats
table is used by one breakdown source, three reports, and two interactive filters:

5. Click the reset button ( ) to return the tree view to the base selection as shown in the header.

Tree view navigation

To navigate the admin console tree view effectively, it’s good to know what the various icons and other visual data in the tree view indicate.

Node types

The node types reflect the different features of Performance Analytics. When you click on a node, it expands into its child features on the next level of the tree view.

Dashboard-related nodes

Dashboards group nodes expand into dashboards. Dashboards expand into dashboard tabs even if the dashboard has only one tab. Dashboard tabs expand into the contents of the tab.

Widgets

Widgets open nodes that show their component parts.

Indicators

All indicator nodes (automated, formula, widget, manual, external and supporting indicators) open into nodes for their component sources, breakdowns, jobs, and scripts.

Reports
Reports open nodes that show their component tables.

**Breakdowns**

Breakdowns open nodes that show their sources.

**Sources**

All source nodes (breakdown, indicator, and report sources) open nodes that show their source tables.

When you click on text widgets, the underlying file appears as a pop-up over the tree view. When you select a context menu item, the result of the selected action appears in a pop-up as well.

**Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Dashboard group" /></td>
<td>Dashboard group</td>
<td>• Edit</td>
</tr>
</tbody>
</table>
| ![Dashboard](image) | Dashboard | • Edit  
• View Dashboard  
When you select View Dashboard, the dashboard is shown in a pop-up over the tree view. All of the dashboard’s features are available including sharing, layout configuration, and adding widgets. When you close the pop-up, the tree view is visible again.  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Dashboard tab](image) | Dashboard tab | • Edit  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Report](image) | Report | • Edit  
Opens the report in the Report Designer in a pop-up window. When you close the pop-up, the tree view is visible again.  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
</table>
| ![Report source icon](image) | Report source | - Edit  
- Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Interactive Filter icon](image) | Interactive Filter | - Edit  
- Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Performance Analytics Widget icon](image) | Performance Analytics Widget | - Edit  
- Preview Widget  
Select [Preview Widget](#) to show the widget in a pop-up window.  
- Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Other Widget icon](image) | Other Widget | No context menu. |
| ![Formula Indicator icon](image) | Formula Indicator | - Edit  
- Show Analytics Hub  
- Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Automated Indicator icon](image) | Automated Indicator | - Edit  
- Show Analytics Hub  
- Show Scores  
- Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Widget Indicator icon](image) | Widget Indicator | - Edit  
- Preview Widget  
Select [Preview Widget](#) to show the widget in a pop-up window. |
<p>| <img src="image" alt="Supporting Indicators icon" /> | Supporting Indicators | - Edit |</p>
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Manual indicator icon" /></td>
<td>Manual indicator</td>
<td>• Edit</td>
</tr>
<tr>
<td><img src="image" alt="External indicator icon" /></td>
<td>External indicator</td>
<td>• Edit</td>
</tr>
</tbody>
</table>
| ![Indicator source icon](image) | Indicator source | • Edit  
• Show Schema Map  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Linked Breakdown icon](image) | Linked Breakdown | No context menu. Click the tile to reveal the associated breakdowns. |
| ![Breakdown icon](image) | Breakdown | • Edit  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Breakdown Source icon](image) | Breakdown Source | • Edit  
• Show Schema Map  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Job icon](image) | Job | • Edit  
• Execute Now  
• View All Logs  
• View Last executed Log  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
| ![Script icon](image) | Script | • Edit |
| ![Table icon](image) | Table | • Edit  
• Show Schema Map  
• Show Used By  
Launches the [Bottom-up tree view](#) which shows all of the entities that use this entity. |
<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Context menu actions</th>
</tr>
</thead>
</table>
| ![Filter widget icon](image) | Filter widget | - Edit  
- Preview Widget  
Select **Preview Widget** to show the widget in a pop-up window.  
- Show Used By  
Launches the **Bottom-up tree view** which shows all of the entities that use this entity. |

**Other visual data**

Each node has one or more of these icons. Point to the upper right corner of the node to show them.

**Info button (ि)**

Click the info button to reveal further details about the node. A node's information panel shows different information depending on the type of node, but all information panels have an **Open Record** button. Click **Open Record** to open the record for editing.

**Context menu ()**

Click the context menu icon to perform further actions on the node's source.

**Error indicators (⚠)**

**Visualize Performance Analytics data**

Display collected data using the Analytics Hub, widgets, and dashboards.

**Note:** In all visualizations, high scores are abbreviated following the metric system. Thus scores in the millions are abbreviated with an M and scores in the (US) billions with a G.

**Analytics Hub**

The Analytics Hub is the central interface where you assess, compare, and predict the performance of an indicator over time. The Analytics Hub replaces scorecards.

In the Analytics Hub, analyze indicator scores by aggregating data, comparing scores, or viewing changes over time, and filter scores by breakdown. Enhance the Analytics Hub by adding targets, thresholds, trendlines, and useful comments for significant changes.

On the indicator form, you can set the indicator to be included in the Analytics Hub automatically.

ServiceNow Performance Analytics – Analytics Hub
Analytics Hub list of indicators

The Analytics Hub provides a list of indicators, their scores, and a customizable selection of other analytics. Click the name of an indicator to see more details about that indicator. The Analytics Hub replaces scorecards.

To access the Analytics Hub list, navigate to **Performance Analytics > Analytics Hub**.

Indicator list controls

The list of indicators includes the following controls:

- Click the name of an indicator to open a view of the Analytics Hub that is focused on the indicator. An extended set of analytical tools is available in this view.
- Click the pencil icon next to an indicator to open the indicator record for editing. This icon is available only if your roles give you access to the indicator record.
- A solid blue star beside an indicator name indicates that it is a favorite. Click the star beside the indicator to mark it as a favorite.
- A black dot beside an indicator name indicates that it is a key indicator. Mark indicators as key by selecting the **Key** check box when creating the indicator.

Customize the indicator list

To customize what is shown in the Analytics Hub, click the list settings icon (⚙️) beside the search box.
Filter settings

You can filter which indicators are shown with the following settings:

**Key indicators**
Only indicators that are defined as key indicators in the indicator record are shown.

**With a target**
Only indicators with a defined target are shown.

**Formula**
Only formula indicators are shown.

**Manual**
Only manual indicators are shown.

Breakdown source and element settings

Within the settings, you can also select a breakdown source. Only indicators that use that breakdown source are shown. After choosing the breakdown source, you can further filter the list of indicators by selecting a breakdown element. Only indicators to which that element applies are shown.

Column settings

Select which analytics to show in the indicator list. The indicator scores are always shown.

**Change**
The change in scores, in absolute value, between the most recent and the preceding data collection.

**Trend**
The trend line for scores over the course of the data collection. This trend line is a miniaturization of the trend line that can be seen when the Analytics Hub is focused on a specific indicator.

**Bullet chart**
A chart comparing current score to target. This chart is shown for an indicator only if a target is set on that indicator.

**Date**
Date that the latest score was collected.

**Target**
The target for the indicator, if one has been set.

**Gap**
The gap between the latest score and the target. A value is shown only if a target has been set for the indicator.
Frequency
The frequency with which scores are calculated for the indicator.

Direction
Whether the score for the indicator should minimize, maximize, or neither.

Show percentage
If activated, the change in score is shown as a percentage instead of as an absolute value.

Filter by performance
You can filter the list of indicators based on the indicator performance, in addition to filtering the list in the settings.

- **Best:** Shows indicators that are outperforming their target (green), ordered by Gap % (best performers on top).
- **Worst:** Shows indicators that are under performing their target (red), ordered by Gap % (worst performers on top).
- **Improved:** Shows indicators that have improved compared to the previous data collection (moving in the right direction).
- **Degraded:** Shows indicators that have degraded compared to the previous data collection (moving in the wrong direction).

Analytics Hub for a specific indicator
Use the Analytics Hub to thoroughly analyze indicator data, such as by aggregating data, comparing scores, or viewing changes over time. The Analytics Hub for specific indicators replaces detailed scorecards.

To access the Analytics Hub for an indicator, navigate to **Performance Analytics > Analytics Hub**, then select an indicator. You can also click the **Show analytics hub** related link on the Indicator form to view the Analytics Hub for that indicator.

Adding Targets, Thresholds, Comments, and Improvement Initiatives
All tabs in the Analytics Hub have a toolbar at the top with the following actions:

- Targets
- Thresholds
- Add a comment
- Information
- Create Improvement Initiative (Requires the Continual Improvement Management application)

A tooltip identifies each icon in the toolbar.
Clicking an icon in the toolbar opens a pane where you can view existing or create new targets, thresholds, or comments, or view the basic information about the indicator.

If you have the Continual Management Improvement application and the sn_cim.improvement_requester role, you can create an improvement initiative. Click the Create Improvement Initiative icon to open an Improvement Initiative form. This form is automatically populated with details of the indicator and Analytics Hub. To see the initiative start and finish dates on the timeline, click the improvement initiative icon in the chart options on the Overview tab.

**Editing indicators and scores, exporting to PDF or CSV, and generating graphics**

Every tab on the Analytics Hub has a context menu to edit the indicator record, edit the indicator scores, create a graphical image of the tab, or launch a dependency assessment. Click the context menu a second time to close it without making a choice.

`View scores and statistics`

The Analytics Hub Overview tab shows the score for a time period, statistics, and a time series. You can set the time period for the statistics and time series. You can also filter scores by breakdown and element.
Overview tab
Scores

At the top left of the tab, you see the following information:

- The score for a chosen time period
- The change, both absolute and percentage, between that score and the score for the previous time period
- If a target is set, the difference between the score and that target
- Controls for switching to the previous, next, or last time period
- A calendar for selecting a time period or the real-time score

Number of open incidents

February 5 ↔ ◼ ▶

181 ▼ -12 (-6.2%)

Target: 450  Gap: 269 (59.8%)

Score section showing compliance with a target

Results are color-coded to show favorability. If the direction of an indicator is Maximize, increases in scores are shown in green and decreases in red. If the direction of an indicator is Minimize, increases in scores are shown in red and decreases in green. Similarly, a color bar indicates whether the target has been met or missed. The colors depend on the color scheme that has been set for the target. For more information, see Create a target color scheme.

The time period that is associated with a score is shown above the score. Controls let you move to the next time period, the previous time period, or the last time period. The date you select here is reflected in the statistics and the time series graph. The selected time period is carried over when you change to another tab. The length of a time period (day, month, quarter...) is the same as the frequency of the indicator.

You can also select the date by clicking along the time series chart. Furthermore, if you navigate to this Analytics Hub from a widget, the date that you select in the widget persists when you open the Analytics Hub.

Viewing real-time scores

You can select real-time scores instead of the last score in the following circumstances:

- The indicator is configured to show real-time scores.
- No scripted breakdowns are being applied to the indicator.

In this case, you can also select the real-time score in the date selector, or by selecting the current time period in the Records view. However, when viewing real-time scores, you cannot see records that do not match a breakdown element in the Records view.
Selecting to show real-time score

For more information about viewing real-time scores in both the Analytics Hub and widgets, see View real-time scores.

Time series aggregation

In the top right corner, you can set the time series aggregation for the Analytics Hub.
The time series aggregation is reflected in the score, the statistics, the time series graph, and the charts in other tabs. The available time series depend on the frequency of the indicator. For more information, see *Time series aggregations in the Analytics Hub and widgets*.

**Setting the time period**

You can set the time period of scores that the Analytics Hub describes. The controls for doing so are above the statistics and to the left of the time series aggregation. The time period you choose is reflected in the score, the statistics, and the time series graph. You have two control options to set the time period:

- The calendar:
The sliders with the navigation bar:

**Statistics**

In the upper right, you have a series of statistics over a time period. You can set the time period with the controls above the statistics.

You cannot customize the statistics display. Not all statistics are relevant to all indicators.

**Breakdowns and elements**

You can show a separate line or column on the chart for every element of a breakdown. You can also filter the scores by selecting a breakdown and an element. You can search for breakdowns and elements by name or you can open a breakdown and element selection dialog.
Breakdown menu and search field

If you select a breakdown but not an element, the chart shows each element of the breakdown.

Chart with all elements of a breakdown

If you select a breakdown and an element, you filter the entire Analytics Hub to show only the values for that breakdown and element.
Analytics Hub filtered to show only low priority incidents

If breakdown relations are defined for the indicator, after you select a first-level breakdown and element, you can navigate to a related element. The element can be in a hierarchical relationship in the same breakdown, or it can be in another breakdown. For more information about breakdown relations including procedures for creating them, see Navigating breakdown elements with breakdown relations.
Breakdown relations

After you select a first-level breakdown and element, you can select a second-level breakdown and element.
Selecting breakdowns and elements

The following animation shows the selection and clearing of a first- and second-level breakdown and element.
Adjusting time period and selecting and clearing breakdowns and elements
You can clear either the first- or second-level breakdown and element combination by clicking the X in the tile for that breakdown/element pair. If you clear the first-level breakdown/element, the second-level breakdown/element becomes the first-level breakdown/element. You can also clear the selection by following the breadcrumbs above the score.

**Records**

You can toggle between showing a time series of scores and a list of records at the bottom of the Overview tab. Click **Show Records** or **Hide Records** in the upper right corner to toggle. In either case, the scores or records are shown for the time period that is chosen at the top of the tab. The scores or records are also filtered by any breakdown/element pairs that you selected.

**Note:**
- Records are shown only for automated indicators.
- The Show Records function is not supported for real-time scores of unmatched breakdown elements. If you are viewing scores in real time, records that are not assigned to any breakdown element are not displayed.
- You can change the view of the list of records in the context menu of the Records list, depending on the views available to the facts table. The default view is set on the indicator source.

**Chart options**

You can change what the chart displays. Click the **Show more** icon, and a toolbar of additional icons appears.
A tooltip for each icon identifies which chart option the icon turns on and off. The chart options include:

- The type of time series that is displayed.
- Displaying labels
- Displaying a forecast of future scores, depending on how forecasting is set up on the indicator.
- Displaying confidence bands
- Displaying the trend line
- Displaying comments
- Displaying thresholds
- Displaying targets
- Selecting the chart visualization

If you have the Continual Management Improvement application installed, you also have an icon to show or hide Improvement Initiatives. If you also have the sn_cim.improvement_requester role, you can create an improvement initiative by clicking the identical icon in the toolbar, as described in Analytics Hub for a specific indicator.

The available time series are:

- Year-over-year
- Change
- Change percent
- Score

Score is the default time series. All time series types except Year-over-year can be shown together. Year-over-year applies to one other graph type and one only. A full year of data is necessary to make Year-over-year meaningful.

To change the visualization used for the graph, select a visualization from the drop-down menu. Area, column, line, and spline visualizations are available.
User preferences

The Analytics Hub tracks the following user preferences:

- All display settings
- Chart visualizations
- Time period

All preferences are stored per indicator and user, so each user can configure each Analytics Hub to display as preferred.

Note: If you are upgrading from a version with scorecards instead of the Analytics Hub, the table with old user preferences is preserved. The first time a user opens the Analytics Hub for an indicator, the preferences are imported from the old table. This import is overridden if the preferences for that user and indicator are set manually in the PA Analytics Hub Preferences (pa_ds_preference) table before the user opens the Analytics Hub.

Compare scores

In the Analytics Hub Compare tab, compare scores on any two dates, or compare scores against linked benchmark scores.
Compare tab

**Note:** The Compare tab is available only for automated indicators.
You can compare the scores of an automated indicator on two dates. Date selection works the same way as in the Overview tab. Furthermore, any dates selected on one tab persist when you change to another tab.

If the scores refer to a count, below the scores, you see the following information, from left to right:

- The score on the earlier date
- The number of records that have moved out, or left the indicator since the earlier date
- The number of records that are shared by the indicator on both dates, meaning the records are in the indicator on both the earlier and later date
- The number of records that moved in, or were added to the indicator on the later date
- The number of records on the latest date

A list of records in the indicator is in the lower pane. If you are comparing dates, click the graph icon to open the Activity Stream. The Activity Stream shows, for each record, the fields most relevant to the latest activity on the record and its current state. Hovering the cursor over the timestamp of an activity reveals the Comment link. This link opens a dialog where you can leave either an Additional Comment or a Work Note.
Activity stream

If the indicator is linked to a benchmark indicator, select **Benchmarks** to compare the two indicators. Select a date range for comparing the indicators as you would in the **Overview** tab.
### Number of resolved incidents Nov 2018

<table>
<thead>
<tr>
<th>Score</th>
<th>Change</th>
<th>Sum</th>
<th>Average</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Change</th>
<th>Change %</th>
<th>Median</th>
<th>Std. dev.</th>
<th>No. of sc...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,400</td>
<td>▲ 323</td>
<td>3,623</td>
<td>1,208</td>
<td>1,077</td>
<td>1,400</td>
<td>254</td>
<td>22%</td>
<td>1,146</td>
<td>170</td>
<td>3</td>
</tr>
</tbody>
</table>

**Benchmark: Number of incidents resolved Dec 11, 2018**

<table>
<thead>
<tr>
<th>Score</th>
<th>Change</th>
<th>Sum</th>
<th>Average</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Change</th>
<th>Change %</th>
<th>Median</th>
<th>Std. dev.</th>
<th>No. of sc...</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0%</td>
<td>4,467</td>
<td>1,489</td>
<td>1,205</td>
<td>1,665</td>
<td>392</td>
<td>33%</td>
<td>1,597</td>
<td>248</td>
<td>3</td>
</tr>
</tbody>
</table>

![Graph showing trend over time](attachment:image.png)
Performance Analytics widgets

Widgets enable you to define visualizations for indicator scores. Widgets are shown on dashboards.

A Performance Analytics widget ties an indicator to a visualization, such as a trend line, a set of columns, or a pie chart. Within the widget, you can filter or group indicator scores by breakdowns. You can also apply time series functions, such as 7-day sums, to the scores.

To create or edit a Performance Analytics widget, the user must have the pa_admin or pa_power_user role. These roles are also required to add widgets to a dashboard. However, any user can view a widget that has been added to a dashboard.

Widget types and creation details

The first step in creating a widget is to select the type of widget to create. Base this decision on the business goals you are trying to achieve with the widget.

<table>
<thead>
<tr>
<th>Widget type</th>
<th>Purpose</th>
<th>Typical Visualizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Series widget</td>
<td>Shows changes over time in indicator scores.</td>
<td>Line visualization is the most usual. Other visualizations are: spline, step, column, stacked column, area, and relative compare.</td>
</tr>
<tr>
<td>Breakdown widget</td>
<td>Groups indicator scores by the elements of a breakdown.</td>
<td>Scorecard, pie and similar charts, funnel and pyramid, column and similar charts, relative compare, line, Pareto, pivot scorecard, and treemap.</td>
</tr>
<tr>
<td>Score widget</td>
<td>Shows aggregate indicator scores. Can show an indicator score against a target.</td>
<td>Latest score, speedometer, real-time score.</td>
</tr>
<tr>
<td>List widget</td>
<td>Lists the metrics for several indicators.</td>
<td>Scorecard, spider web.</td>
</tr>
<tr>
<td>Pivot widget</td>
<td>Groups the scores of one indicator by the elements of two breakdowns.</td>
<td>Heatmap</td>
</tr>
<tr>
<td>Text analytics</td>
<td>Visualizes word frequencies and groupings in the text that users enter in forms</td>
<td>Word cloud</td>
</tr>
<tr>
<td>Workbench widget</td>
<td>Shows multiple indicators and their relations, to monitor a workflow or other process.</td>
<td>Workbench</td>
</tr>
</tbody>
</table>

Role requirements for viewing widgets

For most widgets, if a viewer can view the dashboard containing the widget, they can view the widget. However, the following widgets require users to have the pa_viewer role:

- List widgets
- Text widgets
- The Breakdowns section of Workbench widgets
In addition, the ability to view the individual indicators in a List widget depends on the ACLs of those indicators.

Finally, breakdown access controls apply when viewing breakdowns in widgets.

**Time series widgets**

Time series widgets show changes in an indicator score over time. Different visualizations emphasize the trend in the scores or the scores themselves, and can display one indicator or compare several indicators.

A time series is an ordered sequence of metrics taken continuously over time. Indicator scores are measured over time at uniform intervals, which makes them an appropriate subject for time series widgets. The following business cases are some of the uses of a time series widget:

- Identifying trends, patterns, and outliers in indicator scores.
- Identifying turning points, such as whether a change in policy led to a change in indicator scores.
- Evaluating the relationships between indicators.

When you are selecting a visualization for a time series, consider whether you want to emphasize the trend in the scores or specific changes in the scores. Also consider whether you want to show one indicator or compare several related indicators.

**Note:** Some visualizations of other widget types include a time series. For example, the breakdown widget visualizations Stacked Column and Columns and Total include a time series of the indicator scores.

**Time series widget visualizations**

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visualizing trends in the scores of an indicator</td>
<td>Shows how one or more values change over time by connecting a series of data points with straight lines. Use a line visualization to emphasize the trend in the scores. Consider line visualizations to be the default choice for displaying a time series. If you are unsure of which visualization to use, use a line.</td>
</tr>
<tr>
<td>Line</td>
<td>Shows how one or more values change over time by connecting a series of data points with a fitted curve through the data points. Spline charts let you take a limited set of known data points and approximate intervening values.</td>
</tr>
<tr>
<td>Spline</td>
<td>Comparing scores in an indicator</td>
</tr>
</tbody>
</table>
Considerations when creating a time series widget
To create a time series widget that fulfills your business goal, keep several points in mind.

When you are creating a time series widget, consider the following points:

- To show a filtered set of scores in a time series widget, apply a breakdown to the widget. Only the scores that match the specified element of the breakdown will appear.
- To show aggregated scores, such as a seven-day average or a sum, apply a time series to the widget.
- To show the scores of secondary indicators over the same time line, add widget indicators to an existing widget.
• When you are selecting a visualization for a time series, consider whether you want to emphasize the trend in the scores or specific changes in the scores. Also consider whether you want to show one indicator or compare several related indicators.

Create a line visualization for a time series widget
To show the trend over time in indicator scores, create a time series widget with a line visualization.

Role required: pa_power_user or admin

Line visualization is the simplest way to show the trend over time in the scores of a single indicator. Consider it the default visualization for a time series. If you are unsure which visualization to use for a time series, use a line.

The following example is a line visualization of the number of open incidents over the month of July. The Show trend optional display setting has been enabled.

---

Line visualization - time series

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Time series.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Line.
5. In the Indicator field, select the main indicator for which you want to show scores.
6. Optional: Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in <strong>Color scheme</strong>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <a href="#">Using breakdowns on dashboards</a>. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select <strong>Follow element</strong> on this widget. You also need to select <strong>Followed breakdown</strong> and specify either the Assigned to or the Created by breakdown. This option is available only if <strong>Follow element</strong> is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Review the **Settings** tabs and change settings as desired.

8. Click **Submit**.

To view the widget, add it to a dashboard.

**Create a column visualization for a time series widget**

To emphasize the indicator scores over time instead of the trend in scores, create a time series widget with a column visualization. You can also use column visualizations to compare indicators.

Role required: pa_power_user or admin

If you want to emphasize indicator scores instead of the trend in scores over time, use a column visualization. Column visualizations are also useful for comparing the scores of several indicators. To compare indicators, add indicators to the widget, or place several widgets with column visualization next to each other in a dashboard.
To help see whether there is a correlation between two indicators, add a second indicator to the widget. For best results, select an indicator that has discreet values as the main indicator and a continuous set of data as the secondary indicator.

Column visualization examining correlation
1. Navigate to **Performance Analytics > Widgets** and click **New**.

2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Time series**.
   
   If you change the value of **Type** after you fill in other fields, those fields are cleared.

4. In the **Visualization** field, select **Column**.

5. In the **Indicator** field, select the main indicator for which you want to show scores.

6. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown.</td>
</tr>
<tr>
<td></td>
<td>Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <em>Time series aggregations in the Analytics Hub and widgets</em>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The Column visualization works well for previous period charts. Also consider setting a Color scheme. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in Color scheme.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Review the Settings tabs and change settings as desired.
8. Click Submit.

To compare your indicator to other indicators, perform one of the following actions:
- Add indicators to the Widget Indicators related list. Use the Column visualization for those indicators.
• Create widgets with **Column** visualizations for each of the other indicators. Place these widgets next to each other in a dashboard.

To view the widget, add it to a dashboard.

*Create an area visualization for a time series widget*

To examine the contribution of one or more indicators to a summing indicator, create a time series widget with an area visualization.

**Role required: pa_power_user or admin**

If you want to examine the contribution of one or more indicators to a more inclusive indicator, use an area visualization. An area visualization can emphasize the relative contribution of one or more component indicators to the total trend. At the same time, you can still see the individual trends. Compare to the Stacked Column visualization, which sums the indicator scores and emphasizes the contribution of each score to the sum.

![Area visualization - time series](image)

**Area visualization - time series**

1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Time series**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Area**.
5. In the **Indicator** field, select the main indicator for which you want to show scores.
6. Optional: Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in <strong>Color scheme</strong>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Review the Settings tabs and change settings as desired.

8. Click Submit.

- To compare your selected indicator with other indicators, add indicators to the Widget Indicators related list. Select the Area visualization for those indicators.
- To view the widget, add it to a dashboard.

**Create a spline visualization for a time series widget**

To show the trend over time in indicator scores when you need to apply curve fitting, create a time series widget with a spline visualization.

Role required: pa_power_user or admin

A spline visualization replaces the straight line of a line visualization with a curve. As with a line visualization, use a spline visualization to show the trend over time in the indicator scores. Use a spline instead of a line when you need to fit a curve to your indicator scores.

In the following example, the trend line and 95% confidence interval is shown with a spline visualization of the number of open incidents.
1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Time series**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Spline**.
5. In the **Indicator** field, select the main indicator for which you want to show scores.
6. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The Column visualization works well for previous period charts. Also consider setting a Color scheme. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in Color scheme.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Review the Settings tabs and change settings as desired.
8. Click Submit.

To view the widget, add it to a dashboard.
Create a step visualization for a time series widget
To emphasize changes in indicator scores between discreet points in time, create a time series widget with a step visualization.

Role required: pa_power_user or admin

Consider using a step visualization in the following circumstances:

- You want to emphasize the change in an indicator score between specific points in time, instead of the trend over time.
- The changes in indicator scores are too small to be easily seen in a line visualization.

The use case for a step visualization is the opposite of the use case for the spline visualization. Use a spline to emphasize a trend or the fuzziness of your data over time.

Step visualization - time series

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Time series.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Step.
5. In the Indicator field, select the main indicator for which you want to show scores.
6. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown.  Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <em>Time series aggregations in the Analytics Hub and widgets</em>.</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in <strong>Color scheme</strong>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see <em>Create a color scheme for widget visualizations</em>.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <em>Using breakdowns on dashboards</em>. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow.</td>
</tr>
<tr>
<td></td>
<td>For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Review the Settings tabs and change settings as desired.

8. Click Submit.

To view the widget, add it to a dashboard.

*Create a stacked column visualization for a time series widget*

To compare and sum the scores of several indicators, create a widget as a time series with a stacked column visualization.

Role required: pa_power_user or admin

To show the sum of scores of several indicators over time, and to show the relative contribution of each indicator to the sum, use a stacked column visualization.

In the following example, indicators for each regional sales center are stacked in columns to show both the total sales and the relative contribution of each region.
Stacked column visualization - time series

1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Time series**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Stacked Column**.
5. In the **Indicator** field, select the main indicator for which you want to show scores.
6. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Previous period chart</td>
<td>Compares the scores of the main indicator in similar periods. The <strong>Column</strong> visualization works well for previous period charts. Also consider setting a <strong>Color scheme</strong>. Activating Previous Period Chart disables any secondary Widget Indicators.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies a custom label for the main indicator.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for the main indicator. This field overrides any color selected in <strong>Color scheme</strong>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all indicators. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see <strong>Create a color scheme for widget visualizations</strong>.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <strong>Using breakdowns on dashboards</strong>. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select <strong>Follow element</strong> on this widget. You also need to select <strong>Followed breakdown</strong> and specify either the Assigned to or the Created by breakdown. This option is available only if <strong>Follow element</strong> is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Review the **Settings** tabs and change settings as desired.
8. Right-click the form header and select **Save**.
9. Add additional indicators in the Widget Indicators related list, giving each indicator the **Stacked Column** visualization.

To view the widget, add it to a dashboard.
Create a relative compare visualization for a time series widget

To show how the relative proportions of several indicators change over time, use a relative compare visualization for a time series.

Role required: pa_power_user or admin

Like a pie chart, a relative compare visualization shows relative proportions between data points, but it can also show how those proportions change over time. Traditional uses of relative compare visualizations are stock charts or population growth trends. When you create a relative compare visualization, it uses a baseline of zero and then shows how the data changes over time.

For example, this visualization shows the change of the total number of open incidents compared to the change in the number of open incidents that were not updated for 5 or more days. When you point to a line, the number of incidents and the percentage change for that day appear. The percentage change shown for a data point is calculated from a baseline of zero, not the previous data point as on most other time series visualizations.

Example of a relative compare visualization for a time series

1. Navigate to Performance Analytics > Widgets.
2. Click New.
3. From the Type list, select Times Series.
4. From the Visualization list, select Relative Compare.
5. Specify which indicators to include in the visualization with one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator group</td>
<td>If you select an indicator group, you cannot select a single indicator.</td>
</tr>
</tbody>
</table>
Option | Note
---|---
Indicator | If you select a single indicator, you must manually add additional indicators in the Widget Indicators related list.

6. Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
</tbody>
</table>

7. Right-click the form header and select Save.

8. If you selected a single indicator, add additional indicators in the Widget Indicators related list.

If you selected an indicator group, additional indicators are optional.

9. Select the Show date range selector check box on the Date Settings tab.

This setting lets users dynamically change the amount of time displayed in the visualization.

10. Fill in the other fields, as appropriate.

11. Click Update.

To view the widget, add it to a dashboard.

Optional settings for time series widgets

Time series widgets have the following optional settings for display, for the date range, and for the axis labels.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Settings</td>
<td>The date settings are available only if Previous period chart is not selected.</td>
</tr>
<tr>
<td>Period</td>
<td>Select the date range to display in the widget. Several options are available.</td>
</tr>
<tr>
<td></td>
<td>• Select a specific time range. The default is 3m (3 months).</td>
</tr>
<tr>
<td></td>
<td>• Select max to use scores up to the current date.</td>
</tr>
<tr>
<td></td>
<td>• Select between and then fill in the From and To fields to define a time period.</td>
</tr>
</tbody>
</table>

The Period field is available only if you select Line, Spline, Column, Area, Step, Stacked Column, or Relative Compare as the Visualization.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show date range selector</td>
<td>Display a date range selector on the widget that enables users to change the selected period when viewing the widget on a dashboard.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Selecting a date range on a widget does not update the trend line.</td>
</tr>
<tr>
<td>Axis Settings</td>
<td></td>
</tr>
<tr>
<td>Y-axis title</td>
<td>Specify a title to display on the vertical axis of the chart.</td>
</tr>
<tr>
<td>Y-axis from</td>
<td>Specify the starting point for the range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>Y-axis to</td>
<td>Specify the ending point for the range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>2nd Y-axis title</td>
<td>Specify a secondary title to display on the vertical axis of the chart.</td>
</tr>
<tr>
<td>2nd Y-axis from</td>
<td>Specify the starting point for a 2nd range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td></td>
<td>The 2nd Y-axis can be used if scores normally move between a limited range, but you have some exceptions that would otherwise distort the chart, such as a range of 40 to 60, with an exception of 1000.</td>
</tr>
<tr>
<td>2nd Y-axis to</td>
<td>Specify the ending point for a 2nd range of values for the vertical axis of the chart.</td>
</tr>
<tr>
<td>Display Settings</td>
<td></td>
</tr>
<tr>
<td>Show target</td>
<td>Display the target score, if defined. This field appears only if Previous period chart is not selected.</td>
</tr>
<tr>
<td>Show thresholds</td>
<td>Display thresholds such as an all time high or an all time low. Thresholds appear only if they have been defined for this indicator.</td>
</tr>
<tr>
<td>Show data labels</td>
<td>Display the score for each data point, such as each slice of a pie chart.</td>
</tr>
<tr>
<td>Show trend</td>
<td>Display the trend line. This field appears only if Previous period chart is not selected.</td>
</tr>
<tr>
<td>Show confidence bands</td>
<td>Display confidence bands in this chart. For information about how the confidence band is calculated, see Widget confidence bands.</td>
</tr>
<tr>
<td>Show forecast</td>
<td>Display forecast data in the chart based on current trend data. Forecasting must be configured on the indicator.</td>
</tr>
<tr>
<td>Show forecast range</td>
<td>Display the 95% confidence interval of the forecast. Available only when Select forecast is enabled.</td>
</tr>
<tr>
<td>Show comments</td>
<td>Display comments added to data points in the chart.</td>
</tr>
<tr>
<td>Previous Period Settings</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Previous period settings are available only if Previous period chart is selected.</td>
<td></td>
</tr>
<tr>
<td>Range of periods</td>
<td>Select the range of periods to compare with the current period.</td>
</tr>
<tr>
<td>Number of periods</td>
<td>Specify the number of previous periods to display.</td>
</tr>
</tbody>
</table>

Widget confidence bands

The visible points of the trend line are used to calculate the confidence band. If you increase the date range, the bands are recalculated using the trend for the new date range.

First, the confidence bands are calculated using the standard error of the trend. The width of the band depends on the number of points that are included in the calculation and the mean of the scores. If the standard error is low, the trend line is shown to be accurate. As the number of points decreases, or outliers are recorded, the confidence band widens. The confidence of the trend is less certain with fewer data points or with volatile scores.

Score widgets

Score widgets show aggregate indicator scores.

Score widget visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Latest score</td>
<td>Shows a single indicator score and the change in that score compared to a previous period. A line representing the time series of scores appears in the background.</td>
</tr>
<tr>
<td>Speedometer</td>
<td>Shows the most recently collected score of an indicator in the form of a round meter. The indicator target and its color scheme are shown on the dial.</td>
</tr>
<tr>
<td>Dial</td>
<td>Shows an overview of the most recently collected score of an indicator in a half circle.</td>
</tr>
<tr>
<td>Real-time score</td>
<td>Shows the current indicator score and the change in that score compared to the score at the last scheduled collection. A line representing the time series of scores appears in the background.</td>
</tr>
</tbody>
</table>

Create a latest score visualization for a score widget

To see the change between the latest score and a previous score, use a latest score visualization in a score widget. You can also show a trend line of scores.

Role required: pa_power_user or admin

A latest score visualization shows the latest score and both the absolute and percentage change between this score and a previous score. This visualization is similar to a Chart view in an Analytics
Hub. You can choose how many scores back to compare to the latest score. You can also display a trend line of absolute or percentage changes in scores.

![Latest score visualization](image)

**Latest score visualization**

1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Score**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Latest score**.
5. In the **Indicator** field, select the indicator for which you want to show scores.
6. Optional: Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
</tbody>
</table>

7. Optional: Select a template.

<table>
<thead>
<tr>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template 1</td>
<td>Line shows absolute change in score.</td>
</tr>
<tr>
<td>Template 2</td>
<td>Line shows percentage change in score.</td>
</tr>
<tr>
<td>Template 3</td>
<td>Line is not displayed.</td>
</tr>
</tbody>
</table>

*Formula indicators* that return a percentage value use Template 2 by default. Other indicators use Template 1 by default.

8. Optional: Select which previous score to compare against the latest score in the Compare score with field in the Latest Score Settings tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous score</td>
<td>The score from the previous data collection. This setting is the default.</td>
</tr>
<tr>
<td>Periods back</td>
<td>Specify the number of data collection periods back from which you want the score to compare against the latest score.</td>
</tr>
</tbody>
</table>
9. Click **Submit**.

To view the widget, add it to a dashboard.

Create a speedometer or a dial visualization for a score widget

To show the latest score of an indicator compared to the range of scores, use a speedometer or dial visualization in a score widget. A speedometer also shows the indicator target.

Role required: `pa_power_user` or `admin`

A speedometer visualization shows the latest score with a needle on a speedometer. A dial visualization shows the latest score with a colored section of a half-circle. By default, the speedometer or dial shows the range of possible scores, but you can create your own range.

The speedometer is particularly useful when a target is set on the indicator. If a direction is set on the indicator (minimize or maximize), the visualization reproduces the target and the 3- or 5-color traffic light set on the indicator. For example, the following speedometer shows the Average age open incidents indicator with a Minimize direction, a target of 10, and a 3-color traffic light.

![Average age open incidents](image)

**Speedometer visualization - score widget**

The dial visualization does not show the indicator target.
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Score.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Speedometer or Dial.
5. In the Indicator field, select the indicator for which you want to show scores.
6. Optional: Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <a href="#">Using breakdowns on dashboards</a>. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select <strong>Follow element</strong> on this widget. You also need to select <strong>Followed breakdown</strong> and specify either the Assigned to or the Created by breakdown. This option is available only if <strong>Follow element</strong> is selected.</td>
</tr>
</tbody>
</table>

7. Optional: In the **Speedometer/Dial Settings** tab, either select **Auto scale**, which shows the range of actual scores on the speedometer, or specify another scale.

8. Click **Submit**.

To view the widget, add it to a dashboard.

**Create a real-time score visualization for a score widget**

To see the current score, use a real-time score visualization in a score widget. You can also show a trend line of scores.

- The indicator for which you want the real-time scores must have the **Show real-time score** property enabled.
- Role required: **pa_power_user** or **admin**

A real-time score visualization shows the current score and both the absolute and percentage change between this score and the score at the last previous scheduled data collection. This visualization is similar to a **Chart** view in an Analytics Hub. You can also show a trend line of absolute or percentage changes in scores.

⚠️ **Warning:** If the widget has too many data elements, it cannot update in real time. In this case, a warning appears that instructs the viewer to refresh the widget manually.
Real-time score visualization

1. Navigate to **Performance Analytics > Widgets**.
2. Click **New**.
3. In the **Name** field, give the widget a name that reflects the information being displayed.
4. In the **Type** field, select **Score**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
5. In the **Visualization** field, select **Real-time score**.
6. In the **Indicator** field, select the indicator for which you want to show scores.
7. Optional: Fill in any of the following optional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
</tbody>
</table>
### Follow element

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
</tbody>
</table>

**Followed breakdown**

Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow.

For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select **Follow element** on this widget. You also need to select **Followed breakdown** and specify either the Assigned to or the Created by breakdown.

This option is available only if **Follow element** is selected.

---

8. Optional: Select a template.

<table>
<thead>
<tr>
<th>Template name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template 1</td>
<td>Line shows absolute change in score.</td>
</tr>
<tr>
<td>Template 2</td>
<td>Line shows percentage change in score.</td>
</tr>
<tr>
<td>Template 3</td>
<td>Line is not displayed.</td>
</tr>
</tbody>
</table>

Real-time score visualizations use Template 2 by default.

9. Click **Submit**.

To view the widget, add it to a dashboard.

**List widgets**

List widgets show the scores of multiple indicators.
List widget visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scorecard     | For several indicators, shows any of the following attributes:  
|               | · Scores at several points in time  
|               | · Changes between the last two scores  
|               | · % Change  
|               | · Trends  
|               | · Bullet charts |
| Spider        | Shows a plot of the latest score of each indicator on its own axis, starting with 0 at the center. |

Permission to view indicators

The pa_viewer role is required to view List widgets. Furthermore, List widgets do not show indicators that you do not have permission to read. This behavior is unlike other Performance Analytics widgets, which inherit view ACLs from the dashboards to which they have been added. While the dashboard permission applies to the Performance Analytics list widget as a whole, individual indicators in that list follow the permissions for that indicator.

Create a scorecard visualization in a list widget
To list the metrics of several indicators, use a scorecard visualization in a list widget.

Role required: pa_power_user or admin

Use this visualization to help compare several similar indicators regarding their scores, the trend in their scores, and their compliance with targets.
1. Navigate to Performance Analytics > Widgets.
2. Click New.
3. In the Name field, give the widget a name that reflects the information being displayed.
4. In the Type field, select List.
   If you change the value of Type after you fill in other fields, those fields are cleared.
5. In the Visualization field, select Scorecard.
6. Select indicators in one of the following ways:
   - Select a group in the Indicator Group field.
   - Click Save, then add widget indicators as described in Add widget indicators.
7. Optional: To aggregate the widget data for a specific time period, such as applying a 7-day sum or average, select a function in the Time series field.
8. Optional: The following options apply only when the widget is included in a ‘breakdown dashboard’:
   - Select Follow element for the widget to follow the element that the user selects interactively on the dashboard.
   - Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Select Follow breakdown to set which of the possible breakdowns to follow.
   For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select
Follow element on this widget. You also select Follow breakdown and specify either the
Assigned to or the Created by breakdown.

For more information, see Using breakdowns on dashboards.

9. Optional: Select the attribute on which to sort the data in the Sort on field.
10. Select the scores and metrics to show in the Column Settings tab.

<table>
<thead>
<tr>
<th>Column setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current score</td>
<td>Show the score from the latest data collection. Selected by default.</td>
</tr>
<tr>
<td>Trend</td>
<td>Shows the direction that the indicator is moving. The trend is shown in a mini-chart on the dashboard. Selected by default.</td>
</tr>
<tr>
<td>Bullet chart</td>
<td>Show a graphic that shows how close the latest score is to the latest target score. The graphic only appears if the indicator has a defined target.</td>
</tr>
<tr>
<td>Multiple scores</td>
<td>Shows the number of scores that are defined in the Number of periods field, which appears when Multiple scores is selected. If Current Score is also selected, the most recent period is labeled Score. Otherwise, the most recent period is labeled with the date.</td>
</tr>
<tr>
<td>Number of periods</td>
<td>Select the number of additional periods to include in the widget.</td>
</tr>
<tr>
<td>Period step</td>
<td>If the Number of periods &gt; 1, select the length of each period. The unit is based on the frequency of the first indicator.</td>
</tr>
</tbody>
</table>

**Note:** Including indicators with different frequencies, such as daily or weekly, may result in different numbers of periods per indicator. For example, if the first indicator has a daily frequency, and another indicator has a weekly frequency, the daily indicator shows 7 scores for every 1 score of the weekly indicator.

<table>
<thead>
<tr>
<th>Column setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change</td>
<td>Shows the change in value from the previous score.</td>
</tr>
<tr>
<td>Change %</td>
<td>Shows the percentage change from the previous score.</td>
</tr>
<tr>
<td>Target</td>
<td>Shows the target for the indicator. A value appears only if the indicator has a defined target. The target and current score are shown graphically in the Bullet chart.</td>
</tr>
<tr>
<td>Column setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Gap</td>
<td>Shows the difference between the current score and the target. For indicators with a Maximize direction, the gap calculation is Score–Target. For indicators with a Minimize direction, the calculation is Target–Score. Thus a positive value is always good, and a negative value is always bad. A value appears only if the indicator has a defined target.</td>
</tr>
<tr>
<td>Gap %</td>
<td>Shows the percentage difference between the current and target scores. As with Gap, a positive Gap % is always good, and a negative Gap % is always bad, regardless of the direction of the indicator. A value appears only if the indicator has a defined target.</td>
</tr>
</tbody>
</table>

11. Optional: Filter which indicators to show in the List Settings tab.

<table>
<thead>
<tr>
<th>List setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard options</td>
<td>Select All indicators, indicators marked Key, or Favorite indicators to show only those indicators on the dashboard.</td>
</tr>
<tr>
<td>Page size</td>
<td>Select the number of rows to show on the list scorecard.</td>
</tr>
<tr>
<td>Filter</td>
<td>Filter the scorecard list for Best Performing, Worst Performing, Improved, Declined, or Deteriorated. Only indicator scores that match the filter are shown.</td>
</tr>
</tbody>
</table>

12. Click Submit or Update.

To view the widget, add it to a dashboard.

Create a spider visualization in a list widget

To plot the scores of several indicators, use a spider visualization in a list widget.

Role required: pa_power_user or admin

Use this visualization to help compare the scores of several similar indicators.

Note: You can compare a maximum of ten indicators in a spider visualization.
1. Navigate to Performance Analytics > Widgets.
2. Click New.
3. In the Name field, give the widget a name that reflects the information being displayed.
4. In the Type field, select List.
   If you change the value of Type after you fill in other fields, those fields are cleared.
5. In the Visualization field, select Spider.
6. Select indicators in one of the following ways:
   - Select a group in the Indicator Group field.
   - Click Save, then add widget indicators as described in Add widget indicators.
7. Optional: To aggregate the widget data for a specific time period, such as applying a 7-day sum or average, select a function in the **Time series** field.

8. Optional: The following options apply only when the widget is included in a ‘breakdown dashboard’:
   a) Select **Follow element** for the widget to follow the element that the user selects interactively on the dashboard.
   b) Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Select **Follow breakdown** to set which of the possible breakdowns to follow.
   
   For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select **Follow element** on this widget. You also need to select **Follow breakdown** and specify either the Assigned to or the Created by breakdown.

   For more information, see [Using breakdowns on dashboards](#).

9. Optional: Select the attribute on which to sort the data in the **Sort on** field.

10. Optional: Filter which indicators to display in the **List Settings** tab.

<table>
<thead>
<tr>
<th>List setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator options</td>
<td>Select <strong>All</strong> indicators, indicators marked <strong>Key</strong>, or <strong>Favorite</strong> indicators.</td>
</tr>
<tr>
<td>Page size</td>
<td>Select the number of rows to show on the indicator list.</td>
</tr>
</tbody>
</table>

11. Click **Submit** or **Update**.

   To view the widget, add it to a dashboard.

**Breakdown widgets**

Breakdown widgets show indicator scores grouped by breakdown elements. Different visualizations can be used to compare the relative proportion of breakdown elements or the trends in these proportions.

When you are selecting a visualization for a breakdown widget, consider whether you want to compare the trends or the relative proportions of the breakdown elements. Also consider whether you want to show one indicator or compare several related indicators, and whether you want to show one or two breakdowns.

**Breakdown widget visualizations**

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scorecard</td>
<td>Shows the trends for one breakdown for a single indicator.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong></td>
<td>Enables a comparison between the relative proportion of breakdown elements by displaying them as proportional vertical columns. Use when a pie, funnel, or other such visualization is not appropriate.</td>
</tr>
<tr>
<td><strong>Pie</strong></td>
<td>Enables a comparison between the relative proportion of breakdown elements by using a circle to represent the whole.</td>
</tr>
<tr>
<td><strong>Donut</strong></td>
<td>Enables a comparison between the relative proportion of breakdown elements by using a donut shape to represent the whole.</td>
</tr>
<tr>
<td><strong>Semi-donut</strong></td>
<td>Enables a comparison between the relative proportion of breakdown elements by using a semi-donut shape to represent the whole. A semi-donut chart uses a donut sliced in half to represent the whole.</td>
</tr>
<tr>
<td><strong>Funnel</strong></td>
<td>Enables a comparison between the relative proportion of breakdown elements by displaying values as progressively decreasing proportions. The size of each section reflects a percentage of the total of all values.</td>
</tr>
<tr>
<td><strong>Pyramid</strong></td>
<td>Enables a comparison between the relative proportion of breakdown elements by displaying values as progressively increasing proportions. The size of each section reflects a percentage of the total of all values.</td>
</tr>
</tbody>
</table>

Visualizing both the trend in scores and the relative proportions of elements of a breakdown

<p>| <strong>Stacked Column</strong> | Combines time series and breakdown widget functions. The X-axis is a time line and the visualization shows the development of indicator scores over time. Also, each column is divided into a stack of slices according to the elements of a breakdown. Thus the visualization shows the relative proportion of breakdown elements over time. |</p>
<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column and total</strong></td>
<td>Shows both the relative proportion of breakdown elements and the trend in the indicator score. Shows a separate column for each breakdown value and a line representing the total for all values, over time.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Shows changes over time in the relative proportion of breakdown elements for an indicator by connecting a series of data points with straight lines.</td>
</tr>
<tr>
<td><strong>Relative Compare</strong></td>
<td>Shows how multiple breakdowns diverge over time.</td>
</tr>
</tbody>
</table>

Other visualizations

<table>
<thead>
<tr>
<th>Visualization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pareto</strong></td>
<td>Combines column and line visualizations to identify the most important factors in a large set of factors.</td>
</tr>
<tr>
<td><strong>Pivot scorecard</strong></td>
<td>Enables you to compare the breakdown elements for one breakdown applied to several indicators. The Y-axis can be the indicators or the breakdown elements.</td>
</tr>
<tr>
<td><strong>Treemap</strong></td>
<td>Shows a treelike display of nested rectangles with a color gradient to signify positive to negative scores or trends in scores.</td>
</tr>
</tbody>
</table>

**Grouping by breakdown and filtering by breakdown**

In breakdown widgets, breakdowns either group or filter indicator scores. When you create a widget, this dual purpose of breakdowns affects the function of the breakdown fields.

The **Breakdown** and **2nd Breakdown** fields in the widget form have a different function for breakdown widgets than for other widget types. In most other widget types, these fields specify data filters. Only the indicator scores that correspond to the specified breakdown elements are shown. However, when you create a breakdown widget, you group the data by a breakdown instead of filtering it. The elements of the breakdown are shown as the different wedges of a pie visualization, or separate columns in a column visualization, for example.

You can still filter the data by specifying a breakdown and an element in the **Breakdown** and **Element** fields. However, in this case you must specify the breakdown that is used to group the
data in the 2nd Breakdown field. If you do not specify a 2nd Breakdown, the Element field is ignored and the first Breakdown is used to group indicator scores instead of filtering them.

*Interacting with breakdown widgets on dashboards*

Performance Analytics users can interact with individual breakdown widgets on dashboards to change the visualization or breakdown.

Widgets with the **Type** of Breakdown enable users with the **pa_viewer** role to select the visualization when viewing the widget on a dashboard. Users can select any visualization for the widget type from the Visualization choice list when viewing the widget on a dashboard.

**Note:** You cannot select the **Pivot Scorecard** visualization from a dashboard. To use this visualization, configure the widget record.

Breakdown widgets also enable users to select the breakdown when multiple breakdowns are available. All available breakdowns for the widget **Indicator** appear in the Breakdown choice list when viewing the widget on a dashboard. If the indicator has only one associated breakdown, the Breakdown choice list does not appear on the widget.

**Note:** If the widget is added to a breakdown dashboard and the user selects the same breakdown on the widget and on the dashboard, the dashboard breakdown is ignored. However, when the user selects any other combination of widget and dashboard breakdowns, both breakdowns apply.

By default, the interactive breakdown applies as the 1st-level breakdown. However, if the widget is on a breakdown dashboard and **Follow element** is selected on the Widget form, the interactive breakdown applies as the 2nd-level breakdown. (**Collect breakdown matrix** must be set on the indicator for 2nd-level breakdowns to apply.) Any breakdown that is set on a dashboard that contains the widget applies as the 1st-level breakdown.

You can disable this functionality for a specific widget by clearing the **Show visualization selector** or **Show breakdown selector** check boxes on the Widgets form.

The visualization or breakdown selected in the widget record is used as the default.

Create a scorecard visualization for a breakdown widget

To show the trend for the elements of one breakdown applied to one indicator, use a scorecard visualization.

**Role required:** **pa_power_user** or **admin**

Scorecard visualizations show the trends by element for one breakdown applied to one indicator. This visualization is the equivalent of the **Breakdowns** tab of a Scorecard.
Open incidents by Priority

<table>
<thead>
<tr>
<th>Name</th>
<th>Aug 06</th>
<th>Change</th>
<th>Trend</th>
<th>Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>5 - Planning</em></td>
<td>73</td>
<td>-1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*4 - Low</td>
<td>76</td>
<td>-10</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>3 - Moderate</em></td>
<td>23</td>
<td>-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*2 - High</td>
<td>4</td>
<td>0</td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>1 - Critical</em></td>
<td>4</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Scorecard visualization - breakdown

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Scorecard.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
   To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow breakdown relation</td>
<td>Applies only when this widget is placed in a breakdown dashboard. The widget displays only the breakdown elements that follow the specified breakdown relation. A related breakdown element must be selected on the breakdown dashboard. Otherwise, the widget does not display any data. For a detailed example, see Showing breakdown relations in <a href="#">Using breakdowns on dashboards</a>. You can specify only <strong>Follow breakdown relation</strong> or <strong>Follow breakdown</strong>. You can allow the viewer to see the breakdown relation in visualizations other than Analytics Hub by selecting <strong>Show visualization selector</strong>. However, since only the breakdown in the relation is displayed, do not select <strong>Show breakdown selector</strong>.</td>
</tr>
</tbody>
</table>

9. Optional: Review the Settings tabs and change settings as desired.

10. Click Submit.

To view the widget, add it to a dashboard.

*Create a pie, donut, or semi-donut visualization for a breakdown widget*

To show the relative proportions of the elements of a breakdown, use a pie, donut, or semi-donut visualization.

**Role required: pa_power_user or admin**

When you need to compare the percentages or relative proportions of breakdown elements, you can use a pie, a donut, or a semi-donut visualization. Consider trying all three to see which works best for a particular widget.

These visualizations can be unclear in the following cases:

- The breakdown has many elements.
- Several elements in the breakdown are much smaller than the others.

In these cases, or to compare scores instead of proportions, consider using a column visualization.
Pie, donut, and semi-donut visualizations

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Pie, Donut, or Semi donut.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
   To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

   You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Optional: Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td><strong>Note:</strong> The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the <strong>Sort on</strong> setting is ignored.</td>
<td></td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <a href="#">Using breakdowns on dashboards</a>. Selecting this option removes the ability to set a filtering option on the widget. Only one <strong>Breakdown</strong> field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow.</td>
</tr>
<tr>
<td></td>
<td>For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select <strong>Follow element</strong> on this widget. You also need to select <strong>Followed breakdown</strong> and specify either the Assigned to or the Created by breakdown.</td>
</tr>
<tr>
<td></td>
<td>This option is available only if <strong>Follow element</strong> is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown visualizations in other visualizations by selecting <strong>Show visualization selector</strong>. For more information about selecting a breakdown relation, see <a href="#">Create a scorecard visualization for a breakdown widget</a>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
</tbody>
</table>

9. Optional: Review the **Settings** tabs and change settings as desired.

10. Click **Submit**.

To view the widget, add it to a dashboard.

*Create a pyramid or a funnel visualization for a breakdown widget*

To show the relative proportions of the elements of a breakdown, particularly when the elements represent stages in a process, use a pyramid or funnel visualization.
Role required: pa_power_user or admin

When you need to compare the percentages or relative proportions of breakdown elements, consider using a funnel or pyramid visualization instead of a pie visualization. Funnel and pyramid visualizations are particularly appropriate when the elements of a breakdown represent stages in a process, such as going from lead to closed deal in a sales process.

Funnel charts stack slices from top to bottom by decreasing percentage and pyramid charts stack slices by increasing percentage. Pyramid charts are often used to represent hierarchical levels in an organization.

In the following examples, open incidents are displayed according to the stages that the incidents are in.
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown. If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Pyramid or Funnel. You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields. To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.

<table>
<thead>
<tr>
<th>Follow element</th>
<th>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown elements in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see Create a scorecard visualization for a breakdown widget.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. Optional: Review the **Settings** tabs and change settings as desired.

10. Click **Submit**.

To view the widget, add it to a dashboard.

**Create a column visualization for a breakdown widget**

To compare the elements of one breakdown applied to one indicator, use a column visualization.

Role required: pa_power_user or admin

If you want to compare the relative proportion of indicator scores by breakdown elements, and a pie visualization is not appropriate, use a column visualization. Column visualizations are clearer when there are many elements, when several elements are much smaller than others, or when several elements are close to each other in value.
Column visualization - breakdown

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Column.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields. To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.

8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
</tbody>
</table>

Note: The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.

<table>
<thead>
<tr>
<th>Follow element</th>
<th>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Followed breakdown</th>
<th>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Followed breakdown relation</th>
<th>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown elements in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see Create a scorecard visualization for a breakdown widget.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Color scheme</th>
<th>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</th>
</tr>
</thead>
</table>

9. Optional: Review the Settings tabs and change settings as desired.
10. Click Submit.

To view the widget, add it to a dashboard.

Create a Pareto visualization for a breakdown widget
To identify the most important breakdown elements when the breakdown has a large set of elements, use a Pareto visualization.

Role required: pa_power_user or admin

Pareto visualizations contain both bar and line graphs. The bars display the data in descending order from left to right, and the line graph shows the cumulative totals from each category in the same order. The left Y axis is the record count, and the right Y axis is the cumulative percentage.
of the total number of records evaluated. The data to the left of the intersection of the line graph and the 80% mark have the greatest effect on the overall outcome.

Pareto visualization - breakdown

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Pareto.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
   To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Note: The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
<td></td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown elements in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see Create a scorecard visualization for a breakdown widget.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. Optional: Review the Settings tabs and change settings as desired.

10. Click Submit.

To view the widget, add it to a dashboard.

Create a line visualization for a breakdown widget
To follow changes over time in the relative proportion of breakdown elements for an indicator, use a line visualization in a breakdown widget.

Role required: pa_power_user or admin

A line visualization in a breakdown widget shows how the proportion of indicator scores belonging to different breakdown elements changes over time. To select the time period over which changes are tracked, go to the Date Settings tab.
1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Line.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
   To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown elements in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see Create a scorecard visualization for a breakdown widget.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

9. Optional: Review the **Settings** tabs and change settings as desired.
10. Click **Submit**.

To view the widget, add it to a dashboard.

*Create a columns and total visualization for a breakdown widget*

To follow changes over time in both the scores of an indicator and the relative proportion of breakdown elements for that indicator, use a Columns and Total visualization in a breakdown widget.

Role required: pa_power_user or admin

This visualization combines a time series and a breakdown widget. A classic time series with a line visualization is shown for the indicator scores. This line is combined with a column visualization of...
the breakdown for each point in time at which indicator scores were collected. Use this widget to explore relationships between the indicator score and the relative proportion of breakdown elements for that indicator.

Columns and total visualization

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Columns and Total.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
   To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Optional: Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <a href="#">Using breakdowns on dashboards</a>.</td>
</tr>
<tr>
<td></td>
<td>Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow.</td>
</tr>
<tr>
<td></td>
<td>For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown.</td>
</tr>
<tr>
<td></td>
<td>This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown elements in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see <a href="#">Create a scorecard visualization for a breakdown widget</a>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
</tbody>
</table>

9. Optional: Review the Settings tabs and change settings as desired.
10. Click Submit.

To view the widget, add it to a dashboard.

*Create a stacked column visualization for a breakdown widget*

To follow changes over time in the relative proportion of breakdown elements for an indicator, use a stacked column visualization in a breakdown widget.
Role required: pa_power_user or admin

This visualization shows the relative proportion of breakdown elements in a single column, and shows a column for every point in time that indicator scores are collected. To select the time period over which changes are tracked, go to the Date Settings tab.

Stacked column visualization - breakdown

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Stacked Column.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
   To use a breakdown to filter the data, you must specify an element.
7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

   You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.
8. Optional: Fill in any of the following fields:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <a href="#">Using breakdowns on dashboards</a>.</td>
</tr>
<tr>
<td></td>
<td>Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown visualizations in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see <a href="#">Create a scorecard visualization for a breakdown widget</a>.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see <a href="#">Create a color scheme for widget visualizations</a>.</td>
</tr>
</tbody>
</table>

9. Optional: Review the **Settings** tabs and change settings as desired.
10. Click **Submit**.

To view the widget, add it to a dashboard.

Create a relative compare visualization for a breakdown widget
To show how the relative proportions of several indicators change over time, use a relative compare visualization for a time series.
Role required: pa_power_user or admin

Like a pie chart, a relative compare visualization shows relative proportions between data points, but it can also show how those proportions change over time. Traditional uses of relative compare visualizations are stock charts or population growth trends. When you create a relative compare visualization, it uses a baseline of zero and then shows how the data changes over time.

For example, this visualization shows the number of open incidents from December to March for three different incident types. When you point to a line, the number of incidents and the percentage change for that day appear. The percentage change shown for a data point is calculated from a baseline of zero, not the previous data point as on most other time series visualizations.

Example of a relative compare visualization

1. Navigate to Performance Analytics > Widgets and click New.
2. In the Name field, give the widget a name that reflects the information being displayed.
3. In the Type field, select Breakdown.
   If you change the value of Type after you fill in other fields, those fields are cleared.
4. In the Visualization field, select Relative Compare.
   You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.
5. In the Indicator field, select the main indicator which you want to break down.
6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.
To use a breakdown to filter the data, you must specify an element.

7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.

8. In the Date Settings tab, select Show date range indicator.

9. Review the Settings tabs and adjust other settings as desired.

10. Click Submit.

To view the widget, add it to a dashboard.

Create a pivot scorecard visualization for a breakdown widget

To compare the relative proportions of breakdown elements between a number of indicators, use a pivot scorecard visualization in a breakdown widget.

Role required: pa_power_user or admin

If you want to see the same breakdown applied to more than one indicator in the same widget, use a pivot scorecard. You can pivot the scorecard so that the axes for breakdown elements and for indicators are reversed.

<table>
<thead>
<tr>
<th>Priority of all open incidents</th>
<th>1 - Critical</th>
<th>2 - High</th>
<th>3 - Moderate</th>
<th>4 - Low</th>
<th>5 - Planning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of open incidents</td>
<td>4</td>
<td>4</td>
<td>23</td>
<td>43</td>
<td>71</td>
</tr>
<tr>
<td>Number of open incidents not updated in last 5 days</td>
<td>2</td>
<td>0</td>
<td>5</td>
<td>0</td>
<td>10</td>
</tr>
<tr>
<td>Number of open incidents not updated in last 30 days</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
</tbody>
</table>

Pivot scorecard - breakdown
Pivot scorecard with the breakdown on the Y-axis

1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Breakdown**.
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Pivot Scorecard**.
5. In the **Pivot breakdown** field, select the breakdown whose elements you want to see across several indicators.
6. Click **Save**.
   The **Indicators** related list appears at the bottom of the form.
7. In the **Indicators** related list, click **New**.
8. In the slushbucket that appears, select the indicators that you want to compare breakdown elements between.
9. Click **Update**.
   - To view the widget, add it to a dashboard.
   - Once the widget is in a dashboard, edit the widget and try the **Breakdown on Y-axis** display setting.

*Create a treemap visualization for a breakdown widget*
To display a hierarchy of breakdown elements, use a treemap visualization.

Role required: pa_power-user or admin
If the elements of a breakdown differ in favorability, or if you want to compare each breakdown element against an indicator target, you can use a treemap. Treemaps use nested rectangles with the size representing the relative proportion of the element and the color representing the favorability.

**Treemap visualization**

1. Navigate to **Performance Analytics > Widgets** and click **New**.
2. In the **Name** field, give the widget a name that reflects the information being displayed.
3. In the **Type** field, select **Breakdown**.
   - If you change the value of **Type** after you fill in other fields, those fields are cleared.
4. In the **Visualization** field, select **Treemap**.
You can let the user switch between visualizations. Select Show visualization selector in the Display settings tab.

5. In the Indicator field, select the main indicator which you want to break down.

6. Optional: To show only the scores that match one element of a breakdown, select a filtering breakdown in the Breakdown and Element fields.

To use a breakdown to filter the data, you must specify an element.

7. Select the breakdown to group the scores by.
   - If you did not select a breakdown as a filter, select the grouping breakdown in the Breakdown field.
   - If you selected a filtering breakdown in the Breakdown and Element fields, select the grouping breakdown in the 2nd Breakdown field.

You can let the user switch between breakdowns to apply. Select Show breakdown selector in the Display settings tab.

8. In the Coloring method field, select whether to rank the favorability based on score, change to score, percent of change, or an indicator target.

9. Select the color that indicates a positive in the Positive color field.

10. Depending on the Coloring method, you may need to select a Negative color.

11. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series</td>
<td>Run a function on the scores for a specific time period, such as applying a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Sort on</td>
<td>Sort the data on this attribute and set whether to sort in ascending or descending order.</td>
</tr>
<tr>
<td>Sort direction</td>
<td>Note: The system attempts to sort the data based on the scores from the latest collection job. If the latest job did not collect any scores, the Sort on setting is ignored.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a filtering option on the widget. Only one Breakdown field remains in the form, for selecting the grouping breakdown.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown. This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Followed breakdown relation</td>
<td>This dropdown menu works only with Scorecard visualizations. However, you can allow a viewer to see related breakdown elements in other visualizations by selecting Show visualization selector. For more information about selecting a breakdown relation, see Create a scorecard visualization for a breakdown widget.</td>
</tr>
<tr>
<td>Color scheme</td>
<td>A spectrum of colors for the scores for all breakdowns. If a spectrum cannot be applied, only the first color is used. You can create your own color scheme instead of using a provided color scheme. For more information about creating color schemes, see Create a color scheme for widget visualizations.</td>
</tr>
</tbody>
</table>

12. Optional: Review the **Settings** tabs and change settings as desired.  
13. Click **Submit**.

To view the widget, add it to a dashboard.  
**Optional settings for breakdown widgets**

Breakdown widgets have the following optional settings for the date range, the display, the grouping breakdown, and for the column contents. Not all options are available for all visualizations.

<table>
<thead>
<tr>
<th>Date Settings</th>
<th></th>
</tr>
</thead>
</table>
| Period           | Select the date range to display in the widget. Several options are available.  
|                  |     - Select a specific time range. The default is **3m** (3 months).  
|                  |     - Select **max** to use scores up to the current date.  
|                  |     - Select **between** and then fill in the **From** and **To** fields to define a time period.  
<p>|                  | The <strong>Period</strong> field is available only if you select <strong>Line</strong>, <strong>Columns and Total</strong>, or <strong>Stacked Column</strong> as the <strong>Visualization</strong>. |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show date range selector</strong></td>
<td>Display a date range selector on the widget that enables users to change the selected period when viewing the widget on a dashboard.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Selecting a date range on a widget does not update the trend line.</td>
</tr>
<tr>
<td><strong>Display Settings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show data labels</strong></td>
<td>Display the score for each portion of the chart, such as for each slice of a pie chart.</td>
</tr>
<tr>
<td><strong>Show visualization selector</strong></td>
<td>Display a choice list on the widget that enables users to change the selected visualization from a dashboard.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You cannot select the Pivot Scorecard visualization from a dashboard. You must configure the widget record to use this visualization.</td>
</tr>
<tr>
<td><strong>Show breakdown selector</strong></td>
<td>Display a choice list on the widget that enables users to change the selected breakdown from a dashboard. There must be more than 1 breakdown available for the widget for the breakdown choice list to appear.</td>
</tr>
<tr>
<td><strong>Positive color</strong></td>
<td>When the Visualization is Treemap, select the color used to indicate a score moving in the desired direction, based on the indicator Direction value. If Color based on is set to Target, the positive color indicates values closer to the target.</td>
</tr>
<tr>
<td><strong>Negative color</strong></td>
<td>When the Visualization is Treemap, select the color used to indicate a score moving in the wrong direction, based on the indicator Direction value. If Color based on is set to Target, the negative color indicates values further away from the target. This field is not available when Color based on is Score.</td>
</tr>
<tr>
<td><strong>Show legend</strong></td>
<td>When the Visualization is Treemap, select this option to display a legend for the positive and negative colors.</td>
</tr>
<tr>
<td><strong>Breakdown Settings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Elements filter</strong></td>
<td>Specify if only a certain subset of breakdown elements are available for this widget. By default all elements are available.</td>
</tr>
<tr>
<td></td>
<td>For example, elements of the breakdown Priority can be: Critical, High, Moderate, Low or Planning.</td>
</tr>
<tr>
<td><strong>Breakdown on Y axis</strong></td>
<td>Pivot Analytics Hub breakdown widgets display breakdown elements as the X axis and indicators as the Y axis by default. Select this check box to display breakdown elements as the Y axis and indicators as the X axis.</td>
</tr>
</tbody>
</table>
Manual elements

Breakdown elements can be selected automatically or manually. Select the Manual elements check box to display the Widget Elements related list for adding elements. Clear the Manual elements check box to automatically use the elements that belong to the breakdown.

Show top x

If there are many breakdown instances, the breakdown chart may become too large. Enter a number to show only the top x of the instances. The maximum Number of elements in the breakdown charts can also be specified at System > Properties. The top x for a widget cannot be higher than the property maximum.

Percentages

If you select No percentages, no score percentages are shown for the instances. If you select Percentage of elements, a score percentage is shown for each instance. For example, 6.4% of the total incidents are Critical, 11.8% are High, and so on.

Show total

If you selected Scorecard in the Visualization field, an extra row can be included in the breakdown chart showing the totals of all selected breakdowns.

Show bar

Represent the score for each instance by a bar.

Column Settings

Current score

Display the score from the latest data collection.

Trend

Display the direction the indicator is moving. The trend is shown in a mini-chart on the dashboard.

Multiple scores

Adds scores to the Analytics Hub. Select the number of additional scores to display in Number of periods. Select the length of each period in Period step. If Current Score is also selected, the Score column is counted as the most recent period and N-1 periods are added.

Change

Display the change from the previous score.

Change %

Display the percentage change from the previous score.

Target

Display the target for the indicator if a target has been defined.

Gap

Display the difference between the current and the target scores. Gap can be either positive (moving towards the target) or negative (moving away from the target).

Gap %

Display the percentage difference between the current and target scores. Gap % can be either positive (moving towards the target) or negative (moving away from the target).

Create a heatmap visualization in a pivot widget

To group the scores of an indicator by two breakdowns, use a heatmap visualization in a pivot widget.
Role required: pa_power_user or admin

If you want to apply two breakdowns to an indicator, create a pivot widget with the breakdowns as the two axes of the pivot table. Heatmaps, which use a color gradient to highlight when both scores are high, are the only visualization available for pivot widgets.

Note: Pivot widgets do not support the Follow Element function. Dashboard breakdowns cannot apply to these widgets.

Heatmap visualization - pivot widget

1. Navigate to Performance Analytics > Widgets.
2. Click New.
3. In the Name field, give the widget a name that reflects the information being displayed.
4. In the Type field, select Pivot.
   If you change the value of Type after you fill in other fields, those fields are cleared.
5. In the Visualization field, select Heatmap.
6. In the Indicator field, select the indicator which you want to break down.
7. In the Breakdown field, select the breakdown to be the X-axis.
8. In the 2nd Breakdown field, select the breakdown to be the Y-axis.
9. Optional: In the Display Settings, set the color scheme and whether to display data labels and the legend.

10. Click Submit.

To view the widget, add it to a dashboard.

Text analytics and text widgets

Text analytics reveal any patterns that exist in user-entered text fields.

Text analytics provides visual tools for analyzing the text that users enter in forms. The possible benefits of such analyses include early warning of customer pain points, disclosure of fraudulent activity, and the extraction of certain entities or concepts that are clustering in sales, incident reports, etc. The useful information in this unstructured, qualitative data may be hidden from other tools.

Note: Text analytics is available only with licensed Performance Analytics.

Text analysis begins with indexing the text. Text indexing is defined on indicator sources, to allow for the reuse of a single index configuration by many indicators.

When you set up text analytics, you decide on:

- Which fields in an indicator source to index.
- Which indicators to apply a text index configuration to.
- Which stop words to exclude from analysis.
- What phrases to search for, besides single words.
- Keywords for default filtering.

When you have set up text analytics, create a widget to visualize the text and include the widget in a dashboard.

The following video walks you through the process of setting up and viewing text analytics:

Set up text analytics

Select the text fields to analyze and which indicators to analyze.

Text analytics relies on specific steps in the data collection jobs. The Collect parameter in the relevant jobs must be set to collect text analytics. A job is relevant if it collects data for the same indicators that are subject to text analysis. See Create or schedule a data collection job.

Role required: pa_power_user or pa_admin

1. Navigate to Text Analytics > Setup Fields.
   - To create a new text analytics configuration, click New.
   - To edit an existing text analytics configuration, click the information icon in that row and select Open record. Clicking the indicator source name opens the record for that indicator source, not the text analytics configuration.

2. Select the Indicator source whose input text you want to analyze.

3. Unlock Fields to analyze and select the fields whose input text you want to analyze.
   You must select at least one field. Usually you want to include the Short description field.
   You cannot select the following fields:
   - Dot-walked fields
   - Translated Text fields
   - Any other field with a type other than String
4. Optional: Select **Use system stop words** to include the Zing stop words. 
   Selected by default. The Zing global stop words apply to the indicator source. If you do not use the Zing stop words, you must select all stop words yourself.

5. Save the text index configuration. 
   The **Indicators** related list appears at the bottom of the form.

6. In the **Indicators** list, click **Edit** and select the indicators to analyze from the slushbucket.

7. Run a relevant historical data collection job to collect initial data. 
   You may be able to run a job from this form, or you may have to run a historical data collection job. See the next topic for details.

---

**Collect initial text analytics data**

When you configure text analytics for an indicator source, no data is available until a relevant data collector job is run. If you have newly created a text analytics configuration, run a special collection job. If you have added indicators to an existing text analytics configuration, run a historical data collection job to collect only text analytics.

**Role required:** pa_power_user or admin

- On the **Setup Fields** form, if the button is available next to **Save**, **Update**, and **Delete**, click **Run collection**.
  
  This button launches a single-use historical job that collects only text indexes. It is available only when you create a text analytics configuration.

  This job collects data for a period equal to the shortest period for which there is data for any of the indicators in the analysis. For example, if you are running text analysis on five indicators and you have one year of data for four of them but only four months of data for the fifth indicator, four months of text analytics are collected for all five indicators.

- If you have added an indicator to an existing text analytics configuration, configure and run a historical data collection job.
  a) Navigate to **Data collection > Jobs**.
  b) Create or edit a historical data collection job as described in **Create or schedule a data collection job**, with the following characteristics:
     - Set the **Collect** job parameter to **Text indexes only**.
     - Set the **Run** job parameter to **On demand**.
     - Set **Relative start**, **Relative start interval**, **Relative end**, and **Relative end interval** values that are appropriate for the indicators for which you are performing text analytics.
     - Ensure that the indicators for which you are performing text analytics match the indicators for the collection job.
  c) Execute the job.

---

Now that text analytics are configured and initial data is collected, you can create text analysis widgets for the selected indicators. Consider setting text analytics stop words first. Both these stop words and the Zing stop words can apply.

**Select text analytics stop words**

Select words to exclude from text analysis. You can exclude words at either the indicator source or the indicator level.

**Role required:** pa_analyst or pa_admin

Select stop words to apply either at the indicator source or at the indicator level. If you select stop words for an indicator, you can filter the scores to which the stop words apply by breakdown and breakdown element. If you select stop words for an indicator source, you exclude them from data collection, which results in a leaner index.
By default, the Zing global stop words apply in addition to the stop words you select in this form. You can disable this behavior in the text index configuration.

1. Navigate to Text Analytics > Stop Words and click **New**.
2. In the **Type** field, select either **Indicator** or **Indicator source**.
   - If you specify an indicator, you can filter the text by one or two levels of breakdown.
   - When specified on the indicator source, stop words are removed from data collection to keep the index lean. However, you cannot immediately bring these stop words back into the widget by removing them from the **Stopwords** field. They do not appear until the next data collection.
   - Stop words that are specified on the indicator remain in the index. These stop words can be brought back into the widget immediately by removing them from the **Stopwords** list, but index size may affect performance.
3. Select either the **Indicator** or the **Indicator source** to which to apply the stop words.
4. **Optional:** To filter the text by a breakdown, select values in the **Breakdown** and first **Element** fields.
   - If you select a breakdown but not an element, the widget analyses only the text that is not associated with any element of that breakdown.
5. **Optional:** If you have selected a breakdown and you want to filter the text by a second breakdown, select values in the **2nd Breakdown** and second **Element** fields.
6. In the **Stopwords** field, enter a comma-separated list of words to exclude from the text analysis.
7. Click **Submit**.

---

**Search text for phrases**

You can specify phrases that text analytics searches for, instead of searching for only the most frequent individual words.

**Role required:** pa_analyst, pa_power_user, or admin

1. Navigate to Text analytics > Phrases and click **New**.
   - To edit an existing text index phrases form, click the information icon for that form, then select **Open Record** from the preview window.
2. Select the **Indicator** that you want to search for phrases.
   - Text Analytics must be set up for this indicator.
3. **Optional:** In the **Breakdown** and **Element** fields, you can filter the records that are searched for the phrases.
   - Specify both a breakdown and an element. You can filter to a second level by filling in the level 2 **Breakdown** and **Element** fields.
4. Enter a comma-separated series of phrases in the **Phrases** field.
   - For example, enter "can't access, don't see."

When you include a text widget for this indicator in a dashboard, the specified phrases appear in the trend line.
Create a text widget

To help analysts visualize any patterns in user-entered text in an indicator, create a word cloud visualization in a text widget.

Text widget with phrases "don't see" and "can't access"
Text indexing must be configured for the relevant indicator source, and this configuration must include the relevant indicator.

Text analytics is available only with the licensed version of Performance Analytics.

**Note:** To view the dashboard, users must have the pa_viewer role or a role that contains pa_viewer.

Role required: pa_power_user or admin

The Text widget provides a word cloud for visualizing the frequency of words and phrases.
1. Navigate to Performance Analytics > Widgets and click New.
2. In the **Name** field, give the widget a name that reflects the information being displayed.

3. In the **Type** field, select **Text**.
   
   If you change the value of **Type** after you fill in other fields, those fields are cleared.
   
   **Word Cloud** is automatically selected as the **Visualization**.

4. In the **Indicator** field, select the main indicator for which you want to analyze text.

5. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only text that is associated with the specified element of the specified breakdown is analyzed. Select values for both <strong>Breakdown</strong> and <strong>Element</strong>. Otherwise, only text that is not associated with any element of the breakdown is shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See <a href="#">Using breakdowns on dashboards</a>. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow. For example, consider the indicator <strong>Number of open incidents</strong>. This indicator uses two breakdowns: <strong>Assigned to</strong>, and <strong>Created by</strong>. Both breakdowns are based on the <strong>Users.Active</strong> breakdown source. You create a widget for this indicator and you select <strong>Follow element</strong> on this widget. You also need to select <strong>Followed breakdown</strong> and specify either the <strong>Assigned to</strong> or the <strong>Created by</strong> breakdown. This option is available only if <strong>Follow element</strong> is selected.</td>
</tr>
</tbody>
</table>

6. Set the cutoff value, which filters which words and phrases are shown in the widget based on the frequency of a word or phrase in the field:

   a) In the **Cutoff** field, select whether the cutoff value is a numerical count or a relative percentage.

   - **Count** is the number of occurrences of a word or phrase in the field. For example, if the cutoff settings are (**(Count)** (Greater than or equal to) (10)), the widget shows only words and phrases that occur ten or more times.
- **Percentage** refers to the percent of occurrences of all words in the field that are occurrences of the word or phrase. For example, if there are 30 total occurrences of all words in the field and the cutoff settings are \(((\text{Percentage})(\geq 10))\), the widget shows only words or phrases that occur three or more times.

b) In the **Cutoff conditions** field, select whether the cutoff value is a minimum or a maximum.
- **Greater than or equal to** has the widget show a word or phrase if it is at least as common as the cutoff value.
- **Less than or equal to** has the widget show a word or phrase if it is no more common than the cutoff value.

c) In the **Cutoff value** field, specify an integer value.

7. Optional: Set any of the remaining display settings.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default field</td>
<td>If multiple fields are selected in the text index configuration, this field appears by default.</td>
</tr>
<tr>
<td>Maximum number of words</td>
<td>The maximum number of words to be displayed in the word cloud</td>
</tr>
<tr>
<td>Maximum number of trendlines</td>
<td>The maximum number of trend lines to be displayed beneath the word cloud</td>
</tr>
</tbody>
</table>

- Add the widget to a dashboard.
- The admin gives the **pa_viewer** role to users who need to view the widget. The admin or the dashboard owner also has to share the dashboard containing the widget with these users.
- Text analysis uses special steps in the data collection job. If no data is available for the widget, verify that the relevant data collection job has run and that the job collects text indexes. See [Collect initial text analytics data](#).
- Filter the word cloud by keywords.

**Save keywords for text analytics**
You can save keywords that will always filter a text analytics widget. You can save them directly on the widget in a dashboard, choosing from the words in the word cloud. Alternatively, you can create or edit a record of saved keywords.

Role required: **pa_analyst** or **admin**

To filter a word cloud by keywords, click the words in the cloud. You can save a list of the keywords, which will be used whenever someone views the widget. Each list of keywords applies to one breakdown and element combination for the indicator in one widget. In the following example, the word “battery” has been specified as a keyword. If you click **Save**, all viewers will see this widget filtered by “battery.” Anyone with the required roles can delete the saved keywords later.
Open incident text analytics

Number of open incidents (852)

Trend line

Related Records

- needs
- dying
- replaced
- laptop

Selected keywords

battery (3)

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Alternatively, you can create or edit the record where the keywords are saved. This approach does not restrict your selection to keywords that have already appeared in the word cloud.

1. Navigate to **Text Analytics > Keywords** and click **New**.
2. In the **Widget** field, specify the widget to which the keywords apply.
3. In the **Indicator** field, specify the indicator to which the keywords apply.
4. In the **Field** field, select the indicator field that the keywords apply to.
5. Optional: In the **Breakdown** and **Element** fields, you can filter the records to which the keywords apply by a breakdown element. Specify both a breakdown and an element. You can filter to a second level by filling in the level 2 **Breakdown** and **Element** fields.

   If you specify a breakdown and element combination, the keywords only apply when that combination is selected in the widget. If you do not specify a breakdown and element combination, the keywords apply for all breakdown and element combinations that do not have keywords selected specifically for them.

6. In the **Keywords** field, enter a comma-separated list of keywords.
7. Click **Submit**.

**Monitor a workflow with a workbench process widget**

A workbench process widget is a collection of indicators that tell a story, and that enables you to analyze multiple facets of multiple indicators on one screen without drilling down. This widget is useful when you want to monitor a process or service that has a workflow.

You choose the main indicators on the top of the widget. Optionally, each main indicator can have a unique set of supporting indicators.

The widget has four interconnected sections that dynamically update. For example, when you click a main indicator its score, trend, supporting indicators, and breakdown information appear. Click or select a date on any visualization and the entire widget displays data for that day.

**Note:** If real-time score collection is supported for the indicator and any breakdowns that are applied to the indicator, you can view real-time scores by selecting Real-time in the date selector.
The bottom section of the workbench process widget displays available breakdowns or collected records for the selected main or supporting indicator. Click the **Breakdowns** or **Records** tabs to display one or the other. If you select a supporting indicator that specifies an aggregate, such as the average age of open incidents, the **Records** tab is hidden.

**Note:** The pa_viewer role is required to view breakdown information in a workbench widget.

When you create a workbench widget, you choose only main and supporting indicators. The score, trend, and breakdown sections of widget are automatically configured and cannot be changed. However, you can change the order and appearance of indicators on the widget.
Create a workbench process widget
Create a workbench widget to monitor a process using multiple indicators.

- Familiarize yourself with the structure of the workbench widget
- Decide which main and supporting indicators to include
- Role required: pa_admin, pa_power_user, or admin

2. Name the widget.
3. In the Type field, select Workbench.
4. Right-click the form header and select Save. The Main Widget Indicators related list appears.
5. Add a main indicator to the workbench widget. Main indicators appear on the top of the widget. The maximum number of indicators you can add is specified in com.snc.pa.widget.max_widget_indicators. The default maximum number of widget indicators is seven.
   a) Click New in the Main Widget Indicators related list.
   b) Select an Indicator.
   c) Set the Order to define where the indicator appears (from let to right).
   d) Fill in other fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>A breakdown element filters the data that appears in the indicator. If you select a breakdown you must select an element. For example, if your indicator is <strong>Number of open Incidents</strong> and you select <strong>Breakdown for State</strong> and <strong>Active for Element</strong>, only scores for incidents in the active state are included in the widget.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Adds a second breakdown element that filters the data that appears in indicator. If you select a 2nd breakdown you must select an element. For example, imagine your indicator is <strong>Number of open incidents</strong> and the first breakdown filters for active state. You then select <strong>Category for 2nd Breakdown and Software for Element</strong>. The indicator will now display only scores for open incidents that are active and in the software category.</td>
</tr>
<tr>
<td>Time series</td>
<td>Adds the specified time period and aggregation to the widget's trend visualization.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Follow element</td>
<td>Specifies that a breakdown element applied to the dashboard where the widget is added also applies to the indicator. If you specify a 2nd Breakdown, Follow element is ignored.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Specifies that only this breakdown applies to the indicator as a <strong>Follow element.</strong> All other breakdowns applied to a dashboard where the widget has been added will be ignored. If you do not specify a <strong>Followed breakdown</strong> all breakdowns applied to the dashboard will apply to the indicator.</td>
</tr>
<tr>
<td>Label</td>
<td>Specifies the name of the indicator on the widget. If you do not specify a Label, the name of the indicator is used.</td>
</tr>
</tbody>
</table>

e) Right-click the form header and select **Save.** The Supporting Widget indicators list appears.

   When you click a main indicator, its supporting indicators appear in the middle of the widget. You can add an unlimited number of supporting indicators.
   a) Click **New** in the Supporting Widget Indicators related list.
   b) Select an **Indicator.**
   c) Set the **Order** to define where indicator appears (from left to right).
   d) Fill in other fields, as appropriate. You can configure supporting indicators the same way as main indicators. See step 5 for configuration options.
   e) Click **Submit** to return to the Main Indicator record.
   f) Repeat step 6 until you have added all supporting indicators.

7. Click **Update** to return to the widget record.
8. Repeat steps 5 - 7 until you have added all indicators.
9. Optional: Select one of the main indicators as the **Default indicator.**
   This default indicator appears automatically when a user views the widget. If you do not specify a default indicator, the widget displays the main indicator with the lowest **Order** value first.
10. Click **Update** to save the widget.

Review the widget to ensure that the new indicators are correct. If you have not already, add the widget to a dashboard to view it.

**Add widget indicators**
Add any number of secondary indicators to an existing time series or list widget.
The widget must exist. If you want to add indicators to a widget that you are creating, save the widget instead of submitting it. The form remains open and the Widget Indicators related list appears at the bottom.

Role required: pa_power_user or admin

When you create a time series widget, you associate it with a single, main indicator. If you want to compare this indicator to another indicator in the same widget, add the additional indicator to the existing widget. This procedure is necessary when you create a Stacked Column visualization for a time series.

When you create a list widget, you must either specify an indicator group or add widget indicators.

**Note:** When you include main and widget indicators with different frequencies on a time series widget, be aware of how the widget shows time values on the x-axis. For more information about this behavior, see [KB0755757](#).

**Warning:** You cannot have Previous Period Chart and widget indicators on the same time series widget. If you enable Previous Period Chart on a time series that already has widget indicators specified, the widget indicator list is cleared.

1. Either save a widget that you are creating, or open an existing widget for editing.
   You can open a widget either from Performance Analytics > Widgets or from the dashboard. For more information, see [Edit a responsive dashboard](#).
2. Scroll to the bottom of the form and locate a related list with the label Widget Indicators.
3. Click New.
4. In the Indicator field, select a secondary indicator for the widget.
   Selecting too many indicators might make your widget difficult to read.
5. In the Chart type field, select a visualization for the indicator.
   Select a visualization that works well with the visualization of the primary indicator. For instance, show the primary indicator as columns and the secondary indicators as lines. If you are using a Stacked Column visualization for the primary indicator of a time series widget, set all secondary indicators to also use Stacked Column.
6. Optional: Fill in any of the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown and Element</td>
<td>Only the scores that match the specified element of this breakdown are shown. Select values for both Breakdown and Element. Otherwise, only scores that are not associated with any element of the breakdown are shown.</td>
</tr>
<tr>
<td>2nd Breakdown and Element</td>
<td>Drill down to a second level of breakdown and element, if a first-level breakdown and element have been specified.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Follow element</td>
<td>Applies only when this widget is placed in a breakdown dashboard. Select this option for the widget to follow the element that the user selects interactively on the dashboard. See Using breakdowns on dashboards. Selecting this option removes the ability to set a second breakdown and element on the widget.</td>
</tr>
<tr>
<td>Followed breakdown</td>
<td>Breakdown dashboard configurations specify breakdown sources, not specific breakdowns. The same breakdown source can be used for multiple breakdowns. Therefore, select this option to set which of the possible breakdowns to follow.</td>
</tr>
<tr>
<td></td>
<td>For example, consider the indicator Number of open incidents. This indicator uses two breakdowns: Assigned to, and Created by. Both breakdowns are based on the Users.Active breakdown source. You create a widget for this indicator and you select Follow element on this widget. You also need to select Followed breakdown and specify either the Assigned to or the Created by breakdown.</td>
</tr>
<tr>
<td></td>
<td>This option is available only if Follow element is selected.</td>
</tr>
<tr>
<td>Order</td>
<td>The order in which this indicator appears, if the widget has several secondary indicators. Consider adding extra digits, such as 200 and 300 instead of 2 and 3. This way, if you later add more indicators, you only have to specify the order of the new indicators. You do not have to respresent the order of all secondary indicators.</td>
</tr>
<tr>
<td>Chart type</td>
<td>The type of chart for displaying the widget indicator</td>
</tr>
<tr>
<td>2nd Y-axis</td>
<td>Add a Y-axis for this indicator. Only one secondary indicator Y-axis is displayed. If a second Y-axis is selected for several secondary indicators, only the axis for the indicator that originally came first in the order is shown.</td>
</tr>
<tr>
<td>Color</td>
<td>A single color that applies only to the scores for this indicator.</td>
</tr>
<tr>
<td>Label</td>
<td>A custom label for this indicator.</td>
</tr>
</tbody>
</table>

7. Click **Submit**.

To edit any of these settings later, go to the **Widget Indicators** list and click the information icon for the indicator, not the name.
Set the on-click behavior of a widget

You can configure what happens when a user clicks on a widget.

Role required: pa_power_user, pa_admin, or admin

By default, when a user clicks on a widget, the detailed Analytics Hub for the widget indicator appears. You can configure a widget to direct users to a different URL instead.

1. Navigate to Performance Analytics > Widgets.
2. Select the widget you want to configure.
3. In the On-click behaviors related list, click New and create a new record.
   If you create more than one On-click behavior record for a single widget, only the record with the lowest Order value is used.
   a) In the Label field, enter the text that appears for this option when a user clicks on the widget.
   b) In the Type field, select URL.
   c) In the Value field, enter the URL that you want to direct users to when they click on the widget.
      Only URLs relative to the instance URL are allowed. The value must begin with a / character, such as /incident.do.
   d) Click Submit.

Create a color scheme for widget visualizations

Create a color scheme to predefine and reuse a set of colors in Performance Analytics widgets.

Role required: pa_power_user or pa_admin

1. Navigate to Performance Analytics > Chart Color Schemes.
2. Click New.
3. Enter a descriptive Name.
4. Select colors in the Color 1 and Color 2 fields.
   A color scheme must have at least two colors. All other colors are optional.
5. Optional: Select up to 32 total colors to include in the color scheme.
6. Click Submit.

Select the color scheme in a new or edited Time Series or Breakdown widget. For an example, see the description of the Color Scheme field in Create a line visualization for a time series widget.

View widget statistics

You can view statistics about Performance Analytics widgets to help identify and resolve problems, such as if a widget is loading slowly on dashboards.

Role required: pa_power_user, pa_admin, or admin

1. Navigate to Performance Analytics > Widget Statistics.
2. Select the widget you want to view statistics for.
3. Review the following fields.

Report Stats fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget</td>
<td>The widget that the statistics describe.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Number executions total</td>
<td>The total number of times the widget was loaded from the server.</td>
</tr>
<tr>
<td>Average execution duration</td>
<td>The average time it took to load the widget, in milliseconds, for all executions of this widget.</td>
</tr>
<tr>
<td>Recent number executions</td>
<td>The number of time the widget was recently loaded from the server. The maximum number of recent executions is determined by the property <code>glide.report.recent_executions_number</code>.</td>
</tr>
<tr>
<td>Recent avg execution duration</td>
<td>The average time it took to load the widget, in milliseconds, for recent executions. The maximum number of recent executions is determined by the property <code>glide.report.recent_executions_number</code>.</td>
</tr>
<tr>
<td>Total executions duration</td>
<td>The total sum duration for all executions of the widget.</td>
</tr>
</tbody>
</table>

**Widget statistics properties**

These properties control how widget statistics are tracked and maintained.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>glide.report.recent_executions_number</code></td>
<td>The number of widget executions that are considered recent for the purpose of recent average duration calculations.</td>
</tr>
<tr>
<td>- Type: integer</td>
<td></td>
</tr>
<tr>
<td>- Default value: 25</td>
<td></td>
</tr>
<tr>
<td>- Location: <a href="#">Add a system property</a></td>
<td></td>
</tr>
</tbody>
</table>

**Time series aggregations in the Analytics Hub and widgets**

A time series aggregation consists of an aggregation, such as AVG or SUM, combined with a time series, such as By quarter. The frequency with which scores are collected for the indicator determines which time series are applicable. Some time series include data from partial collection periods.

**Time series and associated indicator frequencies**

When you select a time series aggregation, the frequency with which indicator scores are collected limits which time series you can choose. You cannot select a time series aggregation that is applied to scores more frequently than those scores are collected. For example, the By week SUM time series aggregation can apply to an indicator with a daily frequency. However, By week SUM cannot apply to an indicator with a weekly, monthly, quarterly, or yearly frequency.

**Note:**

- By Year and Year to Date time series are not available for daily scores.
- Weekly indicators support only **Weekly**, **4w running**, and **13w running** time series. This limitation is because beginning and end dates of weeks do not necessarily coincide with the beginning and end dates of months, quarters, or years.
- Bi-monthly and yearly indicators do not support any time series aggregations.

The following table shows which time series are supported for which indicator frequencies. These relationships are independent of which aggregation (AVG, SUM, or custom) is combined with a time series, and therefore only the time series are shown.

<table>
<thead>
<tr>
<th>Time series</th>
<th>Daily</th>
<th>Weekly</th>
<th>Monthly</th>
<th>Quarterly (Fiscal Q, 4-weekly, Bi-weekly)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>7d running</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>28d running</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>30d running</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>4w running</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>13w running</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>3m running</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>6m running</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>12m running</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>4q running</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>By week, by week +</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>By month, by month +</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>By quarter, by fiscal quarter, by quarter +, by fiscal quarter +</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>By year, by fiscal year, by year +, by fiscal year +</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Week to date</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Month to date</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Quarter to date, fiscal quarter to date</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Year to date, fiscal year to date</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Partial periods

Some time series include indicator scores from incomplete collection periods. These periods can include the current period and the period from the beginning of data collection. A plus sign in the name, +, identifies these time series.

A time series that does not include data from partial periods must have data from the beginning and the end of the period. For example, a **By month SUM** time series aggregation requires scores from the start and the end of the month to be present. Otherwise that month is not included. A time series that includes data from partial periods, such as **By month SUM +**, needs only data from one day in the period.

**Warning:** Partial periods can skew the results of certain aggregations, such as averages.

Default time series definitions

Performance Analytics comes with default SUM, AVG, and other time series definitions. Do not alter these definitions.

**Warning:** Any changes to time series definitions can have unexpected results.

View real-time scores

You can view real-time data when viewing the scores of an automated or manual indicator and a non-scripted breakdown.

The indicator must have real-time score enabled, and the indicator or its associated source must have at least one condition set. If you have a role that allows you to edit indicators, you can enable real-time data for an indicator by selecting the **Show real-time score** check box on the **Other** tab of the Indicator form. You may want to disable real-time data when using the indicator in an integration that does not provide real-time data.

Required role: pa_viewer to view in the Analytics Hub. Any role that allows dashboard viewing for workbench widgets. The roles pa_power_user or pa_data_collector to enable real-time scores on indicators.

Real-time data is available on the Analytics Hub and on workbench process widgets. You can view real-time data in the following ways:

- In the date picker, select **Real-time**.
In the Calendar, select **Real-time**.

- In a **Records** section, click the current date and time.

  Note: Record details are not available for the **Unmatched** breakdown element when you view real-time scores.

### Using breakdowns on dashboards

You can add breakdown sources to a dashboard. Users then can select a breakdown element to filter data in the Performance Analytics widgets that have been added to the dashboard.

For example, a dashboard that uses the breakdown source **Incident.Category** enables users to select a category from the list. After this selection, all the Performance Analytics widgets on the dashboard that are configured to follow dashboard elements are filtered by that category value. Reports can also use the breakdown source on the dashboard as an interactive filter, if the dashboard is so configured.

**Note:**

For the element to apply to a Performance Analytics widget on the dashboard, the **Follow element** option must be selected in that widget configuration.

Pivot widgets (Heatmaps) do not support the **Follow Element** function. Dashboard breakdowns cannot apply to these widgets.
Add a breakdown to a dashboard

To enable users to filter Performance Analytics widgets on a dashboard by breakdown element, add breakdown sources to the dashboard.

Role required: pa_admin, pa_power_user, or admin

After you add breakdown sources to a dashboard, all enabled Performance Analytics widgets can be filtered by the elements of those breakdown sources. To enable a widget, select Follow element in that widget configuration. To change this setting while editing the dashboard, click the pencil at the top right of the widget. The Widget Configuration form appears and you can change the setting.

If you did not select Follow element for a widget, that widget does not follow a breakdown applied to the dashboard.

If the dashboard uses a breakdown source which is used by more than one breakdown, set Follow breakdown in the widget configurations and specify which breakdown the widget will use. For example, the breakdowns Opened by, Requested by, Requested for, and Assigned to use the Users.Active breakdown source. If you add the Users.Active source to a dashboard, set Follow breakdown and select the relevant breakdown for each of the widgets that you have on that dashboard. This option does not affect the ability to filter by elements of any of the other breakdown sources you have configured the dashboard to use.

1. Navigate to the relevant list of dashboards.
2. Open the dashboard that you want to add a breakdown source to.
3. Click Edit in the Breakdown Source related list.
4. Move the breakdown sources you want to apply to the Breakdown Source List.
5. Click Save.

The breakdown sources are applied to the dashboard. Users can select elements from these sources on the dashboard.

- You can configure the entries in the Breakdown Source related list so that reports on the dashboard can use the breakdown sources as interactive filters. For more information, see Make a breakdown act as an interactive filter.
- Configure the widgets that are included in the dashboard. For more information, see Configure widgets for breakdown dashboards.

Configure widgets for breakdown dashboards

Configure each widget that goes on a breakdown dashboard. The configuration determines whether and how the widget follows the element selected on the breakdown.

This task assume that you are starting from an open breakdown dashboard that you have configured.

Role required: pa_power_user, admin

1. On the breakdown dashboard, click the plus sign (+) to put the dashboard in edit mode.

2. Point to the widget, then click the pencil icon ( ).
   The widget record opens.

3. Select Follow element in the widget record.
If you do not select **Follow element** for a widget, that widget does not follow a breakdown applied to the dashboard. The **Followed breakdown** option will not be visible. When **Follow element** is selected, the widget shows a filter icon next to the widget title.

4. If the dashboard uses a breakdown source which more than one breakdown uses, specify which breakdown applies to the widget in **Followed breakdown**. For example, the breakdowns Opened by, Requested by, Requested for, and Assigned to use the Users.Active breakdown source. If you add the Users.Active source to a dashboard, set **Followed breakdown** and select the relevant breakdown for each of the widgets that you have on that dashboard. This option does not affect the ability to filter by elements of any of the other breakdown sources you have configured the dashboard to use.

### Same breakdown on widget and dashboard

If a widget uses the same breakdown as the dashboard, the dashboard breakdown does not apply.

When you design a widget, you can specify up to two levels of breakdown to apply to that widget. Then you can add that widget to a dashboard, including a breakdown dashboard. If one of the breakdowns for the dashboard is the same as one of the breakdowns of the widget, that dashboard breakdown does not affect the widget. The behavior for that breakdown is the same as though **Follow element** was disabled for this widget.

If you add a breakdown type widget with interactive breakdown selection to a dashboard, this limitation does not fully apply. When the user selects the same breakdown on the widget and on the dashboard, the dashboard breakdown is ignored. However, when the user selects any other combination of widget and dashboard breakdowns, both breakdowns apply.
Breakdown widget on a breakdown dashboard

In the following animation, you have a breakdown widget on a breakdown dashboard. The widget has **Follow element** selected in its configuration. Both the dashboard and the widget are using elements of the Category breakdown. When you select elements on the dashboard, it has no effect on the widget. Then you select the Urgency breakdown on the widget. Now selecting elements on the dashboard does effect the widget. If you had changed the breakdown source on the dashboard instead of the breakdown on the widget, selecting elements on the dashboard also would have affected the widget.
### Incident daily - 7d - 28d

<table>
<thead>
<tr>
<th>Name</th>
<th>May 17</th>
<th>May 18</th>
<th>May 19</th>
<th>May 20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inquiry / Help</td>
<td>1,132</td>
<td>1,132</td>
<td>1,132</td>
<td>1,132</td>
</tr>
<tr>
<td>Software</td>
<td>675</td>
<td>675</td>
<td>675</td>
<td>675</td>
</tr>
<tr>
<td>Database</td>
<td>587</td>
<td>587</td>
<td>587</td>
<td>587</td>
</tr>
<tr>
<td>Network</td>
<td>564</td>
<td>564</td>
<td>564</td>
<td>564</td>
</tr>
<tr>
<td>Hardware</td>
<td>557</td>
<td>557</td>
<td>557</td>
<td>557</td>
</tr>
</tbody>
</table>

Widget with interactive breakdown selection on a breakdown dashboard
Showing breakdown relations on dashboards

A breakdown widget can display 1st level breakdown elements that are related to the element selected for the dashboard. The widget must be on a breakdown dashboard, and that dashboard must include the breakdown sources of the related breakdowns.

Consider an indicator such as Number of open incidents. This indicator uses the Location breakdown. The Location breakdown has three breakdown relations between its own elements. For an element of Location, these relations are:

- Parent Locations, whose Sys ID value is in the Parent field of other Location elements.
- Child Locations, which have the Sys ID value of another Location element in their Parent fields.
- Sibling Locations, consisting of Location elements who share the same value in the Parent field.

Breakdown relations between elements of Location

Now consider a widget that displays the Number of open incidents indicator scores grouped by Location. You set the widget to follow an element selected in a breakdown dashboard. Now you must select which of the breakdown relations to follow.
Setting up widget to show elements by breakdown relation
Warning: The Followed breakdown relation menu works only when the Scorecard visualization is selected. To allow the user to follow breakdown relations with other visualizations, select Show visualization selector on the widget form.

You select Child Locations. Now you put the widget in a breakdown dashboard that uses the Locations breakdown source. Locations is the breakdown source of the Location breakdown, so on the dashboard you can select any of the elements of Location. You select EMEA, and the widget shows the locations that have EMEA as a parent.

![A widget on a breakdown dashboard showing the children of the dashboard element](image)

You can go down more levels, to “grandchild” and “great-grandchild” elements. For example, here the location of Germany is selected:
Breakdown widget with a child of EMEA selected

If you edit the widget to display the Parent Location instead of the Child Locations and select Germany on the dashboard again, you see the parent location of Germany.
Performance Analytics scores forecasts

Performance Analytics enables you to forecast future scores based on existing trends. You can forecast scores on Performance Analytics time series widgets and the Analytics Hub. Forecast scores appear as a dotted line.

Forecasting is set up in the Forecasting tab of the indicator record. The number of data points included in the forecast depends on the indicator frequency, and the number of Periods to forecast configured on the indicator. A period is a set number of scores based on the indicator frequency.

Note: If you select a time series aggregation, the forecast is based on the frequency of the aggregation instead of the frequency of the indicator. For example, the 7d running SUM aggregation is a daily frequency, whereas the By week SUM aggregation is a weekly frequency.
## Displaying the forecast

To show the forecast on a time series widget, select **Show forecast** in the **Display Settings** section of the Widgets form. You can also show the 95% confidence interval of the forecast, by selecting **Show forecast range**.

To show the forecast on the Analytics Hub, click the chart settings icon and enable the **Forecast** option.

## Forecast methods

Several different methods are available for forecasting Performance Analytics data.

### Automatic method selection

**Important:** In most cases, let your instance select the forecasting method automatically, based on the best fit. To enable automatic forecasting method selection, set **Forecast method used** to **Auto**.

To determine the best fitting forecast method, the instance generates forecasts using each forecast method with your historical data. The instance then compares those forecasts with the latest data based on how far ahead you want to forecast. The instance performs this evaluation each time it displays the forecast. Therefore, collecting additional scores can alter which forecast method is used.

For example, if you configure an indicator with a daily frequency to forecast ahead two periods, the instances applies each forecasting method to your historical data that is older than two weeks. Then the instance compares those forecasts against the latest two weeks of data. The forecast that most closely fits the latest two weeks of data is then recalculated using the entire data set. The instance shows the results of this final calculation in the Analytics Hub.

### Table: Forecast periods

<table>
<thead>
<tr>
<th>Score frequency</th>
<th>Number of data points per period</th>
<th>Total period length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>7</td>
<td>1 Week</td>
</tr>
<tr>
<td>Weekly</td>
<td>13</td>
<td>1 Quarter</td>
</tr>
<tr>
<td>Bi-weekly</td>
<td>6</td>
<td>1 Quarter</td>
</tr>
<tr>
<td>Four Weekly</td>
<td>13</td>
<td>1 Year</td>
</tr>
<tr>
<td>Monthly</td>
<td>12</td>
<td>1 Year</td>
</tr>
<tr>
<td>Bi-monthly</td>
<td>6</td>
<td>1 Year</td>
</tr>
<tr>
<td>Quarterly</td>
<td>4</td>
<td>1 Year</td>
</tr>
<tr>
<td>Fiscal Quarterly</td>
<td>4</td>
<td>1 Year</td>
</tr>
<tr>
<td>Half Yearly</td>
<td>2</td>
<td>1 Year</td>
</tr>
<tr>
<td>Yearly</td>
<td>4</td>
<td>4 Years</td>
</tr>
<tr>
<td>Fiscal Yearly</td>
<td>4</td>
<td>4 Years</td>
</tr>
</tbody>
</table>
Forecast methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>Generates a linear regression forecast based on the historical scores.</td>
</tr>
<tr>
<td>Drift</td>
<td>The forecasts start as the value of the last score but increase or decrease over time, where the amount of change over time (called the drift) is set as the average change seen in the historical data.</td>
</tr>
<tr>
<td>Naive Seasonal</td>
<td>Generates a seasonal forecast that is a copy of the previous season of data. This method does not take into account trend data beyond the previous season, such as increasing scores season over season.</td>
</tr>
<tr>
<td></td>
<td>A ‘season’ for this analysis is one period.</td>
</tr>
<tr>
<td>Naive Seasonal Drift</td>
<td>As Naive Seasonal, the forecast starts as a copy of the previous season of data. The forecast increases or decreases over time, where the amount of change over time (the drift) is set as the average season over season change in the historical data.</td>
</tr>
<tr>
<td>Seasonal Trend Loess (STL)</td>
<td>Generates a seasonal forecast based on a best-fit function, trend data, and a filter to exclude noise from random variation in the data.</td>
</tr>
<tr>
<td></td>
<td>A ‘season’ for this analysis is one period.</td>
</tr>
<tr>
<td>Random Forest (available only for time series)</td>
<td>Creates a multitude of decision trees based on the historical data and then outputs the mean prediction of the trees.</td>
</tr>
</tbody>
</table>

Forecasting and targets

When both forecasting is enabled for an indicator and there is a global target defined, the forecast shows when the target will be reached.

Additionally, the instance sends a notification 14 days before a target is reached. You can control how many days ahead the notification is sent by setting the `pa.job.forecast.target.days_to_check` property.

This functionality is available only for global targets. Thresholds and personal targets do not interact with forecasts.

In-form analytics

In-form analytics integrate performance insights into forms so that users can access important metrics in context and make better decisions.

In-form analytics involve a UI action on a form that opens a view of a dashboard based on a breakdown. This breakdown dashboard provides valuable performance insights to the user who is completing the form. For example, you want support engineers, while creating an incident, to be able to see the expected time to close the incident based on the incident category. To enable the engineers to view this information, you create an in-form analytics UI action for incident forms. This UI action opens an Incident. Category breakdown dashboard with a widget that shows the expected time to close an incident.
Incident: Category in-form analytics

The UI action for in-form analytics is activated through an icon next to the field on the form that represents the breakdown. If that field is not visible in the form view, neither is the icon. When you set up in-form analytics, you have the option of also including a Related Action link on the form. This link is always available.
Add in-form analytics to a form

Create a UI action that enables users to view relevant analytics while completing a form. The UI action associates the table that uses the form, a breakdown used with that table, and a breakdown dashboard.

Role required: pa_power_user, pa_admin, or admin. In addition to the Performance Analytics roles, you must be able to create records on the UI Actions (sys_ui_action) table.

Before adding in-form analytics for a specific table and breakdown, create a breakdown dashboard that uses that table and the breakdown source of that breakdown. Design the dashboard so that it prominently displays the most useful information to the users who create records on that table. For more information about breakdown dashboards, see Using breakdowns on dashboards.

Performance Analytics must be active to create in-form analytics.

Navigate to Performance Analytics > In-Form Analytics and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the UI action.</td>
</tr>
<tr>
<td>Table</td>
<td>The table to display analytics for. The in-page icon appears on forms for this table.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>The breakdown for analyzing the table. The UI action icon appears next to the field that corresponds to this breakdown, if the field is included in the form view.</td>
</tr>
<tr>
<td>Dashboard</td>
<td>The breakdown dashboard to display. The dashboard must use the selected Table and the breakdown source of the Breakdown.</td>
</tr>
<tr>
<td>Icon</td>
<td>The icon to display next to the breakdown-related field on the form.</td>
</tr>
<tr>
<td>Icon color</td>
<td>The color of the form icon.</td>
</tr>
<tr>
<td>Create in-form link</td>
<td>Display a related link on the form in addition to the icon when this check box is selected. The related link directs to the same dashboard as the icon.</td>
</tr>
</tbody>
</table>

Incident Assignment Group in-form analytics

Consider the case where you want support engineers who create incidents to be able to see the expected time to close the incident based on the assignment group. You have designed a widget that shows the expected time to close an incident. You have added this widget to the In-form Analytics breakdown dashboard, which uses the Groups breakdown source. ‘Groups’ is the source for the Assignment Group breakdown.
Now you create in-form analytics for the Incident (incident) table, the Assignment Group breakdown, and the In-form Analytics - Incidents dashboard. You select the icon for the UI Action. This icon will appear next to the Assignment Group field. You also decide to create a Related Link to the dashboard.
Creating in-form analytics

Clicking the dial icon opens the pop-up view of the dashboard. Note that instead of the dashboard name, the pop-up window is titled ‘Analysis of (Breakdown name)’.
Opening dashboard view from incident form
The Self-Service view does not show the Assignment Group field by default. In this case, you can still view the analytics from the Related Links.
Preconfigured in-form analytics

Preconfigured in-form analytics are available as plugins for several applications and their associated tables and forms.

### In-form analytics plugins and associated tables

<table>
<thead>
<tr>
<th>Plugin name</th>
<th>Plugin ID</th>
<th>Table and forms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Change Management</td>
<td>com.snc.pa.change.context_sensitive_analytics</td>
<td>Change Request (change_request)</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Chat</td>
<td>com.snc.pa.chat.context_sensitive_analytics</td>
<td>Chat Queue Entry (chat_queue_entry)</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Customer Service</td>
<td>com.snc.pa.cs.context_sensitive_analytics</td>
<td>Case (sn_customerservice_case)</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Incident Management</td>
<td>com.snc.pa.incident.context_sensitive_analytics</td>
<td>Incident (incident)</td>
</tr>
<tr>
<td>Performance Analytics - Context Sensitive Analytics for Problem Management</td>
<td>com.snc.pa.problem.context_sensitive_analytics</td>
<td>Problem (problem)</td>
</tr>
</tbody>
</table>

**Note:** When you activate a plugin for preconfigured in-form analytics, you also activate the Performance Analytics Solution for that application. For more information, see [Out-of-the-box Performance Analytics Solutions](#).

### Performance Analytics widgets on Service Portal

You can show Performance Analytics indicators and breakdowns using Service Portal.

When you edit a portal, add the **Performance Analytics** widget. Use the widget options to select an existing Performance Analytics widget to show on the portal and whether to show its title.
Role requirements for viewing widgets

For most widgets, if a viewer can view the dashboard containing the widget, they can view the widget. However, the following widgets require users to have the `pa_viewer` role:

- List widgets
- Text widgets
- The Breakdowns section of Workbench widgets

In addition, the ability to view the individual indicators in a List widget depends on the ACLs of those indicators.

Finally, breakdown access controls apply when viewing breakdowns in widgets.

Activate the Performance Analytics and Reporting — Service Portal Widgets plugin

You can activate the Performance Analytics and Reporting - Service Portal Widgets plugin (`com.snc.pa.sp.widget`) if you have the `admin` role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: `admin`

The Service Portal Widget plugin activates these related plugins if they are not already active.
## Plugins for Performance Analytics and Reporting — Service Portal Widgets

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal (com.glide.service-portal)</td>
<td>Core Service Portal functionality.</td>
</tr>
</tbody>
</table>

1. **Navigate to System Definition > Plugins.**
   
   A banner appears to notify you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.

   **Note:**
   
   To redirect to the legacy list view for plugins, click the link.

   ![Banner to redirect to legacy list view](image)

2. **Find the plugin with the filter criteria and search bar.**
   
   You can search for the plugin by its name or ID.

   If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).

3. **Activate the plugin.**
   
   You can activate the plugin directly from the All Applications page or view more details about the plugin before activating it.

   - If you are certain that you have the correct plugin, click **Install**, and then click **Activate** in the dialog box that appears.

     ![Activate Plugin dialog box](image)

   - To view plugin details before activation:
     1. Click the plugin name.
     2. On the form, click the **Activate/Update** related link.
3. On the dialog box that appears, review the dependent plugins.
   If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.

4. If demo data is available and you want to install it, click **Load demo data**.
   Some plugins include demo data, which are sample records that illustrate plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking **Load demo data only** on the plugin form.

5. Click **Activate**.

### Performance Analytics data architecture

Define key metrics and data structure to generate scores.

### Design your Performance Analytics solution with KPI Composer

KPI Composer ensures that your performance management strategy aligns with business goals and has support from executive sponsors. Use KPI Composer to bridge the gap between defining your performance measurement strategy and the realization of that strategy from within Performance Analytics. Start with your business goals and plan all your components through indicators up to the final dashboards.

KPI Composer helps you elicit performance management requirements and drive stakeholder alignment by visualizing implementation objectives, desired business outcomes, and required technical deliverables in a concise visual summary. This holistic approach ensures that stakeholders are completely aligned on the desired outcomes and requirements before implementers spend time working on any technical deliverables. When ready, Performance Analytics implementers get a task list of exactly what they need to create — indicators, breakdowns, and dashboards — to support the goals, and you can even use KPI Composer to track the progress of the implementation.

A free training in KPI Composer is available at [NOW Learning](https://nowlearning.servicenow.com).

### Activating KPI Composer

KPI Composer is available on the ServiceNow Store. Navigate to **System Applications > Search ServiceNow Store**, or point a browser to https://store.servicenow.com/sn_appstore_store.do#!/store/home. Search for the application named KPI Composer. If you are downloading the application to a production instance, you need a HI account.

After you download the application, navigate to **System Applications > All Available Applications > All**. Search for the KPI Composer application and install it. For an example, see [Activate a ServiceNow Store application](https://docs.servicenow.com/appdev/activate-store-applications.htm).

**Note:** To get full use of KPI Composer, you should have the appropriate entitlement to use Performance Analytics.
Roles in KPI Composer

To use KPI Composer, a user must have one of the following roles:

<table>
<thead>
<tr>
<th>Role</th>
<th>Contains</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sn_kpi_composer.admin</td>
<td>pa_viewer</td>
<td>Full access to all components of KPI Composer and all projects. Can associate indicator and breakdown definitions with Performance Analytics indicators and breakdowns.</td>
</tr>
<tr>
<td>sn_kpi_composer.user</td>
<td>None</td>
<td>Can access only projects that they have created. Can access only the design tabs, indicator definitions, and breakdown definitions of those projects. Cannot add Performance Analytics indicators or breakdowns to the respective definitions.</td>
</tr>
</tbody>
</table>

The appropriate Performance Analytics roles are also needed to implement KPI Composer designs in Performance Analytics.

KPI Composer projects

KPI Composer is based on projects. Each project in KPI Composer consists of a single Key Performance Indicator (KPI) tree and the functional and technical definitions of all elements within that tree. You can create multiple projects.

The KPI Composer project UI provides you with a sequence of four tabs, each corresponding to a phase in your project:

Analysis

In this phase, you create a hierarchical tree of Business Goals, Critical Success Factors, and Measurements (or KPIs). Conceptually defining KPIs and mapping them to Goals and Success Factors produces a detailed functional specification of all required Performance Analytics configurations. This specification is vetted by the business sponsors and provides a clear direction to the technical implementers.

Dashboard Design

In this phase, you create a design specification for one or more Performance Analytics dashboards. Use the Dashboard Design tab in presentations early in your implementation to get timely feedback, so when your project is complete, the dashboard viewers get the visualizations they expect.

Indicator Design

In this phase, you provide technical specifications for Performance Analytics Indicators that match the KPIs that you defined during Analysis. You can link the KPIs to appropriate Performance Analytics indicators that already exist or that you create later.

Review

In this phase, verify the design components in your project, run a system definition health check, and generate a task list for implementing the project in Performance Analytics.

Create a KPI Composer project

As the first step in using KPI Composer, create a project.

Role required: sn_kpi_composer.user, admin

1. Navigate to KPI Composer > Projects and click New.
2. In the Create new project dialog, give the project a meaningful name and click **Save**.

Your project is created and is visible in the **Projects** page.

**Define properties for a project**

In the Project Properties, you can associate knowledge articles, owners, and contact persons with the project.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin

**Note:** Project Properties are similar to the Info tab of Element Properties. Only the scope is different.

1. Navigate to **KPI Composer** and create or open a project.

2.

   In the Analysis tab, click the Information icon at the top right of the screen.

3. Specify any of the following details:
   - Knowledge articles that contain information relevant to the project. You can link any number of knowledge articles.
   - Project owners
   - Contact persons

**Add personas to a project**

Each project has several personas with different roles in the Performance Analytics solution that you are designing. A persona is a role within your company, such as service desk manager or service owner.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin

1. Navigate to **KPI Composer** and create or open a project.

2.

   In the Analysis tab, click the persona icon at the top right of the screen.

3. In the Persona dialog, click **Add item**.

4. Type the name of the new persona and click outside the text box.

   The persona appears in the header of the KPI tree canvas. Each persona automatically gets a 2-letter identifier, which is based on the first two words (or first two letters if only one word) that are in the name.

5. Repeat these steps to add more personas.
Adding personas to a KPI Composer project

In the following short animation, you see how to add the personas Agent and CIO to a project. Then you see how to add the CIO persona to a Business Goal.
Drag personas onto existing elements on the canvas to add them to those elements. You can add an unlimited number of personas to any element. If an element has more than three personas, the full names of the personas are hidden. To see the full names, point to the personas.

By holding down the Ctrl/Command or Alt/Option key while dropping a persona onto an element, you activate the following advanced functions:

**Hold Ctrl while dropping**
Add the persona to the element on which it is dropped and to all child elements of that element.

**Hold Alt while dropping**
Remove the persona from the element on which it is dropped.

**Hold Ctrl and Alt while dropping**
Remove the persona from the element on which it is dropped and from all child elements of that element.

*Group data by breakdown definitions*
Each project can have a set of breakdown definitions that you can use to group the data in KPIs. These breakdown definitions provide the specifications for Performance Analytics breakdowns that you eventually create.

Role required: sn_kpi_composer.user (own project), sn_kpi_composer.admin (any project), admin

1. Navigate to **KPI Composer** and create or open a project.
2. In the Analysis tab, click the ‘Group by’ icon at the top right of the screen.
3. In the ‘Group by’ dialog, use the sliders to select which breakdown definitions to include in your project.
The selected breakdown definitions appear in the header of the KPI tree canvas. From here, you can drag and drop them onto elements.

4. To add a new breakdown definition to your project, click **Add Item** and enter the term.
The new item appears in the ‘Group by’ list, and a matching breakdown definition record is created.

**Selecting breakdown definitions for a KPI Composer project**

In the following short animation, you see how to select the breakdown definitions Assignment Group, Impact, and Priority to a project. Then you see
how to group the values of a KPI tree element by Assignment Group and Priority.
Drag breakdown definitions (‘Group by’ items) onto existing elements on the canvas. You can group the data associated with an element by any number of breakdown definitions. The colored dots on an element show which breakdown definitions the element is grouped by. To see the names of these breakdown definitions, point to any of the colored dots on the element.

By holding down the Ctrl/Command or Alt/Option key while dropping a breakdown definition onto an element, you activate the following advanced functions:

**Hold Ctrl while dropping**
Add the breakdown definition to the element on which it is dropped and to all child elements of that element.

**Hold Alt while dropping**
Remove the breakdown definition from the element on which it is dropped.

**Hold Ctrl and Alt while dropping**
Remove the breakdown definition from the element on which it is dropped and from all child elements of that element.

Define a breakdown

Provide the functional description of how to build an actual Performance Analytics breakdown in a breakdown definition. Once an appropriate Performance Analytics breakdown exists, you can link to it in the breakdown definition.

Role required: sn_kpi_composer.user, sn_kpi_composer.admin (to link to Performance Analytics breakdown), admin

The breakdown definitions that you add to KPI Composer projects are not actual Performance Analytics breakdowns. They are only placeholders that describe what the Performance Analytics breakdown should be. In KPI Composer breakdown definitions, you provide either or both of the following pieces of information:

- The details that a Performance Analytics expert needs to create the actual breakdown.
- A reference to an existing Performance Analytics breakdown that meets your requirements.

After a Performance Analytics breakdown has been created for your project needs, add a reference to that breakdown in the relevant breakdown definition. Doing so helps you keep track of the progress in creating a Performance Analytics solution from your KPI Composer project.

1. Navigate to KPI Composer > Breakdown Definitions.
2. From the list, open an incomplete or outmoded breakdown definition.
3. Fill in the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA Breakdown (Restricted to sn_kpi_composer.admin and admin roles)</td>
<td>A Performance Analytics breakdown that exists on this instance.</td>
<td>If a breakdown definition does not have a reference to a Performance Analytics breakdown, you probably need to create that breakdown.</td>
</tr>
<tr>
<td>Facts Table</td>
<td>The table that the breakdown source for the Performance Analytics breakdown has to reference.</td>
<td>Key information for creating a breakdown.</td>
</tr>
</tbody>
</table>
### Analysis and the KPI tree

In the Analysis tab of KPI Composer, design your KPI tree. Specify your business goals, their associated critical success factors, and the measurement related to those factors. Chart the logical relationship between these factors and the personas who own them.

A KPI tree contains the following hierarchically-related elements:

#### Business goals

Typically, you put a business goal at the top of your KPI tree. This goal represents what you want to achieve with the PA dashboards coming forth from this project. A business goal can be something like "Cost Efficiency" or "Quality Assurance."

#### Critical Success Factors

Put these factors under your business goals to identify what your organization needs to do to achieve the business goal. Critical success factors can be placed under a business goal or under other critical success factors.

#### Measurements

Decide how to measure the performance of a critical success factor. Measurements are the most 'indicator-like' element in the KPI tree. They contain the functional description of how to make the measurement. Additionally, you can store who is responsible for the measurement and who to contact in case this measurement is used in different projects.

The KPI tree has a header and a footer with the following drag-and-drop icons:

- Elements, on the left of the footer
- Breakdown definitions, on the left of the header (See [Group data by breakdown definitions](#))
- Personas, on the right of the header (See [Add personas to a project](#))

### Filtering

The following filter options are available on the Analysis tab:

- Filter by persona. Click on a Persona icon in the header to highlight the elements that are linked to the persona. You can select multiple personas. In this case, any element that is linked to at least one of the selected personas is highlighted.
- Filter by breakdown definition. Click on a Breakdown definition icon in the header to highlight the elements that are linked to the breakdown. You can select multiple breakdowns. In this case, any element that is linked to at least one of the selected breakdowns is highlighted.
- Filter on text. Enter text in the filter field, then leave the field. All elements that contain the text are highlighted.

All filter functions can be used in combination with each other.

Add elements to a KPI tree

Add elements to the KPI tree by using the drag-and-drop at the bottom of the project canvas.

Think about your business goal and critical success factors before you begin to work on a project.
Role required: sn_kpi_composer.user/admin, admin

1. Navigate to **KPI Composer** and open or create a project, then navigate to the Analysis tab.
2. Locate the KPI tree elements at the bottom of the screen.

![Add Business Goal, Add Critical Success Factor, Add Measurement]

3. Drag a Business Goal icon to the top of your project.
   To keep your planning simple, usually you have one business goal for each project, but you can have business goals as children of other business goals.
4. In the Business Goal properties, give the business goal a meaningful name and a description.
   Set any other properties as described in "Element properties." You can edit these properties later by clicking the Edit icon on the element tile.
5. Repeat this process with Critical Success Factors and Measurements.
   Critical Success Factors can be children of Business Goals or other Critical Success Factors. A Measurement can be a child of any element.

**Element properties**
Each element in a KPI tree can reference knowledge base articles, personas, or breakdown definitions.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| Info     | Specify any of the following details:  
- Knowledge articles that contain further explanation about the element. You can link any number of knowledge articles.  
- Element owners  
- Contact persons | This short animation shows a knowledge article being added to an element. |
### Property: Persona

The personas currently linked to the project. In the element properties, you can only add and remove personas to the element. For information about adding personas to the project, see [Add personas to a project](#).

In this image, the Agent and CIO personas are linked to the project. The CIO persona is linked to the element and the Agent persona is not.

### Property: Group by

Group the data associated with an element by one or more of the breakdown definitions selected for the project. For information about adding breakdown definitions to the project, see [Group data by breakdown definitions](#).

In this image, the Assignment Group, Impact, and Priority breakdown definitions are available for the element. The data in the element is grouped by only Assignment Group.
Designing dashboards

In the Dashboard Design tab, you can create mock-ups of multiple dashboards with visualizations corresponding to elements in the Analysis tab. You can link widgets in this mock-up to Performance Analytics widgets.

The final outputs of your project are Performance Analytics dashboards, with perhaps separate dashboards or separate tabs corresponding to your Critical Success Factors and widgets displaying the measurements. In Performance Analytics, you cannot create these dashboards until all of the underlying indicators and breakdowns are created. Designing the widgets for these indicators is also somewhat technical, requiring at least a pa_power_user role. When you share the final dashboards, too often the viewers who need the dashboards send feedback that your designs did not quite meet their needs or expectations.

The KPI Composer Dashboard Design tab lets you start dashboard design much earlier in the workflow. You can start work on the visualization when you have only a conceptual tree of your success factors and measurements on the Analysis tab. Furthermore, you can involve other stakeholders earlier in the process. Use KPI Composer in presentations early on to get timely feedback, so when your project is complete, the dashboard viewers get the visualizations they expect.

Add a dashboard
As the first step in designing your dashboards, add a blank dashboard to the KPI Composer Dashboard Design tab.

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab.

Role required: sn_kpi_composer.user/admin, admin
1. Navigate to KPI Composer and open the project.
3. Click + Add Dashboard.
4. Give the Dashboard a meaningful name, probably corresponding to a Business Goal or a higher-level Critical Success Factor in the KPI tree.
5. Optional: Click the Edit Item icon in the Dashboard element to edit dashboard properties.
6. Repeat this process for as many Business Goals or Critical Success Factors for which you want to create dashboards.

Add a Customer Experience dashboard to the Design tab
In the following short animation, you see the user create a dashboard named Customer Experience, after a Critical Success Factor. The user adds the Agent and CIO personas, who are expected to view the dashboard. The user groups all the
widgets on the dashboard by Assignment Group, intending to create a breakdown

KPI Composer dashboard details
Each KPI Composer dashboard mock-up can reference project personas or 'Group by' categories, or an existing Performance Analytics dashboard.
<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>PA Dashboard</td>
<td>Link to an existing Performance Analytics dashboard. This can be an older dashboard that corresponds to your use case, or a new dashboard that you create based on this KPI Composer design. By linking dashboards as you create them, you can keep track of the state of your project.</td>
<td>In this image, you see the existing Performance Analytics dashboards being filtered by the word “Incident”.</td>
</tr>
<tr>
<td>Detail</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Persona</td>
<td>The personas you expect to view the final dashboard. Choose from the personas currently linked to the project. For information about adding personas to the project, see <a href="#">Add personas to a project</a>. After you link personas to a dashboard mock-up, only the elements from the Analytics tab that are associated with those personas are available.</td>
<td>In this image, the Agent, CIO, and Incident Manager personas are linked to the project. The Agent and CIO personas are linked to the dashboard. The Incident Manager is not.</td>
</tr>
</tbody>
</table>
Add tabs and rows to a dashboard

A dashboard mock-up in KPI Composer requires you to lay out the tabs and rows before adding visual components.

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also have at least one dashboard defined in the Dashboard Design tab.

Role required: sn_kpi_composer.user/admin, admin

1. Open a KPI Composer project and navigate to the Dashboard Design tab.
2. Select one of the dashboards in the tab.
3. Click the + icon underneath the dashboards to add a tab to the selected dashboard.
4. Give the tab a meaningful name, probably matching a lower-level Critical Success Factor.
5. Click Add Row.
   A row is a horizontal design area. Add at least one row to each tab.
6. In the Row details dialog, select the number of canvases in the row.
   The term ‘canvases’ here refers to Performance Analytics widgets and reports. Decide how many canvases you want placed horizontally in the row. You can select up to three canvases.
   You can change this number or move the row later.
Adding a tab and a row to a dashboard

In the following short animation, you see a user adding the Quality of service tab to the Customer Experience dashboard mock-up. The user gives the first row in this tab three canvases.

Add more rows or tabs following this procedure. Or, you can add canvases to the rows you have created and come back and add more tabs and rows later.
Add canvases to a dashboard tab
Combine analytics elements and visualizations to create visual components, called canvases, on a KPI Composer dashboard mock-up.

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also have at least one dashboard defined in the Dashboard Design tab. Lastly, one of these dashboards has at least one tab, containing at least one row.

Role required: sn_kpi_composer.user/admin, admin

1. Open a KPI Composer project and navigate to the Dashboard Design tab.
2. Select one of the dashboards in the tab.
   Select a dashboard with at least one tab and a row with empty canvas slots.
3. In the upper right of the Dashboard Design tab, expand the Elements icon.
4. Select an element that you want to represent in an empty canvas slot, and drag the element to the slot.
   You previously defined these elements in the KPI tree in the Analysis tab.
   If you have selected any personas in the dashboard properties, only the elements that are linked to those personas are available.
5. In the upper right of the Dashboard Design tab, expand the Widgets icon.
6. Decide which widget best illustrates the element you previously selected, and drag it to the same canvas slot.
   Widget designs use static images and not actual data visualizations.
   The Canvas Details dialog opens.
7. Fill in the Canvas Details, as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget</td>
<td>Select the widget visualization. If you have already selected a visualization, you can change it here.</td>
</tr>
<tr>
<td>Title</td>
<td>By default the position of the widget in the dashboard is here. Change this to a meaningful title, such as Percent of incidents per assignment group.</td>
</tr>
<tr>
<td>Contents</td>
<td>Further information for the widget viewer that does not fit in the title, such as The percentage of each open incident that is given to a specific assignment group. The total may not reach 100, as unassigned incidents are not included. This entry is visible as a legend in the widget.</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the widget for internal use, such as Widget based on formula indicator % open incidents by assignment group. This entry is not visible in the widget.</td>
</tr>
</tbody>
</table>
On a Performance Analytics breakdown dashboard, does this widget follow the breakdown element that a viewer selects?

Show results in daily, weekly, or monthly increments.

The element measured in this widget. You can select any element in this field, not only Measurements.

Select an existing Performance Analytics widget that matches this mock-up widget.

You now have an element from your analysis and a visualization to illustrate that element on your dashboard.

**Adding a canvas to a dashboard**

In this short animation, you see a user adding a canvas to the Quality of Service tab of the Customer Experience dashboard. The user first picks an
element from their KPI Tree and then selects a widget to illustrate that element.
When you have populated a dashboard, you can change the row order, widget order, or widget title in the element banner. The following short animation demonstrates how to move dashboard components.
Designing indicators

On the KPI Composer Indicator Design tab, you further specify the elements you defined during analysis and link them to indicator definitions.

After you open the indicator design tab, you see the same KPI tree that you defined in the Analysis tab. The header with personas and breakdown definitions and the footer with new elements are gone. Each tree element has a grey box that shows the related indicator definition. If no indicator definition has been linked yet, the grey box shows a plus sign, +.

Indicator definitions

An indicator definition contains the exact description of how to develop a specific Performance Analytics indicator. The indicator definition itself is not a Performance Analytics indicator. The indicator definition bridges the function-oriented element in the KPI tree and the technical implementation of the indicator in Performance Analytics.

When a suitable Performance Analytics indicator exists, you can add a link to it in the indicator definition. This link has no technical effect, but it can help you track your work. At the end of your project, every indicator definition should be linked to a Performance Analytics indicator.

Create an indicator definition

You can create a new indicator definition directly from the relevant element in the Indicator Design tab. Fill the indicator definition with the necessary information for creating a Performance Analytics indicator.

You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. You also need technical knowledge of Performance Analytics indicators.

Role required: sn_kpi_composer.admin or admin to link to a Performance Analytics indicator, sn_kpi_composer.user for other functionality

You usually create an indicator definition for every Measurement in your KPI tree. You might define indicators for one or more Critical Success Factors. You usually do not create indicator definitions for business goals.

1. Navigate to KPI Composer and open the relevant project.
2. Navigate to the Indicator Design tab.
3. Locate an element, probably a Measurement, that you want to define an indicator for.
   Elements with no indicator definition have the word "Undefined" and a plus sign, +, at the bottom.
4. Click the plus sign, +.
5. In the PA Indicator field, you can search the existing Performance Analytics indicators on this instance to see if any match this indicator definition.

Note: Requires the sn_kpi_composer.admin or admin role.
You can only search the indicators by name.
After you create an indicator for this indicator definition, you can come back to KPI Composer and link to it. Doing so can help you track your progress in completing this project. A link icon appears in elements next to the name of each indicator definition that is linked to a Performance Analytics indicator.

6. Decide on the **Direction** of the indicator.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximize</strong></td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting Maximize for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td><strong>Minimize</strong></td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting Minimize for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td><strong>None</strong></td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

7. Decide whether the measurement is best represented by an Automated, Formula, or Manual indicator.

<table>
<thead>
<tr>
<th>Indicator Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automated</strong></td>
<td>An automated indicator is based on an indicator source. The indicator source specifies a table and a frequency at which scores from this table are saved.</td>
</tr>
<tr>
<td><strong>Formula</strong></td>
<td>Create a formula indicator to use the scores and analytics of other indicators to produce a new computed score.</td>
</tr>
<tr>
<td><strong>Manual</strong></td>
<td>Manual indicators are not associated with an indicator source. Scores for manual indicators are not generated automatically by a data collection job. Instead, populate these indicators by adding scores manually or by importing data. Manual indicators are typically used for data that cannot be retrieved from the ServiceNow instance because it comes from an outside system, such as customer data from a third-party sales system.</td>
</tr>
</tbody>
</table>

8. Fill in any remaining fields.
   - If you are defining a Manual indicator, you do not have to add any more information.
• If you are defining a Formula indicator, clearly describe to a Performance Analytics administrator how to build the formula. You do not have to use actual formula indicator JavaScript syntax.

• If you are defining an Automated indicator, include the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>The aggregate function to apply to the data from the indicator source.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Expected periodicity for collecting data. Usually indicator Frequency matches the indicator source Valid for frequency value.</td>
</tr>
<tr>
<td>Facts table</td>
<td>The table that the indicator source references.</td>
</tr>
<tr>
<td>Condition</td>
<td>Textual description of the conditions for filtering records from the facts table. You do not have to use Condition Builder syntax.</td>
</tr>
</tbody>
</table>

9. Either click **Submit**, or, if you want to define supporting indicators, open the context menu and click **Save**.

**Creating an indicator definition**

In the following short animation, the user defines a formula indicator for the measurement "% of incidents resolved in time." The formula takes the ration of the number of incidents resolved on time to the total number of resolved incidents and multiplies the result by 100. Exact syntax is not followed.
Add supporting indicators
After you create an indicator definition in KPI Composer, you can add supporting indicators to that definition. Formula indicator definitions, where the formula includes one or more other indicators, require supporting indicators to be complete.
You have an existing KPI Composer project with a complete draft of the KPI tree in the Analytics tab. This project has at least one indicator definition that requires references to other indicators. You need technical knowledge of Performance Analytics indicators.

Role required: sn_kpi_composer.user/admin, admin

1. In the relevant element on the Indicator Design tab, click the info icon next to the indicator definition name to open the indicator definition.

2. In the Supporting Indicator Definitions related list at the bottom of the Indicator Definition dialog, click one of the following buttons:
   - Click New to create a new indicator. Follow the same procedure that is described in Create an indicator definition.
   - Click Edit to open a list of existing indicator definitions in this project. You can select as many indicators as are needed.

Search the existing indicator definitions before you create new ones, so as not to duplicate indicators.

Reviewing your project

Summarize both the created KPI Composer project elements and the planned Performance Analytics components. Validate the contents of your project. Generate the tasks to build the planned Performance Analytics components.

Navigate to the Review tab at any time for an up-to-date account of completed design work and pending Performance Analytics configurations.

The review tab shows four boxes of information:

**Summary**

Sums up the number of elements, personas, and breakdowns defined on the Analysis tab. Click an item type to open a list of those items.

**PA Elements**

Shows the number of Indicator Definitions and Breakdown Definitions in the project. Click an element type to open a list of those elements.

**Project validation**

Click Refresh Data after adding new or editing existing definitions. The following levels of issues are identified:

- Warning: A Critical Success Factor is not linked to an Indicator Definition.
- Error: A Measurement is not linked to an Indicator Definition, or an Indicator or Breakdown definition is not linked to a facts table.

**To Do List**

Shows the tasks that are generated based on the project definitions. For more information, see the “To Do List” section.
To Do List

The To Do List shows what Performance Analytics indicators and breakdowns you have to create to produce the dashboard that you designed in this KPI Composer project. Click **Rebuild To Do List** to generate a new list of tasks. All existing tasks of the project are removed first.

**Note:** The Project validation list includes dashboard design validation messages. However, the To Do List generates only tasks related to creating indicators and breakdowns.

If an indicator definition is already linked to a Performance Analytics indicator, a task to create that indicator is not generated. The same logic applies to breakdown definitions.

Some validation tasks have you check whether Performance Analytics indicators and breakdowns are correctly configured. See the contents of these tasks to get detailed instructions on what to check.

To see a full list of project tasks, navigate to **KPI Composer > Project Tasks**.

When a task is completed, open the relevant Project Task record and select **Implemented**.

**Performance Analytics indicators**

Indicators define a performance measurement taken at regular intervals of a business service, an activity, or organizational behavior. These performance measurements result in a series of indicator scores over time.

Key characteristics of indicators include:

- Indicator scores can be generated automatically from a set of records defined in an indicator source, entered manually, or calculated from other indicators.
- Indicator scores can be viewed or analyzed in the Analytics Hub or presented, via widgets, on dashboards.

**Set up indicators**

Create an indicator that is based on an indicator source or that uses manually entered scores. You can also create an indicator based on a formula that uses existing indicators.

**Indicator sources**

Indicator sources define filtered sets of records to evaluate when collecting indicator scores.

An indicator source configuration specifies a table, such as Incident [incident], and it specifies the frequency with which to collect data from that table. An indicator source cannot specify a rotated table. Multiple indicators can use the same indicator source.

Typically, an indicator tracks the situation on a certain date. The indicator source conditions should include a date-related filter, such as [Opened] [on] [Today]. Indicators collected less frequently might specify a larger date range, such as [Closed] [on] [This month].

Create indicator sources carefully. Since multiple indicators may be linked to an indicator source, it is not easy to change the indicator source after you created it. Furthermore, changing an indicator source can cause a disjoint with scores that you have already collected.

**Note:** Indicator sources must be created before you can create an indicator.

Create an indicator source

Create an indicator source to define the set of records to evaluate when collecting indicator scores.
Look at the list of indicator sources, for these reasons:

- An indicator source that meets your requirements may already exist. To help maintain your instance, you should not create duplicate indicator sources.
- If you do need to create an indicator source, ensure that you are giving it a unique name. Giving the same name to different indicator sources can be confusing.

Role required: pa_data_collector or admin

1. Navigate to Performance Analytics > Indicator Sources and click New.
2. Enter a unique Name by which you can easily see what the indicator source is used for, such as Incidents.Open.
3. Add a detailed Description to help others understand the use and purpose of this indicator source and to help them avoid creating duplicates.
4. In the Valid for Frequency field, select how often to collect the scores for the indicator source, such as Daily, Weekly, or Bi-weekly.
   Indicators based on this indicator source use the Valid for frequency value as the indicator Frequency. The frequency of the data collection job for the indicator should match this value.
   If you are uncertain about the frequency to set, base the frequency on your business cycle.
5. Select a facts table, either directly or by reusing a report source:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facts table</td>
<td>Specify the facts table and any conditions for filtering the records of that table. You can specify a database view as the facts table.</td>
</tr>
<tr>
<td>Report source</td>
<td>Specify an existing report source to reuse. A report source specifies a facts table and filtering conditions. If the report source changes, a warning appears when you view the indicator source to inform you about the change. To update the indicator source, click the refresh button next to the Report source field.</td>
</tr>
</tbody>
</table>

   **Warning:** Performance Analytics does not support rotated tables. If you select a rotated table as your facts table, data collection will not be accurate. For more information about rotated tables in general, see Table rotation.

   **Warning:** Do not change the facts table for a source after you have started collecting data. If you change the facts table, all historical scores for the associated indicators are lost.

6. If you select a facts table directly, add Conditions that must be fulfilled before data is included in the subset.
   For example, set the conditions [Active] [is] [true] OR [Created] [at or before] [date]. Any records that match the conditions are shown immediately.

   **Note:**
   - Indicator source conditions on text fields are not case-sensitive.
   - Conditions set on indicator sources and indicators all apply.
For an indicator to display real-time scores, set a condition either on the indicator or the indicator source.

Tip:
- Due to the reusability of indicator sources, use only high-level criteria to define indicator source conditions. Use the advanced filters on individual indicators to go deeper into the data.
- Indicator sources should have a date condition, such as (Created)(on)(Today).
- Usually, date conditions should refer to the same time period as the indicator frequency. For example, conditions that refer to days should only be on daily indicators and conditions that refer to months should only be on monthly indicators.
- Avoid dot-walking to the sys_id or display value of a table. Instead, use the reference field by itself, to avoid creating unnecessary joins.
- If your indicator source conditions are well designed, at least one of the indicators on that source will not have any additional conditions of its own.

For general information about building conditions, see Condition builder.

7. Optional: Define RELATED LIST CONDITIONS to include a relationship with another table in the filter.

For more information, see Add related list conditions.

8. Optional: In List view, select the default view on Workbench widgets and the Analytics Hub of lists of facts table records collected for this indicator source.

The available views vary depending on the facts table.

9. Click Submit.

Simple indicator source

The following settings create an indicator source that collects new incidents daily:

- **Name**: Incidents.New
- **Frequency**: Daily
- **Facts table**: Incident [incident]
- **Condition**: [Opened] [on] [Today]
Create indicator sources

After you create an indicator source, you can define text index configurations in a related list on the record. Use these configurations to create Performance Analytics text widgets with word clouds. For more information, see Set up text analytics.

If you are reusing a report source and the report source changes, a warning appears on the indicator source record. To update the indicator source to match the report source, click Update report source. You can click the refresh button next to the Report source field instead.
The read-only **Report source updated at** field displays the last time the report source was updated. This date and time always appear in the GMT time zone.

**Use a database view in an indicator source**

You can select a database view as the facts table in an indicator source. Database views enable you to combine data from tables in your ServiceNow instance that are not connected by default.

By joining tables in a database view, you can easily access them by calling up the view, and then select fields from any of the tables included in the view. For example, if you want to report on the number of SLAs breached, you need fields from both the SLA and the Incident tables.

If you select a database view as the facts table for an indicator source, provide additional configuration in the **Records view** section of the Indicator Source form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Table</td>
<td>Select the table to collect records from, for example, incident.</td>
</tr>
<tr>
<td>List View</td>
<td>Select the list view used to display collected record sets. <strong>Default view</strong> is suggested, but you can select any defined view, such as Self Service or Mobile.</td>
</tr>
</tbody>
</table>

**Create an indicator and related records**

You can quickly create a Performance Analytics indicator and breakdowns, widgets, and data collection jobs for that indicator.

Role required: pa_contributor, pa_data_collector, pa_power_user, or pa_admin

Ensure that there is at least one indicator source and a data collection job for the indicator source facts table.

These instructions are for using a wizard to create a simple automated indicator quickly. If you need access to the full range of indicator parameters, see **Create an automated indicator**.

1. Navigate to **Performance Analytics > Indicators > Create New**.
2. Enter an **Indicator name**.
3. Optional: Specify any other descriptive values for the indicator, such as the **Direction** of the chart, the **Unit** of measurement for numerical values, or the indicator **Group**.
4. Click **Next**.
5. Select an **Indicator source**.
6. Select an **Aggregate**, such as **Count** or **Average**.
   
   If you select an aggregate other than **Count**, you must specify a **Field** or **Script** to use when performing aggregate calculations. You can perform aggregate operations using fields from the indicator source facts table.

7. Optional: Select any additional filtering conditions to filter the indicator data. This filter is applied in addition to any filter defined on the indicator source record.
8. Click **Next**.
9. Select the breakdowns you want to apply to this indicator. Clear the check box for any breakdowns you do not want to apply.
10. Click **Next**.
11. Optional: Select the data collection **Job** you want to use to populate the indicator data. Indicator data is populated only by data collection jobs. If an indicator has no associated collection job, the indicator will not contain any data.
12. Optional: Select **Collect data from the past** and a date range to collect historical data.
   
   If you choose to collect historical data, a new collection job is created and run once to populate the historical data.
13. Click **Next**.
14. Optional: Select any widgets you want to create to display the indicator data. You can specify widget values such as the **Time Series** or add the widget to a dashboard tab.

15. Click **Next**.

16. Review the changes, then click **Apply**. The indicator is created and linked to the selected indicator source, breakdowns, and data collection job. Any widgets associated with the indicator are created and added to the specified dashboard tab.

17. Optional: Click **Create another indicator** to restart the process with a new indicator.

If the data collection job is configured to collect historical data, a temporary data collection job with a **Run** value of **Once** is created. You can delete this job record after the job runs.

Indicator creation widget options

There are several options for creating widgets to display the indicator data when creating an indicator and related records. You can create any or all of the available widget types.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time series widget</td>
<td>Select this check box to create a time series widget to display the indicator data.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>Visualization</td>
<td>Select the chart type to use to display the data, such as Line or Column.</td>
</tr>
<tr>
<td>Latest score widget</td>
<td>Select the check box to create a score widget with a <strong>Visualization</strong> value of <strong>Latest Score</strong> to display the indicator data.</td>
</tr>
<tr>
<td>Time series</td>
<td>Runs a function on the indicator scores for a specific time period, such as a 7-day sum or average. For more information, see Time series aggregations in the Analytics Hub and widgets.</td>
</tr>
<tr>
<td>PerIODS back</td>
<td>Select the number of periods to compare the score with. For example, if the Time series is By week SUM, enter a Periods back value of 4 to compare the current score with scores from the past 4 weeks.</td>
</tr>
<tr>
<td>Breakdown widgets</td>
<td>Select this check box to create a breakdown widget with a scorecard visualization for each breakdown applied to this indicator.</td>
</tr>
<tr>
<td>Put the widgets on a new tab on dashboard</td>
<td>Select a dashboard you want to add these widgets to. If you do not select a dashboard, widget records are created but they are not added to any dashboard.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>New tab name</td>
<td>Enter a name for the new tab created to display these widgets. This field is required if you select a dashboard.</td>
</tr>
</tbody>
</table>

Create an automated indicator

To save scores from a table according to a regular frequency, create an automated indicator.

Role required: pa_admin, pa_power_user, and pa_data_collector

An automated indicator is based on an indicator source. The indicator source specifies a table and a frequency at which scores from this table are saved. After you select the indicator source and specify other properties, choose scheduled jobs to collect data for the indicator.

This form provides all the many options for creating an automated indicator. To create a simple automated indicator quickly, see Create an indicator and related records.

Note:
- You must have a subscription for Performance Analytics to create indicators.
- If you are using domain separation, the indicator is created in the domain that you are currently in.

1. Navigate to Performance Analytics > Indicators > Automated Indicators and click New.
2. In the Name field, give the indicator a descriptive name, such as Number of Critical Incidents.
3. Go to the Sources tab and select the indicator source.
   a) Optional: In the Frequency field, filter the selection of indicator sources by their frequency of data collection.
   The frequency of the indicator is set automatically based on the frequency of the selected indicator source, such as Daily, Weekly, or Monthly. Filling in this field limits the list of indicator sources to the ones whose frequency matches the field value. This field is hidden after you select the indicator source.
   b) Scroll to the Source tab and select an Indicator Source.
      Typing a partial name in the field filters the list of available indicator sources accordingly.
4. In the Aggregate field, select the aggregate function to apply to the data from the indicator source.
   Count counts the number of records. Count distinct counts the number of unique values rather than the total number of records. For example, if the name of a user appears more than once in a list, the user is only counted once. Other choices perform the specified aggregate operation, such as summing the values in a field across records.
   If you select a Sum, Minimum, or Maximum aggregate, consider excluding some types of time series from being applied to the indicator. For more information, see Exclude time series from an indicator.

   Tip: Try to avoid using the Average aggregate, because that aggregate can complicate the use of time series. Instead, create a Sum automated indicator and a Count automated indicator. Then create a Formula indicator that divides the Sum indicator by the Count indicator to calculate the average.
5. If you prefer that the score of this indicator increases or decreases over time, select Maximize or Minimize in the Direction field.
Analytical tools and graphic displays use this **Direction** with this indicator.

**Tip:** Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting Maximize for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting Minimize for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

6. Optional: Specify any of the remaining indicator properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>The unit of measurement for the score, such as number, days, or percentages.</td>
</tr>
<tr>
<td>Precision</td>
<td>The number of digits behind the decimal separator. For thousands and millions, the score is given in thousands or millions followed by a <code>k</code> or an <code>M</code>, with the next lowest power of 10 following the decimal. For more information, see <a href="#">Rounding and precision in indicators</a>.</td>
</tr>
<tr>
<td>Key</td>
<td>Identifies the indicator as a key indicator. Used only to filter the list of indicators in <strong>Performance Analytics &gt; Analytics Hub</strong>.</td>
</tr>
</tbody>
</table>

7. Optional: In the **Source** tab, complete any remaining fields. These fields are available only if **Aggregate** is not set to **Count**.
### Source tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collect records</td>
<td>Check box to indicate if the individual record sys_ids are stored when the indicator is collected. Selecting this check box enables you to drill down to those details in the Analytics Hub and widgets. When available, collected records appear on the Records tab. <strong>Tip:</strong> Generally avoid collecting records with aggregates other than Count and Sum. Users rarely want to see the records that go into a Min or Max, and the number of records in a Count Distinct may differ from the score. Consider collecting records for indicators with these other aggregates only if a user asks for them. This option must be enabled for the main indicator of a Spotlight group. Otherwise, the Spotlight group cannot evaluate a snapshot of collected records. For more information, see <em>Evaluating snapshot or real-time data</em>.</td>
</tr>
<tr>
<td>Scripted</td>
<td>A check box to indicate if the value should be aggregated based on a script. This option is available only if <strong>Aggregate</strong> is not set to <strong>Count</strong>. Clear the <strong>Scripted</strong> check box to aggregate the values in a field.</td>
</tr>
<tr>
<td>Field</td>
<td>The field to perform the aggregate operation on. This field appears only if <strong>Aggregate</strong> is not <strong>Count</strong> and <strong>Scripted</strong> is not selected.</td>
</tr>
<tr>
<td>Script</td>
<td>Select a script or create a new script for the aggregation. This option is available only if the <strong>Scripted</strong> check box is selected. For more information, see <em>Scripting in Performance Analytics</em>.</td>
</tr>
<tr>
<td>Value when nil</td>
<td>The value that is inserted as the score when no value is collected. This value applies only to the indicator score. It does not impact scores for breakdown elements.</td>
</tr>
</tbody>
</table>

### Optional:

In the **Additional Conditions** tab, add conditions to limit the set of records that the indicator evaluates.

The conditions in the indicator apply in addition to the conditions in the indicator source. For real-time scores to be displayed, a condition must be set in the indicator or indicator source.

However, the following operators are not supported on indicators, and so use them only on indicator sources:

- **keywords**
- is same
- is different
- greater than field
- less than field
- greater than or is field
- less than or is field
- is one of
- is not one of

**Warning:** To avoid a data collection job completing with errors, follow these limitations:
- Do not add a condition that references Roles to an indicator. You can reference the Roles table only in an indicator source.
- If you define conditions that refer only to dot-walked fields, you must associate at least one breakdown with the indicator.

In general, try to avoid dot-walking to sys_id or the display value of a table, as doing so creates unnecessary joins.

**Tip:** To verify that your conditions are well-designed, list the indicators for an indicator source and include the Conditions field in the view. You should have at least one indicator that only uses the conditions on the indicator source. Otherwise, your indicator source is probably collecting unused data. In this case, consider moving common conditions from the indicators to the indicator source, or splitting the indicator source.

9. In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

10. Optional: In the **Other** tab, set various miscellaneous properties.
### 'Other' tab fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. The indicator frequency restricts which time series are available. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Live group profile</td>
<td>Live group profile that indicates the live group where the indicator scores are published.</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the <strong>Order</strong> field, indicators are displayed from a to z using the <strong>Name</strong> field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
<tr>
<td>Default chart type</td>
<td>Set a default chart type (line, column, spline, or area) for this indicator. When opening the Analytics Hub for this indicator for the first time, the default chart type is used. If the chart type is changed in the Analytics Hub, that preference is remembered.</td>
</tr>
<tr>
<td>Render continuous lines</td>
<td>When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets with varied starting dates or data that is not regularly updated, such as stock information.</td>
</tr>
<tr>
<td>Show real-time score</td>
<td>When selected, the Analytics Hub shows the score of this indicator in real time, as well as the current state of associated records. Clear this check box when indicator data is not available in real time, such as in an integration that uses data from a third-party source. Note: A condition must be set on the indicator or the associated indicator source for real-time scores to be displayed.</td>
</tr>
<tr>
<td>Show delta</td>
<td>When selected, enables reporting of historic records when viewing this indicator in the Analytics Hub. You can filter the data to display only the current data, only the historical data, or the data shared between both sets.</td>
</tr>
</tbody>
</table>
11. Optional: In the **Collect breakdown matrix fields** tab, you can enable second-level breakdowns for the indicator, such as Open Incidents by Category by Priority. Enabling second-level breakdowns can significantly impact performance.

12. Optional: In the **Collection periods** tab, override the properties that set the maximum number of periods prior to today for which scores and snapshots are collected and kept. To see the properties that you would override, go to **Performance Analytics > System > Properties**.

13. Optional: In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values. For more information, see **Performance Analytics scores forecasts**.

14. Click **Manage Breakdowns**.

### Assign and map breakdowns

Select which breakdowns to assign to an indicator. Map which field on the indicator source references the breakdown source. If no appropriate field is available, specify a script to associate the indicator and breakdown sources.

The desired breakdowns must be defined with breakdown sources.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin

You can create multiple mappings for the same breakdown, enabling you to use that breakdown for multiple indicators.

**Note:**

- The maximum number of breakdown elements that can be included in data collection is set in the property `com.snc.pa.dc.max_breakdown_elements_limit`. Warnings appear in the tool when this value is exceeded. For more information, see **Performance Analytics properties**.
- The procedure on this page uses a graphical tool. You can instead select the breakdowns for the indicator in the **Breakdowns** related list on the indicator form, as described in **Kingston documentation**. You also can map the indicator fields or queries for the indicator source on the breakdown form. For more information, see **Create a breakdown mapping on a breakdown record**.

---

1. Navigate to the indicator that you want to assign a breakdown to.
2. Click **Manage Breakdowns**.
3. Move the breakdown you want to assign to the indicator from **Available Breakdowns** to **Selected**

4. If you are adding an unmapped breakdown, do one of these actions:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use a field to map values to elements.     | Select the **Field** in the indicator source that maps to records in the breakdown.  

See the use of the **Category** field in [Example: Field mapping](#).  

| Use a script to map values to elements.    | Select **Scripted**, then select the **Script** that defines the association between indicator records and breakdown elements.  

Use a script when you do not have the simple use case of a field in the indicator source that maps to a breakdown source table. A script can define a wide range of mapping relationships. The most common use case is when the breakdown source is a bucket group and the script returns an integer to assign an indicator score to a bucket.  

See [Example: Script mapping](#).  

You cannot show real-time scores for an indicator that uses a scripted breakdown. |

**Note:** If you click the **Facts table** choice list, it opens, but you cannot select a different facts table.
5. Click **Submit**.
6. Repeat steps 2–5 as needed, to define additional mappings.

If you have assigned at least two breakdowns to an automated indicator, you can collect the two-breakdown combinations. If you do so, save system resources by excluding meaningless combinations of breakdowns from being collected. See **Collect and manage a matrix of breakdowns**.

**Collect and manage a matrix of breakdowns**
Collect a matrix of the two-breakdown combinations for an indicator. Exclude unnecessary or meaningless combinations of breakdowns from being collected.

Breakdowns must be assigned to the indicator. See **Assign and map breakdowns**.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin

Sometimes, not all breakdown combinations give useful information. For example, the combination (Country, Region) gives the same scores as the breakdown Country. You can prevent the instance from collecting data for these invalid combinations with breakdown matrix exclusions. These exclusions are not shown in the Analytics Hub or in the scoresheet and cannot be selected when creating widgets.

To prevent performance issues, the property **com.snc.pa.dc.max_breakdown_elements_level2_limit** limits the number of elements from
breakdown connections that are included in data collection. If you exceed this limit, some of
the combinations in your matrix are grayed out. By excluding some breakdown combinations,
you can help to avoid exceeding this limit. For more information, see Performance Analytics
properties.

Note:
- The scores for individual breakdowns are still collected when the combination of those
breakdowns has been excluded.
- Scores that were collected in previous jobs for breakdown combinations are not deleted
when those combinations are later excluded. New scores for those combinations are
not collected.
- These instructions are for using the graphical tool to manage breakdown matrix
exclusions. However, you can also manage them in the Breakdown matrix exclusion
tab of the indicator form. For more information, see Exclude a breakdown from the
breakdown matrix in the Kingston documentation.

1. Navigate to Performance Analytics > Automated Indicators.
2. Select the automated indicator for which you want to configure the breakdown matrix.
3. Under Indicator properties, select the Collect breakdown matrix tab.
4. Select the Collect breakdown matrix check box.
5. Click Manage Breakdowns.
6. Click Configure Breakdown Matrix.
   By default, all combinations are included in data collection. You can select combinations to
exclude from data collection.
7. Optional: In the Breakdown Matrix pop-up, select breakdown combinations
to exclude from Analytics Hub and dashboard widgets. Included
combinations are shaded in the breakdown matrix. Excluded combinations
are white. If the number of breakdown combinations exceeds the value of
8. Optional: On the indicator form, open the **Breakdown matrix exclusion** tab and see which breakdown combinations have been excluded.
   You can manage which breakdown combinations to exclude in this tab instead of using the graphical tool.

**Edit a job for the indicator**

Add a data collection job to an indicator to collect scores for that indicator.

**Role required:** pa_admin, pa_power_user, or admin

1. Open an existing automated indicator.
2. In the **Jobs** related list, click **Edit**.
3. Optional: Use **Add Filter** and **Run Filter** to limit the selection of jobs.
4. Select one or more jobs in the **Collections** or **Jobs List**.
   Unless you have a clear use case to do otherwise, help keep your jobs manageable by selecting no more than one scheduled job for your indicator. Select as many unscheduled jobs as are relevant.
5. Use the arrow buttons to move the jobs to the other list.
6. Click **Save**.
Create a manual indicator
Create a manual indicator to enter indicator scores manually. Manual indicators are typically used for data that cannot be retrieved from the ServiceNow instance because it comes from an outside system, such as customer data from a third-party sales system.

Role required: pa_admin, pa_power_user, or admin

Manual indicators are not associated with an indicator source. Scores for manual indicators are not generated automatically by a data collection job. Instead, populate these indicators by adding scores manually or by importing data.

Note:
- You must have a subscription for Performance Analytics to create indicators.
- If you are using domain separation, the indicator is created in the domain that you are currently in.

1. Navigate to Performance Analytics > Indicators > Manual Indicators and click New.
2. In the Name field, give the indicator a descriptive name, such as Number of Critical Incidents.
3. In the Frequency field, select the frequency at which scores are set.
   The default value is Daily.

   Note: The frequency for a manual indicator specifies how to visualize its data. For example, if you set the data points per day or per month in the charts, the setting also affects the scoresheet, so it determines whether you can enter daily or monthly values.

4. If you prefer that the score of this indicator increases or decreases over time, select Maximize or Minimize in the Direction field.
   Analytical tools and graphic displays use this Direction with this indicator.

   Tip: Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting Maximize for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting Minimize for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

5. Optional: Specify any of the remaining indicator properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>The unit of measurement for the score, such as number, days, or percentages.</td>
</tr>
</tbody>
</table>
### Table: Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision</td>
<td>The number of digits behind the decimal separator. For thousands and millions, the score is given in thousands or millions followed by a k or an M, with the next lowest power of 10 following the decimal. For more information, see <em>Rounding and precision in indicators</em>.</td>
</tr>
<tr>
<td>Key</td>
<td>Identifies the indicator as a key indicator. Used only to filter the list of indicators in <em>Performance Analytics &gt; Analytics Hub</em>.</td>
</tr>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. The indicator frequency restricts which time series are available. For more information, see <em>Time series aggregations in the Analytics Hub and widgets</em>.</td>
</tr>
<tr>
<td>Live group profile</td>
<td>Live group profile that indicates the live group where the indicator scores are published.</td>
</tr>
<tr>
<td>Value when nil</td>
<td>The value that is inserted as the score when no value is collected. This value applies only to the indicator score. It does not impact scores for breakdown elements.</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the <strong>Order</strong> field, indicators are displayed from a to z using the <strong>Name</strong> field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
</tbody>
</table>
### Field Description

| Render continuous lines | When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets with varied starting dates or data that is not regularly updated, such as stock information. |

9. Optional: In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values.

For more information, see *Performance Analytics scores forecasts*.

Create manual breakdowns and assign them to this indicator. Then, manually add scores.

**Create a formula indicator**

Create a formula indicator to use the scores and analytics of other indicators to produce a new computed score.

Role required: pa_power_user or admin

Formulas are often used to:

- Calculate ratios and percentages.
- Combine data from different applications.
- Build predictive indicators based on historic performance.

The fields of a formula indicator are similar to an automated indicator except for the condition. Formulas can consist of other indicators, constants, variables, and time series, or any combination of these elements.

### Note:

- You must have a subscription for Performance Analytics to create indicators.
- If you are using domain separation, the indicator is created in the domain that you are currently in.

1. Navigate to **Performance Analytics > Formula Indicators** and click **New**.
2. In the **Name** field, give the indicator a descriptive name, such as Number of Critical Incidents.
3. If you prefer that the score of this indicator increases or decreases over time, select **Maximize** or **Minimize** in the **Direction** field.

Analytical tools and graphic displays use this **Direction** with this indicator.

### Tip:

Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.
<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting Minimize for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

4. Define the Formula for this indicator.

a) (Repeatable) To use an Analytics Hub calculated value in the formula, click **Browse for a method**.

A dialog opens for you to insert a method from `PAFormulaUtils()` into the formula. This API returns the Analytics Hub calculated value for an indicator. For more information about using this API, see [Get indicator analytics in formulas](#).

b) (Repeatable) To put the score of an indicator in the formula, click the **Browse for an indicator** link and fill in the dialog.

### Indicator selection dialog

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>The indicator you are inserting as a component into the formula.</td>
</tr>
<tr>
<td>Breakdown, Element, 2nd Breakdown, 2nd Element</td>
<td>Up to 2 levels of breakdown and element for filtering the scores on the indicator. If you specify a breakdown, you must specify an element of that breakdown. These breakdowns and elements apply only to this component indicator and not to the formula indicator as a whole.</td>
</tr>
<tr>
<td>Time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. This time series applies only to this component indicator and not to the formula indicator as a whole.</td>
</tr>
<tr>
<td>Allow breakdowns</td>
<td>Allows breakdowns that apply to the entire formula indicator to apply to this component indicator. Enabled by default. To see which breakdowns apply to the entire formula indicator, click <strong>Manage breakdowns</strong> at the top of the record.</td>
</tr>
<tr>
<td>Use in method</td>
<td>Returns a unique identifier instead of the score for this indicator. Select this box when you are specifying an indicator for a method in the formula. These methods get calculated values for the indicator from the Analytics Hub. For more information about using these methods, see <a href="#">Get indicator analytics in formulas</a>.</td>
</tr>
</tbody>
</table>
While you could add indicators manually, if you use the **Browse for an indicator** function, you ensure that you have the proper notation for indicators and breakdown elements.

c) Add mathematical operators and symbols to the **Formula** as needed.

Enter any operators or numbers to include in the formula. Use valid operator symbols, such as +, -, /, %, >, <. You can also add more indicators to the formula. For example, to calculate the average age of open incidents based on summed age of open incidents and number of open incidents, use the following formula: \[
\frac{\text{[[Summed age of open incidents]]}}{\text{[[Open incidents]]}} / 24
\]

To specify a data collection period in the formula, you can use the variables `score_start` and `score_end` to refer to the start and end of the data collection period, respectively. However, see the caveat in *Changes to score_start/end because of different user time zones.*

**Important:** Try not to use GlideRecords or GlideAggregates in Performance Analytics scripts or formula indicators. While sometimes you must use these operations to get what you want, they are very expensive, potentially running hundreds of thousands of times. Be certain that no alternative exists before you use them.

5. To apply a breakdown to the entire indicator, click **Manage breakdowns** at the top of the page.

   The breakdown can only be used interactively, meaning on Analytics Hubs, appropriately configured breakdown widgets, and breakdown dashboards. For information about using the **Manage breakdowns** tool, see *Assign and map breakdowns.*

6. In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

7. In the **Other** tab, set miscellaneous properties. These properties apply to the entire formula indicator.

<table>
<thead>
<tr>
<th>'Other' tab fields</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
</tr>
<tr>
<td>Default time series</td>
</tr>
<tr>
<td>Live group profile</td>
</tr>
<tr>
<td>Order</td>
</tr>
<tr>
<td>Field</td>
</tr>
<tr>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Render continuous lines</td>
</tr>
<tr>
<td>Apply time series to result</td>
</tr>
<tr>
<td>Allow formula component to be NULL</td>
</tr>
</tbody>
</table>

8. Optional: In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values.

For more information, see *Performance Analytics scores forecasts*.

Prevent a formula component from following breakdowns

You can prevent certain formula components from being broken down when a user applies a breakdown to the formula indicator.

When you apply a breakdown to a formula indicator, such as on a breakdown dashboard, the selected breakdown applies to all formula components. You prevent certain components from being broken down using the syntax `{{Indicator}}`. You can also prevent a formula component from following breakdowns by clearing the **Allow breakdowns** check box in the **Browse for an indicator** pop-up.

For example, consider the formula `[[Incidents]] / [[Customers]]`. If you apply a region breakdown to this indicator, and specify EU as the breakdown element, the formula indicator returns scores using the formula `[[Incidents > region = eu]] / [[Customers > region = eu]]`. However, to view the EU incidents divided by the total number of incidents across all regions, you can write the formula as `[[Incidents]] / {{Customers}}`. Using the `{{Indicator}}` format causes the Customers component to ignore breakdowns. This way, when you apply the region breakdown with the EU breakdown element, this formula indicator is equivalent to the formula `[[Incidents > region = eu]] / [[Customers]]`.

You can specify a breakdown within a component itself, such as `[[Incidents]] / {{Customers > importance = high}}`. In this example, the formula denominator is always broken down to include only the high-importance customers. Any breakdown applied to the formula indicator, such as the region breakdown, does not apply to the Customers component.

Breakdown matrices in formula indicators

Formula indicators inherit breakdown matrices from indicators in the formula.

If all the indicators in the formula collect breakdown matrices, second-level breakdowns are available for the formula indicator. If none of the indicators in the formula collects breakdown matrices, second-level breakdowns are not available for the formula indicator. If only some of the indicators in the formula collect breakdown matrices, only those indicators can be broken down at a second level.
For example, consider a formula indicator with the following formula:

\[
\frac{\text{Summed age of open incidents}}{\text{Number of open incidents}}/24
\]

Both the Summed age of open incidents and the Number of open incidents indicators have breakdown matrices collected. In the Analytics Hub for the formula indicator, you break down the scores first by Category=Software and second by Priority=High(2). The result is a score of 170.

Scores when both indicators in formula collect breakdown matrices

Now consider the same formula indicator, but the breakdown matrix is not collected for the Number of open incidents indicator. The result is a score of 11.
Scores when only one indicator in formula collects breakdown matrix

Detect indicators with no scores in a formula
As the formula creator, you can handle component indicators that have null scores. First set the formula indicator to calculate the formula even when it contains a null score.

Role required: pa_power_user, admin

The formulas in formula indicators typically contain one or more other indicators. If one of those indicators has no score, by default the formula is not calculated and the formula indicator returns no score. However, several use cases exist for identifying the indicator that has no score instead of having the formula indicator return null. First enable the formula to be calculated when an indicator in the formula has no score. Then you can assign a value to an indicator with no score.

1. Open the formula indicator of interest.
2. Select **Allow formula component to be null**.
3. In the **Formula**, add an `if() else {}` statement that ascribes a value to an indicator when it has no score.

<table>
<thead>
<tr>
<th>Date</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nov 15</td>
<td>8,152 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 14</td>
<td>8,104 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 13</td>
<td>8,056 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 12</td>
<td>8,008 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 11</td>
<td>7,960 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 10</td>
<td>7,912 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 09</td>
<td>7,864 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 08</td>
<td>7,816 Hrs/31/24 = 11</td>
</tr>
<tr>
<td>Nov 07</td>
<td>7,768 Hrs/31/24 = 10</td>
</tr>
<tr>
<td>Nov 06</td>
<td>7,720 Hrs/31/24 = 10</td>
</tr>
<tr>
<td>Nov 05</td>
<td>7,672 Hrs/31/24 = 10</td>
</tr>
<tr>
<td>Nov 04</td>
<td>7,622 Hrs/31/24 = 10</td>
</tr>
<tr>
<td>Nov 03</td>
<td>7,574 Hrs/31/24 = 10</td>
</tr>
<tr>
<td>Nov 02</td>
<td>7,526 Hrs/31/24 = 10</td>
</tr>
<tr>
<td>Nov 01</td>
<td>7,478 Hrs/31/24 = 10</td>
</tr>
</tbody>
</table>
Field indicator with Allow formula component to be null

Consider the following formula indicators for a collection period when there are no closed incidents, so the indicator Number of closed incidents has no score.

Formula 1:

\[
\text{[[Number of open incidents]]} / \text{[[Number of closed incidents]]}
\]

Formula 2:

\[
\text{[[Formula 1]]} + 23
\]

Formula 3:

\[
\text{if } \text{[[Formula 1]]} \text{ == null } \{ \text{23} \text{ } \} \text{ else } \{ \text{11} \}
\]

Formula 4:

\[
\text{[[Formula 2]]} \text{ || 64}
\]

Formula 5:

\[
(\text{[[Formula 1]]} \text{ == null } \&\& \text{[[Formula 2]]} \text{ == null }) \text{ ? 11 } \text{ : 18)}
\]

If **Allow formula component to be null** is not selected for any of the formula indicators, none of them have scores.

If **Allow formula component to be null** is selected for all of the formula indicators, they have the following scores:

- Formula 1 = null
- Formula 2 = 23
- Formula 3 = 23
- Formula 4 = 64
- Formula 5 = 11

Formula 2, Formula 3, Formula 4, and Formula 5 represent four different ways to handle the null score.

Indexing multiple indicators in a formula

You can write a formula to measure what the gap is to the overall target of multiple, combined indicators. Such a formula indicator is called an ‘index indicator’.

The performance of processes, services, groups, and other business entities are often tracked and monitored using more than one indicator. When viewing and analyzing performance of these processes, business services, or workgroups, the overall picture can be confusing and ambiguous. For example:

- Although the scores for three indicators improved somewhat, the scores for 2 of them are still below target and 1 is above target.
- The score for one indicator remained more or less the same and is still below target.
- The score for one indicator did significantly deteriorate, but is fortunately just above target.
Looking at this information, the answers to the following questions are not clear:

- Is the overall performance of the process/service/group still at or above the desired level?
- Did the overall performance improve?

An index indicator can answer these questions. With an index indicator, the scores of multiple indicators are aggregated into one score. It is a weighted average of several indicators. If the weighted sum of these indicators is improving, the calculated score of the index formula goes up. As with any other indicator, the index indicator shows if the score is good or not and if the score has improved or not.

The principle behind an index indicator is to calculate a score value indexed to 100 for each indicator. When you have these indexed scores, you are mathematically allowed to calculate an overall average of them.

To be included in an index indicator, an indicator must have a direction and a target. The basic formula to calculate the indexed score for an indicator that has a **Maximize** direction is:

\[
100 + (((\text{actual score} - \text{target}) / \text{target}) \times 100)
\]

For indicators that have a **Minimize** direction, the formula is:

\[
100 - (((\text{actual score} - \text{target}) / \text{target}) \times 100)
\]

If you are weighting the indicators evenly, you can index the final aggregation to 100 instead of indexing the individual indicators to 100.

You can use methods of the `PAFormulaUtils()` API to get the gap between score and target for the indicator from the Analytics Hub. For more information, see **Get indicator analytics in formulas**:

\[
\text{pa.getGap(indicator, On date) / pa.getGlobalTarget(indicator, On date)}
\]

Because of the different operator for the different direction, if the score of an underlying indicator is improving (up or down), the index indicator score is increasing. Therefore, always set the direction of the index indicator to **Maximize**.

If no target value is set for an indicator, use a norm value instead. Indicators that have a target or norm value equal to 0 cannot be used in the index indicator, because it would require dividing by 0.

Set a target of 100 for each index indicator. This target is the calculated, overall, indexed score if all underlying indicators have an actual score equal to their target or norm value.

An index indicator is measuring what the gap is to the overall target of multiple, combined indicators. It is measuring the ‘Percentage of Target Achievement’.

**Index indicator using PAFormulaUtils() methods**

In the following example, you want a single index that aggregates the gap between score and global target for the following indicators:

- The percentage of incidents that are overdue.
- The average age of the last update of open incidents.
- The total number of open incidents.

To get this single index, you follow these steps to produce an index indicator:

1. You navigate to **Performance Analytics > Formula Indicators** and click **New**. Index indicators are a use case of formula indicators.
2. You give the indicator a meaningful name, such as **Aggregate incident gap**.
3. Because you are creating an index indicator, you set the **Direction** to **Maximize**.

4. In the **Formula** field, you use the **Browse for a method** and **Browse for an indicator** functions to create the following formula:

```javascript
var a = pa.getGap($[% of open overdue incidents], score_start) / pa.getGlobalTarget($[% of open overdue incidents], score_start);
var b = pa.getGap($[Average age of last update of open incidents], score_start) / pa.getGlobalTarget($[Average age of last update of open incidents], score_start);
var c = pa.getGap($[Number of open incidents], score_start) / pa.getGlobalTarget($[Number of open incidents], score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;
```

The three indicators are weighted equally, so the aggregation is indexed to 100 instead of the individual indicators.

---

### Get indicator analytics in formulas

To insert a calculated value from the Analytics Hub into a formula, use a method in the formula.

**Role required:** pa_power_user, admin

You can use a value that was calculated in the Analytics Hub as input for a formula. That value can be from any indicator, including from the current formula indicator itself.

To get a value from the Analytics Hub, insert a method from `PAFormulaUtils()` into the formula. To call one of these methods, use the Performance Analytics variable `pa`. For example, to use the `PAFormulaUtils.getScore` method, call `pa.getScore`. For more information, see `PAFormulaUtils API`.

1. Open the formula indicator record.
2. Beneath the Formula box, click **Browse for a method**.
   A dialog box opens where you can select a method.
3. Browse for the method that matches your needs.
Methods refer either to the current formula that you are editing or to a different indicator that you must specify.

4. After you select the method, read the description, and fill in any parameter fields.

Date fields can take the following values:

- An absolute date in YYYY-MM-DD format, such as 2018-12-21.
- The variable `score_start` or `score_end`. These variables represent the first and last second of the collection period being calculated for the referenced indicator. The times are calculated from the difference between the time zone of the user and the database server time zone, which is GMT. For more information, see [Changes to score_start/end because of different user time zones](#).
- A date parameter that you have coded yourself using the `GlideDate` or the `GlideDateTime` API.
5. Click Select.
The dialog closes and the method appears in the formula field of the indicator form.

6. If the method requires you to specify an indicator, select the indicator parameter with the cursor and click Browse for an indicator.
The indicator selection dialog

Formula

Specify the formula. Use "browse for an indicator" link to pick indicators.

Formula:

```
pa.getGlobalTarget(Indicator,'2018-11-07')
```

Access control

Specify access control for this indicator. If Publish on Analytics Hub is unchecked then it will be accessible for all roles, then specify the roles that have access to this indicator.

Publish on Analytics Hub

Visible to

Everyone

Visible by all roles

Other

Specify other properties. Set the default time series if applicable. And specify a live feed.
7. Select the indicator and optionally any breakdowns or elements and a time series aggregation.

8. Select **Use in method** and click **Submit**.

   The method is complete, with an indicator selected. Note that a dollar sign, $, precedes the indicator. This dollar sign means that the Analytics Hub values for the indicator instead of the indicator score are returned. The Analytics Hub values
are selected instead of the score when you select the **Use in method** check.

**Formula**

Specify the formula. Use "browse for an indicator" link to pick indicators.

**Formula:**

```plaintext
pa.getGlobalTarget(Indicator, '2018-11-07')
```

**Access control**

Specify access control for this indicator. If Publish on Analytics Hub is unchecked then the indicator will be visible to **Everyone** for all roles, then specify the roles that have access to this indicator.

- **Publish on Analytics Hub**
  - Unchecked

- **Visible to**
  - **Everyone**

- **Visible by all roles**
  - Checked

**Other**

Specify other properties. Set the default time series if applicable. And specify a live feed.
Index indicator

Index indicators are a use case of formula indicators for generating a single score that represents multiple indicators. In the following example, you want a single index that aggregates the gap between score and global target for the following indicators:

- The percentage of incidents that are overdue.
- The average age of the last update of open incidents.
- The total number of open incidents.

To get this single index, you create a formula indicator with Direction set to Maximize. All index indicators must maximize. Then you use the Browse for a method and Browse for an indicator functions to create the following formula:

```javascript
var a = pa.getGap($[% of open overdue incidents$], score_start) / pa.getGlobalTarget($[% of open overdue incidents$], score_start);
var b = pa.getGap($[Average age of last update of open incidents$], score_start) / pa.getGlobalTarget($[Average age of last update of open incidents$], score_start);
var c = pa.getGap($[Number of open incidents$], score_start) / pa.getGlobalTarget($[Number of open incidents$], score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;
```

Example: Set targets on a change itself

You want to set a target for your teams of a 10% reduction month-on-month in the incident backlog. You create a formula indicator with the following formula, and set a target of -10% for this indicator on the Analytics Hub.

```javascript
var lastPeriod = new GlideDateTime(score_start.getYear() + '-' + score_start.getMonth() + '-01');
lastPeriod.addDaysUTC(-1);
pa.getChangePercentage($[Number of open incidents$], lastPeriod.addDaysUTC(-1), score_start);
```

Example: Filter out scores based on breakdown and element

You want to filter out the scores of incidents where Priority = 1 - Critical.

1. Obtain the unique record identifiers for the Priority breakdown and the 1 - Critical element. Breakdown records are in the Breakdown table. The location of element records varies, but is identified in the Breakdown Source of the breakdown. In this case, the element is a Choice (sys_choice) record. For directions on how to obtain the unique record identifiers, see The unique record identifier (sys_id).

   The unique record identifiers are baec0752bf130100b96dac808c0739ed for the Priority breakdown and 8a4dde73c6112278017a6a4baf547aa7 for the 1 - Critical element.

2. Create an indicator with the following formula:

```javascript
var res = $[Number of open incidents$];
if(pa.getCurrentBreakdownID() == 'baec0752bf130100b96dac808c0739ed' && pa.getCurrentElementID() == '8a4dde73c6112278017a6a4baf547aa7') {
```
PAFormulaUtils API

The PAFormulaUtils API enables you to obtain a value that was calculated in the Analytics Hub and use that value as input for a formula.

To use the PAFormulaUtils API, you must satisfy these requirements:

- Performance Analytics must be enabled.
- The user who creates the formula indicator that uses this API must have the pa_power_user, pa_admin, or admin roles.

A dollar sign, $, precedes indicator names in PAFormulaUtils parameters, like the Number of open incidents indicator in this example: `pa.getGap($[[Number of open incidents]], score_end)`; This dollar sign means that the Analytics Hub calculated values for the indicator are returned instead of the indicator score.

Date parameters in PAFormulaUtils methods take one of the following forms:

- An absolute date in YYYY-MM-DD format, such as 2018-12-21.
- The variable `score_start` or `score_end`. These variables represent the first and last second of the collection period being calculated for the referenced indicator. The times are calculated from the difference between the time zone of the user and the database server time zone, which is GMT. For more information, see Changes to score_start/end because of different user time zones.
- A date parameter that you have coded yourself using the GlideDate or the GlideDateTime API.

⚠️ Warning: The PAFormulaUtils API can be used only in formula indicators, not in scripts.

PAFormulaUtil - getChange(String indicator, Object fromDate, Object toDate)

Returns the change in the score of an indicator between two specified dates.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator for which to calculate the change.</td>
</tr>
<tr>
<td>fromDate</td>
<td>Object</td>
<td>Initial date of the comparison.</td>
</tr>
<tr>
<td>toDate</td>
<td>Object</td>
<td>End date of the comparison.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Returns</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td></td>
<td>Difference in the specified indicator score between the two dates.</td>
</tr>
</tbody>
</table>
Example:

```javascript
pa.getChange($[['Number of open incidents']], new GlideDateTime(score_start.getYear() + '-' + score_start.getMonth() + '-01'), score_start);
```

**PAFormulaUtil - getChangePercentage(String indicator, Object fromDate, Object toDate)**

Returns the percentage of change in the score of an indicator between two specified dates.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator for which to calculate the percentage of change.</td>
</tr>
<tr>
<td>fromDate</td>
<td>Object</td>
<td>Initial date of the comparison.</td>
</tr>
<tr>
<td>toDate</td>
<td>Object</td>
<td>End date of the comparison.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Percent change of the specified indicator between the two specified dates.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var lastPeriod = new GlideDateTime(score_start.getYear() + '-' + score_start.getMonth() + '-01');
lastPeriod.addDaysUTC(-1);
pa.getChangePercentage($[['Number of open incidents']], lastPeriod, score_start);
```

**PAFormulaUtil - getCurrentAggregateID()**

Returns the time series aggregate identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic time series aggregate ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no time series aggregate ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var res = [[Number of open incidents]];
if(pa.getCurrentAggregateID() == '89ea4c11d7001100ba986f14ce6103dc')
{
  res = 0;
}
res;
```

PAFormulaUtil - getCurrentBreakdownID()

Returns the level 1 breakdown identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method to obtain the sys_id of the level 1 breakdown when altering the formula for a specific breakdown.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 1 breakdown ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 1 breakdown ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var res = [[Number of open incidents]];
if(pa.getCurrentBreakdownSysID() == 'baec0752bf130100b96dac808c0739ed' && pa.getCurrentElementSysID() == '8a4dde73c6112278017a6a4baf547aa7')
{
  res = 0;
}
res;
```
PAFormulaUtil - getCurrentBreakdownLevel2ID()

Returns the level 2 breakdown identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method to obtain the sys_id of the level 2 breakdown when altering the formula for a specific breakdown.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 2 breakdown ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 2 breakdown ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var res = [['Number of open incidents']];
if(pa.getCurrentBreakdownLevel2ID() == 'baec0752bf130100b96dac808c0739ed' && pa.getCurrentElementLevel2ID() == '8a4dde73c611227817a6a4baf547aa7') {
  res = 0;
}
res;
```

PAFormulaUtil - getCurrentElementLevel2ID()

Returns the level 1 breakdown element identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method when altering a formula for a specific element. For example, use the method when running a query to count different attributes, such as excluding scores for changes from groups that do not change.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 1 breakdown element ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 1 breakdown element ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
var res = [[Number of open incidents]];
if(pa.getCurrentBreakdownID() == 'baec0752bf130100b96dac808c0739ed' && pa.getCurrentElementID() == '8a4dde73c6112278017a6a4baf547aa7') {
    res = 0;
}
res;
```

---

### PAFormulaUtil - getCurrentElementLevel2ID()

Returns the level 2 breakdown element identifier (sys_id) from the indicator of the current formula. The sys_id is returned dynamically, as the selection in the Analytics Hub changes.

Use this method when altering a formula for a specific element. For example, use the method when running a query to count different attributes, such as excluding scores for changes from groups that do not change.

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>Dynamic level 2 breakdown element ID from the indicator of the current formula (as it changes with your selection in the Analytics Hub). If there is no level 2 breakdown element ID, the method does not return a value.</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
var res = [[Number of open incidents]];
if(pa.getCurrentBreakdownLevel2ID() == 'baec0752bf130100b96dac808c0739ed' && pa.getCurrentElementLevel2ID() == '8a4dde73c6112278017a6a4baf547aa7') {
    res = 0;
}
```
PAFormulaUtil - getGap(String indicator, Object onDate)
Returns the global target gap for the specified indicator on the specified date.

The gap is the difference between the score on the specified date and the target. For an indicator with the MAXIMIZE direction, the gap is calculated as the score minus the target. For an indicator with the MINIMIZE direction or no direction, the gap is calculated as the target minus the score.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator for which to provide the gap information.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date of the score to use to compare against the target score.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Difference between the score on the specified date and the global target score.</td>
</tr>
</tbody>
</table>

Example:

```javascript
var a = pa.getGap($[[% of open overdue incidents]], score_start) / pa.getGlobalTarget($[[% of open overdue incidents]], score_start);
var b = pa.getGap($[[Average age of last update of open incidents]], score_start) / pa.getGlobalTarget($[[Average age of last update of open incidents]], score_start);
var c = pa.getGlobalTarget($[[Number of open incidents]], score_start) / pa.getGlobalTarget($[[Number of open incidents]], score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;
```

PAFormulaUtil - getGlobalTarget(String indicator, Object onDate)
Returns the global target associated with the specified indicator for the specified date.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date for which to return the global target.</td>
</tr>
</tbody>
</table>
### Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Global target for the specified date and indicator.</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
pa.getGlobalTarget($[% of open overdue incidents%],score_start);
```

PAFormulaUtil - `getPersonalTarget(String indicator, Object onDate)`

Returns the personal target associated with the specified indicator for the specified date.

Use this method to obtain a personal index score. "Personal" refers to the active user who is looking at the Analytics Hub.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date for which to return the personal target.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Personal target for the specified date and indicator.</td>
</tr>
</tbody>
</table>

**Example:**

```javascript
var a = pa.getGap($[% of open overdue incidents%],score_start) / pa.getPersonalTarget($[% of open overdue incidents%],score_start);
var b = pa.getGap($[Average age of last update of open incidents%],score_start) / pa.getPersonalTarget($[Average age of last update of open incidents%],score_start);
var c = pa.getGap($[Number of open incidents%],score_start) / pa.getPersonalTarget($[Number of open incidents%],score_start);
var res = 100 - (100 * (a + b + c) / 3);
res;
```

PAFormulaUtil - `getScore(String indicator, Object onDate)`

Returns the score of the specified indicator for the specified date.
## Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indicator</td>
<td>String</td>
<td>Unique identifier of the indicator whose score is to be retrieved.</td>
</tr>
<tr>
<td>onDate</td>
<td>Object</td>
<td>Date for which to return the score.</td>
</tr>
</tbody>
</table>

## Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Score for the specified date and indicator.</td>
</tr>
</tbody>
</table>

### Example:

```javascript
pa.getScore($[[Number of open incidents]], score_end);
```

### Changes to score_start/end because of different user time zones

For formula indicators, the values of the variables `score_start` and `score_end` are calculated based on the time zone of the user who is executing the formula. If users in different time zones execute the same formula, the values of `score_start` and `score_end` change.

**Warning:** The date value of the `score_start` and `score_end` variables can shift when users from different time zones view the same formula.

Formulas can include `score_start` or `score_end` variables as parameters for indicators that the formula references. These variables represent the first and last second of the specific collection period being calculated for the referenced indicator. The values of the `score_start` and `score_end` variables are calculated from the difference between the time zone of the user executing the formula and the time zone of the database server, which is GMT. A user executes a formula whenever they view the formula indicator in a dashboard widget or on the Analytics Hub. As a result, the date value of the start or end of the collection period can shift when different users view the same formula.

### Different values of score_end for different user time zones

Consider a formula indicator with a daily frequency and the following formula:

```javascript
pa.getScore($[[Number of open incidents]], score_end);
```

Three different users view a dashboard widget with this formula indicator on 18 October. The database server considers `score_end` for 18 October to be 23:59:59 GMT on 18 October.

- One user is in the Europe/Berlin time zone. Their `score_end` value is “2019-10-18 21:59:59”, and the score for the date 18 October is returned.
- One user is in the US/Pacific time zone. Their `score_end` value is “2019-10-19 06:59:59”, and the score for the date 19 October is returned.
- One user is in the GMT time zone. Their `score_end` value matches the database server, “2019-10-18 23:59:59”, and the score for the date 18 October is returned.
Create an indicator group

For convenience, you can organize related indicators into an indicator group. When you configure some visualizations that show multiple indicators, you can specify an indicator group instead of individual indicators.

Role required: pa_admin, pa_power_user, or admin

By creating indicator groups, you can organize indicators along whatever themes are most useful to you. The indicators do not have to be of the same type or share an indicator source or data collector job. Indicator groups save you the trouble of specifying multiple individual indicators when you configure the following objects:

- List widgets
- Time series widgets with the relative compare visualization
- Email notifications about indicators
- Security Incident Analytics treemaps

After you create an indicator group, you can add indicators to the group or remove them from the group. This change propagates to all objects that use the indicator group, so you do not need to edit the configurations of the objects.

1. Navigate to Performance Analytics > Indicator Groups.
2. Click New.
3. Enter a Label for the indicator group.
4. Open the Additional actions menu and click Save. The Indicators related list appears.
5. Click Edit on the Indicators related list and add indicators to the group.
6. Click Save to finish adding indicators, then Update to exit the Indicator Group record.

Creating and using the 'Open and Resolved Incidents' indicator group

In this example, create an indicator group with all the indicators that refer to either open or resolved incidents. The incidents are all included with the demo data for Performance Analytics. After creating the indicator group, create a list widget that uses the indicator group and add the widget to a dashboard.

1. First, go to Performance Analytics > Indicator Groups and click New. An empty Indicator Group form opens.
2. Give the indicator group the label Open and Resolved Incidents, and save the form from the Additional actions menu.
The Indicators related list appears at the bottom of the record.

3. Click **Edit**, which opens the Edit Members dialog. To group all the indicators that involve resolved or open incidents, add all the indicators with 'resolved' or 'open' in their name. Also add the Incident backlog growth indicator.
4. The indicator group is complete. Click **Save** in the Edit Members dialog and then **Update** on the indicator group record.

5. Now create a Performance Analytics List widget and specify the Open and Resolved Incidents indicator group.
6. To share the widget with other users, add it to the Incident Management dashboard.

Rounding and precision in indicators

Indicators round fractional results using “Banker's rounding” or mathematical rounding depending on the indicator Precision.

When an indicator has a Precision of 0, the indicator rounds the result to the nearest even, whole number. For example, if an indicator with Precision 0 calculates the values 7 + (5 / 2), the indicator rounds the result up to 10. However, if the formula calculates 2 + (5 / 2), the indicator rounds the result down to 4.

When an indicator has a Precision greater than 0, the indicator rounds to the nearest decimal point for the given precision. For example, an indicator with Precision 1 rounds a result of 4.45 to 4.5.

For indicator scores in the thousands and millions, the score is displayed as the number of thousands or millions with a k or an M, respectively. For example, a score of 612,875 with a precision of 0 is rendered as 613K. A score of 8,546,937 with a precision of 1 is rendered as 8.5M.

Y-axis values plotted on a line or column chart are not rounded. The score and tooltip displayed when you point to a value on the chart are rounded based on the indicator Precision.
Create a unit

You can define units in which Performance Analytics indicator scores are shown. Units can be numbers, percentages, currencies, quantities of time, or any other entity you define. The most commonly used units are provided by default.

Roles required: pa_admin or pa_data_collector

1. Navigate to Performance Analytics > System > Units.
2. Click New.
3. Enter the Name of the unit.
   For example, Gallon.
4. Specify the way the unit must be formatted.
   For example, {0}Gal gives you the number of gallons with the abbreviation Gal. For currencies, you can place the symbol for the unit in front of the number, such as $({0}).
5. Click Submit.
   Units can be used for automated, manual, and formula indicators.

Exclude time series from an indicator

You can exclude time series on automated, formula, and manual indicators. Excluded time series are not selectable from the Analytics Hub or widgets. Other time series remain selectable.

To exclude a time series from an indicator, select the time series in the Time series exclusions related list on the Indicator form.

Control access to an indicator

You can control which user roles grant access to specific indicators. Access to an indicator is regulated in the indicator record.

pa_admin or admin

1. Navigate to Performance Analytics > Automated Indicators or to Manual Indicators or Formula Indicators if applicable.
2. Select an indicator record.
3. In the Access control section, clear the Visible by all roles check box.
4. Select the Roles that grant access to the indicator.
5. Click Update.

Create a notification for an indicator or group of indicators

Performance Analytics can automatically generate an email with the score, change %, target, and score-target gap % of one or more indicators.

Enable and configure email notifications before you can use email summaries.

1. Navigate to Performance Analytics > Automation > Email Summaries.
2. Click New.
3. Enter a Name and a Description for the email summary.
4. Select the Active check box to run a scheduled job that creates the email summary.
5. Select when the job should run.
   - Daily
6. Set the time to run the job by changing the hours, minutes, and seconds (using 24-hour notation).
   By default, the job runs at midnight.
7. Select the indicators to include in the summary, either dynamically or manually.

**Dynamically**
Select the **By Condition** check box. Use the condition builder to define the conditions that determine which indicators the email summary includes. For example, you can select all key indicators by setting the condition to (Key) (is) (true).

**Manually**
Clear the **By Condition** check box. After you save the Scheduled Email Summary form, select individual indicators to include in the summary in the **Indicators** related list.

8. Right-click the form header and select **Save**. The related lists become available.
9. Select any number of users in the **Users** related list.
10. If you are selecting indicators manually, select them in the **Indicators** related list.

The email summary job runs based on the schedule you configured. You can also run the job manually by clicking **Execute Now**.

**Schedule the export of an indicator to PDF**
Schedule an indicator to automate its distribution.
Role required: pa_power_user, pa_admin, or admin

Navigate to **Performance Analytics > Scheduled Indicators** and create a new record.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>Select the indicator that you want to export.</td>
</tr>
<tr>
<td>Breakdown</td>
<td>Select a breakdown to filter the indicator scores.</td>
</tr>
<tr>
<td>Element</td>
<td>If you selected a breakdown, select a breakdown element to show only scores associated with that element.</td>
</tr>
<tr>
<td>Chart</td>
<td>Select this checkbox to include the scores visualization in the PDF. The visualization is the same as displayed on the indicator Analytics Hub.</td>
</tr>
<tr>
<td>Breakdowns</td>
<td>Select this checkbox to include the scores for each breakdown and breakdown element in a table at the bottom of the PDF. If you have selected a <strong>Breakdown</strong> and <strong>Element</strong>, the breakdowns displayed at the bottom of the PDF are 2nd-level breakdowns.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Users</td>
<td>Users who should receive the indicator. To receive indicators, users must have an Email address defined and have <strong>Notifications</strong> set to <strong>Enable</strong> in their user records.</td>
</tr>
<tr>
<td>Groups</td>
<td>Groups that should receive the indicator.</td>
</tr>
<tr>
<td>Email addresses</td>
<td>Email addresses of users who should receive the indicator but who are not in the system.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that enables (selected) or disables (cleared) scheduling for the indicator.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency for exporting the indicator.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to export the indicator.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Check box that displays (selected) or hides (cleared) the <strong>Condition</strong> field, which allows you to specify conditions under which the indicator is exported.</td>
</tr>
<tr>
<td>Condition</td>
<td>User-created script that checks for certain conditions to be true before exporting the indicator. This field is visible only when <strong>Conditional</strong> is selected.</td>
</tr>
<tr>
<td>Subject</td>
<td>Text that appears in the subject line of the distribution email.</td>
</tr>
<tr>
<td>Introductory message</td>
<td>Additional message that is delivered with the indicator.</td>
</tr>
<tr>
<td>Include with</td>
<td>Additional scheduled indicators to send.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Select the page orientation, Landscape or Portrait.</td>
</tr>
<tr>
<td>Zip output</td>
<td>Select this check box to send the indicator as a zip file.</td>
</tr>
</tbody>
</table>

### Performance Analytics breakdowns

Breakdowns enable you to group or filter indicator scores for more detailed analysis, such as to show separate scores for each assignment group. You can apply a breakdown on the Analytics Hub and on dashboards.

The values for each breakdown are called breakdown elements. For example, the Priority breakdown may have the elements Critical, High, and Low. Breakdowns are categorized as automated, manual, or external, depending on where these elements come from. Automated breakdown elements are specified in **breakdown sources**. Manual breakdowns have their elements entered manually to define an organization. Lastly, an external breakdown specifies the JDBC data source and SQL statement for retrieving breakdown elements.

For example, you can look at the Number of Open Changes by Assignment Group. Or you can see the Number of New Changes by Priority.
Create and apply a simple breakdown

Create a breakdown, breakdown source, and breakdown mappings, and associate the breakdown with indicators.

Role required: pa_power_user, pa_data_collector, or admin

Note: Users with only the pa_power_user role cannot create breakdown sources.

Create a simple breakdown based on an existing indicator. To create more advanced breakdowns or breakdown sources, such as to limit data sets with complex filters, create or update breakdown and breakdown source records directly.

1. Navigate to Performance Analytics > Breakdowns > Create New.
2. Select the Indicator that you want to create the breakdown for.
   The Table field is automatically populated based on the indicator source table. You can apply the new breakdown to other indicators with the same source table on the Link to indicators tab.
3. Select the Field to base the breakdown on.
   The breakdown uses values from this field as breakdown elements and breaks down collected data based on the value of this field in each record.
4. Click Next.
   The Define the breakdown tab displays different data depending on if a breakdown, breakdown source, or breakdown mapping exist for the specified indicator, table, and field.
5. Perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a breakdown, breakdown source, and mapping</td>
<td>If no breakdown or breakdown source exists for the specified table, enter a name for the new breakdown. A breakdown source and mapping for the selected table and field are created automatically. Click Show filter to make adjustments to filter the data included in the breakdown source.</td>
</tr>
<tr>
<td>Create a mapping using an existing breakdown source</td>
<td>If at least one breakdown source exists for the specified table and there are one or more breakdowns using the source, select the breakdown to create a mapping for. If a mapping exists between a breakdown with the selected source and a field on a parent of the indicator table, you can only select an existing breakdown to create the mapping for. If no such mapping exists for a parent table, you can select an existing breakdown or create a new breakdown.</td>
</tr>
<tr>
<td>Review existing records</td>
<td>If a breakdown and breakdown source exist for the specified table, and a breakdown mapping exists for the specified breakdown and field, review the settings. You do not need to make any changes.</td>
</tr>
</tbody>
</table>

6. Click Next.
7. On the Link to indicators tab, select any additional indicators that you want to apply the breakdown to.
You can apply the breakdown to other indicators with the same source table as the indicator you selected first. If the breakdown already applies to an indicator, that indicator is not displayed.

8. Click Next.
9. On the Data Collection tab, select how many days of historical, broken-down scores and snapshots to collect, or clear the Collect data from the past to skip historical data collection.
10. Click Next.
11. Review the settings and confirm that the correct records will be created, then click Apply. A check mark appears next to each record after it is created. When all records are created the Create another breakdown button appears.

Automated breakdowns

An automated breakdown uses a breakdown source to determine selectable elements.

Automated breakdowns are based on a breakdown source, which is a set of records from a table. The breakdown maps these records, known as breakdown elements, with fields on tables that indicators collect scores from. Scores collected from mapped tables can then be grouped and filtered based on the values in the mapped fields and the breakdown elements.

For example, the Groups breakdown source that includes records from the Groups (sys_user_groups) table is available by default. This breakdown source specifies the filter (Active) (is)(true) to include only active groups as elements. You can map this breakdown source to fields on other tables that reference the Groups table, such as the Incident Assignment group field. Scores collected from the mapped table are grouped based on the value of that field. You can then filter the scores on the Analytics Hub and dashboards by selecting the breakdown and an element, such as to show scores only for incidents assigned to the Hardware group.

Define a breakdown source

Breakdown sources specify which unique values, called breakdown elements, a breakdown contains. A breakdown source is defined as a set of records from a table or database view or as a bucket group. Multiple breakdowns can use the same breakdown source.

Roles required: pa_data_collector, pa_admin, or admin. The breakdown source creator needs access to the table and reference column that the indicator source uses.

Always use a facts table with a field that has a unique value for every record, usually Sys ID. For example, the Incident.Category breakdown source takes its elements from the Choice table. The elements are identified by the Sys ID field. The breakdown source filters the choices to those that are on the Incident table, in English, and not inactive.

Tip: As in this example, if you use Choice (sys_choice) for the facts table, put conditions on the Table, Element, and Language fields. Also filter out Inactive records.
Select the facts table for the breakdown source elements and apply conditions to optimize the element list.

- **Facts table**: Choice (sys_chalid)
- **Field**: Sys ID

Conditions:

- **Table**: is incident
- **Element**: is category
- **Language**: is en

And:

- **Inactive**: is false
- **Inactive**: is-empty

Label for unmatched:
The breakdown source uses the following records from the Choice table:

![Choice table screenshot]

**Note:** The Choice table includes every possible choice from every table, which is why it has Table and Element columns. Most other facts tables you would use for a breakdown source are simpler.

1. Navigate to **Performance Analytics > Breakdown Sources** and click **New**.
2. Give the breakdown source a meaningful **Name**.
3. Add a detailed **Description** to help others understand the use and purpose of this breakdown source and to help them avoid creating duplicates.
4. For the **Facts Table**, select the table that the breakdown source gets elements from. For example, for the breakdown source to specify user groups as elements, select **Group (sys_user_group)**.
   
   **Warning:** Do not change the facts table for a source after you have started collecting data. If you change the facts table, all historical scores for the associated indicators are lost.

5. In the **Field** table, select a field that contains a unique value for every record. This field is usually **Sys ID**.
6. Set the **Conditions** to filter out unneeded elements.
If you set Choice (sys_choice) as the facts table, always filter on table, element, and language, and filter out inactive records. For example:

(Table) is (Incident) and
(Element) is (Category) and
(Language) is (en) and
Inactive is (false) or
Inactive is (empty)

7. To see how many records match the selected conditions, click Preview.
8. Optional: Define RELATED LIST CONDITIONS to include a relationship with another table in the filter.
   For more information, see Add related list conditions.

For example, consider a breakdown source for Configuration Item (CI) Managers. The facts table is User (sys_user), but the only condition you can apply from this table is to filter for active users. No field on the table lets you select only users who are CI Managers. You get hundreds of results.

If you add a condition that the Name on the User record must match at least one entry in the Managed by column of the Configuration Item (cmdb_ci) table, the breakdown source only returns the users who are CI Managers.
9. Optional: In **Label for unmatched**, write a custom label to use when the value in a mapped field on an indicator source record does not match any elements on the breakdown source. The default label is **Unmatched**.

10. In the **Security** tab, set whether to exclude or include breakdown source elements by role based on element security lists. For more information, see [Define an elements security list](#).

Bucket groups for breakdown sources

Bucket groups are used to recategorize data so it can be used as a breakdown, for example by grouping a range of values into discrete buckets.

In the data architecture, bucket groups are defined in Bucket Group (pa_bucket_groups) records and buckets in Bucket (pa_buckets) records. Each Bucket (pa_buckets) record contains a Bucket Group field that is a reference to a Bucket Group (pa_bucket_groups) record.

To work with a bucket group, create a breakdown source that uses Bucket (pa_buckets) as the facts table and specifies the bucket group in a condition. If a breakdown built on this source uses
a breakdown mapping with a script, the breakdown groups the values that the script returns into buckets. If the breakdown mapping specifies a field instead of using a script, the breakdown groups the values of the mapped field into buckets.

Grouping field values into buckets
You can use a bucket group with a breakdown mapping that does not use a script, to group the values of any mapped field into buckets.

The use case can be as simple as translating the true and false values of a Boolean into two buckets with meaningful labels.

**Sorting Boolean values into buckets**
A base Performance Analytics installation includes the Active breakdown as part of the Analytics Usage Overview. This breakdown uses a mapping to the job.active Boolean field from the Job Log (pa_jobs_logs) table. The breakdown source uses a bucket group where true values for job.active are sorted into the Active bucket, while false values are sorted into the Inactive bucket. Note that false values are numerically considered to be a value less than one, while true values are numerically one and above.
Grouping script results into buckets

When you have a breakdown mapping script that collects a range of values, you can define a bucket group to divide those values into discrete buckets.

After you create the bucket group, you create a breakdown source based on the bucket group. Then you create a breakdown that uses that breakdown source. When you create the breakdown mapping for the breakdown, define or select a script for the mapping. The
breakdown groups the results that the script returns into the buckets of the bucket group. For an example, see Example: Script mapping.

You can write a bucket group for an existing script, or you can first write the bucket group and then write the script. Both must exist before you can create the breakdown.

Note: The same script can be used with any number of bucket groups. Also, in principle any scripts that returned the same kind of data could be used with the same bucket group.

Create a bucket group

Specify a group of buckets into which you want to recategorize data.

Role required: pa_data_collector or admin

1. Navigate to Breakdowns > Bucket Groups.
2. Click New.
3. Enter a Name that clearly identifies the bucket group, like Age Ranges in Days.
4. Double-click Insert a new row to add a new bucket.
5. Enter a Name for the first bucket, then press Enter or click the green check icon.
6. Double-click in the Start and End columns to enter the starting and ending values for the range.

Records that match the end value are excluded from the bucket. Therefore, set the end value of one bucket and the start value of the next bucket to be the same. Records that exactly match that value are sorted into the bucket that has that value as the start value.

Warning: If the end value of one bucket does not match the start value of the next bucket, you have a 'hole' where records are not sorted into any bucket. For example, if you have a bucket that ends at 20 and the next bucket starts at 21, records for which the script returns a value between 20.0000~ and 20.9999~ do not get sorted into any buckets.

7. Click Submit after all the bucket ranges have been defined.

Incident Age Ranges bucket group

Consider the case where you want to group incidents by age, as follows:

- Less than a day
- 1–5 days
- 6–30 days
- 30–90 days
- More than 90 days

In Performance Analytics > Scripts, you already have a script named Incident.Age.Days. This script derives the age in days of an incident from its opening date and the latest date on which a score was collected:

```javascript
var diff=function(x,y){return y.dateNumericValue() - x.dateNumericValue();};
var days=function(x,y){return diff(x,y)/(24*60*60*1000);};
days(current.opened_at, score_end);
```

You create a new bucket group named Incident Age Ranges (Days). In this bucket group, you define a set of buckets that start at the desired date and end at the beginning of the next
bucket. For example, the 06–30 Days bucket starts at 6 and ends at 31:

This bucket will contain incidents from the age of precisely 6 days to the age of 30 days, 23 hours, 59 minutes, and 59 seconds.

At the end, you have a bucket group with five buckets corresponding to the age ranges in which you want to divide incidents.
### Bucket group - Incident Age Ranges (Days)

**Name**

<table>
<thead>
<tr>
<th>Description</th>
<th></th>
</tr>
</thead>
</table>

**Description**

Define the buckets for this bucket group by providing start and end ranges for each of the buckets.

#### Buckets

<table>
<thead>
<tr>
<th>Name</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>00 - 01 Day</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>01 - 05 Days</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>06 - 30 Days</td>
<td>31</td>
<td></td>
</tr>
<tr>
<td>31 - 90 Days</td>
<td>91</td>
<td></td>
</tr>
<tr>
<td>91+ Days</td>
<td>91</td>
<td></td>
</tr>
</tbody>
</table>

*Insert a new row...*

**Update**
The Script Mapping example shows a breakdown that uses this bucket group and script.

Create a breakdown source that uses the Bucket (pa_buckets) facts table, the Sys ID field, and the condition (Bucket group)(is)<(the name of the bucket group you created>). Then create a breakdown that uses this breakdown source and uses the relevant script for the breakdown mapping.

Create an automated breakdown

To create an automated breakdown, select a breakdown source for it to use and apply access restrictions. Then map which field on the indicator source references the breakdown source. Finally, assign indicators to the breakdown.

Familiarize yourself with the definitions and uses of breakdowns in general and automated breakdowns in particular.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin

An automated breakdown uses a breakdown source to determine selectable elements. You can use an existing breakdown source or you can define a new one.

Note: This process allows you to create a fully customized breakdown. To create a simple automated breakdown, see Create and apply a simple breakdown.

1. Navigate to Performance Analytics > Automated Breakdowns and click New.
2. Specify a meaningful Name.
   The name of a breakdown is frequently based on the label of the field that is used in the breakdown mappings.
3. In the Automated tab, select the Breakdown source.
4. Optional: Select a Default elements filter.
   Use element filters to restrict the elements that are visible to a user. For more information, see Breakdown element filters.
5. Optional: In the Access control tab, set who can see the breakdown.
   These restrictions apply in all cases: seeing the breakdown in the list of breakdowns, seeing the breakdown in an Analytics Hub or dashboard, or using the breakdown when creating a widget.

<table>
<thead>
<tr>
<th>Value of Visible to</th>
<th>Further settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone (default)</td>
<td>You can restrict visibility by roles. Unselect Visible by all roles and select the Roles that are required to access the breakdown.</td>
</tr>
</tbody>
</table>

| Groups and Users     | Select the Groups and individual Users who can access this breakdown. You can select groups or users from a list, and you can select users by email address. |

Create breakdown mappings and associate indicators with the breakdown. You can do this from the indicator, using a graphical tool (see Assign and map breakdowns).

Create a breakdown mapping on a breakdown record

Specify which field on the indicator source references the breakdown source. If no appropriate field is available, specify a script to query the indicator source.

Assign a breakdown source to the breakdown before creating the mapping.

The required roles are the same as for creating a breakdown.
You can create multiple mappings for the same breakdown, enabling you to use that breakdown for multiple indicators.

**Note:** The procedure on this page uses a related list on the breakdown form. You can instead use a graphical tool that you access from the indicator form. See Assign and map breakdowns.

1. If you are adding a mapping to an existing breakdown, find that breakdown in the relevant list of breakdowns and open it.
2. In the Breakdown Mapping related list, click New.
3. Select the Facts table. This table is the indicator source that you want to break down.
4. Do one of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
   | **Use a field to map values to elements.**  | Select the Field in the indicator source that maps to records in the breakdown.  
   |                                              | See the use of the Category field in Example: Field mapping.                  |
   | **Use a script to map values to elements.** | Select Scripted, then select the Script that defines the association between indicator records and breakdown elements. Use a script when you do not have the simple use case of a field in the indicator source that maps to a breakdown source table. A script can define a wide range of mapping relationships. The most common use case is when the breakdown source is a bucket group and the script returns an integer to assign an indicator score to a bucket. See Example: Script mapping. You cannot show real-time scores for an indicator that uses a scripted breakdown. |

5. Click Submit.
6. Repeat steps 2–5 as needed, to define additional mappings.

Example: Field mapping
The Category breakdown maps the Category field on the incident table to the Incident.Category breakdown source, which references the Choices(sys_choice_list) table.

In the first image, you see the Category breakdown with the Incident.Category breakdown source. This breakdown has a breakdown mapping to the Category field on the incident table.
### Breakdown - Category [Automated view]

<table>
<thead>
<tr>
<th>Type</th>
<th>Automated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Category</td>
</tr>
</tbody>
</table>

**Description**

An automated breakdown is a breakdown based on breakdown source and points to a field in a facts table, or is scripted.

<table>
<thead>
<tr>
<th>Breakdown source</th>
<th>Incident.Category</th>
</tr>
</thead>
</table>

**Default elements filter**

**Update**  **Delete**

<table>
<thead>
<tr>
<th>Breakdown Mappings (3)</th>
<th>Breakdown Relations</th>
<th>Indicators (51)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown Mappings</td>
<td>New</td>
<td>Search</td>
</tr>
</tbody>
</table>

#### Breakdown = Category

<table>
<thead>
<tr>
<th>Facts table</th>
<th>Field</th>
<th>Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>incident</td>
<td>inc_category</td>
<td></td>
</tr>
<tr>
<td>incident</td>
<td>category</td>
<td></td>
</tr>
<tr>
<td>incident sla</td>
<td>inc_category</td>
<td></td>
</tr>
</tbody>
</table>
The Incident.Category breakdown source uses records in the Choices(sys_choice_list) table.
The next image shows the Choices(sys_choice_list) table records that meet the conditions that are specified in the Incident.Category breakdown source. Note the Label field values.

Finally, you see the Category field of some records on the Incidents table. This field is mapped to the Category breakdown. The field values match the Label fields of the records of the Choices(sys_choice_list) table that the Incident.Category breakdown source filters for.
Example: Script mapping

The Age breakdown uses the Incident.Age.Days script to calculate the age of incidents in days and map the values to the Incident Age Ranges bucket group.

In the first two images, you see the Age breakdown, which uses the Incident.Age.Days breakdown source and the Incident.Age.Days script for breakdown mapping. You also see that the breakdown source refers to the Incident Age Range (Days) bucket group.
Automated

An automated breakdown is a breakdown based on breakdown source and points to a field in a facts table, or is scripted.

Breakdown source: incident.Age.Days

Access control

Specify access control for this breakdown.

Visible to: Everyone

Visible by all roles: ✔

Update Delete
The Incident.Age.Days script takes the time stamp when the incident was opened from the incident table and subtracts this from the time stamp at the end of the collection period. The script converts this value from milliseconds to days.

```javascript
var diff = function(x, y) {
    return y.dateNumericValue() - x.dateNumericValue();
};

var days = function(x, y) {
    return diff(x, y) / (24 * 60 * 60 * 1000);
};

var current = days(current.opened_at, score_end);
```

The resulting numbers of days are sorted into the buckets of the bucket group.
Bucket group
Incident Age Ranges (Days)

Name

Description

Buckets

Define the buckets for this bucket group by providing start and end ranges for each of the buckets.

<table>
<thead>
<tr>
<th>Name</th>
<th>Start</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td>00 - 01 Day</td>
<td>01</td>
<td>1</td>
</tr>
<tr>
<td>01 - 05 Days</td>
<td>05</td>
<td>6</td>
</tr>
<tr>
<td>06 - 30 Days</td>
<td>30</td>
<td>31</td>
</tr>
<tr>
<td>31 - 90 Days</td>
<td>90</td>
<td>91</td>
</tr>
<tr>
<td>90+ Days</td>
<td>90+</td>
<td>91</td>
</tr>
</tbody>
</table>
Here is the result of running this script on the Number of open incidents indicator.
### Number of open incidents

**August 3**

<table>
<thead>
<tr>
<th>Age</th>
<th>Score</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>90+ Days</td>
<td>250</td>
<td>243</td>
</tr>
<tr>
<td>31 - 90 Days</td>
<td>32</td>
<td>5</td>
</tr>
<tr>
<td>06 - 30 Days</td>
<td>29</td>
<td>18</td>
</tr>
<tr>
<td>01 - 05 Days</td>
<td>5</td>
<td>5</td>
</tr>
</tbody>
</table>
Assign an indicator to an automated breakdown
Associate automated or formula indicators with a breakdown to enable the collection of broken down scores for those indicators.

The breakdown must have a breakdown mapping for the indicator source table.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin

1. Navigate to Performance Analytics > Automated Breakdowns.
2. Select a breakdown record.
3. In the Indicators related list, click Edit.
4. Use the slushbucket to select the indicators you want to assign to this breakdown.
5. Click Save.
6. Optional: In the Indicator Breakdowns related list, set the Display value to false to hide the breakdown on the Analytics Hub and dashboard widgets.
   If the Display field is false, broken-down scores are still populated during data collection, but the breakdown is not selectable on the Analytics Hub or on dashboard widgets.

Manual breakdowns
In a manual breakdown, you define the breakdown elements and the indicator scores for each element manually instead of using records from a breakdown source.

Unlike an automated breakdown, a manual breakdown does not map to any fields on the indicator source table. Instead, users must populate the broken-down scores manually.

Create a manual breakdown
Create a breakdown for an indicator where you add scores manually.

Roles required: pa_data_collector, pa_power_user, pa_admin, or admin

2. Click New.
   The Type is set to Manual automatically.
3. Enter a descriptive Name.
4. Right-click the form header and select Save.
5. In the Manual section, double-click Insert a new row to add a new breakdown element.
6. Press Enter or click the green check mark to save the entry.
7. Optional: Change the Order value.
   Elements with a lower Order value appear higher in the list of elements, such as on the Analytics Hub and dashboards.
8. Repeat steps 5-7 to add additional breakdown elements.
9. Click Submit.

Associate manual indicators with this breakdown and populate scores using the scoresheet.

Assign a manual indicator to a manual breakdown
Associate a manual indicator with a manual breakdown to enable users to enter broken-down scores for the indicator.

Role required: pa_data_collector, pa_power_user, pa_admin, or admin

Note: You can break down manual indicator scores by only one breakdown at a time. You cannot apply a 2nd-level breakdown to a manual indicator.

2. Select a breakdown record.
3. In the **Indicators** related list, click **Edit**.
4. Use the slushbucket to select the indicators you want to assign to this breakdown.
5. **Click Save.**
6. Optional: In the **Indicator Breakdowns** related list, set the **Display** value to false to hide the breakdown on the Analytics Hub and dashboard widgets.
   If the **Display** field is false, broken-down scores are still populated during data collection, but the breakdown is not selectable on the Analytics Hub or on dashboard widgets.

Populate broken-down scores for the indicators using the scoresheet.

**Breakdown element filters**

Element filters enable you to limit the displayed breakdown elements on an Analytics Hub or widget using filter conditions.

You can select an element filter when viewing breakdowns on an Analytics Hub, or when configuring a breakdown widget.

*Create an element filter*

Select the breakdown source and filter conditions to filter breakdown elements from that breakdown source.

**Role required:** `pa_data_collector` or `admin`

Navigate to **Performance Analytics > Element Filters** and create a new record (see table for field descriptions).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown source</td>
<td>Select the breakdown source you want to create an element filter for. The element filter is available for any breakdowns based on this breakdown source.</td>
</tr>
<tr>
<td>Facts table</td>
<td>Read-only. Displays the breakdown source facts table.</td>
</tr>
<tr>
<td>Filter</td>
<td>Specify the filter conditions to limit the available elements. Only elements that meet these conditions are displayed when you apply this element filter. For example, if the breakdown source facts table is <code>User (sys_user)</code>, you can add a filter condition to include only users in a particular department such as <code>(Department) (is) (HR)</code>.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select any roles that a user must have to select this element filter. A user must have at least one of the specified roles. If no roles are specified, all users can access this element filter.</td>
</tr>
</tbody>
</table>

You can select the element filter on an Analytics Hub **Breakdown** tab when viewing a breakdown based on the same breakdown source as the element filter.

You can specify a **Default element filter** for a breakdown to select that element filter automatically when viewing the breakdown. Users that view the breakdown on an Analytics Hub can change or clear the selected element filter.
You can also specify an **Element filter** from the **Breakdown settings** tab when creating a breakdown widget. Users cannot change or clear the element filter on a widget when viewing the widget.

**Navigating breakdown elements with breakdown relations**

Breakdown relations open a new navigation path for viewing breakdown scores, by moving from one breakdown element to another breakdown element. Breakdown relations can be between the elements of different breakdowns, or they can be within a hierarchical structure of elements in the same breakdown. Breakdown relations affect navigation on the Analytics Hub and in breakdown widgets.

You can use breakdown relations to navigate between the elements of a single breakdown that are in a hierarchical relationship. For example, the Location breakdown has a hierarchy of ‘parent’ and ‘child’ elements, where a country can be the parent of cities. Breakdown relations let an Analytics Hub viewer navigate from a country down into a city, from a city to the country, or between cities in the same country.

**Navigating on the Analytics Hub between elements of the same breakdown**

Similarly, a breakdown widget can show the parent, child, or sibling elements of the element that was chosen for the breakdown dashboard. For more information about using breakdown relations on breakdown dashboards, see [Showing breakdown relations on dashboards](#).
Breakdown dashboard displaying children of the EMEA element

Breakdown relations also enable navigation between the elements of different breakdowns. For example, first choose an element of the Assignment Group breakdown, then look at the Members breakdown relation. In this relation, navigate to an element of the Assigned To breakdown. The selected member of Assigned To is not necessarily a member of the Assignment Group. You are changing which first-level breakdown you are looking at, not drilling down to a second level of breakdown and element. Again, this breakdown relation can be used both on the Analytics Hub and in a breakdown widget on a breakdown dashboard.
Overview  Compare  Insights

Number of open incidents
April 19  ◀ ◁ ◁

260 ▲ 20 (8.3%)

59
No. of scores

Search breakdowns and elements
More details about these cases for using breakdown relations are in the topics about creating breakdown relations.

Create a breakdown relation between breakdowns
To set up navigation in a visualization between the elements of two breakdowns at the same level, create a breakdown relation between the breakdowns. A table must exist with fields that reference the records for both breakdowns.

Review the use cases for breakdown relations in *Navigating breakdown elements with breakdown relations*.

Role required: pa_data_collector, pa_power_user, admin

**Note:** While a business analyst, typically with the pa_power_user role, is most likely to know what breakdown relations to create, creating them requires the knowledge and access to tables of a technical expert with pa_data_collector. A pa_admin is likely to understand both. Consider having either a pa_admin create the relation or have a collaboration between a pa_power_user and a pa_data_collector.

You want to be able to navigate quickly between two breakdowns at the same level that are logically related. The example used in this topic involves the breakdowns Assignment Group and Assigned To for the indicator Number of open incidents. In the following animation, you switch from seeing the number of incidents assigned to the Oracle Support group and seeing the number of incidents assigned to Candace Bruckman. Both breakdowns are first level, which means that you see the total number of incidents assigned to Oracle Support and the total assigned to Candace Bruckman. If you had selected Candice as a second-level breakdown instead of through a breakdown
relation, you would have seen only the Oracle Support issues that she was working on.
Note: Breakdown relations are one-way relationships. To create a bi-directional relationship, define multiple breakdown relations.

1. Navigate to **Breakdowns > Breakdown Relations** and click **New**.
2. Fill in the fields on the form, as follows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown</td>
<td>Select the breakdown that this relationship belongs to. You can access related breakdowns from this breakdown only.</td>
<td>For our example, where you want a selection of group members to appear when you select an Assignment Group, the <strong>Breakdown</strong> is Assignment Group.</td>
</tr>
<tr>
<td>Related breakdown</td>
<td>Select the breakdown you want to associate with the first breakdown.</td>
<td>For our example, the related breakdown with the Assignment Group members is Assigned To.</td>
</tr>
<tr>
<td>Table</td>
<td>Select a table with fields that reference the facts table records of the sources of both breakdowns. For many-to-many relationships, select a many-to-many table. For one-to-many relationships, select a facts table.</td>
<td>The Assignment Group breakdown uses Group data. The Assigned To breakdown uses User data. Assignment Groups can have many members, and a user can be a member of more than one Assignment Group, so they have a many-to-many relationship. Therefore, you select the Group Member (sys_user_grmember) table, which is a many-to-many table that joins groups and users.</td>
</tr>
<tr>
<td>Breakdown field</td>
<td>Select the field from the specified table that identifies the breakdown element you can navigate from.</td>
<td>In our example, you select the <strong>Group</strong> field. This field in the Group Member (sys_user_grmember) table identifies the element of the Assignment Group breakdown.</td>
</tr>
<tr>
<td>Related breakdown field</td>
<td>Select the field from the specified table that identifies the breakdown elements you can navigate to when viewing this relation.</td>
<td>In our example, you select the <strong>User</strong> field. This field in the Group Member (sys_user_grmember) table identifies the element of the Assigned To breakdown.</td>
</tr>
<tr>
<td>Common field</td>
<td>Leave this field empty when defining a relation between breakdowns.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conditions</td>
<td>Define any further conditions that a record must fulfill to appear as a related breakdown for this relationship.</td>
<td>In our example, you add the condition ((User.Active) \text{ is} (true)) to filter our inactive group members.</td>
</tr>
</tbody>
</table>

After you submit the Breakdown Relation form, the navigation options are available in the Analytics Hub for the relevant indicator. You do not need to run a data collection job first.

View examples of breakdown relations that are shipped by default in every instance. The example shown here is the **Members** breakdown relation. The **Member of** breakdown relation provides navigation in the reverse direction, starting with an element in **Assigned To** and navigating to an **Assignment Group**. Lastly, the **Manager** breakdown relation is similar to **Members**, but because each assignment group has only one manager, it shows a many-to-one relationship. It thus uses a facts table instead of a many-to-many table.

**Create relations between elements of one breakdown**

Use a breakdown relation to set up navigation on an Analytics Hub between a hierarchy of elements within the same breakdown. A field in the breakdown records must identify the hierarchical relationship of one record to another.

Review the use cases for breakdown relations in [Navigating breakdown elements with breakdown relations](#).

Role required: pa_data_collector, pa_power_user, admin

**Note:** While a business analyst, typically with the pa_power_user role, is most likely to know what breakdown relations to create, creating them requires the knowledge and access to tables of a technical expert with pa_data_collector. A pa_admin is likely to understand both. Consider having either a pa_admin create the relation or have a collaboration between a pa_power_user and a pa_data_collector.

You can create breakdown relations to navigate the following hierarchical relationships between elements of a breakdown:

- Child relations, to navigate from a parent element to its children
- Parent relations, to navigate from a child element to its parents
- Sibling, or peer relations, to navigate between elements that share the same parent element

In a breakdown with a hierarchical relationship between elements, one field in the element record identifies the position of the element in the hierarchy. Typically this field is **Parent**, and identifies the parent element. Elements that are the parent of one element can themselves have a parent element, and you can navigate this multi-level hierarchy in the Analytics Hub.

The example used in this topic is the **Location** breakdown for the **Number of open incidents** indicator. A child relation and a parent relation are needed to navigate the several levels of hierarchy, such as from region to country to city and back.
1. Navigate to **Breakdowns > Breakdown Relations** and click **New**.
2. In the **Breakdown** and **Related breakdown** fields, select the breakdown whose elements you want to navigate between.
   These fields have the same value when you are creating a relation between elements of the same breakdown. For our example, select the **Location** breakdown in both fields.
3. In the **Table** field, select the same table as the breakdown source facts table.
   In our example, select **Location (cmn_location)**.
4. Fill in the rest of the form, depending on whether you are creating a child, a parent, or a sibling/peer relation.

### Note:
Breakdown relations are one-way relationships. Define multiple breakdown relations to create a bi-directional relationship.
Breakdown Relation form

<table>
<thead>
<tr>
<th>Field</th>
<th>Child relation</th>
<th>Parent relation</th>
<th>Sibling/peer relation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Breakdown field</td>
<td>Select the field that identifies the parent element. For the Location breakdown, select <strong>Parent</strong>.</td>
<td>Select the unique identifier field for elements of this breakdown. For the Location breakdown, as for most breakdowns, select <strong>Sys ID</strong></td>
<td>Select the unique identifier field for elements of this breakdown. For the Location breakdown, as for most breakdowns, select <strong>Sys ID</strong></td>
</tr>
<tr>
<td>Related breakdown field</td>
<td>Select the unique identifier field for elements of this breakdown. For the Location breakdown, as for most breakdowns, select <strong>Sys ID</strong></td>
<td>Select the field that identifies the parent element. For the Location breakdown, select <strong>Parent</strong>.</td>
<td>Select the unique identifier field for elements of this breakdown. For the Location breakdown, as for most breakdowns, select <strong>Sys ID</strong></td>
</tr>
<tr>
<td>Common field</td>
<td>Leave empty.</td>
<td>Leave empty.</td>
<td>Select the field that identifies the parent element. For the Location breakdown, select <strong>Parent</strong>.</td>
</tr>
</tbody>
</table>

5. **Under Conditions**, define any further conditions that a record must fulfill to appear as a related breakdown for this relationship.

After you submit the Breakdown Relation form, the navigation options are available in the Analytics Hub for the relevant indicator. You do not need to run a data collection job first.

View examples of breakdown relations that are shipped by default in every instance. For the Location breakdown, the **Child Location** and **Parent Location** breakdown relations are included. The **Sibling Group** breakdown relation is an example of a sibling or peer relation.

**Control access to a breakdown**

You can control access to specific breakdowns.

Roles required: pa_admin or admin

There are no visibility options for breakdowns. Instead, access to breakdowns is regulated by ACLs in the breakdown sources.

1. Navigate to **Performance Analytics > Breakdown Sources**.
2. Open the breakdown sources record for the breakdown you want to set access to.
3. In the **Security type** choice list, select if you want to blacklist (exclude) or whitelist (include) source elements by role based on element security lists.
4. Define an Elements Security List record and either select the elements to be included or excluded, or use conditions to define which elements should be included.
5. Specify the roles that have access to the elements security list.
Define an elements security list
An elements security list prevents unauthorized access to breakdown elements.

1. Navigate to Performance Analytics > Breakdown Sources.
2. Open an existing breakdown source record.
3. In the Elements Security List related list, click New.
4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Descriptive name of the elements security list.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of what the elements security list does and its purpose.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box for making the elements security list active (selected) or inactive (cleared).</td>
</tr>
<tr>
<td>All roles</td>
<td>Select to indicate that the list applies to all roles. Clear the check box and click the lock icon to specify the roles belonging to this elements security list. You can use the search button to look for specific roles.</td>
</tr>
<tr>
<td>Security type</td>
<td>(Read-Only) Security type selected for the associated breakdown source.</td>
</tr>
<tr>
<td>Dimension</td>
<td>(Read-Only) Dimension selected for the associated breakdown source.</td>
</tr>
<tr>
<td>Facts table</td>
<td>(Read-Only) Facts table selected for the associated breakdown source.</td>
</tr>
<tr>
<td>Select elements</td>
<td>Select to specify explicitly the elements that this security list applies to. If this option is cleared, use Conditions to determine which elements to include.</td>
</tr>
<tr>
<td>All elements</td>
<td>Select for the security list to include all elements. Clear to specify individual elements in this security list. Default: selected</td>
</tr>
<tr>
<td>Show blank option</td>
<td>Select to allow a user on a breakdown dashboard to see scores without any breakdown elements specified. Clear to allow a user on a breakdown dashboard to see only scores for the breakdown elements that are visible to their role. This setting affects only widgets that follow breakdown dashboard elements. Users with the admin role can always see unfiltered scores on breakdown dashboards.</td>
</tr>
<tr>
<td>Conditions</td>
<td>The conditions for determining which breakdown elements the security list applies to. For example, (User.Manager) (is (dynamic)) (Me). Conditions are applied on top of the breakdown source conditions. This field is available only if Select elements is not selected.</td>
</tr>
</tbody>
</table>

5. Click Submit.
Role restrictions with blacklist
If blacklist security is specified for a breakdown source, and any of the roles of a user are on an element security list for that breakdown source, that user cannot see the elements which that security list applies to.

Visibility of breakdown element by user role with blacklist security

<table>
<thead>
<tr>
<th>User role on element security list?</th>
<th>Visibility of elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>None of the roles of the user are in an element security list.</td>
<td>All elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>Any of the roles of the user are in an element security list.</td>
<td>None of the elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>User has the admin role.</td>
<td>All elements are visible.</td>
</tr>
</tbody>
</table>

Role restrictions with whitelist
If whitelist security is specified for a breakdown source, and any of the roles of a user are on an element security list for that breakdown source, that user can see the elements which that security list applies to.

Visibility of breakdown element by user role with whitelist security

<table>
<thead>
<tr>
<th>User role on element security list?</th>
<th>Visibility of elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>None of the roles of the user are in a security list.</td>
<td>None of the elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>Any of the roles of the user are in a security list.</td>
<td>All elements that the security list applies to are visible.</td>
</tr>
<tr>
<td>User has the admin role.</td>
<td>All elements are visible.</td>
</tr>
</tbody>
</table>

Performance Analytics targets and thresholds

Targets and thresholds enable you to define important points in your data and provide notifications when a score reaches a specific point.

Performance Analytics targets

Targets are goals your organization wants to achieve. Targets enable you to visualize the difference between the desired score at a certain date and the actual score of an indicator.

A target can be personal or global. A personal target is visible only to the user that created it and appears as a light line, a global target is visible to all users and appears as a dark line. Personal targets appear only on the Analytics Hub, global targets appear on the Analytics Hub and time series widgets.

Create a target

You can set targets for indicators, breakdowns, and time series.

Role required:
- pa_viewer to create personal targets that are visible only to the user that created them
- pa_target_admin or admin to create global targets that are visible to all users

1. Navigate to Performance Analytics > Analytics Hub.
2. Select an indicator.
3. Optional: Select a breakdown and breakdown element if you want to add a target to a subset of the data.
   You can also select a 2nd-level breakdown and element.
4. Optional: Select a time series if the target should apply only to a specific aggregation of the data.
5. Select the date on the Analytics Hub that you want to add a target to.
   A target is used from the specified start date until the start date for another target. For example, to set a target per quarter in a year, add four targets, each starting on the first day of the quarter.
6. Click the target icon ( ).
7. Enter the numeric target value for the score at the selected date.
8. Optional: Clear the Global target check box to create a personal target. Leave the check box selected to create a global target.
   Only users with the pa_target_admin role can create global targets. Users without this role can create only personal targets.
9. Click Save.

Create a target color scheme
A target color scheme can be used to visualize the position of the indicator score relative to its target.
Role required: pa_admin, pa_power_user, or admin
For example, if you want to filter the number of open incidents, the scores for an increase of 25% can be shown in red, an increase of 10% in orange, and no change in yellow. Whereas, for example, a decrease by 25% can be shown in dark green. Two target color schemes are available in Performance Analytics by default: the 3-color traffic light and the 5-color traffic light.

**Note:** You can set a color scheme only for a global target, not a personal target.

1. Navigate to Performance Analytics > System > Target Color Schemes.
2. Click New.
3. Enter a Name and a Description.
4. Define each of the five ranges and their associated colors. If you do not want to use all the ranges, you can use the same range color for multiple range limits.
5. Click Submit.
   A Default indicator target color scheme can be set in Performance Analytics > System > Properties. This is used when no color scheme has been selected for an indicator target.

Add a target for all elements of a breakdown
You can specify a target that applies separately to each subset of data for an indicator with a breakdown.
Role required: pa_target_admin or admin
For example, you can set a target on an Incident indicator that applies separately to the scores for each assignment group.

**Note:** This functionality is available only for global targets. The Any element check box does not appear for personal targets.

1. Navigate to Performance Analytics > Targets.
2. Select the **Indicator** you want to set the target for.
3. Select a **Breakdown**.
   - The **Any element** check box is selected by default. Do not clear this check box.
4. Optional: Select a **Time series**.
   - For example, you can measure closed incidents daily and set monthly targets for closed incidents.
5. Optional: Select a **Color scheme** for the target.
6. Click **Submit**.

Define target values for the new target.

**Configure which users receive a target notification**

You can control which users receive a notification when a target is reached.

Role required: pa_target_admin

This functionality applies to global targets only. For personal targets, the target owner automatically receives notifications.

1. Navigate to **Performance Analytics > Targets**.
2. Select a target.
3. In the **Users** related list, click **Edit**.
4. Move the users that you want to notify from the **Collection** column to the **Users List** column.
5. Click **Save**.

The notification is sent automatically when a target is reached. Users that receive a notification can unsubscribe from that notification.

**Add, modify, or delete a target or threshold**

Performance Analytics administrators can add, modify, or delete global targets and thresholds as well as personal targets and thresholds for all users.

Role required: pa_admin

Personal targets and thresholds are visible on the Analytics Hub only to the user that created them. On the indicator record, you can create personal targets and thresholds for other users, or modify and delete existing targets and thresholds that other users have created.

1. Navigate to **Performance Analytics > Automated Indicators, Manual Indicators, or Formula Indicators**.
2. Select the indicator for which you want to add, modify, or delete a target or threshold.
3. Use the **Targets** or **Thresholds** related lists to add, modify, or delete targets or thresholds.

   - The related lists display both personal and global targets and thresholds. When you create a new personal target or threshold, ensure that the **Owner** field is populated.

**Performance Analytics thresholds**

Thresholds define a normal range of scores for an indicator and alert you when certain events occurs, such as when a score reaches an all-time high or low.

When a threshold is triggered the instance generates an email notification. This message is associated with the indicator and the message is directly available via the detailed Analytics Hub.

A threshold can be personal or global. A personal threshold is visible only to the user that created it and appears as a light grey dotted line, a global threshold is visible to all users and appears as a dark grey dotted line. Personal thresholds appear only on the Analytics Hub, global thresholds appear on the Analytics Hub and time series widgets.

**Create a Performance Analytics threshold**

Create a threshold to define the range of scores considered normal.
Role required: pa_power_user or admin

Thresholds can be set for any indicator in combination with a time series and elements of a breakdown.

1. Navigate to Performance Analytics > Scorecards.
2. Select an Analytics Hub.
3. Optional: Select a breakdown and breakdown element if you want to add a threshold to a subset of the data.
   You can also select a 2nd-level breakdown and element.
4. Optional: Select a time series if the threshold should apply only to a specific aggregation of the data.
5. Click the threshold icon ( ).
6. Select the condition that triggers the threshold notification, such as when the score reaches an all-time high, or when the score falls lower than a specific value.
7. Optional: Clear the Global threshold check box to create a personal threshold. Leave the check box selected to create a global threshold.
   Only users with the pa_threshold_admin role can create global thresholds. Users without this role can create only personal thresholds.
8. Click Save.

Configure which users receive a threshold notification
Configure which users should receive an email when a threshold is reached.

Role required: pa_admin, pa_power_user, or admin

This procedure applies to global thresholds. Notifications for personal thresholds are sent only to the owner of the threshold. To configure the message content, modify the PA Threshold Reached notification. See the Notifications documentation for more information.

1. Navigate to Performance Analytics > Indicators > Thresholds.
2. Open a threshold.
3. In the Users related list, click Edit.
4. In the Edit Members screen, use the slushbucket to add members.
5. Click Save.
   Besides the notifications for each indicator, you can also send notifications with an overview of all indicators for which the threshold is reached.

Configure the threshold comment
The Check PA Thresholds job triggers the PA threshold reached comment script action, which adds a comment for the indicator that has reached the threshold.

Role required: admin

The comment is displayed when you open the Analytics Hub for the indicator. Configure the threshold comment to display different text.

1. Navigate to System Policy > Events > Script Actions.
2. Open PA threshold reached comment.
3. Modify the buildMessage function within the script.
4. Click Update.

Configure threshold overview notifications
Besides the notifications for each indicator, you can also send notifications with an overview of all indicators for which the threshold is reached.
Role required: pa_admin, pa_power_user, or admin

This procedures describes how to access the summary notification and change the users who receive the notification as well as the content of the notification.

1. Navigate to System Policy > Email > Notifications.
2. Select PA Thresholds Notification.
3. Optional: Add users or groups to the Who will receive section by clicking the lock icon for either Users or Groups and then selecting the appropriate users or groups.
4. Optional: Change the content of the message by modifying the Message field.
5. Click Update.

Add, modify, or delete a target or threshold
Performance Analytics administrators can add, modify, or delete global targets and thresholds as well as personal targets and thresholds for all users.

Role required: pa_admin

Personal targets and thresholds are visible on the Analytics Hub only to the user that created them. On the indicator record, you can create personal targets and thresholds for other users, or modify and delete existing targets and thresholds that other users have created.

1. Navigate to Performance Analytics > Automated Indicators, Manual Indicators, or Formula Indicators.
2. Select the indicator for which you want to add, modify, or delete a target or threshold.
3. Use the Targets or Thresholds related lists to add, modify, or delete targets or thresholds.
   The related lists display both personal and global targets and thresholds. When you create a new personal target or threshold, ensure that the Owner field is populated.

Performance Analytics data collection and cleanup
Performance Analytics uses scheduled jobs to collect and clean scores and snapshots, and enables you to manually set or import scores.

To collect data immediately for existing records, run a historical data collection job.

For ongoing data collection, choose one of the following methods to collect indicator scores and snapshots based on the frequency and integrity of your data:

- If you need to measure an indicator once a month, quarter, or year, enter scores manually or import scores.
- If you need to measure indicators more frequently, or you want to eliminate any human involvement, use a scheduled data collection job.

**Note:** Performance Analytics snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with Collect records selected.

Performance Analytics data collection jobs do not collect scores older than specified in the property com.snc.pa.dc.keep_snapshots_for. Scores or snapshots older than this value are not collected during data collection.

**Collect historical data**
Run a historical data collection job to collect scores and snapshots for existing records. When collecting data for the first time, such as for a new indicator, run historical data collection once to generate scores and snapshots for existing records.
Role required: pa_data_collector or admin

Performance Analytics regularly collects scores from your data on an ongoing basis. When you first set up Performance Analytics for an application, or when you create new indicators or indicator sources, run historical data collection to collect scores on your existing data. Historical data collection enables you to analyze data that existed prior to setting up Performance Analytics.

**Note:** A historical data collection job deletes any previously collected data for the periods and the indicators that the job covers. It does not delete data from outside that date range or for other indicators.

Historical jobs also collect snapshots of the existing data. Performance Analytics snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with **Collect records** selected.

1. Navigate to **Performance Analytics > Data Collector > Jobs**.
2. Select a historical data collection job, such as (PA Change) Historic Data Collection, or create a new historic data collection job.
3. If you are creating or editing the historic data collection job, follow the procedure in **Create or schedule a data collection job**.

**Important:** For a historical data collection job, set **Run** to On demand. Do not run historical data collection jobs on a fixed schedule.

4. In the job indicators, exclude any breakdowns that are based on fields whose value is likely to change during the historical collection period, as described in **Configure a job indicator**.

   For example, in the provided (PA Incident SLA) Historic Data Collection job, the job indicator ‘Number of open and overdue incidents’ excludes the Assignment Group and the State breakdowns. The value of both of these breakdowns could change over the data collection period, making the results meaningless.

5. Click **Execute Now**.

After collecting historical data, use a scheduled data collection job to collect new scores regularly.

### Create or schedule a data collection job

Schedule a data collection job to regularly collect scores.

Before defining data collection jobs, make sure that indicator sources, breakdown sources, and indicators have been defined. Otherwise, jobs cannot return any results.

Roles required: pa_data_collector or admin

The important items to know when you configure a data collection job are:

- **Collection period**
- **Collection timezone**
- **Collected scores domain**, if domains are used.
- **The collection job runs without any restrictions. It does not use the permissions of the user who runs it.**

Data collection jobs run different steps to collect scores and to collect text analytics data. By default, jobs collect both types of data. To improve performance, you can instead schedule separate jobs for scores and for text analytics data.

1. Navigate to **Performance Analytics > Data Collector > Jobs** and click **New**.
You can instead edit an existing data collection job, for example to change the schedule of when the job runs. In this case, navigate to Performance Analytics > Data Collector > Jobs and click the job name.

2. In the Name field, give the job a meaningful name.

Follow a standard format for naming data collector jobs, such as (PA Indicator) Daily Data Collection, (PA Indicator) Historic Data Collection...

3. In the Operator field, select whether to collect data for an absolute or a relative time period.

<table>
<thead>
<tr>
<th>Operator Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed</td>
<td>Collects data for an absolute time period.</td>
</tr>
<tr>
<td>Relative</td>
<td>Collect data for a period of time that is relative to the time when the job is run.</td>
</tr>
</tbody>
</table>

4. If you selected Fixed as the operator, select the Fixed start date and the Fixed end date.

5. If you selected Relative as the operator, specify the intervals prior to the run time to collect data from.

If you set relative start 1 and relative end 1 and intervals of “days ago,” you collect data only for yesterday.

   a) In the fields Relative start and Relative start interval, set the number and the length, respectively, of time periods in the past to begin to collect data from.

   b) In the fields Relative end and Relative end interval, set the number and the length, respectively, of the last period in the past to collect data from.

Tip: Most indicators, and therefore most data collection jobs, run Daily. Daily scheduled jobs normally should collect for the most recently completed day. Therefore, they should have both a relative start and relative end of one day ago. Run historical data collection jobs, which have longer collection periods, only once.

For example, you want to collect scores for a set of several new indicators with a daily frequency, all using the same indicator source. First you create a historical data collection job that collects data from two months ago up to the day before yesterday. For this job, enter 60 in Relative start and days ago in Relative start interval. Enter 2 in Relative end and days ago in Relative end interval. Set the Run field to On Demand. Click Execute now and run this job once, to collect the initial scores.

Create a second job with relative start and end of 1 day ago and set the Run field to Daily. Activate this job to collect the scores for yesterday and all future scores for the day before the job is run.

6. Fill in the Job parameters, as appropriate.

<table>
<thead>
<tr>
<th>Job Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run as</td>
<td>Select the user that runs this scheduled job. The data collection job does not use the permissions of this user. Any user can run the job. However, if you have enabled domain support but do not configure domains for this job, the records retrieved from the indicator source respect the domain of this user.</td>
</tr>
<tr>
<td>Job parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Run as tz</td>
<td>Select the time zone that the queries use when they are executed from the job. Use the reporting time zone of your company if one exists. By default the System time zone is used. This time zone determines what day is &quot;Today&quot; for conditions like ((\text{Opened})(\text{on})(\text{Today})).</td>
</tr>
<tr>
<td>Active</td>
<td>If selected, as it is by default, the data collection occurs at the scheduled date and time.</td>
</tr>
</tbody>
</table>
| Run           | Select the schedule for collecting the data. Choices are:  
- Daily
- Weekly
- Monthly
- Periodically
- Once
- On demand  
If you are creating a historical data collection job, schedule the job to run On demand. |
| Day           | If Run is Weekly, specify the day of the week.  
- If Run is Monthly, specify the day of the month.  
To collect at the end of the month, set for day 1 and set Time to soon after midnight. This setting collects data for a completed month regardless of the length of the month. |
| Repeat Interval | If Run is Periodically, specify the amount of time between scheduled data collections, in days and hour. |
| Starting      | If Run is Periodically or Once, specify the date and time of the first scheduled data collection. |
| Time          | Time that the job runs, on 24 hour clock. Field appears after Active is selected.  
- Time based on the time zone for your user session, not the Run as tz time zone.  
- Generally set for an hour between midnight and 6 am at your company, to collect the last complete period.  
For example, if you are in New York and want to collect data at 5 am for your company that is on Los Angeles time, set the time to 08:00:00. |
ServiceNow    Madrid    Analytics, Intelligence, and Reporting

<table>
<thead>
<tr>
<th>Job parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Collect       | Data collection jobs have separate steps for collecting scores and for collecting text analytics. Select one of:  
· Scores only  
· Text index only  
· Both scores and text index (default)  
For more information, see Set up text analytics. |
| Conditional   | If checked, the data collection occurs only if certain conditions are met. |
| Conditions    | If Conditional is selected, write a script that specifies under what conditions the job is run. |

7. Right-click the form header and select Save.
8. In the Indicators related list, click Edit and select the indicators that this job collects data for.

Important:
· Include at least one indicator for the job. Otherwise, the job cannot return any results.
· To help keep jobs maintainable, try not to associate an indicator with more than one active collection job unless you have a clear use case. If you are trying to get real-time data, consider using a real-time indicator.

9. Click Submit.

- By default, for each job indicator, data is collected for all breakdowns and the indicator itself. To change this configuration for an indicator, see Configure a job indicator.
- If you have enabled domain support, you have a related list named Domain configuration. In this tab, click Edit to relate an existing domain configuration with this job or click New to create a new domain configuration. For more information, see Create a domain configuration.

Configure a job indicator

Increase the efficiency of data collection by configuring job indicators to collect only necessary and sensible data.

Role required: admin, pa_admin

By default, a job indicator collects data for the indicator itself and for all breakdowns that are associated with that indicator. However, not all breakdown data might make sense for a particular data collection job. For example, breakdowns that are based on fields that are likely to change over a collection period, such as Assignment Group and State, are usually excluded from historical jobs. Alternatively, you might need to collect only breakdown data and not to calculate the indicator scores. You can configure a job indicator not to collect unnecessary or meaningless data, thus reducing the resource consumption of the job.

1. Navigate to Performance Analytics > Jobs.
2. Open the job for which you want to configure a job indicator.
   Job indicators are specific to the job that uses them.
3. In the Indicators tab, click the name of the job indicator that you want to configure.
4. Fill in the fields, as appropriate.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job</td>
<td>Is automatically copied from the job name.</td>
</tr>
<tr>
<td>Indicator</td>
<td>Select the indicator that must be collected for this job.</td>
</tr>
<tr>
<td>Collect</td>
<td>Choose to collect <strong>All breakdowns</strong> or <strong>No breakdowns</strong>, or to exclude specific breakdowns.</td>
</tr>
<tr>
<td>Collect indicator</td>
<td>Select the check box to collect data for the indicator itself (the default). Clear this check box if you want to collect data for breakdowns alone. Depending on the setting in Collect, data is collected for all breakdowns, one breakdown, or none at all.</td>
</tr>
</tbody>
</table>

5. If in the **Collect** field you chose to **Exclude these breakdowns**, select breakdowns to exclude.
   a) Open the context menu and click **Save**.
      A related list of excluded breakdowns appears.
   b) Click **Edit** in the **Excluded breakdowns** list and add or remove breakdowns to exclude.

**Cancel a data collection job**

Cancel an active data collection job to stop the job from collecting scores.

Role required: **pa_data_collector** and **schedule_admin**, or **admin**

1. Navigate to **Performance Analytics** > **Data Collector** > **Jobs**.
2. Select the job you want to cancel.
3. Click **Cancel Job**.

**Add or edit indicator scores manually**

You can manually enter score data for indicators, including automated indicators.

Role required: **pa_contributor**, **pa_admin**, **pa_power_user**, or **admin**

You typically add scores manually for indicators that require an update only once a month or less often. In addition, if data cannot be collected automatically for some entities, like customers, you can manually enter or import data.

You can manually overwrite data that a job collected. However, the next time that a job is run that collects this data, the manually entered data is overwritten in turn.

1. Navigate to **Performance** > **Indicators** > **Scoresheet** > .
2. Select the indicator for which you want to enter manual scores.
3. Optional: Change the selected date by clicking the left or right arrows around the date range, or click the date range to select a new range.
4. Fill in the main scores for the indicator in the **Indicator Scores** row.
   Alternatively, if an indicator contains breakdowns, fill in the indicator scores per breakdown element.

**Note**: A percentage bar above each column of scores indicates the percentage of breakdown elements that contain scores. A value of 0 counts as a score; only the absence of any value counts as empty.
a) Click **Aggregate scores**.

b) Choose whether you want to use the **Sum** or the **Average** of a specific breakdown to calculate the main scores for the indicator.

c) Select the breakdown to aggregate, such as **Priority**, and click **Apply**. All scores for that breakdown are totaled or the average is calculated for them. For automated indicators that collect a second-level breakdown and are based on two or more breakdown sources, multi-level breakdown scores can be entered in the scoresheet. For example, for Open incidents by workgroup by priority, you can enter both scores for the elements of workgroup (first level) and the elements of priority (second level). Aggregations for these indicators are calculated in the same way as other breakdowns.

### View a data collection job event

Job events show which jobs have been executed for Performance Analytics and which actions have been triggered in your ServiceNow instance, such as notifications or business rules.

**Role required:** pa_data_collector or admin

1. Navigate to **Performance Analytics > Data Collector > Job Events**.
2. Click **Created** to view the details of a specific job event. Additional information on the job event is displayed.

### View the data collection job logs

Job logs display information about the data collection jobs that have run for Performance Analytics. You can view job logs, create events, and view and edit the event registry. The list view displays all log entries, unless filtered.

**Role required:** pa_data_collector or admin

1. Navigate to **Performance Analytics > Data Collector > Job Logs**.

   The log provides the following information for all occurrences.

#### Data Collection Job Log

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>Date and time the data collection job started.</td>
</tr>
<tr>
<td>State</td>
<td>One of the following values: <strong>Collecting</strong>, <strong>Collected</strong>, or <strong>Collected with errors</strong>.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the job.</td>
</tr>
<tr>
<td>Completed</td>
<td>Date and time the data collection job ended.</td>
</tr>
<tr>
<td>Inserts</td>
<td>The number of new records that have been inserted.</td>
</tr>
<tr>
<td>Updates</td>
<td>The number of existing records that have been updated.</td>
</tr>
<tr>
<td>Warnings</td>
<td>The number of warnings that occurred during the data collection process.</td>
</tr>
<tr>
<td>Errors</td>
<td>The number of errors that occurred during the data collection process.</td>
</tr>
</tbody>
</table>
### Data Collection Process and Logging

To debug data collection, you need to know the data collection process and how it is reflected in the job logs.

As an administrator, sometimes you have to debug a data collection job. Each job generates a log, but to understand the entries in this log, you need to know which step in the data collection process produced the entries.

The data collection job involves executing an SQL query for each indicator source that uses the data collector. The query is repeated for every collection time from the start date to the stop date, and then queries are run for the next indicator source. Each step of executing the query is documented in the data collection job log. The following example is excerpted from the (PA Incident) Historic Data Collector job.

<table>
<thead>
<tr>
<th>Step num</th>
<th>Step of SQL Query Execution</th>
<th>Example of Resulting Log Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Retrieve indicator source.</td>
<td>Processing indicator source Incidents.Open</td>
</tr>
<tr>
<td>2</td>
<td>Start date of collection job.</td>
<td>Collecting for 20171028</td>
</tr>
<tr>
<td>3</td>
<td>Fetch fields.</td>
<td>Fetching &quot;short_description,sys_id,opened_at,assignment_group,description,priority,category&quot; from &quot;incident&quot;</td>
</tr>
<tr>
<td>4</td>
<td>Generate SQL based on the conditions that are specified in the indicator source.</td>
<td>SELECT task0.<code>sys_id</code> FROM task0 WHERE task0.<code>sys_class_name</code> = 'incident' AND (task0.<code>opened_at</code> &gt;= '2017-10-28 07:00:00' AND task0.<code>opened_at</code> &lt;= '2017-10-29 06:59:59')</td>
</tr>
</tbody>
</table>

**Note:** If the indicator source specifies Today in one of the conditions, Today is considered relative to the period for which the data collection job is executed. For example, the Incidents.New indicator source includes the condition (Opened(on) (Today)). With days defined to start at 07:00:00, when data is collected for 2017-10-28, the job produces the SQL script on the right.

<table>
<thead>
<tr>
<th>Step num</th>
<th>Step of SQL Query Execution</th>
<th>Example of Resulting Log Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Validate indicator conditions</td>
<td>(Not logged)</td>
</tr>
<tr>
<td>6</td>
<td>Execute SQL query, which fetches rows from the facts table.</td>
<td>Fetched 150 rows from incident</td>
</tr>
<tr>
<td>7</td>
<td>The map/reduce function runs.</td>
<td>Applying map/reduce function for indicator source Incidents.Open</td>
</tr>
</tbody>
</table>

Applied map/reduce function

---

2. Click **Created** to view the details of a specific job.

Additional information on the job settings and sequence steps is displayed. If notifications are enabled, you can send emails about the data collection results to users.

Click on a job in the list to see a detailed log of the job. For information about the contents of individual job logs, see [Data collection process and logging](#).
<table>
<thead>
<tr>
<th>Step_num</th>
<th>Step of SQL query execution</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>If text indexing is active and has been configured for the indicator source, the data collector stores the resulting text index.</td>
<td>Storing Text Index for indicator source Incidents.Open&lt;br&gt;Bytes used by text index: 41,984 for: Incidents.Open</td>
</tr>
<tr>
<td>9</td>
<td>Loop through the records of the indicator source and execute or evaluate any scripts.</td>
<td></td>
</tr>
</tbody>
</table>

For each indicator that is a member of the collection job and uses the same indicator source:

<table>
<thead>
<tr>
<th>Step_num</th>
<th>Step of SQL query execution</th>
<th>Example of resulting log entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Validate indicator conditions</td>
<td>(Not logged)</td>
</tr>
<tr>
<td>11</td>
<td>Calculate the indicator score</td>
<td>(Not logged)</td>
</tr>
<tr>
<td>12</td>
<td>For each breakdown:&lt;br&gt;1. Calculate the breakdown score or execute the breakdown script.</td>
<td>Not logged, but retrieving breakdown unique values can cause delays, especially if the query does not use indexes or retrieves many records.</td>
</tr>
<tr>
<td></td>
<td>2. Retrieve all breakdown unique values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Create or update the array for scores or snapshots. The array is Indicator, Breakdown 1, Element 1, Breakdown 2, Element 2, Domain, Value, Array of [sys_id]</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Delete previous scores for the indicators and breakdowns that use the indicator source.</td>
<td>Deleting previous results for indicator source Incidents.Open&lt;br&gt;Deleted previous results 38&lt;br&gt;Deleted previous results 21</td>
</tr>
<tr>
<td>14</td>
<td>Store newly collected results for the indicator source.</td>
<td>Storing collected results for indicator source Incidents.Open&lt;br&gt;Stored collected results</td>
</tr>
<tr>
<td>15</td>
<td>Specify which indicators the data collector does not collect scores for.</td>
<td>Not collecting for Indicator: Summed age of open incidents with excluded Breakdown: Assignment Group</td>
</tr>
<tr>
<td>16</td>
<td>Finish collecting data for that indicator source for that period.</td>
<td>Collecting for 20171028 finished</td>
</tr>
<tr>
<td>17</td>
<td>For each other period, if any, for the same indicator source, loop back to step 2.</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>For each other indicator source, if any, loop back to step 1.</td>
<td></td>
</tr>
</tbody>
</table>

**View data collection usage**

To view statistics about data collection jobs, click **Data Collection Overview** in the Usage tile on the Performance Analytics Admin Console.

Role required: pa_admin, admin

1. Navigate to **Performance Analytics > Admin Console**.
2. In the Usage tile, click **Data Collection Overview**.
The following widgets are displayed:

- The net new scores, average run time, and number of errors for the day
- The weekly net new scores and average run time
- The number of data collection job inserts and deletes over time

By default, weekly statistics are shown in an Analytics Hub, broken down by data collector. You can select different visualizations and breakdowns in the widget.

**Cleaning collected Performance Analytics data**

Performance Analytics scores and snapshots may grow over time and should be routinely cleaned to ensure optimal performance and accurate data.

Performance Analytics uses a scheduled job to remove old scores and snapshots. The Clean PA collections scheduled job is active by default and has no impact on performance. By default, the job runs daily so it only has to delete a small amount of data.

**Note:** The table attributes nibble_size and nibble_sleep affect the behavior of the collection cleaner job if the attributes are defined for the Scores or Snapshots tables.

This scheduled job also deletes any Score (pa_scores), Score Level 1 (pa_scores_l1), Score Level 2 (pa_scores_l2), or Snapshots (pa_snapshots) records that do not have an associated indicator or breakdown. For example, if a user deletes an indicator, the scheduled job cleans up any scores or snapshots that were associated with the deleted indicator.

**Modify the Clean PA collections job**

Modify the scheduled job to configure when Performance Analytics scores and snapshots are cleaned. The scheduled cleanup job should not run while a data collection job is running.

Role required: pa_admin or admin

By default, the Clean PA collections job runs at 05:00 which is appropriate when using the default data collection jobs. If you create additional data collection jobs, you may need to change the start time of the Clean PA collections job.

1. Navigate to **Performance Analytics > Automation > Schedules**.
2. Select the **Clean PA collections** job.
3. Make any necessary changes. For example, change the **Run time** field value to change when the job runs.
4. Click **Update**.

**Migrating Performance Analytics scores**

The Performance Analytics Scores (pa_scores) table was split into two tables. This structure helps with processing large numbers of scores. You can migrate your scores from the old table structure to the new, using the score migration tool.

**Warning:** The new table structure is not supported on Oracle databases.

In Istanbul, the Scores (pa_scores) table was split into Scores Level 1 (pa_scores_1) and Scores Level 2 (pa_scores_2). The pa_scores_2 table contains the second-level breakdown matrix of scores and the pa_scores_1 table contains all other scores. This separation of scores ensures optimal performance when collecting and analyzing scores, and enables larger sets of scores. New instances created on the Istanbul release or later use the new scores tables by default.
Instances created prior to Istanbul still use the original Scores (pa_scores) table after upgrading. However, you can migrate your scores on these instances to the new scores tables. Your instance must be on a release that supports the scores migration tool, as follows:

- London, with patch 10
- Madrid, with patch 6
- All New York and later releases

**Migration Monitor**

After beginning the migration, you can track the migration status by navigating to **Performance Analytics > Scores Migration Monitor**.

If any errors occur during migration, contact ServiceNow Technical Support to resolve the issue.

**Delays in starting score migration**

If any of the following processes are running, score migration remains in the Waiting state until they stop:

- Data collector jobs
- Collection cleaner jobs
- Scoresheet editing

**Schedule the Performance Analytics scores migration**

Schedule the automated migration process to move existing scores to the new table structure.

Role required: admin. Users with the pa_admin role can view the migration monitor page but cannot schedule the migration.

Migrating scores improves performance and scalability of Performance Analytics. Migration should be performed during off-peak hours.

During migration you cannot collect, modify, or delete scores. Scheduled data collection jobs do not run during migration. After migration completes, check any data collection jobs that were scheduled to run during the migration, as these jobs were suspended.

**Note:**

- The scores migration can take several hours to complete, depending on the number of scores. Schedule the migration in a non-production instance and then carefully plan the migration in production.
- The original Scores (pa_scores) table is truncated 10 days after successful migration.

1. Navigate to **Performance Analytics > Scores Migration Monitor**.
2. Click the **Schedule Scores Migration** button.
   If there are greater than 300 million scores on the instance, the button is disabled. Contact ServiceNow Technical Support to begin the scores migration.
   The scores migration is scheduled. The page displays the time that the migration is scheduled to start, and the estimated completion time.
3. Optional: Click the **Logs** or **Active Jobs** links to view additional information about the migration.
If there are any data collection or cleanup jobs running when you start the migration, the migration waits for those jobs to complete before beginning. All scheduled collection and cleanup jobs are paused during the migration.

If the migration fails for any reason, contact ServiceNow Technical Support for assistance. Existing scores remain in place.

Using Performance Analytics with external data

Performance Analytics on external data sources enables you to perform detailed analysis on data that is not in your ServiceNow instance.

When you collect scores on external data, Performance Analytics stores scores and breakdown elements from the external data on your instance. The raw data being analyzed remains on the external data source and is not copied to your instance. This functionality enables you to analyze and share metrics without duplicating the underlying data.

Performance Analytics external data collection uses three types of configuration records:

- An external indicator which specifies the JDBC data source and SQL statement used to collect scores.
- An external breakdown which specifies the JDBC data source and SQL statement used to specify breakdown elements.
- An external indicator breakdown which defines the relationship between an external indicator, and breakdown, and the SQL statement used to collect scores for each breakdown element for that indicator.

Create an indicator for external data

Create an external indicator to define what data to evaluate and the SQL statement used to determine the indicator score.

Role required: pa_admin, pa_power_user, or admin

1. Navigate to Performance Analytics > External Indicators and click New.
2. Give the indicator a descriptive Name.
3. In the Frequency field, specify the frequency of data points for the indicator, such as Daily, Weekly, or Monthly.
4. In the Source tab, select a Data Source to collect scores from.
   Only JDBC type data sources are supported by Performance Analytics. Refer to the data sources documentation for information on setting up data sources.

   Note: The SQL Statement and Import set table defined in the data source are not used by Performance Analytics.

5. Specify the SQL Statement to use to calculate the score value.
   The SQL statement must return an aggregate value with the alias value, and should filter data based on a date field, such as SELECT count(*) AS value FROM...
   WHERE DATE(date_field) >= DATE(${start_at}).

   Important: The aggregate alias must be value.

6. If you prefer that the score of this indicator increases or decreases over time, select Maximize or Minimize in the Direction field.
   Analytical tools and graphic displays use this Direction with this indicator.
Tip: Set a direction whenever you can. All key indicators should be set to Maximize or Minimize.

<table>
<thead>
<tr>
<th>Value</th>
<th>Use case</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximize</td>
<td>Select if an increase in this indicator score is desired. For example, consider selecting <strong>Maximize</strong> for an indicator that shows revenue. Analytic tools and graphic elements reflect that an increase in this indicator score is good and a decrease is bad.</td>
</tr>
<tr>
<td>Minimize</td>
<td>Select if a decrease in this indicator score is desired. For example, consider selecting <strong>Minimize</strong> for an indicator that shows costs. Analytic tools and graphic elements reflect that a decrease in this indicator score is good and an increase is bad.</td>
</tr>
<tr>
<td>None</td>
<td>Select if the direction of change in this score does not matter to your business.</td>
</tr>
</tbody>
</table>

7. **Optional:** Specify any of the remaining indicator properties:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>The unit of measurement for the score, such as number, days, or percentages.</td>
</tr>
<tr>
<td>Precision</td>
<td>The number of digits behind the decimal separator. For thousands and millions, the score is given in thousands or millions followed by a k or an M, with the next lowest power of 10 following the decimal. For more information, see <a href="#">Rounding and precision in indicators</a>.</td>
</tr>
<tr>
<td>Key</td>
<td>Identifies the indicator as a key indicator. Used only to filter the list of indicators in Performance Analytics &gt; Analytics Hub.</td>
</tr>
</tbody>
</table>

8. In the **Access control** tab, set whether to publish this indicator to the Analytics Hub, and whether to limit the visibility of the indicator by user, group, or role.

9. **Optional:** In the **Other** tab, set various miscellaneous properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default time series</td>
<td>A predefined analytical function, like a 7-days running average, to apply to the indicator instead of showing the raw scores of the indicator. The indicator frequency restricts which time series are available. For more information, see <a href="#">Time series aggregations in the Analytics Hub and widgets</a>.</td>
</tr>
<tr>
<td>Live group profile</td>
<td>Live group profile that indicates the live group where the indicator scores are published.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Order</td>
<td>Number indicating the order in which indicators are displayed in the Analytics Hub. Indicators with the lowest value are displayed at the top of the list. If no values are provided in the Order field, indicators are displayed from a to z using the Name field. To use the order field, you must enter order numbers for all indicators. If you put in numbers for only a few indicators, the order in which indicators are displayed reverts to a to z.</td>
</tr>
<tr>
<td>Default chart type</td>
<td>Set a default chart type (line, column, spline, or area) for this indicator. When opening the Analytics Hub for this indicator for the first time, the default chart type is used. If the chart type is changed in the Analytics Hub, that preference is remembered.</td>
</tr>
<tr>
<td>Render continuous lines</td>
<td>When selected, the Analytics Hub shows unbroken data lines for this indicator, even when there is no data for a specific date. This behavior may be useful when displaying data sets with varied starting dates or data that is not regularly updated, such as stock information.</td>
</tr>
<tr>
<td>Show real-time score</td>
<td>When selected, the Analytics Hub shows the score of this indicator in real time, as well as the current state of associated records. Clear this check box when indicator data is not available in real time, such as in an integration that uses data from a third-party source. Note: A condition must be set on the indicator or the associated indicator source for real-time scores to be displayed.</td>
</tr>
<tr>
<td>Show delta</td>
<td>When selected, enables reporting of historic records when viewing this indicator in the Analytics Hub. You can filter the data to display only the current data, only the historical data, or the data shared between both sets.</td>
</tr>
</tbody>
</table>

10. Optional: In the **Forecasting** tab, set the forecast method, the number of data collection periods to forecast, the amount of historical data to base the forecast on, and the upper and lower limits of forecast values. For more information, see [Performance Analytics scores forecasts](#).

11. Save the indicator.

12. **Press Test Collection.**

   This action tests the main query of the indicator.

If you want to collect breakdown scores for the indicator, define an external breakdown and associate it with the indicator.
Create a breakdown using external data

Create an external breakdown to define what elements are available to break down external indicator scores.

Role required: pa_admin, pa_power_user, or admin

By default an external breakdown can contain a maximum of 5000 elements. This limit is controlled by the property `com.snc.pa.dc.max_external_elements`.

External breakdown elements are stored on the `pa_ext_elements` tables.

1. Navigate to **Performance Analytics > External Breakdowns**.
2. Click **New**.
3. Select a **Data Source** that contains the records you want to use as breakdown elements.

   Only JDBC type data sources are supported by Performance Analytics. Refer to the data sources documentation for information on setting up data sources.

   **Note:** The SQL Statement and Import set table defined in the data source are not used by Performance Analytics.

4. Specify a **SQL Statement** to select the breakdown elements.

   The SQL Statement must return the unique key for each breakdown element with the alias `id` and the element display name with the alias `name`, such as `SELECT guid AS id, user_name AS name FROM...`.

   **Important:** The unique key alias must be `id` and the display name alias must be `name`.

5. Save the breakdown.
6. Press **Test Collection**.

   This action tests the query that selects the breakdown elements.

After defining how to collect breakdown elements, associate the external breakdown with one or more external indicators.

Configure an external indicator to use an external breakdown

Associate an external indicator and external breakdown to define how to collect breakdown scores for the indicator.

Role required: pa_admin, pa_power_user, or admin

1. Navigate to **Performance Analytics > External Indicators**.
2. Select an indicator.
3. In the **Breakdowns** related list, click **New**.
4. Select the external **Breakdown** to apply to this indicator.
5. In the **SQL statement** field, enter a SQL statement that calculates the score value for each breakdown element.

   The SQL statement should use the same aggregate function as the indicator SQL statement, such as `COUNT`. The SQL statement must return the aggregate value with the alias `value` and the breakdown element unique key with the alias `id`. The SQL statement must also group the data by the column that contains the breakdown element values.

   For example, `SELECT count(*) AS value, guid as id FROM... WHERE DATE(date_field) >= DATE({$start_at}) GROUP BY guid`
Important: The aggregate alias must be **value** and the breakdown unique key alias must be **id**.

6. Save your changes.
7. Press **Test Collection**.
   
   This action tests the SQL statement that calculates the score value for the breakdown element.

Repeat the previous steps to add additional breakdowns to the indicator. Test the SQL statement after adding each one.

**Test external indicators and breakdowns**

Test your external indicators and breakdowns to ensure you can connect to the external data source and collect the data you expect.

Role required: pa_admin, pa_power_user, or admin

Test an indicator to test the query for that indicator and the queries for all breakdown elements.
Test a breakdown to test the query used to determine available breakdown elements.

No scores or breakdown elements are saved when you test an indicator or breakdown.

1. Navigate to **Performance Analytics > External Indicators** or **Performance Analytics > External Breakdowns**.
2. Select the indicator or breakdown that you want to test.
3. Click the **Test** button.
   
   If the query runs successfully, the number of scores or breakdown elements that would be collected appears. If an error occurs during testing, the error message appears.

After confirming that all queries run successfully and return the data you expect, add the external indicator to a data collection job to begin collecting scores.

**Filtering external data by date**

When using Performance Analytics with external data you must filter SQL statements that collect scores by date.

In indicator and indicator breakdown SQL statements, filter the query by date, such as `WHERE DATE(my_date_field) >= DATE(${start_at})`. It is not necessary to filter breakdown SQL statements by date as breakdown SQL statements collect only elements and not scores.

The variable `${start_at}` contains the date of the period being collected in the format YYYYMMDD. For daily indicators this value is always the date being collected. For indicators with longer collection frequencies, such as weekly or monthly, the date is the first day of the collection period. The date that the data collection job runs on does not affect this variable.

When you test an indicator or breakdown, the `${start_at}` variable is always set to the current date.

**Limitations when using Performance Analytics with external data**

Certain Performance Analytics functionality is not available when you measure external data.

- You cannot collect snapshots
- You cannot view real-time scores
- You cannot apply 2nd-level breakdowns
- You cannot use widget visualizations that depend on 2nd-level breakdowns with external data. This includes pivot and heatmap visualizations.
- Because snapshots are not available, you cannot view changes in collected records
Quickly configure Performance Analytics for a task table

The configuration generator enables you to quickly configure Performance Analytics to display data from any task table.

You can specify a Task-based table to report on, and the configuration generator automatically creates indicators, breakdowns, formulas, data collection jobs, and dashboards. This configuration provides the same elements as the Performance Analytics incident solution, but for any Task table. When using domain separation, all records are created in the domain of the current user.

**Note:** You can use the configuration generator only with tables that extend Task.

You can access the configuration generator by navigating to Performance Analytics > Configuration Generator.

After generating a configuration for the selected table, you can view the created records using the Go to the configuration record, Generated Indicators, and Generated Jobs related links. You can modify the generated records as needed using standard Performance Analytics configuration options.

**Note:** You may need to tweak the configuration before you start using the files that are created by the generator.

Activate the Performance Analytics configuration generator

As an administrator, you can enable the Performance Analytics configuration generator plugin (com.snc.pa.configurationgenerator).

Role required: admin

Before starting this procedure, you must have Performance Analytics.

1. Navigate to System Definition > Plugins.
   
   A banner appears to notify you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.

   **Note:**
   
   To redirect to the legacy list view for plugins, click the link.

   ![Plugin View](image)

   ![Redirect to Legacy List](image)

2. Find the plugin with the filter criteria and search bar.

   You can search for the plugin by its name or ID.

   If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Activate the plugin.

   You can activate the plugin directly from the All Applications page or view more details about the plugin before activating it.

   - If you are certain that you have the correct plugin, click Install, and then click Activate in the dialog box that appears.
To view plugin details before activation:

1. Click the plugin name.
2. On the form, click the *Activate/Update* related link.
3. On the dialog box that appears, review the dependent plugins.
   
   If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.

4. If demo data is available and you want to install it, click *Load demo data*.
   
   Some plugins include demo data, which are sample records that illustrate plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking *Load demo data only* on the plugin form.

5. Click *Activate*.

**Performance Analytics schema maps**

You can view a schema map of Performance Analytics configuration records.

To view the schema map for a Performance Analytics configuration record, click the *Show Schema Map* related link on the appropriate form.

You can view the schema map for these types of records:

- Automated indicators
- Breakdowns
- Indicator sources
- Breakdown sources
- Scripts
- Element filters
Domain separation and Performance Analytics

Performance Analytics supports collecting scores from multiple domains and can be configured to enable domain-specific administration. Additional domain functionality is available for managed service providers. This is an overview of domain separation and Performance Analytics. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 3

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Note: You must license Performance Analytics to use it in any domain other than global.

Performance Analytics domain configurations

When using Performance Analytics with domain separation you can collect domain-specific scores, and use global or domain-specific configuration records such as indicators, breakdowns, and dashboards.

Collecting domain-specific scores

Data collector jobs can access records based on the roles, entitlements, and domain of the user selected in the job Run as field. To collect scores from a particular domain, ensure the Run as user is a member of that domain.

The domain of each data collector job determines the domain of scores generated by that data collector. The domain of the source records do not affect the domain of the scores.

Only users with the pa_admin role that are a member of the domain that contains the scheduled job, or the domain of the Run as user, can modify domain-separated data collection jobs.

Global configuration

By using configuration records in the global domain, you can present domain-appropriate data automatically.

Note: Additional functionality is available for MSP customers using domain separation. For more information, see Performance Analytics domain separation for managed service providers. This functionality requires a global configuration.

To populate the data, create a separate data collector job for each domain. Ensure each user selected in the Run as field is a member of the correct domain. The collected score is recorded under the domain of the Run as user. When a user in a domain views a widget or Analytics Hub, only scores from that user’s domain appear.

By default, configuration records from Performance Analytics solutions use the global domain.
Domain-specific configuration

By using domain-specific configuration records, you can grant the pa_admin role to domain users to create their own domain-specific components. Users, including system administrators, can create and edit configuration records only within their domain. Users in child domains can read but not edit configuration records in a parent domain.

You must create a domain-specific copy of a configuration record to use it in that domain. For example, to add a domain-specific condition to an indicator source, you must create a copy of the indicator and indicator source in that domain.

You can quickly copy an indicator or breakdown and related data from a different domain using the Insert and Stay with Relations UI action on the Indicator or Breakdown forms. Any breakdowns, breakdown exclusions, or time series exclusion relationships are also copied. Any associated scheduled jobs are copied only if the Run as user for that job is the current user.

To collect scores, create a new data collector job associated with the domain-specific indicators.

**Note:** Domain users cannot set Performance Analytics properties that begin with com.snc.pa. These properties can only be set by users with the admin or pa_admin roles in the global domain.

Hybrid configuration

By using a hybrid configuration you can maintain reusable foundation configuration records such as indicator sources within the global domain or a parent domain while allowing administrators in other domains to create domain-specific configuration records such as indicators and widgets.

**Note:** The hybrid configuration is an advanced option. Implement either the global or domain-specific configurations successfully before attempting to use a hybrid configuration.

When using a hybrid configuration, foundation records should be managed only within the global domain or a parent domain. All other configuration records, such as widgets and indicators should be managed separately within each child domain. The following record types are considered foundation records.

- Bucket groups
- Buckets
- Scripts
- Breakdown sources
- Indicator sources
- Filters
- Breakdowns
- Managed sources
- Manual breakdowns
- Breakdown mappings
- Breakdown relations
Copying configuration data between domains

You can reuse Performance Analytics configurations in multiple domains. The PADomainUtils API provides functionality that enables system administrators to move or copy Performance Analytics configuration records between domains.

Transferring domain configurations between instances

Use update sets to transfer domain configurations between instances. If the domain configuration has Collect aggregate enabled, also transfer the aggregation domain separately. For more information, see Transfer domain configuration with score aggregation.

Performance Analytics domain separation for managed service providers

Managed service providers can configure Performance Analytics with domain separation to provide domain-specific analytics and to control how scores are collected through the domain hierarchy.

You can create domain configurations to define which domains to collect data from and which domains to display on dashboards. Associate these domain configurations with specific data collection jobs and dashboards to provide relevant scores to users while maintaining your Performance Analytics configuration in a single domain.

To use this functionality you must have Performance Analytics, the Domain Support - Domain Extension installer plugin, and responsive dashboards.

Activate the Performance Analytics - Domain Support plugin
You can activate the Performance Analytics - Domain Support plugin (com.snc.pa.domain_support) if you have the admin role.

Role required: admin

Performance Analytics - Domain Support activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics - Domain Support (com.snc.pa.domain_support)</td>
<td>Provides features to support scores collection on domain-separated instances. This plugin depends on the Performance Analytics premium and Domain Separation plugins.</td>
</tr>
</tbody>
</table>

1. Navigate to System Definition > Plugins.

A banner appears to notify you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.

Note:
To redirect to the legacy list view for plugins, click the link.

1. You have been redirected to All Applications. To see the Plugins list click here

2. Find the plugin with the filter criteria and search bar.
You can search for the plugin by its name or ID.

If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Activate the plugin.

You can activate the plugin directly from the All Applications page or view more details about the plugin before activating it.

- If you are certain that you have the correct plugin, click Install, and then click Activate in the dialog box that appears.

To view plugin details before activation:

1. Click the plugin name.

2. On the form, click the Activate/Update related link.

3. On the dialog box that appears, review the dependent plugins.

   If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.

4. If demo data is available and you want to install it, click Load demo data.

   Some plugins include demo data, which are sample records that illustrate plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking Load demo data only on the plugin form.

5. Click Activate.

Create a domain configuration

Create a domain configuration to define which domains to collect scores from and how to store scores within the domain hierarchy.

Role required: pa_admin or admin

Navigate to Performance Analytics > Domain Configuration and create a new record.
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration type</td>
<td>Specify how you want to determine which domains to include in this configuration.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Visibility group</strong> to include all domains visible to a specific group, based on existing visibility domains associated with that group.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Conditions</strong> to specify the domains directly, using conditions.</td>
</tr>
<tr>
<td>Visibility group</td>
<td>When <strong>Configuration type</strong> is <strong>Visibility group</strong>, select the user group. All domains available to this group, based on associated visibility domains, are included in this domain configuration.</td>
</tr>
<tr>
<td>Conditions</td>
<td>When <strong>Configuration type</strong> is <strong>Conditions</strong>, specify conditions to determine which domains are included in this configuration.</td>
</tr>
<tr>
<td>Collect aggregate</td>
<td>Aggregate scores from the specified domain hierarchy. Aggregate scores are stored in a separate domain that exists outside of the domain hierarchy and contains only scores.</td>
</tr>
<tr>
<td></td>
<td>One aggregate domain is created for each domain configuration where <strong>Collect aggregate</strong> is selected. The name of this domain is displayed in the read-only <strong>Aggregate domain</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Aggregate domains are stored as children of the Performance Analytics Aggregation Container domain.</td>
</tr>
<tr>
<td>Collect children</td>
<td>Select this option to collect scores from children of the specified domains. Scores are collected from all child domains, not only those domains that are direct children of the specified domains.</td>
</tr>
<tr>
<td></td>
<td>Scores collected from a child domain are stored in that domain.</td>
</tr>
<tr>
<td>Roll up</td>
<td>Select this option to roll collected scores up to the top-level domain in the selected hierarchy. Scores collected from child domains are stored in the top-level domain of the specified domain hierarchy.</td>
</tr>
<tr>
<td>Roll up type</td>
<td>Select <strong>All child domains</strong> to roll up scores from the specified domains and all of their child domains. Select <strong>Only selected domains</strong> to roll up scores only from the domains you specified.</td>
</tr>
</tbody>
</table>

### Associate a domain configuration with a data collection job

**Associated a domain configuration with a collection job to collect scores from specific domains.**

**Role required:** `pa_data_collector` or `admin`
When you use a domain configuration to control the domain of a data collection job, the domain of the **Run as** user is not used.

1. Navigate to **Performance Analytics > Jobs**.
2. Select a data collection job.
3. In the **Domain Configurations** related list click **Edit**.
4. Select the domain configurations you want to associate with this job.

   A separate data collection job runs for each domain included in the configuration.
5. Click **Save**.
6. Optional: Modify the **Order** of the domain configuration.

   If multiple domain configurations are associated with a collection job, any overlap in the included domains may cause scores to be collected incorrectly. Only the scores collected for the domain configuration with the highest **Order** value are preserved for the overlapping domains.

   **Tip:** When using multiple domain configurations with a single job, ensure each domain configuration specifies a unique set of domains.

---

**Associate a domain configuration with a dashboard**

Associate a domain configuration with a dashboard to display the domain picker on that dashboard and enable users to view scores from specific domains.

Role required: pa_power_user or admin

A user must have visibility into all domains in the domain configuration to view domain-specific scores on a dashboard.

1. Navigate to **Performance Analytics > Dashboard Administration**.
2. Select a dashboard.
3. In the **Domain Configurations** related list click **Edit**.
4. Select the domain configurations you want to associate with this dashboard.
5. Click **Save**.

---

**Domain separation on dashboards and the Analytics Hub**

You can view domain-specific scores on dashboards and Analytics Hubs.

When you view a dashboard associated with one or more domain configurations you can select which domain's scores to view.

**Note:** You must have access to all domains in the domain configuration to view the domain choice list.

Select a specific domain, or select **My domain** to view scores associated with your domain.

When viewing domain scores on a dashboard, click a widget to view the domain-specific indicator in the Analytics Hub. The name of the domain appears following the indicator name on the Analytics Hub. All details on the Analytics Hub are specific to the domain. Any target, threshold, or comment you add is automatically associated with the current domain. The **Edit scores** option is not available from a domain Analytics Hub.

---

**Transfer domain configuration with score aggregation**

To transfer between instances a Performance Analytics domain configuration that is set to aggregate scores, transfer both the configuration and the aggregation domain.

Transfer the domain configuration with an update set. For more information about using update sets to transfer configurations between instances, see [System update sets](#).
1. Log in as admin to the source instance from which you transferred the domain configuration.
2. Navigate to **Data Collector > Domain Configurations**.
3. Open the domain configuration record that you transferred in the update set.
4. Right-click on the header of the form and select **Show XML**.
5. Copy the `sys_id`, which is the value of the `aggregate_domain` element.

This XML file does not appear to have any style information associated with it below.

```
<xml>
<pa_domain_configurations>
  <aggregate_domain display_value="OpCos">676a49440fa8060094a9716ce1050e14</aggregate_domain>
</pa_domain_configurations>
```
6. Navigate to Domain Admin > Domains.
7. Filter the list of domains by the sys_id that you copied from the transferred domain configuration.
8. Open the filtered domain and from the context menu, export the domain record to XML.
9. Log in as admin to the target instance.
10. Navigate to Domain Admin > Domains.
11. From the context menu, import the XML file of the domain record from the source instance.

You can execute data collection jobs for the transferred domain.

**PADomainUtils**

The PADomainUtils API enables you to copy Performance Analytics configurations between different domains on the same instance.

Use this API in server scripts to copy Performance Analytics configuration records, such as indicators, breakdowns, and dashboards, to different domains. This API enables you to create a Performance Analytics configuration in one domain and copy that configuration to any number of additional domains.

**Note:** This API cannot copy records into the Global domain.

To use PADomainUtils, you must satisfy these requirements:
- Performance Analytics must be enabled.
- The user running the script must have the admin role.
- The instance must use domain separation.
- The script must be run from the global domain.
- When moving or copying records, the source and target domains must be different.

**PADomainUtils - PADomainUtils()**

Instantiates a new PADomainUtils object to move or copy Performance Analytics configuration records from the global domain.

Use the PADomainUtils(String domainFrom) constructor instead when moving or copying records from a domain other than the global domain.

**Parameters**

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```
// PADomainUtils initialized with the global domain
var globalUtils = new SNC.PADomainUtils();
```

**PADomainUtils - PADomainUtils(String domainFrom)**

Instantiates a new PADomainUtils object to move or copy Performance Analytics configuration records from the specified domain.

Use the PADomainUtils() constructor instead when moving or copying from the global domain.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>domainFrom</td>
<td>String</td>
<td>The domain to copy records from.</td>
</tr>
</tbody>
</table>

```java
// c90d4b084a362312013398f051272c0d is the sys id of the ACME domain
var acmeUtils = new SNC.PADomainUtils('c90d4b084a362312013398f051272c0d');
```

** PADomainUtils - setFoundation(Boolean foundation) **

Use this method to move or copy only foundation records in a hybrid domain configuration.

You can implement a hybrid configuration by maintaining some types of record in a parent domain and some types in child domains. Records maintained in the parent domain are known as foundation records. The following types of record are considered foundation records.

- Bucket groups
- Buckets
- Scripts
- Breakdown sources
- Indicator sources
- Filters
- Breakdowns
- Managed sources
- Manual breakdowns
- Breakdown mappings
- Breakdown relations

Other Performance Analytics configuration records such as widgets and indicators are not foundation records. Set this method to false to move or copy these additional records as well.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>foundation</td>
<td>Boolean</td>
<td>Indicates if only foundation records should be copied or moved by this PADomainUtils object.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PADomainUtils</td>
<td>The object calling this function.</td>
</tr>
</tbody>
</table>

```java
var pa = new SNC.PADomainUtils().setFoundation(true);
```
PADomainUtils - setOverrides(Boolean overrides)

Use this method before copying records to set the sys_override value of the new record to the original parent record.

Using this method enables you to automatically override records in a parent domain. By overriding the parent records, the parent records do not impact the child domain. If the source domain is not the parent of the target domain when copying records, setting the sys_override value will not have any impact on behavior. You can specify an override only when copying records, not when moving records.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>overrides</td>
<td>Boolean</td>
<td>Indicates that copied records in a child domain should override the source record in the parent domain. This value is true by default.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PADomainUtils</td>
<td>The object calling this function.</td>
</tr>
</tbody>
</table>

var pa = new SNC.PADomainUtils('c90d4b084a362312013398f051272c0d');
pa.setOverrides(false);
pa.copy('bb6b58b01f1310005a3637b8ec8b70dd');

PADomainUtils - copy(String runAs)

Copies Performance Analytics configuration records to a different domain.

To copy dashboards or scheduled jobs, see copyDashboard and copyJob.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy records to.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>
PADomainUtils - copyJob(String paJob, String runAs)
Copies a Performance Analytics scheduled data collection job record to another domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>paJob</td>
<td>String</td>
<td>The sys_id of a Performance Analytics scheduled data collection job (sysauto_pa) record.</td>
</tr>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy the job to.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>An error message if an error occurs, or an empty string if there is no error.</td>
</tr>
</tbody>
</table>

PADomainUtils - copyDashboard(String dashboardId, String runAs)
Copy a dashboard to another domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dashboardId</td>
<td>String</td>
<td>The sys_id of the dashboard to copy.</td>
</tr>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy the dashboard to.</td>
</tr>
</tbody>
</table>
PADomainUtils - copy(String runAs)
Moves Incident Management dashboard from global to user's domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy records to.</td>
</tr>
</tbody>
</table>

Optional example explanation

```
// Copy Incident Management dashboard from global to user's domain
var pa = new SNC.PADomainUtils();
pa.copyDashboard('a64b7031d7201100b96d45a3ce610335', '09ff3d105f231000b12e3572f2b4775d');
```

PADomainUtils - move(String runAs)
Moves Performance Analytics configuration records to a different domain.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>runAs</td>
<td>String</td>
<td>The user whose domain you want to copy records to.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

Optional example explanation

```
// move all the Performance Analytics records from the global to the customers domain
var pa = new SNC.PADomainUtils();
pa.move('774190f01f1310005a3637b8ec8b70ef');
```

PADomainUtils - isWriteable(String table, String id)
Evaluate if you can write to a specific record identified by table and sys_id.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>String</td>
<td>The name of the table containing the record to query, such as pa_indicators.</td>
</tr>
<tr>
<td>id</td>
<td>String</td>
<td>The sys_id of the record to query.</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Indicates that you can write to the specified record. Returns true if the record exists within the domain of the current user. Returns false if the record does not exist, or is in a different domain.</td>
</tr>
</tbody>
</table>

```javascript
var pa = new SNC.PADomainUtils();
pa.isWriteable('pa_incidents','cd8125b5140012007665a83e633b028d');
```

**Link an automated indicator to a benchmark**

To enable the comparison of indicators to ITSM and ITOM benchmarks, link an automated indicator to the corresponding benchmark KPI. A benchmark KPI can be linked to only one indicator. You can compare the linked indicators in the Analytics Hub.

You must opt-in to the ServiceNow® Benchmarks application.

Role required: pa_data_collector, pa_power_user, admin

**Note:** If you have the sn_bm_client.benchmark_admin role, you can link Performance Analytics indicators to benchmark indicators through the Benchmarks Setup interface. For instructions about linking indicators through that interface, see [Link or customize a benchmark KPI](#).

Used together, benchmarking and Performance Analytics enables you to measure your enterprise ITSM and ITOM against industry standards while driving improvements across all important metrics. For more information, see [Benchmarks](#).

1. In the list of automated indicators or the list of formula indicators, identify which benchmark indicator you want to link to which other indicator.

   Benchmark indicator names begin with the word **Benchmark**.

2. Verify that the benchmark indicator and the linked indicator are configured compatibly.

   Specifically, verify that the following properties match in both indicators:
   - Indicator source
   - Unit
   - Formula (for formula indicators)

**Warning:** The indicators in Out-of-the-box Performance Analytics Solutions are not configured the same as the matching benchmark indicators.

3. Open the benchmark indicator record.

4. In the **Linked indicator** field under **Indicator properties**, select the automated indicator to link to the benchmark.

**Note:**
- The fully licensed version of Performance Analytics must be activated to see the complete list of Performance Analytics automated and formula indicators.
To edit the **Linked indicator** field, you may need to change the scoped application that you are working in, at the top of the record.  
The names of the benchmark indicator and the indicator to link might not match.

After you update the benchmark KPI record, you can compare the benchmark KPI and the automated indicator on the **Compare** tab of the Analytics Hub for the automated indicator. For more information and an example, see **Compare scores**.

**Scripting in Performance Analytics**

Performance Analytics provides several script objects for use in scripts and APIs for querying Performance Analytics data. The scripts serve as breakdown mappings or to calculate a value from an indicator.

**Tip:**
- Scripts are best used only to support indicators like Age with date processing, using the `score_start` and `score_end` variables.
- Limit unnecessary fields. Every time you include an extra dot-walked field, you add an extra join to the query.
- Try to replace manual breakdowns with database views for better performance.
- Try to use script includes for common functions. For more information, see **Script includes**.
- If the data is not structured in a way you need for reporting, try adding 'reporting fields' to the operational tables instead of creating scripts. For more information, see this **Community post**.

**Important:** Try not to use GlideRecords or GlideAggregates in Performance Analytics scripts or formula indicators. While sometimes you must use these operations to get what you want, they are very expensive, potentially running hundreds of thousands of times. Be certain that no alternative exists before you use them.

A breakdown mapping script typically returns either a sys_id of a breakdown element or an integer to put the score in a bucket. Indicator scripts return a score calculated from one or more fields. The same script can serve both as a breakdown mapping script and as an indicator script. For example, consider the provided Incident.Age.Days script, which uses the `opened_at` field from the incident table. This script serves as a breakdown mapping for the Age breakdown, which uses the Incident Age Ranges (Days) bucket group as the breakdown source.

```javascript
var diff=function(x,y){return y.dateNumericValue() - x.dateNumericValue();};
var days=function(x,y){return diff(x,y)/(24*60*60*1000);};
days(current.opened_at, score_end);
```

In this example, `current.opened_at` gets the timestamp of when the currently evaluated record was opened. The `score_end` script variable comes from the data collector and is bound to the period being collected. For example, if a monthly indicator is being collected, the `score_end` is the end of the month. Here the timestamp of when the incident was opened is subtracted from the timestamp of the end of the collection period and the result is converted to days.

**Note:**
Create a script in Performance Analytics

To create a script, first select the facts table to which the script applies and explicitly select any fields.

Role required: admin, pa_admin

1. Navigate to Performance Analytics > Scripts and click New.
2. Give the script a descriptive Name.
3. Select the Facts table that the script applies to.
   Only indicators that use the same facts table can use this script.
4. Select the fact table Fields, if any, that will be used in the script.
   You select fields by their labels.
5. Write the script.
   The script must conform to the following relationships and restrictions:
   - You can include only the fields that are selected in this form and script variables. For more information, see the section about Performance Analytics variables.
   - When you use a field in the script, you use the column name. If necessary, look up the column name in the facts table.
   - When you use a field from a database view, you must include the prefix. For example, the incident_sla database view includes the task_sla table, with the prefix taskslatable. Task_sla includes the business_duration column. To use the business_duration field from the incident_sla database view, write it as taskslatable_business_duration. If you do not have access to the database view, ask your system administrator to find the prefix for you.

Performance Analytics variables

Several variables are available for use in Performance Analytics scripts and formula indicators.

You can use the following variables in Performance Analytics scripts and formulas.

- **score_start**: Date of the first indicator score collection, as defined by the frequency. For example, if you have an indicator with a daily frequency and you are calculating for today, score_start is yesterday. If you are calculating that indicator on the date for yesterday, score_start is two days ago.
- **score_end**: Date of the last indicator score collection, as defined by the frequency. For example, if you have an indicator with a daily frequency and you are calculating for today, score_end is today. If you are calculating that indicator on the date for yesterday, score_end is yesterday.
- **pa**: A formula variable, not usable in scripts, that provides a set of Analytics Hub-related attributes and methods.

In scripts, the score collection start and end variables are GlideElementGlideObject objects. You can obtain a GlideDateTime object from these variables by calling

```javascript
getGlideObject(), such as in this example: gs.log("Score main = " + score_end.getGlideObject().getDayOfWeek());
```

In formulas, the score collection start and end variables already are GlideDateTime objects. Therefore, you can use the variables directly without calling getGlideObject(), such as in this example:

```javascript
gs.log("Score main = " + score_end.getDayOfWeek());
```
The values of the start and end variables are bound to the period being collected. For example, if a monthly indicator is being collected, the `score_end` is the end of the month.

**PAScorecard**

The PAScorecard API enables you to fetch data about indicators and their associated records, such as breakdowns.

**PAScorecard - addParam(String parameter, String value)**

Add a query parameter to filter the returned scores.

Call this method multiple times on the same PAScorecard object to pass multiple parameters, such as the indicator sys_id and a breakdown sys_id. After specifying all parameters, call `query()` to run the query.

If you query a PAScorecard object with no parameters, the API returns a list of all indicators that are displayed on the Analytics Hub, with their scores.

### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| uuid             | String  | Enter a colon-separated list of sys_id values to specify which indicators, breakdowns, aggregates, and domains to query. The parameter follows this format: <indicator sys_id>:<breakdown sys_id>:<element sys_id>:<lvl-2 breakdown sys_id>:<lvl-2 element sys_id>:<aggregate sys_id>:<domain sys_id>

The parameter must begin with the sys_id of an indicator record. Optionally, you can append the sys_id values of a breakdown and breakdown element to group the response based on the breakdown, and the sys_id of an aggregate to apply that aggregate. You can use a breakdown with an aggregate, or use only one.

For information about obtaining the sys_id values of records, see [Unique record identifier (sys_id)].

**Note:** If an indicator is configured to use a Default time series, all Analytics Hubs for that indicator use the selected aggregate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>breakdown</td>
<td>String</td>
<td>Enter the sys_id of a breakdown to return chart information organized as defined by the breakdown. For example, enter the sys_id of a priority breakdown to return separate task chart information for each priority value, such as Number of open incidents / Priority / 2 - High.</td>
</tr>
<tr>
<td>breakdown_relation</td>
<td>String</td>
<td>Specify the sys_id of a breakdown relation to break down the returned data using that relation. You can view available breakdown relations by setting the <code>include_available_breakdowns</code> parameter to <code>true</code>.</td>
</tr>
<tr>
<td>elements_filter</td>
<td>String</td>
<td>Specify the sys_id of an elements filter to apply that filter to the returned data.</td>
</tr>
<tr>
<td>display</td>
<td>String</td>
<td>Set to <code>true</code> to return only indicators that are displayed on the Analytics Hub. Set this parameter to <code>all</code> to return all indicators. This parameter is <code>true</code> by default.</td>
</tr>
<tr>
<td>favorites</td>
<td>String</td>
<td>Set to <code>true</code> to return only indicators that are favorites of the querying user.</td>
</tr>
<tr>
<td>key</td>
<td>String</td>
<td>Set to <code>true</code> to return results only for key indicators.</td>
</tr>
<tr>
<td>Name</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>target</td>
<td>String</td>
<td>Set to <code>true</code> to return results only for indicators that have a target set on the Analytics Hub.</td>
</tr>
<tr>
<td>contains</td>
<td>String</td>
<td>Enter a comma-separated list of names or descriptions to return results only from indicators with a matching value.</td>
</tr>
<tr>
<td>tags</td>
<td>String</td>
<td>Enter an indicator group sys_id to return the indicators in that group. Do not use <code>uuid</code> with this parameter.</td>
</tr>
<tr>
<td>per_page</td>
<td>String</td>
<td>Enter the maximum number of indicators each query can return on a page. By default this value is 10, and the maximum is 100.</td>
</tr>
<tr>
<td>page</td>
<td>String</td>
<td>Specify the page number. For example, when querying 20 Analytics Hubs with the default per_page value (10), specify a page value of 2 to retrieve Analytics Hubs 11-20.</td>
</tr>
<tr>
<td>sortby</td>
<td>String</td>
<td>Specify the value to use when sorting results. Valid values for this parameter are value, change, changeperc, gap, gapperc, duedate, name, order, default, group, indicator_group, frequency, target, date, trend, bullet, and direction. By default, queries sort records by value.</td>
</tr>
<tr>
<td>sortdir</td>
<td>String</td>
<td>Specify the sort direction, ascending or descending. By default, queries sort records in descending order. Set this parameter to <code>asc</code> to sort in ascending order.</td>
</tr>
</tbody>
</table>
| display_value      | String | Data retrieval operation for reference and choice fields. Based on this value, the display value and/or the actual value in the database are retrieved.  
  - true returns display values for all of the fields.  
  - false returns actual values from the database. If a value is not specified, this parameter defaults to false.  
  - all returns both actual and display values. |
| exclude_reference_link | String | Set to `true` to hide additional information provided for reference fields, such as the URI to the reference resource. |
| include_scores     | String | Set to `true` to return indicator scores for the entire time range selected on the Analytics Hub. If a value is not specified, this parameter defaults to false and returns only the most recent score value.  
  To constrain the date range of the scores that are returned, combine this parameter with the `from` and `to` parameters. |
| from               | String | Specify the earliest date to return scores from. Only scores from this date or later are returned. The date format must match the ISO-8601 standard.  
  This parameter requires that `include_scores` is set to `true`. |
| to                 | String | Specify the latest date to return scores from. Only scores from this date or earlier are returned. The date format must match the ISO-8601 standard.  
  This parameter requires that `include_scores` is set to `true`. |
<p>| step               | String | Specify a numeric value to skip scores, based on the indicator frequency. For example, specify a value of 3 to return only scores from every third day for a daily indicator, or from every third week for a weekly indicator. |
| limit              | String | Specify the maximum number of scores to return. |</p>
<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>include_available_breakdowns</td>
<td>String</td>
<td>Set to true to return all available breakdowns for an indicator. If a value is not specified, this parameter defaults to false and returns no breakdowns.</td>
</tr>
<tr>
<td>include_available_aggregates</td>
<td>String</td>
<td>Set to true to return all possible aggregates for an indicator, including aggregates that have already been applied. If a value is not specified, this parameter defaults to false and returns no aggregates.</td>
</tr>
<tr>
<td>include_realtime</td>
<td>String</td>
<td>Set this parameter to true to return the realtime_enabled element which indicates if real-time scores are enabled for the indicator, and the realtime_value element which contains the real-time score value. This parameter is not supported for formula indicators.</td>
</tr>
<tr>
<td>include_target_color_scheme</td>
<td>String</td>
<td>Set this parameter to true to return the target_color_scheme element that contains the minimum and maximum values, and the color of each section of the target color scheme for the Analytics Hub.</td>
</tr>
<tr>
<td>include_forecast_scores</td>
<td>String</td>
<td>Set this parameter to true to return the forecast_scores element that contains an array of date-value pairs that define the forecast data for the Analytics Hub. This parameter requires that the include_scores parameter is also set to true.</td>
</tr>
<tr>
<td>include_trendline_scores</td>
<td>String</td>
<td>Set this parameter to true to return the trendline_scores element that contains an array of date-value pairs that define the Analytics Hub trendline. This parameter requires that the include_scores parameter is also set to true.</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

In this example, the uuid parameter specifies the Number of open incidents indicator, and the breakdown parameter specifies the Priority breakdown. Both parameters have the sys_id of the respective records as their values. The query() function returns the results as an object.

```javascript
var sc = new SNC.PAScorecard(); // in a scoped app, do not use the SNC namespace
sc.addParam('uuid', 'fb007202d7130100b96d45a3ce6103b4'); // Number of open incidents
sc.addParam('breakdown', '0df47e02d7130100b96d45a3ce610399'); // by Priority
var result = sc.query(); // Query results, which are returned as an object
for (var i = 0; i < result.length; i++)
gs.info(result[i].name + ': ' + result[i].value + ' ' + result[i].unit.display_value);
```

PAScorecard - query()
Perform a query based on the specified parameters and return the results as an object.
Before calling this method, configure parameters for the PAScorecard object by calling addParam(String parameter, String value).

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The PAScorecard object.</td>
</tr>
</tbody>
</table>

**PAScorecard - result()**

Get the last query result as an object.

This method does not perform a query. To perform a query before returning the result, use query().

This function cannot run in a scope other than global.

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object</td>
<td>The results from the last query, returned as a JS object.</td>
</tr>
</tbody>
</table>

**PASnapshot**

The PASnapshot API enables you to query information about Performance Analytics snapshots. Snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with Collect records selected.

You can query information about a snapshot at a certain date using the indicator sys_id and date, and perform comparisons between snapshots for an indicator at different dates.

**PASnapshot - getIDs(String sys_id, Number date)**

Get the sys_id values for all records contained in the snapshot for a specified indicator at the specified date.

<table>
<thead>
<tr>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
</tr>
<tr>
<td>sys_id</td>
</tr>
<tr>
<td>date</td>
</tr>
</tbody>
</table>
Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>String</td>
<td>A comma-separated list of sys_id values.</td>
</tr>
</tbody>
</table>

```javascript
var snapshot1 = PASnapshot.getIDs('fb007202d7130100b96d45a3ce6103b4', 20160530);
gs.info(snapshot1);
```

Output: *** Script:
09c01200d7002100b81145a3ce6103ab,19c01200d7002100b81145a3ce6103e9,fcc01200d7002100b81145a3

```javascript
PASnapshot - getCompareIDs(String sys_id, Number date1, Number date2, String type)
```

Compare records in snapshots for a specified indicator at multiple dates, such as to identify records included in one snapshot but not the other.

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sys_id</td>
<td>String</td>
<td>The indicator sys_id.</td>
</tr>
<tr>
<td>date1</td>
<td>Number</td>
<td>The date of the first snapshot, in the format yyyymmd.</td>
</tr>
<tr>
<td>date2</td>
<td>Number</td>
<td>The date of the second snapshot, in the format yyyymmd.</td>
</tr>
<tr>
<td>type</td>
<td>String</td>
<td>Specifies what data to retrieve. Valid values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• all1: all records in the first snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• all2: all records in the second snapshot</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• shared: records that are in both snapshots</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• movedin: records that are in the second snapshot, but not the first</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• movedout: records that are in the first snapshot, but not the second</td>
</tr>
</tbody>
</table>
ServiceNow

Madrid

Analytics, Intelligence, and Reporting

Returns

Type

Description

String

A comma-separated list of sys_id values.

var snapshot2 =
PASnapshot.getCompareIDs('fb007202d7130100b96d45a3ce6103b4',
20160430, 20160531, 'shared');
gs.info(snapshot2);

Output: *** Script:
09c01200d7002100b81145a3ce6103ab,19c01200d7002100b81145a3ce6103e9,fcc01200d7002100b81145a3
….
PASnapshot - getQuery(String sys_id, Number date)
Get the query used to generate the snapshot for a specified indicator at the specified date.
Parameters

Name

Type

Description

sys_id

String

The indicator sys_id.

date

Number

The date when the snapshot
was taken, in the format
yyyymmdd.

Returns

Type

Description

String

The table, view, and encoded query as a JSON
string.

var snapshot3 =
PASnapshot.getQuery('fb007202d7130100b96d45a3ce6103b4',
20160530);
gs.info(snapshot3);
Output: *** Script: {"view":"","query":"sys_idINjavascript:new
PAUtils().getSnapshotIDs(\"fb007202d7130100b96d45a3ce6103b4\",
\"20160530\")","table":"incident"}
PASnapshot - getCompareQuery(String sys_id, Number date1, Number date2, String type)
Get the query used to compare records in snapshots for a specified indicator at multiple dates.
Parameters

Name

Type

Description

sys_id

String

The indicator sys_id.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States
and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

336


ServiceNow

Madrid

Analytics, Intelligence, and Reporting

Name

Type

Description

date1

Number

The date of the first snapshot, in
the format yyyymmdd.

date2

Number

The date of the second
snapshot, in the format
yyyymmdd.

type

String

Specifies what data to retrieve.
Valid values are:
• all1: all records in the first
snapshot
• all2: all records in the second
snapshot
• shared: records that are in
both snapshots
• movedin: records that are in
the second snapshot, but not
the first
• movedout: records that are
in the first snapshot, but not
the second

Returns

Type

Description

String

The table, view, and encoded query as a JSON
string.

var snapshot4 =
PASnapshot.getCompareQuery('fb007202d7130100b96d45a3ce6103b4',
20160530, 20160531, 'all1');
gs.info(snapshot4);
Output: *** Script: {"view":"","query":"sys_idINjavascript:new
PAUtils().getCompareSnapshotIDs(\"fb007202d7130100b96d45a3ce6103b4\",
\"20160530\",\"20160531\",\"all1\")","table":"incident"}

Performance Analytics properties
These system properties control the behavior of Performance Analytics.
To configure properties, navigate to Performance Analytics > System > Properties or to
sys_properties.list.

Collection cleanup properties
Several properties determine how long Performance Analytics scores and snapshots are
maintained before the scheduled cleanup job deletes them.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States
and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

337


<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.pa.dc.keep_scores_for.frequency | Maximum number of periods prior to today for which scores are collected and kept. The number of periods varies according to the score collection frequency, as follows: daily; weekly; bi-weekly; four weeks; monthly; bi-monthly; quarterly; fiscal quarterly; half-yearly; yearly; fiscal yearly. Scores older than this limit are not collected during data collection. | Type: String  
Default value: 732;105;53;40;60;30;20;20;20;10;10  
Location: Performance Analytics > System > Properties |
| com.snc.pa.dc.keep_snapshots_for.frequency | Maximum number of periods prior to today for which lists of records (snapshots) related to a score are collected and kept. The number of periods varies according to the score collection frequency, as follows: daily; weekly; bi-weekly; four weeks; monthly; bi-monthly; quarterly; fiscal quarterly; half-yearly; yearly; fiscal yearly. Snapshots older than this limit are not collected during data collection. | Type: String  
Default value: 183;26;13;10;15;8;5;5;5;3;3  
Location: Performance Analytics > System > Properties |

**Fiscal year properties**

These properties set the year in Performance Analytics to match your company fiscal year.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.fy_start</td>
<td>Start of the fiscal year of your company</td>
</tr>
</tbody>
</table>

**Default color schemes**

These properties set the default colors for the chart overall and for indicator targets.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.indicator_target_default_color_schema</td>
<td>Default indicator target color scheme</td>
</tr>
<tr>
<td>com.snc.pa.chart_default_color_schema</td>
<td>Default visualization color scheme</td>
</tr>
</tbody>
</table>
Breakdown and visualization properties

Most of these properties relate to breakdowns and how breakdowns are displayed in visualizations.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.scoresheet.max_elements</td>
<td>Maximum number of elements of a breakdown that can be shown in a scoresheet</td>
</tr>
</tbody>
</table>
| com.snc.pa_breakdown_element_cutoff                | Maximum number of elements that a breakdown can have for the elements without scores to be shown in an Analytics Hub. If the value of this parameter is exceeded, no scoreless elements are shown in the Analytics Hub. Example: The value of the parameter is 10. Breakdown A has 8 elements. All 8 are shown in the Analytics Hub. Breakdown B has 12 elements, of which 5 have scores. Only those 5 elements are shown. Notes:  
  • This parameter does not affect whether unmatched elements are shown.  
  • Both historical and real-time/live scores are counted when considering whether an element has a score.  
  • If the element involves a formula with multiple scores, the element is considered to have a score if all parts of the formula have scores at any point in time. The formula is considered to have a score even if the result is invalid, such as a division by 0. |
| com.snc.pa.scorecards.max_breakdown_elements       | Maximum number of breakdown elements in Analytics Hub lists                                     |
| com.snc.pa.scorecard.breakdown.chart.max_rows       | Number of breakdown elements in visualizations                                                  |
| com.snc.pa.thresholds.frequency_intervals_in_the_pa | Maximum number of frequency intervals in the past that a threshold check job will analyze       |
| com.snc.pa.scorecard.max_record_number             | Number of records to be loaded automatically on the records tab of a detailed Analytics Hub. If the number of records exceeds the value of this property, records are not automatically loaded. In this case, the user is presented with a message and a button to load all records. |
| com.snc.pa.breakdown_element_ui_max_records        | Deprecated in new Analytics Hub. Limit for the number of elements to be fetched for a breakdown. Default 100. Used for the lookup fields (breakdown dashboard, old detailed scorecard, etc.) |
| com.snc.pa.widget.max_widget_indicators            | Maximum number of widget indicators, in addition to the main indicator, that can be added to a widget |
# Chart properties

A chart refers here to a graphical component of a widget visualization or the Analytics Hub.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.default_chart_line_color</td>
<td>Color of the scores in the Analytics Hub and widgets, including the trend line and bullet chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 106,183,239,1</td>
</tr>
<tr>
<td>com.snc.pa.text.trendline_points_for.frequency</td>
<td>Maximum number of points visible in the text analytics trend-line</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_target_color</td>
<td>Color of the target in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: Hexadecimal</td>
</tr>
<tr>
<td></td>
<td>• Default: #666666</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_personal_target_color</td>
<td>The line color for personal targets displayed on Analytics Hubs.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: #BDC0C4</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_threshold_color</td>
<td>Color of the threshold in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: Hexadecimal</td>
</tr>
<tr>
<td></td>
<td>• Default: #666666</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_personal_threshold_color</td>
<td>The line color for personal thresholds displayed on the Analytics Hub.</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Default value: #BDC0C4</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_area_color0</td>
<td>Color of first gradient area in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 106,183,239,1</td>
</tr>
<tr>
<td>com.snc.pa.default_chart_area_color1</td>
<td>Color of second gradient area in a chart.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 106,183,239,0</td>
</tr>
<tr>
<td>com.snc.pa.navigator_line_color</td>
<td>Color of the Line in the chart navigator.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 106,183,239,1</td>
</tr>
<tr>
<td>com.snc.pa.navigator_area_color0</td>
<td>Color of first gradient area in the chart navigator.</td>
</tr>
<tr>
<td></td>
<td>• Format: RGBA</td>
</tr>
<tr>
<td></td>
<td>• Default: 204,204,204,0.25</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| com.snc.pa.navigator_area_color1 | Color of second gradient area in the chart navigator.  
  - **Format**: RGBA.  
  - **Default**: 204,204,204,0.5 |
| com.snc.pa.navigator_mask_fill_color | Deprecated in new Analytics Hub. Mask fill color of the chart navigator.  
  - **Format**: RGBA.  
  - **Default**: 106,183,239,0.25 |
| com.snc.pa.spark_line_width | Pixel width of the chart line. Used only on the workbench widget.  
  - **Default**: 1 |
| com.snc.pa.scorecard.breakdown.chart.name_max_length | Maximum number of element names on the legend in a breakdown widget.  
  - **Default**: 27 |

**Data collector properties**

Data collector properties enable you to configure various limits for Performance Analytics data collection. The properties are configured to safeguard the data collection process. The default values are appropriate for most environments.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| com.snc.pa.dc.script_timeout | The maximum time in seconds that a script is allowed to run during a data collection cycle, such as an indicator source script or a breakdown script.  
  This limit applies individually for each record processed by the data collection job. If a script exceeds this limit, the data collection job skips the current record.  
  If your scripts frequently reach the default limit, simplify the scripts as much as possible before modifying this property.  
  - **Type**: integer  
  - **Default value**: 30 |
| com.snc.pa.dc.query_time_limit | The maximum duration in minutes that a single query for a data collection job can run before a warning is logged.  
  - **Type**: integer  
  - **Default value**: 60 |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.dc.max_row_count_indicator_source</td>
<td>The maximum number of records that a job can collect from a single indicator source.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning:</strong> If the number of records that an indicator source contains is higher than the value of this property, no indicators are collected for this indicator source.</td>
</tr>
<tr>
<td></td>
<td>Increasing this value may cause data collection jobs to take longer to complete.</td>
</tr>
<tr>
<td></td>
<td>This limit applies separately to each indicator source included in a data collection job. The number of indicators associated with each indicator source does not affect this limit.</td>
</tr>
<tr>
<td></td>
<td>For example, if a data collection job collects scores for 12 indicators from three indicator sources, the job can collect a maximum of 150,000 records by default: 50,000 from each indicator source.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> 50,000</td>
</tr>
<tr>
<td>com.snc.pa.dc.max_breakdown_elements_limit</td>
<td>Maximum number of breakdown elements retrieved by data collection for each breakdown source. If a breakdown source has more elements than this property defines, it is disabled.</td>
</tr>
<tr>
<td></td>
<td>Increasing this limit increases the potential number of table insertions that are made for a data collection job. This increase may impact performance, depending on your database. Also, it may be difficult for users to access data for a specific breakdown element when there are many elements.</td>
</tr>
<tr>
<td></td>
<td>This limit applies separately to each breakdown source included in a data collection job. The number of breakdowns associated with each breakdown source does not affect this limit.</td>
</tr>
<tr>
<td></td>
<td>For example, if a data collection job collects scores for 12 breakdowns from three breakdown sources, the job can collect a maximum of 30,000 records by default: 10,000 from each breakdown source.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Type:</strong> integer</td>
</tr>
<tr>
<td></td>
<td>- <strong>Default value:</strong> 10,000</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>com.snc.pa.dc.max_breakdown_elements_level2</td>
<td>Maximum number of breakdown elements resulting from the combination of two breakdowns for a data collection. For example, if the first-level breakdown has 10 elements, and the second-level breakdown has 5, 50 breakdown elements are collected. Increasing this limit can cause data collection to use a large amount of memory which may impact performance. Consider a first-level breakdown with the maximum of 10,000 elements. In this scenario, the second-level breakdown can specify at most 100 breakdown elements before reaching the default second-level limit of 1,000,000 total elements. Note: This limit is also affected by the com.snc.pa.dc.max_breakdown_elements_limit property. For example, if the first-level breakdown has greater than 10,000 elements, the breakdown is disabled.</td>
</tr>
<tr>
<td>Type: integer</td>
<td>Default value: 1,000,000</td>
</tr>
<tr>
<td>com.snc.pa.dc.max_error_count</td>
<td>The maximum number errors that may occur for a single data collection job run before data collection is stopped. Errors during data collection usually occur due to an invalid script, or when encountering the script timeout limit. Do not increase this value. If you encounter this limit, review any scripts that run during data collection to ensure that they are valid and perform as expected.</td>
</tr>
<tr>
<td>Type: integer</td>
<td>Default value: 500</td>
</tr>
</tbody>
</table>
Integrate Performance Analytics

Integrate Performance Analytics with an external system to collect scores based on remote data or to expose Analytics Hub information.

Performance Analytics API

The Performance Analytics REST API enables you to query data about Performance Analytics Analytics Hubs.

The Performance Analytics API supports only the GET action. Performance Analytics queries never update records.

Performance Analytics API - GET /now/pa/scorecards

This method retrieves details about indicators from the Analytics Hub.

URL format

Versioned URL: /api/now/v1/pa/scorecards
Default URL: /api/now/pa/scorecards

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.snc.pa.dc.max_records</td>
<td>Maximum number of sys IDs that are stored on a single Snapshot (pa_snapshots) record. A Snapshot record is created for each collected score, and a field in this record contains all the sys IDs from the indicator that contribute to the score. If this limit is exceeded, a Snapshot record is not created for this score. This limit applies only when Collect records is selected for an indicator. For example, say you are using the default limit of 5,000 and you run a job that collects a score referring to 4,500 sys IDs. The system creates a Snapshot record with a comma-separated list of the 4,500 sys IDs in the sys ID field. If the same job also collects a score of 5,001, the system does not create a Snapshot record corresponding to that score. Generally, the default limit provides enough detail into collected records. Increasing this limit may impact performance during data collection or when performing operations on the Snapshots table.</td>
</tr>
<tr>
<td></td>
<td>Type: integer</td>
</tr>
<tr>
<td></td>
<td>Default value: 5000</td>
</tr>
</tbody>
</table>
## Supported parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_uuid</td>
<td>Enter a colon-separated list of sys_id values to specify which indicators, breakdowns, aggregates, and domains to query. The parameter follows this format: ( &lt;\text{indicator sys_id}&gt;:&lt;\text{breakdown sys_id}&gt;:&lt;\text{element sys_id}&gt;:&lt;\text{lvl-2 breakdown sys_id}&gt;:&lt;\text{lvl-2 element sys_id}&gt;:&lt;\text{aggregate sys_id}&gt;:&lt;\text{domain sys_id}&gt; ) The parameter must begin with the sys_id of an indicator record. Optionally, you can append the sys_id values of a breakdown and breakdown element to group the response based on the breakdown, and the sys_id of an aggregate to apply that aggregate. You can use a breakdown with an aggregate, or use only one. <strong>Note:</strong> If an indicator is configured to use a Default time series, all values that this API retrieves for that indicator use the selected aggregate. For examples of fully-constructed sysparm_uuid values, see <a href="https://%3Cinstance_name%3E.nowlive.com/developer/docs/rest_api/analytics">Performance Analytics REST API examples</a>.</td>
</tr>
<tr>
<td>sysparm_breakdown</td>
<td>Enter the sys_id of a breakdown to return chart information organized as defined by the breakdown. For example, enter the sys_id of a priority breakdown to return separate task chart information for each priority value, such as Number of open incidents / Priority / 2 - High.</td>
</tr>
<tr>
<td>sysparm_include_scores</td>
<td>Set to true to return indicator scores for the entire time range selected on the Analytics Hub. If a value is not specified, this parameter defaults to false and returns only the most recent score value. To constrain the date range of the scores that are returned, combine this parameter with sysparm_from and sysparm_to.</td>
</tr>
<tr>
<td>sysparm_include_aggregates</td>
<td>Set to true to return all possible aggregates for an indicator, including aggregates that have already been applied. If a value is not specified, this parameter defaults to false and returns no aggregates.</td>
</tr>
<tr>
<td>sysparm_include_available_breakdowns</td>
<td>Set to true to return all available breakdowns for an indicator. If a value is not specified, this parameter defaults to false and returns no breakdowns.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sysparm_include_available_aggregates</td>
<td>Set to <code>true</code> to return all available aggregates for an indicator when no aggregate has been applied. If a value is not specified, this parameter defaults to <code>false</code> and returns no aggregates.</td>
</tr>
</tbody>
</table>
| sysparm_display_value            | Data retrieval operation for reference and choice fields. Based on this value, retrieves the display value and/or the actual value from the database. Valid values:  
  - `true`: returns the display values for all fields.  
  - `false`: returns the actual values from the database.  
  - `all`: returns both actual and display values.  
  Default: `false`                                                                                                                |

**Note:** There is no preferred method for setting this parameter. However, specifying the display value may cause performance issues since it is not reading directly from the database and may include referencing other fields and records. For more information on display values and actual values, see Table API FAQs (KB0534905).

<table>
<thead>
<tr>
<th>sysparm_exclude_reference_link</th>
<th>Set to <code>true</code> to hide additional information provided for reference fields, such as the URI to the reference resource.</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_favorites</td>
<td>Set to <code>true</code> to return only indicators that are favorites of the querying user.</td>
</tr>
<tr>
<td>sysparm_key</td>
<td>Set to <code>true</code> to return results only for key indicators.</td>
</tr>
<tr>
<td>sysparm_target</td>
<td>Set to <code>true</code> to return results only for indicators that have a target set on the Analytics Hub.</td>
</tr>
<tr>
<td>sysparm_display</td>
<td>Set to <code>true</code> to return only indicators that are displayed on the Analytics Hub. Set this parameter to <code>all</code> to return all indicators. This parameter is <code>true</code> by default.</td>
</tr>
<tr>
<td>sysparm_contains</td>
<td>Enter a comma-separated list of names or descriptions to return results only from indicators with a matching value.</td>
</tr>
<tr>
<td>sysparm_tags</td>
<td>Enter an indicator group sys_id to return the indicators in that group. Do not use <code>sysparm_uuid</code> with this parameter. You cannot obtain the sys_id of an indicator group through this API. Instead, get the sys_id from the indicator group record. For more information about obtaining sys_ids from records, see Unique record identifier (sys_id)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sysparm_per_page</td>
<td>Enter the maximum number of indicators each query can return on a page. By default this value is 10, and the maximum is 100.</td>
</tr>
<tr>
<td>sysparm_page</td>
<td>Specify the page number. For example, when querying 20 indicators with the default sysparm_per_page value (10), specify a sysparm_page value of 2 to retrieve indicators 1-20.</td>
</tr>
<tr>
<td>sysparm_sortby</td>
<td>Specify the value to use when sorting results. Valid values for this parameter are value, change, changeperc, gap, gapperc, duedate, name, order, default, group, indicator_group, frequency, target, date, trend, bullet, and direction. By default, queries sort records by value.</td>
</tr>
<tr>
<td>sysparm_sortdir</td>
<td>Specify the sort direction, ascending or descending. By default, queries sort records in descending order. Set this parameter to asc to sort in ascending order.</td>
</tr>
<tr>
<td>sysparm_from</td>
<td>Specify the earliest date to return scores from. Only scores from this date or later are returned. The date format must match the ISO-8601 standard.</td>
</tr>
<tr>
<td></td>
<td>This parameter requires that sysparm_include_scores is set to true.</td>
</tr>
<tr>
<td>sysparm_to</td>
<td>Specify the latest date to return scores from. Only scores from this date or earlier are returned. The date format must match the ISO-8601 standard.</td>
</tr>
<tr>
<td></td>
<td>This parameter requires that sysparm_include_scores is set to true.</td>
</tr>
<tr>
<td>sysparm_step</td>
<td>Specify a numeric value to skip scores, based on the indicator frequency. For example, specify a value of 3 to return only scores from every third day for a daily indicator, or from every third week for a weekly indicator.</td>
</tr>
<tr>
<td>sysparm_limit</td>
<td>Specify the maximum number of scores to return.</td>
</tr>
<tr>
<td>sysparm_elements_filter</td>
<td>Specify the sys_id of an elements filter to apply that filter to the returned data.</td>
</tr>
<tr>
<td></td>
<td>You cannot obtain the sys_id of an indicator group through this API. Instead, get the sys_id from the indicator group record. For more information about obtaining sys_ids from records, see Unique record identifier (sys_id).</td>
</tr>
<tr>
<td>sysparm_breakdown_relation</td>
<td>Specify the sys_id of a breakdown relation to break down the returned data using that relation.</td>
</tr>
<tr>
<td>sysparm_include_score_notes</td>
<td>Set this parameter to true to return all notes associated with the score. The note element contains the note text as well as the author and timestamp when the note was added.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sysparm_include_realtime</td>
<td>Set this parameter to <code>true</code> to return the <code>realtime_enabled</code> element which indicates if real-time scores are enabled for the indicator, and the <code>realtime_value</code> element which contains the real-time score value. This parameter is not supported for formula indicators.</td>
</tr>
<tr>
<td>sysparm_include_target_color_scheme</td>
<td>Set this parameter to <code>true</code> to return the <code>target_color_scheme</code> element that contains the minimum and maximum values, and the color of each section of the target color scheme for the Analytics Hub.</td>
</tr>
</tbody>
</table>
| sysparm_include_forecast_scores   | Set this parameter to `true` to return the `forecast_scores` element that contains an array of date-value pairs that define the forecast data for the Analytics Hub.  
This parameter requires that the `sysparm_include_scores` parameter is also set to `true`. |
| sysparm_include_trendline_scores  | Set this parameter to `true` to return the `trendline_scores` element that contains an array of date-value pairs that define the Analytics Hub trendline.  
This parameter requires that the `sysparm_include_scores` parameter is also set to `true`. |

**Headers**

**Request headers**

<table>
<thead>
<tr>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**Status codes**

<table>
<thead>
<tr>
<th>Status code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>Indicates that the query ran successfully.</td>
</tr>
</tbody>
</table>

**Security**

Access to tables via the REST API is restricted by BasicAuth. ACLs defined for tables are enforced to restrict access to data.

To make queries using the Performance Analytics API, you must also have the `pa_viewer` role.
Return an indicator filtered by a breakdown and element

```bash
# The GET request gets the details for
# the indicator Number of open incidents, where the Priority of the
# incident is 1 - Critical. The sys_id values for the indicator, the
# Priority breakdown, and the 1 - Critical element are all passed in
# the sysparm_uuid parameter.

curl --verbose -user "user:password" \
   --header "Accept:application/json" \
   "https://instance.service-now.com/api/now/v1/pa/scorecards?
   sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:e5900140200331007665978299a805f3"

{
   // The request is made Dec 12. The
   // score is 76, which is unchanged from
   // Dec 11, and which exceeds the
   // target of 70.
   "result": [ 
      {
         "indicator": {
            "display_value": "Number of open incidents",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
            "value": "fb007202d7130100b96d45a3ce6103b4"
         },
         "gap_formated": "-6",
         "benchmarking": false,
         "frequency_label": "Daily",
         "changeperc_formated": "0.0%",
         "direction_label": "Minimize",
         "precision": 0,
         "breakdown": {
            "display_value": "Priority",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399",
            "value": "0df47e02d7130100b96d45a3ce610399"
         },
         "personal_target": null,
         "description": "Number of incidents open based on resolved date is empty.",
         "value_color": "#ff8c00",
         "uuid": "fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003ee8f93baf9619bd",
         "frequency": 10,
         "gap": -6.0,
         "value_unit": "76",
         "indicator_frequency": 10,
         "value": 76.0,
         "indicator_aggregate": 1,
         "facts_table": {
            "name": "incident",
            "label": "Incidents"
         },
         "key": false,
         "indicator_frequency_label": "Daily",
         "direction": 2,
         "element": {
            "display_value": "1 - Critical",
```
Sample Python request

```python
import requests
url = "https://instance.service-now.com/api/now/v1/pa/scorecards"
user = 'user'
pwd = 'password'
querystring = {
    "sysparm_uuid": "fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce61039a:5f012106db5123003ee8f93baf9619bd"
}
headers = {
    "Content-Type": "application/json", 
    "Accept": "application/xml"
}
response = requests.get(url, auth=(user,pwd), headers=headers, params=querystring)
if response.status_code != 200:
    print('Status:', response.status_code, 'Headers:', response.headers, 'Error Response:',response.json())
    exit()
data = response.json()
print(data)
```
<response>
  <result>
    <indicator>
      <display_value>Number of open incidents</display_value>
      <link>https://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4</link>
      <value>fb007202d7130100b96d45a3ce6103b4</value>
      <gap>-6</gap>
      <benchmarking>false</benchmarking>
      <frequency_label>Daily</frequency_label>
      <changeperc_formatted>0.0%</changeperc_formatted>
      <direction_label>Minimize</direction_label>
      <precision>0</precision>
      <breakdown>
        <display_value>Priority</display_value>
        <link>https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399</link>
        <value>0df47e02d7130100b96d45a3ce610399</value>
        <key>false</key>
        <indicator_frequency>Daily</indicator_frequency>
        <direction>2</direction>
        <element>
          <display_value>1 - Critical</display_value>
          <link>https://instance.service-now.com/api/now/v1/table/sys_choice/5f012106db5123003ee8f93baf9619bd</link>
          <value>5f012106db5123003ee8f93baf9619bd</value>
        </element>
        <period_title>Dec 13</period_title>
        <period>Dec 13</period>
        <target_formatted>70</target_formatted>
        <change>0.0</change>
        <gapperc_formatted>-8.6%</gapperc_formatted>
      </breakdown>
    </indicator>
  </result>
</response>

<query>opened_atONToday@javascript:gs.beginningOfToday()@javascript:gs.endOfToday()^ORopened_at&lt;javascript:gs.beginningOfToday()^resolved_atISEMPTY^ORresolved_at&gt;javascript:gs.endOfToday()^state!=8^priority=1^EQ</query>
Performance Analytics API examples

These examples demonstrate how to perform a REST query using cURL commands, and show the data returned for each command. Each example builds upon the last, with later examples using the data returned by earlier examples.

Return all indicators that are displayed in the Analytics Hub

You can request a list of all indicators that are displayed in the Analytics Hub, including their unique record identifiers.

Note: These examples use the Mac syntax for curl commands. The Windows syntax can differ.

Command:

curl -v -u "user:password" -H "Accept:application/json" "https://instance.service-now.com/api/now/v1/pa/scorecards"

The following response is truncated to show only the Number of open incidents indicator, which is used in the other examples on this page:

```json
{
   "result" : [
   ...
   {
      "change_formatted" : ",",
      "key" : false,
      "value_unit" : ",",
      "value_formatted" : ",",
      "period_title" : null,
      "gapperc" : null,
      "gap" : null,
      "target" : null,
      "period" : null,
      "targetFormattedMessage" : ",",
      "favorite" : false,
      "direction_label" : "Minimize",
      "uuid" : 
"fb007202d7130100b96d45a3ce6103b4",
      "name" : "Number of open incidents",
      "value_color" : 
"#000000",
      "frequency_label" : "Daily",
      "change" : null,
      "gapFormattedMessage" : ",",
      "gappercFormattedMessage" : ",",
```
Return indicator details

You can query the Analytics Hub for a particular indicator by providing the `sysparm_uuid` parameter with an indicator sys_id value. In this case, you use the sys ID for the Number of open incidents indicator, which you retrieved in the first example, when you got all the indicators in the Analytics Hub:

```
"uuid" : "fb007202d7130100b96d45a3ce6103b4",
"name" : "Number of open incidents",
```

Command:

```
curl -v -u "user:password" -H "Accept:application/json"
   "https://instance.service-now.com/api/now/v1/pa/scorecards?
   sysparm_uuid=fb007202d7130100b96d45a3ce6103b4"
```

Response:

```
{  
  "result" : [  
    {  
      "change_formatted" : ",",
      "key" : false,
      "value_unit" : ",",
      "value_formatted" : ",",
      "period_title" : null,
      "gapperc" : null,
      "gap" : null,
      "target" : null,
      "period" : null,
      "target_formatted" : ",",
      "favorite" : false,
      "direction_label" : "Minimize",
      "uuid" : "fb007202d7130100b96d45a3ce6103b4",
    }
  ]
}
```
Return all breakdowns and aggregates for an indicator

You can query a list of available breakdowns and aggregates for an indicator by setting the `sysparm_include_available_breakdowns` and `sysparm_include_available_aggregates` parameters to true.

Command:

```bash
curl -v -u "user:password" -H "Accept:application/json" "https://instance.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_include_available_breakdowns=true&sysparm_include_available_aggregates=true"
```

Response:

```
{
  "result" : [
    {
      "key" : false,
      "change_formatted" : "",
      "aggregates" : [
        {
          "display_value" : "7d running SUM",
          "link" : "https://instance.service-now.com/api/now/v1/table/pa_aggregates/89ea4c11d7001100ba986f14ce6103dc",
          "value" : "89ea4c11d7001100ba986f14ce6103dc"
        },
        {
          "display_value" : "28d running SUM",
          "link" : "https://instance.service-now.com/api/now/v1/table/pa_aggregates/4dfa4c11d7001100ba986f14ce6103e2",
          "value" : "4dfa4c11d7001100ba986f14ce6103e2"
        }
      ]
    },
    {
      "key" : false,
      "change_formatted" : "",
      "aggregates" : [
        {
          "display_value" : "7d running SUM",
          "link" : "https://instance.service-now.com/api/now/v1/table/pa_aggregates/89ea4c11d7001100ba986f14ce6103dc",
          "value" : "89ea4c11d7001100ba986f14ce6103dc"
        },
        {
          "display_value" : "28d running SUM",
          "link" : "https://instance.service-now.com/api/now/v1/table/pa_aggregates/4dfa4c11d7001100ba986f14ce6103e2",
          "value" : "4dfa4c11d7001100ba986f14ce6103e2"
        }
      ]
    }
  ]
}
```
<table>
<thead>
<tr>
<th><strong>display_value</strong></th>
<th><strong>link</strong></th>
<th><strong>value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;30d running SUM&quot;</td>
<td>&quot;<a href="https://instance.service-now.com/api/now/v1/table/pa_aggregates/3e409011d7001100ba986f14ce610319">https://instance.service-now.com/api/now/v1/table/pa_aggregates/3e409011d7001100ba986f14ce610319</a>&quot;</td>
<td>&quot;3e409011d7001100ba986f14ce610319&quot;</td>
</tr>
</tbody>
</table>

Aggregates truncated for brevity

<table>
<thead>
<tr>
<th><strong>display_value</strong></th>
<th><strong>link</strong></th>
<th><strong>value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Priority&quot;</td>
<td>&quot;<a href="https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399">https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399</a>&quot;</td>
<td>&quot;0df47e02d7130100b96d45a3ce610399&quot;</td>
</tr>
<tr>
<td>&quot;Category&quot;</td>
<td>&quot;<a href="https://instance.service-now.com/api/now/v1/table/pa_breakdowns/1f918835d7231100b96d45a3ce6103fe">https://instance.service-now.com/api/now/v1/table/pa_breakdowns/1f918835d7231100b96d45a3ce6103fe</a>&quot;</td>
<td>&quot;1f918835d7231100b96d45a3ce6103fe&quot;</td>
</tr>
<tr>
<td>&quot;Assignment Group&quot;</td>
<td>&quot;<a href="https://instance.service-now.com/api/now/v1/table/pa_breakdowns/baec0752bf130100b96dac808c0739ed">https://instance.service-now.com/api/now/v1/table/pa_breakdowns/baec0752bf130100b96dac808c0739ed</a>&quot;</td>
<td>&quot;baec0752bf130100b96dac808c0739ed&quot;</td>
</tr>
</tbody>
</table>

Information for State and Age indicators truncated

<table>
<thead>
<tr>
<th><strong>display_value</strong></th>
<th><strong>link</strong></th>
<th><strong>value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number of open incidents&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Return a time series aggregation of indicator scores

You can apply the 7d running SUM aggregate to the Analytics Hub using the `sysparm_uuid` value with the `sys_id` of the aggregate.

Command:

```
curl -v -u "user:password" -H "Accept:application/json" https://instance.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:89ea4c11d7001100ba986f14ce6103dc
```  

Response:

```json
{
  "result": [
    {
      "key": false,
      "change_formatted": "",
      "value_unit": "",
      "value_formatted": "",
      "period_title": null,
      "aggregate": {
        "display_value": "7d running SUM",
        "link": "https://instance.service-now.com/api/now/v1/table/pa_aggregates/89ea4c11d7001100ba986f14ce6103dc",
        "value": "89ea4c11d7001100ba986f14ce6103dc"
      },
      "gapperc": null,
      "target": null,
      "period": null,
      "target_formatted": "",
      "favorite": false,
      "gap": null,
      "direction_label": "Minimize",
      "uuid": "fb007202d7130100b96d45a3ce6103b4:89ea4c11d7001100ba986f14ce6103dc",
      "name": "Number of open incidents / 7d running SUM",
      "value_color": "#000000",
      "frequency_label": "Daily",
      "change": null,
      "gap_formatted": "",
      "gapperc_formatted": "",
      "value": null,
      "unit": {
        "display_value": "#",
        "link": "https://instance.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad",
        "value": "17b365e2d7320100ba986f14ce6103ad"
      },
      "changeperc_formatted": "",
      "direction": 2,
    }
  ]
}
```
Return the elements for a breakdown

To get the scores associated with each element of a breakdown, and to get the sys_ids of those elements, use the sysparm_breakdown parameter with the sys_id of the breakdown. In this example, you get the elements of the Assignment Group breakdown for the Number of open incidents indicator. From previous example, you have the sys_id of fb007202d7130100b96d45a3ce6103b4 for the Number of open incidents indicator and the sys_id of baec0752bf130100b96dac808c0739ed for the Assignment Group breakdown.

Command:

```
curl -v -u "user:password" -H "Accept:application/json" "https://<instance>.service-now.com/api/now/v1/pa/scorecards?sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_breakdown=baec0752bf130100b96dac808c0739ed"
```

The response consists of a set of indicator objects, each containing one element object. The element objects each contain the name and sys_id of an object. Because the information about the indicator is the same for each indicator object, in this example only the first indicator object is given in detail.

Response:

```
{
  "result":[
    {
      "indicator": {
        "display_value": "Number of open incidents",
        "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
        "value": "fb007202d7130100b96d45a3ce6103b4"
      },
      "gap_formatted": "",
      "benchmarking": false,
      "frequency_label": "Daily",
      "changeperc_formatted": "0.0%",
      "direction_label": "Minimize",
      "precision": 0,
      "breakdown": {
        "display_value": "Assignment Group",
        "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/baec0752bf130100b96dac808c0739ed",
        "value": "baec0752bf130100b96dac808c0739ed"
      },
      "personal_target": null,
    }
  ]
}
```
"description":"Number of incidents open based on resolved date is empty.",
"value_color":="#455464",
"uuid":"fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:unmatched",
"frequency":10,
"gap":null,
"value_unit":"14",
"indicator_frequency":10,
"value":14.0,
"indicator_aggregate":1,
"facts_table": {
  "name":"incident",
  "label":"Incidents"
},
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element": {
  "display_value":"Unassigned", //Element name
  "link":https://<instance>.service-now.com/api/now/v1/table/sys_user_group/unmatched",
  "value":"unmatched" //No sys_id for unmatched scores
},
"period_title":"Jul 22",
"period":"Jul 22",
"target_formatted":"
"change":0.0,
"gapperc_formatted":"
"query":"opened_atONToday@javascript:gs.beginningOfToday()@javascript:gs.endOfToday()^ORopened_at<javascript:gs.beginningOfToday()^resolved_atISEMPTY^ORresolved_at>javascript:gs.endOfToday()^state!=8",
"realtime_enabled":true,
"changeperc":0.0,
"target":null,
"unit": {
  "display_value":"#",
  "link":https://<instance>.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad",
  "type":"formatted",
  "value":"17b365e2d7320100ba986f14ce6103ad"
},
"value_formatted":"14", // Score where Assignment Group=Unassigned
"name":"Number of open incidents > Assignment Group = Unassigned",
"gapperc":null,
"change_formatted":"0",
"favorite":false,
"personal_target_formatted":"
"indicator": {
  "element": {
    "display_value":"Software",
    "link":https://<instance>.service-now.com/api/now/v1/table/sys_user_group/8a4dde73c6112278017a6a4ba547aa7",
    "value":"8a4dde73c6112278017a6a4ba547aa7" // sys_id of element Software
  },
  "value_formatted":"6", // Score where Assignment Group: Software
  "name":"Number of open incidents > Assignment Group = Software",
  ...
"gapperc":null,
"change_formatted":"0",
"favorite":false,
"personal_target_formatted":"
},
{"indicator": {
...

"element": {
   "display_value":"Service Desk",
   "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/d625dccec0a8016700a222a0f7900d06",
   "value":"d625dccec0a8016700a222a0f7900d06"  // sys_id of element
Service Desk
},
...

"value_formatted":"5",  // Score for Assignment Group: Service Desk
"name":"Number of open incidents > Assignment Group = Service Desk",
"gapperc":null,
"change_formatted":"0",
"favorite":false,
"personal_target_formatted":"
},
{"indicator": {
...

"element": {
   "display_value":"Hardware",
   "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/8a5055c9c61122780043563ef53438e3",
   "value":"8a5055c9c61122780043563ef53438e3"  // sys_id for element
Hardware
},
...

"value_formatted":"3",  // Score for Assignment Group: Hardware
"name":"Number of open incidents > Assignment Group = Hardware",
"gapperc":null,
"change_formatted":"0",
"favorite":false,
"personal_target_formatted":"
},
{"indicator": {
...

"element": {
   "display_value":"Network",
   "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/287ebd7da9fe198100f92cc8d1d2154e",
   "value":"287ebd7da9fe198100f92cc8d1d2154e"},  // sys_id for element
Network
...

"value_formatted":"3",  // Score for Assignment Group: Network
"name":"Number of open incidents > Assignment Group = Network",
"change_formatted":null,
"gapperc":null,
"favorite":false,
Return the indicator filtered by a breakdown and element

You can apply a breakdown by appending the breakdown and breakdown element sys_id values to the `sysparmUuid` parameter. In this example, the data is broken down to show priority 1 incidents. The sys_id for the Priority breakdown is `0df47e02d7130100b96d45a3ce610399` and is in the example Return all breakdowns and aggregates for an indicator. You can get the sys_id for the 1 - Critical element by running the same command as in Return all elements for a breakdown, but with the Priority breakdown instead of Assignment Group. The sys_id for 1 - Critical is `5f012106db5123003ee8f93baf9619bd`.

Command:

```bash
curl -v -u "user:password" -H "Accept:application/json" 
"https://instance.service-now.com/api/now/v1/pa/scorecards?sysparmUuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003ee8f93baf9619bd"
```

Response:

```json
{
   // The request is made Dec 12. The
   // score is 76, which is unchanged from
   // Dec 11, and which exceeds the
   // target of 70.
   "result": [
      {
         "indicator": {
            "display_value": "Number of open incidents",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
            "value": "fb007202d7130100b96d45a3ce6103b4"
         },
         "gap_formatted": "-6",
         "benchmarking": false,
         "frequency_label": "Daily",
         "changeperc_formatted": "0.0%",
         "direction_label": "Minimize",
         "precision": 0,
         "breakdown": {
            "display_value": "Priority",
            "link": "https://instance.service-now.com/api/now/v1/table/pa_breakdowns/0df47e02d7130100b96d45a3ce610399",
            "value": "0df47e02d7130100b96d45a3ce610399"
         },
         "personal_target": null,
         "description": "Number of incidents open based on resolved date is empty.",
         "value_color": "#ff8c00",
         "uuid": "fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:5f012106db5123003ee8f93baf9619bd",
         "frequency": 10,
      }
   ]
}
```
"gap":-6.0,
"value_unit":"76",
"indicator_frequency":10,
"value":76.0,
"indicator_aggregate":1,
"facts_table":{
  "name":"incident",
  "label":"Incidents"
},
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element":{
  "display_value":"1 - Critical",
  "link":"https://instance.service-now.com/api/now/v1/table/sys_choice/5f012106db5123003ee8f93baf9619bd",
  "value":"5f012106db5123003ee8f93baf9619bd"
},
"period_title":"Dec 12",
"period":"Dec 12",
"target_formatted":"70",
"change":0.0,
"gapperc_formatted":"-8.6%",
"query":"opened_atONToday@javascript:gs.beginningOfToday()@javascript:gs.endOfToday()^ORopened_at<javascript:gs.beginningOfToday()^resolved_atISEMPTY^ORresolved_at>javascript:gs.endOfToday()^state!=8^priority=1^EQ",
"realtime_enabled":true,
"changeperc":0.0,
"target":70.0,
"unit":{
  "display_value":"#",
  "link":"https://instance.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad",
  "type":"formatted","value":"17b365e2d7320100ba986f14ce6103ad"
},
"value_formatted":"76",
"name":"Number of open incidents > Priority = 1 - Critical",
"gapperc):-0.08571428571428572,
"change_formatted":"0",
"favorite":true,
"personal_target_formatted":""}

Return the indicator broken down by location

The Performance Analytics API returns geolocation data when available.

Command:

curl -v -u "user:password" -H "Accept: application/json"
  "https://<instance>.service-now.com/api/now/v1/pa/scorecards?
  sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_breakdown=656d5662eb23310065deac6a"

Response:

{  "result": [  {  ...
Return first- and second-level breakdown scores

You can apply multiple breakdowns by appending multiple breakdown sys_ids to the `sysparm_uuid` parameter. In this example, the data is broken down by priority to show priority 1 incidents, and by category to show database incidents.

Command:

```bash
curl -v -u "user:password" -H "Accept:application/json"
"https://instance.service-now.com/api/now/v1/pa/scorecards?
sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:0df47e02d7130100b96d45a3ce610399:e5900140200331007665978299a805f3:1f918835d7231100b96d45a3ce6103fe:9e418d40200331007665978299a805c1"
```

Response:

```json
{
  "result": [
  {
    "value_formatted": "",
    "indicator": {
      "display_value": "Number of open incidents",
      "link": "http://instance.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
      "value": "fb007202d7130100b96d45a3ce6103b4"
    },
    "gapperc": null,
    "change": null,
    "value_color": "#000000",
    "direction": 2,
    "target_formatted": "",
    "frequency": 10,
    "changeperc_formatted": "",
    "direction_label": "Minimize",
    "period_title": null,
    "description": "Number of incidents open based on resolved date is empty."
  }
  ]
}```
Return scores across a range of dates for two levels of breakdown

You can request a list of individual scores for all available dates by setting the `sysparm_include_scores` parameter to true. To specify the date range of scores, also use the `sysparm_from` and `sysparm_to` parameters. In this example, the level 1 breakdown and element are Assignment Group: Software (sys_id baec0752bf130100b96dac808c0739ed and 8a4dee73c6112278017a6a4baf547aa7). The level 2 breakdown and element are Priority: 1 - Critical (sys_id 0df47e02d7130100b96d45a3ce610399 and 9e418d40200331007665978299a805c1).
Only scores on and after 30 November 2018 are returned.

Command:

```
curl -v -u "resttest:resttest" -H "Accept:application/json" 
"https://<instance>.service-now.com/api/now/v1/pa/scorecards? 
sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7:0df47e02d7130100b96d45a3ce6103b4:e5900140200331007665978299a805f3 &sysparm_include_scores=true&sysparm_from=2018-11-30"
```

Response:

```
{
  "result": [{
    "indicator": {
      "display_value": "Number of open incidents",
      "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
      "value": "fb007202d7130100b96d45a3ce6103b4"
    },
    "gap_formatted": "",
    "benchmarking": false,
    "frequency_label": "Daily",
    "scores": [
      {
        "end_at": "2018-12-04",
        "period": "Dec 04",
        "value_formatted": "2",
        "start_at": "2018-12-04",
        "value": 2.0
      },
      ...
      {
        "end_at": "2018-11-30",
        "period": "Nov 30",
        "value_formatted": "0",
        "start_at": "2018-11-30",
        "value": 0.0
      }
    ],
    "changeperc_formatted": "",
    "direction_label": "Minimize",
    "precision": 0,
    "breakdown": {
      "display_value": "Assignment Group",
      "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/ baec0752bf130100b96dac808c0739ed",
      "value": "baec0752bf130100b96dac808c0739ed"
    },
    "personal_target": null,
    "description": "Number of incidents open based on resolved date is empty.",
    "value_color": "#455464",
    "uuid": "fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c6112278017a6a4baf547aa7:0df47e02d7130100b96d45a3ce6103b4:e5900140200331007665978299a805f3",
    "frequency": 10,
    "gap": null,
    "value_unit": "2",
    "indicator_frequency": 10,
    "value": 2.0,
    "indicator_aggregate": 1,
    "key": false,
    "indicator_frequency_label": "Daily",
    "direction": 2,
    "element": {
      //First-level breakdown element
    }
  }
```

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Return breakdown relations for a breakdown and element

To obtain the sys_id values for all breakdown relations associated with an indicator, use the `sysparm_include_available_breakdowns` parameter. In the `sysparm_uuid` parameter, include the sys_ids of the first-level breakdown and element whose relations you want to find. In this example, the `sysparm_uuid` parameter includes the sys_id for the Assignment Group breakdown and the sys_id for the Software element. The sys_id of the Assignment Group was obtained in the example where all breakdowns and aggregates were returned. The sys_id of the Software element was obtained in the previous example, where all the elements of Assignment Group were returned. The sys_id of the Assignment Group breakdown is `baec0752bf130100b96dac808c0739ed` and of the Software element is `8a4dde73c6112278017a6a4baf547aa7`. The breakdown relation is obtained for the Number of open incidents indicator, whose sys_id is `fb007202d7130100b96d45a3ce6103b4`.

Note: To find the breakdown relations for incidents that do not match any element value in a breakdown, such as in Assignment Group: Unassigned, use the string `unmatched` in place of the element sys_id. In this case, the parameter would be `sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:unmatched`. 
Command:

curl -v -u "user:password" -H "Accept:application/json"  
"https://<instance>.service-now.com/api/now/v1/pa/scorecards?  
sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:8a4dde73c612278017a6a4baf547aa7&sysparm_include_available_breakdowns=true"

Response:

{
    "result": [
        {
            "value_formatted": "37",
            "indicator": {
                "display_value": "Number of open incidents",
                "link": "https://<instance>.service-now.com/api/now/v1/table/  
pa_indicators/fb007202d7130100b96d45a3ce6103b4",
                "value": "fb007202d7130100b96d45a3ce6103b4"
            },
            "gapperc": null,
            "change": 9.0,
            "value_color": "#455464",
            "direction": 2,
            "target_formatted": "",
            "frequency": 10,
            "changeperc_formatted": "32.1%",
            "direction_label": "Minimize",
            "period_title": "Jul 22",
            "description": "Number of incidents open based on resolved date is empty.",
            "name": "Number of open incidents / Assignment Group / Software",
            "value": 37.0,
            "key": false,
            "gap_formatted": "",
            "element": {
                "display_value": "Software",
                "link": "https://<instance>.service-now.com/api/now/v1/table/  
sys_user_group/287ee6fe9a9e198100ada7950d0b1b73",
                "value": "8a4dde73c612278017a6a4baf547aa7"
            },
            "precision": 0,
            "breakdowns": [
                // Information about each breakdown
            ],
            "breakdown_relations": [
                {
                    "display_value": "Child Groups",
                    "link": "https://<instance>.service-now.com/api/now/v1/table/  
pa_breakdown_relations/301fd511eb23310065deac6aa206fe31",
                    "value": "301fd511eb23310065deac6aa206fe31"
                },
                {
                    "display_value": "Parent Group",
                    "link": "https://<instance>.service-now.com/api/now/v1/table/  
pa_breakdown_relations/790b6e11eb23310065deac6aa206fe1c",
                    "value": "790b6e11eb23310065deac6aa206fe1c"
                },
                {
                    "display_value": "Sibling Groups",
                    "link": "https://<instance>.service-now.com/api/now/v1/table/  
pa_breakdown_relations/15e15a12eb233100871aac6aa206fe59",
                    "value": "15e15a12eb233100871aac6aa206fe59"
                }
            }
        }
    ]
}
Return indicator using a breakdown relation

To use a breakdown relation, include the sys_id values of the indicator, breakdown, and element in the `sysparm_uuid` parameter, and the sys_id of the breakdown relation in the `sysparm_breakdown_relation` parameter. This example returns the Sibling Group values for Assignment Group: Software from the previous example.

Command:

```
curl -v -u "user:password" -H "Accept:application/json" 
"https://<instance>.service-now.com/api/now/v1/pa/scorecards? 
sysparm_uuid=fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed&sysparm_breakdown_relation=15e15a12eb233100871aac6aa206fe59"
```

Response:

```
{
  "result": [
    {
      "indicator": {
        "gap_formatted": "", 
        "benchmarking": false, 
        "frequency_label": "Daily", 
        "changeperc_formatted": "0.0\%", 
        "direction_label": "Minimize", 
        "precision": 0, 
        "breakdown": {
          "display_value": "Assignment Group", 
          "link": "https://<instance>.service-now.com/api/now/v1/table/ 
pa_breakdowns/baec0752bf130100b96dac808c0739ed", 
          "value": "baec0752bf130100b96dac808c0739ed" 
        }, 
        "personal_target": null, 
```
"description":"Number of incidents open based on resolved date is empty",
"value_color":"#455464",
"uuid":"fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:0a52d3dcd7011200f2d224837e6103f2",
"frequency":10,
"gap":null,
"value_unit":"0",
"indicator_frequency":10,
"value":0.0,
"indicator_aggregate":1,
"facts_table":{
   "name":"incident",
   "label":"Incidents"
},
"key":false,
"indicator_frequency_label":"Daily",
"direction":2,
"element":{
   "display_value":"Application Development",
   "link":"https://<instance>.service-now.com/api/now/v1/table/sys_user_group/0a52d3dcd7011200f2d224837e6103f2",
   "value":"0a52d3dcd7011200f2d224837e6103f2"
},
"period_title":"Dec 03",
"period":"Dec 03",
"target_formatted":"
"change":0.0,
"gapperc_formatted":"

"query":"opened_atONToday@javascript:gs.beginningOfToday()@javascript:gs.endOfToday()^ORopened_at<javascript:gs.beginningOfToday()^resolved_atISEMPTY^ORresolved_at>javascript:gs.endOfToday()^state!=8^assignment_group=0a52d3dcd7011200f2d224837e6103f2^EQ",
"realtime_enabled":true,
"changeperc":0.0,
"target":null,
"unit":{
   "display_value":"#",
   "link":"https://<instance>.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba986f14ce6103ad",
   "type":"formatted",
   "value":"17b365e2d7320100ba986f14ce6103ad"
},
"value_formatted":"0",
"name":"Number of open incidents > Assignment Group = Application Development",
"gapperc":null,
"change_formatted":"0",
"favorite":false,
"personal_target_formatted":""
// Followed by an indicator object with an element object for every element in the Sibling Group
}
}

Return a filtered set of elements for a breakdown

You can apply a filter to the Analytics Hub data using the `sysparm_elements_filter` parameter with the `sys_id` of a Performance Analytics element filter record.
Get the sys_id of the elements filter from the elements filter record, as described in "The unique record identifier (sys_id).

In this example, the element filter applies to the Groups breakdown source, with the condition (Parent)'is '(Database). The sys_id of this element filter is 7b9eb563eb11020065deac6aa206fe11. The example gets the elements of the Assignment Group breakdown that have the element Database as a parent.

Command:

```
curl -v -u "user:password" -H "Accept:application/json" 
"https://<instance>.service-now.com/api/now/v1/pa/scorecards?
sysparm_uuid=fb007202d7130100b96d45a3ce6103b4&sysparm_breakdown=baec0752bf130100b96dac80739ed&sysparm_elements_filter=7b9eb563eb11020065deac6aa206fe11"
```

Response:

```
{
 "result": [
  {
   "value_formatted": "37",
   "indicator": {
     "display_value": "Number of open incidents",
     "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
     "value": "fb007202d7130100b96d45a3ce6103b4"
   },
   "gapperc": null,
   "change": 9.0,
   "value_color": "#455464",
   "direction": 2,
   "target_formatted": "",
   "frequency": 10,
   "changeperc_formatted": "32.1%",
   "direction_label": "Minimize",
   "period_title": "Jul 22",
   "description": "Number of incidents open based on resolved date is empty."
   "name": "Number of open incidents / Assignment Group / Database",
   "value": 37.0,
   "key": false,
   "gap_formatted": "",
   "element": {
     "display_value": "Database",
     "link": "https://<instance>.service-now.com/api/now/v1/table/sys_user_group/287ee6fe9fe198100ada7950db1b73",
     "value": "287ee6fe9fe198100ada7950db1b73"
   },
   "precision": 0,
   "breakdown": {
     "display_value": "Assignment Group",
     "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/287ee6fe9fe198100ada7950db1b73",
     "value": "287ee6fe9fe198100ada7950db1b73"
   },
   "period": "Jul 22",
   "favorite": false,
   "change_formatted": "9",
   "unit": {
     "display_value": "#",
     "link": "https://<instance>.service-now.com/api/now/v1/table/pa_units/17b365e2d7320100ba86f14ce6103ad",
     "value": "17b365e2d7320100ba86f14ce6103ad"
   }
  }
]}
```
"frequency_label": "Daily",
"target": null,
"changeperc": 0.25,
"uuid": "fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:287ee6f96a9fe198100ada7950d0b1b73",
"gapperc_formatted": "",
"value_unit": "",
"gap": null
},
{
"value_formatted": "20",
"indicator": {
    "display_value": "Number of open incidents",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_indicators/fb007202d7130100b96d45a3ce6103b4",
    "value": "fb007202d7130100b96d45a3ce6103b4"
},
"name": "Number of open incidents / Assignment Group / Database Atlanta",
"value": 20.0,
"key": false,
"gap_formatted": "",
"element": {
    "display_value": "Database Atlanta",
    "link": "https://<instance>.service-now.com/api/now/v1/table/sys_user_group/db53580b0a0a6501aa37c294a2ba6b",
    "value": "db53580b0a0a6501aa37c294a2ba6b"
},
"precision": 0,
"breakdown": {
    "display_value": "Assignment Group",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_breakdowns/баec0752bf130100b96dac808c0739ed",
    "value": "баec0752bf130100b96dac808c0739ed"
},
"period": "Jul 22",
"change_formatted": "4",
"unit": {
    "display_value": "#",
    "link": "https://<instance>.service-now.com/api/now/v1/table/pa_units/1b365e2d7320100ba986f14e6103ad",
    "value": "1b365e2d7320100ba986f14e6103ad"
},
"changeperc_formatted": "",
"target": null,
"changeperc": 0.25,
"uuid": "fb007202d7130100b96d45a3ce6103b4:baec0752bf130100b96dac808c0739ed:db53580b0a0a6501aa37c294a2ba6b",
"gapperc_formatted": "",
"value_unit": "",
"gap": null
Example integration - LinkedIn

Performance Analytics includes an optional example integration that demonstrates how to fetch data from the LinkedIn service and display it on a Performance Analytics dashboard.

To use the LinkedIn integration, you must activate the Performance Analytics - Example - LinkedIn plugin.

The integration enables you to track, break down, and report on the number of followers and updates for a particular company.

LinkedIn enforces several limits and requirements:
- The LinkedIn Updates API supports only 600 calls per day. The integration tracks at most the latest 600 updates.
- The application authentication must be refreshed every 90 days. See the access_token_expire field to determine when authentication expires.

Configure LinkedIn integration

Configure the LinkedIn integration to display LinkedIn data in Performance Analytics.

Role required: linkedin_admin

Before starting this procedure, ensure that you have complete the following prerequisites with the LinkedIn service:
- A LinkedIn Client Application is associated with your company LinkedIn profile.
- Configure the Client Application with the redirect URL for your instance. You can view this URL by creating a LinkedInApps record (LinkedIn > Apps).
- You have recorded the LinkedIn Client Application API Key and API Secret values.

1. Navigate to LinkedIn > Apps.
2. Click New.
3. Enter a descriptive App name.
4. Enter the Api key and Api secret for your LinkedIn Client Application.
5. Right-click the form header and select Save.
6. Click the Authenticate related link.
   You are redirected to LinkedIn. Complete any steps required by LinkedIn.
7. On the LinkedInApp form, right-click the form header and select Reload form to confirm that the application was authenticated.
   Note the access token expiry date.
8. Navigate to LinkedIn > Companies.
9. Click New.
10. Enter the company Name and the company ID Code.
11. Click Submit.
13. Click New.
14. Select the App and Company records you created.
15. Click Submit.
16. Navigate to LinkedIn > LinkedIn Collector Job.
17. Schedule this job to run at least once.
   The job state changes to Running, then to Ready. Wait for this process to complete before moving on--this may take several minutes.
18. Navigate to LinkedIn > Aggregate Update Table and LinkedIn > Individual Update Table to verify that the tables were populated.
19. Navigate to LinkedIn > PA Data Collector Job.
20. Change the Relative end value to 0.
21. Schedule this job to run at least once.
   An entry is added to the Job Logs related list. Wait for this record to reach the Collected state before moving on--this may take several minutes.

After configuring the integration and collecting the data, you can view the LinkedIn dashboard by navigating to LinkedIn > Dashboard.

You can view all LinkedIn indicators on the Analytics Hub by navigating to Performance Analytics > Analytics Hub and filtering the list to include only indicators that contain the text LinkedIn.

Example integration - Twitter

Performance Analytics includes an optional example integration that demonstrates how to fetch data from the Twitter service and display it on a Performance Analytics dashboard.

To use the Twitter integration you must activate the Performance Analytics - Example - Twitter plugin.

The integration enables you to track, break down, and report on the number of tweets and retweets containing certain tags and mentions.

You can define which tags and users to track by creating Twitter context records.

The Twitter service enforces several limits:

- The Twitter Search API limits results to tweets at most three weeks old. Historic collection of hashtags and mentions is not available.
- The integration is intended for use with a single user account and timeline. Support for multiple Twitter accounts is not available.

Configure Twitter integration

Configure the Twitter service integration to display Twitter data in Performance Analytics.

Role required: pa_admin, u_pa_twitter_context_user, and web_service_admin

Before starting this procedure, ensure that you have completed the following prerequisites with the Twitter service:

- A Twitter application is associated with your Twitter account.
- You have recorded the Twitter application Consumer Key and Consumer Secret values.

1. Navigate to System Web Services > REST Message.
2. Select the Get Twitter OAuth Token REST message record.
3. In the HTTP Methods related list, select the POST method.
4. In the Basic authentication user ID field, enter your Twitter application Consumer Key.
5. In the Basic authentication password field, enter your Twitter application Consumer Secret.
6. Click Update.
7. Navigate to Twitter > Twitter Collector Job.
8. Schedule this job to run at least once.
   The job state changes to Running, then to Ready. Wait for this process to complete before moving on--this may take several minutes.
9. Navigate to Twitter > PA Data Collector Job.
10. Schedule this job to run at least once. When the job runs, an entry is added to the Job Logs related list. Wait for this record to reach the Collected state before moving on--this may take several minutes.

After configuring the integration and collecting the data, you can view the Twitter dashboard by navigating to Twitter > Dashboard.

You can view all Twitter indicators by navigating to Performance Analytics > Analytics Hub and filtering the list to include only indicators where the Indicator group is Twitter.

Performance Analytics diagnostics

Identify and diagnose configuration issues using predefined scripts that examine the database for invalid records and provide suggestions to resolve issues.

Each diagnostic consists of a script or database query with a severity code, message text, and suggested solution. Diagnostics are read-only. You cannot create or edit diagnostics.

You can run one or all diagnostics against all applicable records, or you can run all applicable diagnostics against one record.

Run a diagnostic for all applicable records

To determine if a specific configuration issue could impact your Performance Analytics implementation, run the relevant diagnostic. The diagnostic examines the subset of Performance Analytics facts table records to which the diagnostic logically applies.

Role required: sn_pa_diagnostics.pa.diagnostics

1. Navigate to Performance Analytics > Diagnostics.
2. Select the diagnostic you want to run.
   To run all active diagnostics, click Execute All from the list.
3. Click Run Diagnostic.
   The diagnostics script is canceled automatically if it takes longer than 2 minutes to run.
4. After the diagnostic completes, click View Result.

If a diagnostic returns a warning or error, review the provided solution and take steps to resolve the issue.

Run all active diagnostics for one record

To determine if any of the configuration details of a record could impact your Performance Analytics implementation, run the set of all applicable diagnostics on that record.

Role required: sn_pa_diagnostics.pa.diagnostics

1. Navigate to Performance Analytics and open a list of any components: indicators, indicator sources, breakdowns, breakdown sources, widgets, or others.
2. Locate and open the record of interest.
3. Click the link Run diagnostics.
   A dialog opens to show the progress of the diagnostics.
4. When the diagnostic run is complete, click View Result in the progress dialog.

If a diagnostic returns a warning or error, review the provided solution and take steps to resolve the issue.
Performance Analytics for mobile devices

You can view the Performance Analytics Analytics Hub using the ServiceNow mobile application. You can use the mobile application to view and share an indicator in the Analytics Hub, mark favorite indicators in the Analytics Hub, and perform detailed analysis of Analytics Hub data such as by applying an aggregate or breakdown.
For information about device support and how to obtain the mobile application, refer to the general mobile application documentation.
Analytics Hub mobile interface

The Analytics Hub mobile interface enables you to interact with the Analytics Hub.

You can perform many of the same actions on an Analytics Hub in the mobile interface as in the standard web interface. For example, you can apply aggregates and breakdowns, view the score at specific dates, and view target and gap information.

The mobile Analytics Hub interface is divided into three main sections.

- The top section shows the indicator details such as the indicator name, score, the selected aggregate, and target information if targets are defined for the indicator. You can change the aggregation by tapping on the current aggregate in the top-right corner, such as Daily. Tap on the information icon (i) to view metadata about the indicator, such as the formula for formula indicators.

- The center section shows all collected scores as a graph. You can pinch to zoom in and out, or select a specific date by tapping on the graph. Selecting a specific date causes the top section to display details for the selected date instead of for the most recent score.

- The bottom section displays breakdown information. You can select a breakdown by tapping on the breakdown name, such as Priority. Available breakdown elements and the score for each element appears below the breakdown. Tap on a breakdown element to filter the Analytics Hub by that breakdown and element. The breakdown section does not appear if you have already selected both first and second level breakdowns.
Access an Analytics Hub in the mobile application

You can browse your favorite indicators in the Performance Analytics Analytics Hub.

You must have a System Mobile UI Navigator application with a module that accesses $pa_scorecards.do. The Now Platform provides a default System Mobile UI Navigator application named Analytics, with a module named Favorite KPIs that accesses $pa_scorecards.do. You can replace this module or create additional modules and applications that display the Analytics Hub. For more information, see Enable an application menu for the ServiceNow Classic mobile app.

Role required: pa_viewer or admin

The mobile application displays indicators marked as favorites in alphabetical order. Each entry includes the indicator name, current score, change, and an indication if the score is improving.
based on the indicator direction and a defined target. You can select an indicator to view the Analytics Hub.

1. In the mobile application, tap the general navigator icon ( ).
2. Select Analytics > Favorite KPIs. Any indicators you have marked as favorites appear. If no indicators appear, you must first select at least one favorite.
3. Optional: Tap the favorites icon ( ) to add an icon for the Favorite KPIs page to the mobile application homepage so you can quickly access the Favorite KPIs page later.
4. Tap on an indicator to view the Analytics Hub.
Select favorite indicators in the mobile application

Mark an indicator as a favorite to access it quickly.

Role required: pa_viewer, pa_admin, or admin

Select multiple indicators as favorites to quickly access them in the Analytics Hub. You can also select individual indicators as favorites by tapping the favorites icon (⭐) when viewing the Analytics Hub.

1. Navigate to the list of your favorite indicators.
2. Tap the plus (+) icon in the top-right corner.
   The list of all indicators appears.
3. Tap the check mark (✓) next to the indicators you want to favorite.
   To filter the list by name, enter text in the top search box. Filtering may hide but does not clear indicators you have already selected.
4. Tap Add to mark all selected indicators as favorites.

To remove a favorite, swipe the favorite to the side when viewing the list of your favorite indicators, then tap Delete.

Share an Analytics Hub in the mobile application

You can share an image of an Analytics Hub, such as by MMS or email.

Role required: pa_viewer, pa_admin, or admin

You can share an image of an Analytics Hub that includes the latest score and change, the graph, the instance URL, and the target and gap values if defined.

1. Navigate to an Analytics Hub using the mobile application.
2. Tap the share icon (➡).
3. Select how you want to share or save the image using your device’s default options.

Ranking records with Spotlight

To help focus energy and resources, use Spotlight to identify and rank records of interest based on multiple weighted criteria.

Spotlight illuminates records that otherwise you might overlook. You can define weighted criteria to identify and rank those records that require attention, such as when triaging incidents or performing lead scoring. You can rank records based on multiple dimensions, instead of by a single field value such as priority.

For example, you might want to have incidents brought to your attention if they have been open for a long time, or been reassigned multiple times, even if these incidents are low priority. Among those incidents, you might want one that has been open a long time and been assigned multiple times to be ranked above one that has only been open a long time.

Watch this ten-minute video for information about:
- Activating the Spotlight plugin and assigning roles
- Setting up Spotlight
• Sharing Spotlight results

Spotlight uses scheduled jobs that run to evaluate the records. The results of these jobs can be viewed in Spotlight interactive analyses. To share Spotlight results, share the URL of the analysis with any user who has the pa_spotlight_viewer role.

The following diagram demonstrates scoring in Spotlight. The large circle represents the set of all open incidents. Each of the smaller circles represents a weighted Spotlight criteria that applies to a subset of the open incidents.

Spotlight diagram

Note: To use Spotlight, an administrator must activate the Spotlight plugin or one of the Out-of-the-box Spotlight Solutions. For more information, see Activate Out-of-the-box Spotlight solutions.
Setting up Spotlight

Set up Spotlight for each set of table records that you want to evaluate and rank by importance. The records must be associated with an indicator.

Specify the records you want to evaluate by creating a Spotlight group. Create multiple Spotlight criteria and associate them with the group to define how to weight records. In the Spotlight group, you set the sum of the weights of criteria that a record must meet to trigger the creation of a Spotlight.

Note: Before you start to work with Spotlight, an administrator must activate a Spotlight plugin. When activating Spotlight, consider activating one of the out-of-the-box Spotlight solutions. First, see whether one of these solutions already covers your business use case. Second, if you still need to create a new Spotlight group or Spotlight criteria, an out-of-the-box solution can be a useful template. For more information, see Activate Out-of-the-box Spotlight solutions.

After creating the Spotlight group and multiple Spotlight criteria, activate the Spotlight group. After the Group is activated, Spotlight scores are collected automatically according to the Spotlight group job schedule. You can also collect Spotlight scores manually at any time for an active group. A Spotlight is automatically created for any records with Spotlight scores that exceed the Spotlight group threshold, allowing you to quickly identify the highest priority work.

Create a Spotlight group

Create a Spotlight group to define the records to evaluate. In the Spotlight group, you also set the threshold that the score of a record must exceed to trigger the creation of a Spotlight.

An administrator must have activated the Spotlight plugin or one of the Spotlight out-of-the-box solutions. See Activate Out-of-the-box Spotlight solutions.

Role required: pa-spotlight or admin

Spotlight groups specify a set of records to evaluate and a threshold. If the score of a record in the data set exceeds the threshold, a spotlight is created for that record. The score of a record is the total weight from all applicable spotlight criteria in the spotlight group.

The set of records to evaluate must be associated with a Performance Analytics indicator. The Spotlight group specifies this indicator. A Spotlight group can reference only one facts table: both the main indicator and all Spotlight criteria for the group must refer to the same table.

Note: You can change the main indicator of an existing Spotlight group. However, after you select criteria for the group, you can change the main indicator only to another indicator that uses the same facts table.

If you have domain separation enabled, you create the Spotlight group in whichever domain you are logged in to when you create it.

Warning: If you create a Spotlight group in the Global domain, every domain has access to the group.

1. Navigate to Spotlight > Spotlight Groups and click New.
2. Give the spotlight group a meaningful Name.
3. Fill in the fields:
ServiceNow Madrid Analytics, Intelligence, and Reporting

Spotlight Group form

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threshold</td>
<td>The sum of the weights of the Spotlight criteria that a record must meet to trigger the creation of a Spotlight. Consider revisiting this value when you assign weights to Spotlight criteria.</td>
</tr>
</tbody>
</table>
| Main Indicator| The indicator that collects the records that you want this Spotlight group to evaluate. The main indicator must meet the following requirements:  
• It must be an automated indicator.  
• The collect_records property of the indicator must be set to true. This property is set in the Source tab of the indicator form.  
• The indicator source for the indicator must refer to an actual table, not a database view. All criteria for evaluating this Spotlight group use the same facts table as the indicator source of the main indicator. |

4. To filter the records to evaluate, select a **Breakdown** and an **Element**.

5. To evaluate real-time data, clear the **Use Snapshot** checkbox.

   By default, Spotlight jobs collect a snapshot of records from when the data collection job for the main indicator last ran. Instead, the Spotlight job can collect indicator data in real-time when the Spotlight job runs. For more information, see [Evaluating snapshot or real-time data](#).

6. In the context menu, select **Save**.

You have created a Spotlight group with an indicator and a threshold, and you have defined whether to collect scores based on a snapshot or on real-time data.

Create Spotlight criteria for the Spotlight group and set the schedule for collecting Spotlight scores. See [Create Spotlight criteria](#). [Evaluating snapshot or real-time data](#)

When a Spotlight job runs, it collects either a snapshot of collected records or real-time data.

**Note:** New Spotlight scores overwrite previous scores, regardless of whether the scores are from a snapshot or from real-time data.

### Evaluating snapshot records

By default, a new Spotlight group uses a snapshot of records. Snapshots are the lists of records (sys_ids) that are collected at the time that the scores for those records are collected. A snapshot is made only for indicators with **Collect records** selected. The Performance Analytics data collection jobs for the main indicator and the criteria indicators of the Spotlight group create the snapshots. These jobs must run, collecting records, before the Spotlight evaluation job runs.
For a Spotlight group to use snapshot records, the data collection and Spotlight evaluation jobs must meet the following conditions:

- The main indicator and all the indicators used in the criteria of the Spotlight group have record collection enabled.

  **Note:** The Collect Records option on the Indicator form enables record collection, as described in Create an automated indicator.

- The main indicator and all the indicators used in the criteria of the Spotlight group have the same data collection frequency.

- The data collection jobs for all the Spotlight group indicators run as closely together as possible, to keep the data synchronized. The snapshots of the criteria indicators must have the same date as the last score date of the main indicator. Ideally, the main indicator and all the criteria indicators are in the same data collection job.

- The Spotlight score collection job runs at the same frequency as the data collection jobs, and as soon as possible after those jobs complete. Scheduling Spotlight score collection in this way ensures that the results are up-to-date and meaningful.

  **Note:** Only indicator-based Spotlight criteria evaluate snapshot records. Query-based criteria always evaluate real-time data, even when Use Snapshot is selected.

### Evaluating real-time data

Spotlight jobs can evaluate record scores using the real-time platform data or against the latest snapshots provided by Performance Analytics data collection jobs. However, Spotlight scores are only as current as the last time a Spotlight job ran, regardless of whether it was run against the real-time or snapshot data. For example, changes to a record are visible in real-time, but the change in the Spotlight score of the record will not be reflected until the next time a Spotlight job runs.

Evaluating real-time data requires more system resources to query the indicator data than evaluating records from a snapshot does.

Also, indicator-based criteria cannot be used to evaluate real-time data when scripted breakdowns are applied. The specific restrictions are:

- If the indicator of a criterion uses a breakdown that is based on a script, such as a bucket group, this specific criterion cannot be used. Either collect snapshot instead of real-time data or create query-based criteria in place of indicator-based criteria.

- If the main indicator of the Spotlight group uses a breakdown that is based on a script, you cannot evaluate real-time data. Configure the Spotlight group to collect data based on snapshots only.

### Create Spotlight criteria

Create Spotlight criteria to define when to weight a record, and the weight to assign.

*Create a Spotlight group*

Role required: pa_spotlight or admin

Spotlight criteria define how to weight records based on specific attributes. Each Spotlight criterion is associated with a Spotlight Group.
Spotlight criteria can refer to an indicator or can use a direct query to the facts table. The former criteria are called indicator-based criteria and the latter are called query-based criteria. The indicator for an indicator-based criterion must meet the following requirements:

- It must be an automatic indicator.
- It must be set to collect records.
- It must be based on the same table that the indicator source of the main indicator is based on. This table cannot be a database view.

A query-based criterion queries the same table that the indicator source of the main indicator is based on. The suitability of indicator-based and query-based criteria depends also on whether a snapshot of records or real-time data is evaluated. For more information, see Evaluating snapshot or real-time data.

Some criteria may be more important than others and have a higher weight. Weight from multiple criteria is cumulative within a Spotlight Group. The score of a record is the total weight from all applicable Spotlight criteria in the Spotlight Group.

1. Open a Spotlight criteria record in one of the following ways:
   - If you have a Spotlight group record open, locate the Spotlight Criteria related list and click New.
   - Navigate to Spotlight > Spotlight Criteria and click New.

2. If the field is not already populated, select the Spotlight Group to associate this criterion with. The Spotlight group specifies which records are evaluated against the criterion. Each criterion can be associated with one Spotlight group. A Spotlight group can have any number of criteria associated with it.

3. Enter the Weight you want to assign to records that meet this criterion. Consider revisiting the Threshold value that is set in the associated Spotlight group. Optimize the weights of the Spotlight criteria of the group and the group threshold against each other.

4. Select the Criteria Type to determine which records are assigned the specified weight.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator</td>
<td>Select an Indicator to assign the weight to all records included in that indicator. Optionally, select one or two breakdowns and elements to limit the records to only those records with the specified breakdown element values.</td>
</tr>
<tr>
<td>Query</td>
<td>Set Filter conditions. The specified weight is assigned to all records from the facts table that match the filter conditions. The facts table of the main indicator of the Spotlight group is automatically selected.</td>
</tr>
</tbody>
</table>

5. Click Submit.

You have a criterion for a Spotlight group.

Spotlight group with three criteria

Consider a Spotlight Group with the following three criteria, all referring to indicators:

- Priority is P1-Critical, with a weight of 1000.
- Priority P2-High, with a weight of 100.
- Open incidents not updated in 30 days, with a weight of 1000.
In this example, an open P2 incident that has not been updated in 30 days has a total score of 1100. This incident is prioritized above a recently opened P1 incident that has a total score of 1000.

Repeat the procedure to create as many criteria as are necessary. Then collect scores. See Collect Spotlight scores.

Collect Spotlight scores

To collect Spotlight scores, schedule score collection and activate the Spotlight group. You can also collect scores manually for an active Spotlight group.

1. Create a Spotlight group
2. Create Spotlight criteria

Role required: pa_spotlight or admin

When Spotlight collects scores, Spotlight also deletes all older Spotlight records for the associated Spotlight group, without exception.

1. Open the Spotlight group that you want to collect scores for.
2. If it is not already selected, select Active in the check box and save the Spotlight group form.
   New Spotlight groups are active by default.
   You can now execute the Spotlight job using the Execute Now button.

3. To collect scores immediately, click Execute Now.
4. Go to the Schedule section and in the Run field, select the frequency at which to collect Spotlight scores.
5. Fill in any specific information about when the Spotlight scores will be collected.
   The required information depends on the period you choose in the Run field. For example, if you choose to run Daily, you have to fill in the time of day to run. If you choose Monthly, you have to fill in the day of the month and the time of day to run.
6. If you are using domain separation, specify a user in the Run as field.
   Spotlight filters the scores for evaluation according to the domain of this user. If no user is specified, scores are evaluated for all domains.
Warning: Scores from subdomains of the user domain are not collected.

Spotlight starts collecting scores according to the schedule you set. You can also collect scores manually at any time by clicking Execute Now. Administrators who need to troubleshoot scheduling can read Schedule Item (sys_trigger) records for Spotlight.

You can see the details of the criteria that contribute to a Spotlight score. For more information, read See Spotlight score details. You can also see and share an interactive analysis of the results.

See Spotlight score details

To see the criteria whose weights contributed to a Spotlight score, view the details of the Spotlight record.

Role required: pa_spotlight or admin

1. Navigate to Spotlight > Spotlight or view the Spotlights related list in a Spotlight Group record.
2. Locate the Spotlight that interests you and click the information icon.
3. Click Open Record

The Spotlight record opens. In the Spotlight Audits related list, you can see which Spotlight criteria the record met and the contribution of each criterion to the total score.

Spotlight criteria contributing to total score

Consider the Spotlight record for Incident INC0006831, which had a Spotlight score of 1,200 against a threshold of 1,000.
Opening the Spotlight record, you see that the following criteria weights contributed to the total score:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open incidents not updated 30 days</td>
<td>1,000</td>
</tr>
<tr>
<td>Incidents older than 28 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 7 days</td>
<td>25</td>
</tr>
<tr>
<td>Open incidents not updated 5 days</td>
<td>100</td>
</tr>
</tbody>
</table>
### Spotlight interactive analysis

Spotlight interactive analysis shows the key results of a Spotlight job. Access the analysis from a Spotlight Group record.

To open the Spotlight interactive analysis, open the Spotlight Group record for the group of interest and click **Launch Interactive Analysis**. The pa_spotlight role is necessary.

Using interactive analysis with any table other than incident requires the fully enabled, licensed version of Performance Analytics. See [Get licensed Performance Analytics](#).

Interactive Analysis contains the following information:

- The number of Spotlight records. This value is also the number of corresponding fact table records that exceeded the Spotlight Group threshold.
- The number of unassigned facts table records that exceeded the Spotlight threshold. These records have no value in the Assigned To column.
- The database view that joins the Spotlight table with the facts table of the main indicator. Each row of this view shows the columns from a Spotlight record and the corresponding facts table record.

**Note:**
- If a user cannot see the values in this table, ensure that they have the itil role.
- You can create reports by using this database view as a data source. You can include these reports in dashboards. Each of the Out-of-the-box Spotlight Solutions includes such a dashboard and reports.

For more information, see [Spotlight database views](#).

You can apply interactive filters to the analysis. The following filters are available, for facts tables with the matching columns:

- The **Priority** of the facts table record (tasks only)
- When the record was **Opened**
- The **Age** of the record
- The **Assignment Group** (tasks only)
- The **State** that the record is in

For information about adding or removing any of these filters, see [Add a filter to Interactive Analysis](#) and [Remove a filter from Interactive Analysis](#).

**Note:** If you create an interactive filter for a Spotlight interactive analysis, the filter must be created on top of the relevant Spotlight database view. The admin role is necessary to access the database view. If you do not have this role, contact your system administrator.
To share the interactive analysis, share the URL from the Filter Info. The user with whom you share the interactive analysis must have the pa_spotlight_viewer role. For more information about the Filter Info, see Interactive Analysis information panel.

**Spotlight logs**

The steps of Spotlight jobs are recorded in logs. Use these logs to debug any issues. Users with the pa_spotlight or admin roles can read and delete Spotlight job logs. The logs are listed at the following locations:

- At Spotlight > Spotlight Logs.
- As the Spotlight Job Logs related list on the relevant Spotlight Group record.

The same Spotlight Job Logs list opens in both places, but in the Spotlight Group form, the list is filtered by that Spotlight group.

To debug a Spotlight job, open the job log from the list and examine the job log row fields.

**Debugging Spotlight jobs**

Consider the Incident Spotlight group, which evaluates real-time data from the Incident (incident) table. This table is the table that the indicator source of the Number of open incidents indicator uses. A Spotlight job runs on this Spotlight group every day at 15:00 hours.
The Spotlight jobs for this group generate the following list of Spotlight job logs, where the most recent job completed with errors:

<table>
<thead>
<tr>
<th>Created</th>
<th>Spotlight Group</th>
<th>State</th>
<th>Run Time</th>
<th>Deletes</th>
<th>Inserts</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018-05-07 04:04:23</td>
<td>Incident Spotlight</td>
<td>Collected with errors</td>
<td>0 Seconds</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2018-05-07 04:02:03</td>
<td>Incident Spotlight</td>
<td>Collected</td>
<td>2 Seconds</td>
<td>0</td>
<td>7</td>
</tr>
</tbody>
</table>

Clicking the timestamp of the 04:02:03 job shows a successful job with only informational messages.
### Spotlight Job Log Rows

<table>
<thead>
<tr>
<th>Created</th>
<th>Sequence</th>
<th>Level</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018-05-07</td>
<td>1</td>
<td></td>
<td>Information: Verifying configuration for spotlight group: Incident Spotlight</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>2</td>
<td></td>
<td>Information: Spotlight configuration verified successfully</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>3</td>
<td></td>
<td>Information: Start collecting scores for spotlight group Incident Spotlight</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>4</td>
<td></td>
<td>Information: 140 Records will be processed.</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>5</td>
<td></td>
<td>Information: Evaluating criteria and calculating scores for spotlight group for 140 records.</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>6</td>
<td></td>
<td>Information: 4 Records to evaluate against criterion P2 - High</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>7</td>
<td></td>
<td>Information: 23 Records to evaluate against criterion P3 - Moderate</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>8</td>
<td></td>
<td>Information: 13 Records matched criterion Reassignment &gt; 3 times</td>
</tr>
<tr>
<td>2018-05-07</td>
<td>9</td>
<td></td>
<td>Information: 39 Records to evaluate against criterion P4 - Low</td>
</tr>
</tbody>
</table>
Returning to the list and opening the log for the job that had errors, you see that the Spotlight criterion **Incident more than 30 days old** is invalid.

Navigating to the Spotlight criteria, you see that **Incident more than 30 days old** is an indicator-based criterion that uses the Age breakdown.
<table>
<thead>
<tr>
<th>Description is Empty</th>
<th>Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident more than 30 days old</td>
<td>Age</td>
</tr>
<tr>
<td>Incidents</td>
<td>Older than 14 days</td>
</tr>
</tbody>
</table>
Viewing the Age breakdown shows that it uses a script in a breakdown mapping.

As shown at the top, the Incident Spotlight group evaluates real-time data. Therefore, the group cannot support criteria that use scripted breakdowns. For the job to run without errors, replace this criterion with a criterion that uses a query instead of an indicator and a breakdown. For example, create a criterion that queries the Incident [incident] table with the following conditions:

- `[[Opened](relative)(on or before)(30)(Days)(ago)]`
- `[[Opened](relative)(on or after)(90)(Days)(ago)]`

For more information, see [Create Spotlight criteria](#).

**Administering Spotlight**

Users with the admin role can access lower-level components of Spotlight.
Spotlight database views

Spotlight ensures that a database view joins the Spotlight (spotlight) table and the facts table whose records the Spotlight group evaluates. Administrators can access this database view to create reports or for troubleshooting.

After creating the database view, Spotlight adds a reference to it in the related spotlight_group record on the Spotlight Group (spotlight_groups) table. The reference consists of the primary key field value of the database view, which is put in the database_view column of the record.

**Note:** If you upgrade from an earlier version than London, you start with an empty database_view value in the database_view column of your spotlight_groups records. This empty column has no impact. The column populates as users modify the records in the spotlight_groups table.

If you are an administrator, you can access the database view directly. To see the database view for a Spotlight Group, click the **Show Database View** related link on the Spotlight Group form. You can also add a **Database View** column to the Spotlight Groups list.

If you delete a Spotlight group, Spotlight deletes the database view associated with that group if it is safe to do so. To determine whether the database view can be deleted, Spotlight checks for the following conditions:

- Do any other Spotlight groups have a reference to that database view?
- Are any other Spotlight groups defined with a main indicator that uses the same facts table as the main indicator of the group to be deleted?

If neither condition is true, the database view is deleted.

When creating, modifying, or deleting database views, Spotlight runs these business rules:

- Update Database View
- Delete Database View
- Set DB View on Insert

Schedule Item (sys_trigger) records for Spotlight

Setting a Spotlight group to Active creates a Schedule Item (sys_trigger) record. As an administrator, access this record to troubleshoot scheduling. This record contains the scheduling information that is set on the Spotlight group.

Editing the schedule in the Spotlight group record replaces the Schedule Item (sys_trigger) record with a new one. Deactivating or deleting the Spotlight group deletes the Schedule Item record. If you reactivate the Spotlight group, you create a new Schedule Item record.

**Note:** As an administrator, you can access the Schedule Item (sys_trigger) record for a Spotlight group by clicking **Show Scheduler** on the Spotlight Group form.

The process of creating, editing, and deleting Schedule Item (sys_trigger) records uses business rules as follows:

**Spotlight group activation, business rules, and scheduling**

<table>
<thead>
<tr>
<th>Action</th>
<th>Business rule</th>
<th>Effect on Schedule Item record</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activating a Spotlight group</td>
<td>Create Schedule Item (sys_trigger)</td>
<td>A new Schedule Item (sys_trigger) record is created with the scheduling information,</td>
</tr>
<tr>
<td>Action</td>
<td>Business rule</td>
<td>Effect on Schedule Item record</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>----------------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Editing a schedule in a Spotlight group record</td>
<td>Create Schedule Item [sys_trigger] record</td>
<td>The existing Schedule Item [sys_trigger] record is replaced with a new record, with the new scheduling information.</td>
</tr>
<tr>
<td>Deactivating a Spotlight group</td>
<td>Delete Schedule Item [sys_trigger] record</td>
<td>The existing Schedule Item [sys_trigger] record associated with that Spotlight group is deleted.</td>
</tr>
<tr>
<td>Reactivating a Spotlight group</td>
<td>Create Schedule Item [sys_trigger] record</td>
<td>A new Schedule Item [sys_trigger] record is created with the scheduling information.</td>
</tr>
<tr>
<td>Deleting a Spotlight group</td>
<td>Delete Schedule Item [sys_trigger] record</td>
<td>The existing Schedule Item [sys_trigger] record associated with that Spotlight group is deleted.</td>
</tr>
</tbody>
</table>

**Out-of-the-box Spotlight solutions**

These solutions contain pre-configured Spotlight components. The solutions also contain dashboards that present the same information as Spotlight interactive analyses.

The following Spotlight solutions are available:

- Spotlight — Change Spotlight Performance Analytics Solution (com.snc.pa.spotlight.change)
- Spotlight — Incident Spotlight Performance Analytics Solution (com.snc.pa.spotlight.incident)
- Spotlight — Problem Spotlight Performance Analytics Solution (com.snc.pa.spotlight.problem)
- Spotlight — Request Spotlight Performance Analytics Solution (com.snc.pa.spotlight.request)
- Customer Service (com.snc.pa.customer_service) — Includes the Case Spotlight Group. Activation also activates the Spotlight plugin. No dashboard, but includes the Case Spotlight report that can be included on dashboards.

**Activate Out-of-the-box Spotlight solutions**

To use Spotlight, activate the Spotlight plugin. Also activate any of the Spotlight solution plugins that apply to how you use the product. After you install Spotlight solutions, follow the Guided Setup to explore and customize those solutions.

- OOTB Spotlight Solutions other than Incident Spotlight require the fully enabled, licensed version of Performance Analytics. See [Get licensed Performance Analytics](#).
- Performance Analytics Responsive Dashboards must be active. For more information, see [Working with responsive dashboards](#).

Role required: admin

Spotlight functionality is not available until you activate the Performance Analytics - Spotlight plugin (com.snc.pa.spotlight). You can activate the plugin directly or through activating your first Spotlight solution plugin.

Each Spotlight Solution provides the following:

- A Spotlight dashboard for the relevant application. The information in this dashboard is similar to the information in the Spotlight interactive analysis. The reports in these dashboards can be used in other dashboards.
- A preconfigured Spotlight group. The Spotlight group defines which records to evaluate for prioritization, based on a specified indicator. The Spotlight group also defines which criteria to use to evaluate the data and the schedule for evaluating the data.
- Several spotlight criteria based on common business use cases
- A database view joining the Spotlight table to the facts table that is the source of the main indicator of the Spotlight Group. Both the Spotlight dashboard for the solution and the Interactive Analysis use this database view. For more information, see Spotlight database views.

After Spotlight solutions are activated, use Guided Setup to walk you through the Spotlight solutions. Navigate to Spotlight > Guided Setup and follow the instructions there.

1. Navigate to System Definition > Plugins.
   A banner appears to notify you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.
   
   Note:
   To redirect to the legacy list view for plugins, click the link.
   
   You have been redirected to All Applications. To see the Plugins list click here

2. Find the plugin with the filter criteria and search bar.
   You can search for the plugin by its name or ID.
   If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Activate the plugin.
   You can activate the plugin directly from the All Applications page or view more details about the plugin before activating it.
   - If you are certain that you have the correct plugin, click Install, and then click Activate in the dialog box that appears.

   To view plugin details before activation:
1. Click the plugin name.

2. On the form, click the **Activate/Update** related link.

3. On the dialog box that appears, review the dependent plugins.
   
   If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.

4. If demo data is available and you want to install it, click **Load demo data**.
   
   Some plugins include demo data, which are sample records that illustrate plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking **Load demo data only** on the plugin form.

5. Click **Activate**.

If you have activated a Spotlight solution, examine the Spotlight group and Spotlight criteria for that solution. A Guided Setup is available to walk you through the solution. Navigate to **Spotlight > Guided Setup** and follow the instructions there.

**Example: Incident Spotlight**

This example describes the settings in the Incident Spotlight group, which is included in the Incident Spotlight Out-of-the-box Solution. The example includes the results of a Spotlight job and the details of a resulting Spotlight record.

The Incident Spotlight solution includes the Spotlight group Incident Spotlight. This group uses the indicator **Number of open incidents** and has a threshold of 1000. Because the **Number of open incidents** indicator uses the incident facts table as its source, the Spotlight job evaluates records in that table.

The Incident Spotlight group has a job scheduled to execute every day at 1500. Set the group to **Active** for the job to execute according to the schedule.
The Incident Spotlight group has Spotlight Criteria related to:

- The age and priority of an open incident
- Whether the incident has a description
- Whether the incident has been reassigned more than three times

Each criterion is assigned a weight, which varies in this case from 1 for a priority of P4 Low to 1000 for a priority of P1 Critical.

When a data evaluation job executes, it evaluates the records of the incident facts table. Each record is given a score equal to the sum of the weights of the criteria that the record meets. The job generates a Spotlight for each incident record with a score that meets or exceeds the group threshold of 1000.
Clicking an information icon for a Spotlight shows the details of which criteria contributed to the score. For example, Incident INC0000015 met the following Spotlight criteria:

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incidents older than 28 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 14 days</td>
<td>25</td>
</tr>
<tr>
<td>P1 Critical</td>
<td>1,000</td>
</tr>
<tr>
<td>Incidents older than 7 days</td>
<td>25</td>
</tr>
<tr>
<td>Incidents older than 90 days</td>
<td>25</td>
</tr>
</tbody>
</table>

**TOTAL SCORE:** 1,100

The results of the Spotlight job are visible on the Incident dashboard, which is in the Spotlight group. This dashboard is
identical to the interactive analysis of the Incident Spotlight group.

<table>
<thead>
<tr>
<th>Number</th>
<th>Short description</th>
<th>Assigned to</th>
<th>Assignment group</th>
<th>State</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC00000039</td>
<td>Unable to access team file share</td>
<td></td>
<td></td>
<td>New</td>
<td>1.210</td>
</tr>
<tr>
<td>INC00000048</td>
<td>Performance problems with email</td>
<td></td>
<td></td>
<td>New</td>
<td>1.200</td>
</tr>
<tr>
<td>INC00000677</td>
<td>Performance problems with wifi</td>
<td></td>
<td></td>
<td>New</td>
<td>1.200</td>
</tr>
<tr>
<td>INC00000031</td>
<td>Need help with Remedy. Can we configure UIT</td>
<td>David Loos</td>
<td></td>
<td>In Progress</td>
<td>1.200</td>
</tr>
<tr>
<td>INC00000643</td>
<td>Database error observed in SuccessFactors Workforce Analytics</td>
<td>Ed Gorof</td>
<td>SAP Support</td>
<td>New</td>
<td>1.150</td>
</tr>
<tr>
<td>INC00006939</td>
<td>Mass delete junk data from the users table in PeopleSoft Asset Lifecycle Mana...</td>
<td>Carla Siriburgh</td>
<td>Oracle Support</td>
<td>New</td>
<td>1.150</td>
</tr>
<tr>
<td>INC0000672</td>
<td>Error opening page in HireRight Reports</td>
<td>Randel</td>
<td>HR Systems Support</td>
<td>New</td>
<td>1.150</td>
</tr>
</tbody>
</table>

Incident Opened

- All

Incident Priority

- All

Incident State

- All

Assignment Group

- All
Interactive Analysis

Interactive Analysis enables you to quickly explore data using visualizations. From any list of records, you can access an interactive set of reports on the list data. You can also manipulate the data by grouping, stacking, aggregating, and applying interactive filters. Click the visualization to drill down into the data. Click the information icon (i) to edit the source filter, view the list of applied filters, and copy the URL of the analysis.
Launch Interactive Analysis

Launch Interactive Analysis from any list.

Role required: none

You must have access to the list of records that you want to analyze.

1. Navigate to any list.
2. Optional: Configure the columns that are displayed on the list.
   - The columns that appear on the list when you launch Interactive Analysis determine which fields are included in the analysis. The included fields determine which Group by and Stack by options are available, and which interactive filters appear by default.
3. Right-click the column header for a reference, choice, date/time, or boolean field and select Launch Interactive Analysis.
   - The column that you launch Interactive Analysis from is used as the default Group by value.
4. Optional: Change how data is aggregated by selecting different values in the Group by and Stack by choice lists, or filter the data by applying one or more interactive filters.
5. Optional: Drill down into a subset of the data by clicking a visualization, such as a bar in the bar chart or a cell in the heatmap.

Request Interactive Analysis

The Interactive Analysis plugin (com.glideapp.interactive_analysis) requires the licensed version of Performance Analytics.

Role required: admin

There are two ways to request a plugin:

- Access the HI Service Catalog directly by clicking Service Catalog > Activate Plugin on HI.
- Access the HI Service Catalog through the All Applications page on your instance by following these steps.

1. From your instance, navigate to System Definition > Plugins.
2. On the All Applications page, click Request Plugin to open the request form on HI.
3. On HI, select to be redirected to the HI Service Portal Service Catalog.
4. On the Activate Plugin request form, fill in the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Instance</td>
<td>Instance on which to activate the plugin.</td>
</tr>
<tr>
<td>Plugin Name</td>
<td>Name of the plugin to activate.</td>
</tr>
<tr>
<td>Specify the date and time you would like this plugin to be enabled</td>
<td>Date and time must be at least two business days from the current time.</td>
</tr>
<tr>
<td>Reason/Comments</td>
<td>Information that would be helpful for the ServiceNow personnel who are activating the plugin. For example, if you need the plugin activated at a specific time instead of during one of the default activation windows, specify it in the comments.</td>
</tr>
</tbody>
</table>

5. Click Submit.

**Reporting**

ServiceNow® Reporting enables you to create and distribute reports that show the current state of instance data, such as how many open incidents of each priority there are. Reporting functionality is available by default for all tables, except for system tables.

**Explore**
- Performance Analytics and Reporting release notes
- Upgrade to Madrid
- Domain separation in Reporting

**Administer**
- Administering reports includes role information
- Report Administration module

**Use**
- Getting started with reports
- Creating reports
- Distribute reports
- Add a report to a dashboard or homepage
- Using multiple data series in a report

**Develop**
- Data Visualization
- Developer documentation

**Videos**
- Watch Reporting videos

**Troubleshoot and get help**
- Ask or answer questions in the Performance Analytics and Reporting forum
- Search the HI knowledge base
Getting started with reports

ServiceNow reports are visualizations of your data that you can share with users on dashboards and service portals, export to PDF, and send via email. Learn how to create, run, edit, view, and share reports.

Note: To administer reports, reporting roles, and report sources, navigate to Reports > Administration and select the area to administer.

The ServiceNow system includes a range of predefined reports that provide data on applications and features like incident management and service catalog requests. You can also create your own reports. Add reports on homepages and dashboards to share information across your organization.

The following podcast offers additional information on Reporting.

Run a report

Run a report to view current data with an existing report configuration.

To administer reports, reporting roles, and report sources, navigate to Reports > Administration and select the area to administer.

1. Navigate to Reports > View/Run.
2. Click the title of the report you want to run.

The report is shown in the Report Builder or Report Designer.

Run a report from a list

You can create a pie or bar chart report directly from a list. If you have a reporting role you can also save, distribute, and export these reports.

1. Navigate to the list.
2. Right-click the header of the column that contains the values you want to be displayed as the bars or slices in the chart.
3. Select Pie Chart or Bar Chart.

The report is generated and opened in the report creation tool.

- Share the report using the Report Designer.
- Publish the report by generating a URL to share with other users.

Create a report visualization

Create a report to visualize and analyze current instance data or temporary data that you have imported.

1. Follow one of these paths:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a report</td>
<td>Navigate to Reports &gt; Create New.</td>
</tr>
<tr>
<td>Edit an existing report</td>
<td>Navigate to Reports &gt; View / Run and click the edit icon beside the report name.</td>
</tr>
<tr>
<td>Create a report on a dashboard</td>
<td>Navigate to the dashboard where you want to add the report, click the Add Widgets icon, and select Reports.</td>
</tr>
<tr>
<td>Edit a report on a dashboard</td>
<td>Navigate to the dashboard where the report resides and click Edit. To edit a report, click its edit icon.</td>
</tr>
</tbody>
</table>

2. On the Configure and Style tabs, fill in the fields, as appropriate.
3. Click Save.

The report is generated.

**Note:** For details on creating a specific report type, see [Creating reports](#).

**Report options**

When you edit a form, you can also choose to save, share, run, delete, or view more information about the report.

All actions are available from the upper right side of the form, from the Save and Share lists and the Info, Delete, and Run buttons. Available report options vary depending on the role of the user working with the report.

**Note:** In the Report Builder (“Classic UI”), these options are found in the Save menu.
### Report options

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link (🔗)</td>
<td>Displays the URL of a saved report that you can copy into other documents.</td>
</tr>
<tr>
<td>Info (ℹ️)</td>
<td>Displays general and statistical information for the report. General information includes the base table, type, creator, users, groups, and last modification date of the report. Statistical information includes when the report was last run, the number of runs, and run time.</td>
</tr>
<tr>
<td>Sharing (➡️)</td>
<td>Displays several options for sharing the output of the report.</td>
</tr>
<tr>
<td>Share</td>
<td>Enables you to set the visibility of the report. Options are Me, Everyone, and Groups and Users. See Share a report – Report Designer for more information on sharing. This option is available from the Sharing icon (➡️).</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule</td>
<td>Creates a schedule for running the report.</td>
</tr>
<tr>
<td></td>
<td><img src="i" alt="Note" /> You cannot schedule calendar reports.</td>
</tr>
<tr>
<td>Add to Dashboard</td>
<td>Adds the current report to a dashboard or homepage. For details on how to</td>
</tr>
<tr>
<td></td>
<td>edit reports and other dashboard content, see <a href="#">Edit a responsive dashboard</a>.</td>
</tr>
<tr>
<td></td>
<td><img src="i" alt="Note" /> Users can add reports to any homepage they can view. Users who</td>
</tr>
<tr>
<td></td>
<td>do not have edit rights to a homepage create new homepages with the added</td>
</tr>
<tr>
<td></td>
<td>information when they modify a homepage that they don’t own.</td>
</tr>
<tr>
<td>Export to PDF</td>
<td>Generates a PDF that you can download or email. This option is not available</td>
</tr>
<tr>
<td></td>
<td>for calendar reports.</td>
</tr>
<tr>
<td></td>
<td><img src="i" alt="Note" /> Drilldown reports do not export to PDF. If you select Export to PDF</td>
</tr>
<tr>
<td></td>
<td>on a drilldown report, a PDF of the top-level report is generated.</td>
</tr>
<tr>
<td>Publish</td>
<td>Creates a URL for the report and displays the URL above the report form. You</td>
</tr>
<tr>
<td></td>
<td>can email this URL to share the report.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the report.</td>
</tr>
<tr>
<td>Delete ()</td>
<td>Deletes the report.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves your changes to the report and leaves the form open.</td>
</tr>
<tr>
<td>Update</td>
<td>Saves your changes to the report and returns to the Reports list.</td>
</tr>
<tr>
<td>Insert</td>
<td>Duplicates the report record, inserts it into the Reports list, and opens</td>
</tr>
<tr>
<td></td>
<td>the Reports list. Use this option to create a report quickly by changing</td>
</tr>
<tr>
<td></td>
<td>values in an existing report. Be sure to give the new report a unique name.</td>
</tr>
<tr>
<td>Insert and Stay</td>
<td>Duplicates the report record, inserts it into the Reports list, and opens</td>
</tr>
<tr>
<td></td>
<td>the new record. Use this option to create a report quickly by changing</td>
</tr>
<tr>
<td></td>
<td>values in an existing report. Be sure to give the new report a unique name.</td>
</tr>
<tr>
<td>Save as data source</td>
<td>Opens the <a href="#">Create new report source</a> window in which you can save the</td>
</tr>
<tr>
<td></td>
<td>report conditions as a report source that can be reused for other reports.</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>Run</td>
<td>Creates the report based on the conditions and layout you select.</td>
</tr>
</tbody>
</table>

**View the Reports list**

View a list of reports and create reports from the Reports list.

On the View / Run report module, standard platform ACLs control access to reports in the reports list. For information about the ACLs used to control access to reports, see [Access control list rules](#).

You can sort and filter the search results using the standard report list controls, such as by clicking tabs, column headings, or the favorites icon (⭐).

Select the gear icon (⚙️) next to the Create a report button to configure the columns displayed in the Reports list.
You can filter the Reports list with the following tabs:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>My reports</td>
<td>Reports that you created.</td>
</tr>
<tr>
<td>Group</td>
<td>Reports that have been shared with you and with the groups that you are a member of.</td>
</tr>
<tr>
<td>Global</td>
<td>Reports that are available to everyone.</td>
</tr>
<tr>
<td>All</td>
<td>All reports that you have access to (Global, Group, and My reports).</td>
</tr>
</tbody>
</table>
Users with report_admin or admin roles also see these columns on their Reports list.

### Additional columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Indicates if the report is scheduled to run in the future. Reports can be run periodically to be emailed.</td>
</tr>
<tr>
<td>Published</td>
<td>If the report is published, shows a check mark (✓).</td>
</tr>
</tbody>
</table>

### View favorite reports

You can show either all reports or only those reports marked as favorites. Reports can be marked favorite both automatically and manually.

To toggle between showing only favorite reports and showing all reports, click the favorites icon (⭐) in the list header.

**Note:** Favorites filtering is persistent. If you chose to show only favorites the last time you viewed the Reports list, then only favorites are shown the next time. Click the favorites icon or the **Favorites filtering is on** button to show all reports you have the rights to view in the
selected category. The **My reports** category is selected by default when you open the Reports list.

<table>
<thead>
<tr>
<th>Type</th>
<th>Title</th>
<th>Table</th>
<th>Last modified</th>
<th>Scheduled</th>
<th>Published</th>
</tr>
</thead>
<tbody>
<tr>
<td>⭐</td>
<td>30/60/90 Day Task Aging</td>
<td>Follow On Task [cert_follow_on_task]</td>
<td>2018-02-05 04:00:50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>⭐</td>
<td>All Incidents Closed By [My Groups]</td>
<td>Incident [incident]</td>
<td>2013-11-19 05:40:20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>⭐</td>
<td>Configuration Item by Vendor</td>
<td>Configuration Item [cmmid_c]</td>
<td>2013-11-18 15:31:08</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Report favorites

A report is automatically marked as a favorite when you open it. You can manually mark a report as a favorite by clicking the star icon beside the report title.

**Note:** To turn off the automatic marking of reports as favorites, disable the user preference glide.ui.nav.auto_favorite. For more information, see [User preferences](#).

### Reports list URL parameters

You can add parameters to the Reports list URL to filter the list before it loads.

### Reports list URL structure


For example, the URL `https://yourbusiness.service-now.com/report_home.do?jvar_selected_tab=MyReports` returns the Reports list with the **My Reports** tab selected.
## Parameters

The following parameters are available for Reports list URLs:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td>jvar_selected_tab</td>
<td>Shows the Reports list with the specified tab selected. Use these values:</td>
</tr>
<tr>
<td></td>
<td>- myReports</td>
</tr>
<tr>
<td></td>
<td>- groupReports</td>
</tr>
<tr>
<td></td>
<td>- globalReports</td>
</tr>
<tr>
<td></td>
<td>- allReports</td>
</tr>
<tr>
<td>jvar_search_table</td>
<td>Filter reports created on a specified table. For example, the parameter</td>
</tr>
<tr>
<td></td>
<td>jvar_search_table=incident shows only</td>
</tr>
<tr>
<td></td>
<td>the reports created on the incident table.</td>
</tr>
<tr>
<td>jvar_list_order_by</td>
<td>Sorts the list on one of these columns:</td>
</tr>
<tr>
<td></td>
<td>- type</td>
</tr>
<tr>
<td></td>
<td>- title</td>
</tr>
<tr>
<td></td>
<td>- table</td>
</tr>
<tr>
<td></td>
<td>- modificationDate</td>
</tr>
<tr>
<td></td>
<td>- scheduled</td>
</tr>
<tr>
<td></td>
<td>- published</td>
</tr>
<tr>
<td></td>
<td>- createdBy</td>
</tr>
<tr>
<td></td>
<td>For example <a href="https://yourbusiness.service-now.com/report_home.do">https://yourbusiness.service-now.com/report_home.do</a>?</td>
</tr>
<tr>
<td></td>
<td>jvar_list_order_by=table returns the list</td>
</tr>
<tr>
<td></td>
<td>sorted by the source table of the report.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Use jvar_list_sort_direction to specify ascending or descending order.</td>
</tr>
<tr>
<td>jvar_list_sort_direction</td>
<td>Specifies the direction of the sort.</td>
</tr>
<tr>
<td></td>
<td>- asc — Sorts the list in ascending order</td>
</tr>
<tr>
<td></td>
<td>- desc — Sorts the list in descending order</td>
</tr>
<tr>
<td>sysparm_reportquery</td>
<td>Filters the reports with names that contain the specified value, for example:</td>
</tr>
<tr>
<td></td>
<td>sysparm_reportquery=Active returns reports with the string Active in the title.</td>
</tr>
<tr>
<td>jvar_search_created_by</td>
<td>the user who has created the report for example:</td>
</tr>
<tr>
<td></td>
<td><a href="https://yourbusiness.service-now.com/report_home.do">https://yourbusiness.service-now.com/report_home.do</a>?</td>
</tr>
<tr>
<td></td>
<td>jvar_selected_tab=allReports&amp;jvar_search_created_by=itil returns the reports</td>
</tr>
<tr>
<td></td>
<td>created by the user with user name itil.</td>
</tr>
</tbody>
</table>
### Copy a report

Copying a report enables users who cannot create their own global reports to modify a global report, and then save a personal version of the report.

**Role required:** itil, report_user, report_group, report_global, report_admin, or admin.

If you save a global report as a group or personal report, the platform copies the report rather than changing its security state.

**Note:** If you open a personal report and try to save it as a group or global report, security state is changed rather than copying the report.

1. Navigate to **Reports > View / Run**.
2. Click the arrow next to **Save**.
3. Select **Insert and Stay**. Creates a copy of the report that you can modify.
4. Modify the report. See [Creating reports](#).
5. Optional: Change the report visibility. In the upper right side of the report form, click the **Sharing** icon ( ) and select **Share**.

### Delete a report

Delete reports that are no longer used.

You must be the creator, an administrator, or have a managing role of a report to delete it. If a report has been shared with you, and you do not have a report managing role, you do not have the ability to delete it.

1. Navigate to **Reports > View / Run**.
2. Select the report to delete.
3. When the report opens, click the Delete icon (\(\text{Delete}\)). If you are using the Report Builder, click the arrow next to the Save button and select Delete.

4. Confirm that you want to delete the report.

The selected report is removed, and is no longer available to share, publish, or view.

**Report Designer keyboard shortcuts**

Keyboard shortcuts enable you to perform certain functions in the Report Designer without using your mouse.

You can use the following keyboard shortcuts.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run the current report</td>
<td>Control + Alt (Option) + R</td>
</tr>
<tr>
<td>Save the current report</td>
<td>Control + Alt (Option) + S</td>
</tr>
<tr>
<td>Delete the current report</td>
<td>Control + Alt (Option) + D</td>
</tr>
<tr>
<td>Opens the Data tab</td>
<td>Control + Alt (Option) + 1</td>
</tr>
<tr>
<td>Open the Sharing menu</td>
<td>Control + Alt (Option) + H</td>
</tr>
<tr>
<td>Display the Report info panel</td>
<td>Control + Alt (Option) + N</td>
</tr>
</tbody>
</table>

**Distribute reports**

Distribute reports to provide business information to other users.

Watch the following video for an overview of distributing reports.

**Report access control**

You can control who sees reports by applying a security state. You can make reports that are:

- Globally visible to all users
- Visible only to you if you are the report creator.
- Visible to one or more specific roles
- Visible to one or more specific users or groups

Sharing by user, group, or role, is the primary method of sharing reports. You can use access control lists (ACLs) to control access to the underlying table or database view data. Users are able to view reports when the user does not have access rights to a data record in a data source or source table of a report. However, they are not able to see that record in a list view or in a drill-down view. Database-view-list reports require the reporting user to satisfy ACLs on the target data to view records in the list. Users without sufficient permissions see filtered list reports.

**Note:** ACLs for a table do not propagate to database views based on that table. Database views require separate ACLs.

Reports that present aggregate data, such as pie or bar reports, do not require the user to satisfy target table ACLs to view the report. ACLs are required to view the list of records when you select...
a portion of a report visualization. When you have access to a report but not to some of its records, you do not see those records in a drill-down list or in a list view of the data in the report. However, they are included in visualizations of data.

If a user saves a global report as a group or personal report, the platform copies the report rather than changing its security state. Copying the report enables users who cannot create their own global reports to modify a global report, and then save a personal version of the report.

If a user opens a personal report and tries to save it as a group or global report, the security state is changed rather than copying the report.

**Share a report – Report Designer**

Control which users and groups can see a report in their Reports list.

**Role required:**

The following roles can share reports:

<table>
<thead>
<tr>
<th>Role</th>
<th>Report sharing permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>report_admin</td>
<td>Can share a report that is shared with the user, any group, or everyone. This role can share with:</td>
</tr>
<tr>
<td></td>
<td>• any user</td>
</tr>
<tr>
<td></td>
<td>• any group</td>
</tr>
<tr>
<td></td>
<td>• everyone</td>
</tr>
<tr>
<td>report_global</td>
<td>• Can share a report that is shared with everyone. This role can share with everyone.</td>
</tr>
<tr>
<td></td>
<td>• Cannot share a report that is shared with the user or a group</td>
</tr>
<tr>
<td>report_group</td>
<td>• Can share a report that is shared with the user, or a report shared with a group the user belongs to.</td>
</tr>
<tr>
<td></td>
<td>• any user</td>
</tr>
<tr>
<td></td>
<td>• any group</td>
</tr>
<tr>
<td></td>
<td>• Cannot share a report that is shared with everyone, or with a group the user does not belong to.</td>
</tr>
<tr>
<td>report_publisher</td>
<td>No sharing permissions.</td>
</tr>
<tr>
<td>report_scheduler</td>
<td>No sharing permissions.</td>
</tr>
<tr>
<td>report_user</td>
<td>No sharing permissions.</td>
</tr>
</tbody>
</table>

You can control who sees reports by making them:

- Globally visible to all users
- Visible only to you if you are the report creator.
- Visible to one or more specific users
- Visible to one or more specific groups

**Note:** The permissions of a report can constrain the number of users or groups you can share a report with. For more information, see [Restrict report creation with an ACL rule](#).

1. Navigate to **Reports > View / Run** and select the report you want to control.
2. In the upper right side of the report form, click the Sharing icon ( ) and select Share.

3. In the Sharing settings dialog box, fill in the fields and click OK.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible to</td>
<td>Users to whom the report is available. You can select the following options:</td>
</tr>
<tr>
<td></td>
<td>• Me Only you can view the report. This option is only available to you on reports that you created.</td>
</tr>
<tr>
<td></td>
<td>• Everyone All users can view the report. If roles are selected from the Roles field and added to the Role required list, only users with those roles can view the report.</td>
</tr>
<tr>
<td></td>
<td>• Groups and Users Only specific groups and users can see the report. The Groups and Users option is visible to users with the report_group role.</td>
</tr>
<tr>
<td></td>
<td>Groups whose members are authorized to see the report. This field is available when the Groups and Users option is selected.</td>
</tr>
<tr>
<td></td>
<td>Users who are authorized to see the report. This field is available when the Groups and Users option is selected.</td>
</tr>
</tbody>
</table>

4. Click the Sharing icon ( ) and select Add to Dashboard or Publish.

5. Share the dashboard or share the URL of the published report with the user, role, or group with whom you have shared the report.

The people with whom you share the report must have rights to view the report data.

**Automate report distribution**

Schedule a report to automate its distribution. Scheduled reports can be distributed in PDF, CSV, or XLS format. Graphical reports can be distributed in PNG or PDF format. Multilevel pivot reports can only be scheduled in PDF format.

Role required: To create scheduled reports, you must have both the report_user role and either the report_admin or report_scheduler role.

**Note:** It is not possible to schedule Calendar, Map, Pivot Table, and Single Score reports.

1. Navigate to Reports > View / Run.
2. Click a report to be scheduled for distribution.
3. In the Report Designer, click the Sharing icon ( ) and select Schedule.

In the Report Builder, click the down arrow next to the Save button and select Schedule.

4. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the scheduled report. The default name is based on the name of the underlying report.</td>
</tr>
<tr>
<td>Report</td>
<td>The report to schedule. This field is filled in by default. To send a report as a URL instead of as an image, clear this field and include the report URL in the Introductory Message field.</td>
</tr>
<tr>
<td>Users</td>
<td>Individual recipients of the report. To receive reports, users must have an email address defined and have Notifications set to Enable in their user records.</td>
</tr>
<tr>
<td>Groups</td>
<td>Group recipients of the report.</td>
</tr>
<tr>
<td>Email addresses</td>
<td>Email addresses of report recipients who are not in the system.</td>
</tr>
<tr>
<td>Active</td>
<td>Check box that enables (selected) or disables (cleared) scheduling for the report.</td>
</tr>
<tr>
<td>Run</td>
<td>Frequency for generating the report.</td>
</tr>
<tr>
<td>Time</td>
<td>Time of day to generate the report.</td>
</tr>
<tr>
<td>Conditional</td>
<td>Check box that shows (selected) or hides (cleared) the Condition field, which lets you specify the conditions under which the report is generated.</td>
</tr>
<tr>
<td>Omit if no records</td>
<td>Check box that prevents (selected) or allows (cleared) the distribution of empty reports.</td>
</tr>
<tr>
<td>Condition</td>
<td>User-created script that checks for certain conditions to be true before generating reports. This field is visible only when Conditional is selected.</td>
</tr>
<tr>
<td>Subject</td>
<td>Text that appears in the subject line of the distribution email.</td>
</tr>
<tr>
<td>Introductory message</td>
<td>Additional message that is delivered with the report.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Report output type. Graphical reports are sent as PNG or PDF files, and list reports are sent as PDF files. When scheduling a graphical report to be emailed, select output type PDF or PDF-landscape to include the chart grid data. When scheduling a data report, select output type Excel or CSV.</td>
</tr>
<tr>
<td>Zip output</td>
<td>Check box to send the report as a zip file.</td>
</tr>
<tr>
<td>Include with</td>
<td>Additional scheduled report to send.</td>
</tr>
<tr>
<td>Page size (Multilevel pivot report only)</td>
<td>Select from A3, A4, Letter, or Legal size. To specify the dimensions for a different paper size, select Custom and enter the Page height and Page width in pixels.</td>
</tr>
<tr>
<td>Page height (in pixels) (Multilevel pivot report only)</td>
<td>Shows when Page size is set to Custom. For non-standard paper sizes, multiply the page height in inches by 72 and enter the value in this field.</td>
</tr>
<tr>
<td>Page width (in pixels) (Multilevel pivot report only)</td>
<td>Shows when Page size is set to Custom. For non-standard paper sizes, multiply the page width in inches by 72 and enter the value in this field.</td>
</tr>
</tbody>
</table>

5. Click Submit.
6. Optional: Use the Included in Email related list to create additional scheduled reports.

Each report you add to the Included in Email related list must have its own schedule. By specifying a schedule for each report, you can send different reports to recipients of the previously identified reports, each with its own schedule.

To unschedule a report:
1. Navigate to Reports > Scheduled reports.
2. Select the entry.
3. Choose Delete from Actions on selected rows.

This action only deletes the report schedule, not the report itself.

Report output formats

You can export reports in certain output formats. You can schedule these reports for regular export.
Report output formats

<table>
<thead>
<tr>
<th>Report format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>Generate a PDF in portrait or landscape orientation. PDF reports include the chart grid data. Map reports cannot be exported to PDF format.</td>
</tr>
<tr>
<td>Note: To export <strong>Multi-level pivot tables</strong> to PDF, you must enable the Webkit HTML to PDF (com.snc.whtp) plugin.</td>
<td></td>
</tr>
<tr>
<td>Excel</td>
<td>Report visualization shows as a Microsoft Excel (XLS) spreadsheet.</td>
</tr>
<tr>
<td>PNG</td>
<td>Report visualization shows as a Portable Network Graphic (PNG) file.</td>
</tr>
<tr>
<td>CSV</td>
<td>Report visualization shows as a comma-separated value (CSV) plain-text file.</td>
</tr>
</tbody>
</table>

Publish a report

Publish a report to create a URL that anyone can use to access the report, including people who are not users. When anyone navigates to the URL, the report is generated with current data from the instance. Reports are available until they are unpublished.

Role required: both the report_publisher and report_user, report_admin, or admin

There are limitations to what users see when they follow the publish URL for a report:

- Data that is visualized as a graphic report and not limited by business rules is always visible in published reports. Graphic reports are all reports except for list reports.
- Read ACLs govern the content of list reports. Users cannot see records for which they do not have access.

Users with the admin or report_admin role can see if a report has been published. Navigate to

**Reports > View / Run**, open the report, and click the Sharing icon ( ). If the Sharing menu has the Publish option, the report is not yet published. If the Sharing menu has the Unpublish option, the report has been published.

**Note:** To make a report available only to logged in users, set its Sharing setting to Everyone, but do not publish it.

1. Navigate to **Reports > View / Run**.
2. Click the report you want to publish.
3. In the upper right side of the report form, click the Sharing icon ( ) and select **Publish**.

A link icon ( ) shows with the Report option icons message. Click this icon to show a link to the published report. This link is available as long as the report is published.
Note: Business rules may affect how records are collected for public reports.

Unpublish a report

Published reports are available at the published URL until you unpublish them.

Role required: both the report_publisher and report_user, report_admin, or admin

1. Navigate to Reports > View / Run.
2. Select the report you want to unpublish.
3. From the upper right side of the report form, click the Sharing icon ( ) and select Unpublish.

The report is no longer published and the link icon ( ) is removed from the report designer for the unpublished report.

Add a report to a dashboard or homepage

Make actionable decisions faster by combining relevant reports and widgets onto a dashboard or a homepage. Navigating to single reports and widgets is time-consuming and less efficient.

Role required: Any user who can create a report can add it to a responsive dashboard or a homepage.

To add a report to a non-responsive dashboard, one of the following roles is required: itil, report_user, report_global, report_group, report_admin, pa_power_user.

Note: It is recommended to add a report to a dashboard. Homepages have more restrictive layouts and permission structures than dashboards. For more information, see Differences between homepages and responsive and non-responsive dashboards.

1. Click the Settings icon.
2. Select the General tab.
3. Under Home, select **Dashboards** or **Homepages**.

4. Navigate to **Reports > View/Run**.

5. Select a report.

6. Click the **Sharing** icon ( ) and select **Add to Dashboard**.

7. Select if you want to add the report to a **Homepage** or **Dashboard** (default).

8. Based on your selection, perform one of the following actions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard</td>
<td>Select the <strong>Dashboard</strong> and <strong>Tab</strong> to add the report to.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Homepage</td>
<td>1. Select the <strong>Homepage</strong> to add the report to.</td>
</tr>
<tr>
<td></td>
<td>2. For non-responsive homepages, click <strong>Add here</strong> to add the report in a specific position, or click <strong>Add</strong> to add the report to the first available position on the homepage.</td>
</tr>
</tbody>
</table>

9. If you selected a dashboard to add the report to, perform the applicable action:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>for responsive dashboards</strong></td>
<td>Click <strong>Add</strong>. The widget is added to the dashboard in the top position and the dashboard opens. Click <strong>Edit</strong> to move or resize the widget.</td>
</tr>
<tr>
<td><strong>for non-responsive dashboards</strong></td>
<td>Click <strong>Add here</strong> to add the report in a specific position, or click <strong>Add</strong> to add the report to the first available position on the homepage or dashboard.</td>
</tr>
</tbody>
</table>

**Reports on Service Portal**

Show reports using Service Portal.

When you edit a portal, add the **Report** widget. Use the widget options to specify a report to show on the service portal and whether to show the title of the report.
ServiceNow Madrid Analytics, Intelligence, and Reporting

Report widget

With the report widget, you can show all report types on your portal except for list reports. Use the Simple List widget instead.

Activate the Performance Analytics and Reporting — Service Portal Widgets plugin

You can activate the Performance Analytics and Reporting - Service Portal Widgets plugin (com.snc.pa.sp.widget) if you have the admin role. This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

The Service Portal Widget plugin activates these related plugins if they are not already active.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Portal (com.glide.service-portal)</td>
<td>Core Service Portal functionality.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Definition > Plugins**.

A banner appears to notify you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.
2. Find the plugin with the filter criteria and search bar.

You can search for the plugin by its name or ID.

If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in Request a plugin.

3. Activate the plugin.

You can activate the plugin directly from the All Applications page or view more details about the plugin before activating it.

- If you are certain that you have the correct plugin, click Install, and then click Activate in the dialog box that appears.

- To view plugin details before activation:
  
  1. Click the plugin name.
  2. On the form, click the Activate/Update related link.
  3. On the dialog box that appears, review the dependent plugins.
  
     If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.
  4. If demo data is available and you want to install it, click Load demo data.

     Some plugins include demo data, which are sample records that illustrate plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking Load demo data only on the plugin form.
5. Click **Activate**.

**PDF page header footer templates**

Administrators and report owners can create header and footer templates for reports exported as PDFs.

A default PDF page header footer template appears on all PDF exports that do not specify a custom header footer template. PDF page header footer templates are saved independently from reports. All header and footer text uses 8-point Helvetica bold font. A PDF page header footer template is made of multiple cells containing report attributes or user-specified content.

The default PDF page header footer template appears on all reports, as well as exports from lists, unless you define a specific template for that report. You can modify the default template but you cannot delete it. In the default template, the header shows the report **Title** and the page number in the format **Page X**. The footer shows the report **Run by** field and the report run time and date.

**Create a header footer template for reports exported to PDF**

A PDF page header footer template defines the page header and footer layout for PDF files exported from your instance.

Role required: report_admin or admin

The header and footer each have three cells: Left, Middle, and Right. To leave a cell blank, select **Empty**.

1. Navigate to **Reports > Header Footer Templates**.
2. Click **New**.
3. Enter a **Name** for the template.
4. Select the content option for each header and footer cell, and enter or upload content as appropriate.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page number of the PDF</td>
<td>Page number in either the Page X format or Page X of Y format.</td>
</tr>
<tr>
<td>Report Title</td>
<td>Title of the report.</td>
</tr>
<tr>
<td>Run by</td>
<td>Name of the user who ran the report.</td>
</tr>
<tr>
<td>Run Date and Time</td>
<td>Date and time the report ran.</td>
</tr>
<tr>
<td>User Specified Text</td>
<td>User-defined message. Messages are truncated at 150 characters.</td>
</tr>
<tr>
<td>Image</td>
<td>User-specified. Upload a new image when selecting image content. Images are scaled to fit the space available in the template cell.</td>
</tr>
</tbody>
</table>

5. Click **Submit**.
Creating reports

Learn about different types of reports you can create, and when and how to create them.

Differences between Report Builder and Report Designer

The Report Designer provides a guided flow for report creation. Selection of the data source, selection of the report type, configuration, and styling of the report are presented on successive tabs. The Report Builder provides most report creation functionality in a single panel.

Using the Report Designer, users can configure a report, preview it, iterate and adjust, then share it using the integrated Share panel.

The older Report Builder provides functionality for naming, selection of the data source, and configuration on one page. Style option selection is provided in a pop-up.

The Report Designer supports imported data sources and MetricBase Time Series reports, but the Report Builder does not. See Using imported report data.

Report types

You can generate the following types of reports, organized by category:

- **Bar reports** enable you to compare scores across data dimensions.
- **Proportional reports** visualize the relationship between the parts and the whole of a data set using other shapes such as pies and pyramids.
- **Time Series reports** visualize data over time. In addition to data from within your instances and imported data sources, you can also use MetricBase data in time series reports. For more information, see MetricBase application.
- **Multidimensional reports** visualize data across dimensions in a single table or graph.
- **Scores** visualize single data points either across ranges or as a single value.
- **Statistical reports** visualize data with statistical values such as medians and means.
- **Other reports** include calendars, maps, and lists.

### Bar reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bar</strong></td>
<td>Shows vertical bars with lengths proportional to the values that they represent.</td>
</tr>
<tr>
<td><strong>Horizontal bar</strong></td>
<td>Shows horizontal bars with lengths proportional to the values that they represent.</td>
</tr>
<tr>
<td><strong>Pareto</strong></td>
<td>Combines bar and line reports to identify the most important factors in a large set of factors.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Histogram</strong></td>
<td>Provides visual interpretation of numerical data by indicating the number of data points that lie within a range of values.</td>
</tr>
</tbody>
</table>

**Other proportional reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pie</strong></td>
<td>Shows how individual pieces of data relate to the whole using a circle to represent the whole.</td>
</tr>
<tr>
<td><strong>Donut</strong></td>
<td>Shows how individual pieces of data relate to the whole using a donut shape to represent the whole.</td>
</tr>
<tr>
<td><strong>Semi-donut</strong></td>
<td>Shows how individual pieces of data relate to the whole using a semi-donut shape to represent the whole. A semi-donut report uses a donut sliced in half to represent the whole.</td>
</tr>
<tr>
<td><strong>Funnel</strong></td>
<td>Displays values as progressively decreasing proportions. The size of each section reflects a percentage of the total of all values. (Found in the Other reports section.)</td>
</tr>
<tr>
<td><strong>Pyramid</strong></td>
<td>Visualizes a variation on a bar report using pyramid sections instead of rectangles. (Found in the Other reports section.)</td>
</tr>
</tbody>
</table>

**Time series reports**

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column</strong></td>
<td>Shows how one or more values change over time by displaying them as proportional vertical columns.</td>
</tr>
<tr>
<td><strong>Line</strong></td>
<td>Shows how one or more values change over time by connecting a series of data points with straight lines.</td>
</tr>
<tr>
<td><strong>Step line</strong></td>
<td>Shows how one or more values change over time by connecting a series of data points with horizontal and vertical lines.</td>
</tr>
<tr>
<td>Report</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Area</td>
<td>Resembles a line chart, but the area between the axis and line is commonly emphasized with colors.</td>
</tr>
<tr>
<td>Spline</td>
<td>Shows how one or more values change over time by connecting a series of data points with a fitted curve through the data points. Spline reports let you take a limited set of known data points and approximate intervening values.</td>
</tr>
</tbody>
</table>

### Multidimensional reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multilevel pivot table</td>
<td>Displays aggregate data broken down by multiple metrics in a single chart.</td>
</tr>
<tr>
<td>Heatmap</td>
<td>Displays aggregate data in a matrix using colors to represent different values.</td>
</tr>
<tr>
<td>Bubble</td>
<td>Displays multiple metrics on a single chart.</td>
</tr>
</tbody>
</table>

### Scores

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a dial or speedometer report</td>
<td>Shows an overview of the count of an indicator at the current moment in the form of a round meter.</td>
</tr>
<tr>
<td>Dial</td>
<td>Shows an overview of the count of an indicator you want to measure at this moment in a half circle, where the part in which scores are shown is filled out with a color.</td>
</tr>
<tr>
<td>Single score</td>
<td>Displays a single aggregate value that is important to your business.</td>
</tr>
</tbody>
</table>
### Statistical analysis visualizations

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control</td>
<td>Displays data as a series of connected points to determine whether a business process is in a state of statistical control and to identify outliers. (Found in the Other reports section.)</td>
</tr>
<tr>
<td>Trend</td>
<td>Shows how the value of one or more items changes over time. Values along the horizontal axis of the trend report represent the time measurement. Values on the vertical axis represent the changes to the items being monitored. The trend line or curve reveals a general pattern of change. (Found in the Other reports section.)</td>
</tr>
<tr>
<td>Box</td>
<td>Shows the distribution of values in a data set highlighting statistical averages. (Found in the Other reports section.)</td>
</tr>
<tr>
<td>Trendbox</td>
<td>Shows the distribution of values in a data set highlighting statistical averages for a specified period of time. (Found in the Other reports section.)</td>
</tr>
</tbody>
</table>

### Other reports

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List</td>
<td>Displays data in the form of an expandable list, similar to a standard ServiceNow list.</td>
</tr>
<tr>
<td>Calendar</td>
<td>Displays data-driven events in a calendar format.</td>
</tr>
<tr>
<td>Map</td>
<td>Displays data on a geographical map image.</td>
</tr>
<tr>
<td>Pivot table</td>
<td>Aggregates data from a table to display the source of summarized data. This functionality is expanded in multilevel pivot reports.</td>
</tr>
</tbody>
</table>
Area and spline reports

Area reports show trends over time for related attributes. Spline reports show how one or more values change over time by connecting a series of known data points with a curve that emphasizes the trend over individual data points.

For example, you can create an area or spline reports for incident counts, to show how the number of incidents changes over time. The incident count often increases during the first few months after a product upgrade is deployed. Over time, the number of reported incidents decreases as users become more accustomed to the changes in the product.
Area reports

Note:
When the sections of an area report with multiple datasets overlap, it is not possible to drill down into the various sections. To drill down, click items in the legend to clear them from the report.
Create an area or spline report

Area and spline reports show trends over time for related attributes.

Create an area or spline report with the Report Designer

Create an area or spline report to show trends over time for related attributes.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
</tbody>
</table>

**Note:** If you select a data source used by existing reports, a notification will display prompting you to view them.

Table | The raw data from a table with no filters applied.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. On the **Type** tab, enter **Area** or **Spline** in the filter, select the report type, and click **Next**.
   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.
6. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see How to report on extended tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| per   | Time period to group data by. Time periods range from an hour to a year. You can also specify a date.  

**Note:** Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years. |

| Aggregation | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.  

To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.

Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.

If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See **How to report on extended tables**.  

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage calculation</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when Aggregation is set to Average, Sum, or Count Distinct.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Use Aggregation calculates the percentage using the selection in the Aggregation field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the Aggregation set to Sum and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Use Record Count calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the Low priority section is 40%.</td>
<td></td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon ( ), and select Add Sort.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click + to configure additional sorting order conditions. (Click - to delete configured sorting order conditions.)

3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
   For more details on how conditions are constructed, see [Condition builder](#).

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click **Save**.
   The report is generated.

   - Click the Report info icon (📝) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Area and spline report style options**

Change the look of your area or spline report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

### Area and spline report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Chart color    | Colors used in the report. If you do not group or stack the report, Use one color is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:  
- **Use color palette**: Select a color palette from the predefined system color palettes.  
- **Use several colors**: Define a custom set of Colors using hex codes. You can add any number of colors.  
- **Use chart colors**: Use the colors defined in Reports > Chart Colors.  |
| Set color      | Color used in the report. This field displays when you select Use one color from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list. |
| Colors         | Colors used in the report. This field displays when you select Use several colors from the Chart color list. |
| Set palette    | Color palette used in the report. This field appears when you select Use color palette from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list. |
| Display data labels | Check box to show the value for each data point.                        |

**Note:** It is not possible to use transparency hex values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not plot nil as zero</td>
<td>Check box to specify whether to replace missing data points with values of zero. This field is available when creating or editing time series reports (area, spline, line, and step line reports only) that include multiple datasets, and when creating or editing datasets within the applicable time series reports. This field is not available when data in the report is aggregated by Count or Count Distinct. If selected, the report may show gaps where no data exists.</td>
</tr>
<tr>
<td>Show marker</td>
<td>Check box to show a symbol at each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
</tbody>
</table>

**Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See Access control rules.

For more information, see Define a report drilldown in the Report Designer.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show chart title              | When the chart title is shown for the report.                                                                                       | • Never: Never show the chart title.  
• Report only: Shows the chart title on reports.  
• Always: Shows the chart title on reports, dashboards, and homepages.                                                                                       |
<p>| Chart title                   | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.                                                                                                             |
| Size of the chart title       | Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.                                                                                     |
| Chart title color             | Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.                                                                                       |
| Custom chart title position   | Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.                                                                                                             |
| Title horizontal alignment    | How the chart title is aligned horizontally. This field is available when Custom chart title position is cleared.                                                                                                                                         |
| Title vertical alignment      | How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.                                                                                                                                                                                                                                                          |
| Chart title X position        | Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.                                                                 |
| Chart title Y position        | Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.                                                                 |
| Legend                        | Check box to show a chart legend. This check box appears when a Group by field is selected on the report form.                                                                                                                                                                                                                                                                                                                                                           |
| Show legend                   |                                                                                                                                   | How the legend is aligned horizontally. This field appears when Show legend is selected.                                                                                                                                                                                                                                                                                  |
| Legend horizontal alignment   | How the legend is aligned vertically. This field appears when Show legend is selected.                                                                                                              |
| Legend vertical alignment     | How the legend is aligned vertically. This field appears when Show legend is selected.                                                                                                              |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
</tbody>
</table>

**Axis**

<table>
<thead>
<tr>
<th>Y axis and X axis</th>
<th>Axis to configure the titles, appearance, and labels for.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report. On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
</tbody>
</table>

**From**

Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type **Number**, the From and To fields are not available.

**Note:** Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.

**To**

Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type **Number**, the From and To fields are not available.

**Note:** Depending on configured Highcharts settings, the maximum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X axis / Y axis label size</td>
<td>On the X axis tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**Bar and horizontal bar reports**

Use bar reports to compare individual or aggregate scores across data dimensions. You can create bar and horizontal bar reports. Bar report columns originate on the x-axis and horizontal bar report columns originate on the y-axis.

Bar reports display data in either a horizontal or vertical bar format with each bar representing a specific category of data. A bar report can use a single color to represent all categories of data, or a different color for each category.

The following figure shows an example of a bar report that displays discrete categories of data. The report includes data from the Incident (incident) table for all incidents recorded up until the time that the report is generated.
Bar report

You can configure the bar report to stack data or change the measurement units of the bars. Stacked bar reports show the parts that contribute to the total. The following figure shows a bar report with the number of incidents that are assigned to each user. It is also stacked to display how many of the incidents are from each incident category.
Create a bar report

Create a bar report that compares two or more values.

Create a bar report in the Report Designer

Bar reports enable you to show information in segments that are proportional to the values they represent.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Note: If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>
## ServiceNow Madrid Analytics, Intelligence, and Reporting

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>External Import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase application</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. On the **Type** tab, enter **Bar** or **Horizontal bar** in the filter, select the report type, and click **Next**. A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group by</strong></td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to ( \text{Software, Service Desk, and Network} ) are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
</tbody>
</table>

**Note:** It is not possible to group or stack reports by the **Tags** field.

| **Additional group by**      | Extra fields to group the report by. When you select **Additional group by** fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see [How to report on extended tables](#). |

**Note:** It is not possible to group or stack reports by the **Tags** field.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack by</td>
<td>Divide each bar using values of this field. To stack by fields on extended tables, see <a href="#">How to report on extended tables</a>. Note: It is not possible to group or stack reports by the Tags field.</td>
</tr>
<tr>
<td></td>
<td>On a bar chart of incidents sorted by Category and stacked by Priority, a user sees the proportion of high, medium, and low priority issues for each category. Select stacked fields carefully to avoid cluttering the report. Sometimes it is a better practice to create another report that shows these relationships rather than stack too much data. Bar charts display a legend only when a stacked field is selected. Boolean, reference, and choice lists can be used as stacked fields. Date, date/time, integer, long, string, and text fields cannot be used as stacked fields. Note: Date types are not allowed starting with the introduction of the Report Charting v2 plugin.</td>
</tr>
<tr>
<td></td>
<td>You can choose to display the stacked field either in a single bar or as a group of bars. If you select a Group by field on the report form, you can choose to visualize the bars as Grouped bars. In this case, bars are displayed next to one another per the Group by field (for example, the state of the incident), instead of stacked. If you choose fields with Additional group by, these fields are also available in a Stacked by control at the bottom of the report.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Aggregation           | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected. To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**. Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number. If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#).  

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized. |
| Percentage calculation | Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when **Aggregation** is set to **Average**, **Sum**, or **Count Distinct**.  

- **Use Aggregation** calculates the percentage using the selection in the **Aggregation** field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the **Aggregation** set to **Sum** and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.  

- **Use Record Count** calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the Low priority section is 40%. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (.expand_more) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click **+** to configure additional sorting order conditions. (Click **-** to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔧) and select conditions to filter the report data.
For more details on how conditions are constructed, see [Condition builder](#).

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click **Save**.
The report is generated.

   •
   
   Click the Report info icon (📝) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Bar report style options**
Change the look of your bar report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Field | Description
--- | ---
**General** | Colors used in the report.
**Chart color** | If you do not group or stack the report, **Use one color** is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:
- **Use color palette**: Select a color palette from the predefined system color palettes.
- **Use several colors**: Define a custom set of Colors using hex codes. You can add any number of colors.
- **Use chart colors**: Use the colors defined in Reports > Chart Colors.

> **Note**: It is not possible to use transparency hex values.

**Set color** | Color used in the report. This field displays when you select **Use one color** from the **Chart color** list.

Click the search icon ( ) to choose from the **Chart color schemes** or **Color Definitions** list.

**Set palette** | Color palette used in the report. This field appears when you select **Use color palette** from the **Chart color** list.

**Display data labels** | Select to display the current value for each bar. This field is available when you select None from the **Stacked by** list or if there is no **Stacked by** list.

- Select **Data labels in the middle** to show the labels in the middle of each bar.
- Select **Allow data labels to overlap** to override default separation of labels in the visualization.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored. <strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules. For more information, see Define a report drilldown in the Report Designer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.

[Chart image showing average resolution count with labels Open = 0.713 (21.79%) and Closed/Resolved = 1.01]
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the title to the right, enter a positive value. To move the title to the left, enter a negative value.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on configured Highcharts settings, the maximum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the X axis tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**Box reports**

Box reports, also called box plots, visualize the distribution of data including the maximum, minimum, quartiles, median, and mean.

Use box charts to report multiple data sets from different sources that are related to each other.

For example, use a box chart to view the age range of all customers who attended a convention. The box chart helps you determine where most ages are grouped. With this information, you can attempt to increase attendance levels at future events by targeting advertisements at the age groups that had lower attendance levels.
Box chart

A box chart displays the following information for each group of data:
Box chart scale

1. Sample maximum
2. Upper quartile
3. Median
4. Mean
5. Lower quartile
6. Sample minimum

Note: When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see Enabling accessibility features.

Create a box report

Box reports enable you to show data organised by statistical averages.

Create a box report in the Report Designer
Create a box report to show the distribution of values in a data set.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (擤) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
</tbody>
</table>
### MetricBase

MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see [MetricBase application](#).

---

4. Click **Next**.
5. On the **Type** tab, enter **Box** in the filter, select the report type, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.
6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Note:</td>
<td>Label names longer than 20 characters may show or print a truncated view.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Measured by</td>
<td>Field to use as a measurement for the data. Date and time fields are not supported for box charts.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

   1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, ...
or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click (+) to configure additional sorting order conditions. (Click (-) to delete configured sorting order conditions.)

3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority choice list is often indexed from Critical to Planning as shown in the figure below.

Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see Condition builder.
9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.

    The report is generated.

- Click the Report info icon ( ) and add a description of the report.

- Click the sharing icon ( ) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Box report style options**

Configure the look of your box report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td><strong>Custom chart size</strong> Check box to specify the width and height of the report in pixels. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td><strong>Chart width</strong></td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td><strong>Chart height</strong></td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td><strong>Chart size</strong></td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>. <strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
</tbody>
</table>
| Display grid  | On the **X axis** tab, select this check box to show horizontal grid lines on the report.  
                      On the **Y axis** tab, select this check box to show vertical grid lines on top the report. |
| Grid dotted   | Check this box to show dotted grid lines instead of solid lines.                                                                                          |
| From          | Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type **Number**, the **From** and **To** fields are not available. |
| To            | Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type **Number**, the **From** and **To** fields are not available. |
| X axis / Y axis label size | On the **X axis** tab, specify the size of the labels for the rows of the report.  
                      On the **Y axis** tab, specify the size of the labels for the columns in the report.              |
| Label bold    | Check this box to show the labels of the report in a bold typeface.                                                                                     |

**Bubble reports**  
Bubble reports plot data points on X and Y axes and use a third aggregate dimension to define bubble size.  
Bubble reports can use numeric values to define the X and Y axes, and an aggregate value to determine the size of each bubble.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see [Enabling accessibility features](#).
For example, when using Demand Management you can create a bubble report on the Demand table to compare risk and reward for various demands. Each bubble represents one demand. The risk and financial return determine the position of each bubble, while the total financial benefit for the demand determines the bubble size. You can quickly identify demands with low risk and high reward using the large bubbles in the top left of the report.
Create a bubble report

Create a bubble report to aggregate information over three different metrics, using the X axis, Y axis, and bubble size.

Create a bubble report in the Report Designer
Create a bubble report to display multiple separate metrics on a single chart.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

<table>
<thead>
<tr>
<th>Report Designer UI</th>
<th>Report Builder UI</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Report Designer UI" /></td>
<td><img src="image2.png" alt="Report Builder UI" /></td>
</tr>
</tbody>
</table>

1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Bubble** in the filter, select the report type, and click **Next**. A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Field to group data by. Each value is represented by a unique bubble color on the chart. <strong>Note:</strong> It is not possible to group or stack reports by the Tags field.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select Additional group by fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see How to report on extended tables. <strong>Note:</strong> It is not possible to group or stack reports by the Tags field.</td>
</tr>
<tr>
<td>Row</td>
<td>Numeric field to use as the Y axis.</td>
</tr>
<tr>
<td>Column</td>
<td>Numeric field to use as the X axis.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident <strong>Table</strong>, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number. If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. Note: For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</td>
</tr>
</tbody>
</table>

#### 7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the **Sorting Order** drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click 🔄 to configure additional sorting order conditions. (Click ✖️ to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type **Choice list**, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. For more details on how conditions are constructed, see Condition builder.

Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save.

The report is generated.

Click the Report info icon (🔍) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Bubble report style options**
Change the look of your bubble report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Bubble report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.

For more information, see Define a report drilldown in the Report Designer.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show chart title              | When the chart title is shown for the report.  
  - **Never**: Never show the chart title.  
  - **Report only**: Shows the chart title on reports.  
  - **Always**: Shows the chart title on reports, dashboards, and homepages. |
| Chart title                   | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Size of the chart title       | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Chart title color             | Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Custom chart title position   | Check box to specify X and Y coordinates for the position of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Title horizontal alignment    | How the chart title is aligned horizontally. This field is available when **Custom chart title position** is cleared. |
| Title vertical alignment      | How the chart title is aligned vertically. This field appears when **Custom chart title position** is cleared. |
| Chart title X position        | Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value.  
  This field appears only when **Custom chart title position** is selected. |
| Chart title Y position        | Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value.  
  This field appears only when **Custom chart title position** is selected. |
<p>| Legend                        | Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. |
| Show legend                   | Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. |
| Legend horizontal alignment   | How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected. |
| Legend vertical alignment     | How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <em>Show legend</em> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <em>Show legend</em> is selected.</td>
</tr>
</tbody>
</table>

**Calendar reports**

Calendar reports display date-driven events on a calendar.
Calendar report

You can highlight calendar events by relevant criteria such as priority, status, or escalation. Events that have no end date have a duration of one hour.

Limitations

- Events that started more than 30 days before the first day visible on a calendar are not displayed on the calendar. For example, if you select Year, then the calendar includes events that start between December 1 of the previous year and December 31 of the current year.
- To view more or fewer days, edit the glide.report.calendar.max_days_back property from Reporting properties.
- **Note:** Performance may degrade if this value is too large.
- This report type cannot be run as a scheduled report.
Persistent highlighting of one selected criterion, for example, *Priority* can be set by an admin. See [Set persistent highlighting for a calendar criterion](#).

### Create a calendar report

Create a calendar report to show and highlight date-driven events.

*Create a calendar report in the Report Designer*

Create a calendar report to display date-driven events on a calendar.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to **Reports** > **Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, enter Calendar in the filter, select the report type, and click Next.
   A preliminary version of the report is displayed. To view the updated report at any time, click Run.
6. On the Configure tab, fill in the following fields and click Next.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event to display</td>
<td>The date-driven event to display on the calendar. This list contains fields that are in the date/time format in the data source or source table.</td>
</tr>
</tbody>
</table>

7. Optional: To limit the information displayed in the report, click the filter icon (▽) and select conditions to filter the report data.
   For more details on how conditions are constructed, see Condition builder.
   Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.
8. Click Save.
   The report is generated.
   Note: When there are more events on a date than fit in the calendar cell, a link is shown to view the additional events.
If there are more than thirty events, the cell shows + many. Click this link to show all the
events in a list view for that date.

- Click the Report info icon (i) and add a description of the report.
- Click the sharing icon (folder) to open the **Sharing** menu. On this menu, you can share the
report with users and groups, add the report to a dashboard, and publish the report to the
web.

### Disable new calendar reports

To use the version of calendars from releases prior to Helsinki, disable the new calendar version.
Reasons to use the old calendar include having scripts that are incompatible with the new
calendar and preference for the style of the older calendar. The updated calendar is also not
supported in Internet Explorer versions 7 and 8.

**Role required:** report_admin or admin

1. Navigate to **Reports > Administration > Properties**.
2. Add the `glide.report.new_calendar` system property, and set it to **false**.
   For help with adding this, see *Reporting properties*.

**Note:**

If this system property is set to true, it is supported only in the classic UI. Click **Switch to classic UI** in the report designer.

### Column reports

Column reports show how the value of one or more items changes over time by with columns.

Values along the horizontal axis of the column chart represent the time measurement (years,
hours, minutes, milliseconds, and so on). Values on the vertical axis represent the changes to the
items being monitored. Users with the report_admin role can define the ranges that are used in a
column chart report. See *Report ranges* for information on creating report ranges.

For example, you can create a column chart for incident counts, to show how the number of
incidents changes over time. The incident count often increases during the first few months after
a product upgrade is deployed. Over time, the number of reported incidents decreases as users
become more accustomed to the changes in the product.
The figure shows resolved incidents stacked by category with a legend that indicates which category the colors represent.

A grouped column chart shows the categories as individual bars, rather than stacked colors in a single bar.
Create a column report

Create a column report to show how the values of data elements change over time. 

Usage examples:

Create a column report in the Report Designer
Create a column report to show how the value of one or more data elements changes over time using vertical columns.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>
**Option** | **Description**
--- | ---
**External Import** | Choose an existing imported report source, or click the Upload icon ( ) to import a new file. See [Create a report from an imported Microsoft Excel document](#).

**MetricBase** | MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see [MetricBase application](#).

4. Click **Next**.
5. On the **Type** tab, enter **Column** in the filter, select the report type, and click **Next**.

A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group by</strong></td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
</tbody>
</table>

**Note:** It is not possible to group or stack reports by the **Tags** field.

| **Additional group by** | Extra fields to group the report by. When you select **Additional group by** fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see [How to report on extended tables](#). |

**Note:** It is not possible to group or stack reports by the **Tags** field.

<p>| <strong>Stacked bars / Grouped bars</strong> | How to show the relationship of individual items from the selected field to the whole. You can choose to display the stacked field either in a single bar or as a group of bars. Select <strong>Stacked bars</strong> to display the parts that contribute to the whole for each column in the chart. Select <strong>Grouped bars</strong> to display the parts that contribute to the whole as individual columns. Bars are displayed next to one another according to the <strong>Group by</strong> field (for example, the state of the incident), instead of stacked. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. Time periods range from an hour to a year. You can also specify a date.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use Count Distinct. Select Average, Sum, or Count Distinct, to show a list of fields from the selected Table. Select a field to Aggregate by from this list. For example, if you select a duration field, such as Business duration on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as Priority, the data is expressed as a decimal value number. If you choose Average, Sum, or Count Distinct, you may further be able to aggregate on fields from extended tables. See How to report on extended tables.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percentage calculation</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when Aggregation is set to Average, Sum, or Count Distinct.</td>
</tr>
<tr>
<td></td>
<td>· Use Aggregation calculates the percentage using the selection in the Aggregation field. Only data that is displayed in the report is used to calculate the percentage.</td>
</tr>
<tr>
<td></td>
<td>For example, a report shows assets by department with the Aggregation set to Sum and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.</td>
</tr>
<tr>
<td></td>
<td>· Use Record Count calculates the percentage using the total number of records in the data set.</td>
</tr>
<tr>
<td></td>
<td>For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the Low priority section is 40%.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon () and select Add Sort.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click + to configure additional sorting order conditions. (Click - to delete configured sorting order conditions.)

3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority...
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon ($filter icon$) and select conditions to filter the report data.
   
   For more details on how conditions are constructed, see $Condition builder$.

   $Note$: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the $Style$ tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click $Save$.

    The report is generated.

   $•$

   Click the Report info icon (report info icon) and add a description of the report.
Click the sharing icon (gp) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Column report style options**
Change the look of your column report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td><strong>Chart color</strong> - Colors used in the report. If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options: <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes. <strong>Use several colors</strong>: Define a custom set of <strong>Colors</strong> using hex codes. You can add any number of colors. <strong>Use chart colors</strong>: Use the colors defined in <strong>Reports &gt; Chart Colors</strong>. <strong>Note</strong>: It is not possible to use transparency hex values. <strong>Set color</strong> - Color used in the report. This field displays when you select <strong>Use one color</strong> from the <strong>Chart color</strong> list. Click the search icon (gp) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list. <strong>Set palette</strong> - Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the <strong>Chart color</strong> list. Click the search icon (gp) to choose from the <strong>Chart color schemes</strong> or <strong>Color Definitions</strong> list. <strong>Colors</strong> - Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the <strong>Chart color</strong> list.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Select to display the current value for each bar. This field is available when you select None from the Stack by list or if there is no Stack by list.</td>
</tr>
<tr>
<td></td>
<td>- Select Data labels in the middle to show the labels in the middle of each bar.</td>
</tr>
<tr>
<td></td>
<td>- Select Allow data labels to overlap to override default separation of labels in the visualization.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels. [Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.]</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large. [Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.]</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored. [Note: All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.]</td>
</tr>
</tbody>
</table>

For more information, see Define a report drilldown in the Report Designer.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td></td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a Group by field is selected on the report form.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td>Note:</td>
<td>Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td>Note:</td>
<td>Depending on configured Highcharts settings, the maximum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.  Adamantium.</td>
</tr>
</tbody>
</table>

**Control reports**

Control reports visualize data over time using standard deviations to show statistical likelihood and identify outliers.

Control reports display data as a series of connected points. The blue line at the center of the report is drawn at the mean. Upper and lower control limits, represented by red lines, indicate the thresholds at which activity is considered statistically unlikely. If the process is in control, all points are plotted within the control limits. You may want to investigate any activity outside these limits.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see [Enabling accessibility features](#).
Control report

**Note:** The mean is calculated by taking a sum of the data points on the Data Points line and dividing by the number of points. These values depend on the aggregation (Count, Average, Sum, or Count Distinct). This mean can differ from averages in other reports based on the same data if the other reports use different aggregations. For example, the mean number of incidents (Count) per month over a period is different from the mean Average duration of those same incidents.

Create a control report

Create a control chart to determine whether a business process is in a state of statistical control. 

Create a control report in the Report Designer

Create a control chart to determine whether a business process is in a state of statistical control.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Note</strong>: If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>External Import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase application</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Control** in the filter, select the report type, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend by</td>
<td>Table field whose values you want to show in a time sequence.</td>
</tr>
<tr>
<td>per</td>
<td>Time period to group data by. Time periods range from an hour to a year. You can also specify a date.</td>
</tr>
</tbody>
</table>

   **Note:** Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years.
### Field | Description
--- | ---
Aggregation | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.

To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.

Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.

If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#).

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click **»** to configure additional sorting order conditions. (Click **«** to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
For more details on how conditions are constructed, see Condition builder.

Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click Save to generate the report.

•

Click the Report info icon (🔍) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Control report style options
Change the look of your control report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See Access control rules.

For more information, see Define a report drilldown in the Report Designer.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report. On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report. On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**Dial and speedometer reports**

Dials and speedometers provide a real-time count for an indicator. These charts cannot contain comparison or historical data. You can configure colors to display at a glance that values are within specified ranges.

For example, red indicates unacceptable value ranges. A low value for monthly sales is worse than a high value, but a low value for incident resolution times is better than a high value. So you would configure red for low values in the report for monthly sales and red for high values in the report for incident resolution times.

Dials and speedometers also have different appearances:

- A speedometer shows numbers in the form of a round meter with a defined range.
- A dial shows where a score falls across ranges on a half-circle dial.
Angular speedometer report
Create a dial or speedometer report

Create a report that shows counts for an indicator with colors to indicate value ranges. Create a dial or speedometer report in the Report Designer
Create a dial or speedometer to provide a real-time count for an indicator.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see . MetricBase application</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Speedometer** or **Dial** in the filter, select the report type, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
   | Aggregation | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.  
                           To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.  
                           Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**.  
                           Select a field to **Aggregate by** from this list. For example, if you select an integer field, such as **Priority**, the data is expressed as a decimal value number.  
                           If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#).  

   **Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.

7. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

   For more details on how conditions are constructed, see [Condition builder](#).

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

8. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

9. Click **Save**.

   The report is generated.
Click the Report info icon ( ) and add a description of the report.

Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Dial and speedometer report style options
Change the look of your dial or speedometer report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

**Dial chart style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>A predefined system color for the dial.</td>
</tr>
<tr>
<td>Chart color (dial chart only)</td>
<td>Color used in the report. This field displays when you select Use one color from the Chart color list.</td>
</tr>
<tr>
<td>Set color</td>
<td>Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
</tbody>
</table>

**Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Direction     | Choose whether lower or larger numbers are better. Select **Minimize** if lower numbers are better. Select **Maximize** if larger numbers are better. This setting works with **Lower Limit** and **Upper Limit**, which determine the colors for the areas in the dial or speedometer.  
  - Green indicates that the figures are acceptable.  
  - Orange indicates that the figures have changed, but are still within the acceptable range.  
  - Red indicates that the figures are not acceptable. |
| Lower limit   | The lower threshold for color change on the dial or speedometer. If it uses only two colors, specify the same number for both lower and upper limits.                                                                |
| Upper limit   | The upper threshold for color change on the dial or speedometer. If it uses only two colors, specify the same number for both lower and upper limits.  
  For example, a dial contains a current score of 50 and **Dial Autoscale** is selected. The **Lower Limit** is set to 50 and **Upper Limit** is set to 100 and the direction is **Minimize**. The dial displays the area 0–50 in green, the area 50–100 in orange, and the area above 100 in red.  
  If **Lower Limit** is set to 50, **Upper Limit** is set to 100 and the direction is **Maximize**, the colors are reversed.  
  If no upper and lower limits have been set, no colors are used in the visualization. If you want to have only two section or colors, you can set the upper and lower limits to the same number. |
<p>| Dial autoscale| Check box to automatically generate start and end values for the dial or speedometer based on the selected data.                                                                                             |
| From          | Custom minimum value to display on the left side of the dial or speedometer. This field is available when <strong>Dial Autoscale</strong> is cleared.                                                                     |
| To            | Custom maximum value to display on the right side of the dial or speedometer. This field is available when <strong>Dial Autoscale</strong> is cleared.                                                                     |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.

For more information, see Define a report drilldown in the Report Designer.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
</tbody>
</table>

### Donut reports

Donut and semi-donut reports show the proportions that make up a whole.

Donut reports are similar to pie reports, but the donut report has empty space in the middle. The difference between a donut and a semi-donut is that a semi-donut is a donut sliced in half. The information presented is the same. Donut and semi-donut reports can be placed on homepages where users can quickly interpret the information displayed.
For example, use a donut or semi-donut reports to show open incidents by priority. At any time, there are open incidents of different priority levels. A donut or semi-donut report enables you to see quickly whether incident counts of different priorities are within acceptable ranges.

Donut chart incidents by Priority

Donut report of incidents by priority
Semi-donut report of incidents by priority

Create a donut report

Create a donut report to show how one grouping relates to the total amount.

Create a donut report in the Report Designer

Create a donut chart report to compare the size of parts to the whole.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
</tbody>
</table>

**Note:** If you select a data source used by existing reports, a notification will display prompting you to view them.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon () to import a new file.</td>
</tr>
</tbody>
</table>

See [Create a report from an imported Microsoft Excel document](#).
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase application</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. On the **Type** tab, enter **Donut** in the filter, select **Donut** or **Semi-donut**, and click **Next**.
   
   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.
6. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the <strong>Display data table</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number. If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See How to report on extended tables. Note: For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click (+) to configure additional sorting order conditions. (Click (-) to delete configured sorting order conditions.)
3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see [Condition builder](#).

**Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.
The report is generated.

- Click the Report info icon ( ) and add a description of the report.
- Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Donut chart style options
Change the look of your donut or semi-donut chart.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

### Donut chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Donut width</td>
<td>Percentage for the width of the donut or semi-donut band, ranging from 1 through 100 percent. 100 percent equals a pie chart. The default value is 50.</td>
</tr>
<tr>
<td>Show total and hide legend</td>
<td>Check box to display the total aggregation value in the center of the donut. Also automatically hides the chart legend.</td>
</tr>
<tr>
<td><strong>Chart color</strong></td>
<td>Color for the chart. Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Use color palette: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>- Use several colors: Define a custom set of Colors using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>- Use chart colors: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select Use color palette from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select Use several colors from the Chart color list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td>Note:</td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td>Note:</td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td>Note:</td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td>Note:</td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
<tr>
<td>Note:</td>
<td>All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules. For more information, see Define a report drilldown in the Report Designer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property <code>glide.chart.decimal.precision</code> and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
</tbody>
</table>
|                              | - **Never**: Never show the chart title.  
|                              | - **Report only**: Shows the chart title on reports.  
|                              | - **Always**: Shows the chart title on reports, dashboards, and homepages.                                                                     |
| Chart title                  | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Size of the chart title      | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.        |
| Chart title color            | Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.             |
| Custom chart title position  | Check box to specify X and Y coordinates for the position of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Chart title X position       | Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value.  
|                              | This field appears only when **Custom chart title position** is selected.                                                                    |
| Chart title Y position       | Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. 
<p>|                              | This field appears only when <strong>Custom chart title position</strong> is selected.                                                                    |
| Title horizontal alignment   | How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.                      |
| Title vertical alignment     | How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.                              |
| Legend                       |                                                                                                                                              |
| Show legend                  | Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.                          |
| Legend horizontal alignment  | How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.                                                  |
| Legend vertical alignment    | How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

**Funnel and pyramid reports**

Funnel and pyramid reports visualize the distribution of data. The size of the slices or sections represents a percentage of the total of all values.

Funnel reports are often used to represent stages in a sales process (from lead to closed deal), or to identify potential problem areas in a process. If you apply a neck in a funnel chart, all values below a certain percentage of the total value are represented as a bar. The bar indicates that their differences are of equal importance.

Funnel reports stack slices from top to bottom by decreasing percentage and pyramid charts stack slices by increasing percentage. Pyramid reports are often used to represent hierarchical levels in an organization. Funnel and pyramid reports can be placed on homepages where users can quickly interpret the information displayed.

For example, use a funnel or pyramid report to show open incidents by priority. At any time, there are open incidents of different priority levels. For example, an organization has a policy that P1 incidents can never exceed 40% of all open incidents. Funnel and pyramid charts show whether incident counts are within acceptable ranges.
Funnel report of incidents by priority
Pyramid report of incidents by priority

Create a funnel or pyramid report

Create a report that shows the distribution of data in a process.
*Create a funnel or pyramid report in the Report Designer*
Create a funnel report where the size of each slice represents a percentage of the total.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file.</td>
</tr>
</tbody>
</table>

Note: If you select a data source used by existing reports, a notification will display prompting you to view them.
Option | Description
--- | ---
MetricBase | MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.

4. **Click Next.**

5. On the **Type** tab, enter **Pyramid** or **Funnel** in the filter, select the report type, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Funnel chart**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.</td>
</tr>
</tbody>
</table>

   **Note:** It is not possible to group or stack reports by the **Tags** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see How to report on extended tables.</td>
</tr>
</tbody>
</table>

   **Note:** It is not possible to group or stack reports by the **Tags** field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the <strong>Display data table</strong> field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Aggregation   | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.  
To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.  
Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.  
If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See **How to report on extended tables**.  
**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized. |
| Max number of groups | Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group **Other**.  
If you select **Show all**, all groups up to a limit of 50 are displayed. The rest of the results are grouped as **Other**. |
| Show Other    | Check box to include the **Other** group in the report. The **Other** group contains data for all groups that exceed the number specified in **Max number of groups**. |

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the **Sorting Order** drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click + to configure additional sorting order conditions. (Click − to delete configured sorting order conditions.)
3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see Condition builder.

Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save.
The report is generated.

- Click the Report info icon ( ) and add a description of the report.
- Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Funnel and pyramid report style options
Change the look of your funnel or pyramid report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Funnel neck size</td>
<td>(Funnel charts only) Enter a percentage for the width of the funnel, from 1–100 percent. 1 percent is the lowest value that can be represented above the funnel neck. Values lower than 1 percent are stacked below the neck in a bar of a set width. 100 percent equals a bar chart. The default value is 30.</td>
</tr>
</tbody>
</table>
| Chart color                  | Select one of the following options:
|                              | - Use color palette: Select a color palette from the predefined system color palettes.
|                              | - Use several colors: Define a custom set of Colors using hex codes. You can add any number of colors.
|                              | - Use chart colors: Use the colors defined in Reports > Chart Colors. |
| Set palette                  | Color palette used in the report. This field appears when you select Use color palette from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list. |
| Colors                       | Colors used in the report. This field displays when you select Use several colors from the Chart color list. |
| Custom chart size            | Check box to specify the width and height of the report in pixels. |

Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See <strong>Access control rules</strong>.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <strong>Define a report drilldown in the Report Designer</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show chart title              | When the chart title is shown for the report.  
  - **Never**: Never show the chart title.  
  - **Report only**: Shows the chart title on reports.  
  - **Always**: Shows the chart title on reports, dashboards, and homepages. |
| Chart title                   | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Size of the chart title       | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Chart title color             | Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Custom chart title position   | Check box to specify X and Y coordinates for the position of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Chart title X position        | Number of pixels to adjust the chart title position right or left. By default, the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value.  
  This field appears only when **Custom chart title position** is selected. |
| Chart title Y position        | Number of pixels to adjust the chart title position up or down. By default, the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value.  
  This field appears only when **Custom chart title position** is selected. |
<p>| Title horizontal alignment    | How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared. |
| Title vertical alignment      | How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared. |
| Legend                        |                                                                                                                                              |
| Show legend                   | Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form. |
| Legend horizontal alignment   | How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.                                                   |
| Legend vertical alignment     | How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.                                                   |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
</tbody>
</table>

**Heatmap reports**

Heatmap reports display aggregate data visually using colors to represent different values on a matrix. Heatmap reports can have no more than 1000 cells.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see *Enabling accessibility features*.

In the figure, the cell for confirmed low priority problems is filled to highlight the large value.
Create a heatmap report

Create a heatmap report to show aggregate data with ranges of values highlighted in different colors.

*Create a heatmap report in the Report Designer*

Create a heatmap report to display aggregate data visually using colors to represent different values on a matrix.
Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

<table>
<thead>
<tr>
<th>Report Designer UI</th>
<th>Report Builder UI</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create a report" /></td>
<td><img src="image" alt="Report Builder" /></td>
</tr>
</tbody>
</table>

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

Note: If you select a data source used by existing reports, a notification will display prompting you to view them.
### Option | Description
--- | ---
**External Import** | Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See [Create a report from an imported Microsoft Excel document](#).

### MetricBase

MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see the MetricBase application.

4. **Click Next.**
5. On the **Type** tab, enter **Heatmap** in the filter, select the report type, and click **Next**.

A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. Fill in the fields, as appropriate (see table).

#### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Row** | Field used as the source of the data for the rows in the heatmap. To select a source field on an extended table, see *How to report on extended tables*.  

**Note:** Label names longer than 20 characters may show or print a truncated view. |
| **Column** | Field used as the source of the data for the columns in the heatmap. To select a source field on an extended table, see *How to report on extended tables*.  

**Note:** Label names longer than 20 characters may show or print a truncated view. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected table. Select a field to aggregate by from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number. If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See How to report on extended tables.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click 📊 to configure additional sorting order conditions. (Click ⌚️ to delete configured sorting order conditions.)
3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see **Condition builder**.

**Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click **Save**.
The report is generated.

- Click the Report info icon ( ) and add a description of the report.
- Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Heatmap report style options**

Change the look of your heatmap chart.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Heatmap chart style options

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use heatmap colors</td>
</tr>
<tr>
<td>Color for high scores</td>
</tr>
<tr>
<td>Color for low scores</td>
</tr>
<tr>
<td>Display data labels</td>
</tr>
<tr>
<td>Display Zero</td>
</tr>
</tbody>
</table>

**Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.

<table>
<thead>
<tr>
<th>Custom chart size</th>
<th>Check box to specify the width and height of the report in pixels.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td></td>
</tr>
<tr>
<td><strong>Chart size</strong></td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
</tbody>
</table>

| **Drilldown view** | List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See **Configure the list layout**. If you specify a **Report drilldown**, **Drilldown view** is ignored. |
| **Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See **Access control rules**. |

For more information, see **Define a report drilldown in the Report Designer**.
### General

**Decimal precision**

Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.

**Note:** Percentage labels do not change accordingly with the decimal precision specified.

<table>
<thead>
<tr>
<th>Average Resolution Count</th>
<th>(empty), Open = 0.773 (27.79%)</th>
</tr>
</thead>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
</table>
| Show chart title | When the chart title is shown for the report.  
- **Never**: Never show the chart title.  
- **Report only**: Shows the chart title on reports.  
- **Always**: Shows the chart title on reports, dashboards, and homepages. |
| Chart title | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the Show chart title list. |
| Size of the chart title | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the Show chart title list. |
| Chart title color | Color of the chart title. This field appears when **Report only** or **Always** is selected from the Show chart title list. |
| Custom chart title position | Check box to specify X and Y coordinates for the position of the chart title. This field appears when **Report only** or **Always** is selected from the Show chart title list. |
| Chart title X position | Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value.  
This field appears only when **Custom chart title position** is selected. |
| Chart title Y position | Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value.  
This field appears only when **Custom chart title position** is selected. |
| Title horizontal alignment | How the chart title is aligned horizontally. This field is available when **Custom chart title position** is cleared. |
| Title vertical alignment | How the chart title is aligned vertically. This field appears when **Custom chart title position** is cleared. |

**Legend**

<table>
<thead>
<tr>
<th>Legend</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>
### General

<table>
<thead>
<tr>
<th>Show legend border</th>
<th>Check box to show a border around the legend. This check box appears when Show legend is selected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
</tbody>
</table>

### Histogram reports

Histograms group numbers in a data set into ranges. The data used in a histogram is continuous data. Continuous data is measured whereas discrete data, which is used in bar charts, is counted.

For example, a histogram can show the pattern of P1 incidents logged over a four-week period after a product release. For the first week after the product was released, P1 incidents are low because users do not really understand the product enough to use it. In the second week, more users start working with the product and P1 issues increased. In the third week, P1 issues increase even more as more users began working with the product. In the fourth week, P1 issues stay the same as the third week. The information suggests that it is not necessary to increase support staff until the third week after a product is released.

**Note:** When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see Enabling accessibility features.

### Create a histogram report

Create a histogram to group data set values into discrete ranges.

*Create a histogram report in the Report Designer*

Histograms group numbers in a continuous data set into ranges.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (usaha) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
</tbody>
</table>

Note: If you select a data source used by existing reports, a notification will display prompting you to view them.
Option | Description
--- | ---
**MetricBase** | MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see . [MetricBase application](#)

4. Click Next.

5. On the **Type** tab, enter **Histogram** in the filter, select the report type, and click Next.
   
   A preliminary version of the report is displayed. To view the updated report at any time, click Run.

6. On the **Configure** tab, fill in the following fields and click Next.

<table>
<thead>
<tr>
<th>Configure tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Measured by</td>
<td>Select a field to report against. The values from this field appear on the X axis of the histogram and determine the width of the bars.</td>
</tr>
</tbody>
</table>

7. Optional: To limit the information displayed in the report, click the filter icon ( ) and select conditions to filter the report data.
   
   For more details on how conditions are constructed, see [Condition builder](#).

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

8. Click Save.
   
   The report is generated.

   - Click the Report info icon ( ) and add a description of the report.

   - Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Line reports**

Line reports plot individual data points to show how the value of one or more items changes over time.

The value of an item at specific dates or times is displayed as data points connected by horizontal lines. Values along the horizontal axis of the line chart represent the time measurement (years, hours, minutes, milliseconds, and so on). Values on the vertical axis represent the changes to the items being monitored. Users with the report_admin role can define the ranges that are used in a line chart report.

For example, you can create a line report for incident counts, to show how the number of incidents changes over time. The incident count often increases during the first few months after a product upgrade is deployed. Over time, the number of reported incidents decreases as users
become more accustomed to the changes in the product. This figure shows the number of incidents per caller over time.

Create a line report

Create a line report to visualize the trend in the value changes of one or more items over time. Create a line report in the Report Designer
Create a line report to show how the value of one or more items changes over time.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (👍) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
**MetricBase** | MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see [MetricBase application](#).

4. **Click Next**.

5. On the **Type** tab, enter **Line** in the filter, select the Line report type in the **Time Series** section, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group by</strong></td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.&lt;br&gt;&lt;br&gt;<strong>Note:</strong> It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td><strong>Additional group by</strong></td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see <a href="#">How to report on extended tables</a>.&lt;br&gt;&lt;br&gt;<strong>Note:</strong> It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td><strong>Display data table</strong></td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added.&lt;br&gt;<strong>All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the <strong>Display data table</strong> field.</strong></td>
</tr>
<tr>
<td><strong>Trend by</strong></td>
<td>Table field whose values you want to show in a time sequence.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **per** | Time period to group data by. Time periods range from an hour to a year. You can also specify a date.  

**Note:** Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years. |

| Aggregation | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.  

To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.  

Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the **Incident** table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.  

If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See **How to report on extended tables**.  

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized. |
### Field: Percentage calculation

**Description**
Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when **Aggregation** is set to **Average**, **Sum**, or **Count Distinct**.

- **Use Aggregation** calculates the percentage using the selection in the **Aggregation** field. Only data that is displayed in the report is used to calculate the percentage.

  For example, a report shows assets by department with the **Aggregation** set to **Sum** and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%.

- **Use Record Count** calculates the percentage using the total number of records in the data set.

  For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the Low priority section is 40%.

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon ( término ) and select **Add Sort**.

   1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

      The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

   2. Click **to configure additional sorting order conditions.** (Click **to delete configured sorting order conditions.)

   3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon ( ) and select conditions to filter the report data. For more details on how conditions are constructed, see Condition builder.

Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click Save.

The report is generated.

- Click the Report info icon ( ) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Line report style options**
Configure the look of your line report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

**Line chart style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Colors used in the report. If you do not group or stack the report, Use one color is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options: Use color palette: Select a color palette from the predefined system color palettes. Use several colors: Define a custom set of Colors using hex codes. You can add any number of colors. Use chart colors: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
<tr>
<td>Chart color</td>
<td>Color used in the report. This field displays when you select Use one color from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select Use one color from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select Use color palette from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select Use several colors from the Chart color list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
</tbody>
</table>

*Note: It is not possible to use transparency hex values.*
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not plot nil as zero</td>
<td>Check box to specify whether to replace missing data points with values of zero. This field is available when creating or editing time series reports (area, spline, line, and step line reports only) that include multiple datasets, and when creating or editing datasets within the applicable time series reports. This field is not available when data in the report is aggregated by Count or Count Distinct. If selected, the report may show gaps where no data exists.</td>
</tr>
<tr>
<td>Show marker</td>
<td>Check box to display a symbol at each data point.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td>Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td></td>
<td>Note: The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <em>Configure the list layout</em>. If you specify a <em>Report drilldown</em>, <em>Drilldown view</em> is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See *Access control rules*. For more information, see *Define a report drilldown in the Report Designer*. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- Never: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- Report only: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- Always: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a Group by field is selected on the report form.</td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a Group by field is selected on the report form.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is</td>
</tr>
<tr>
<td></td>
<td>exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select</td>
</tr>
<tr>
<td></td>
<td>this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type</td>
</tr>
<tr>
<td></td>
<td><strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type</td>
</tr>
<tr>
<td></td>
<td><strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**List reports**

List reports display data in the form of an expandable list. You can configure whether lists appear expanded or collapsed. Lists are often used for enumerations such as the number of incidents or changes. They contain columns that show more detailed information, such as a short description, category, or state.
Notes:

- List reports display in List v2, even if List v3 is enabled.
- As of the Kingston release, the record count and pagination buttons appear only at the bottom of the list.

This example list report displays incidents sorted by caller.
Table: change_request

<table>
<thead>
<tr>
<th>Category</th>
<th>Number</th>
<th>Assigned to</th>
<th>Short description</th>
<th>Planned start date</th>
<th>Planned end date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
<td>CHG0000015</td>
<td>Bud Richman</td>
<td>Unix update</td>
<td>2018-12-30 16:00:00</td>
<td>2018-12-30 22:00:00</td>
</tr>
<tr>
<td></td>
<td>CHG0000009</td>
<td>ITIL User</td>
<td>Install new Cisco</td>
<td>2016-05-28 12:30:00</td>
<td>2018-05-28 17:30:00</td>
</tr>
<tr>
<td></td>
<td>CHG0000006</td>
<td>ITIL User</td>
<td>Put another 100 Gb drive on the 2nd Floor Server</td>
<td>2018-05-30 23:00:00</td>
<td>2018-05-30 23:45:00</td>
</tr>
<tr>
<td>Network</td>
<td>(60)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other</td>
<td>(26)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Server</td>
<td>Reboot</td>
<td>(3)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Software</td>
<td>(4)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Telecom</td>
<td>(2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CHG0000005</td>
<td>David Loq</td>
<td>Install new PBX</td>
<td>2018-05-26 00:00:00</td>
<td>2018-05-29 16:45:31</td>
</tr>
<tr>
<td></td>
<td>CHG0000002</td>
<td>ITIL User</td>
<td>Switch Sales over to the new 555 prefix</td>
<td>2018-05-23 12:00:00</td>
<td>2018-05-23 12:30:00</td>
</tr>
</tbody>
</table>
Create a list report

Create a list report to display data in the form of an expandable list.

Create a list report in the Report Designer

List reports display data in the form of an expandable list. For example, an incident report grouped by priority displays only the priority names and a number of records that display if the user clicks the priority. You can configure whether lists display expanded or collapsed.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
### ServiceNow Madrid Analytics, Intelligence, and Reporting

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file.</td>
</tr>
<tr>
<td><strong>MetricBase</strong></td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see . MetricBase application</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **List** in the filter, select the report type, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Choose columns</strong></td>
<td>Fields to display as columns in the list report. In the Columns window that opens after you click <strong>Choose columns</strong>, select fields in the Available list that you want to appear in your report and move them to the Selected list. Depending on system configuration, you can add fields from tables that extend the selected table. For more information, see How to report on extended tables.</td>
</tr>
<tr>
<td><strong>Group by</strong></td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.</td>
</tr>
</tbody>
</table>

   **Note:** It is not possible to group or stack reports by the **Tags** field.

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Field | Description
--- | ---
**Additional group by** | Extra fields to group the report by. When you select **Additional group by** fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see [How to report on extended tables](#).

**Note:** It is not possible to group or stack reports by the **Tags** field.

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click 🔗 to configure additional sorting order conditions. (Click ⏺️ to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority...
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (.masks) and select conditions to filter the report data. For more details on how conditions are constructed, see Condition builder.

   Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. Click Save. The report is generated.

   Click the Report info icon (.masks) and add a description of the report.
• Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules. For more information, see Share a report – Report Designer.

Note:
- The default number of rows in a list report exported to PDF is 1000. To configure this value, enter sys_properties.list in the Filter Navigator, and edit the property glide.pdf.max_rows. For more information, see: Add a system property.
- Despite list filtering, pdf-format exported rows will count all record rows sequentially up to the export limit and show as blank for roles prevented by ACLs from viewing restricted data.

• Configure and use list functions

Create a list report with variable columns
You can create a list report with variables columns based on a data source or table that has variables associated with it. For example, if an item has a variable called Storage, you can create a list report that has a column for the values in this variable.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has variables associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Note:</td>
<td>If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

For list reports with variables, the report source is usually the service catalog table.
4. Click Next.
5. On the Type tab, enter List in the filter, select the report type, and click Next.

A preliminary version of the report is displayed. To view the updated report at any time, click Run.
6. On the **Configure** tab, click **Choose columns** and select **Variables (+)** in the Columns window that opens.

   **Variables (+)** is at the bottom of the list of available columns.

   Depending on system configuration, you can add fields from tables that extend the selected table. For more information, see [How to report on extended tables](#).

7. Click the structure icon ( ) to choose an item.

8. Select an item from the Catalog item list that appears.

   The variables associated with the selected item then appear in the **Columns** window.
9. Select and move variables to the Selected column and click OK.
10. On the Configure tab, fill in the following fields and click Next.
### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to group or stack reports by the <strong>Tags</strong> field.</td>
</tr>
</tbody>
</table>

11. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (⪣) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click + to configure additional sorting order conditions. (Click − to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

12.
Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
For more details on how conditions are constructed, see Condition builder.

**Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

13. Click Save.
The report is generated.

- Click the Report info icon (🔍) and add a description of the report.
Click the sharing icon ( ) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules. For more information, see *Share a report – Report Designer*.

**Note:**
- The default number of rows in a list report exported to PDF is 1000. To configure this value, enter `sys_properties.list` in the Filter Navigator, and edit the property `glide.pdf.max_rows`. For more information, see: *Add a system property*.
- Despite list filtering, pdf-format exported rows will count all record rows sequentially up to the export limit and show as blank for roles prevented by ACLs from viewing restricted data.

---

**Create a list report with question columns**

You can create a list report with question columns based on a data source or table that has questions associated with it. For example, if a form prompts a user to select the specific nature of a problem, you can create a list report that lists columns for those values.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

**Note:** Questions are treated as variables.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select a report source that has questions associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>
4. Click **Next**.
5. On the **Type** tab, enter **List** in the filter, select the report type, and click **Next**.
6. On the **Configure** tab, click **Choose columns** and select **Questions (+)** in the Columns window that opens.

**Questions (+)** is at the bottom of the list of available columns.

Depending on system configuration, you can add fields from tables that extend the selected table. For more information, see [How to report on extended tables](#).
7. Click the structure icon ( ) to choose an item.

8. Select an item from the Catalog item list that appears.
   The variables associated with the selected item then appear in the Columns window.
9. Select and move questions to the **Selected** column and click **OK**.
10. On the **Configure** tab, fill in the following fields and click **Next**.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
</tbody>
</table>

**Note:** It is not possible to group or stack reports by the **Tags** field.
11. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select Add Sort.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click to configure additional sorting order conditions. (Click to delete configured sorting order conditions.)

3. Click Save.

   For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

12. Optional: To limit the information displayed in the report, click the filter icon ( ) and select conditions to filter the report data.
   For more details on how conditions are constructed, see Condition builder.

   Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

13. Click Save.
   The report is generated.

   ·
   Click the Report info icon ( ) and add a description of the report.
Click the sharing icon ( ) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules. For more information, see *Share a report – Report Designer*.

**Note:** The default number of rows in a list report exported to PDF is 1000. To configure this value, enter `sys_properties.list` in the Filter Navigator, and edit the property `glide.pdf.max_rows`. For more information, see: *Add a system property*.

**Grouping records in list reports**

Grouped list reports can display only the records in each group that are configured to appear in a normal list. You can group rows of information in list reports by specific fields. You cannot group list reports by service catalog variables.

For example, a list configured to display 100 records at a time can show only the first 100 records, regardless of the number of records in that group. Paging is not available within groups, and you cannot access the remaining records without leaving the grouped list. To access all the records in a group:

- Increase the display size of the list.
- Click the group header to return to a normal list for that group with paging enabled.

List reports do not support the user preference to automatically expand grouped records.

This figure shows a list of products grouped by manufacturer. By default, the sections of the report are collapsed. In this example, the items associated with Gateway are expanded.
<table>
<thead>
<tr>
<th>Manufacturer: Gateway (19)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>*CAROL-1-GATEWAY</td>
</tr>
<tr>
<td><strong>8400-0553105</strong></td>
</tr>
<tr>
<td><strong>DianeK</strong></td>
</tr>
<tr>
<td><strong>DM Series</strong></td>
</tr>
<tr>
<td><strong>JENREALTY</strong></td>
</tr>
<tr>
<td><strong>KIRKK</strong></td>
</tr>
<tr>
<td><strong>MEGANIS</strong></td>
</tr>
<tr>
<td><strong>OLGAS</strong></td>
</tr>
<tr>
<td><strong>Product IDGSK</strong></td>
</tr>
</tbody>
</table>
Export a list report to Excel
You can export a list report to Excel from the list columns, or by scheduling it to be exported.

- You can export a list report as an Excel spreadsheet by right-clicking any column heading and selecting Export > Excel.
- You can schedule a saved list report to be exported as an Excel spreadsheet, by clicking Schedule and specifying Type as Excel Spreadsheet. Excel displays report duration values in milliseconds, rather than the "<x> days <y> hours" format.

Applying list report column configurations with an update set
Configured columns in list reports can be moved to another instance by committing an update set.

Configured list report columns do not automatically get applied to an instance when you commit an update set. List reports render using UI views created each time you save a report. To ensure configured columns reflect in a list report or on a dashboard widget in another instance, from the UI View table, search for the sys_id of the report (RPT) view record for your changes, and add it to the update set. For information on adding customized configurations to an update set and applying them, see System update sets.

Map reports

Map reports display data on a map. You can display data as a geographical heatmap ( ) or view specific data points ( ).

Zoom in on a map to get a more detailed view. In heatmap mode, click any region on the map that contains data to drill down into its map.

Note: Save the map report to drill down into it. You cannot drill down into unsaved reports.
The lowest level of a map hierarchy can display only data points. Click data on this lowest level to see the data in list view, or in drill-down view if one has been configured.

**Limitations**

- Maps are not supported on Internet Explorer versions 7 and 8.
- Map reports cannot be saved as images on Internet Explorer versions 7 to 9, Firefox versions 31 to 37, Safari 5, or all versions of the Edge browser. For best results, use Chrome to work with map reports.
- Map reports cannot be exported as PDFs, but can be saved as images.
- This report type cannot be run as a scheduled report.
Create a map report

Create a map report to plot your data on geographical heatmap or with pin locations for specific data points.

Create a map report in the Report Designer
Create a map report to plot your data on a map.

Role required: itil, report_user

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file.</td>
</tr>
<tr>
<td></td>
<td>See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the **Type** tab, enter **Map** in the filter, select the report type, and click **Next**.

A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to <strong>true</strong>. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Aggregation | Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.

To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.

Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.

If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#).

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.

| Map this data | The data that you want to plot on the map. Only data that a report administrator has prepared as a map source is available. |
| Map this data | The data that you want to plot on the map. Only data that a report administrator has prepared as a map source is available. |

**Map this data**

| Set map | The starting map for the report. You can zoom in but cannot zoom out from this map. |
| Set map | The starting map for the report. You can zoom in but cannot zoom out from this map. |

7. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see [Condition builder](#).

**Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

8. On the **Style** tab, configure the appearance of the report. Fill in the fields as appropriate.

#### Map report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Check box to use different colors to indicate different values on the map. If you clear this check box, all geographical locations with data are displayed in the same color.</td>
</tr>
<tr>
<td>Color for high scores</td>
<td>Color to indicate high values.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Color for low scores</td>
<td>Color to indicate low values.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to show the value for each data point.</td>
</tr>
<tr>
<td>Display geographical labels</td>
<td>Check box to display the names of geographical objects on the map, such as countries, regions, and states.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are <strong>Small</strong>, <strong>Medium</strong>, and <strong>Large</strong>.</td>
</tr>
<tr>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <a href="#">Configure the list layout</a>. If you specify a <em>Report drilldown</em>, <em>Drilldown view</em> is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message "Number of rows removed from this list by Security constraints:" followed by the number. See [Access control rules](#). For more information, see [Define a report drilldown in the Report Designer](#).
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show chart title             | When the chart title is shown for the report.  
  - **Never**: Never show the chart title.  
  - **Report only**: Shows the chart title on reports.  
  - **Always**: Shows the chart title on reports, dashboards, and homepages.                                                                 |
| Chart title                  | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Size of the chart title      | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.                                                                         |
| Chart title color            | Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list.                                                                               |
| Custom chart title position  | Check box to specify X and Y coordinates for the position of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |
| Chart title X position       | Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when **Custom chart title position** is selected. |
| Chart title Y position       | Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when **Custom chart title position** is selected. |
| Title horizontal alignment   | How the chart title is aligned horizontally. This field is available when **Custom chart title position** is cleared.                                                                                       |
| Title vertical alignment     | How the chart title is aligned vertically. This field appears when **Custom chart title position** is cleared.                                                                                             |
| Legend tab fields (available only when colors are used on the report)     |                                                                                                                                                                                                             |
| Show legend                  | Check box to show a chart legend. This check box appears when a **Group by** field is selected on the report form.                                                                                         |
| Legend horizontal alignment  | How the chart title is aligned horizontally. This field appears when **Show legend** is selected.                                                                                                          |
### Field Table

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when Show legend is selected.</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
</tbody>
</table>

9. Optional: To limit the information displayed in the report, click the filter icon ( filtro ) and select conditions to filter the report data.

For more details on how conditions are constructed, see [Condition builder](#).

**Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

10. Click **Save**.

The report is generated.

- Click the Report info icon ( info ) and add a description of the report.
- Click the sharing icon ( share ) to open the **Sharing** menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

### Multilevel pivot tables

Multilevel pivot tables display aggregate data broken down by multiple dimensions in a single table. They display separate cells for each row and column value combination, as well as a column subtotal for each first-level row. Aggregate information is presented in the top left of the chart.

You can also create multilevel pivot tables with columns and rows containing variables. See **Use service catalog variables in a report – Report Designer**.

You can expand and collapse rows in the table to show the chart details, or only the subtotals. The top row of a multilevel pivot report is always visible.

**Note:** Some row configurations prevent the chart from displaying subtotal information, such as when a string column has the same text value but with different character cases.

**Note:** This report type cannot be run as a scheduled report.
### Multilevel Pivot Report Example

<table>
<thead>
<tr>
<th>Last name</th>
<th>Name</th>
<th>Active false</th>
<th>Active true</th>
</tr>
</thead>
<tbody>
<tr>
<td>▼ (empty)</td>
<td>Total</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>(empty)</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>▼ Anglin</td>
<td>Total</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Sales</td>
<td>1</td>
<td>5</td>
</tr>
<tr>
<td>▼ Goodlife</td>
<td>Total</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>Development</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>▼ Johnson</td>
<td>Total</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Sales</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>▼ Loo</td>
<td>Total</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Development</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>▶ Luddy</td>
<td>Total</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>▶ Richman</td>
<td>Total</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>▶ User</td>
<td>Total</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>▶ Whitherspoon</td>
<td>Total</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>▶ Wilson</td>
<td>Total</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

| Count | 20 | 5 | 20 | 6 | 2 |

Multilevel pivot with subtotals and expanded rows
Create a multilevel pivot report

Create a multilevel pivot report to display aggregate data broken down by multiple dimensions in a single table.

Create a multilevel pivot report in the Report Designer
Create a multilevel pivot report to display aggregate data broken down by multiple metrics in a single table.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application</td>
</tr>
</tbody>
</table>

4. Click **Next**.
5. On the **Type** tab, enter **Multi-level pivot table** in the filter, select the report type, and click **Next**.

A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select columns</td>
<td>One or more fields to use as chart columns. The chart displays data broken down by a combination of row and column values. You can select up to three columns.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> It is not possible to group by the <strong>Tags</strong> field.</td>
</tr>
<tr>
<td>Select rows</td>
<td>One or more fields to use as chart rows. The chart displays data broken down by a combination of row and column values. You can select up to five rows.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The <strong>Tags</strong> field is not supported for multilevel pivot reports.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use Count Distinct. Select Average, Sum, or Count Distinct, to show a list of fields from the selected Table. Select a field to Aggregate by from this list. For example, if you select a duration field, such as Business duration on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as Priority, the data is expressed as a decimal value number. If you choose Average, Sum, or Count Distinct, you may further be able to aggregate on fields from extended tables. See How to report on extended tables.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. Optional: Select Default expanded to display the report with the rows expanded. Otherwise, the report will display with all rows collapsed.
8. Optional: Check **Display row lines** and **Display column lines** to show the lines that separate the cells in the report.
9. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (▲) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click **+** to configure additional sorting order conditions. (Click **-** to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

10. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. For more details on how conditions are constructed, see Condition builder.

Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

11. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.
12. Click Save.

The report is generated.

• 

Click the Report info icon (🔍) and add a description of the report.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Create a multilevel pivot report in the Report Designer with variable columns and rows
You can create a multilevel pivot report with variables columns and rows based on a data source or table that has variables associated with it. Variables are descriptions of catalog items. For example, if a service catalog item has a variable called Storage, you can create a report that has a column or row for the values in this variable, such as 128 GB, 500 GB, and 1 TB.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

<table>
<thead>
<tr>
<th>Report Designer UI</th>
<th>Report Builder UI</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Report Designer UI" /></td>
<td><img src="image2" alt="Report Builder UI" /></td>
</tr>
</tbody>
</table>

**Note:** To export multilevel pivot tables to PDF, you must activate the Webkit HTML to PDF plugin.

1. Navigate to Reports > Create New.
2. On the **Data** tab, give the report a name that reflects the information being grouped.

3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External Import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. **Click Next.**

5. On the **Type** tab, enter **Multi-level pivot table** in the filter, select the report type, and click **Next**.

A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, click **Select columns**.

From the **Available** list in the **Multilevel Pivot Columns** window, select columns that you want to use in the report and move them to the **Selected** list.

**Note:** It is not possible to group or stack reports by the **Tags** field.

Depending on system configuration, you can add fields from tables that extend the table selected as the report data source. For more information, see How to report on extended tables.

7. Select variables to use as columns:

a) Select one or more fields to use as report columns.

The report visualization displays data broken down by a combination of row and column values. You can select up to three columns including the variables.

b) Select **Variables (+)** and click the structure icon (↑) to choose an item.
c) Select a **Catalog item** from the pop-up window. The variables associated with the item appear in the **Columns** window.
d) Move the selected variables to the **Selected** column and click **OK**.

8. Click **Select rows** to select one or more fields to use as report rows. You select rows similarly to how you select columns.

The report visualization displays data broken down by a combination of row and column values. You can select up to five rows including the variables.

Note: It is not possible to group or stack reports by the **Tags** field.

9. On the **Configure** tab, fill in the following fields and click **Next**.
### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected table. Select a field to <strong>Aggregate by</strong> from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number. If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See <a href="https://servicenow.com">How to report on extended tables</a>.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

10. Optional: Check **Display row lines** and **Display column lines** to show the lines that separate the cells in the report.
11. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon ( ) and select Add Sort.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click to configure additional sorting order conditions. (Click to delete configured sorting order conditions.)

3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

12. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
   For more details on how conditions are constructed, see **Condition builder**.

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

13. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
14. Click **Save**.
   The report is generated.

   •

   Click the Report info icon (🔍) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Multilevel pivot report style options**

Change the look of your multi-level pivot chart.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Multilevel pivot report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>Display Zero</td>
<td>Check this box to display the number 0 when the value of a cell is 0. Clear this check box to display an empty cell when the value of the cell is 0. Applicable when Aggregation is Count or Count Distinct.</td>
</tr>
<tr>
<td>Default expanded</td>
<td>Check this box to expand all rows when the report is displayed. Clear this check box to collapse all rows when the report is displayed. See <strong>Multilevel pivot report with collapsed and expanded rows</strong></td>
</tr>
<tr>
<td>Display row lines</td>
<td>Check this box to display lines between rows in the report.</td>
</tr>
<tr>
<td>Display column lines</td>
<td>Check this box to display lines between columns in the report.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See **Access control rules**.

For more information, see **Define a report drilldown in the Report Designer**.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit coloring rules</td>
<td>Click this hyperlink to configure how cells and cell text with numerical values are colored in the report. You can create rules to define which colors are used based on operators and values. For example, you can specify that any value greater than 5 displays in red. See <a href="#">Create coloring rules for multilevel pivot table reports</a>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. Note: Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
</tbody>
</table>
**Pareto reports**

Pareto charts help you identify the most important dimension in a large set of dimensions. Columns show data in descending order. A line shows cumulative percentage.

Pareto charts contain both bar and line graphs. The bars display the data in descending order from left to right, and the line graph shows the cumulative totals from each category in the same order. The left Y axis is the record count, and the right Y axis is the cumulative percentage of the total number of records evaluated. The blue line at the 80% mark helps determine which data is the most influential in the process. The data to the left of the intersection of the line graph and the 80% mark have the greatest effect on the overall outcome.

The figure below shows that five callers account for 80% of the incident calls, while seven account for the other 20%.
Pareto report example
Create a pareto report

Create a Pareto report to identify the most important factors in a large set of factors. Columns show data in descending order while a curve shows cumulative percentage.

**Create a Pareto report in the Report Designer**

Create a Pareto report to identify the most important factors in a large set of factors.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

### Report Designer UI vs Report Builder UI

<table>
<thead>
<tr>
<th>Report Designer UI</th>
<th>Report Builder UI</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Report Designer UI Screenshot" /></td>
<td><img src="image2.png" alt="Report Builder UI Screenshot" /></td>
</tr>
</tbody>
</table>

1. Navigate to **Reports > Create New.**
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
</tbody>
</table>

**Note:** If you select a data source used by existing reports, a notification will display prompting you to view them.
4. Click Next.
5. On the Type tab, enter Pareto in the filter, select the report type, and click Next.
   A preliminary version of the report is displayed. To view the updated report at any time, click Run.
6. On the Configure tab, fill in the following fields and click Next.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by Assignment group, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to group or stack reports by the Tags field.</td>
</tr>
<tr>
<td>Additional group by</td>
<td>Extra fields to group the report by. When you select Additional group by fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see How to report on extended tables.</td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to group or stack reports by the Tags field.</td>
</tr>
<tr>
<td>Display data table</td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click **+** to configure additional sorting order conditions. (Click **−** to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data. For more details on how conditions are constructed, see Condition builder.

   Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click Save.
    The report is generated.

   · Click the Report info icon (🔍) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

Pareto report style options
Change the look of your Pareto report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

Note: The cumulative totals percentage line is not configurable. It cannot be disabled and the color cannot be changed.

Pareto chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Chart color</td>
<td>Colors used in the report.</td>
</tr>
<tr>
<td></td>
<td>If you do not group or stack the report, Use one color is automatically selected. Select a single predefined system color.</td>
</tr>
<tr>
<td></td>
<td>If you group or stack the report, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- Use color palette: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>- Use several colors: Define a custom set of Colors using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>- Use chart colors: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>It is not possible to use transparency hex values.</td>
</tr>
<tr>
<td>Set color</td>
<td>Color used in the report. This field displays when you select Use one color from the Chart color list.</td>
</tr>
<tr>
<td></td>
<td>Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select Use color palette from the Chart color list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Select to display the current value for each bar. This field is available when you select None from the Stacked by list or if there is no Stacked by list.</td>
</tr>
<tr>
<td></td>
<td>- Select Data labels in the middle to show the labels in the middle of each bar.</td>
</tr>
<tr>
<td></td>
<td>- Select Allow data labels to overlap to override default separation of labels in the visualization.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See <strong>Configure the list layout</strong>. If you specify a <strong>Report drilldown</strong>, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See <strong>Access control rules</strong>. For more information, see <strong>Define a report drilldown in the Report Designer</strong>.</td>
</tr>
<tr>
<td>Title</td>
<td>When the chart title is shown for the report. <strong>Never</strong>: Never show the chart title. <strong>Report only</strong>: Shows the chart title on reports. <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when Report only or Always is selected from the Show chart title list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when Custom chart title position is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when Custom chart title position is cleared.</td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

### Pie charts

Pie charts show the proportions that make up a whole.

You can use a pie chart to show things like open incidents by priority. For example, suppose that an organization has a policy that critical incidents can never exceed 40% of all open incidents. Given that there are always open incidents of various priority levels, you can quickly see with a pie chart when incident counts exceed acceptable ranges. This figure shows that 14.61% of the open incidents are critical.
Pie chart

Create a pie report

Create a pie chart to show the relationship of individual values to the whole.

Create a pie chart in the Report Designer

Create a pie chart to compare the size of individual categories to the whole.
This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
External Import | Choose an existing imported report source, or click the Upload icon ( ) to import a new file. See Create a report from an imported Microsoft Excel document.

**MetricBase**

MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.

4. Click **Next**.
5. On the **Type** tab, enter **Pie** in the filter, select the report type, and click **Next**.
   
   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.
6. On the **Configure** tab, fill in the following fields and click **Next**.

### Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Group by | Group report data using the values of this field. For example, in an incident report grouped by Assignment group, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.  
   
   **Note**: It is not possible to group or stack reports by the Tags field. |
| Additional group by | Extra fields to group the report by. When you select Additional group by fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see How to report on extended tables.  
   
   **Note**: It is not possible to group or stack reports by the Tags field. |
| Display data table | Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added.  
   
   All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected.</td>
</tr>
<tr>
<td></td>
<td>To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number.</td>
</tr>
<tr>
<td></td>
<td>If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group <strong>Other</strong>.</td>
</tr>
<tr>
<td></td>
<td>If you select <strong>Show all</strong>, all groups up to a limit of 50 are displayed. The rest of the results are grouped as <strong>Other</strong>.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the <strong>Other</strong> group in the report. The <strong>Other</strong> group contains data for all groups that exceed the number specified in <strong>Max number of groups</strong>.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click (+) to configure additional sorting order conditions. (Click (-) to delete configured sorting order conditions.)
3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see Condition builder.

Note: Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.

10. Click Save.
The report is generated.

- Click the Report info icon ( ) and add a description of the report.
- Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Pie chart style options**
Change the look of your pie chart.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Chart color</td>
<td>Colors used in the report. If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use several colors</strong>: Define a custom set of Colors using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Use chart colors</strong>: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: It is not possible to use transparency hex values.</td>
</tr>
<tr>
<td>Set palette</td>
<td>Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.</td>
</tr>
<tr>
<td>Colors</td>
<td>Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the Chart color list.</td>
</tr>
<tr>
<td>Display data labels</td>
<td>Check box to display the value for each slice.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600.</td>
</tr>
<tr>
<td></td>
<td>This field is available when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450.</td>
</tr>
<tr>
<td></td>
<td>This field appears when <strong>Custom chart size</strong> is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when <strong>Custom chart size</strong> is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, <strong>Drilldown view</strong> is ignored.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Define a report drilldown in the Report Designer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when <strong>Show legend</strong> is selected.</td>
</tr>
</tbody>
</table>

**Pivot tables**

Pivot tables aggregate data from a table into columns and rows, which you define. They help you quickly investigate the source of the summarized data. Non-empty cells display tooltips to indicate how many records the cell represents. Click a non-empty cell to display a breakdown of those records.

You can configure a filter to further refine the data and select the aggregation values.

**Note:** Pivot tables are no longer supported. If you have a problem with a pivot table report, open the report and change the type to **Multilevel pivot table**. The multilevel pivot table report is more stable and has more features than the pivot table.
## Incident Breakdown

<table>
<thead>
<tr>
<th>Assigned to</th>
<th>Request</th>
<th>Inquiry / Help</th>
<th>Software</th>
<th>Hardware</th>
<th>Network</th>
<th>Database</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>(empty)</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Beth Anglin</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>5</td>
</tr>
<tr>
<td>Bow Ruggeri</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Bud Richman</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>Charlie Whitherspoon</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>David Loo</td>
<td>0</td>
<td>4</td>
<td>1</td>
<td>3</td>
<td>0</td>
<td>1</td>
<td>9</td>
</tr>
<tr>
<td>Don Goodliffe</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>7</td>
</tr>
<tr>
<td>Fred Luzzy</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Howard Johnson</td>
<td>0</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td>ITIL User</td>
<td>0</td>
<td>8</td>
<td>5</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>15</td>
</tr>
<tr>
<td>Luke Wilson</td>
<td>0</td>
<td>2</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>1</td>
<td>20</td>
<td>16</td>
<td>8</td>
<td>3</td>
<td>2</td>
<td>50</td>
</tr>
</tbody>
</table>

### Pivot table

A pivot table allows you to aggregate data from a table into user-defined columns and rows with tooltips to indicate what the values represent.

#### Note:
*Multilevel pivot table reports* provide more configuration features, more style options, and are more stable.

### Create a pivot table report

Create a pivot table report to aggregate data from a table into user-defined columns and rows with tooltips to indicate what the values represent.

Create a pivot table in the Report Designer

Create a pivot table to aggregate data from a table into columns and rows.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file.</td>
</tr>
</tbody>
</table>

See [Create a report from an imported Microsoft Excel document](#).
MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.

4. Click Next.
5. On the Type tab, enter Pivot in the filter, select the Pivot report type from the Other section, and click Next.

A preliminary version of the report is displayed. To view the updated report at any time, click Run.
6. On the Configure tab, fill in the following fields and click Next.

**Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td>Select one field for the chart rows. The chart displays data broken down by a combination of row and column values. To select a source field on extended table, see How to report on extended tables.</td>
</tr>
<tr>
<td>Column</td>
<td>Select one field for the chart columns. The chart displays data broken down by a combination of row and column values. To select a source field on an extended table, see How to report on extended tables.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is Count, which shows the number of records selected. To show only unique records, select Count Distinct. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use Count Distinct. Select Average, Sum, or Count Distinct, to show a list of fields from the selected Table. Select a field to Aggregate by from this list. For example, if you select a duration field, such as Business duration on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as Priority, the data is expressed as a decimal value number. If you choose Average, Sum, or Count Distinct, you may further be able to aggregate on fields from extended tables. See How to report on extended tables.</td>
</tr>
</tbody>
</table>

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select Add Sort.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click + to configure additional sorting order conditions. (Click − to delete configured sorting order conditions.)

3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority...
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon and select conditions to filter the report data.
   For more details on how conditions are constructed, see Condition builder.

   ![Filter icon](image)

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click **Save**.
    The report is generated.

   ![Save icon](image)

   Click the Report info icon and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Note:** While the Import Export property glide.pdf.max_rows applies to row limits for PDF data exports in the platform product, for pivot reports exported to PDF from the Reporting product, it sets the maximum number of total cells (both rows and columns).

**Pivot report style options**

Change the look of your pivot report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

### Pivot report style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.</td>
</tr>
</tbody>
</table>

**Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.

For more information, see Define a report drilldown in the Report Designer.

**Single score report**

Single score reports display a single value that is key to your business. You can add single score reports to dashboards and configure them to update in real time.
Create a single score report

Create a single score chart to display a value that is key to your business and that updates in real time on a dashboard.

Create a single score report in the Report Designer
Create a single score chart to display a metric or score that is key to your business.

Role required: itil, report_user

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

Note: This report type cannot be run as a scheduled report.
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Note: If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see <a href="#">MetricBase application</a>.</td>
</tr>
</tbody>
</table>

4. Click **Next**.

5. On the **Type** tab, enter **Single score** in the filter, select the report type, and click **Next**.

A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

<table>
<thead>
<tr>
<th>Configuration tab Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Computational method for aggregating report data. The default is <strong>Count</strong>, which displays the number of records selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note: A single score chart displays only the aggregate value.</th>
</tr>
</thead>
</table>

If you select **Count Distinct**, only unique records are counted. For example, you want to generate a report with a distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.

If you select **Average**, **Sum**, or **Count Distinct**, a list of fields from the selected **Table** appears. You may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#). Select a field to aggregate by from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as the **Priority** field, the data is expressed as a number. You may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#).

<table>
<thead>
<tr>
<th>Note: For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</th>
</tr>
</thead>
</table>

7. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.

For more details on how conditions are constructed, see [Condition builder](#).
8. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
9. Click **Save**.
   The report is generated.

- Click the Report info icon (ساءل) and add a description of the report.
- Click the sharing icon (ساخ) to open the **Sharing** menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

**Single score report style options**
Change the look of your single score report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

**Single score chart style options**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
<tr>
<td>Default color</td>
<td>Color of the score in the chart.</td>
</tr>
<tr>
<td>Edit coloring rules</td>
<td>Click this hyperlink to configure how values are colored in the report. You can create rules to define which colors are used based on operators and values. For example, you can specify that any value greater than 5 displays in red. See <a href="#">Create coloring rules for single score reports</a>.</td>
</tr>
<tr>
<td>Display Zero</td>
<td>Check box to display the number 0 when the value of the report is zero. Clear this check box to display an error message when the value of the cell is 0. Applicable when <strong>Aggregation</strong> is <strong>Count</strong> or <strong>Count Distinct</strong>.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drilldown view</td>
<td>List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored. Note: All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules. For more information, see Define a report drilldown in the Report Designer.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value. Note: Percentage labels do not change accordingly with the decimal precision specified.</td>
</tr>
</tbody>
</table>

Note: Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
</tbody>
</table>

| Chart title                  | The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |

| Size of the chart title      | Size of the chart title in pixels. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |

| Chart title color            | Color of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |

| Custom chart title position  | Check box to specify X and Y coordinates for the position of the chart title. This field appears when **Report only** or **Always** is selected from the **Show chart title** list. |

| Chart title X position       | Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when **Custom chart title position** is selected. |

| Chart title Y position       | Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when **Custom chart title position** is selected. |

| Title horizontal alignment   | How the chart title is aligned horizontally. This field is available when **Custom chart title position** is cleared. |

| Title vertical alignment     | How the chart title is aligned vertically. This field appears when **Custom chart title position** is cleared. |

**Step line reports**

Step line reports plot individual data points to show how the value of one or more items changes over time. Horizontal lines in the step report show the duration of a change and vertical lines show its magnitude.

The values of an item at specific dates or times are displayed as data points connected by horizontal lines. Values along the horizontal axis of the step line report represent the time measurement (years, hours, minutes, milliseconds, and so on). Values on the vertical axis represent...
the magnitude of changes to the items being monitored. Users with the report_admin role can define the ranges that are used in a step line report.

For example, you can create a step line report for incident counts, to show how the number of incidents changes over time.
Create a step line report

Create a step report to show how the value of one or more items changes over time.

Create a step line report
Create a step report to show how the value of one or more items changes over time with emphasis on the duration and magnitude of the change.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

This task refers to the Madrid release under UI15 and UI16.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Note: If you select a data source used by existing reports, a notification will display prompting you to view them.</td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, enter Step in the filter, select the report type, and click Next.

A preliminary version of the report is displayed. To view the updated report at any time, click Run.
6. On the Configure tab, fill in the following fields and click Next.

Configure tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by Assignment group, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.</td>
</tr>
<tr>
<td>Note: It is not possible to group or stack reports by the Tags field.</td>
<td></td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Additional group by | Extra fields to group the report by. When you select **Additional group by** fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see [How to report on extended tables](#).

**Note:** It is not possible to group or stack reports by the **Tags** field.

Display data table | Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added.

All reports that use charts, including reports that are used on dashboards, show the table of report data when the `glide.ui.section508` system property is set to **true**. The `glide.ui.section508` property overrides the **Display data table** field.

Trend by | Table field whose values you want to show in a time sequence.

per | Time period to group data by. Time periods range from an hour to a year. You can also specify a date.

**Note:** Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation</td>
<td>Mathematical calculation to perform on the data. The default is <strong>Count</strong>, which shows the number of records selected. To show only unique records, select <strong>Count Distinct</strong>. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use <strong>Count Distinct</strong>. Select <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, to show a list of fields from the selected <strong>Table</strong>. Select a field to <strong>Aggregate by</strong> from this list. For example, if you select a duration field, such as <strong>Business duration</strong> on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as <strong>Priority</strong>, the data is expressed as a decimal value number. If you choose <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>, you may further be able to aggregate on fields from extended tables. See <strong>How to report on extended tables</strong>. <strong>Note:</strong> For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.</td>
</tr>
<tr>
<td>Percentage calculation</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when <strong>Aggregation</strong> is set to <strong>Average</strong>, <strong>Sum</strong>, or <strong>Count Distinct</strong>. <strong>Use Aggregation</strong> calculates the percentage using the selection in the <strong>Aggregation</strong> field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the <strong>Aggregation</strong> set to <strong>Sum</strong> and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%. <strong>Use Record Count</strong> calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the Low priority section is 40%.</td>
</tr>
</tbody>
</table>
7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon ( ), and select Add Sort.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click to configure additional sorting order conditions. (Click to delete configured sorting order conditions.)

3. Click Save.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (maze) and select conditions to filter the report data.
   For more details on how conditions are constructed, see Condition builder.

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click **Save**.
   The report is generated.

- Click the Report info icon (angle) and add a description of the report.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Step line report style options**
Configure the look of your step line report.

When you create or edit a report, click the Style tab for options to configure the look of your report. The options are organized under two or more of the following tabs: General, Title, Legend, and Axis. To see how the report looks with the changed settings, click Save.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Colors used in the report.</td>
</tr>
<tr>
<td>Chart color</td>
<td>If you do not group or stack the report, <strong>Use one color</strong> is automatically selected. Select a single predefined system color.</td>
</tr>
<tr>
<td></td>
<td>If you group or stack the report, select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use color palette</strong>: Select a color palette from the predefined system color palettes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use several colors</strong>: Define a custom set of Colors using hex codes. You can add any number of colors.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Use chart colors</strong>: Use the colors defined in Reports &gt; Chart Colors.</td>
</tr>
</tbody>
</table>

> Note: It is not possible to use transparency hex values.

<p>| Set palette    | Color palette used in the report. This field appears when you select <strong>Use color palette</strong> from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list. |
| Colors         | Colors used in the report. This field displays when you select <strong>Use several colors</strong> from the Chart color list. |
| Set color      | Color used in the report. This field displays when you select <strong>Use one color</strong> from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list. |
| Display data labels | Check box to show the value for each data point. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do not plot nil as zero</td>
<td>Check box to specify whether to replace missing data points with values of zero. This field is available when creating or editing time series reports (area, spline, line, and step line reports only) that include multiple datasets, and when creating or editing datasets within the applicable time series reports. This field is not available when data in the report is aggregated by Count or Count Distinct. If selected, the report may show gaps where no data exists.</td>
</tr>
<tr>
<td>Show marker</td>
<td>Check box to show a symbol at each data point. When selected, the marker shows in the center of the step and the endpoints of the report visualization.</td>
</tr>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
</tbody>
</table>

**Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Drilldown view      | List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See Configure the list layout. If you specify a Report drilldown, Drilldown view is ignored.  
  **Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See Access control rules.  
  For more information, see Define a report drilldown in the Report Designer.                                                                                                                                                                                                       |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show chart title</strong></td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td><strong>Chart title</strong></td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td><strong>Size of the chart title</strong></td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td><strong>Chart title color</strong></td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td><strong>Custom chart title position</strong></td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td><strong>Chart title X position</strong></td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td><strong>Chart title Y position</strong></td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td><strong>Title horizontal alignment</strong></td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td><strong>Title vertical alignment</strong></td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td><strong>Legend</strong></td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td><strong>Legend horizontal alignment</strong></td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td><strong>Legend vertical alignment</strong></td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report. On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the X axis tab, specify the size of the labels for the rows of the report. On the Y axis tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**Trend reports**

Trend reports show how the value of one or more items changes over time. Values along the horizontal axis of the trend report represent the time measurement. Values on the vertical axis represent the changes to the items being monitored.
Users with the report_admin role can define the ranges that are used in a trend chart report. See Report ranges for information on creating report ranges.

An example of an item that changes over time is incident count. The incident count will likely increase during the first few months after a product upgrade is released. Over time, the number of incidents reported drops as users become more accustomed to the changes in the product.

Create a trend report

Create a trend report to show how the values of data elements change over time. Create a trend report in the Report Designer
Create a trend report to show how the value of one or more data element changes over time.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.
1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td>External import</td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See Create a report from an imported Microsoft Excel document.</td>
</tr>
</tbody>
</table>
4. Click Next.

5. On the **Type** tab, enter **Trend** in the filter, select the Trend report type from the **Other** section, and click **Next**.

   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

   **Configure tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group by</strong></td>
<td>Group report data using the values of this field. For example, in an incident report grouped by <strong>Assignment group</strong>, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td><strong>Additional group by</strong></td>
<td>Extra fields to group the report by. When you select <strong>Additional group by</strong> fields, a control is added to the bottom of the report that groups the report by any one of the additional fields. To additionally group by fields on extended tables, see <a href="#">How to report on extended tables</a>.</td>
</tr>
<tr>
<td><strong>Display data table</strong></td>
<td>Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added. All reports that use charts, including reports that are used on dashboards, show the table of report data when the <code>glide.ui.section508</code> system property is set to <strong>true</strong>. The <code>glide.ui.section508</code> property overrides the <strong>Display data table</strong> field.</td>
</tr>
<tr>
<td><strong>Trend by</strong></td>
<td>Table field whose values you want to show in a time sequence.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **per** | Time period to group data by. Time periods range from an hour to a year. You can also specify a date.  
**Note:** Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years. |

**Aggregation**  
Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.  
To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.  
Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.  
If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See **How to report on extended tables**.  
**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage calculation</td>
<td>Method of calculating percentages. The percentage appears when you point to a report segment, such as a bar on a bar report. This field appears when Aggregation is set to Average, Sum, or Count Distinct.</td>
</tr>
<tr>
<td></td>
<td><strong>· Use Aggregation</strong> calculates the percentage using the selection in the Aggregation field. Only data that is displayed in the report is used to calculate the percentage. For example, a report shows assets by department with the Aggregation set to Sum and the percentage calculated using aggregation. If the total cost of assets is $100,000 and the cost of assets for Customer Support is $10,000, the percentage for Customer Support is 10%. <strong>· Use Record Count</strong> calculates the percentage using the total number of records in the data set. For example, a report shows incidents by priority. Out of 500 incident records, 200 have low priority. The percentage for the Low priority section is 40%.</td>
</tr>
<tr>
<td>Max number of groups</td>
<td>Maximum number of groups to display in the report. Groups with highest values are included first. Any excluded groups are combined into the single group Other. If you select Show all, all groups up to a limit of 50 are displayed. The rest of the results are grouped as Other.</td>
</tr>
<tr>
<td>Show Other</td>
<td>Check box to include the Other group in the report. The Other group contains data for all groups that exceed the number specified in Max number of groups.</td>
</tr>
</tbody>
</table>

7. Optional: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select Add Sort.

   1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose a-z or z-a for alphabetical order or reverse alphabetical order. The list contains all possible fields from the report’s source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

   2. Click ⬆ to configure additional sorting order conditions. (Click ⬇ to delete configured sorting order conditions.)

   3. Click Save.
For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
   For more details on how conditions are constructed, see [Condition builder](#).

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click **Save**.
   The report is generated.
Click the Report info icon (i) and add a description of the report.

Click the sharing icon ( ) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Trend report style options**
Change the look of your trend report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General**, **Title**, **Legend**, and **Axis**. To see how the report looks with the changed settings, click **Save**.

### Trend chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| General     | Colors used in the report. If you do not group or stack the report, **Use one color** is automatically selected. Select a single predefined system color. If you group or stack the report, select one of the following options:  
  - **Use color palette**: Select a color palette from the predefined system color palettes.  
  - **Use several colors**: Define a custom set of Colors using hex codes. You can add any number of colors.  
  - **Use chart colors**: Use the colors defined in Reports > Chart Colors.  |
| Chart color | **Set color** Color used in the report. This field displays when you select **Use one color** from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.  |
| Set palette | Color palette used in the report. This field appears when you select **Use color palette** from the Chart color list. Click the search icon ( ) to choose from the Chart color schemes or Color Definitions list.  |
| Colors      | Colors used in the report. This field displays when you select **Use several colors** from the Chart color list.  |

**Note:** It is not possible to use transparency hex values.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Display data labels | Select to display the current value for each bar. This field is available when you select None from the **Stacked by** list or if there is no **Stacked by** list.  
  - Select **Data labels in the middle** to show the labels in the middle of each bar.  
  - Select **Allow data labels to overlap** to override default separation of labels in the visualization. |
| Custom chart size   | Check box to specify the width and height of the report in pixels.  
  - **Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart. |
| Chart width         | Width of the report in pixels. The default value is 600.  
  This field is available when **Custom chart size** is selected. |
| Chart height        | Height of the report in pixels. The default value is 450.  
  This field appears when **Custom chart size** is selected. |
| Chart size          | Chart size. This field is available when **Custom chart size** is cleared. Options are **Small**, **Medium**, and **Large**.  
  - **Note:** The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart. |
| Drilldown view      | List view to show when a user selects a segment of a report for which no drilldown report type is specified. This view is also used when the user reaches the lowest drilldown level of a report. See **Configure the list layout**. If you specify a **Report drilldown**, **Drilldown view** is ignored.  
  - **Note:** All users are able to view report visualizations, such as pie charts and column reports. However, the last level of a report drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. See **Access control rules**.  
  For more information, see **Define a report drilldown in the Report Designer**. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart.decimal.precision and specify the value.</td>
</tr>
</tbody>
</table>

**Note:** Percentage labels do not change accordingly with the decimal precision specified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Legend</td>
<td></td>
</tr>
<tr>
<td>Show legend</td>
<td>Check box to show a chart legend. This check box appears when a <strong>Group by</strong> field is selected on the report form.</td>
</tr>
<tr>
<td>Legend horizontal alignment</td>
<td>How the legend is aligned horizontally. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Legend vertical alignment</td>
<td>How the legend is aligned vertically. This field appears when <strong>Show legend</strong> is selected.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show legend border</td>
<td>Check box to show a border around the legend. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Left align legend text</td>
<td>Check box to left-align the legend text when the report is viewed in a browser. By default, the legend text is centered. When the report is exported to PDF, PNG, or JPG, the legend remains centered. This check box appears when Show legend is selected.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
<tr>
<td>Opposite</td>
<td>On the X axis tab, select this check box to show the X-axis title on the right side of the report instead. On the Y axis tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the X axis tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the Y axis tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on configured Highcharts settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type Number, the From and To fields are not available.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on configured Highcharts settings, the maximum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| X axis / Y axis label size | On the **X axis** tab, specify the size of the labels for the rows of the report.  
On the **Y axis** tab, specify the size of the labels for the columns in the report. |
| Label bold              | Check this box to show the labels of the report in a bold typeface.                                                                           |

**Trendbox reports**

Trendbox reports visualize the distribution of data for a specific time period.

A trendbox report is similar to a box report, but it also allows you to specify a time period for the report. When defining the report, use a descriptive title that indicates the use of the time period. Use trendbox reports when you have multiple small data sets from different sources that are related to each other. Examples include incident resolution times for different product features, or incident resolution times for different priorities.

For example, a trendbox report can show incident resolution duration for high priority incidents by support employee. Suppose every support employee handles P1 incidents, but you know that the time it takes to resolve each P1 incident varies. A trendbox report would show, by employee, the longest and shortest resolution times, and a grouping with the most common or closely clustered resolution times. With this information, you can compare resolution times by employee, or you can use the information to estimate future support staffing levels.
Trendbox report

About trendbox report

Each box in a trendbox report displays the following information for each group of data:
Create a trendbox report

Create a trendbox report to show the distribution of values in a data set as with a box report, but within a specified time period.

Create a trendbox report in the Report Designer
Create a trendbox report to show the distribution of values in a data set, with a specified time period.

This task refers to Report Designer in the Madrid release. If you are using the Report Builder (Classic UI) for creating reports, select the applicable report instructions instead from in the Kingston release.

Box chart scale

1. Sample maximum
2. Upper quartile
3. Median
4. Mean
5. Lower quartile
6. Sample minimum

Note: When accessibility is enabled, this visualization includes a report that screen readers can interpret. For more information, see Enabling accessibility features.
1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. Select the applicable source for the report:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data source</strong></td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>The raw data from a table with no filters applied.</td>
</tr>
<tr>
<td><strong>External import</strong></td>
<td>Choose an existing imported report source, or click the Upload icon (↑) to import a new file. See <a href="#">Create a report from an imported Microsoft Excel document</a>.</td>
</tr>
</tbody>
</table>

*Note: If you select a data source used by existing reports, a notification will display prompting you to view them.*
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MetricBase</td>
<td>MetricBase enables you to collect, retain, analyze, and visualize custom time series data on the Now Platform. For more information, see MetricBase application.</td>
</tr>
</tbody>
</table>

4. Click Next.

5. On the **Type** tab, enter **Trendbox** in the filter, select the report type, and click **Next**.
   
   A preliminary version of the report is displayed. To view the updated report at any time, click **Run**.

6. On the **Configure** tab, fill in the following fields and click **Next**.

Trendbox report configuration options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data using the values of this field. For example, in an incident report grouped by Assignment group, all incidents that belong to Software, Service Desk, and Network are placed in separate groups. To group by fields on extended tables, see How to report on extended tables.</td>
</tr>
</tbody>
</table>

   **Note:** It is not possible to group or stack reports by the **Tags** field.

   **Note:** Label names longer than 20 characters may show or print a truncated view.

<table>
<thead>
<tr>
<th>Trend by</th>
<th>Table field whose values you want to show in a time sequence.</th>
</tr>
</thead>
<tbody>
<tr>
<td>per</td>
<td>Time period to group data by. Time periods range from an hour to a year. You can also specify a date.</td>
</tr>
</tbody>
</table>

   **Note:** Reporting per Week is not supported when the report range includes more than one year. Inconsistent results are produced when a week is split between two years.
### Field Description

**Aggregation**

Mathematical calculation to perform on the data. The default is **Count**, which shows the number of records selected.

To show only unique records, select **Count Distinct**. For example, if you want a report on the distinct number of users who have one or more of the roles in a given list of roles. Users with more than one role would be counted twice unless you use **Count Distinct**.

Select **Average**, **Sum**, or **Count Distinct** to show a list of fields from the selected **Table**. Select a field to **Aggregate by** from this list. For example, if you select a duration field, such as **Business duration** on the Incident table, the aggregated data is expressed in days, hours, and minutes. If you select an integer field, such as **Priority**, the data is expressed as a decimal value number.

If you choose **Average**, **Sum**, or **Count Distinct**, you may further be able to aggregate on fields from extended tables. See **How to report on extended tables**.

Note: For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.

7. **Optional**: Configure the sort order of the applicable fields in the report (column, row, Group by, Stack by or Trend by depending on the report type). Click the filter icon (🔍) and select **Add Sort**.

1. In the Sorting Order drop-down list, choose the field you want to sort on and then choose **a-z** or **z-a** for alphabetical order or reverse alphabetical order.

   The list contains all possible fields from the report's source. The only effective values, however, are the fields chosen for the current report (column, row, Group by, Stack by, or Trend by depending on the report type). Add sort cannot be applied to dot-walked fields.

2. Click 📅 to configure additional sorting order conditions. (Click ❌ to delete configured sorting order conditions.)

3. Click **Save**.

For fields of the type Choice list, the sort order is determined by the sequence of the choices in the choice list, not alphabetically or numerically. For example, a priority
choice list is often indexed from Critical to Planning as shown in the figure below.

8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
   For more details on how conditions are constructed, see Condition builder.

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the **Style** tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click **Save**.
    The report is generated.

   - Click the Report info icon (🔍) and add a description of the report.
Click the sharing icon ( ) to open the **Sharing** menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.

**Trendbox report style options**
Change the look of your trendbox report.

When you create or edit a report, click the **Style** tab for options to configure the look of your report. The options are organized under two or more of the following tabs: **General, Title, Legend, and Axis**. To see how the report looks with the changed settings, click **Save**.

### Trendbox chart style options

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom chart size</td>
<td>Check box to specify the width and height of the report in pixels.</td>
</tr>
<tr>
<td><img src="https://example.com/note-icon.png" alt="Note" /></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Chart width</td>
<td>Width of the report in pixels. The default value is 600. This field is available when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart height</td>
<td>Height of the report in pixels. The default value is 450. This field appears when Custom chart size is selected.</td>
</tr>
<tr>
<td>Chart size</td>
<td>Chart size. This field is available when Custom chart size is cleared. Options are Small, Medium, and Large.</td>
</tr>
<tr>
<td><img src="https://example.com/note-icon.png" alt="Note" /></td>
<td>The chart size is ignored when you export the report to PDF. In PDFs, the full page width is used to show the chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Decimal precision</td>
<td>Number of decimal places to show. You can show from zero to four decimal places. Default value: 2. To change the default value, create the system property glide.chart_decimal_precision and specify the value.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show chart title</td>
<td>When the chart title is shown for the report.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Never</strong>: Never show the chart title.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Report only</strong>: Shows the chart title on reports.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Always</strong>: Shows the chart title on reports, dashboards, and homepages.</td>
</tr>
<tr>
<td>Chart title</td>
<td>The chart title has a maximum length of 40 characters. If no title is entered, the report name is used for the title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Size of the chart title</td>
<td>Size of the chart title in pixels. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title color</td>
<td>Color of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Custom chart title position</td>
<td>Check box to specify X and Y coordinates for the position of the chart title. This field appears when <strong>Report only</strong> or <strong>Always</strong> is selected from the <strong>Show chart title</strong> list.</td>
</tr>
<tr>
<td>Chart title X position</td>
<td>Number of pixels to adjust the chart title position right or left. By default the title appears at the center top of the chart. To move the chart title to the right, enter a positive value. To move the title to the left, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Chart title Y position</td>
<td>Number of pixels to adjust the chart title position up or down. By default the title appears at the center top of the chart. To move up the chart title, enter a positive value. To move the chart title down, enter a negative value. This field appears only when <strong>Custom chart title position</strong> is selected.</td>
</tr>
<tr>
<td>Title horizontal alignment</td>
<td>How the chart title is aligned horizontally. This field is available when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Title vertical alignment</td>
<td>How the chart title is aligned vertically. This field appears when <strong>Custom chart title position</strong> is cleared.</td>
</tr>
<tr>
<td>Axis</td>
<td></td>
</tr>
<tr>
<td>Y axis and X axis</td>
<td>Axis to configure the titles, appearance, and labels for.</td>
</tr>
<tr>
<td>Title</td>
<td>Title for the axis.</td>
</tr>
<tr>
<td>Title size</td>
<td>Size of the axis title in pixels. Default value is 12.</td>
</tr>
<tr>
<td>Title bold</td>
<td>Check this box to show the axis title in a bold typeface.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opposite</td>
<td>On the <strong>X axis</strong> tab, select this check box to show the X-axis title on the right side of the report instead. On the <strong>Y axis</strong> tab, select this check box to show the Y-axis title on top of the report instead of across the bottom.</td>
</tr>
<tr>
<td>Display grid</td>
<td>On the <strong>X axis</strong> tab, select this check box to show horizontal grid lines on the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, select this check box to show vertical grid lines on top the report.</td>
</tr>
<tr>
<td>Grid dotted</td>
<td>Check this box to show dotted grid lines instead of solid lines.</td>
</tr>
<tr>
<td>From</td>
<td>Specify a minimum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on configured <strong>Highcharts</strong> settings, the minimum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>To</td>
<td>Specify a maximum Y-axis value to limit the amount of information in the report. If you select an aggregation field that is not of the type <strong>Number</strong>, the <strong>From</strong> and <strong>To</strong> fields are not available.</td>
</tr>
<tr>
<td></td>
<td>Note: Depending on configured <strong>Highcharts</strong> settings, the maximum value may be rounded up or down. If you require the settings that affect this changed, contact the administrator.</td>
</tr>
<tr>
<td>X axis / Y axis label size</td>
<td>On the <strong>X axis</strong> tab, specify the size of the labels for the rows of the report.</td>
</tr>
<tr>
<td></td>
<td>On the <strong>Y axis</strong> tab, specify the size of the labels for the columns in the report.</td>
</tr>
<tr>
<td>Label bold</td>
<td>Check this box to show the labels of the report in a bold typeface.</td>
</tr>
</tbody>
</table>

**Differences between Report Builder and Report Designer**

The Report Designer provides a guided flow for report creation. Selection of the data source, selection of the report type, configuration, and styling of the report are presented on successive tabs. The Report Builder provides most report creation functionality in a single panel.

Using the Report Designer, users can configure a report, preview it, iterate and adjust, then share it using the integrated Share panel.

The older Report Builder provides functionality for naming, selection of the data source, and configuration on one page. Style option selection is provided in a pop-up.
The Report Designer supports imported data sources and MetricBase Time Series reports, but the Report Builder does not.

**Determine the report creation tool**

You can create and edit reports in both report creation UIs. The new Report Designer has separate panels for specifying the report source, the type, the configuration, and the style options. The Report Builder (‘Classic UI’) provides most of this functionality on a single panel.

The layout of the report creation tool indicates the type:

1. Report Designer:
2. Report Builder:
30/60/90 Day Task Aging

Data: Table, Follow On Task [cert_follow_on_task]
Type: Horizontal bar
Group by: Aging Level
Stacked by: -- None --
Display Grid

Add Filter Condition, Add "OR" Clause, Add Sort Field

State is one of

30 days
Past 90 days
Perform tasks in the Report Builder

View steps for performing various Report Builder tasks using Kingston release documentation.

If you are using the Report Builder (Classic UI) to perform tasks, see steps for the applicable task from in the Kingston release documentation.

Advanced reporting

Learn how to further customize report visualizations and the data you report on. Topics in this section are appropriate for users who are already familiar with the basics of report creation.

Drilling down within reports

You can drill down within a report to visualize a subset of its data. For example, you can click on the critical section of a report sorted by priority to view the categories of those critical incidents.

For reports with a defined drilldown, click on a portion of the chart to display a subset of data. The subset may use a different chart type. In the example, the user clicks on the critical incidents in a bar chart to reveal the categories of critical incidents in a semi-donut chart.

Drilldown example

All chart types except for list, histogram, calendar, control, box, and trendbox charts support drilling down. Drilling down is not available on charts added to forms, and charts embedded as iframes. You can define any number of drilldown levels for a report.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Note: Drilldown reports do not export to PDF. If you select Export to PDF on a drilldown, a PDF of the top level report is generated.

Define a report drilldown in the Report Designer

You can define a report drilldown to allow reporting users to view subsets of the report data. When you define a report drilldown, it applies only to the report for which you define it. The report that you want to define a drilldown for must exist.

Note: You can only drill down to data in the same table as the report. The following report types do not support the drilldown feature: list, histogram, calendar, control, box, and trendbox.

1. Navigate to Reports > View / Run.
2. Select the report you want to add a drilldown to.
3. Click the Show report structure icon ( ).
   A badge on the Report structure icon displays the number of defined drilldowns.
4. Click the Add drilldown icon ( ).

Drilldown example

5. Enter a Title for the drilldown and click Next.
6. Select the chart Type to display the data and click Next. See Creating reports.
The drilldown chart type can be different than the parent report.
7. Configure the report. Configuration options depend on the selected Type.
8. Click Save drilldown.

The user can now drill down from the top-level report to the specified drilldown report visualizations.

**Note:** All users can view report visualizations, such as pie charts and column reports. However, the last level of a drilldown is always a list. Platform access control lists determine user access to list information. Users who do not have rights to any part of the list data see the message “Number of rows removed from this list by Security constraints:” followed by the number. For more information, see Access control list rules.

### Set the on-click behavior of a report
You can configure a URL to open when a user clicks a report.

Role required:
- When creating reports: Any
- When editing reports created by others: report_admin, report_global, or report_group

Redirect the user to a URL rather than to the configured drilldown or the list that underlies the clicked section of a report.

1. Navigate to Reports > View / Run.
2. Select the report you want to configure.
3. Click the Show report structure icon ( ).
4. Click the link icon ( ).
5. In the Set redirect URL dialog box, enter relative link in the instance, for example, /$knowledge.do.
   When the user points to the report, the tooltip includes the text Click to open.
6. Optional: Enter a label for the URL.
   When the user points to the report, the tooltip includes the text Click to open and the text of the label, for example, Click to open Knowledge Base.
7. Click Save.

When the user clicks the report, the redirect URL replaces any drilldown functionality.

### Using multiple datasets in a report
You can create reports that use datasets from multiple tables in a single report.

The following report types support multiple datasets: bar, horizontal bar, line, column, area, spline.

Multiple **Group bys** are not supported on multiple datasets. When using multiple datasets, the report legend is always displayed.
Add an additional dataset to a report — Report Designer

Add an extra dataset to a report to visualize data from multiple sources in a single report.

Role required: itil, report_user. The property `glide.ui.doctype` must be enabled.

1. Navigate to `Reports > View / Run`.
2. Select a report with a type that supports multiple datasets.
   You can add additional sets to bar, horizontal bar, line, column, area, and spline reports.
3. Click the `Show report structure` icon.
4. Click `Add dataset`.
5. On the `Data` tab, provide a custom name for the additional data set to appear in the legend of the report, select a data source, and click the `Configure` tab.
6. On the `Configure` tab, specify applicable fields the same way that you would configure a standalone report. Note attention to the following fields on applicable report types.

   **Note:** The `Display data table` option is not available from the `Add dataset` module, but is only available from the `Configure` tab of the main Report Designer. If the `Display data table` option is selected, only the first dataset will display on the data table.

7. On the `Style` tab, specify the following fields the same way that you would configure a standalone report.
8. Click `Save dataset`.

The report is generated with the information from the additional dataset.
Add an additional group by or stack by – Report Designer

You can configure a report to let users adjust its grouping and stacking.

Role required: itil, report_user

Configure alternative Group by and Stack by choices that users can select when viewing the chart. Additional group bys can be added to any report that supports group bys (such as bar or pie) and to list reports as columns. When you configure an additional group by to a bar or horizontal bar, it is also added as an additional stack by. You can add variables and variable groups as additional group bys.

**Note:** Available Stack by fields are limited to catalog variables, reference fields, choice lists, and boolean values. Date/time, integer, long, string, list, and text fields cannot be used as stacked fields.

1. Navigate to Reports > View / Run.
2. Select a report.
3. On the Configure tab, click Additional group by.
4. Move one or more fields to the Selected list.
5. Optional: Select a Stack by field used to show the relationship of individual items from the selected field to the whole. For example, group a bar chart of incidents by Category and stack by Priority. The viewer can then determine at a glance the proportion of high, medium, and low priority issues for each category.

Users viewing the report can select one of these fields to group or stack the report data. The report Group by and Stack by field values are the default choices.

**Note:** Only bar and horizontal bar reports use stacked data. Other report types allow only grouping.

6. Arrange the fields in the Selected column in the order you want them to appear to users.
7. Click Close.
8. In the report builder, click Save.

Create a report from an imported Microsoft Excel document

In addition to creating reports from tables and data sources maintained on your instance, you can import Excel spreadsheets (.xlsx files) of data maintained outside of your instance and create reports from those files.

Role required: admin, sys_admin, report_admin, pa_admin, or pa_power_user

You must have Performance Analytics to create reports with imported data. See Activate Performance Analytics Premium.

**Note:** The following restrictions apply to imported data:

- The maximum file size is 2 MB.
- The maximum number of rows is 10,000. The maximum number of columns is 25.

  **Note:** You can import .xlsx files of up to 50,000 rows, but only the first 10,000 rows appear in your data set.

- Only the first sheet of an .xlsx file with multiple sheets is imported.
The first row and first column of the imported file must not be empty. The first row is used to identify the column names.
- It is not possible to join columns, calculate fields, or make other changes to the table after import. These changes must be made before import.
- The imported .xlsx file must have a specified expiration date.
- If the owner deletes the table after import, reports based on the imported table are also deleted.

**Note:** Importing report data in this way is useful when you have information that is maintained outside of your instance, for example, recurring third-party data. To import an external data set into your instance permanently, see [Importing data using import sets](#).

1. Navigate to **Reports > Create New**.
2. On the **Data** tab, give the report a name that reflects the information being grouped.
3. In the **Source type** list, select **External**.

4. Choose an existing imported report source, or click the **Upload** icon (↑) icon to import a new file.
   1. Click and drag the file onto the drop zone or click **Browse files** to choose it from your file system.
   2. Enter a name for the uploaded file.
   3. Set the expiration of the file. After this date, the imported file is deleted and reports based on it are no longer available.
   4. Select the visibility for the uploaded file: Only you, all users, or a specified group of users, groups, or roles.
   5. Click **Upload**.
   6. Click **Done**.

5. Click **Next**.
6. On the **Type** tab, select the type of report you want to create and click **Next**. For information on specific reports, see [Creating reports](#).
A preliminary version of the report is displayed. To view the updated report at any time, click Run.

7. On the Configure tab, fill in the fields as appropriate for the report type.
8. Optional: To limit the information displayed in the report, click the filter icon (🔍) and select conditions to filter the report data.
   For more details on how conditions are constructed, see Condition builder.

   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.
10. Click Save.
    The report is generated.

The report is created from the external source. Reports on a dashboard or a homepage show an icon to show that the report is temporary and expires when the external data source expires.

- Click the Report info icon (ℹ️) and add a description of the report.
- Click the sharing icon (🔗) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.
- Click the sharing icon (🔗) to open the Sharing menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

**Edit an imported data source**

You can edit imported Excel spreadsheets (.xlsx files) of data maintained outside of your instance.

Only the person who imported the data source can edit it.

1. Navigate to Reports > View / Run.
2. Click the name of a report that uses to imported data source to open the report in the Report Designer.
3. On the Data tab, click the pencil icon (📝) next to the name of the external import.
4. In the Edit external import dialog box you can make these changes:

   **Change file**
   Select this option to upload a new .xlsx file with the same name and structure.

   **Name**
   Provide a new name for the external import. This name appears on the Data tab of the Report Designer in the External Import list.

   **Expires**
   Set a new expiry date for the external import. After this date, the imported file is deleted and reports based on it are no longer available.
Visible to

Change the visibility for the uploaded file: Only you, Everyone, or Custom. Select Custom to specify users, groups, or roles.

If you select Custom, click Next to choose who can use the data in the imported file and click Submit.

5. Click Submit.

If you changed the file, the data from the new file replaces that of the old in any reports that are based on the imported file. Changed name, expiry date, and visibility apply to the imported file.

Create time series reports from MetricBase data

Use the MetricBase application to create time series reports from MetricBase data stored on an instance.

You must have the MetricBase product. To get it, see Request the MetricBase product.

1. Navigate to Reports > CreateNew.
2. On the Data tab, enter a report name that reflects the information being grouped.
3. In the Source type list, select MetricBase.

Note:

- The MetricBase menu option is available only if you have MetricBase installed on your instance.
- The default maximum number of series per data set is 20. You can increase the maximum value up to 100 by configuring the glide.report.metric_max_series system property. However, due to the 10,000 data points limit, increasing the number of series in a data set results in a smaller number of data points per series.
- The total number of data points that can be displayed per series is: 10,000 / (actual number of series in dataset * number of data sets). For example:
  - 1 dataset used with 20 series: 10K / (20*1) = 500
  - 2 datasets used with 20 series: 10K / (20*2) = 250
  - 1 dataset used with 100 series: 10K / (100*1) = 100
- If the actual number of data points in a series exceeds the limit, the data is resampled.
4. Choose an existing MetricBase table.
5. Click Next.
6. On the Type tab, select the type of report to create and click Next. Only Time Series reports are available. For information on specific reports types, see Creating reports. A preliminary version of the report appears. To view the updated report, click Run.
7. On the Configure tab, fill in the following fields and click Next.

<table>
<thead>
<tr>
<th>Configure tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group by</td>
<td>Group report data by any of the applicable fields in the Metrics table.</td>
</tr>
<tr>
<td>Metric</td>
<td>Metrics are determined in your MetricBase database. Click the plus icon (+) to add multiple metrics. For each metric, you can set one or more transforms. Click the minus icon (-) to remove a metric.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Transform             | - Select no transforms to show the raw data in your report.  
                        - Select one transform.  
                        - Select multiple transforms to create a transform chain. A transform chain applies a new transform to the results of the previous transform.  
                        For more information, see MetricBase transforms.                                                                                                                                                     |
| Time range            | Set a period of time for the report to cover.  
                        Relative values are a number of minutes, hours, days, months, or years from the current time. Absolute ranges enable you to specify the start time and end time of the report.                                                                 |
| Display data table    | Check this box to show report data in a grid beneath the report. The table appears on dashboards where the report is added.  
                        All reports that use charts, including reports that are used on dashboards, show the table of report data when the glide.ui.section508 system property is set to true. The glide.ui.section508 property overrides the Display data table field. |

8. Optional: To limit the information displayed in the report, click the filter icon (фильтр) and select conditions to filter the report data.  
   For more details on how conditions are constructed, see Condition builder.

   ![](https://example.com/condition-builder)  
   **Note:** Keywords is a special field used for text searches across all fields. Its use in a filter or condition, in combination with other conditions, may return inconsistent results.

9. On the Style tab, fill in the fields as appropriate to configure the appearance of the report.  
   See the Style options section of the report you are creating for more information.

   - Area and spline report style options
   - Line report style options
   - Step line report style options

10. Click Save.  
    The report is generated.

    The report is created from the MetricBase source. If the report visualization is truncated, a message displays

    - Click the Report info icon (информация о отчете) and add a description of the report.

    - Click the sharing icon (делится) to open the Sharing menu. On this menu, you can add the report to a dashboard, export the report to PDF, publish the report to the web, and set visibility and schedules.
Click the sharing icon ( ) to open the Sharing menu. On this menu, you can share the report with users and groups, add the report to a dashboard, and publish the report to the web.

**MetricBase transforms**

Transforms enable you to visualize MetricBase data in different ways.

**Available transforms**

All transforms except for the **Label** transform are mathematical functions you can apply to the metrics data. Apply multiple transforms to create a transform chain.

<table>
<thead>
<tr>
<th>Transform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Calculates an outcome by adding the specified value to the data points in the dataset.</td>
</tr>
<tr>
<td>Average</td>
<td>Calculates the arithmetic means of all currently selected metrics.</td>
</tr>
<tr>
<td>Bottom</td>
<td>Shows only the lowest specified number of values of the metric dataset.</td>
</tr>
<tr>
<td>Chisquare</td>
<td>Shows how well a statistical model fits the metric dataset.</td>
</tr>
<tr>
<td>Count</td>
<td>Shows the count of data points within the metric dataset.</td>
</tr>
<tr>
<td>Divide</td>
<td>Calculates an outcome by dividing the data points in the dataset by a specified value.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Shows the minimum and maximum values of the metric dataset.</td>
</tr>
</tbody>
</table>
| Filter    | Produces a new series with values calculated using the given aggregation function over a sliding time window of the given duration. A sliding 15-minute average would use the Filter transform with the **Average** aggregation function and a duration of 15 minutes. Supported aggregation functions:  
  - AVG  
  - CHISQUARE  
  - LAST  
  - MAX  
  - MEDIAN  
  - MIN  
  - STDDEV |
<p>| Fractiles | Returns a new series with values representing the given percentiles of the underlying data. For example, to query for the 90th and 99th percentile response times, supply an array of (0.9,0.99). |
| Interpolate | Constructs new data points a specified duration to calculate an outcome. |</p>
<table>
<thead>
<tr>
<th>Transform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Enables you to set a label for your transform.</td>
</tr>
<tr>
<td>Last</td>
<td>Returns the last defined value in the period window.</td>
</tr>
<tr>
<td>Log</td>
<td>Calculates the natural logarithm of all values in the dataset.</td>
</tr>
<tr>
<td>Max</td>
<td>Shows the largest value at each point in time for the metric dataset.</td>
</tr>
<tr>
<td>Median</td>
<td>Shows the median of the metric dataset. The median separates the higher values of the metric dataset from the lower values.</td>
</tr>
<tr>
<td>Min</td>
<td>Shows the smallest value at each point in time for the metric dataset.</td>
</tr>
<tr>
<td>Multiply</td>
<td>Calculates an outcome by multiplying the data points in the dataset by a specified value.</td>
</tr>
</tbody>
</table>
| Partition | Produces a new series with values calculated using the given aggregation function over a fixed time frame of a given duration. Specify the Base (a time stamp) to align the partition window. Supported aggregation functions:  
· AVG  
· CHISQUARE  
· LAST  
· MAX  
· MEDIAN  
· MIN  
· STDDEV  |
| Resample | Expands or contracts the data to fit the given period. When you extend the period, the aggregation function is used to combine the data to fit the new period. When you shorten the period, the existing data is propagated to the underlying periods. Supported aggregation functions:  
· AVG  
· CHISQUARE  
· LAST  
· MAX  
· MEDIAN  
· MIN  
· STDDEV  |
<p>| Standard Deviation | Calculates the standard deviation across the underlying data. Used to quantify the variation or dispersion of a set of data values in the metric dataset. |
| Subtract | Calculates an outcome by subtracting the specified value from the data points in the dataset. |</p>
<table>
<thead>
<tr>
<th>Transform</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sum</td>
<td>Calculates the sum of the data points within the metric dataset.</td>
</tr>
<tr>
<td>Top</td>
<td>Shows only the highest specified number of values of the metric dataset.</td>
</tr>
</tbody>
</table>

**Configure charts on forms**

You can add reports to forms such as change requests, and configure the report visualizations to display information relevant to the user of the form. The configuration is specific to the current view.

Role required: admin

The following report types are not supported on forms: List, Pivot, Multilevel Pivot, Calendar, and Single Score.

1. Select the table on which you want to configure a form with a report in the Filter navigator and select a record. For example, select a record from task.list.
2. From the context menu, select Configure > Form Layout.
3. From the Available list, add *Chart to the Selected column.
4. Use the up and down arrows to position the report on the form.
5. Optional: Specify a label for the chart.
   The label appears next to the report in the form. If you do not specify a label, the label New Chart is used.
6. Click Save.
   A grey box with the text Configure chart appears on the form in the specified position.
7. Click Configure chart.
8. Click the search icon (🔍) to select a report.
9. Optional: Specify the height of the chart. The default value is 300 pixels.
10. Optional: You can filter the data in the report based on selected fields or based on a scripted filter or an encoded query.
    The first field must be visible on the form. To add fields to the form, select Configure > Form Layout and use the Available Fields slush bucket.
    On the Report condition extension tab, select the form field on which the report is updated and the field on the report source table to which the form field is compared.
    To specify a scripted filter or an encoded query, select Advanced Condition Extensions and paste the script in the Report Qual text box. Advanced condition extensions, if present, override report condition extensions.
11. Click Update.
12. To change the configuration, right click on the label and select Configure chart.
The selected report appears on all forms which are of the same type as the one selected. These reports are filtered based on the report condition extensions.

**Embedding reports in Jelly**

You can embed reports in any Jelly-based element, such as a UI page.

**Enabling Embedding**

To enable embedding reports in Jelly, add the following element to your Jelly code.

```xml
<g:inline template="reporting_includes.xml" />
```

After adding this code, you can embed an existing report, or generate a report within the Jelly code.

**Embedding an existing report**

You can embed an existing report by calling the `embedReportById(targetSpan, reportId)` function.

For example:

```xml
<xml version="1.0" encoding="utf-8">
    <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
    xmlns:j2="null" xmlns:g2="null">
        <g:inline template="reporting_includes.xml" />
        <div id="report_stuff" />
    </j:jelly>
    var div = $j("#report_stuff");
    embedReportById(div, <report sys_id>);
</xml>
```
Alternatively, you can embed the JavaScript in the jelly code:

```xml
<xml version="1.0" encoding="utf-8">
  <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
  xmlns:j2="null" xmlns:g2="null">
    <g:inline template="reporting_includes.xml" />
    <div id="report_stuff" />
    <script>
      var div = $j("#report_stuff");
      embedReportById(div, <report sys_id>);
    </script>
  </j:jelly>
```

### Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetSpan</td>
<td>The jQuery element to embed the chart in. The chart uses the size of this element.</td>
</tr>
<tr>
<td>reportId</td>
<td>The sys_id of the report you want to embed.</td>
</tr>
</tbody>
</table>

### Generate and embed a report

You can embed a report within the UI by calling the `embedReportByParams(targetSpan, parms)` function. When embedding a report in this way, you can generate a new report using parameters, or specify a report sys_id to display that report.

For example:

```xml
<xml version="1.0" encoding="utf-8">
  <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
  xmlns:j2="null" xmlns:g2="null">
    <g:inline template="reporting_includes.xml" />
    <div id="report_stuff" />
  </j:jelly>
  var div = $j("#report_stuff");
  embedReportByParams(div, params);
</xml>
```

Alternatively, you can embed the JavaScript inside the jelly code:

```xml
<xml version="1.0" encoding="utf-8">
  <j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
  xmlns:j2="null" xmlns:g2="null">
    <g:inline template="reporting_includes.xml" />
    <div id="report_stuff" />
    <script>
      var div = $j("#report_stuff");
      embedReportByParams(div, params);
    </script>
  </j:jelly>
```
Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>targetSpan</td>
<td>The jQuery element to embed the chart in.</td>
</tr>
<tr>
<td>parms</td>
<td>A JSON object defining the report. Available parameters depend on the report type.</td>
</tr>
</tbody>
</table>

Embedded report parameters

When embedding a report in a Jelly element, you can define a report at any time by passing parameters.

Common parameters

Certain parameters are used by multiple report types.

Common parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>jvar_report_id</td>
<td>The sys_id of a report record. If you pass this parameter, do not specify any other parameters. All values are taken from the report record.</td>
<td></td>
</tr>
<tr>
<td>sysparm_title</td>
<td>The title of the report.</td>
<td></td>
</tr>
<tr>
<td>sysparm_table</td>
<td>The table to report on. Specify this value or sysparm_report_source_id, but not both.</td>
<td></td>
</tr>
<tr>
<td>sysparm_report_source_id</td>
<td>The sys_id of a report source. Specify this value or sysparm_table, but not both. This value is used instead of sysparm_table if you pass both.</td>
<td></td>
</tr>
<tr>
<td>sysparm_type</td>
<td>The type of report to create. Possible values are: list, line, line_bar, area, spline, bar, horizontal_bar, pareto, hist, pie, donut, semi_donut, speedometer, dial, pivot, pivot_v2, funnel, calendar, pyramid, box, trend, control, trendbox, and heat map.</td>
<td>line</td>
</tr>
<tr>
<td>sysparm_field</td>
<td>The field from the specified table to group data by. This value is required for time series, column, bar, pie, donut, funnel, pyramid, box, trend, and trend box reports. This value is optional for list reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_query</td>
<td>The filter to apply to the data before generating the report. Specify a query string for this value. To sort your query results by a specific field, add ^ORDERBY&lt;field_name&gt; or ^ORDERBYDES&lt;field_name&gt; to the end of the query string. ORDERBY sorts the query by ascending order; ORDERBYDES sorts the query by descending order.</td>
<td></td>
</tr>
<tr>
<td>sysparm_aggregate</td>
<td>The aggregation type. Possible values are: AVG, COUNT, SUM, and COUNT_DISTINCT</td>
<td>COUNT</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>sysparm_sumfield</td>
<td>The field to aggregate data on. This parameter does not apply when using a COUNT aggregation type.</td>
<td></td>
</tr>
<tr>
<td>sysparm_display_grid</td>
<td>A boolean value that controls whether the report displays a data grid.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_show_other</td>
<td>A boolean value that controls whether the Other group appears on the report. This group appears only if the number of groups exceeds the number specified in the sysparm_others parameter. This parameter applies to bar, pie, funnel, pyramid, pivot, and heat map reports.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_others</td>
<td>The maximum number of individual groups of data to display. Any additional data groups are combined into the Other group. This parameter applies to bar, pie, funnel, pyramid, pivot, and heat map reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_source_type</td>
<td>The source of the embedded report. Optional. Possible values are: table, metricbase, source, import</td>
<td>table</td>
</tr>
<tr>
<td>sysparm_set_color</td>
<td>The color setting for the report. Possible values are: one_color, color_palette, several_colors</td>
<td>color_palette</td>
</tr>
<tr>
<td>sysparm_color_palette</td>
<td>The color palette that the report uses. This parameter is used when sysparm_set_color=&quot;color_palette&quot;. Possible value: The sys_id of a color palette</td>
<td>Default UI14</td>
</tr>
<tr>
<td>sysparm_color</td>
<td>The color that the report uses. This parameter is used when sysparm_set_color=&quot;one_color&quot;. Possible value: The sys_id of a color</td>
<td></td>
</tr>
<tr>
<td>sysparm_chart_colors</td>
<td>The set of chart colors that the report uses. This parameter is used when sysparm_set_color=&quot;several_colors&quot;. Possible value: A comma-separated list of color hex codes</td>
<td></td>
</tr>
<tr>
<td>sysparm_show_marker</td>
<td>A marker is the value, such as a number, that is represented by a dot in a line or another graphic element in a chart. This parameter is a boolean value that controls whether the marker appears. Possible values: true or false</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_show_empty</td>
<td>A boolean value that controls if records with empty grouping or trend values appear on the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_stack_field</td>
<td>The field used to control stacking on bar and column reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_bar_unstack</td>
<td>A boolean value that controls if stacked data is presented as a single bar or column, or as multiple bars.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_box_field</td>
<td>The numeric field used to measure the data. This parameter is required for box and histogram reports.</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Default value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>sysparm_trend_field</td>
<td>The date-time field used to organize trend data. This parameter is required for time series, trend, and box reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_trend_interval</td>
<td>The interval to measure trend values by. Possible values are: year, quarter, month, week, dayofweek, hour, and date.</td>
<td>year</td>
</tr>
<tr>
<td>sysparm_compute_percent</td>
<td>The value to use when displaying report percentages. You can display percentages based on the total record count, or by the specified aggregate. Possible values are: aggregate and count</td>
<td>count</td>
</tr>
<tr>
<td>sysparm_funnel_neck_percent</td>
<td>A number 1–100 that defines the percentage of a funnel report that is the neck of the funnel.</td>
<td>30</td>
</tr>
<tr>
<td>sysparm_show_chart_data_label</td>
<td>A boolean value that controls if data labels appear on the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_show_zero</td>
<td>A boolean value that controls if zeroes appear on multipivot and heat map reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_ct_row</td>
<td>The field used to define the rows in heat map and bubble reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_ct_column</td>
<td>The field used to define the columns in heat map and bubble reports.</td>
<td></td>
</tr>
<tr>
<td>sysparm_y_axis_category_fields</td>
<td>The field used to define the rows in multipivot reports. Specify up to five comma-separated field names.</td>
<td></td>
</tr>
<tr>
<td>sysparm_x_axis_category_fields</td>
<td>The field used to define the columns in multipivot reports. Specify up to three comma-separated field names.</td>
<td></td>
</tr>
<tr>
<td>sysparm_list_ui_view</td>
<td>The sys_id of a list view to use when a user drills into the report.</td>
<td></td>
</tr>
<tr>
<td>sysparm_show_marker</td>
<td>A boolean value that controls if markers appear at every plotted point on a report.</td>
<td>true</td>
</tr>
</tbody>
</table>

**Service catalog parameters**

Certain parameters apply only to reports created on service catalog tables, such as the Requested Item (sc_req_item) table. These parameters are not available on list or calendar type reports.

**Service catalog report parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_sc_groupby_item_id</td>
<td>The sys_id of a catalog item. Use this parameter with the <strong>sysparm_sc_groupby_variable_id</strong> parameter to group a service catalog report based on a catalog variable value. These parameters replace the <strong>sysparm_field</strong> parameter when grouping on service catalog variables.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sysparm_sc_groupby_variable_id</td>
<td>The sys_id of the catalog item variable used to determine how data is grouped on the report. This variable must belong to the catalog item specified in the sysparm_sc_groupby_item_id parameter.</td>
</tr>
<tr>
<td>sysparm_sc_stackby_item_id</td>
<td>The sys_id of a catalog item. Use this parameter with the sysparm_sc_stackby_variable_id parameter to stack a service catalog report based on a catalog variable value. These parameters replace the sysparm_stack_field parameter when grouping on service catalog variables. Only reports that support stacking, such as bar reports, support these parameters.</td>
</tr>
<tr>
<td>sysparm_sc_stackby_variable_id</td>
<td>The sys_id of the catalog item variable used to determine how data is grouped on the report. This variable must belong to the catalog item specified in the sysparm_sc_stackby_item_id parameter.</td>
</tr>
</tbody>
</table>

**MetricBase parameters**

To use MetricBase in an embedded report, the sysparm_source_type parameter must be set to "metricbase".

MetricBase also requires the sysparm_custom_configuration parameter, which has the following syntax:

```plaintext
sysparm_custom_config: "{query_condition:"",transforms: [{transform: {transform:"Reference",name:"chart-subjects"}},metric:"mb_metricname "]}, group_by:"", table:"mb_tablename"";
```

In this syntax:

- **transform** is a chain of nested transform functions. The last transform of every chain must always be the Reference transform:

  ```plaintext
  {transform:"Reference",name:"chart-subjects"}
  ```

- **metric** is a metric field of a metric table.
- **group-by** is the field on the selected metric table by which the time series is grouped.
- **table** refers to the metric table
- **mb_...** are placeholder names

All attributes are mandatory except for **group-by**.

**Chart-specific parameters**

Certain parameters are available only for specific report types.

**Donut report parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_show_report_total</td>
<td>A boolean value that controls if the total score of the grouped donut appears in the center of the report.</td>
<td>false</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_donut_width_percent</td>
<td>A number 1–100 that controls the thickness of the donut report.</td>
<td>50</td>
</tr>
</tbody>
</table>

#### Heatmap parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_use_color_heatmap</td>
<td>A boolean value that controls if the heatmap uses a gradient to color the report. When true, the sysparm_axis_max_color and sysparm_axis_min_color values are used.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_axis_max_color</td>
<td>The color used in the heatmap gradient to indicate a high value. This value must be the sys_id of a Color Definition (sys_report_color) record.</td>
<td>Ul14 blue</td>
</tr>
<tr>
<td>sysparm_axis_min_color</td>
<td>The color used in the heatmap gradient to indicate a low value. This value must be the sys_id of a Color Definition (sys_report_color) record.</td>
<td>white</td>
</tr>
</tbody>
</table>

#### Dial parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_gauge_autoscale</td>
<td>A boolean value that controls if the dial automatically calculates the minimum and maximum scale on the report. If you set this value to false, you must specify a sysparm_from and sysparm_to value.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_from</td>
<td>A number that defines the minimum value for the axis scale.</td>
<td></td>
</tr>
<tr>
<td>sysparm_to</td>
<td>A number that defines the maximum value for the axis scale.</td>
<td></td>
</tr>
<tr>
<td>sysparm_upper_limit</td>
<td>A number that defines the upper threshold for the dial. If you do not specify a value, the dial has no upper threshold.</td>
<td></td>
</tr>
<tr>
<td>sysparm_lower_limit</td>
<td>A number that defines the lower threshold for the dial. If you do not specify a value, the dial has no lower threshold.</td>
<td></td>
</tr>
<tr>
<td>sysparm_direction</td>
<td>A value that controls which values are considered positive on the report, lower values or higher values. Possible values are: minimize and maximize.</td>
<td>minimize</td>
</tr>
</tbody>
</table>

#### Chart size parameters

Certain parameters control the width and height of the report.
### Size parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_chart_size</td>
<td>The size of the chart in the report. Valid values are small, medium, and large.</td>
<td>large</td>
</tr>
<tr>
<td>sysparm_custom_chart_size</td>
<td>Set this parameter to true to specify custom chart height and width values instead of using one of the size options from the sysparm_chart_size parameter.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_custom_chart_height</td>
<td>The height of the chart in the report, in pixels.</td>
<td></td>
</tr>
<tr>
<td>sysparm_custom_chart_width</td>
<td>The width of the chart in the report, in pixels.</td>
<td></td>
</tr>
</tbody>
</table>

### Chart title parameters

Certain parameters are available only for reports that display a title. These report types include time series, bar, column, pie, donut, dials, trend, box, trend box, histogram, pyramid, heat map, funnel, and control reports.

### Title parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_report_title_size</td>
<td>A number that defines the font size of the title.</td>
<td>16</td>
</tr>
<tr>
<td>sysparm_report_title_color</td>
<td>The title text color. This value must be the sys_id of a Color Definition (sys_report_color) record.</td>
<td>black</td>
</tr>
<tr>
<td>sysparm_title_horizontal_alignment</td>
<td>Where the title is placed horizontally relative to the report. This value is used only if sysparm_custom_report_title_position is false. Possible values are: left, center, and right.</td>
<td>center</td>
</tr>
<tr>
<td>sysparm_title_vertical_alignment</td>
<td>Where the title is placed vertically relative to the report. This value is used only if sysparm_custom_report_title_position is false. Possible values are: top, middle, and bottom.</td>
<td>top</td>
</tr>
<tr>
<td>sysparm_custom_report_title_position</td>
<td>A boolean value that controls if the report title position is defined by x and y coordinates instead of relative alignment.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_report_title_x_position</td>
<td>A number that defines the x position of the title on the report. This value is used only if sysparm_custom_report_title_position is true.</td>
<td>0</td>
</tr>
<tr>
<td>sysparm_report_title_y_position</td>
<td>A number that defines the y position of the title on the report. This value is used only if sysparm_custom_report_title_position is true.</td>
<td>0</td>
</tr>
</tbody>
</table>
Chart border parameters

Certain parameters are available only for reports that display a border. These report types include time series, bar, column, pies, donuts, dials, trend, box, trend box, histogram, pyramid, heat map, funnel, and control reports.

Border parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_show_report_border</td>
<td>A boolean value that controls whether the report displays a border.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_report_border_width</td>
<td>A number that defines the width of the border, in pixels.</td>
<td>1</td>
</tr>
<tr>
<td>sysparm_report_border_radius</td>
<td>A number that defines the radius size of the corners of the border, in pixels.</td>
<td>0</td>
</tr>
</tbody>
</table>

Legend parameters

Certain parameters are available only for reports that display a legend. These report types include pie, donut, stacked bar, stacked column, time series, trend, box, histogram, pyramid, control, and heat map reports.

Legend parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_show_legend</td>
<td>A boolean value that controls whether the report displays a legend.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_legend_horizontal_alignment</td>
<td>Where the legend is placed horizontally relative to the report. Possible values are: left, center, and right.</td>
<td>center</td>
</tr>
<tr>
<td>sysparm_legend_vertical_alignment</td>
<td>Where the legend is placed vertically relative to the report. Possible values are: top, middle, and bottom.</td>
<td>bottom</td>
</tr>
<tr>
<td>sysparm_show_legend_border</td>
<td>A boolean value that controls whether the legend displays a border.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_legend_border_width</td>
<td>A number that defines the width of the legend border, in pixels.</td>
<td>1</td>
</tr>
<tr>
<td>sysparm_legend_border_radius</td>
<td>A number that defines the radius size of the corners of the legend border, in pixels.</td>
<td>0</td>
</tr>
</tbody>
</table>

X-axis parameters

Certain parameters are available only for reports that use an X axis. These report types include bar, horizontal bar, pareto, column, line area, spline, box, trendbox, control, and trend reports.
### X-axis parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_x_axis_title</td>
<td>The name to display on the x axis.</td>
<td></td>
</tr>
<tr>
<td>sysparm_x_axis_title_size</td>
<td>A number that defines the font size of the x-axis title.</td>
<td></td>
</tr>
<tr>
<td>sysparm_x_axis_title_bold</td>
<td>A boolean value that controls whether the x-axis title text is bold.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_x_axis_opposite</td>
<td>A boolean value that controls if the x axis appears at the top of the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_x_axis_display_grid</td>
<td>A boolean value that controls if vertical grid lines appear from the x axis.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_x_axis_grid_dotted</td>
<td>A boolean value that controls whether the vertical grid lines are dotted.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_x_axis_label_size</td>
<td>A number that defines the font size for increment labels on the x axis.</td>
<td>11</td>
</tr>
<tr>
<td>sysparm_x_axis_label_bold</td>
<td>A boolean value that controls whether the x-axis increment labels are bold.</td>
<td>false</td>
</tr>
</tbody>
</table>

### Y-axis parameters

Certain parameters are available only for reports that use a Y axis. These report types include bar, horizontal bar, pareto, column, line area, spline, box, trendbox, control, and trend reports.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_y_axis_title</td>
<td>The name to display on the y axis.</td>
<td>An automatically generated description of the report aggregation</td>
</tr>
<tr>
<td>sysparm_y_axis_title_size</td>
<td>A number that defines the font size of the y-axis title.</td>
<td></td>
</tr>
<tr>
<td>sysparm_y_axis_title_bold</td>
<td>A boolean value that controls whether the y-axis title text is bold.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_y_axis_opposite</td>
<td>A boolean value that controls if the y axis appears on the left of the report.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_y_axis_display_grid</td>
<td>A boolean value that controls if horizontal grid lines appear from the y axis.</td>
<td>true</td>
</tr>
<tr>
<td>sysparm_y_axis_grid_dotted</td>
<td>A boolean value that controls whether the horizontal grid lines are dotted.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_y_axis_label_size</td>
<td>A number that defines the font size for increment labels on the y axis.</td>
<td>12</td>
</tr>
</tbody>
</table>
### How to report on extended tables

Learn how to include fields from tables that extend the Task table in a single report. For example, you could include both incidents and problems in a single report.

Role required: report_admin

### Related tables in reporting

Watch the video to learn how to use dot-walking, dynamic filters, and database views to access data on extended, or related, tables.

### Reporting on extended table fields using dot-walking

Dot-walking provides access to fields on extended, or related, tables, enabling you to report on fields from those tables.

When creating or editing a report, you can access references on extended tables from the Group by/Stack by, or row/column, fields on the Configure tab. If the currently selected table contains a reference to another table, it is denoted by the (춘) icon.

Dot-walking references a field by building a chain of field names separated by dots (periods). For instance, `incident.assigned_to.company` references the company of the user assigned to an incident. The recommended limit for chain length is three levels.

### Report on service catalog variables

Create reports grouped by a variable on a selected service catalog item. In addition you can create filters on the same variable. For example, if a specific mobile phone item has a storage variable, you can create a report that only shows those phones with 32 GB of storage.

- To group by variables, see [Group a report by service catalog variables – Report Designer](#).
- To group a report on a field and additionally group by a variable, see [Add additional group by variables to a service catalog report](#).
- To add a variable field to a list report, see [Create a list report with variable columns](#).

### Use service catalog variables in a report – Report Designer

For reports on service catalog data, you can stack and group data by variables, use variables as columns in list reports, and use variables as columns and rows in multilevel pivot tables.

Role required: itil, report_user, report_admin, report_global for global reports, or report_group for group reports

---

### Table: sysparm_y_axis_label_bold, sysparm_y_axis_from, sysparm_y_axis_to

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_y_axis_label_bold</td>
<td>A boolean value that controls whether the y-axis increment labels are bold.</td>
<td>false</td>
</tr>
<tr>
<td>sysparm_y_axis_from</td>
<td>A number defining the lowest value displayed on the y axis.</td>
<td></td>
</tr>
<tr>
<td>sysparm_y_axis_to</td>
<td>A number defining the highest value displayed on the y axis.</td>
<td></td>
</tr>
</tbody>
</table>
Note:

- The report for which you want to use the variable must report on the Requested Items table (sc_req_item) or Catalog Task table (sc_task). Using other types of variables causes an error when generating the report.
- The Oracle Database CLOB field does not have the functionality to retrieve the variables data in reports. For a column string field of less than 4000 bytes, you can change the column type to varchar2; or to compare the CLOB columns of a smaller size, use the to_char() function. For a larger size CLOB, you need to get a substring for comparison using dbms_lob.substr functions.

For primary **Group by** and **Stack by** these steps are intuitive.

Variable use in Group by and Stack by fields.

Note: List, Box, Trendbox, and Pivot reports cannot use service catalog variables as a primary or secondary **Group by**. Single Score, Calendar, Control, and Map reports do not support **Group by** on any fields. List reports can use service catalog variables as columns.

Follow these steps below to use a variable as an additional **Group by**, as a column in a list report, or as a column or row in a multilevel pivot table.

1. Navigate to **Reports > View / Create** and open the report to add the variable to.
2. Do one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add as a column in a list report</td>
<td>On the <strong>Configure</strong> tab, select <strong>Variables</strong> at the bottom of the <strong>Available</strong> slushbucket.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
Add as an additional Group by | On the Configure tab, click Additional group by, then select Variables+ at the bottom of the Available column in the Additional group by slushbucket.

As as a column or row in a multilevel pivot table | Click Select columns or Select rows, then select Variables+ at the bottom of the slushbucket that appears.

3. Click the structure icon ( ) the plus sign that appears. A list of service catalog items appears.

4. Select a catalog item where the variable has been added. The variables for that item appear in the Available slushbucket.

5. Move the variable that you want to use to the Selected column.

6. Save the report.

**Group a report by service catalog variables – Report Designer**

You can create reports grouped by variable on a selected service catalog item. In addition you can create filters on the same variable. For example, if a specific mobile phone item has a storage variable, you can create a report that only shows those phones with 32 GB of storage.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.

You can apply these steps to any report type as long as the report source has variables associated with it. If the report source does not have variables, the Variables option does not display in the Group by and Stack by fields.

**Note:** List, Box, Trendbox, and Pivot reports cannot use service catalog variables as a primary or secondary Group by. Single Score, Calendar, Control, and Map reports do not support Group by on any fields. List reports can use service catalog variables as columns.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has variables associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, select the report type and click Next.
6. On the Configure tab, select Variables from the Group by or Stack by filters.
7. Click **Select item** to choose the item the variable is associated with.
8. Click **Select variable** to choose the variable to group or stack by.
9. In the **Variables** window, click the filter icon (🔍) to choose the variable.
10. Continue to configure and style the report according to its report type. See [Creating reports](#).

**Add additional group by variables to a service catalog report**

You can create reports grouped by any field with an additional group by variable on a selected service catalog item. In addition, you can create filters on the same variable. For example, if a specific mobile phone item has a storage variable, you can create a report that only shows those phones with 32 GB of storage.

Role required: itil, report_user, report_group, report_global, report_admin, or admin. To create a meaningful report, you must have the right to access the data you want to report on.
You can apply these steps to any report type as long as the report source has variables associated with it. If the report source does not have variables, the Variables option does not display in the Additional group by filter.

1. Navigate to Reports > Create New.
2. On the Data tab, give the report a name that reflects the information being grouped.
3. Select a report source that has variables associated with it. There are two kinds of report sources:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source</td>
<td>A table with filters applied to provide a single source of information for all users.</td>
</tr>
<tr>
<td>Table</td>
<td>The raw data from a table with no filters applied.</td>
</tr>
</tbody>
</table>

4. Click Next.
5. On the Type tab, select the report type and click Next.
6. On the Configure tab, select a Group by filter.
7. Click Additional group by.
8. Select Variables (+) and click the structure icon (\(\text{structure icon}\)) to choose an item.
9. Select a **Catalog item**.
The variables associated with the item appear in the **Additional group by** window.

10. Add the variables desired variables to the **Selected** column and click **OK**.
11. Continue to configure and style the report according to its report type. See [Creating reports](#).

**Chart colors**

Report administrators can change the look of charts by specifying colors used to represent specific report data categories.

You can configure the system to use the same color for all bars on a bar or column chart. You can also define new system colors that can be used in charts. The following reports use the color palette specified on the **Style** tab of the Report designer:

- Pie charts
- Bar and column charts that have a **Stack by** or **Group by** value
- Line and trend reports that have a **Stack by** or **Group by** value
Bar and column charts and line and trend reports that do not have a **Stack by** or **Group by** value use one color.

**Using chart colors**

Newly generated bar or pie chart reports update the Chart Colors list to show each data category for the report and the color associated with the category. The colors used in bar and pie charts for a particular data category are consistently used across all bar and pie charts created. For example, priority 1 incidents in a chart always have the same color and do not change color based on their relative position within the chart.

Colors from the following list are automatically assigned to each category the first time the category is used in a chart. If there are more than 15 possible categories, the colors repeat.

![Chart colors]

**Define colors for report data categories**

You can define colors for a specific value for a data category.

Role required: report_admin

1. Navigate to **Reports > Administration > Chart Colors**.
2. Click **New**.
### New Chart Colors form

3. Fill in the fields, as appropriate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Table used for the report.</td>
</tr>
<tr>
<td>Application</td>
<td></td>
</tr>
<tr>
<td>Color name</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td></td>
</tr>
<tr>
<td>Element</td>
<td>Column name specific to the selected table.</td>
</tr>
<tr>
<td>Value</td>
<td>The sys_id of the value for which the specified color should be displayed.</td>
</tr>
<tr>
<td>Color name</td>
<td>Color name, as defined in the Color Definition module. When a report is</td>
</tr>
<tr>
<td></td>
<td>generated, this color is used to represent the specified Value.</td>
</tr>
</tbody>
</table>

**Note:** The list shows only tables and database views that are in the same scope as the chart colors record.

**Note:** A sys_id value applies when the element being used is a reference type. For choice type fields, this value must be the value defined in choice entries. When entering the value, letter casing must match.

To understand the various ways to get a record's sys_id, see The unique record identifier (sys_id).
Define system colors for reports

You can define colors that the system uses in reports.

1. Navigate to Reports > Administration > Color Definition.
2. Click New.
3. Fill in these fields.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a unique name for the new color.</td>
</tr>
<tr>
<td>Color</td>
<td>Enter a hexadecimal value, for example #003366.</td>
</tr>
</tbody>
</table>

4. Click Submit.

The default color scheme glide.ui.chart.default.colors contains the following 20 colors:
Scoped reports

When editing a report from a different application scope than the current scope, actions modifying the original report are unavailable.

To modify the original report, change the current application scope to the report’s scope and make any changes.

The following actions are available from the Save menu after opening a report from a different application scope in the Report Designer. Other actions, such as Update are not available.

- Insert
- Insert and Stay
- Schedule
- Add to Dashboard
- Export to PDF
- Report History

You can create a new report based on an existing report, but within the current application scope using the Insert or Insert and Stay options.
Administering reports

Learn about the tasks report administrators typically perform, the objects that they work with, and the roles and rules that apply.

To administer reports, reporting roles, and report sources, navigate to Reports > Administration and select the area to administer.

Reporting roles

> Note:
- Users must have the report_user role to see the Reports module on the application navigator (left navigation pane).
- Users with any reporting role or the itil role can access the following report options for all reports that are visible to them: Insert, Insert and Stay, Add to Dashboard, and Export to PDF.
- In the table below, the term manage indicates access to the following report options: Update, Delete, and Export settings.

Navigate to User Administration > Roles to manage roles.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No role</td>
<td>Can view reports that are shared with them.</td>
</tr>
<tr>
<td>itil (itil), report user (report_user)</td>
<td>Can create and view reports that have been shared with them. Cannot share, edit, or delete reports that have been shared with them.</td>
</tr>
<tr>
<td>report publisher (report_publisher)</td>
<td>Can Publish reports that they can manage. Publishing a report creates public a link to that report. Users with this role must also have another role that grants permission to create, edit, and share reports.</td>
</tr>
<tr>
<td>report scheduler (report_scheduler)</td>
<td>Can Schedule emailing of all reports that they can see, including reports they cannot manage. Users with this role must also have another role that grants permission to create, edit, and share reports.</td>
</tr>
<tr>
<td>group report user (report_group)</td>
<td>Can manage and share reports that are shared with them (listed in Group).</td>
</tr>
<tr>
<td>global report user (report_global)</td>
<td>Can manage reports that are shared with everyone (listed in Global).</td>
</tr>
<tr>
<td>report administrator (report_admin)</td>
<td>Can manage, share, publish, and schedule all reports. Can access Reports &gt; Administration and manage all report-related objects. The report_admin role inherits all other report roles.</td>
</tr>
</tbody>
</table>
Restrict report creation with an ACL rule

Create an access control list rule to restrict who can create a report on a table, data source, or database view.

Requires role: security_admin

Note: In addition to report_on ACLs for specific tables, a write ACL on the (sys_report) table controls write access for all reports. If this ACL prevents you from saving the current report, the Save button in the Report Designer or Report Builder is disabled. For example, when you view a report that another user shared with you. If you have the correct security settings, click Save > Insert to save an editable copy of the report.

1. Navigate to System Security > Access Control (ACL).
2. Add an access control record with the following information:
   
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>record</td>
</tr>
<tr>
<td>Operation</td>
<td>report_on</td>
</tr>
<tr>
<td>Name (table)</td>
<td>&lt;select the table name&gt;</td>
</tr>
</tbody>
</table>

3. Define the rules that determine whether a user can report on a table.

   If a user does not have report_on access for a table, the table does not appear in the Table field when the user creates a report. Data sources based on tables for which a user does not pass the report_on ACL do not appear in the Data Source list in the Report Designer and Report Builder. To restrict one or more users from seeing a data source in the Report Source list, create a new read ACL on the (sys_report_source) table that excludes those users.

Note:

- Users can view and run reports on tables even if they cannot create reports due to report_on ACL restrictions.
- System tables are not reportable by default. To allow reporting against system tables, administrators can configure the glide.ui.permitted_tables property. To learn more, see Reporting on system tables.
- The ACL report_on operation grants the right to report on the target table.
- Database views have their own ACLs. If a user has report_on rights to all the tables in a database view, they still require report_on rights on the database view to create reports on it. See Database views.

Report_view access control

Report_view table ACLs prevent users from viewing report content derived from the table specified in the ACL. Report_view field ACLs prevent users from viewing reports that aggregate data grouped by the field specified in the ACL.

For example, a report_view field ACL restricts itil and report_user roles from viewing the salary field in an HR table. When a manager shares a report grouped on the salary field, the itil or report_user role sees the message ‘Access to this content denied based on report_view field ACLs’.

Note: To restrict the visibility of aggregated data that is grouped by an inherited field, the report_view field ACL must be defined on the table from which the field is inherited. For
example, to restrict visibility of incident data grouped by the assigned_to field, then you must create the ACL on the task.assigned_to field, not the incident.assigned_to field.

List reports do not honor report_view field ACLs. To restrict access to columns in list reports use read ACLs.

Remove the old Report Builder UI

The admin can remove the old Report Builder and restrict users to the new Report Designer UI for creating and editing reports. With users restricted to the new UI, they can no longer switch to the old UI through a UI hyperlink in the upper right corner of the Report Designer.

Role required: admin

The new Report Designer has a clearer work flow, is easier to navigate, and is generally easier to use.

1. Follow the steps to Add a system property
2. Add the glide.ui.report.old_report_builder property, and set the property value to false to disable use of the old Report Builder UI.

Report statistics

The Report Stats list enables you to view how often each of your reports is run and how long it takes for the reports to run.

Role required: admin or report_admin

To view report statistics, navigate to Reports > Administration > Report Statistics. By default, the Report Statistics list displays all reports that have been run. To view all reports, click the context menu icon (≡) and select Add Unused Reports.

Note: Adding unused reports to this list takes some time, especially if your instance contains many reports.

The Report Stats list has the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>The name of the report. Click the hyperlink to view the report properties.</td>
</tr>
<tr>
<td>Last run</td>
<td>The date and time the report was last run.</td>
</tr>
<tr>
<td>Runs</td>
<td>The number of times the report has been run.</td>
</tr>
<tr>
<td>Runs on page</td>
<td>The number of times the report has been run on dashboard or homepage.</td>
</tr>
<tr>
<td>Recent run time</td>
<td>The average execution time of the report in milliseconds based on the 25 most recent runs. Edit the glide.report.recent_executions_number property to change the number of runs used to calculate this value.</td>
</tr>
</tbody>
</table>
### Column Description

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run time</td>
<td>The average execution time in milliseconds of all runs of the report.</td>
</tr>
</tbody>
</table>

- To view the reports that take the most time to run, sort **Recent run time** from z-a.
- To view used reports, filter out the value 0 from the **Runs** column.
- To view the most used reports, sort the **Runs** column from z-a.

### Reports Usage dashboard

The Reports Usage dashboard provides an overview of how reports are used in a ServiceNow instance or domain.

To view report statistics, navigate to **Performance Analytics > Admin Console** and select **Report Usage** on the Usage tile.

**Note:** The report_admin role cannot view this console. The admin or pa_admin role is required.

The Reports Usage dashboard shows the following widgets:

<table>
<thead>
<tr>
<th>Widget</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Reports</td>
<td>Single Score with percentage</td>
<td>The number of reports in the instance. Click the score to view a dashboard with chart and lists of breakdowns, records, and scores.</td>
</tr>
<tr>
<td></td>
<td>change month on month.</td>
<td></td>
</tr>
<tr>
<td>% Reports not viewed in</td>
<td>Single Score with percentage</td>
<td>The percentage of reports in the domain or instance that have not been viewed in the last six months. Click the score to view a detailed dashboard</td>
</tr>
<tr>
<td>the last 6 months</td>
<td>change month on month.</td>
<td>with a chart on which you can adjust the period, the calculation used, and additional information on the report.</td>
</tr>
<tr>
<td>Top 10 Report Tables</td>
<td>List</td>
<td>A list of the top 10 tables used in reports. Point to the name of a table to read its description. Click the name of the table or the number of reports to show a dashboard with an enlarged chart, a list of the records in the table, the scores, and additional information on the report.</td>
</tr>
<tr>
<td>Reports by Visualization</td>
<td>Bar chart (with option to change the visualization to one of several other report types)</td>
<td>The number of times the report has been run on dashboard or homepage. Click a report segment to show a dashboard with an enlarged chart, a list of the records in the table, the scores, and additional information on the report.</td>
</tr>
</tbody>
</table>
Report sources

Report sources are predefined data sets for creating reports.

Use report sources for reports containing the same conditions, so you do not have to define the conditions more than once. You can also use report sources to implement the same definitions across your organization.

A report source always consists of a table and a number of conditions. When you create a new report, you can either use a report source or select a table. Some examples of report sources are open incidents, closed problems, and so on.

Create a report source

Create a custom set of data that you can use to create reports. In the Report Designer and Report Builder, report sources are called Data Sources.

Role required: report_admin

If you update the conditions in a report source, these conditions are automatically propagated to all reports based on that report source.

1. Navigate to Reports > Administration > Report Sources.
2. Click New.
3. Fill in the fields on the form, as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the report source. For example, <em>Open incidents</em></td>
</tr>
<tr>
<td>Table</td>
<td>The table on which the report source is based. For example, <em>Incident (incident)</em></td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description of what the report source does and its purpose.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Conditions for the specific table records to include in the report source. For example, to include open incidents, select (State) (is) (Active) for the Incident table.</td>
</tr>
</tbody>
</table>

**Note:**
- If the report source is used for a report that includes OR conditions, only records that match both the report and the report source conditions are included.
- Sorting on data fields is accessible from within reports for specific report types. For information on how to access, search for the Add Sort field description in a Creating reports topic for the report type to sort data on.
- If a report source specifies a Add related list conditions, a report created that is based on the report source will ignore any additional related list conditions specified from within the report.

4. To view reports based on a report source, click the **Reports using this report source** related link in the report source record.

5. Click **Submit**.

Use the report source to create a report.

**Note:** While a report source is used by active reports, you cannot delete it.

### Report ranges

Use a report range to define data intervals that are used in bar and pie charts.

Sometimes it can be helpful to group results into ranges or buckets rather than viewing every result as an individual score. Think of a bar or pie chart which shows a percentage result. By default each individual value from 0% – 100% would be a separate data point, creating an unnecessarily crowded-looking visual. However, segmenting the results into logical groups of scores can add context and help the audience understand which ranges are good, bad, or concerning. A report range is used to define data intervals for bar, pie, and donut charts. For example, if you’re interested in understanding how many tasks were completed well within the SLA versus how many elapsed during the SLA.

Example use case: There is a significant cost involved to a business each time a SLA is breached at a company. A Service Manager can understand which SLAs are being easily met versus which ones are being breached, or are coming close to being breached. This information helps her identify which SLAs may need to be adjusted.
Note: Reports only show historical data. It is not possible to set report ranges for dates in the future.

Incidents created date with ranges

Note: The module for report ranges is hidden by default. You may need to enable the module before use. For more information, see Enable or disable an application menu or module.

How report ranges work

Report ranges work with elements that hold only dates, lists, or integers.
## Report range elements list

<table>
<thead>
<tr>
<th>Type</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dates</td>
<td>Using the Created field in the Incidents table: Same Day, 2 Days, 2–5 Days, 5–7 Days, 1–2 Weeks, 2–4 Weeks, 1–2 Months, &gt; 2 Months</td>
</tr>
<tr>
<td>Lists</td>
<td>Using the Priority field in the Incidents table: Low, Moderate, High, Critical, Planning</td>
</tr>
<tr>
<td>Integers</td>
<td>Using the Count field in the Incidents table: Overloaded, Optimized, Under Utilized</td>
</tr>
</tbody>
</table>

Report ranges can be globally applied to all date type fields (date, due date, duration, date/time, date/time), or you can limit report ranges to a specific table.

### View all report ranges

To view all currently configured report ranges, navigate to Reports > Administration > Report Ranges.
**Report ranges list**

The following are important columns and their associated data types:

<table>
<thead>
<tr>
<th>Field</th>
<th>Corresponding data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper value duration</td>
<td>Date - works with elements that store dates.</td>
</tr>
<tr>
<td>Upper value int</td>
<td>Integer - works with elements that store numbers.</td>
</tr>
<tr>
<td>Value list</td>
<td>List - works with elements that store a list item.</td>
</tr>
</tbody>
</table>
Create a report range

Create a report range to define data intervals that are used in bar and pie charts.

1. Navigate to Reports > Administration > Report Ranges.
2. Select New.
3. Fill in the form (see table):

   ![Range Form](attachment:image)

   Use the following fields to refine the data displayed in the report and to design the appearance of your line chart:
### Report range form fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the table to draw the values from.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field is required before you can select from the Element list.</td>
</tr>
<tr>
<td>Element</td>
<td>The table field to draw the values from.</td>
</tr>
<tr>
<td>Label</td>
<td>The name for the report range that is displayed in reports.</td>
</tr>
<tr>
<td>Value list</td>
<td>For list elements, this field defines which values are within the range.</td>
</tr>
<tr>
<td></td>
<td>After the range is saved, the value list is populated with the choices of</td>
</tr>
<tr>
<td></td>
<td>the element.</td>
</tr>
<tr>
<td>Color name</td>
<td>The color to display this report range in.</td>
</tr>
<tr>
<td></td>
<td>The color appears in the Display field. If you enter a color name, you do</td>
</tr>
<tr>
<td></td>
<td>not need to enter a color value.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When creating reports, colors may not display as specified for</td>
</tr>
<tr>
<td></td>
<td>ranges on Group by report fields selected via dot-walking. For this feature</td>
</tr>
<tr>
<td></td>
<td>to work appropriately, select applicable Group by fields from the base</td>
</tr>
<tr>
<td></td>
<td>table only.</td>
</tr>
<tr>
<td>Color</td>
<td>The hexadecimal value for the color to report this report range in.</td>
</tr>
<tr>
<td></td>
<td>The color appears in the Display field. If you enter a value for color,</td>
</tr>
<tr>
<td></td>
<td>you do not need to enter a color name.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When creating reports, colors may not display as specified for</td>
</tr>
<tr>
<td></td>
<td>ranges on Group by report fields selected via dot-walking. For this feature</td>
</tr>
<tr>
<td></td>
<td>to work appropriately, select applicable Group by fields from the base</td>
</tr>
<tr>
<td></td>
<td>table only.</td>
</tr>
<tr>
<td>Upper value int</td>
<td>The upper limit of the range. The upper value of the report range with</td>
</tr>
<tr>
<td></td>
<td>nearest lower Order defines the lower limit of this range. If no range</td>
</tr>
<tr>
<td></td>
<td>with a lower Order exists, the lower limit is zero.</td>
</tr>
<tr>
<td></td>
<td>Example: One report range has an upper limit of 10 and an Order of 20. A</td>
</tr>
<tr>
<td></td>
<td>second report range has an upper limit of 5 and the Order of 19. Values</td>
</tr>
<tr>
<td></td>
<td>from 5 to 10 display the formatting specified by this range.</td>
</tr>
</tbody>
</table>
### Upper value duration

For duration-type elements, this field defines the upper limit of the range. The upper value of the report range with nearest lower **Order** defines the lower limit of this range. If no range with a lower **Order** exists, the lower limit is zero.

Example: One report range has an upper limit of 10 and an **Order** of 20. A second report range has an upper limit of 5 and the **Order** of 19. Values from 5 to 10 display the formatting specified by this range.

### Display

Read-only. Shows the color that is used for the specific report range.

### Order

The order in which the report ranges are used. If a value is defined within more than one label, it is reported under the report range with the lowest order.

---

**Note:** Once configured, a report range will show as empty if there's no data available in your report. Context fields such as data labels or legend related to the configured report range will still show and be highlighted.

### Using imported report data

Imported Excel spreadsheets enable you to generate reports based on data maintained outside of your instance and to distribute those reports.

Users with admin, sys_admin, report_admin, pa_admin, and pa_power_user roles are able to upload .xlsx files. Uploaded data is temporary and has a specified expiration date, after which reports based on those files are no longer available.

You must have Performance Analytics to create reports with imported data. See [Activate Performance Analytics Premium](#).

**Note:** Importing report data in this way is useful when you have information that is maintained outside of your instance. To import an external data set into your instance permanently, see [Easy import](#).

### Reporting on system tables

System tables are, by default, restricted from the Reporting module.

These tables include, but are not limited to:

- Sys audit (sys_audit)
- Log (syslog)
- Transaction Log (syslog_transaction)
- Attachment (sys_attachment)
- Email (sys_email)
The reason for this is because `sys_audit` is typically the largest table in any instance. It is not unusual for the audit table, in even a mid-sized instance, to be several gigabytes. In a large installation, this table can be 50GB or more.

When we access the `sys_audit` table programmatically, we know what our query pattern is going to look like, so we have added appropriate data indexes to match our queries. This means that when you bring up, for example, the history of an incident, the database can use an index to efficiently pull back the few dozen rows it needs for that query.

With freeform reporting, however, we cannot predict what your query pattern is going to look like. Maybe you want to group by `fieldname`, or sort by `oldvalue`. So it is possible your queries are not going to be indexed queries. The net result is you will be asking the database to table scan a multiple gigabyte file, which is bad for these reasons:

- It is slow, so your report will take an unacceptably long time to run.
- While the database is scanning your table, your instance will slow down or even become unavailable because other queries cannot get the resources they need.

If you must report on a system table, you can add it to the `glide.ui.permitted_tables` property. Navigate to System Properties > UI Properties and locate the property labeled List of system tables (beginning with "sys_", comma separated), that are reportable. By default, system tables are not reportable. Proceed with caution.

**Map report administration**

Learn how about the different objects that are used in map reports, and how to create and modify them.

**Map report objects**

Map objects define the different levels that users can drill down into on a map report and the data displayed on these levels. Admins can create and manage these objects.

Each map report contains a map source hierarchy, which configures the data for a map level. The report also contains a map hierarchy, which defines the map drill levels. The Level field connects levels for these hierarchies. For example, the data in the Level 1 map is displayed on the Level 1 map object.

**Note:** A set of predefined map sources and maps are available by default. Use these predefined objects whenever possible. If you need a map source that does not exist, generate it automatically using Generate map source levels link on the map source form, then customize it. You can automatically generate map source levels only for map sources that reference the location table. These map sources have a field that ends in `.location`. 
Map report

Map source hierarchy (Map data)

Level 1 map source

Level 2 map source

Level 3 map source

Map hierarchy

Level 1 map (Set map)

Level 2 maps

Level 3 maps

Selected when you create a map report, fields on the report form listed in bold

Map objects

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map source</td>
<td>Defines a set of data to display on a map report.</td>
</tr>
<tr>
<td></td>
<td>The map source that a user selects in the Map data field when creating a</td>
</tr>
<tr>
<td></td>
<td>map report is actually a map source hierarchy. There is one map source</td>
</tr>
<tr>
<td></td>
<td>level for each drill level on the map. The top map source in the hierarchy</td>
</tr>
<tr>
<td></td>
<td>is not a level, but rather a wrapper for other hierarchy levels. Each map</td>
</tr>
<tr>
<td></td>
<td>source contains the data for a single map hierarchy drill level, with both</td>
</tr>
<tr>
<td></td>
<td>having the same Level.</td>
</tr>
<tr>
<td></td>
<td>Because they both specify the data that is used for a report, a map</td>
</tr>
<tr>
<td></td>
<td>source is similar to a report source. However, in a map source you select a</td>
</tr>
<tr>
<td></td>
<td>field to report on instead of a table.</td>
</tr>
</tbody>
</table>
### Object | Description
--- | ---
**Map** | The map that data is displayed on. Maps are set up in a hierarchy defined by parent-child relationships. Each hierarchy level is a drill level on the map report. A JSON definition (geoJSON definition for geographical maps) defines the actual map layout.
Select an existing map or create a new one. You can optionally define conditions for a map, which further filters the data it displays.

**Mappings** | Transform the data in a map source to a value that can be displayed on a map.
Mappings are organized into the **Countries** and **State / Province** mapping groups. During map source configuration, you select the mapping group to transform the data in that source. The mapping group that you select must match the **Field** that you have selected.

For example, a map source that has a **Field** value of **Locations Country** would use the **Country mappings** group. A map source that has a **Field** value of **Locations State / Province** would use the **Region and state mappings** mapping group.

---

### Automatically generate a map source hierarchy

A map source hierarchy is a data source that is used to create a map report. Except for the top-level wrapper, each map source level in the hierarchy defines the data for one map drill level.

*Role required: report_admin or admin*

**Note:** A set of predefined map sources and maps are available by default. Use these predefined objects whenever possible. If you need a map source that does not exist, generate it automatically using **Generate map source levels** link on the map source form, then customize it. You can automatically generate map source levels only for map sources that reference the location table. These map sources have a field that ends in `.location`.

1. Navigate to **Reports > Administration > Map Sources**.
2. Click **New**.
3. Fill in these fields.

**Map Source fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter a descriptive name. For example, Incident by location. Users select the map source by this name in the Map data field when they create a map report.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>Select the table that contains the field that you want to map. All map source levels in the hierarchy use this table.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td>Select the field with the data that you want to display on the map report. This field must reference the location table. For example, <code>incident.caller.location</code> or <code>incident.location</code>. You can dot walk to this field.</td>
</tr>
<tr>
<td><strong>Active</strong></td>
<td>Select this check box to make the map source available when creating map reports.</td>
</tr>
</tbody>
</table>

4. Right-click the form header and select **Save**.
5. Click **Generate map source levels**.
Three map source levels are created. Only the level 1 map source is visible in the Map Sources related list.

Note: A map source can have up to four levels, but only three are automatically generated. If the map hierarchy you are using requires an extra drill level, you can create a fourth level map source.

The map source is ready to use in a map report.

Customize a map source level

A map source configures data to be displayed in a map report. Customize existing map sources according to your needs.

Role required: report_admin or admin

Note: A set of predefined map sources and maps are available by default. Use these predefined objects whenever possible. If you need a map source that does not exist, generate it automatically using Generate map source levels link on the map source form, then customize it. You can automatically generate map source levels only for map sources that reference the location table. These map sources have a field that ends in .location.

1. Navigate to Reports > Administration > Map Sources.
2. Open the map source whose level you want to customize, then navigate down to the appropriate level using the Map Sources related lists.
   For example, click the level 1 map source name to reopen the Map Source form with the level 2 map source in the related list, and so on.
3. Modify these fields as appropriate.

   Map source fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the map source. Include the level in the names of map source levels. For example, Incident by location - level 2.</td>
</tr>
<tr>
<td>Table</td>
<td>The same table is used throughout a map source hierarchy, and is specified in the top-level map source.</td>
</tr>
</tbody>
</table>
Field | Description
--- | ---
Field | Select the field whose data you want to display on the map. You can dot walk to other fields. Select a field that is one level more granular than the map you want to display the data on.

For example, imagine you are configuring data for a level 1 map source that is displayed on the world map. Because the data for countries are displayed on the world map, select **Location Country**. Similarly, if you are configuring data to display on a map of Germany or the United States, select **Location State / Province**.

**Note:** The city label is the most granular level able to be displayed when drilling down into a map report. For example: If you want to report on various site locations within a city, and define the bottom-level map source field to include location.name, the map report displays the multiple locations as the corresponding city labels. As a result, reporting on multiple locations which have the same location.city value results in displaying multiple map dots with the same label, but with different aggregated values, and which drill down to different locations.

Most map sources use a field on the Location table.

Level | Select a hierarchy level for this map source. You can have a maximum of four levels. Each map source level corresponds to a drill level on the map hierarchy, and these levels much match. Each level must exist in a hierarchy only once.

Active | Clear this check box to make this map source unavailable when creating map reports.

4. **In the Data transformation** section, modify these fields as appropriate.

Field | Description
--- | ---
Data | Select how to use data in this map source.

- **Use data on table:** Use the data in the ServiceNow platform without transforming it. Select this option when the data already matches the JSON key values that you are mapping to.
- **Use mapping:** Transform that data so it matches the JSON key values that you are mapping to. For geographical map sources that use the hc-key geoJSON key, always select this option.
- **Use longitude and latitude:** Use latitude and longitude coordinates to plot your data. Always select this option for the bottom map level, such as level 3. Ensure that your data has latitude and longitude values.

**Warning:** Because the **Use longitude and latitude** option disables heatmap and drilling for maps using this map source, select this option only on map source levels that are the bottom level in a hierarchy.
5. In the **JSON key** section, select a JSON key to connect the map source data to maps. Geographical maps typically use hc-key.

   Every report map has a JSON definition. Select one JSON key-value pair to map the data to. The data to appear on the map must match the JSON key values. So the key that you select determines whether you must transform your data with the settings in the **How to use data** section. All default platform maps and mappings use the geoJSON hc-key and ISO 3166 standard values. For custom maps, you can enter a different JSON key.

6. Click **Update**.

---

### Create a key-value pair mapping

Key-value pair mappings transform data in the ServiceNow platform to a value that can be plotted on a map. Mappings are used during map source configuration when data requires transformation. Each mapping exists in a mapping group.

**Role required:** report_admin or admin

Default system key-value pairs map data to geoJSON hc-key values. All hc-key values follow ISO 3166 standards. Default mappings exist for the most commonly used data values. If your data uses a different value, you must create a key-value pair mapping.

For example, the default mapping for United States of America maps key USA to ISO value us. If your data has value of United States instead of USA, you must make a new key-value pair to map United States to ISO value us.

1. Navigate to the Locations Mappings (sys_report_map_source_mapping) table.
2. Open the mapping group to add the mapping to.
   - Select the mapping group that corresponds to type of object that you want to create a mapping for. For example, if you are creating a mapping for field value United States, select the **Country mappings** group.
3. Click **New**.
4. Fill in these fields.

   **Locations Mappings form**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The field value to transform. For example, USA.</td>
</tr>
<tr>
<td>Value</td>
<td>The value to transform the key to. For example, us. This value is typically an ISO 3166 standard value. Each value can be used only once per map.</td>
</tr>
<tr>
<td>Map</td>
<td>The map to associate with this mapping. If you do not fill in this field, this mapping can be used with any map.</td>
</tr>
</tbody>
</table>

5. Click **Submit** to save your changes.
Add the mapping to a report source, so it can be used to map data from that source to a map.

**Create a map**

Create a map that can be used in a map hierarchy.

Role required: report_admin or admin

1. Navigate to Reports > Administration > Maps, and click New.
2. Fill in the following fields as appropriate.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>Specify a unique key that links this map to other maps. For default maps, the key is the hc-key value. The key must be included in the geoJSON of the parent map.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the map.</td>
</tr>
<tr>
<td>Level</td>
<td>Specify the level for this map in the map hierarchy.</td>
</tr>
<tr>
<td>JSON definition</td>
<td>Define the geoJSON for the map. You can download predefined maps from Highcharts, or use any map that follows geoJSON standards. For more information, see the GeoJSON site.</td>
</tr>
<tr>
<td>Parent</td>
<td>Select a parent map for this map. The parent-child relationships define drill levels in a map hierarchy.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this check box to make the map unavailable when creating map reports.</td>
</tr>
<tr>
<td>Geographical map</td>
<td>If your map is not geographical, clear this check box. For example, clear this check box for a floor map.</td>
</tr>
</tbody>
</table>

3. Right-click the form header and select Save.
4. To add conditions that filter the data in the map:
   a) Click New in the Map conditions related list.
   b) Fill in these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select this check box to apply this condition.</td>
</tr>
<tr>
<td>Table</td>
<td>Specify the table that these conditions apply to. Conditions cannot be shared across tables.</td>
</tr>
<tr>
<td>Map source</td>
<td>Select the map source that the condition applies to.</td>
</tr>
<tr>
<td>Conditions</td>
<td>Add filter conditions to apply to this map.</td>
</tr>
</tbody>
</table>

5. Optional: In the Report Maps related list, create a child map to extend the map hierarchy.
6. Click Update to save the map.

*Set the default map for map reports*

You can change the map that appears by default in the Set map field when you create a map report.
Role required: admin or report_admin

1. Navigate to Reports > Administration > Properties.
2. In the Set the default map for reports of type 'Map' field, type the key of the map that you want to set as default.
   You can find a list of maps under Reports > Administration > Maps.
3. Click Save.

Create coloring rules for multilevel pivot table reports

Configure rules for how numerical values are displayed in a multilevel pivot table report, to easily highlight the more important values. The color rule is applied to the content of cells in pivot reports.

Role required: report_admin or admin

   If you see the error message 'Security constraints prevent access to requested page,' an ACL is preventing access. If necessary, a user with the security_admin role should create new read and write ACLs on the Multilevel Pivot Rule (sys_report_mpivot_rule) table.
2. In the Multilevel Pivot Rules dialog box, click New rule.
3. Fill in the fields on the form.

### Multilevel Pivot Rule fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>The operator used when evaluating values in cells, such as greater than or between. For example, to style cells with a value less than 5, select lower than and specify a Value 1 value of 5.</td>
</tr>
<tr>
<td>Value 1</td>
<td>The number to evaluate cell values against. When the Operator value is between, enter the lower value in the Value 1 field.</td>
</tr>
<tr>
<td>Value 2</td>
<td>The maximum value a cell can contain to match this rule. This field only appears when the Operator value is between.</td>
</tr>
<tr>
<td>Font color</td>
<td>The font color to apply to cells that match this rule.</td>
</tr>
<tr>
<td>Background color</td>
<td>The background color to apply to cells that match this rule. This option applies only to multilevel pivot table reports.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule order</td>
<td>A numerical value that determines the order in which rules apply. Rules with a higher rule order apply later and override lower-order rules. For example, one rule matches cells with a value greater than 140, and another rule matches cells with a value less than 150. The rule with the higher order applies to cells with values from 141 through 149.</td>
</tr>
</tbody>
</table>

4. Click **Submit** to save the rule and create a new rule, or click **OK** to save the rule and return to the Report Designer.

#### Create coloring rules for single score reports

Configure rules for how numerical values are displayed in single score reports, to easily highlight why a value is important.

This task is part of configuring the style options of a single score report.

1. On the **Style** tab of the Report Designer, click **Edit coloring rules**.
2. In the Multilevel Pivot Rules (Single Score Color Rule view) dialog box, click **New rule**.
3. Fill in the fields on the form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operator</strong></td>
<td>The operator used when evaluating values, such as <strong>greater than</strong> or <strong>between</strong>. For example, to style values of less than 5, select <strong>lower than</strong> and specify a <strong>Value 1</strong> value of 5.</td>
</tr>
</tbody>
</table>
| **Value 1**     | The number to evaluate cell values against. When the **Operator** value is **between**, enter the lower value in the **Value 1** field.  
  **Note:** The color rule is applied to the aggregated values. |
| **Value 2**     | The maximum value to match this rule. This field only appears when the **Operator** value is **between**. |
| **Font color**  | The font color to apply to values that match this rule. |

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
4. Click Submit to save the rule and create a new rule, or click OK to save the rule and return to the Report Designer.

## Domain separation in Reporting

This is an overview of domain separation as it pertains to reporting and how it relates to report creation and administration. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

### Overview

**Support: Level 2**

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation. To activate the domain separation plugin, see Request domain separation.

### How domain separation works in Reporting

In the case of Reporting, the data that is separated includes report designs and report content. A report defined at the global level is visible to users in all child domains. In the figure below, the TOP domain represents the global domain.

- Reports created in the TOP domain are visible to users in the Joe’s company domain and HR, CS, and IT child domains of Joe’s company.
- Reports created in either the IT, CS, or HR child domains are not visible to users in the other child domains, but they are visible to users in the parent Joe’s company domain.
- Reports created in the parent Joe’s company domain are available only to users in that domain, but not to users in the child domains.
However, if you create a report in one domain and copy it to another, the report structure remains the same, but the data the report accesses is adjusted for the domain. For example, a report on the [incident] table that shows active incidents will show all active incidents to a user in the parent domain, but only IT incidents to a user in the IT domain.

Enable domain separation on reports

Activate the domain separation plugin to enable reports to display content based on data, rules, and settings from the logged-on user domain.

Requires role: security_admin

By default, the Domain Support plugin separates data on certain tables by domain. It does not, however, separate reports by domain unless the MSP Extensions plugin is installed. The report displays data only from the user's domain, but the user is able to see all the reports.

Follow these steps to ensure domain separation on reports if the MSP Extensions plugin is not installed.

1. Navigate to Reports > Administration and select a report to separate by domain.
2. Right-click the header and select Configure > Dictionary.
3. Configure the dictionary on the sys_domain field and fill in the Reference field with the domain for this report. If left blank, the report is global.

Domain fields appear on reports, and this field references a table. After a domain field exists on a form, all records within the table will have the domain field enabled. By default, all these records are global.
Quick start tests for Reporting

Validate that Reporting still works after you make any configuration change such as applying an upgrade. Copy and customize these quick start tests to pass when using your instance-specific data.

The Reporting quick start test Automated Test Framework - Reporting plugin (com.glide.automated_testing_impl.report) is active by default or instance reboot.

Note: Reporting quick start tests do not test report access from dashboards. To test dashboards, see Quick start tests for Dashboards.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report Visibility</td>
<td>Confirm whether reports are still visible to users whom they are shared with.</td>
</tr>
</tbody>
</table>

Report Visibility test steps

You can customize these pre-configured example test steps.

The Report Visibility test contains two types of steps:

**Impersonate**

When configuring this step, select which user to impersonate when executing the Confirm steps that follow. Select a user with the role or roles whose access you are testing.

**Report Visibility**

When configuring this step, select which report to test. Also select whether the test succeeds with positive results or with negative results. In other words, set whether Report Visibility succeeds when the user can view the report or when the user cannot view the report.

The example test included in the plugin includes the following three steps:

1. Impersonate the user
2. Confirm a test report can be viewed by the test user
3. Confirm a test report cannot be viewed by the test user

However, when you customize a test, you can combine steps in any logical sequence by adding and configuring the two types of steps. For example, you could configure the Report Visibility test as follows:

1. Impersonate a user.
2. Confirm that this user can view a report.
3. Confirm that this user can view another report.
4. Confirm that this user cannot view a third report.

Customize calendar reports

You can specify the fields that are displayed in calendar tasks.

By default, the number and short_description fields are displayed, but this behavior is configurable. Radio buttons on reports can be configured for various fields to highlight calendar
Configure how calendar entries look

To configure how calendar entries appear for a table, add calendar_elements attributes to the System Dictionary entry for that table.

1. Open a form for any record in that table.
2. Right-click the form header and select Configure > Dictionary.
3. In the record list that appears, select the first record that does not have a value in the Column name field.
4. Switch the Dictionary Entry form to the Advanced view. See View management.
5. In the Attributes field, add calendar_elements=<field name>;<field name>, listing the fields you want to appear in each entry of your calendar report separated by semi-colons.

Note: When you define attributes for calendar elements, you replace the default display elements of number and short_description with the attributes that you list in this field. To add any additional attributes to the calendar entry and retain the number and short description of the change, include the number and short_description fields in your attributes. For example, to add state information to your task calendar, add the following attribute to the Task table:

```
calendar_elements=number;short_description;state
```

entries by properties such as priority level and approval status. You can select a unique highlight color for each task property.
6. If the table already has an attribute, separate it from the attribute you are adding with a comma, for example:

   reference_index_include=active,calendar_elements=number;short_description;state

7. Click Update.
The calendar entries display the attributes you have added for the selected table.

Modify or add calendar report system properties

Specify system property values to override Task table highlighting in calendar events, limit the number of events in a calendar cell, or change the day the calendar week starts.

Override Task table field styles for highlighting calendar events

Highlighting for calendar report events is configured with field styles, which are defined for a particular table. You can configure whether calendar reports use field styles from the tables or report sources that they are based on.
Role required: admin

By default, field styles in the Task (task) table are applied to calendar reports. If calendar reports are configured to use field styles from their tables or report sources, these field styles override the Task table styles.

1. In the filter navigator, enter: `sys_properties.list`
2. Select the `glide.ui.report.extend_calendar_choices` property to specify which field styles are used during calendar highlighting.
   - If `false`, calendar reports will use only styles from the Task table when determining options for calendar highlighting. For example, a calendar report on the Change Request (change_request) table will only use styles from the Task (task) table instead of styles from a the combination of the two tables.
   - If `True`, calendar reports will use field styles from the table that the calendar report is based on.
3. Click Update.

Limit the number of events displayed on calendar days

For calendar reports, the maximum number of events that appear in some calendar views is configurable. When this maximum is exceeded a `+ <number>` link appears, which opens a pop-up window with additional events. You can also configure the maximum number of events that appear in this pop-up window. When this maximum is exceeded, a `+ many` link appears, which opens a list of events instead of a pop-up window.

Role required: report_admin, admin

You can configure these settings for the following calendar views:

- A calendar day when calendar is in month or year view
- The top ‘full day’ section of a calendar day when a calendar is in day or week view

1. In the navigation filter, enter `sys_properties.list`.
2. Configure the `glide.report.calendar.max_events_displayed_per_cell` and `glide.report.calendar.max_more_events_per_day` properties.
3. Click Update.

Change the day that calendar weeks start on

By default, weeks for calendar reports start on Monday. You can add a system property to start weeks on Sunday or another day instead. Weeks use ISO numbering regardless of what day they start on.

Role required: admin

The `glide.ui.date_format.first_day_of_week` system property modifies the generated date/time value used in the query and sets the start day of the week in the rendered calendar.

Note:

- `glide.ui.filter.first_day_of_week` must also be set to the same value as `glide.ui.date_format.first_day_of_week` for the set day to display properly.
- If you change the `glide.ui.filter.first_day_of_week` property after collecting Performance Analytics score data, the scores will be removed.

1. Add the `glide.ui.date_format.first_day_of_week` system property.
2. Set one of the following integer values:
Option | Description
--- | ---
Start weeks on Monday | Set Value to 2
Start weeks on Sunday | Set Value to 1

3. Click Submit.

**Set calendar record limit**
By default, calendar reports save up to 10,000 records. Change this limit by setting the `glide.ui.max_calendar_records` system property. If the number of records fetched exceeds this limit, you are prompted to filter the data and run the report again.

Role required: admin

1. Add the `glide.ui.max_calendar_records` system property.
2. Complete the form with the following values.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><code>glide.ui.max_calendar_records</code></td>
</tr>
<tr>
<td>Description</td>
<td>Enter a phrase that describes the function of the property, such as Maximum number of calendar records saved.</td>
</tr>
<tr>
<td>Type</td>
<td>Integer</td>
</tr>
<tr>
<td>Value</td>
<td>Enter the desired value for the number of records retained by the platform. The default value if this property is not configured is 10,000.</td>
</tr>
</tbody>
</table>

3. Click Submit.

**Change highlighting of calendar report events**
Field styles control the highlighting of events in calendar reports. Manage field styles to change how highlighting works.

Role required: admin

You can apply field styles for the table that a calendar is based on or field styles for the Task (task) table to a calendar. The field styles that are applied for calendar highlighting depends on the `glide.ui.report.extend_calendar_choices` system property.

You can change only the background color of calendar events. All other CSS is ignored. Events without a defined field style display a white background when highlighting is applied to a calendar report.

*Define field styles* for the appropriate table.

- To define field styles for all calendar reports, define the style on the Task (task) table.
- To define field styles that apply only to calendars that are based on a specific table or report source, define the field styles on that table.

If calendar reports are configured to use field styles from their tables or report sources, these field styles override the Task (task) table styles.

**Set persistent highlighting for a calendar criterion**
Calendar report and widget criteria highlighting is removed once you close the report or widget. Set highlighting for a selected criterion to remain persistently.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Role required: admin

1. Navigate to **Homepage Admin > Pages**.
2. Click the homepage or dashboard title where the calendar report is located.
3. Click the Dropzone the calendar report type is listed under.
4. Click **New** to define a new portal preference.
5. Complete these fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter <code>sysparm_calstyle</code></td>
</tr>
<tr>
<td>Value</td>
<td>Enter the value you want to highlight, for example, <code>priority</code></td>
</tr>
</tbody>
</table>

6. Click **Update** to save the preference and return to the homepage or dashboard portal page form.
Each time you open the report, the selected criterion will be highlighted.

**Customize a start and end date**

You can configure calendar reports to support the spanning of multi-day events across calendar cells.

Role required: dictionary admin or admin

A change request with a **Work Start** date on Monday and a **Work End** date on Tuesday is displayed on both days when viewed in a Calendar field. However, when two custom fields named **First Date** and **Last Date** are used, the same behavior does not occur.

The code looks for an ending field with the same name as the start date field, except using the word end instead of start. If the custom fields are **My Start Date** and **My End Date**, the system...
correctly interprets the meaning of these fields because their names are the same except for the words start and end.

1. Follow the steps in Add and customize a field in a table.
2. Enter the following values in the form to create the start date span field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Calendar start date span</td>
</tr>
<tr>
<td>Database column name</td>
<td>u_first_date # u_my_start_date</td>
</tr>
<tr>
<td>Type</td>
<td>Date</td>
</tr>
</tbody>
</table>

3. Add another field using the following values for the end date span field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Calendar end date span</td>
</tr>
<tr>
<td>Database column name</td>
<td>u_last_date # u_my_end_date</td>
</tr>
<tr>
<td>Type</td>
<td>Date</td>
</tr>
</tbody>
</table>

**Translate a report’s grouping labels**

When executing reports that group results by a Translated Text field, to ensure that individual field labels and values display as translated, use the Translated_field type.

> Note: Reporting only supports columns of type Translated_field.

When executing reports, for example multi-level pivot or bar reports, that group results by a Translated Text field, the labels may not all display as translated when the instance language is changed from English to another language. These field labels are entries from the Translated Name / Field table.

Translation errors can occur when translating more than the first row or column of a report, or when creating a custom field for grouping. Use the Translated_field type to Translate individual field labels and values. See Creating reports for grouping options available from the Configure tab for the specific report type.

If you create a custom field for a report, the label is not added automatically. You need to add the label in the Field Label table and manually Translate a field label.

**Report Administration module**

Learn how to administer reports on the ServiceNow platform using the Reports > Administration module.

This module is not enabled by default, and must be activated. For a list of the reporting roles delivered with the ServiceNow platform, see Base system roles.

> Note: Restricting a report by role restricts who can view a report. Users without the admin role cannot edit global reports. If a non-admin user edits a global report, saving that report creates a personalized version belonging to that user.

Use the record list view to filter, view, or modify reports using any of the standard record list controls. Click New to create reports or select any of the records to display the report as a form. All the standard ServiceNow form controls apply.
You can select the table and field on which to report and the characteristics of the report format. Create a condition in the Filter field to further restrict the data that is presented in the report and select a role that can use the report.

**Report Security**

The Report Security enforce access control checks plugin allows administrators to use access control list (ACL) rules to restrict report access. This functionality prevents unauthorized users from editing, updating, or deleting reports either through the UI or through a URL construct. See [Access control list rules](#) for more information.

**Available Report Fields**

The following fields can be manipulated:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>A unique and descriptive name for the report.</td>
</tr>
<tr>
<td>Table</td>
<td>The ServiceNow table against which this report is run.</td>
</tr>
<tr>
<td>Field Name</td>
<td>The name of the group-by field.</td>
</tr>
<tr>
<td>Type</td>
<td>The report type for this report.</td>
</tr>
<tr>
<td>Chart Size</td>
<td>Large, medium, or small.</td>
</tr>
<tr>
<td>Visible to</td>
<td>Select a group whose members are authorized to see the report. Select Everyone to give all your users access.</td>
</tr>
<tr>
<td>User</td>
<td>The user who can view the chart. Enter GLOBAL to make the report accessible to all.</td>
</tr>
<tr>
<td>Filter</td>
<td>The filter applied to the report data.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles required to view the report.</td>
</tr>
</tbody>
</table>

If added to the form, the following fields are available

| Aggregate | Determine how you want the data in the report aggregated. The default is Count, which displays the number of records selected. When you select Average, Sum or Count Distinct, you can select from a list of additional fields whose values you want to use to aggregate the data. Typical values to use as an average or a sum are the time measurements, such as Business duration (expressed in days, hours, and minutes) and Resolve time (expressed in seconds). Other fields, such as Priority, have numerical values associated with their levels and can be used as aggregators. |

**Note:** Averages are calculated by dividing the sum of all fields by the number of those fields that contain a value. Fields that are empty or that contain a light gray zero are not included in the field count that is used when dividing the sum.
### Field Input Value

**Content**
An HTML field for describing the content of the report. Not processed in the generation of the report.

**Display grid**
Select to display a table under the chart that contains a breakdown of the requested data. The aggregation units are **Count**, **Average**, **Sum**, or **Count Distinct**. The percentage of the total data represented by each discrete piece is displayed.

**Group**
Select a group whose members are authorized to see the report. Select **Everyone** to give all your users access.

**Interval**
For **Trend** or **Trendbox** charts, the interval of time to measure along.

**No Groups**
Use the values in this list to limit the number of bars that appear in the chart. The platform displays 12 bars by default, from high values to low values and puts the remaining data into an **Other** category. You can select to display 10, 12, 15, 20, or all bars.

**Others**
Check box to include the **Other** group in the report.

**Select fields for list**
The fields that display in a list report.

**Select fields fororderBy**
The order of fields that display in the report.

**Show Empty**
Whether to display empty categories.

**Sumfield**
The field to perform a sum on for **Trend** or **Trendbox** Charts.

**Trend Field**
The field to track over time for **Trend** or **Trendbox** Charts.

### Reporting properties

Use properties to fine-tune report behavior and appearance.

### Introduction

Navigate to **Reports > Administration > Properties** to configure the main reporting properties. In the Filter navigator, enter **sys_properties.list** to configure other reporting properties.

### Reporting properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Truncates x-axis labels to 20 characters, if selected (Applicable only to charts generated with the charting v2 plugin) glide.chart.truncate.x_axis_labels | - Type: true | false  
- Default value: true  
- Location: **Reports > Administration > Properties** |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.report.old_report_builder</td>
<td>Enables (true) or disables (false) use of the old report builder.</td>
</tr>
<tr>
<td>· Type: true</td>
<td>false</td>
</tr>
<tr>
<td>· Default value: false</td>
<td><strong>Add a system property</strong></td>
</tr>
<tr>
<td>glide.ui.chart.bar.horiz.max_col_slant_labels</td>
<td>Sets the maximum number of columns in a horizontal bar chart before slanting (angling) the labels.</td>
</tr>
<tr>
<td>· Type: integer</td>
<td><strong>Default value: 5</strong></td>
</tr>
<tr>
<td>· Location: <strong>Add the property</strong> to the System Property (sys_properties) table.</td>
<td></td>
</tr>
<tr>
<td>Toggle animations on and off for charts generated with the charting v2 plugin glide.chart.animation</td>
<td>Enables animations for reports and Performance Analytics visualizations that support animations.</td>
</tr>
<tr>
<td>· Type: true</td>
<td>false</td>
</tr>
<tr>
<td>· Default value: true</td>
<td><strong>Location: Reports &gt; Administration &gt; Properties</strong></td>
</tr>
<tr>
<td>Truncates data labels from the front of the label. glide.chart.data_labels.remove_leading</td>
<td>This property is applicable only if glide.chart.truncate.data_labels is set.</td>
</tr>
<tr>
<td>· Type: string</td>
<td><strong>Default value: false</strong></td>
</tr>
<tr>
<td>· Location: <strong>Reports &gt; Administration &gt; Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Number of bins in a histogram chart (minimum 1, maximum 20) glide.chart.histogram.bins</td>
<td>Determines the number of sections that appear on the Y axis of the histogram.</td>
</tr>
<tr>
<td>· Type: integer</td>
<td><strong>Default value: 10</strong> (Allowed range of values 1–20)</td>
</tr>
<tr>
<td>· Location: <strong>Reports &gt; Administration &gt; Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Color of the mean value dot in box and trendbox charts. glide.chart.box.mean.color</td>
<td>Sets the color of the ‘mean’ value dot in a box or trendbox report.</td>
</tr>
<tr>
<td>· Type: string</td>
<td><strong>Default value: #2f7ed8</strong></td>
</tr>
<tr>
<td>· Location: <strong>Reports &gt; Administration &gt; Properties</strong></td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.chart.drill.open_new_win | If enabled, opens the default list drilldown in a new tab if no drilldown is defined. Applies only for non-list type reports.  
- Type: true | false  
- Default value: false  
- Location: Reports > Administration > Properties |
| Color of the box and whisker in box charts glide.chart.box.color | Sets the color of the box report.  
- Type: string  
- Default value: #FF0000  
- Location: Reports > Administration > Properties  
This property applies to box reports. |
| Default Color list name for each dataset glide.ui.report.datasets.default_colors | Sets the default colors to use when adding multiple data sets to a single chart. These values are used when the Chart color value is Use one color.  
Enter a comma-separated list of chart color Color name values. You can view available colors and define new colors on the Chart Colors (sys_report_chart_color) table.  
Each color is used in order as the default chart color when adding a data set to a chart. If there are more data sets than default colors, the colors repeat.  
- Type: string  
- Default value: Default Color  
- Location: Reports > Administration > Properties |
| List of color palette names that are used as a default color palette for each dataset glide.ui.report.datasets.default_palettes | Sets the default palette to use when adding multiple data sets to a single chart. These values are used when the Chart color value is Use color palette.  
Enter a comma-separated list of chart color scheme Name values. You can view available palettes and define new palettes on the Chart Color Schemes (pa_chart_color_schemes) table.  
Each palette is used in order as the default chart palette when adding a data set to a chart. If there are more data sets than default palettes, the palettes repeat.  
- Type: string  
- Default value: Default UI14  
- Location: Reports > Administration > Properties  
This property applies to pie, bar, horizontal bar, donut, and semi-donut reports. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Set the default map for reports of type 'Map' glide.ui.report.map.default_map | Specifies the default map to use when creating Map-type reports.  
- Type: string  
- Default value: world  
- Location: **Reports > Administration > Properties**  
This property applies to Map reports. |
| glide.ui.chart.color | Specify the chart color.  
- Type: string  
- Default value: #006DDA  
- Location: **Add a system property** to the System Property [sys_properties] table |
| glide.ui.chart.use_full_color_palette | Enable to generate bars in bar and Pareto charts with different colors for each bar.  
- Type: true | false  
- Default value: #false  
- Location: **Reports > Administration > Properties**  
This property applies to bar, horizontal bar, and Pareto reports. |
| glide.chart.label.legend.truncate_to | Truncates legend labels for left or right legend alignment for all chart sizes except large charts. Prevents shrinking of charts when labels are too long.  
- Type: integer  
- Default value: 14  
- Location: System Property [sys_properties] table |
| glide.chart.label.legend.truncate_to.large | Truncates legend labels for left or right legend alignment for large charts. Prevents shrinking of charts when labels are too long.  
- Type: integer  
- Default value: 20  
- Location: System Property [sys_properties] table |
| glide.report.new_calendar |  
- Type: true | false  
- Default value: true  
- Location: **Add the property** to the system Property (sys_properties) table. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.report.calendar.max_days_back | Enables you to specify the number of days with events that are returned when you browse backward and forward in a calendar report. Evaluated on the **Calendar by** field in the report creator.  
  - Type: integer  
  - Default value: 30  
  - Location: [Add a system property](#) to the System Property [sys_properties] table  
  
  This property applies to calendar reports. |
| glide.report.calendar.default_event_duration | The default duration for an event without a specified end date.  
  - Type: string  
  - Default value: 01:00:00 (One hour, zero minutes, zero seconds)  
  - Location: System Property [sys_properties] table  
  
  This property applies to calendar reports. |
| glide.report.calendar.max_more_events_per_day | Defines the maximum number of calendar events that can appear in the + <number> popup for:  
  - A calendar day when calendar is in month or year view  
  - The top ‘full day’ section of a calendar day when a calendar is in day or week view  
  
  When this number is exceeded, a + many link appears, which opens a list of events instead of a popup. For more information about the maximum number of events that can be displayed in a calendar day, see system property glide.report.calendar.max_events_displayed_per_cell.  
  - Type: integer  
  - Default value: 30  
  - Location: [Add the property](#) to the System Property (sys_properties) table. |

---

© 2020 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| glide.report.calendar.max_events_displayed_per_cell | Defines the maximum number of events that can appear in calendar report for:  
- A calendar day when calendar is in month or year view  
- The top ‘full day’ section of a calendar day when a calendar is in day or week view  

Events that exceed this value are visible via a link in the calendar cell. See glide.report.calendar.max_more_events_per_day for more information.  
- Type: integer  
- Default value: 3  
- Location: Add the property to the System Property (sys_properties) table. |
| glide.ui.report.extend_calendar_choices            | Controls which field styles are applied during calendar highlighting. If this property is set to false, field styles in only the Task table are used. If this property is set to true, the calendar first uses field styles from the table that the report is based on. If no applicable styles exist in that table, the calendar uses field styles from the Task table.  
- Type: true | false  
- Default value: true  
- Location: System Property (sys_properties) table |
| glide.ui.filter.first_day_of_week                  | Identifies the first day of the calendar week for the company. By default, the start of the week is Monday, meaning that the calendar week begins with Monday and ends with Sunday. To change this behavior, add the property glide.ui.filter.first_day_of_week to the instance as an integer property. Set the value to the integer corresponding with the day of the week that the calendar begins on, where 1 is Sunday, 2 is Monday, and so on. The function impacts all charts and calculations where the day of the week is used as a parameter.  
- Type: integer  
- Default value: 2  
- Location: Add a system property to the System Property [sys_properties] table |
| glide.ui.chart.bar.horiz.max_col_slant_labels      | Sets the maximum number of columns in a horizontal bar chart before slanting (angling) the labels.  
- Type: integer  
- Default value: 5  
- Location: Add a system property to the System Property [sys_properties] table  

This property applies to horizontal bar reports. |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.ui.chart.pie.labels</td>
<td>Enables (true) or disables (false) labels on pie chart slices.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the System Property (sys_properties) table.</td>
</tr>
<tr>
<td>glide.ui.chart.pie.labels.max_items</td>
<td>Sets the maximum number of pie chart slice values that can be returned to display their labels.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 8</td>
</tr>
<tr>
<td></td>
<td>• Location: Add the property to the System Property (sys_properties) table.</td>
</tr>
<tr>
<td>glide.chart.data.label.truncate_to</td>
<td>Sets the maximum length of a data label for a chart. If longer, the label is truncated and an ellipsis (...) appended.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 13</td>
</tr>
<tr>
<td></td>
<td>• Location: System Property [sys_properties] table</td>
</tr>
<tr>
<td>glide.report.pivot.fixed_headers</td>
<td>When disabled, the header row of a multiple level pivot table is unfrozen and scrolls out of frame when the user scrolls through the table.</td>
</tr>
<tr>
<td></td>
<td>• Type: true</td>
</tr>
<tr>
<td></td>
<td>• Default value: true</td>
</tr>
<tr>
<td></td>
<td>• Location: Add a system property to the System Property [sys_properties] table</td>
</tr>
<tr>
<td></td>
<td>This property applies to multilevel pivot tables.</td>
</tr>
<tr>
<td>glide.report.metric_max_data_points</td>
<td>Configure the maximum number of data points per MetricBase report. Typically only MetricBase time series reports display enough data to require this limitation.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 2000</td>
</tr>
<tr>
<td></td>
<td>• Location: Add a system property to the System Property [sys_properties] table</td>
</tr>
<tr>
<td>glide.report.metric_max_series</td>
<td>Configure the number of series per data set in a MetricBase report.</td>
</tr>
<tr>
<td></td>
<td>• Type: integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: 20</td>
</tr>
<tr>
<td></td>
<td>• Maximum value: 100</td>
</tr>
<tr>
<td></td>
<td>• Location: Add a system property to the System Property [sys_properties] table</td>
</tr>
</tbody>
</table>
Interactive Filters properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.homepage_interactivity.ui_ctrls_max_display_options</td>
<td>Maximum number of choices for radio button and check box interactive filters.</td>
</tr>
<tr>
<td></td>
<td>· Type: integer</td>
</tr>
<tr>
<td></td>
<td>· Default value: 25</td>
</tr>
<tr>
<td></td>
<td>· Location: Reports &gt; Administration &gt; Properties</td>
</tr>
<tr>
<td></td>
<td>Category: Choice list, Reference field, Date, Group</td>
</tr>
</tbody>
</table>

Interactive Analysis

Interactive Analysis enables you to quickly explore data using visualizations.

From any list of records, you can access an interactive set of reports on the list data. You can also manipulate the data by grouping, stacking, aggregating, and applying interactive filters. Click the visualization to drill down into the data. Click the information icon (____) to edit the source filter, view the list of applied filters, and copy the URL of the analysis.
Launch Interactive Analysis

Launch Interactive Analysis from any list.

Role required: none

You must have access to the list of records that you want to analyze.

1. Navigate to any list.
2. Optional: Configure the columns that are displayed on the list.
   The columns that appear on the list when you launch Interactive Analysis determine which fields are included in the analysis. The included fields determine which Group by and Stack by options are available, and which interactive filters appear by default.
3. Right-click the column header for a reference, choice, date/time, or boolean field and select Launch Interactive Analysis.
   The column that you launch Interactive Analysis from is used as the default Group by value.
4. Optional: Change how data is aggregated by selecting different values in the Group by and Stack by choice lists, or filter the data by applying one or more interactive filters.
5. Optional: Drill down into a subset of the data by clicking a visualization, such as a bar in the bar chart or a cell in the heatmap.

Interactive Filters deduplication

When you launch Interactive Analysis, the Filters panel displays all of the configured filters that are available on your personalized view. So that you do not have to clean up the filter panel, duplicate filters are removed automatically.

Duplicate filters are removed according to the following criteria:

- If the configuration is the same, the UI control determines which filter is shown on initial launch. Multiple input filters have first priority, then single input, check box, and radio buttons. For reference on available UI control type field options for displaying the filter, see Available interactive filter UI control types.
- If the configuration is the same, except that some filters have only one target and others have multiple targets, then only the last updated filter is retained.
- If both the configuration and the UI control are the same, then the last updated filter is retained.
- If the configuration is the same, but some filters have multiple target columns in the same target table, then all the filters are considered as separate filters and retained. An example of multiple target columns in the same target table is the Date opened and Date escalated columns in the incident table.
- If the configuration and the UI control are the same, but the base condition is different for any two filters, then they are considered separate filters and retained.

Interactive Analysis information panel

The Filter Info panel summarizes what the current filter shows and enables you to edit the source filter condition, bookmark an interactive analysis, and share an interactive analysis with colleagues.

Click the information icon ( ) to open the Filter Info panel.
The information panel has the following features:

**Source Filter**
Shows the conditions that apply to the filter. Click the star to add this interactive analysis to your favorites.

**Edit Source Filter**
Click the **Edit Source Filter** button to open the condition builder. You can edit the source filter here instead of reopening the definition page of the interactive filter.

**Applied Filter**
Shows a summary of the filters that are applied to the current interactive analysis.

**Share**
Shows the full URL of the analysis. Click the URL to highlight it. For more information, see [Share an interactive analysis](#).
**Bookmark an interactive analysis**

To save an interactive analysis for later use, you can add it to your favorites.

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select **Launch Interactive Analysis**.
3. Click the information icon (i) to open the **Filter Info** panel.
4. Apply filters to the interactive analysis and click **Apply Filters**.
5. Click the star icon to add the interactive analysis to your favorites.

The favorites list on the navigation panel is updated with a bookmark for the current interactive analysis.

**Share an interactive analysis**

You can share the URL of an interactive analysis with other users.

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select **Launch Interactive Analysis**.
3. Click the filter icon ( ) to show the interactive filters.
4. Make the desired filter changes and click **Apply Filters**.

5. Click the information icon (__) to open the **Filter Info** panel.

6. Right-click the URL in the **Share** section and select **Copy**.

You can share the URL for the interactive analysis via email with users who have rights to the information in the analysis.
Add a filter to Interactive Analysis

Add a filter to show more refined information in your Interactive Analysis.

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select Launch Interactive Analysis.
3. Click the filter icon ( ▼ ) and click Add filters. Use the Search Filters bar to limit the number of filters displayed.

   ![Filters](image)

   Assignment Group

   Domain

   Incident Assignment Group

4. Select the filter to add.
5. Click Apply Filters.
Filters

Add Filters

Collapse All

INCIDENT CATEGORY

Software

Software × Network × Database ×

ASSIGNMENT GROUP

Change Management

Change Management ×

INCIDENT OPENED

Last 6 months

Apply Filters
The new filter is applied to the interactive analysis. Click the information icon (__) to view the filters in the source filter summary.

Remove a filter from Interactive Analysis

You can remove a filter from Interactive Analysis and specify whether to remove the filter element from Group by and Stack by lists in the analysis.

1. Navigate to the table that you want to analyze.
2. Right-click on a column header and select **Launch Interactive Analysis** or open a dashboard that you own to show the interactive filters.
3. Click the filter icon (__) to show the interactive filters.
4. Point to the filter you want to remove and click the **Remove filter** icon.

The filter is removed from the Interactive Analysis.

Edit source filters

You can edit a source filter in the Interactive Analysis **Filter Info** panel.

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select **Launch Interactive Analysis**.
3. Click the information icon (__) to open the **Filter Info** panel.
4. Click **Edit Source Filter**.
5. Click **Load Filter** and select the filter to edit.
6. Edit the existing conditions and add new conditions.
7. Click **Save changes**.

The interactive analysis updates with the new source filter. The **Filter Info** panel shows the updated conditions.

**Interactive Analysis persistence**

The filters that you select persist between uses of Interactive Analysis per view and per user.

When you launch Interactive Analysis on a view, a specific column in a table, for the first time, all filters are set to their default values. The next time you launch Interactive Analysis on the same view, selections including filters, filter order, group by, stack by, and aggregation parameters persist from the previous visit.

In addition, **Group by** and **Stack by** elements are updated when filters are added to an analysis. For example, add a manager filter to an Interactive Analysis page. You can immediately group and stack your widgets by manager.
**Synchronize Group by and Stack by elements in filters**

Synchronize Group by and Stack by elements in an interactive analysis when filters are added to the filter panel and when they are removed from the filter panel. You can also remove a filter without synchronizing group by and stack by elements.

1. Navigate to the table that you want to analyze.
2. Right-click on the header of the column you want to analyze and select **Launch Interactive Analysis**.
3. In the **Filters** panel, click **Add Filters** and add a new filter.
4. Click **Apply Filters**.
   
The new filter element appears in the **Group by** and **Stack by** lists.
5. **Remove the filter from the interactive analysis** to remove the filter from the **Filters** panel.

6. Optional: Select **Remove element from Group by and Stack by**.
   
The option **Remove element from Group by and Stack by** is not shown if:
   
   - There is another filter on the **Filters** panel that has the same target field as the filter you are removing.
   - You have personalized the source list before launching interactive analysis. You cannot synchronize **Group by** and **Stack by** elements by adding or removing a filter if the column is part of a personalized list.

**Interactive Analysis aggregations**

When you work with Interactive Analysis, you can view data from the perspectives of record counts, sums, averages, and distinct counts.

**Aggregation types**

**Count**

Count is the default aggregation and shows when you launch Interactive Analysis. The Count aggregation shows the number of records selected. For example, an analysis of incidents grouped by state, stacked by priority, and aggregated by count shows the number of incidents in each category in hints and in the cells of multidimensional reports.
Average, Sum, Count Distinct

Select **Average**, **Sum**, or **Count Distinct**, to show a list of fields from the selected **Table**. You may further be able to aggregate on fields from extended tables. See [How to report on extended tables](#). Select a field to **Aggregate by** from this list. For example, if you select an integer field, such as **Reassignment count**, the data is expressed as a decimal value number. For more information, see [Create a column report](#).

**Note:** For duration values, the unit of measurement displayed in the aggregation axis cannot be customized.
Interactive Filters

Interactive Filters allow you to filter report widgets directly from a homepage or dashboard without modifying the reports.

You can create an interactive filter and add it to a homepage or dashboard as a widget. Selecting a value in the Interactive Filter widget filters the data in report widgets on the homepage or dashboard. On dashboards, selected filters are saved for each user and applied automatically next time that user views the dashboard.

Interactive filters on homepages do not retain default values or retain values across logins or page refreshes. This functionality is available on dashboards. For more information, see Create a dashboard version of a homepage.

Note:

You must have the licensed version of Performance Analytics to create new interactive filters.
Available Interactive Filter types

You can create Interactive Filters for multiple field types.

Interactive filter types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choice list</td>
<td>Allows you to filter data based on the value of a specific choice list. You must select the table and choice list field. The filter affects reports on the specified table.</td>
</tr>
<tr>
<td>Reference</td>
<td>Allows you to filter data based on the value of one or more reference fields. You must select the referenced table, as well as reference fields from other tables. The filter affects reports on tables that have the specified reference fields.</td>
</tr>
<tr>
<td>Date</td>
<td>Allows you to filter data based on the value of one or more date fields. You must select the tables and date fields. The filter affects reports on the specified tables.</td>
</tr>
<tr>
<td>Boolean</td>
<td>Allows you to filter data based on the value in a specific true/false field. You must select the table and the true/false field. The filter affects reports on the specified table.</td>
</tr>
<tr>
<td>Group</td>
<td>Allows you to display multiple interactive filters in a single widget on a homepage. Users viewing the homepage can select which grouped filters to apply.</td>
</tr>
<tr>
<td>Empty/non-empty</td>
<td>Filter based on whether a field contains a value.</td>
</tr>
<tr>
<td>Cascading</td>
<td>Allow you to filter based on multiple values in a hierarchy, such as by region, country, and city.</td>
</tr>
</tbody>
</table>

Create a choice list interactive filter

A choice list interactive filter enables users to filter report widgets based on the value of a choice list.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.

**Note:** If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on [Responsive dashboards](#).

1. Navigate to **Homepage Admin > Interactive Filters.**
2. Click **New.**
3. In the **Filter based on** list, select **Choice list.**
4. Set the following fields:
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the Add content menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the Name value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See Available interactive filter UI control types.</td>
</tr>
</tbody>
</table>

5. Optional: Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.

6. Optional: Select **Apply filter to database views and tables** to apply the filter to widgets based on both database views and tables.

   **Note:** It is not possible to apply filters to tables which extend the database view’s tables. For more information, see Interactive filters on database views and table hierarchies.

7. Optional: Exclude specific elements from appearing on the filter using the **Exclusion list**. However, data for excluded choices is included when you select **All** on the interactive filter.

8. In the **Table** list, select the table that contains the choice list to filter on.

9. In the **Field** list, select the field to filter on.

10. Optional: Add any list elements you want to exclude from the filter to the **Exclusion list** field.

11. Optional: Select a **Default value** for the filter. This default is applied automatically for all users. If a user selects a different value, that value is saved as the user’s default and overrides the global default. You can specify more than one default value when using a UI control type that enables multiple selections, such as Select Multiple Input.

   **Note:** To pass more than 50 default values, or if you see the error **This is exceeding the GET call limitation**, create multiple interactive filters.

12. Click **Submit**.

   After you create the filter, add it to a homepage or dashboard.

**Create a reference field interactive filter**

A reference field interactive filter allows users to filter report widgets based on the value of a reference field.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.
Note: If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on Responsive dashboards.

1. Navigate to Homepage Admin > Interactive filters.
2. Click New.
3. In the Filter based on list, select Reference.
4. In the Reference table list, select the table that stores the referenced records you want to filter on.
5. Optional: Select a Default value for the filter. This default is applied automatically for all users. If a user selects a different value, that value is saved as the user’s default and overrides the global default. You can specify more than one default value when using a UI control type that enables multiple selections, such as Select Multiple Input.

Note: To pass more than 50 default values, or if you see the error This is exceeding the GET call limitation, create multiple interactive filters.

6. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the Add content menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the Name value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See Available interactive filter UI control types.</td>
</tr>
</tbody>
</table>

7. Optional: Select Apply to all tables in hierarchy to apply the filter to parent, child, and sibling tables of an extended table.
8. Optional: Select Apply filter to database views and tables to apply the filter to widgets based on both database views and tables.

Note: It is not possible to apply filters to tables which extend the database view’s tables. For more information, see Interactive filters on database views and table hierarchies.

9. Right-click on the form header and select Save.
10. In the Interactive filter references related list, click New.
11. In the Reference table field, select a table that has reports you want to filter.
12. Select the Reference field to filter on.

The field must reference the table specified in the parent filter Reference table field.

You can dot-walk from fields that reference other tables. For example, if the parent filter Reference table is Department (cmn_department), you can select Incident as the reference Reference table, then select Caller Department as the Reference field.
13. Click Submit.

Repeat steps 9-12 as needed for each reference field you want to filter on. After you create the filter, add it to a homepage or dashboard.

**Note:** A filter may be converted from the **Check boxes** to the **Select Multiple Input** control type for performance reasons.

Create a date interactive filter

A date interactive filter allows users to filter report widgets based on the value in a date field.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.

**Note:** If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on **Responsive dashboards**.

1. Navigate to **Homepage Admin > Interactive filters**.
2. Click **New**.
3. In the **Filter based on** list, select **Date**.
4. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the <strong>Add content</strong> menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the <strong>Name</strong> value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See <a href="#">Available interactive filter UI control types</a>.</td>
</tr>
</tbody>
</table>

5. Optional: Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.
6. Optional: Select **Apply filter to database views and tables** to apply the filter to widgets based on both database views and tables.

**Note:** It is not possible to apply filters to tables which extend the database view’s tables. For more information, see [Interactive filters on database views and table hierarchies](#).

7. In the **Date** section, use the slushbucket to select one or more date ranges that users can filter on.

Available date filters are defined in the **Get Date Filter options for Date Filters** business rule. Customize this business rule to add or remove filter options.
8. Optional: Select a **Default value** for the filter.
   This default is applied automatically for all users. If a user selects a different value, that value is saved as the user’s default and overrides the global default. You can specify more than one default value when using a UI control type that enables multiple selections, such as **Select Multiple Input**.

   ![Note](image)

   **Note:** To pass more than 50 default values, or if you see the error **This is exceeding the GET call limitation**, create multiple interactive filters.

9. Right-click on the form header and select **Save**.
10. In the **Interactive filter Dates** related list, click **New**.
11. In the **Table** field, select a table that has reports you want to filter.
12. In the **Field** field, select a date field to filter on.
13. Click **Submit**.

Repeat steps 8-11 as needed for each date field you want to filter on. After you create the filter, add it to a dashboard or homepage.

### Create a boolean interactive filter

A boolean interactive filter allows users to filter report widgets based on the value of a true/false field.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.

![Note](image)

**Note:** If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on **Responsive dashboards**.

1. Navigate to **Homepage Admin > Interactive filters**.
2. Click **New**.
3. In the **Filter based on** list, select **Boolean**.
4. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the <strong>Add content</strong> menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the <strong>Name</strong> value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
<tr>
<td>UI control type</td>
<td>Select how the available filtering options for this filter appear on the dashboard widget. See <strong>Available interactive filter UI control types</strong>.</td>
</tr>
</tbody>
</table>

5. Optional: Select **Apply to all tables in hierarchy** to apply the filter to parent, child, and sibling tables of an extended table.
6. Optional: Select Apply filter to database views and tables to apply the filter to widgets based on both database views and tables.

   Note: It is not possible to apply filters to tables which extend the database view’s tables. For more information, see Interactive filters on database views and table hierarchies.

7. In the Table list, select the table that contains the true/false field to filter on.
8. In the Field list, select the true/false field to filter on.
9. Optional: Select a Default value for the filter.
   This default is applied automatically for all users. If a user selects a different value, that value is saved as the user's default and overrides the global default.
10. Click Submit.

After you create the filter, add it to a homepage or dashboard.

Create a group interactive filter

A group interactive filter allows users to select multiple interactive filters to apply to reports on a homepage or dashboard.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.

   Note: If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on Responsive dashboards.

Before starting this procedure, create several choice list, reference field, boolean, or date filters to group.

   Note: Default values selected for child filters are not applied when using a group filter. Selected values in a group filter are not saved when you reload the dashboard.

1. Navigate to Homepage Admin > Interactive filters.
2. Click New.
3. In the Filter based on list, select Group.
4. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
<tr>
<td>Look up name</td>
<td>Enter a lookup name for the filter. This name appears in the Add content menu for users adding a filter to a dashboard. Use this name to help organize your filters. If you do not specify a lookup name, the Name value is used instead.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the filter.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
Create an interactive filter for whether a field is empty or populated

You can create a Boolean interactive filter that lets users filter report widgets based on whether a specific field is empty or populated.

Role required: hp_publisher_admin and report_admin. The hp_publisher_admin role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.

Create this filter for a field where **Yes** filters for records where the specified field is populated and **No** filters for records where the field is empty. Name the filter to represent this logical relationship. For example, you can use the name "Incident generated problem" for a filter based on the Incident table and the Problem field.

1. Navigate to **Reports > Interactive filters**.
2. Click **New**.
3. In the **Filter based on** list, select **Boolean**.
4. Set the following fields:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for the filter. This name appears on the dashboard widget for the filter.</td>
</tr>
</tbody>
</table>
### Create a cascading filter

Cascading filters allow you to filter based on multiple values in a hierarchy, such as by region, country, and city. Lower-level choices are filtered by the values selected at higher levels. For example, you can create a cascading filter that allows users to select from a list of managers, then select from groups that report to that manager. Report data is then filtered to show only records assigned to that group. Alternatively, you can leave lower levels of the filter unselected, such as by selecting only a manager but no group. Report data is then filtered to show records assigned to any group managed by that manager. Cascading filters retain the last elements selected on a dashboard.

Role required: `hp_publisher_admin` and `report_admin`. The `hp_publisher_admin` role exists only for managing interactive filters. By default, it contains no other roles and is not contained in any other roles.

You must have the licensed version of Performance Analytics to create new interactive filters.

Ensure that the structure of the data that you use to create the filter is consistent. For example, in a cascading filter based on location, ensure that the top-level choices are all regions, and the second-level choices are all countries. You can define filter conditions to ensure that only appropriate choices for each level are available.

This procedure includes examples based on a cascading interactive filter using managers and groups. In this example, the top-level choice allows users to select a manager and the second-level choice allows users to select a user group managed by that manager.
Example cascading filter

**Note:** You can filter reports based on the values in reference fields only. Cascading filters support only the *Single Select UI control type*.

1. **Homepage Admin** > **Interactive filters**.
2. Click **New**.
3. In the **Filter based on** list, select **Cascading Filters**.
4. Right-click the form header and select **Save**.
5. Define the first level of the cascading filter.
   a) In the **Cascading Filter** related list, click **New**.
   b) Select the **Table** and the **Display field** from the table that contains the values you want to use as the top-level filter choices. The **Display Field** is limited to the types boolean, choice, reference, and string.
   To define the top level of a hierarchy based on managers and the groups they manage, select **Group (sys_user_group)** as the **Table** and **Manager** as the **Display field**.
   c) Optional: Use the **Filters** field to limit which choices are available to users.
   Filter conditions are especially useful when you create a cascading filter based on a self-referencing table, such as Location (cmn_location). Filter the data to ensure each level of the cascading filter only has options appropriate for that level.
d) Right-click the form header and select Save.

6. Define the next level of the hierarchy.
Cascading filters use a one-to-many relationship between higher-level filters and lower-level filters. One higher-level filter can affect the choices available in any number of lower-level filters.

a) From the manager filter, in the Cascading Filter related list, click New.

b) Select the Table and the Display field from the table that contains the values you want to use as the second-level filter choices. The Display Field is limited to the types boolean, choice, reference, and string.

In the managers and groups example, select Group (sys_user_group) as the Table and Name as the Display field.

c) In the Parent Reference Field field, select the field that contains the value selected from the higher-level filter.

For example, when you create the Group filter, the Parent Reference Field value is Manager. In this example, the manager selected in the first filter is used to filter the list of available groups based on the Manager field value of each group.

d) Right-click the form header and select Save.

e) Repeat these substeps for each additional filter you want to add. To add another level to the filter hierarchy, add a new record in the Cascading Filter related list of the lowest-level filter. For example, add the Group filter instead of a top-level filter such as the Manager filter.

7. Define how each filter level applies the filter to reports on a dashboard.

a) In the Target Tables related list, click New.

b) Select the Target table that contains the data you want to filter, such as Incident.

c) Select the Field to filter on.

The field must reference the table specified in the filter. For example when filtering incident data, the Field for the top-level manager filter is Assignment group.Manager. In this example, the Field for the second-level group filter is Assignment group.

d) Click Submit.

e) Repeat these substeps to add targets for each level of the filter.

You can define multiple targets for each filter level. For example, filter incident data by assignment group or CMDB CIs by support group using the same Groups (sys_user_group) filter.

Note: A cascading filter hierarchy must specify at least one target. You can define a cascading filter that skips levels in a hierarchy, or a cascading filter that only specifies targets for certain levels in a hierarchy. For example, define a target only for the Group-level filter and not the Manager-level filter. In this example, reports are filtered only when a user selects a specific group and not just a manager.

The following images demonstrate the completed configuration for the example cascading filter. The Cascading Filter related list (not shown) in the top-level filter contains the second-level filter.
After you create all levels of the filter, add it to a homepage or dashboard.

*Cascading filters deduplication*

So that you do not have to clean up the filter panel, duplicate filters are removed automatically.

Duplicate filters are removed according to the following criteria:

- If the configuration is the same, the last edited filter is retained.
- If the configuration is the same, except that some filters have only one target and others have multiple targets, then only the last updated filter is retained.
If the configuration is the same, but some filters have multiple target columns in the same target table, then all the filters are considered as separate filters and retained. An example of multiple target columns in the same target table is the Date opened and Date escalated columns in the incident table.

If the configuration and the UI control are the same, but the base condition is different for any two filters, then they are considered separate filters and retained.

Interactive filters on database views and table hierarchies

When you create an interactive filter on an extended table, you can also apply the filter to database views and to the other tables in the hierarchy.

When you create an interactive filter, you can:

Select All tables in the hierarchy.

If the source table is incident, then the interactive filter applies to incident; its parent table, task; and to its sibling tables, problem and change.

Select Apply filter to both database views and tables.

If the source table is incident, then the interactive filter applies to both incident and, for example, the [incident_sla] database view.

Select both check boxes.

The interactive filter applies to all tables in the hierarchy and to database views.

Select neither check box.

Interactive filters apply only to the source table, such as incident.

Note: This is the default setting when you create an interactive filter.
Interactive filters applied to extended tables also apply to the other tables in the hierarchy.

**Note:** Interactive filters on a database view do not apply automatically to the siblings of the database view’s source table. For example, (problem_sla) is a database view created on the table (task_problem). Interactive filters applied to (problem_sla) do not apply automatically to widgets based on the (task_change) table, a sibling of (task_problem), even if you have selected both options.

**Available interactive filter UI control types**

The interactive filter UI control type field provides several options for displaying the filter.

**Available UI control types**

<table>
<thead>
<tr>
<th>UI control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio Buttons</td>
<td>Displays each filtering option as a radio button. Users can select only one radio button at a time.</td>
</tr>
<tr>
<td>Check boxes</td>
<td>Displays each filtering option as a check box. Users can select any number of check boxes at a time.</td>
</tr>
<tr>
<td>Select Single Input</td>
<td>Displays the filtering options as a choice list. Users can select only one choice at a time.</td>
</tr>
</tbody>
</table>
**ServiceNow Madrid Analytics, Intelligence, and Reporting**

<table>
<thead>
<tr>
<th>UI control type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Multiple Input</td>
<td>Displays the filtering options as a choice list. Users can select any number of choices at a time. Click the X next to a selected choice to deselect that choice.</td>
</tr>
</tbody>
</table>

**Note:** Filtering behavior depends on the filter type when selecting multiple values using the **Check boxes** or **Select Multiple Input** control types. Choice and reference filters use an AND query, meaning records must match all conditions. Date filters use an OR query, meaning records must match at least one of the specified conditions.

**Note:** A filter may be converted from the **Check boxes** to the **Select Multiple Input** control type for performance reasons.

**Interactive Filters on homepages and dashboards**

You can make an Interactive Filter available to users by adding the filter to a homepage or dashboard.

**Add an interactive filter widget to a homepage**

You can use an interactive filter by adding the filter widget to a homepage.

Role required: itil, report_user. You must have edit access to the homepage you want to add the filter to.

Add an interactive filter to a homepage to filter reports on that homepage. To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of Interactive Filters based on the incident table. For more information, see [Make a report follow interactive filters](#).

**Note:** Interactive filters on homepages do not retain default values or retain values across logins or page refreshes. This functionality is available on dashboards. For more information, see [Create a dashboard version of a homepage](#).

1. Navigate to a homepage.
2. Click the add content icon ( ).
3. In the Add content menu, select **Interactive filters** from the left column.
4. Select the type of filter to add, such as **Choice list** or **Reference**.
5. Select the filter you want to add to the homepage.
6. Click **Add here** in the section you want the filter to appear.

**Add an interactive filter widget to a responsive dashboard**

Add an interactive filter to a dashboard to filter reports on that dashboard.

Role required: pa_power_user. You must have edit access to the dashboard you want to add the widget to.

To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of
Interactive Filters based on the incident table. For more information, see Make a report follow interactive filters.

1. Navigate to a dashboard.
2. Click the add content icon ( + ).
3. Select Interactive filters.
4. Select the type of filter to add, such as Choice list or Reference.
5. Select the filter you want to add.
6. Click Add or drag the filter onto the dashboard.

Add an interactive filter widget to a non-responsive dashboard

Add an interactive filter to a dashboard to filter reports on that dashboard.

Role required: pa_power_user

Note: If the interactive filter has a default value or specifies the last selected value, this value is not applied automatically on non-responsive dashboards. This feature is only available on Responsive dashboards.

To be effective, interactive filters must be based on the same tables as the reports they filter. Report widgets based on the user table, for example, do not change based on the settings of Interactive Filters based on the incident table. For more information, see Make a report follow interactive filters.

1. Navigate to a dashboard.
2. Click Edit.
3. Click the add content icon ( + ).
4. In the Add content menu, select Interactive filters from the left column.
5. Select the type of filter to add, such as Choice list or Reference.
6. Select the filter you want to add.
7. Click Add here in the section you want the filter to appear.

Make a breakdown act as an interactive filter

You can configure a breakdown on a dashboard to act as an interactive filter for reports on the dashboard.

There must be a dashboard configured with one or more reports and breakdowns, and an interactive filter based on the same table as the breakdown source.

Role required: pa_power_user, pa_admin, or admin

When you select a breakdown and breakdown element on a dashboard, that element can be used to filter reports on the dashboard based on the filtering rules defined in an interactive filter.

1. Navigate to Performance Analytics > Dashboards.
2. Select the dashboard with the breakdown you want to make act as an interactive filter.
3. Click the context menu icon ( ) and select Dashboard Properties.
4. In the Breakdown sources related list, click the reference icon ( ) next to the breakdown source you want to make into an interactive filter and select Open Record.
Note: You cannot use a breakdown source that is based on a bucket group as an interactive filter.

5. In the Act as filter field, select the interactive filter you want this breakdown source to act as. The breakdown source Facts table must match the table that the interactive filter is based on. For example, for the breakdown source HR.Groups.Active, use a reference field interactive filter for the Groups (sys_user_group) table. Breakdown elements from the HR.Groups.Active breakdown source are not valid selections for interactive filters on other tables, such as interactive filters based on a choice or date field.

6. Click Update.

7. On the dashboard’s record, click View Dashboard.

8. Click the + icon to put the dashboard in edit mode.

9. Click the cog icon to open the Edit Widget window.

10. Select Follow interactive filter.

11. Click Done.

The selected breakdown acts as an interactive filter on the dashboard’s reports.

Make a report follow interactive filters

You can configure a report widget to accept input from interactive filters.

Role required: itil, report_user

1. Navigate to a homepage or dashboard.

2. Put the dashboard or homepage in edit mode.

3. In the report widget, click the Edit widget icon ( ).

4. Select Follow interactive filter.

   This option is available for all report widgets. If you do not see the Follow interactive filter option, the widget is a list, PA, or other non-report widget.

5. To show a filter icon ( ) on the top left corner of the report when it is following an interactive filter, select Show when following.

6. Click Done.

7. Refresh the current browser page to apply the change.

Add one or more interactive filters to the homepage or dashboard.

Make a report act as an interactive filter

You can configure an existing report widget to filter other report widgets on the same homepage or dashboard.

Role required: itil, report_user

1. Navigate to a homepage or dashboard.

2. If editing a dashboard, click Edit Widget.

3. In the report widget, click the Edit widget icon ( ).

4. Select Act as interactive filter.
This field appears only for reports that can be filters. Only reports with a Type value of pie, donut, semi donut, funnel, or pyramid may be filters.

**Note:** If responsive canvas is disabled, then there is no delay in filtering when a user clicks segments of a report that acts an interactive filter in quick succession.

5. Click Done.
6. Refresh the current browser page to apply the change.

Click on a subset of data in the report, such as a slice of pie in a pie chart, to filter all subscriber reports for the same table. All subscriber reports on the homepage or dashboard for the same table show information about that subset of data only.

**Reset all interactive filters on a dashboard tab**

Reset all applied filters on a dashboard tab to view the unfiltered data.

Role required: none. You must have access to the dashboard.

1. Navigate to **Self-Service > Dashboards**.
2. Select the dashboard and tab that you want to reset.
3. Click the context menu (…) and select **Reset Filters**.

**Custom interactive filters**

As an administrator, you can create scripted interactive filter widgets to provide advanced filtering options on dashboard reports.

By creating a custom interactive filter, you control all aspects of the filter interface and filtering logic. By defining these elements you can create filters that fit your specific needs, such as filters that perform multiple, common filtering operations with a single click.

Custom filters are scripted widgets (**System UI > Widgets**) that use the **DashboardMessageHandler** JavaScript class to define and publish report filters.

**Note:** The exposed API for custom interactive filters is limited and does not provide parity with standard interactive filters. Before implementing any custom interactive filters, please review the **Custom Interactive filter limitations**.

**Note:** Access control lists on the Table API may restrict the records shown when a dashboard is filtered. To alleviate this problem, add necessary users or roles to the Table API ACL. For more information, see **Access control list rules**.

You must define the appearance of the widget, such as available buttons, using Jelly.

You must have the licensed version of Performance Analytics to create new interactive filters.

**Custom interactive filter example**

As an administrator, you can create custom interactive filter widgets to provide advanced filtering options on dashboards.
Use case

This example details how to create a custom filter that filters reports on the Task table, or child tables, to show only records where the current user is the caller. The filter exposes two buttons to the user, one button to add the filter and one to remove the filter.
Create the widget

To create a custom filter, you must create a new dynamic content record (Content Management > Blocks > Dynamic > New) and define the user interface for the filter.

```xml
<xml version="1.0" encoding="utf-8" ?
<j:jelly trim="false" xmlns="jelly:core" xmlns:g="glide" xmlns:j="null" xmlns:st2="null">
<script>
    var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");

    function publishFilter () {
        var filter_message = {};
        filter_message.id = "my_unique_id";
        filter_message.table = "task";
    }

    <!-- Add your own filter query logic here -->

    filter_message.filter = "assigned_to=VNMVCGBd1921e5f5181b0e9ad2557212b477fe";

    SNC.canvas.interactiveFilters.setDefaultValues({
        id: filter_message.id,
        filters: [filter_message]
    }, false);

    my_dashboardMessageHandler.publishFilter(filter_message.table, filter_message.filter);
</script>
</j:jelly>
```
Define the filtering logic

Filters use the `DashboardMessageHandler` class to manage active filters. Instantiate `DashboardMessageHandler` with a unique value.

**Note:** The ID of the custom interactive filter must be unique. If it has the same ID as another interactive filter or custom interactive filter, the filtering logic will not work properly.

The **Only mine** button publishes a filter on Task table reports using the encoded query `caller_idDYNAMIC90d1921e5f510100a9ad2572f2b477fe`. The **All tasks** button removes the filter.

**Note:** In the definition of a custom interactive filter, it is possible to specify only one table. If multiple tables are specified, the filter is invalid.

You can then add buttons or other interface elements to the dynamic content.

```xml
<?xml version="1.0" encoding="utf-8"/>
<j:jelly trim="false" xmlns:j="jelly:core" xmlns:g="glide"
 xmlns:j2="null" xmlns:g2="null">
<script>
    var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");

    function publishFilter () {
        var filter_message = {};
        filter_message.id = "my_unique_id";
        filter_message.table = "task";

        <!-- Add your own filter query logic here -->
        filter_message.filter = "assigned_toDYNAMIC90d1921e5f510100a9ad2572f2b477fe";
        SNC.canvas.interactiveFilters.setDefaultValue({
            id: filter_message.id,
            filters: [filter_message]
        }, false);

        my_dashboardMessageHandler.publishFilter(filter_message.table, filter_message.filter);
    }

    function clearFilter() {
        var filter_message = {};
        filter_message.id = "my_unique_id";
        filter_message.table = "task";
        filter_message.filter = ";
        SNC.canvas.interactiveFilters.setDefaultValue({
            id: filter_message.id,
            filters: [filter_message]
        }, false);
        my_dashboardMessageHandler.removeFilter();
    }
</script>

Example of a filter that generates a static filter on 'task' table reports, or removes it
<br/>
<input id="allTasks" type="button" value="All tasks"
onclick="clearFilter();"/>
```
Add the filter to a dashboard

After creating the filter, add it to a dashboard that contains reports on the Task table or child tables.

Clicking the Only mine button on the filter filters reports on the dashboard to only show tasks where the current user is the caller.

The custom filter

![Publisher sample](image)

Debug filter

The debug interactive filter facilitates the creation of custom filters by displaying a JSON array representation of all active filters on a dashboard.

To use the debug filter, add it to a homepage. The debug filter is read-only and intended to aid in the design and implementation of custom interactive filters.
Custom interactive filter limitations

Custom interactive filters are a fallback for use when standard interactive filters don’t provide certain functionality.

ℹ️ Note: The exposed `DashboardMessageHandler` API for custom interactive filters is limited and does not provide parity with standard interactive filters. The API does not support these features. To provide this functionality, you must write your own code.

Unsupported custom interactive filter features

Setting default filter values

Creators of custom interactive filters are not able to select default filter values.

Retaining filter value on refreshing the widget
When you click a widget's refresh icon (↻) to refresh its content, or when you select **Refresh** from the context menu (⋮), the custom interactive filter value does not persist.

**Resetting custom filter values / All filter values**

When you select **Reset Filters** from the context menu (⋮), the custom interactive filter does not change and is still applied.

**Setting filter values on page load or tab switch**

Custom interactive filter values do not persist when the user switches tabs, or opens a new dashboard and returns to the first dashboard or dashboard tab.

**Adding multiple instances of the same custom interactive filter on a tab**

If there is more than one instance of the same custom interactive filter on a tab, unexpected behavior can result.

**Note:** Custom interactive filter values do not persist across tabs. To filter values on multiple tabs on the same dashboard, you must add the custom interactive filter to each tab.

**Unsubscribing reports on removal of custom interactive filter**

Reports following a custom interactive filter on a dashboard continue to follow that filter even when the filter is deleted from the dashboard.

**Applying a custom interactive filter to more than one table at a time**

In the definition of a custom interactive filter, it is possible to specify only one table. If multiple tables are specified, the filter is invalid. The publishFilter method of the API only takes one table as an argument.

**Filtering widgets in Export to PDF**

When you create custom content to be placed as widgets on dashboards and home pages, you must perform extra tests before you export the content to PDF. In the exported PDF, report widgets that are filtered using custom interactive filters may appear as blank squares or the widget content does not respect the filter.

**Custom filters do not apply to lazy loaded dashboard widgets**

Custom interactive filters only apply to the widgets below the filter and on the screen when the filter is visible. Widgets that are loaded when the user scrolls through a longer dashboard are not filtered. For more information on lazy loading, see [Differences between homepages and responsive and non-responsive dashboards](#).

**Custom interactive filters cannot be used in a breakdown dashboard**

On breakdown dashboards, the breakdown itself is used to filter all Performance Analytics widget data. For more information, see [Using breakdowns on dashboards](#).

**DashboardMessageHandler**

The ```DashboardMessageHandler``` class allows you to define custom filtering logic for interactive publishers.

```DashboardMessageHandler - DashboardMessageHandler(String id)```

Instantiate a DashboardMessageHandler object with a given unique ID.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Id</td>
<td>String</td>
<td>A unique ID for the filter. This ID allows report widgets to track which filter applied each filter. The ID does not need to be unique across all dashboards, but each dashboard cannot have multiple filters with the same ID.</td>
</tr>
</tbody>
</table>

```javascript
var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");
```

**DashboardMessageHandler - publishFilter(String table, String encodedQuery)**

Each DashboardMessageHandler object can publish a single filter.

Publishing a new filter from the same object overwrites the original filter. Use multiple DashboardMessageHandler objects to publish multiple filters.

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>table</td>
<td>String</td>
<td>The table to filter, such as task.</td>
</tr>
<tr>
<td>encodedQuery</td>
<td>String</td>
<td>An encoded query that specifies the filter to publish.</td>
</tr>
</tbody>
</table>

**Returns**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td></td>
</tr>
</tbody>
</table>

```javascript
var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");

<input id="onlyMine" type="button" value="Only mine" onclick="my_dashboardMessageHandler.publishFilter('task','caller_idDYNAMIC90d1921e5f510100a9ad2572f2b477fe');"/>
```

**DashboardMessageHandler - removeFilter()**

Removes the current filter published by this DashboardMessageHandler object from all reports on the homepage or dashboard.
Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

Returns

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>void</td>
<td>void</td>
</tr>
</tbody>
</table>

```javascript
var my_dashboardMessageHandler = new DashboardMessageHandler("my_unique_id");
<input id="removeFilter" type="button" value="Remove filter"
onclick="my_dashboardMessageHandler.removeFilter();"/>
```

Dashboards

The ServiceNow® Dashboards product enables you to display multiple Performance Analytics, reporting, and other widgets on a single screen. Use dashboards to create a story with data you can share with multiple users.

**Explore**
- Dashboards Release Notes
- Upgrade to Madrid
- Available Performance Analytics Solutions
- Preconfigured in-form analytics
- Domain separation in Dashboards

**Administer**
- Enable responsive dashboards
- Organize dashboards into groups
- Solving permissions issues on a responsive dashboard
- Move a dashboard with an update set

**Use**
- Working with responsive dashboards
- Working with non-responsive dashboards
- Determine whether a dashboard is responsive

**Troubleshoot and get help**
- Ask or answer questions in the Performance Analytics and Reporting forum
- Search the HI knowledge base
- Contact ServiceNow Technical Support

**Training**
- Performance Analytics training

Create and use dashboards

Learn about different types of dashboards and how to use them.

Watch this seven-minute video to learn more about flexible layouts, multiple tabs, sharing, converting homepages to dashboards, and enabling responsive dashboards.
Working with responsive dashboards

Responsive dashboards enable users to share widgets such as reports and Performance Analytics visualizations. Use an easy-to-use drag and drop canvas to create, edit, and arrange content, and then share it with colleagues.

Use dashboards to:

- Create and edit Performance Analytics reports and other widgets directly from the dashboard.
- Use the Add Widget pane to quickly find and preview widgets, then add them to the dashboard.
- Easily share dashboards with other users from the integrated Sharing pane.
- Use quick layouts to snap widgets into a predefined layout, then adjust the layout as desired.
- Set dashboards as your Home so you can quickly access information that you use frequently.

For more information, see: [Dashboards release notes](#).

Watch this seven-minute video to learn more about flexible layouts, multiple tabs, sharing, converting homepages to dashboards, and enabling responsive dashboards.

Benefits

- Optimize performance with configurable widget loading. For more information on the benefits of configurable widget loading, see [Optimize widget rendering time on responsive dashboards](#).
- Use the Restrict to roles field to [Restrict responsive dashboard access to specific roles](#). Users with any of the specified roles can access the dashboard if they have been given access to the dashboard on the dashboard Share pane.

Limitations

- The mobile apps do not give access to dashboards as dashboards are not optimized for mobile screen sizes. You can access dashboards on a tablet using the standard web interface.

Create or configure a responsive dashboard

Create a dashboard where you can add widgets that you frequently use. You can then share the dashboard with other users.

Users with any role can create dashboards.

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Click New.
3. Fill in the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name the dashboard.</td>
</tr>
<tr>
<td>Order</td>
<td>Enter an Order number to indicate the order the dashboard appears on the dashboards picker. Dashboards with lower numbers are listed first.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Active</td>
<td>Clear this field to mark the dashboard <strong>inactive</strong>. Inactive dashboards are visible on the Dashboard Overview page and in the dashboard picker only to the owner, and users with the dashboard_admin and admin roles. Users with the dashboard_admin role have full view, edit, delete, and share privileges on all dashboards in the instance, including inactive dashboards. <strong>Note:</strong> When you activate responsive dashboards, the permissions associated with the non-responsive dashboard are carried over to the responsive version. This applies to both active and inactive non-responsive dashboards.</td>
</tr>
<tr>
<td>Owner</td>
<td>The dashboard owner. Only a user with the administrator role can change this value.</td>
</tr>
</tbody>
</table>
4. Optional: Click the **Restrict to roles** edit icon ( ) to specify the roles that a user must have to access this dashboard. For more information, see *Share a responsive dashboard*.

5. Optional: Users with admin, pa_admin, and pa_power_user roles can configure these additional fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Click the magnifier icon to add the dashboard to a Group. Groups organize dashboards in the dashboard picker list. Grouped dashboards appear at the top of the list. Ungrouped dashboards appear at the bottom of the list, under Other.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Breakdown Source</td>
<td>Select one or more breakdown sources in the Breakdown Source related list. Breakdowns enable users to filter Performance Analytics data on the dashboard. The Breakdown Source related list is available on the Dashboard form after you create the dashboard.</td>
</tr>
<tr>
<td>Act as filter</td>
<td>You can configure a breakdown on a dashboard to act as an interactive filter for reports on the dashboard. Select the interactive filter you want this breakdown source to act as.</td>
</tr>
</tbody>
</table>

6. Click Submit.
The dashboard is created with no content. To add content, select a widget type and a widget and click **Add**. For more information, see [Edit a responsive dashboard](#).

**Create a dashboard version of a homepage**

To take advantage of responsive dashboard functionality, you can migrate your existing homepage to a dashboard.

Users with any role can copy their own homepage to a dashboard. Users with the admin role can create dashboard versions of any homepage.

Advantages of dashboards include:

- Responsive design — The widgets on a dashboard are optimized for the screen you are using: desktop, tablet, or mobile phone.
- Drag-and-drop widgets — You can add dashboard widgets precisely where you want them and rearrange the dashboard with easy to use tools.
- Shareability — You can share dashboards easily with users, roles, and groups.

When you create a dashboard version of a homepage, the content is added to the new dashboard, but permissions associated with the homepage are not retained. To apply permissions to the dashboard, specify the permissions again. Users with whom you share a dashboard may or may not be able to edit the dashboard or share it with others. The ability to edit or share a dashboard is based on the user's role and the permissions granted to them.

**Note:**

Only pages that are accessible through `home.do` can be converted. Manually coded UI pages that utilize the homepage layout system, but are not accessible through `home.do` cannot be converted.

Homepages with layouts that include scripts or style sheets might not work or might not look as expected after conversion. This discrepancy is because jelly code is not evaluated during conversion.

When you convert a homepage to a dashboard, the dashboard is independent of the homepage. Changes you make to the dashboard do not migrate to the source homepage. In addition, changes that you make to the homepage after conversion do not migrate to the dashboard.

1. Enable responsive dashboards. For more information, see [Responsive dashboard properties](#).
2. Navigate to **Self-Service > Homepage**.
3. From the list, select the homepage you want to copy.
4. Click the Homepage settings icon and choose **Create Dashboard Version**.
5. Select Create new dashboard or Add to existing dashboard and click Create.

The Add to existing dashboard list contains only the dashboards you own.

When successful, the dashboard version opens as a new dashboard or as a tab on the selected dashboard.

**Note:** The layout of the dashboard version is similar to the homepage layout but may not be precisely the same.

**Note:** Homepages with dashboard versions show a button with the text Open Dashboard Version. This button takes the user to the most recently created dashboard version of the homepage.

You can share the dashboard version of your homepage with other users. See Share a responsive dashboard.

**Solving errors on dashboards created from homepages**

Occasionally it is not possible to create a dashboard from a homepage. Follow the instructions for each error to solve these problems.
Entity name must immediately follow the ‘&’ in the entity reference

When you try to create a dashboard version of a homepage, the following error may occur: ‘The entity name must immediately follow the ‘&’ in the entity reference’. To solve this error, remove ampersands from the names of the dashboards in the instance or temporarily change the value of the glide.ui.escape_text property.

Role required: security_admin to edit glide.ui.escape_text or admin/dashboard_admin to rename dashboards.

There are two sources of this error:

- The system property glide.ui.escape_text is set to false.
  
  Only users with the security_admin role can enable or disable the glide.ui.escape_text property.
- There are dashboards in the instance that contain an ampersand (&) in the title.
  
  If any dashboard in the instance has an ampersand in the title, and the glide.ui.escape_text property is set to false, then conversion of homepages to dashboards is not possible.

If both of these conditions are met, then the list of dashboards that you can add the converted homepage to does not populate and you cannot convert the homepage.

With the security_admin role, you can temporarily enable this property and convert the homepages in your instance to dashboards.

1. **Elevate your role to security_admin.**
2. In the filter navigator, type `sys_properties.list`.
3. In the System Properties list, find `glide.ui.escape_text` and enable this property.
4. **Create dashboard versions of the homepages.**
   
   The dashboard list is shown and you can create dashboard versions the homepages as new dashboards or add the dashboard versions as tabs to existing dashboards.
5. **Disable glide.ui.escape_text.**

Dashboards overview

The Dashboards Overview shows cards that represent the dashboards that you have access to and a dashboard picker which allows you to show cards for all the dashboards in a group and to search and choose a dashboard from a list. Click a card to open the dashboard.

Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.

Watch this two-minute video to learn more about using the Dashboards Overview.

The Dashboards Overview enables you to show dashboards in one of these categories. By default, the Recent category is selected when you visit the Dashboards Overview.

- **Recent** shows up to nine dashboards that you have visited recently. The most recent are shown first.
- **Owned by me** shows the dashboards that you have created and those dashboards to which you have been assigned ownership.
- **Shared with me** shows the dashboards which have been shared with you as a user, or member of a group or role.
- **All** shows all the dashboards that you have access to.

Note: The category you choose limits the dashboard groups and individual dashboards you see when you choose from the Groups list and the Dashboard Picker search box. If no dashboards in the Incident group have been shared with you, and you select Incident from...
the Groups list, then the overview shows the note ‘No dashboards shared with you match your search.’

All tabs except for the Recent tab are sorted in ascending order by:

1. Dashboard group — Order
   The owner of the dashboard can specify an order number in the dashboard group’s form. This field is optional.

2. Dashboard group — Name

3. Dashboard — Order
   The owner of the dashboard can specify an order number in the dashboard’s form. This field is optional.

4. Dashboard — Name

**Dashboards Overview tiles**

Tiles on the overview show thumbnails of the widgets on the dashboard, the Dashboard Group, your level of access on the dashboard, the name of the dashboard, and the owner of the dashboard. Dashboard access levels are Owner, Editor, and Viewer. For more information, see [Share a responsive dashboard](#).

**Dashboards Overview Groups list**

Use the Groups list to show only those dashboards in a single group. The Groups list shows all dashboard groups without applying ACL rules. You may see dashboard groups in this list that have not been explicitly shared with you.
Dashboards Overview search box

Use the search box to search for dashboards by name or group.
Click **New** to **create a responsive dashboard**.

**Find a responsive dashboard**

Use dashboard categories, dashboard groups, and dashboard lists to find the dashboard you want to use.

Role required: There are no specific permissions required to view dashboards. However, you must have permission to view at least one dashboard to see the Dashboards Overview and the dashboard picker. For more information about dashboard permissions, see **Solving permissions issues on a responsive dashboard**.

On the Dashboards Overview, each tile contains information about the dashboard it represents: Thumbnails of the widgets on the dashboard, the Dashboard group, your role on the dashboard,
the name of the dashboard, and the owner of the dashboard. Dashboards that are not assigned a group by their creators are assigned the group Other.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**. The Dashboards Overview shows tiles representing the most recent dashboards you have visited.
2. Select a category:
   - **Recent** shows up to nine dashboards that you have visited recently. The most recent are shown first.
   - **Owned by me** shows the dashboards that you have created and those dashboards to which you have been assigned ownership.
   - **Shared with me** shows the dashboards which have been shared with you as a user, or member of a group or role.
   - **All** shows all the dashboards that you have access to.

All tabs except for the Recent tab are sorted in ascending order by:

1. Dashboard group — Order
The owner of the dashboard can specify an order number in the dashboard group’s form. This field is optional.

2. Dashboard group — Name

3. Dashboard — Order

   The owner of the dashboard can specify an order number in the dashboard’s form. This field is optional.

4. Dashboard — Name

3. Select a group from the Groups list to filter the displayed tiles on a dashboard group. If no dashboards match the combination of category and group, a message is shown, for example, ‘No dashboards shared with you match your search.’

   The Groups list shows all dashboard groups without applying ACL rules. You may see dashboard groups in this list that have not been explicitly shared with you.

4. Type a string in the Search by name or group box to filter the dashboards further. For example, type complete to search for the Completeness dashboards.

5. Click a dashboard tile to open that dashboard.

6. On any open dashboard, click the grid icon ( ) to return to the Dashboards Overview.

7. To find another dashboard, click the arrow next to the dashboard name to open the Dashboard Picker. You can:
   - Type a string in the Search by name or group box to filter the list.
   - Click the Dashboard Group selector to filter the list on a specific dashboard group.

   The Dashboard Group selector shows all dashboard groups in the instance. If you do not have permission to view any dashboards in a selected group, you will see the message, ‘No dashboards shared with you match your search.’

   - Scroll through all dashboards you have permission to open, starting with the most recent that you have viewed.
8. Select the name of a dashboard to replace the current dashboard with the new one.

**Edit a responsive dashboard**

You can edit the contents of a dashboard, including tabs and widgets. Because dashboards are shared, any modifications you make are applied globally.

Users can edit dashboards that they own, or ones to which they have been given editing rights. See [Dashboard permissions](#) for more information about viewing and editing rights on dashboards.

**Note:** Responsive dashboards do not support the Sticky Notes widget.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. From the dashboard picker, select the dashboard that you want to edit.
3. Perform any of the following actions.
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add a widget</strong></td>
<td>1. Click the plus sign (+ ) to put the dashboard in edit mode.</td>
</tr>
<tr>
<td></td>
<td>2. From the list, select the type of widget that you want to add, for example, Performance Analytics, Report, or Content Block.</td>
</tr>
<tr>
<td></td>
<td>3. Select the widget. A preview of the widget is shown.</td>
</tr>
<tr>
<td></td>
<td>4. Click <strong>Add</strong>. The widget is added to the top of the dashboard.</td>
</tr>
<tr>
<td></td>
<td>5. Drag to move the widget or resize it.</td>
</tr>
</tbody>
</table>

**Note:** Report titles are not automatically translated when added to a dashboard on localized ServiceNow instances.

| Remove a widget         | 1. Click the plus sign (+ ) to put the dashboard in edit mode.        |
|                         | 2. Point to the top of the widget, then click the X icon (×) that appears. |

**Note:** There is no confirmation message. The widget is simply removed from the dashboard.

| Configure widget layouts| For information on changing the appearance of widgets, changing widget layouts, and showing and hiding widget headers, see [Configure widget layouts](#). |

| Edit a widget           | 1. Click the plus sign (+ ) to put the dashboard in edit mode.        |
|                         | 2. Point to the widget, then click the pencil icon (✏). This icon is available only if your roles give you access to the widget's source. Edit rights to a dashboard do not necessarily give you edit rights to the widgets on that dashboard. |

The widget is opened in the tool where it was created. For example, when you edit a report widget, the source report is opened in the Report Designer.

| Apply a quick layout to a dashboard | Click the configuration icon (→) to open the configuration pane, then click a layout to snap the widgets against. Modify the layout as desired. |
### Add a tab to a dashboard

Click the configuration icon ( ) to open the configuration pane, then click **Create Tab**. The panel created with the dashboard becomes the dashboard's first tab. The default names of the tabs are the name of the dashboard followed by New Tab and New Tab 2. To change the default names, see Rename a tab below.

**Note:** You cannot link an existing tab into a dashboard.

### Reorder a dashboard tab

1. Click the plus sign ( ) to put the dashboard in edit mode.
2. Select the dashboard tab and drag it to the desired position.

Alternatively,

1. Click the context menu ( ) and select **Dashboard Properties**.
2. On the **Dashboard Tabs** related list, enter numbers in the **Order** column to specify the tab order. Tabs are listed from left to right with lower numbers appearing first.

### Delete a dashboard tab

Click the tab to make it active. Point to the tab name and click the trash icon that appears.

**Note:** The dashboard tab is deleted from all dashboards where it exists. Dashboards may have tabs that are used in multiple dashboards.

### Rename a tab

1. Click the tab to make it active.
2. Point to the tab name and click the pencil icon that appears.
3. Type the new name then press Enter.

**Note:** If you rename a tab on a dashboard that has been translated, the translations are replaced with the new English tab name. To translate the new name:

1. Click the gear icon ( ) to open the System Settings.
2. On the **General** tab, select the target language.
3. On the translated dashboard, rename the tab with the translation of its new name.
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable filtering of data for report widgets</td>
<td>Interactive filters let users filter data for all report widgets on a dashboard that are configured to follow interactive filters.</td>
</tr>
<tr>
<td></td>
<td>1. Click the plus sign (+) to put the dashboard in edit mode.</td>
</tr>
<tr>
<td></td>
<td>2. From the list, select Interactive Filters.</td>
</tr>
<tr>
<td></td>
<td>3. Navigate to the filter you want to add.</td>
</tr>
<tr>
<td></td>
<td>4. Click Add.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Interactive Filters.</td>
</tr>
</tbody>
</table>

Configure a report widget to follow interactive filters

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Point to the report widget, then click the gear icon ( ).</td>
</tr>
<tr>
<td></td>
<td>2. In the Edit Widget window, select the Follow interactive filter check box.</td>
</tr>
<tr>
<td></td>
<td>3. To show a filter icon ( ) on the report when it is following an interactive filter, select the Show when following check box.</td>
</tr>
<tr>
<td></td>
<td>Note: Performance Analytics widgets cannot follow interactive filters.</td>
</tr>
</tbody>
</table>

Enable filtering of data for Performance Analytics widgets

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Click the plus sign (+) to put the dashboard in edit mode.</td>
</tr>
<tr>
<td></td>
<td>2. Add a breakdown to a dashboard so that users can filter data for all Performance Analytics widgets on that dashboard. The pa_admin or pa_power user role is required to work with breakdowns.</td>
</tr>
<tr>
<td></td>
<td>See Add a breakdown to a dashboard.</td>
</tr>
</tbody>
</table>

View the description of a widget

- Point to the widget, then click the question mark (?). If the widget does not have a description, the question mark icon does not appear.

Configure widget layouts

- You can change the appearance of widgets; change widget layouts; change the widget title, header, and background color; and show or hide widget headers.

Users can edit dashboards that they own, or ones to which they have been given editing rights.

Note: Responsive dashboards do not support the Sticky Notes widget.

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. From the dashboard picker, select the dashboard that you want to edit.
3. Click the plus sign (+) to put the dashboard in edit mode.

4. Perform any of the following actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| Show or hide the widget border, header, and title | 1. Point to the widget, then click the gear icon (🔧).  
2. In the Edit Widget window, select or clear the boxes to show or hide the border, header, and title.  
|                                                             | Note: If you hide the header, point to the handlebar at the top of the widget to show the icons.  
3. To align the title, select Left, Center, or Right. |

**Edit Widget**

- Show
  - Border  
  - Header  
  - Title

- Title alignment  
  - Left  
  - Center

- Title color  
  Default color: #343d47

- Header color  
  Default color: #ffffff

When you hide the widget header, all the header icons are hidden, including the filter icon that indicates an interactive filter has been applied to the widget.
<table>
<thead>
<tr>
<th>Action</th>
<th>Steps</th>
</tr>
</thead>
</table>
| **Change the widget title color and header color** | 1. Point to the widget, then click the gear icon (🔧).
2. In the Edit Widget window, click the color picker icon (🎨) for Title color or Header color.
3. In the color picker, use the slider to choose a hue and select a color to choose it. You can also enter the hexadecimal code for the color in the Title color or Header color field. Delete the hexadecimal code to return to the default title or header color. |
| **Resize or change the layout of widgets** | 1. Drag to move and resize widgets.
- To make a widget larger, point to the widget header and then click the resize icon (🔍).
- To make a widget smaller, point to the widget header and press SHIFT as you click the resize icon. |
| **Apply a dashboard background color** | 1. Click the configuration icon (🔧) to open the configuration pane.
2. Click the color picker icon (🎨) for Dashboard Background and select the color to use. Use the slider to choose a hue and click a color to select it. You can also enter the hexadecimal code for the color in the Dashboard Background field. Delete the hexadecimal code to return to the default background color. |
| **Apply a quick layout to a dashboard** | 1. Click the configuration icon (🔧) to open the configuration pane.
2. Click a layout to snap the widgets against. Resize or change the layout of widgets as desired. |
Share a responsive dashboard

Share a dashboard with other users to create a shared view of data that you can use to collaborate. You can give other users viewing rights or both viewing and editing rights.

- Users can share dashboards that they own with other groups and users.
- Only users with the admin, dashboard_admin, pa_admin, or pa_power_user role can see roles in the Sharing panel.
- Users with the pa_admin or pa_power_user role can share dashboards that they can edit.
- Users with the admin role can share any dashboard they can access.

Administrators can set two properties that affect how users share responsive dashboards:

**glide.cms.share_dashboards.role**

In this system property, the admin can specify a comma-separated list of roles that can share their own dashboards.

**Note:** If one role in this list is misspelled, that role will not be able to share dashboards. If there is only one role in this list and that role is misspelled, no user will be able to share dashboards until the value for this property is corrected.

**glide.cms.dashboards.sharing_with_secure_search**

In this system property, the admin can specify that security rules are applied to the lists of users, user groups, and roles that are visible when users share responsive dashboards. Only users with one of these roles can see roles in the Sharing panel: admin, dashboard_admin, pa_admin, and pa_power_user.

For more information, see Dashboard permissions.

In general, when you share a dashboard, you are not granting permission to the widgets on that dashboard. Most Performance Analytics widgets, however, inherit security rules from the dashboards where they have been added. If you can view a dashboard, you can see the Performance Analytics widgets on that dashboard.

**Note:** Performance Analytics List widgets do not show the indicators that you do not have permission to read. While the dashboard permission applies to the Performance Analytics list widget as a whole, individual indicators in that list follow the permissions for those indicators. For more information about indicator permissions, see Control access to an indicator.

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard that you want to share from the dashboard picker on the top left.
3. Click the Sharing icon ( ) to open the Share panel.
4. Click Add groups and users ( ). Users who have the admin, pa_admin, dashboard_admin, or pa_power_user roles can also see roles on the Share panel.
5. Start typing the name in the To field.
6. Select a user, group, or role from the list that is shown.
7. From the Recipients list, select Can view or Can edit to specify the permissions the user, group, or role has on the dashboard. When a person you have shared the dashboard with goes to the Dashboard Overview, they will see either Viewer or Editor as their role with respect to the dashboard.
8. Optional: Clear the Send an email invitation check box.

**Note:** To edit a shared dashboard, a user must be in the same domain as the dashboard. Sharing a dashboard with write access (Can edit) does not change that. The Can edit sharing option works only if the dashboard is shared with a user in the same domain as the dashboard. For more information, see Domain separation in Dashboards.
You can choose not to send an email message. For example, if the recipients are already aware the dashboard has been shared with them.

9. Optional: Compose an addition to the default email invitation message. The default email message reads "The dashboard <Name of Dashboard> has been shared with you by <user role>.”

Users with the admin role can edit the default email message. Navigate to System Notification > Email > Notifications and open the Dashboard Sharing Notification. For more information, see Create an email notification.

10. Click Share.
The dashboard is shared and, if specified, an invitation is sent to the invited users.

Manage responsive dashboards

Depending upon their role, users can delete or duplicate responsive dashboards, and remove a user from a dashboard. All users can mark a dashboard as a favorite.
Delete a responsive dashboard
Delete dashboards that are no longer used. Deleted dashboards cannot be restored.

Role required: dashboard_admin or admin, or be the owner of the dashboard.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Select the dashboard you want to delete.
3. Click the context menu (≡) and choose **Delete Dashboard**.

When you delete a dashboard, the tabs on the dashboard are deleted if they are not used in any other dashboard.

Delete a dashboard tab
When dashboard tabs are no longer useful, it is possible to delete them.

To delete a dashboard tab, you must have edit rights on the dashboard.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Select the dashboard containing the tab you want to delete.
3. To delete a dashboard tab, point to the tab and click the trash icon.

When you delete a dashboard tab, it is removed from the dashboard. If it is not used in any other dashboard, it is deleted entirely.

Copy a responsive dashboard
When you duplicate a dashboard, its widget layout is preserved. However, sharing permissions are not preserved. Changes you make to the duplicated dashboard do not affect the original dashboard.

Any user who can share a dashboard can copy it.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Select the dashboard that you want to duplicate.
3. Click the context menu (≡) and select **Duplicate Dashboard**.

A copy of the dashboard is created with you as the owner. The name of the copy is Copy of (Original Dashboard Name).

4. Optional: To rename the dashboard, click the context menu (≡), select Dashboard Properties, and edit the Name field.

A copy of the dashboard is created with you as the owner.

Modify the dashboard and then share it with other users.

Remove a user from a dashboard
When you no longer want to share a dashboard with a specific user, group, or role, you can remove their access to the dashboard.

Role required: Any dashboard owner can remove users or groups from dashboards they own.

Users with the dashboard_admin or admin role can remove users, groups, or roles from any dashboard.

Users with the pa_admin or pa_power_user role can remove users, groups, or roles from any dashboard that they can edit. These dashboards include dashboards that a user owns, and dashboards to which they have been granted edit rights.

For more information, see Dashboard permissions.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Select the dashboard you want to modify.
3. Click the sharing icon ( ).
4. In the Share panel, select the user, group, or role that you want to remove.
5. On the information panel of the user, group, or role, click Remove From Dashboard.

The removed users no longer have the right to view the shared dashboard.

Mark a responsive dashboard as a favorite
You can mark a dashboard as a favorite to access it easily from the navigation pane.

Anyone who can access a dashboard can make it a favorite.
1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. From the dashboard picker, select the dashboard that you want to mark as a favorite.
3. Click the context menu ( ) and select Create Favorite.

Favorite dashboards appear in the favorites tab of the Application Navigator.

Export a responsive dashboard to PDF
Export a dashboard as a PDF so you can archive or print it.

Roles required: pa_viewer role is required to export dashboards to PDF.
You must activate the WebKit HTML To PDF plugin before you can export homepages, dashboards, and some reports as PDF documents. If the OAuth 2.0 plugin is not already active, the WebKit HTML To PDF plugin activates it as well. For more information, see Activate a plugin.
Interactive filters that are applied to the dashboard are also applied to the PDF. However, applied breakdowns are not included in the export.

Note: To generate the PDF locally, set the interactive filters, click the settings icon, and choose Printer Friendly Version to open the dashboard in a new window or tab. Export the dashboard using the print settings of the browser.

Limitations:
- Custom content may not generate as expected when exported to PDF. For more information, see Custom content PDF export limitations.
- Dashboards that are exported to PDF do not include the dashboard layout. Widgets are stacked on top of each other and take up the full page width.
- Widgets are exported to a fixed height. Large widgets, such as workbench or list widgets, are truncated.
Because exporting calendar reports to PDF is not supported, calendar reports exported from a dashboard may be truncated.

- Breakdowns applied to a dashboard are not included in the PDF.
- Widgets may appear in a different order than on the dashboard.
- Widget legends may not appear.
- Coloring on the delta text for single score report widgets is not preserved.
- The selected time frame at the widget level (for example, three minutes) is not reflected in the PDF file when the Show date range selector is selected at the widget level.

**Note:** PDFs that are sent as emails may not be generated immediately.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. From the dashboard picker in the upper left, select the dashboard that you want to export.
3. Click the context menu (≡) and select Export to PDF.
4. Configure your print and delivery options.
5. Click Export.

The content is exported to PDF according to the print and delivery options. If the PDF does not generate, identify and resolve any JavaScript errors.

### Copy a responsive dashboard URL

It is not possible to copy a dashboard URL from the browser. You can, however, create a URL that opens the current view of the dashboard, including tabs and breakdown elements. When the link is followed, the ServiceNow platform frame around the dashboard is not included.

You must be able to access the dashboard.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. Select the responsive dashboard with the URL you want to copy.
3. Optional: Select a specific tab, breakdown, and breakdown element.
4. Click the context menu (≡) and select Copy Dashboard URL.

The dashboard URL is copied to your clipboard. Some browsers prompt you to manually copy the URL to your clipboard.

Share the URL with other users.

**Dashboard URL format**

It is possible to link to a Performance Analytics dashboard from your instance. Several URL parameters enable you to specify aspects of the dashboard when the link is followed.

All dashboard URLs follow this format:

```
https://<instance>.service-now.com/$dashboards.do?
```

**Note:** Because dashboards are not limited to users of Performance Analytics,
ServiceNow    Madrid    Analytics, Intelligence, and Reporting

replaces

spa_dashboard

although both strings work in dashboard URLs.

This base URL is followed by several optional URL query parameters.

### URL parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_dashboard=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard to show.</td>
</tr>
<tr>
<td>sysparm_tab=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard tab to show. If you do not specify a tab, the leftmost tab is displayed. This parameter applies only if <code>sysparm_dashboard</code> exists.</td>
</tr>
<tr>
<td>sysparm_breakdown_source=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard breakdown to show.</td>
</tr>
<tr>
<td>sysparm_element=&lt;value&gt;</td>
<td>The sys_id or value of breakdown element to show. This parameter applies only if <code>sysparm_breakdown_source</code> also exists. Values are case-sensitive.</td>
</tr>
<tr>
<td>sysparm_element_value=&lt;value&gt;</td>
<td>The selected element value. This value may be the sys_id of a referenced record, or the database value for a choice list choice. Database values are case-sensitive. This parameter applies only if <code>sysparm_element</code> and <code>sysparm_breakdown_source</code> also exist.</td>
</tr>
<tr>
<td>sysparm_header=&lt;value&gt;</td>
<td>Controls if the dashboard header appears. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Visible — The full header is visible.</td>
</tr>
<tr>
<td></td>
<td>• Hidden — The full header is hidden.</td>
</tr>
<tr>
<td></td>
<td>• Embedded — The header is visible but only the options Refresh, Reset filters, and Export to PDF are visible.</td>
</tr>
<tr>
<td>sysparm_breakdown=&lt;value&gt;</td>
<td>Controls if the dashboard breakdown appears. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• Visible — The full breakdown is visible, including both source and element.</td>
</tr>
<tr>
<td></td>
<td>• Hidden — The full breakdown is hidden.</td>
</tr>
<tr>
<td></td>
<td>• Embedded — Only the breakdown element is visible.</td>
</tr>
<tr>
<td></td>
<td>• Readonly — The breakdown is visible but the user cannot change how the filter is configured.</td>
</tr>
</tbody>
</table>

When linking to your instance from an outside source such as a text document or presentation, use nav_to.do instead. For instructions on constructing this URL, see Navigate to a record or module using a URL.
Enable real-time updating for single score report widgets

Real-time updates ensure that users viewing a responsive dashboard always see the most up-to-date information.

You must have edit rights to the dashboard where the widget has been added.

Four types of aggregation are available for single-score reports: Count, Average, Sum, and Count Distinct. Real-time updating is available only for single score widgets that use the Count aggregation.

**Note:** Real-time updating does not work for single score report widgets on responsive dashboards under the following circumstances:

- When the report source is a database view, the user must click the Refresh icon on the widget to update the score. For more information, see Database views.
- When a business rule that uses the `current.update()` method fires on insert/update, the single score report increments by two instead of one. For more information, see KB article KB0693812.
- When a widget uses the filter `Assignment group - is (dynamic) - One of My Groups`, the widget does not update in real time. For more information, see KB article KB0749987.

You can enable real-time updating for single score widgets on homepages and all dashboards.

1. Navigate to the dashboard where the single score widget has been added.
2. Click the plus sign (➕) to put the dashboard in edit mode.
3. Point to the widget, then click the gear icon (🔧) that appears.
4. Select Show real-time updates then click Done.
5. Click the plus sign (➕) to exit edit mode for the dashboard.

The real-time icon (TableViewCell) appears on the widget. This icon is permanently visible, even when the score is not changing.

Change the owner of a responsive dashboard

The owner of a dashboard can edit it, and share it with other users.

Role required: Only users with the dashboard_admin or admin role can change a dashboard owner.

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Open the dashboard whose owner you want to change.
3. Click the context menu (⌥) and select Dashboard Properties.
4. Select a new owner in the Owner field.
5. Click Update.
Working with non-responsive dashboards

Non-responsive dashboards have several limitations including who can create, view, and edit them. Only users with the pa_viewer role can view non-responsive dashboards. Only users with the admin, pa_admin, or pa_power_user roles can create and edit them. Non-responsive dashboards use layouts with predefined dropzones.

**Basic principles, non-responsive dashboards**

<table>
<thead>
<tr>
<th>Principle</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboards</td>
<td>Users with any Performance Analytics role can have one or more dashboards assigned for viewing. Users with the pa_admin and pa_power_user role can set up and edit dashboards.</td>
</tr>
<tr>
<td>Tabs</td>
<td>Each dashboard may contain one or more dashboard tabs.</td>
</tr>
<tr>
<td>Rows</td>
<td>A tab can have multiple rows. For each row, you can specify the number of “placeholders” or columns. Each placeholder can hold a widget.</td>
</tr>
<tr>
<td>Widgets</td>
<td>Widgets contain information about one or multiple indicators.</td>
</tr>
</tbody>
</table>

**Note:** The mobile apps do not give access to dashboards as dashboards are not optimized for mobile screen sizes. You can access dashboards on a tablet using the standard web interface.

**Create or configure a non-responsive dashboard**

Create a dashboard to show the most relevant indicators for specific users or groups.

Roles required: pa_admin or pa_power_user

Watch these four-minute videos to learn how to create a non-responsive dashboard and a non-responsive breakdown dashboard.

**Note:** While these videos were created in an older release, the concepts are still valid.

You can create separate dashboards according to topic, such as for incident management, problem management, or request management. The **Owner** field is automatically populated. Only a user with the admin role can change the contents of the owner field.

1. Navigate to **Self-Service > Dashboards** or **Performance Analytics > Dashboards**.
2. From a dashboard, click the unlock icon (🔒).
3. Click the plus (+) icon in the top left.
4. Enter a **Name** that indicates what the dashboard shows. For example, Incidents Dashboard.
5. Enter an **Order** number to indicate the order the dashboard should appear on the Dashboards list.
Dashboards with lower numbers are listed before dashboards with higher numbers.

6. Select **Active** to make the dashboard available in the **Dashboards** list.

7. Select a dashboard **Group** to add the dashboard to. Dashboard groups determine how dashboards appear on the dashboard picker.

8. Optional: Select **No tabs** to disable the tab header.
   Dashboards with the tab header disabled can show only one tab. If you select the **No tabs** option, you cannot add additional tabs to the dashboard.

9. In the **Visible to** field, select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>Make the dashboard available to all users with the pa_viewer role.</td>
</tr>
<tr>
<td>Requires Roles</td>
<td>Select any roles that are required to access the dashboard, in addition to the pa_viewer role.</td>
</tr>
<tr>
<td>Users and Groups</td>
<td>Select specific users or groups that can access the dashboard. Users must have the pa_viewer role.</td>
</tr>
</tbody>
</table>

10. Optional: Select one or more breakdown sources in the **Breakdown Source** related list.
    Breakdown dashboards have extra options in the dashboard header to select a breakdown and an element.

### Create a tab on a non-responsive dashboard

By default, a dashboard is created with a **Home** tab. You can create and manage additional tabs to group information in a logical order. Tabs help you to manage information on your dashboard and keep related widgets in the same place.

Role required: pa_admin, pa_power_user, or admin

For example, the tabs **Daily Indicators**, **Weekly Indicators**, and **Home** could show the key indicators for incident management.

1. On a dashboard, click **Edit**.
2. Click the plus (+) icon beside the existing tabs.
3. In the pop-up window, enter a name for the new tab.
4. Perform one of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a name for the new tab and click Create tab.</td>
<td>Adds a new empty tab to the dashboard.</td>
</tr>
<tr>
<td>Select an existing tab from a different dashboard and click Link this tab.</td>
<td>Adds the tab to the dashboard. You can share a tab across multiple dashboards.</td>
</tr>
<tr>
<td>Select an existing homepage and click Link this homepage.</td>
<td>Adds the homepage to the dashboard. You can show a homepage within the dashboard.</td>
</tr>
</tbody>
</table>

To add or change content for a tab, click the plus (+) icon at the top left of the tab area.

To change the appearance of a tab, click **Change Layout**.

### Modify a tab on a non-responsive dashboard

An existing tab can be renamed, reordered, or deleted. Rename a tab when you want to clarify what it contains in a different way; reorder tabs when you want to move tabs with related information closer together; and delete a tab when what it contains is no longer relevant.

Role required: pa_admin, pa_power_user, or admin
1. Navigate to the dashboard that you want to modify.
2. In edit mode, click the down arrow beside the name of the active tab to access options for modifying tabs.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename</td>
<td>Change the name of the tab.</td>
</tr>
</tbody>
</table>
|                         | **Note:** If you rename a tab on a dashboard that has been translated, the translations are replaced with the new English tab name. To translate the new name:
|                         | 1. Click the gear icon (⚙️) to open the System Settings.                    |
|                         | 2. On the General tab, select the target language.                          |
|                         | 3. On the translated dashboard, rename the tab with the translation of its new name. |
| Delete this tab         | Delete the tab completely. When deleting the tab, it is also removed from all other dashboards. |
| Set as homepage         | Make this tab the homepage for the dashboard. When a user selects the dashboard, this tab appears as the first page. The homepage icon is added before the title of the tab. |
| Change tab order        | Change the order of the tabs by giving them a number. The tab with the lowest number starts on the left and the tab with the highest number appears on the right. |

**Change the layout of a non-responsive dashboard tab**
You can change the layout of a tab to improve the display of information in the same way you change the layout of homepages.

1. In edit mode, click **Change Layout**.
2. In the pop-up window, select one of the available layouts.
   - three columns with two wide columns and a narrow right column.
   - narrow left column, large right column, with a header.
   - Minimalist approach to the CMS layout.
   - two columns with wide right column, header and footer.
   - three columns of equal size only.
   - a single cell centered on screen.
3. Click **Change Layout** to apply the new layout to the tab.
   To revert the change, click **Change Layout** and select the original layout.
Manage non-responsive dashboards

Depending upon their roles, users can modify, delete, or duplicate non-responsive dashboards. Administrators can control access to a dashboard and add a Performance Analytics widget to a dashboard.

Modify, delete, or copy a non-responsive dashboard
You can manage non-responsive dashboards if you have an admin or power user role, including duplicating or permanently deleting them.

Role required: pa_admin, pa_power_user, or admin

Note: Report titles are not automatically translated when added to a dashboard on localized ServiceNow instances.

1. Navigate to the dashboard that you want to modify, delete, or copy.
2. Click Edit to put the dashboard in edit mode.
3. Click the gear icon at the top right and select one of the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td>Change the basic dashboard settings, as described in Create or configure a non-responsive dashboard.</td>
</tr>
<tr>
<td>Delete</td>
<td>Permanently delete the dashboard.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Create a copy of the dashboard, with the name Copy of &lt;name&gt;. The copy contains all tabs and their content. Widgets are not copied, only widget links are copied.</td>
</tr>
</tbody>
</table>

You can add, delete, rename, and change the layout of tabs in a copy without affecting the original dashboard. However, changing the configuration of a widget on the copied dashboard also affects the original dashboard, since they share widgets. Use the Modify option to change the name and update the look and contents of the dashboard copy.

Control access to a non-responsive dashboard
You can control which users, groups, or user roles can access a dashboard.

Role required: pa_admin

If users can access a dashboard, they can see all widgets on that dashboard.

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select the dashboard you want to give access to.
3. Click Edit.
4. Click the properties icon (            ).
5. Select Modify.
6. Limit access using one of these options:
   - To limit access to users with certain roles, select the roles in the Required Roles field.
   - To limit access to certain users and groups, select Users and Groups in the Visible to list and specify which users and groups get access.

Add a Performance Analytics widget to a non-responsive dashboard
You can add a widget to a non-responsive dashboard.
The dashboard must be in edit mode. To enable edit mode, click Edit.

Role required: pa_admin, pa_power_user, or admin

Note: The information on this page applies only to non-responsive dashboards. For information on how to use responsive dashboards, see Working with responsive dashboards.

Click the plus (+) icon at the top of the tab area to add widgets. A pop-up window appears for choosing which content you want to add to the tab. Content is not limited to Performance Analytics content, but may be from any area.

1. Select Performance Analytics in the category list.
2. Select the type of content to use.
   - Breakdown
   - List
   - Score
   - Time Series
   - Relative Compare
3. Select an existing widget, or select the option to create a new one.
4. Select the desired tab location by clicking the corresponding Add here button.
5. You can either add another widget or close the pop-up window. The widget is saved automatically.

Copy the URL of a non-responsive dashboard

It is not possible to copy a dashboard URL from the browser. You can, however, create a URL that opens the current view of the dashboard, including tabs and breakdown elements. When the link is followed, the ServiceNow platform frame around the dashboard is not included.

Role required: pa_viewer

1. Navigate to Self-Service > Dashboards or Performance Analytics > Dashboards.
2. Select a dashboard.
3. Optional: Select a specific tab, breakdown, and breakdown element.
4. Click the Copy URL icon ( COPY ).

Distribute the URL to share the dashboard.

Dashboard URL format

It is possible to link to a Performance Analytics dashboard from your instance. Several URL parameters enable you to specify aspects of the dashboard when the link is followed.

All dashboard URLs follow this format:

https://<instance>.service-now.com/$dashboards.do?

Note: Because dashboards are not limited to users of Performance Analytics,
replaces

$pa_dashboard

, although both strings work in dashboard URLs.

This base URL is followed by several optional URL query parameters.

### URL parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sysparm_dashboard=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard to show.</td>
</tr>
<tr>
<td>sysparm_tab=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard tab to show. If you do not specify a tab, the leftmost tab is displayed. This parameter applies only if <code>sysparm_dashboard</code> exists.</td>
</tr>
<tr>
<td>sysparm_breakdown_source=&lt;sys_id&gt;</td>
<td>The sys_id of the dashboard breakdown to show.</td>
</tr>
<tr>
<td>sysparm_element=&lt;value&gt;</td>
<td>The sys_id or value of breakdown element to show. This parameter applies only if <code>sysparm_breakdown_source</code> also exists. Values are case-sensitive.</td>
</tr>
<tr>
<td>sysparm_element_value=&lt;value&gt;</td>
<td>The selected element value. This value may be the sys_id of a referenced record, or the database value for a choice list choice. Database values are case-sensitive. This parameter applies only if <code>sysparm_element</code> and <code>sysparm_breakdown_source</code> also exist.</td>
</tr>
</tbody>
</table>
| sysparm_header=<value> | Controls if the dashboard header appears. Possible values are:
- Visible — The full header is visible.
- Hidden — The full header is hidden.
- Embedded — The header is visible but only the options Refresh, Reset filters, and Export to PDF are visible. |
| sysparm_breakdown=<value> | Controls if the dashboard breakdown appears. Possible values are:
- Visible — The full breakdown is visible, including both source and element.
- Hidden — The full breakdown is hidden.
- Embedded — Only the breakdown element is visible.
- Readonly — The breakdown is visible but the user cannot change how the filter is configured. |

When linking to your instance from an outside source such as a text document or presentation, use nav_to.do instead. For instructions on constructing this URL, see Navigate to a record or module using a URL.

### Export a homepage or non-responsive dashboard to PDF

You can generate a PDF of any homepage or dashboard.
Roles required: pa_viewer role is required to export dashboards to PDF.

You must activate the WebKit HTML To PDF plugin before you can export homepages, dashboards, and some reports as PDF documents. If the OAuth 2.0 plugin is not already active, the WebKit HTML To PDF plugin activates it as well. For more information, see Activate a plugin.

Custom content may not generate as expected when exported to PDF. For more information, see Custom content PDF export limitations.

Some widgets may be truncated on PDF exports.

Interactive filters and breakdowns that are configured as interactive filters that are applied to the dashboard are not applied to the PDF exports of homepages and non-responsive dashboards. Interactive filters are applied when you generate the PDF locally using the browser’s print settings.

To generate the PDF locally, set the interactive filters, click the settings icon, and choose Printer Friendly Version to open the dashboard in a new window or tab. Export the dashboard using the browser’s print settings.

1. Navigate to a homepage or a dashboard.

2. Click the export to PDF icon ( ) on a homepage or the Export to PDF button on a dashboard.

3. In the Export to PDF dialog box, select formatting options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Orientation</td>
<td>Page orientation of the exported PDF, either portrait or landscape.</td>
</tr>
<tr>
<td>Paper size</td>
<td>Paper size for the PDF. Available sizes match common paper sizes such as Letter and A4.</td>
</tr>
<tr>
<td>Zoom factor</td>
<td>Scaling percentage for the displayed widgets. This value must be a positive number.</td>
</tr>
<tr>
<td>Avoid page break inside widget</td>
<td>Prevents widgets from being printed across multiple pages. Widgets that would span multiple pages are moved to the top of the following page.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Smart shrink</td>
<td>Automatically selects the necessary zoom factor for all content to fit into</td>
</tr>
<tr>
<td></td>
<td>the width of the selected paper size.</td>
</tr>
</tbody>
</table>

**Note:** This option may cause incorrect page formatting when used with Avoid page break inside widget or a zoom factor greater than 100.

<table>
<thead>
<tr>
<th>Delivery</th>
<th>PDF delivery method.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Generate now</strong> generates the PDF immediately and shows a button for downloading.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Send as an email</strong> shows a field for entering an email address. After you click Export, the PDF file is generated and sent to the email address.</td>
</tr>
</tbody>
</table>

4. Click Export.
5. If you selected the **Generate now** option, wait for the rendering to complete and then click **Download**.

The content is exported to PDF according to the print and delivery options. If the PDF does not generate, identify and resolve any JavaScript errors.

**Enable real-time updating for single-score report widgets on a non-responsive dashboard**

Enable single score report widgets on a dashboard to update in real time. Real-time updates ensure that users see the most up-to-date information.

You must have edit rights to the dashboard where the widget has been added.

Four types of aggregation are available for single-score reports: Count, Average, Sum, and Count Distinct. Real-time updating is available only for single score widgets that use the Count aggregation.

You can enable real-time updating for single score widgets on homepages and all dashboards.

**Note:** Real-time updating does not work for single score report widgets on non-responsive dashboards when a business rule that uses the `current.update()` method fires on insert/update. The single score report increments by two instead of one. For more information, see the Knowledge Base article [KB article KB0693812](#).

1. Navigate to the dashboard where the single score widget has been added.
2. Click **Edit** to put the dashboard in edit mode.
3. Point to the widget, then click the gear icon (🔧) that appears.
4. In the Edit Widget window, select the **Show real-time updates** check box and then click **Done**.
5. Click **Done** to exit the edit mode for the dashboard.

The real-time icon (✔️) appears on the widget. This icon is permanently visible, even when the score is not changing.
Differences between homepages and responsive and non-responsive dashboards

ServiceNow has three ways to share Report and Performance Analytics visualizations with other users.

Compare dashboard types

<table>
<thead>
<tr>
<th></th>
<th>Responsive dashboards</th>
<th>Non-responsive dashboards</th>
<th>Homepages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move and resize widgets</td>
<td>Drag to move and resize widgets.</td>
<td>Layouts with drop zones, no custom resizing of widgets.</td>
<td>Layouts with drop zones, no custom resizing of widgets.</td>
</tr>
<tr>
<td>Lazy loading</td>
<td>Only visible widgets load. More widgets load as you scroll down. For more information, see Optimize widget rendering time on responsive dashboards.</td>
<td>All widgets load when the dashboard is opened which results in slower performance.</td>
<td>All widgets load when the dashboard is opened which results in slower performance.</td>
</tr>
<tr>
<td>Preconfigured layouts</td>
<td>Not required. On responsive dashboards, you can resize each widget individually, or apply a quick layout.</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>View dashboards / homepages</td>
<td>All users</td>
<td>Only users with pa_viewer role.</td>
<td>All users</td>
</tr>
<tr>
<td>Create dashboards / homepages</td>
<td>Any user with any role.</td>
<td>Only users with pa_admin and pa_power_user roles.</td>
<td>Any user with any role can create, but only admins can share.</td>
</tr>
<tr>
<td>Share permissions</td>
<td>Dashboard owners can share with users, groups, and roles. The ability of users to share responsive dashboards may be limited by the administrator. For more information, see Responsive dashboard properties.</td>
<td>Users with the pa_admin and pa_power_user roles can share. Users with the pa_admin and pa_power_user roles can edit and view. Users with the pa_viewer role can view dashboards that have been shared with them.</td>
<td>Only admins can assign read and write roles.</td>
</tr>
</tbody>
</table>

Determine whether a dashboard is responsive

Dashboards on an instance are responsive or non-responsive depending on how an administrator has configured your instance. These different dashboard types have different headers.

Look at the dashboard header to determine the type:

1. Responsive dashboards:

   Note: Some of the buttons are shown only if you have edit rights to the dashboard.
2. Non-responsive dashboards:

Set dashboards as your Home

You can set dashboards instead of homepages as your Home. With this setting, the last dashboard you selected appears when you navigate to Self-Service > Homepage, or click the logo on the upper left corner of the platform.

When dashboards are set as your Home, you can no longer navigate to homepages under Self-Service > Homepage or the company logo. The most recently selected dashboard is always loaded. You cannot specify a specific dashboard as your Home. Mark a dashboard as a favorite to easily navigate to the dashboard.

1. Click the gear icon to access System Settings.
2. On the General tab, select **Dashboards** in the **Home** section.

When you navigate to **Self-Service > Homepage**, **Self-Service > Dashboards**, or click your company logo, the last dashboard you selected appears.

**Request an analytics service**

Request services associated with dashboards, such as to request a new dashboard or access to an existing dashboard.

Role required: none

1. Navigate to either **Self-Service > Service Catalog** or **Service Portal > Service Portal Home**.
2. If you navigated to the Service Portal, select **Order Something**.
3. Select the **Can We Help You?** category.
4. Select **Analytics Request**.
5. Select the **Request type**, such as **Request dashboard access**, **Edit a dashboard**, or **Report an issue**.
6. **Optional**: If you are submitting the request for another user, select the **Request on behalf of another user** check box and select the user you are making the request for.
7. Provide additional details about your request, such as the name of the dashboard and a description of the changes you want made. Available fields depend on the request type. A notification is automatically sent to the requesting user.

After you submit the request, the Analytics team is responsible for reviewing and implementing your requested changes.

**Fulfill an analytics request**

Analytics service requests are assigned to the Analytics group who can review and fulfill the requests.

At least one user must be a member of the Analytics group.

**Role required:**
- Fulfiller — itil and pa_admin. The fulfilling user must be a member of the Analytics group which automatically grants these roles.
- Approver — itil and approver_user

1. Navigate to **Service Desk > My Groups Work**.
2. Select a request.
3. If the request is to grant access to a dashboard, select the **Dashboard** that this request applies to.
4. Select one or more users as the **Request Approver**.
   This approver should not be a member of the Analytics group.

**Note:** No approval is required when the request type is **Report an issue**.

5. The approver can then approve the request.
   a) Navigate to **Self-Service > My Approvals**.
   b) Select the request approval.
   c) Click **Approve**.

If the approver rejects the approval, the request is closed automatically. If the approver selects an option other than approved or rejected, the fulfilling user can close the request by setting the **State** to **Closed Skipped** or **Closed Incomplete**.

After the request is approved, or if no approval was required, a task is created for the Analytics team. Navigate to the **Tasks** related list on the request record to view the task. An email notification is sent to the Analytics team.

6. After the approver approves the request, perform the requested changes to fulfill the request.
   Refer to the dashboards documentation for instructions on how to modify dashboards and dashboard permissions.

7. Update the task **State** to **Closed Complete**.
   The request **State** is updated automatically when the task is closed. An email notification is sent to the requesting user to inform the user that the requested changes are complete.
Activate the Self-Service Portal for Analytics plugin

You can activate the Self-Service Portal for Analytics plugin (com.snc.pa.bi_service) if you have the admin role.

Role required: admin

Self-Service Portal for Analytics activates these related plugins if they are not already active.

### Plugins for Self-Service Portal for Analytics

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Analytics</td>
<td>Core Performance Analytics functionality</td>
</tr>
<tr>
<td>(com.snc.pa)</td>
<td></td>
</tr>
</tbody>
</table>

1. Navigate to **System Definition > Plugins**.

   A banner appears to notify you that you are in the All Applications page, which contains plugins and ServiceNow Store applications.

   **Note:**

   To redirect to the legacy list view for plugins, click the link.

2. Find the plugin with the filter criteria and search bar.

   You can search for the plugin by its name or ID.

   If you cannot find a plugin, you may have to request it from ServiceNow personnel. To request a plugin, follow the steps in [Request a plugin](#).

3. Activate the plugin.

   You can activate the plugin directly from the All Applications page or view more details about the plugin before activating it.

   - If you are certain that you have the correct plugin, click **Install**, and then click **Activate** in the dialog box that appears.
To view plugin details before activation:

1. Click the plugin name.
2. On the form, click the **Activate/Update** related link.
3. On the dialog box that appears, review the dependent plugins.
   
   If your plugin requires dependent plugins, they are activated automatically when you activate your plugin if they are not active already.
4. If demo data is available and you want to install it, click **Load demo data**.
   
   Some plugins include demo data, which are sample records that illustrate plugin features for common use cases. Load demo data when you first activate the plugin on a development or test instance. You can always load demo data later by clicking **Load demo data only** on the plugin form.
5. Click **Activate**.

### Administering dashboards

Learn about administering dashboards including how to group dashboards, how to move a dashboard with an update set, and troubleshooting permissions.

Users with the dashboard_admin role have full access including view, edit, delete, and share permissions on all dashboards in an instance, including all inactive dashboards. To view a list of all dashboards in an instance, navigate to **Performance Analytics > System > Dashboard Administration**. Click on the name of a dashboard to view its form.

The fields on the dashboard's form are described in [Create or configure a responsive dashboard](#). Use the related links to:

- Generate dashboard metadata
- View the dashboard
- [Launch Dependency Assessment](#)
Explore and manage dashboards

Quickly identify the relationships between Performance Analytics elements, such as dashboards, reports, and indicators. Each dashboard tab has customized interactive filters that enable you to refine the information that the dashboard shows. Navigate to Performance Analytics > Admin Console and select Dashboards in the Explore and Manage tile.

Explore dashboards example

To see all the automated indicators related to the Incident dashboard group based on the Incident table:

1. Select Dashboard Groups and Incident from the first two lists.
2. Select the Indicators tab.
3. From the Indicator — Table list, select Incident to see only the indicators on the Incident table.
4. From the Type list, select Automated to see only the automated indicators on the Incident table.

Dashboard and Dashboard Groups

Click Dashboard or Dashboard Groups to view the dashboard with the following tabs:

- **Dashboard groups** — a list of all the dashboard groups in your instance. This tab has focus if you select Dashboard Groups on the Admin Console.
  
  Filter: **Visibility**. Show all dashboard groups, dashboard groups that are visible to everyone, or dashboard groups that are limited to specified groups and users.

- **Dashboards** — a list of all the dashboards in your instance sorted by group. Expand the group to view the individual dashboards. Click the dashboard name to view and edit its details. This tab has focus if you select Dashboards on the Admin Console.
  
  Filters:
  
  - **Active** — Choose All, Active=True, or Active=False.
  - **Dashboard owner** — Choose All or select one or more owners from a choice list.

- **Widgets** — a list of all widgets used in your instance's dashboards.
  
  Filters:
  
  - **Type** — Choose All or filter on one or more widget types. See Performance Analytics widgets.
  - **Visualization** — Choose All or filter on one or more report visualization types from a list.

- **Indicators** — a list of all indicators used in your instance's dashboards. Filters: You can filter on Indicator Table, Type, Frequency, Indicator Source, Units, Direction, Scripted, and Aggregation Type. Click the name of the Indicator or Indicator Source to view and edit its details. For more information, see Set up indicators.

- **Indicator Sources** — a list of all indicator sources in your instance. Filter on Indicator Table and Frequency. Click the name of the Indicator Source to view and edit its details. For more information, see Indicator sources.

- **Breakdowns** — a list of all breakdowns in your instance. Filter on one or more Breakdown Tables. Click the names of the breakdown and the breakdown source to view and edit their details. For more information, see Performance Analytics breakdowns.
- **Breakdown Sources** — a list of all breakdown sources in your instance. Filter on one or more **Breakdown Tables**. Click the name of the breakdown source to view and edit its details. For more information, see [Define a breakdown source](#).

- **Jobs** — a list of all jobs created in your instance. The **Run** column shows how often the job is run. The **Time** column shows how long the job took the last time it was run. The list also shows whether the job is **Active**. Click the name of the job to view its details. For more information, see [Configure a job indicator](#).

- **Reports** — a list of all reports created on your instance. Filter on one or more **Report Tables** and one or more **Report Types**. Click the title of a report to view its details. For more information, see [Create a report visualization](#).

- **Interactive Filters** — a list of all interactive filters configured on your instance. Filter on what the filter is based on and one or more UI control types. Click the **Look up name** to view and edit the details of the interactive filter. For more information, see [Interactive Filters](#).

---

**Organize dashboards into groups**

Assign groups to dashboards so that users can find the dashboards they want more easily. Dashboard groups determine how dashboards appear in the dashboard picker when you navigate to **Self-Service > Dashboards**. You can also add view permissions to dashboard groups.

**Role required:** admin, pa_admin, or pa_power_user

Permissions on dashboard groups apply to all the dashboards in that group.

**Note:**
- View permissions on an individual dashboard override the permissions set at the dashboard group level.
- Edit permissions on a dashboard do not affect group permissions.
- Dashboard group permissions do not appear in the dashboard Sharing panel.

To show single groups in the dashboard picker, add the parameter `sysparm_group=` followed by the group name to the dashboard URL. For example, to show only a dashboard group named incident, use the URL `https://<instance>/$dashboards.do?sysparm_group=incident`.

1. Navigate to **Performance Analytics > System > Dashboard Administration**.
   Review current dashboards groupings using the **Group** column.
2. Click the dashboard that you want to add to a group to open its form.
3. In the **Group** field, select a group to add the dashboard to, or click **New** to create a group.
4. Optional: Open the form of the dashboard group to modify its permissions. Only view permissions can be set on dashboard groups.
   Dashboard groups use standard platform permissions. For more information, see [Access control list rules](#).
5. Click **Update**.

**How dashboard and dashboard group permissions interact on responsive dashboards**

Dashboard group and dashboard permissions are not additive. Depending on how permissions are defined on a dashboard, dashboard group permissions may not apply.

If a dashboard belongs to a dashboard group, any view permissions defined on the dashboard override all view permissions on the dashboard group. Permissions on the dashboard group level are not visible from the **Share** panel of a dashboard. When changing the view permissions for
a dashboard that is part of a group, always review the permissions for the dashboard group to ensure that users do not lose access. For more information, see Dashboard permissions scenarios.

For example, the dashboard group Support Dashboards contains the dashboards Open Incidents and Incident Metrics. The dashboard group has view permissions for the group Support. When you give view permissions to user John Dee for the dashboard Incident Metrics, the group Support can no longer see that dashboard. View permissions on the dashboard override all view permissions on the dashboard group.

Move a dashboard with an update set

Portal pages related to dashboard tabs are not automatically transferred in update sets. You can add portal pages to update sets from a dashboard record using the Unload Dashboard function, which unloads the entire dashboard with all related tabs, including portal pages.

Role required: admin

This procedure describes moving the dashboard structure to an update set. The dashboard structure includes the dashboard itself, tabs, the related security configuration, and dashboard-specific widget settings such as header color, borders, etc.

This procedure does not move the content of the dashboard (such as reports, PA widgets, content blocks, and other widgets) to the update set. You can add dashboard content to the update set using default platform functionality.

Note: Make sure dashboard content is either in the same update set as the dashboard record or is already present in the target instance. Errors result if the moved dashboard points to content that does not exist on the target instance.

1. In the source instance, navigate to the location of the dashboard you want to unload, for example, Self-Service > Dashboards.
2. Select the dashboard you want to unload to an update set.
3. Click the context menu icon ( ) and select Launch Dependency Assessment to verify that there is a portal page record associated with each tab.
Click the info icon (ℹ️) to see the associated portal page.

4. Click the context menu icon (︰) and select **Dashboard Properties** to open the dashboard record.

5. Click the context menu icon (︰) and select **Unload Dashboard**.
   
   Only perform this step once the dashboard is ready to unload, meaning that all content is added to the tabs.

6. When you are ready to move the update set, mark the update set as complete.

7. On the target instance, move the update using standard update set functionality. For more information, see **Retrieve an update set**.
   
   On the Remote Instance page, the **Retrieved Update Sets** related list shows all retrieved update sets. Click the update set to see if there are errors. Errors are shown on the **Retrieved Update Set** form in a related list called **Update Set Preview Problems**. See **Solving errors on dashboards moved with update sets**.

8. On the target instance, make sure that all the tabs of the dashboard have associated portal pages. See **Validate that tabs are moved to a target dashboard**.

   If the portal page is missing in the Tab form, click the search icon (🔍) next to the **Page** field to search for the associated portal page.

**Note:** If you cannot find the associated portal page in the target instance, follow these steps to move each missing portal page through the update:

1. Navigate to **Homepage Admin > Pages**.
2. Filter the list to show only the portal page with the sys_id you copied.
3. Right-click the record and select **Unload Portal**

The portal page for the current tab is added to the current update set.

4. Move the update set to another instance using standard update set functionality. For more information, see [Retrieve an update set](#).

The dashboard and its tabs are moved to the target instance.

**Validate that tabs are moved to a target dashboard**

When you have moved a dashboard with an update set, validate that the tabs are moved to the target instance and are populated.
Role required: admin

Moving dashboards from one instance to another requires associating the sys_id values of dashboard tabs with the sys_id values of the associated portal pages. This task explains how to find these values and map them to each other if there are problems with moving the dashboard. Perform this task after you Move a dashboard with an update set.

1. In the target instance, navigate to the dashboard you have just moved.
2. Click the context menu icon (≡) and select Dashboard Properties.
3. For each tab in the tab form, verify that the mandatory field Page (sys_portal_page reference) is there. If every tab has an associated portal page then the dashboard was successfully moved.
4. If the portal page is missing in any of the tab forms, perform these steps:
   a) Click the context menu icon (≡) in the Tab form and select Copy sys_id.
   b) In the filter navigator of the source instance, enter pa_tabs.list.
   c) Filter the list to show only the tab with the sys_id you copied in substep a.
   d) Click the name of the tab to open its form.
   e) Click the information icon (ℹ️) of the Page value for that tab.
f) On the **Portal Page**, click the context menu icon ( deste ) and select **Copy sys_id**. Paste this value into the text editor.

This value is the sys_id for the portal page. It is different than the sys_id for the associated tab that you have already used. These values are used together to map the tab to the portal page.

g) Click the search icon ( este ) associated with the **Page** field.

h) In the pop-up window, filter on the portal page sys_id and select the returned query result.

i) Click **Update** in the Tab form to save your changes.

5. The associated portal page should be visible in the target instance. If you can’t find the portal page in the target, perform the following:

a) In the source instance, navigate to **Homepage Admin > Pages**.

b) Filter the list to show only the portal page with the sys_id you copied.
c) Right-click the record and select **Unload Portal Page**.

d) Move the update set to another instance using standard update set functionality. For more information, see [Retrieve an update set](#).

**Solving errors on dashboards moved with update sets**

When you move a dashboard with an update set, if errors are shown on the **Update Set Preview Problems** tab of the Retrieved Update Set page, follow the instructions for each error to solve these problems.

*Could not find a record in sys_grid_canvas for column canvas_page referenced in this update*

When you move a dashboard with an update set, the following error may occur: 'Could not find a record in sys_grid_canvas for column canvas_page referenced in this update'. To solve this error, move the canvas page from the source instance to the target instance.
Role required: admin

1. In the **Update Set Preview Problems** related list, click the information icon next to the error.

2. In the `pa_tabs` record payload, copy the `sys_id` associated with the `canvas_page` field.

3. In the source instance, navigate to `sys_grid_canvas.list`.

4. Filter the list on the `sys_id` copied in step 2.

5. Right-click on the returned record and select **Unload Canvas Page** to add this record to the current update set.

6. Transfer the update set to the target instance using standard update set functionality. For more information, see [Retrieve an update set](#).

7. Repeat this task for all update set preview problems that have this error.

The missing dashboard tab content is moved to the target instance.
Dashboard permissions

Dashboards have special granular view and edit permissions that are managed from the Sharing pane. Access control lists (ACLs) apply to most widgets that are added to dashboards.

- Users with any role can create dashboards, share dashboards that they own with users and groups, and edit dashboards if they have been given edit permissions. Users with any role can restrict access by role to any dashboard that they have created. The user also needs whatever roles are necessary to access the specific data on the dashboards.
- Users without a role can view dashboards that have been shared with them, but cannot create or edit dashboards.
- Users with pa_admin and pa_power_user roles can manage users, groups, and roles on any dashboard that they can edit.
- Users with the dashboard_admin or admin role can edit and manage users, groups, and roles for any dashboard. Admin and dashboard_admin users can also change a dashboard owner at any time.
- Only a dashboard owner and users with the dashboard_admin or admin role can delete that dashboard.
- The ability of users to share responsive dashboards may be limited by the administrator. For more information, see Responsive dashboard properties.
- If Explicit Roles are activated, dashboards are treated as internal resources. Users with the snc_external role cannot view dashboards by default. For more information, see Explicit Roles.

**Note:** The columns Visible to, Groups, Users, and Requires Roles only apply to non-responsive dashboards. The values in these columns do not apply to responsive dashboards.

Widget ACLs apply when that widget is added to dashboards (except for Performance Analytics widgets). If a user can view a dashboard but does not have ACLs to view one of its widgets, an empty widget placeholder is displayed. ACLs do not apply to data visualizations that aggregate data, such as pie or bar reports. ACLs always apply to list data that is displayed in widgets. Rows in a list that a user does not have access to are not displayed.

**Note:** ACLs are not applied to Performance Analytics widgets that are added to dashboards. Any user who can view a dashboard can view all its Performance Analytics widgets. Performance Analytics widgets can only be added to dashboards by users with the pa_power_user, pa_admin, and admin roles.

The Restrict to role field on the dashboard properties form and dashboard group permissions may have an impact on dashboard permissions. The dashboard owner, and users with pa_power_user, pa_admin, or admin roles can change dashboard properties. Users with the pa_power_user, pa_admin, and admin roles can change dashboard group permissions.

For example, when you add a pie report widget with 36 records to a dashboard, users who can access to that dashboard and that report can view the report of all 36 records. However, if a user drills down into the list view for that widget, only the records the user is allowed to access are visible.

Solving permissions issues on a responsive dashboard

Dashboard permissions can be set in several different locations.

When you find problems with permissions on responsive dashboards, you can review permissions on the Dashboard Sharing panel, group permissions and dashboard properties.
• Check the permissions on the Dashboard Sharing pane.
The dashboard owner, users with the dashboard_admin or admin role, and users with the pa_power_user or pa_admin role who can edit the dashboard can perform this step.

• Review permissions of the group to which the dashboard belongs. Dashboard group permissions do not show up in the dashboard Sharing panel.
Users with the dashboard_admin, admin, pa_power_user, or pa_admin role can perform this step.
• Compare the dashboard and dashboard group permissions. If permissions are specified on a dashboard, the permissions on the dashboard group are overridden and no do not apply.
Users with the dashboard_admin, admin, pa_power_user, or pa_admin role can perform this step.
• On the dashboard properties form, review the roles specified in the **Restrict to roles** field. Only users with one of the roles specified in this field can view the dashboard.
The dashboard owner, users with the dashboard_admin or admin role, and users with pa_power_user or pa_admin roles who can edit the dashboard can perform this step. Other users who can edit the dashboard can view this field but cannot edit it.

**Dashboard permissions scenarios**
Permissions on dashboards can be complicated. If you set a permission on a dashboard group, for example, permissions set on a dashboard within that group override it. This matrix shows what is visible based on various combinations of permissions.

The Dashboard permissions scenarios table uses these abbreviations:

- **DB** = Dashboard
- **DG** = Dashboard Group
- **RTR** = Restrict to Roles

For more information, see [Restrict responsive dashboard access to specific roles](#).
- **X** = Unspecified

**Note:** Users with admin and dashboard_admin roles have full permissions on all dashboards.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>DG Permission</th>
<th>DB view permission</th>
<th>DB edit permission</th>
<th>RTR</th>
<th>Who can view the DB?</th>
</tr>
</thead>
<tbody>
<tr>
<td>No DG, no DB permissions</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Only RTR</td>
<td>X</td>
<td>X</td>
<td></td>
<td>asset</td>
<td>Only the owner</td>
</tr>
<tr>
<td>Only DB permissions</td>
<td>X</td>
<td></td>
<td>itil</td>
<td>X</td>
<td>Users with the itil role</td>
</tr>
<tr>
<td>DB permissions and RTR</td>
<td>X</td>
<td></td>
<td>itil</td>
<td>X</td>
<td>asset</td>
</tr>
<tr>
<td>Scenario</td>
<td>DG Permission</td>
<td>DB view permission</td>
<td>DB edit permission</td>
<td>RTR</td>
<td>Who can view the DB?</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------</td>
<td>--------------------</td>
<td>--------------------</td>
<td>-----</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Only DG without permissions</td>
<td>Exists</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Users with either the pa_admin role OR the pa_power_user role</td>
</tr>
<tr>
<td>DG without permissions and RTR</td>
<td>Exists</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>asset Users with both the asset role AND either the pa_admin role OR the pa_power_user role</td>
</tr>
<tr>
<td>Only DG and DG permissions</td>
<td>Exists</td>
<td>itil</td>
<td>X</td>
<td>X</td>
<td>Users with either the itil role OR the pa_admin role OR the pa_power_user role</td>
</tr>
<tr>
<td>DG, DG permissions, and RTR</td>
<td>Exists</td>
<td>itil</td>
<td>X</td>
<td>X</td>
<td>asset Users with both the asset role AND either the itil role OR the pa_admin role OR the pa_power_user role</td>
</tr>
<tr>
<td>DG, DG permissions, and DB permissions</td>
<td>Exists</td>
<td>itil</td>
<td>itil_admin</td>
<td>X</td>
<td>asset Users with both the itil_admin role AND the asset role</td>
</tr>
<tr>
<td>DG, DG permissions, DB permissions, and RTR</td>
<td>Exists</td>
<td>itil</td>
<td>itil_admin</td>
<td>X</td>
<td>X Users with the itil_admin role</td>
</tr>
</tbody>
</table>

The default permissions for a dashboard group are pa_admin and pa_power_user. If a permission, such as itil, is specified on the dashboard group, this permission is added to the default permission. Permissions on individual dashboards override the dashboard group permission.

**Restrict responsive dashboard access to specific roles**

Specify additional roles required to access the dashboard when you share a dashboard with specified users, groups, and roles. To access the dashboard, it must be shared with the user and the user must have one of the specified roles.
Role required: pa_admin, pa_power_user, admin, or be the dashboard owner. Other users who edit the dashboard can see this field but cannot modify it.

Note: Restricting access to a dashboard to specific roles is not the same as sharing the dashboard with those roles. You must share the dashboard before you can restrict access to specified roles. The best practice, however, is to use the Share panel to share with users, groups, and roles. Restrict to roles is not recommended.

The Restrict to roles field is available only after responsive dashboards have been enabled. If responsive dashboards have been enabled and then disabled, the Restrict to roles field remains available but does not affect dashboard access.

When dashboards are migrated between releases, this field is automatically populated with the pa_viewe and pa_contributor roles to ensure that only users who could access the dashboard before migration can access it afterward.

1. Navigate to the dashboard to restrict to specific roles.
2. Click the context menu (≡) and select Dashboard properties.
3. In the Restrict to roles field, specify the additional roles required to access the dashboard.

Users with any of the specified roles can access the dashboard only if it has been shared with them first from the Share panel. For more information, see Share a responsive dashboard.

Only users with the restricted role are able to view the dashboard. A message on the Sharing panel indicates which roles have access. Click the roles in this message to view the properties of the dashboard.

Note: The ability of users to share responsive dashboards may be limited by the administrator. For more information, see Responsive dashboard properties.

Restrict responsive dashboard sharing by role
You can configure responsive dashboard properties to restrict which users are able to share responsive dashboards.

Role required: admin.
Configure a dashboard property to specify a comma-separated list of roles that can share their own dashboards. Users with these roles can see the **Share** icon on responsive dashboards.

1. Navigate to **System Properties** > **Dashboard Properties**.
2. In the field labeled **List of roles (comma-separated) that can share their own dashboards**, enter the roles. For example, if all users with the itil, asset, and pa_admin roles can share dashboards, enter `itil, asset, pa_admin`. If this field is empty, users with any role can share their own dashboards.

   If one role in this list is misspelled, that role will not be able to share dashboards. If there is only one role in this list and that role is misspelled, no user will be able to share dashboards until the value for this property is corrected.

Users with the specified roles can see the **Share** panel when they view a dashboard that they own. Users with other roles are not able to see the **Share** panel.

**Note:** Properties that restrict dashboard sharing do not apply to users with the admin and dashboard_admin roles. Users with these two roles can always share any dashboard.

To apply security rules to what is visible in the **Share** panel, select the box labeled **Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards**. For more information, see [Restrict responsive dashboard sharing with security rules](#). Restrict responsive dashboard sharing with security rules

You can configure the users, roles, and groups that users can see on the **Share** panel when they share a responsive dashboard.

**Role required:** admin. To modify the Access Control List, the admin must elevate to the security_admin role. For information, see [Elevate to a privileged role](#).

Users who can see the **Share** icon based on the configuration of **List of roles (comma-separated) that can share their own dashboards** may not see content in the **Share** panel based on the configuration of the property **Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards**.

1. Navigate to **System Properties** > **Dashboard Properties**.
2. Select the box labeled **Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards** to apply security rules to what is visible in the **Share** panel.

The existing security rule configuration for users, user groups and roles is described in their associated read access control list at the platform level. For more information, see [Access control list rules](#).

Only users whose roles are specified in the field labeled **List of roles (comma-separated) that can share their own dashboards** can share their dashboards. If this property is configured and a user’s role is not specified in the property, the user does not see the **Share** panel. When **Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards** is enabled, security rules are applied to the list of users, groups, and roles that the user can share their dashboards with in the **Share** panel.

**Domain separation in Dashboards**

This document is an overview of domain separation as it pertains to dashboards and how it relates to dashboard creation and administration. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.
Overview

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation. To activate the domain separation plugin, see Request domain separation.

Note: In order for users in child domains to view dashboards in parent domains, both domain separation and delegated administration must be enabled. For more information, see Access the Domain Configuration console.

How domain separation works in Dashboards

Assumptions:

- Only dashboards that have been shared are visible to other users. See Share a responsive dashboard.
- Users granted edit permissions on a dashboard can only edit that dashboard if they are in the same domain as the dashboard. For example, a user who is in the HR domain cannot edit a dashboard created in the parent of the HR domain.

Dashboard data that is domain separated includes dashboard records, dashboard tabs, and widget containers. Widget content is governed by the domain separation that applies to the content itself. For example, an admin adds a report created in the HR domain to a dashboard in the IT domain. This dashboard is not visible to users in the IT domain, although they can see the widget container.

A dashboard defined at the global level is visible to all users with whom it has been shared. A shared dashboard created in a parent domain is visible to users in the parent and all its child domains. For example, a dashboard created in the TOP company is visible to users in:

- Joe’s company
- Other companies in the TOP company
- All HR, CS, and IT child domains in those companies if it is shared with those users.

In the following figure, dashboards created in the IT, CS, and HR domain are not visible to users in the other child domains or to users in the parent domain.
Quick start tests for Dashboards

Validate that Dashboards still work after you make any configuration change such as applying an upgrade. Copy and customize these quick start tests to pass when using your instance-specific data.

Dashboards quick start tests require activating the Automated Test Framework - Responsive Dashboards plugin (com.glide.automated_testing_impl.dashboards). This plugin is active on zboot of the instance.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Responsive Dashboard Sharing</td>
<td>Confirm dashboard sharing by impersonating users.</td>
</tr>
<tr>
<td>Responsive Dashboard Visibility</td>
<td>Confirm dashboard visibility by impersonating users.</td>
</tr>
</tbody>
</table>
Dashboard URL parameters

Dashboard URL parameters allow you to control the visibility of headers and the breakdown sources of dashboards used in application pages.

Dashboard header

This sysparm_header URL system parameter controls the visibility of the header of the dashboard. It has the following values:

- hidden — The header is hidden on the application page.
- embedded — The dashboard header appears but only has limited options. Options to refresh, reset filters, and export to PDF are available on the context menu.
- visible (default) — The full header is visible on the application page.

```<your-servicenow-instance.com>/$dashboards.do?
sysparm_dashboard=ABC123&sysparm_tab=123ABC&sysparm_cancelable=true&sysparm_editable=false&sysparm_active_panel=false&sysparm_element=fed654&sysparm_element_value=def456&sysparm_breakdown_source=ghi789&sysparm_homepage_filters=%7B%22h%22:%5B%22table%22:%22incident%22,%22filter%22:%22assignment_group%22%7D%7D&sysparm_ignore_default_filter=true&sysparm_header=embedded``` 

Dashboard breakdown

The sysparm_breakdown URL system parameter controls the visibility of the dashboard breakdown. It has the following values:

- visible (default) — The full breakdown is visible including source and element.
- hidden — The full breakdown is hidden.
- embedded — Only the breakdown element is visible.
- readonly — The breakdown element is visible but is read only.

```<your-servicenow-instance.com>/$dashboards.do?
sysparm_dashboard=ABC123&sysparm_tab=123ABC&sysparm_cancelable=true&sysparm_editable=false&sysparm_active_panel=false&sysparm_element=fed654&sysparm_element_value=def456&sysparm_breakdown_source=ghi789&sysparm_homepage_filters=%7B%22h%22:%5B%22table%22:%22incident%22,%22filter%22:%22assignment_group%22%7D%7D&sysparm_ignore_default_filter=true&sysparm_breakdown=hidden``` 

Dashboard group

The sysparm_group URL system parameter enables you to include a single dashboard group in the dashboard picker on the Dashboards overview page. This parameter takes only the name of the dashboard group for a value.

```<your-servicenow-instance.com>/$dashboards.do?
sysparm_dashboard=ABC123&sysparm_tab=123ABC&sysparm_cancelable=true&sysparm_editable=false&sysparm_group=incident```
Dashboards overview URL parameter

Use the sysparm_group parameter to select the default value of the dashboard group on the Dashboards overview page.

Dashboard group

The sysparm_group URL system parameter enables you to open the All tab of the Dashboards overview page (pa_dashboards_overview.do) filtered by the specified dashboard group. This parameter takes as a value only the name of a dashboard group.

Note: If the dashboard group specified in the URL does not exist, the URL returns the Dashboards overview page with the Recent tab selected.

The example URL shows only the dashboards in the group CMDB Overview.

<your-servicenow-instance.com>nav_to.do?uri=%2F $pa_dashboards_overview.do?sysparm_group=CMDB Overview

Optimize widget rendering time on responsive dashboards

Large dashboards can take a long time to render, especially when widgets require complex queries or queries on large tables. You can use system properties to optimize how widgets load.

Note: You can optimize widget rendering only for responsive dashboards.

Role required: admin

Use these two system properties to optimize dashboard widget rendering:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>glide.canvas.grid.widget_performance_threshold</td>
<td>Defines the maximum number of seconds for a widget to render on a dashboard. Widgets that exceed this time are not rendered and a warning message is shown. Users can click to restart rendering. Stopping widgets that render slowly enables faster widgets to load, and increases the speed of dashboard loading.</td>
</tr>
<tr>
<td></td>
<td>• Type: Integer</td>
</tr>
<tr>
<td></td>
<td>• Default value: none</td>
</tr>
<tr>
<td></td>
<td>• Location: System Properties &gt; Dashboard Properties</td>
</tr>
<tr>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>glide.canvas.grid.widget_render_concurrent_max</td>
<td>Defines the maximum number of widgets that render simultaneously on a dashboard. With smaller values, more requests are made to the server. With larger values, fewer requests are made to the server.</td>
</tr>
</tbody>
</table>

**Note:** This property reduces load on the server. It does not necessarily improve performance of individual dashboards.

Widgets that are outside of the screen do not load at all until you scroll past them.

- **Type:** integer
- **Default value:** 3 if the property is not manually set. The minimum value is 2 if you set the property manually. If you set this property manually to 1 or lower, all widgets on the dashboard load simultaneously.
- **Location:** System Properties > Dashboard Properties

The values to use for these properties depend on the performance of your instance and the contents of its dashboards.

### Enable responsive dashboards

A system administrator can enable responsive dashboards for an entire instance.

**Role required:** admin

During conversion to responsive dashboards, the layout of dashboards may slightly change. Highly customized dashboards may have significant changes, such as different widget layouts or missing widgets. Review each dashboard for changes and adjust its layout as necessary on the drag-and-drop canvas.

1. Navigate to System Properties > Dashboard Properties.
2. Under Enable responsive dashboard, select Yes.

All new dashboards are responsive, and existing dashboards become responsive. Review the layout of all existing dashboards. See [Dashboards release notes](#).

### Disable responsive dashboards

If you disable responsive canvas for an instance, all dashboards become non-responsive dashboards and revert to non-responsive functionality. Disabling responsive canvas after it has been enabled is strongly discouraged.

**Role required:** admin

When you disable responsive dashboards:

- Sharing permissions that were made while responsive canvas was enabled are lost and must be manually re-added to dashboards. Only dashboard owners will be able to see dashboards that were created after responsive dashboards was enabled. For dashboards that existed before responsive canvas was enabled, dashboard permissions revert to their pre-conversion state.
• The layouts of dashboards made after responsive canvas was enabled are lost, and use the default drop zone layout. Dashboards created before responsive canvas was enabled revert to their pre-conversion layout. Any widgets added or removed while the dashboard was responsive are preserved.

• The Restrict to roles and Owner fields remains available in the Dashboard Properties form. However, the Restrict to role field does not do anything.

Set the glide.cms.enable.responsive_grid_layout system property to false. If this system property does not exist, you can create it.

Admin Console for dashboards
The Performance Analytics Admin Console contains several features for dashboard management.

Explore and Manage
Navigate to Performance Analytics > Admin Console.

The Explore and Manage dashboard contains tools to find, modify, and create dashboards and indicator-related records. Click the links to manage Dashboard Groups and Dashboards.

Advanced Configuration
Navigate to Performance Analytics > Admin Console.

The Advanced Configuration tile on the Admin Console shows a link to Dashboard Properties.

Tree view
The Admin Console tree view enables you to identify and view the relationships between various Performance Analytics and Reporting entities in a hierarchical fashion. With the tree view, you do not have to sift through multiple pages to determine how they relate to one another.

Responsive dashboard properties
Use properties to fine-tune dashboard behavior and appearance.

Introduction
Navigate to System Properties > Dashboard Properties to configure the main responsive dashboard properties.
# Responsive Dashboard properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable responsive dashboards.                                          | • Type: true | false  
• Default value: true  
• Location: System Properties > Dashboard Properties  
For more information, see [Enable responsive dashboards](#).                                                                                                                                                                                                                                                                               |
| glide.cms.enable.resposive_grid_layout                                  |                                                                                                                                                                                                                                                                                                                                                                                                  |
| Apply security rules to the list of users, user groups, and roles that are visible when sharing dashboards.                      | • Type: true | false  
• Default value: false  
• Location: System Properties > Dashboard Properties  
When enabled, the list of users, user groups, and roles that are visible in the sharing panel is restricted. The restriction is based on the configuration of the sys_user, sys_user_group, and sys_user_role ACLs. For more information, see [Access control list rules](#). There is a performance penalty associated with enabling this property. Performance degradation may be based on the number and complexity of business rules and ACLs on your instance. |
| glide.cms.dashboards.sharing_with_secure_search                        |                                                                                                                                                                                                                                                                                                                                                                                                  |
| Specify a comma-separated list of roles that can share their own dashboards.                                                | • Type: string  
• Default value: empty  
When this property is empty, all users can share their own dashboards.  
• Location: System Properties > Dashboard Properties  
[Note: Properties that restrict dashboard sharing do not apply to users with the admin and dashboard_admin roles. Users with these two roles can always share any dashboard.](#)                                                                                              |
| glide.cms.share_dashboards.role                                          |                                                                                                                                                                                                                                                                                                                                                                                                  |
| Maximum number of seconds for a widget to render on a responsive dashboard.                                                  | • Type: integer  
• Default value: none  
• Location: System Properties > Dashboard Properties  
For more information, see [Optimize widget rendering time on responsive dashboards](#).                                                                                                                                                                                                                                                   |
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum number of widgets that can render simultaneously on a responsive dashboard. | - Type: integer  
- Default value: 3  
- Location: System Properties > Dashboard Properties  
For more information, see [Optimize widget rendering time on responsive dashboards](#).  
glide.canvas.grid.widget_render_concurrent_max |
| Number of minutes that responsive dashboard widgets are cached in the browser. | - Type: integer  
- Default value: 2  
- Location: System Properties > Dashboard Properties  
glide.canvas.grid.widget_cache_ttl |

### Custom content PDF export limitations

When you create custom content to be placed as widgets on dashboards and home pages, you must perform extra tests before you export the content to PDF.

### Outside of ServiceNow support

As with any custom implementations, several things have limited or no support when they are beyond ServiceNow’s control:

- Custom content blocks: Content blocks that are not out-of-the-box or part of a plugin.
- Custom interactive filters (dynamic content blocks).
- Custom Iframes, including Iframes that link back to existing UI pages and scripts.
- Custom widgets: widgets not created by ServiceNow.
- Custom Global UI scripts: UI scripts that are not out-of-the-box.
- Custom UI pages: UI pages that are not out-of-the-box.
- Custom script includes: Script includes that are not out-of-the-box.

PDF export engines do not render pages the same way a browser does. PDF export functionality supports the following web technologies: HTML 4, CSS2, and JavaScript 1.5. Content block developers are responsible for testing their code against PDF export and for adjusting their implementation to these limitations.

### Gauge support

Gauges are containers for holding graphical content on dashboards and home pages in ServiceNow®, but gauges are no longer supported. Widgets are the supported containers for graphical content.

It is not possible to create gauges through the Dashboard and Homepage user interfaces. When you navigate to System UI > Gauges and click New, a widget is created for your content. You may have gauges in your instance if they have been moved from an earlier instance in an update set or are present in an older installed plugin. If gauges do not contain content or do not behave correctly, create a new widget with the content you want to show.

**Note:** Admins can create gauges at the table level using platform functionality. An ACL on the sys_gauge table restricts other users from creating gauges.
To create a new widget, navigate to **System UI > Widgets** and click **New**. For an example, see **Create a widget that displays a ServiceNow UI page**.

**Performance Analytics Solution Library**

The Solution Library enables you to easily install and update dashboards and visualizations for Performance Analytics solutions so that you stay current and have the latest KPIs and visualizations.

Using the Solution Library, you can install and update dashboards, widgets, reports, interactive filters, and other configuration records without impacting your indicators or indicator sources. The Solutions Library ensures that your data remains consistent. The Solution Library also enables you to update existing visualizations when you want, either individually or for an entire dashboard. Visualisation and configuration records that are already installed as part of initial plugin activation are also not updated on upgrade because those files are under apply once folder.

The Solution Library provides a description of each dashboard that you can use to identify which dashboards you want to install.

**Note:** You must enable responsive dashboards to use the Solution Library.

**Activate the Solution Library plugin**

Users with the admin role can activate the Performance Analytics - PA Solution Library plugin (com.snc.pa.solution.library). This plugin includes demo data and activates related plugins if they are not already active.

Role required: admin

If the related plugins are not already active, the Performance Analytics - PA Solution Library plugin activates them. The Solution Library plugin is active on both zboot and upgraded ServiceNow instances.

**Install a dashboard**

Use the Solution Library to install a dashboard and all its associated visualizations such as widgets and reports, and to configure existing dashboards.

Role required: pa_admin

When you install or upgrade a Performance Analytics solution, out of the box content in the instance is overwritten and new content is added to the dashboard. Any content that you have previously customized on the dashboard is not changed.

To reinstall a solution metadata record from a dashboard, such as a widget, without impacting other records used by the same dashboard, see **Install a single solution metadata record**.

Solution metadata record types include:

- Breakdown
- Breakdown Source
- Bucket Group
- Dashboard
- Dashboard Group
- Filter
- Indicator
- Indicator Source
- Permission
1. Navigate to **PA Solution Library** > **Solutions**.
2. Select the dashboard you want to install.
   
   The dashboards provided in the Solution Library may depend on indicators, indicator sources, or other configuration records. Solution Library content always includes the associated visualization and configuration content.
3. Click **Install**.
4. In the confirmation window, click **Install**.
   
   The installation may take some time to complete after you confirm. Clicking **Cancel** during this time closes the confirmation window but does not stop the in-progress installation.
   
   When the installation is complete, the confirmation window disappears and the **Installed Metadata** related list is populated with the records that were installed.

Navigate to the dashboard to begin analyzing your data.

**Upgrade a dashboard**

When you upgrade a dashboard, solution metadata that have updates available, including any new records added to the dashboard, are installed. Solution metadata records that you have customized, even if those records are updated in the newer release, are not affected.

Role required: **pa_admin**

When you install or upgrade a Performance Analytics solution, out of the box content in the instance is overwritten and new content is added to the dashboard. Any content that you have previously customized on the dashboard is not changed.

1. Navigate to **PA Solution Library** > **Solutions**.
   
   Records where the **Update Available** field is true are upgraded.
2. Select the dashboard you want to upgrade.
3. Review the **Solution Metadata** related list.
   
   When you click **Upgrade**, solution metadata records in which update_available = true are installed. Customized records are not overwritten.
4. Click **Upgrade**.
   
   The **Upgrade** button is available if at least one solution metadata record has an update available and the solution content has been installed at least once.
5. In the confirmation window, click **Upgrade**.
   
   The upgrade may take some time to complete after you confirm. If you click **Cancel** during this time, the confirmation window closes, but does not stop an in-progress upgrade.

New dashboard records are added to the dashboard. Updates to dashboard records that are not customized are applied. Dashboard records that you have customized are left unchanged.

If the dashboard does not appear as you expected after installing the solution content, see if the uninstalled records appear under the customer update table. The presence of uninstalled records on this table indicates that the uninstalled records were customized. To view the customer updates table, enter `sys_update_xml.list` in the filter navigator.
Install a single solution metadata record

Install a single solution metadata record used by a dashboard, such as a widget, to match the latest version of the record without impacting other records used by the same dashboard.

Role required: pa_admin

To install the entire dashboard and all associated records, see Install a dashboard.

Note: Installing a record does not overwrite any customizations you have made to that record.

Available solution metadata types:
- Breakdown
- Breakdown Source
- Bucket Group
- Dashboard
- Dashboard Group
- Filter
- Indicator
- Indicator Source
- Permission
- Report
- Report Source
- Scheduled Data Collection
- Script
- Tag
- Widget

1. Navigate to PA Solution Library > Solutions.
2. Select the dashboard that uses the record you want to install.
3. In the Solution Metadata related list, select the record you want to install.
4. Click Install.
5. In the confirmation window, click Install.

Duplicate a dashboard

Duplicate the dashboard, including the tabs, portal pages, and canvas records. Widgets on the dashboard are not duplicated.

Role required: pa_admin

By duplicating a dashboard you can modify or upgrade one copy without affecting the other.

Note: Duplicating a dashboard does not duplicate the widgets displayed on the dashboard. You can rearrange or remove widgets from one copy of the dashboard without affecting the other. However, modifying a widget record affects both the original dashboard and the duplicate.

1. Navigate to PA Solution Library > Solutions.
2. Select the dashboard you want to duplicate.
3. Click the **Duplicate Dashboard** icon.

A copy of the dashboard with the name Copy of (original dashboard name) is created.

**Widgets**

Objects that have been added to dashboards are called widgets. You can create and manage widgets. Many applications have their own widgets. See an application’s documentation for information about the widgets included with the application.

**Create a widget that displays a ServiceNow UI page**

You can create ServiceNow UI page that displays a web page, then make the UI page into a widget that can be added to dashboards and homepages.

Role required: admin

A UI page is a ServiceNow page that is not a list or a form. Certain UI pages, such as external site widgets or gadgets, do not display properly when placed in a dashboard.

**Note:** This functionality requires a knowledge of JavaScript.

1. Create or find a ServiceNow UI page that you want to display as a widget. Note the name of this UI page, to use in Step 4.

   For example, this HTML shows the ServiceNow landing page in an iframe.

   ```html
   <iframe id="myframe" src="http://www.service-now.com" scrolling="yes" style="height:100%; width:100%"></iframe>
   ```

2. Navigate to **System UI > Widgets** and click **New**.

   Widgets records are widget category records, not records for individual widgets. When adding a widget to the dashboard, first select the category and then the widget. The javascript you specify in step 4 contains the list of widgets to include in that category.

3. Fill in the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of this widget category. The user selects this category when adding its widgets to a dashboard.</td>
</tr>
<tr>
<td>Renderer Type</td>
<td>Select Javascript.</td>
</tr>
<tr>
<td>Active</td>
<td>Clear to make the widget unavailable to add to dashboards.</td>
</tr>
<tr>
<td>Roles</td>
<td>Select roles that can see this category when adding widgets to dashboards. If no roles are selected, all roles can see the category.</td>
</tr>
</tbody>
</table>

4. Add the following javascript in the **Script** field, making replacements as specified. The return statement contains the widgets that are listed in this widget category.

   ```javascript
   widget_name
   ```

   The name of the widget, which the user selects in the widget picker when adding the widget to a dashboard. This string also appears on the widget header.
function sections() {
    return {
        'widget_name': { 'uiPageName': 'UI_page_name'},
        'widget_name2': { 'uiPageName': 'UI_page_name'}
    };
}

function render() {
    var uiPageName = renderer.getPreferences().get("uiPageName");
    return renderer.getRenderedPage(uiPageName);
}

function getEditLink() {
    var uiPageName = renderer.getPreference('uiPageName');
    return 'sys_ui_page.do?sysparm_query=' + encodeURIComponent('name=' + uiPageName);
}

5. **Click Submit.**

To learn how to make a UI page without using a framework page template, see the [Making a UI page without using the framework page template](#) blog posting by a developer in the ServiceNow Community.

**Linking to the Analytics Hub from a custom widget**

You can create a custom widget to link to the Performance Analytics Analytics Hub.

Use the function `paDetailedHelper.open('<scorecard sys_id>')` in a widget link to open the Analytics Hub when clicking that link.

The following example demonstrates how to create a dynamic content block including links to the Performance Analytics Analytics Hub for the Number of Resolved Incidents indicator.

```xml
<?xml version="1.0" encoding="utf-8" ?> <j:jelly trim="false"
    xmlns:j="jelly:core" xmlns:g="glide" xmlns:j2="null"
    xmlns:g2="null"><script src="scripts/pa/pa_detailed_helper.js" />
    <a href="#" onclick="paDetailedHelper.open('31efe602d7130100b96d45a3ce610300')">New Incidents</a><br />
    <a href="#" onclick="paDetailedHelper.open('7dafa602d7130100b96d45a3ce6103c8')">Resolved Incidents</a><br />
</j:jelly>
```

**Agent Intelligence**

ServiceNow® Agent Intelligence is a platform function that provides a layer of artificial intelligence (AI) that empowers features and capabilities across ServiceNow applications to provide better work experiences.

**Note:** Agent Intelligence is not supported on on-premise instances, as its solution training functionality requires processing in ServiceNow datacenters.
Agent Intelligence includes two frameworks that you can use to create machine-learning solutions: one that predicts the correct category for your record data, and one that recommends solution content for reuse based on record similarity. You can enable this function on your instance by activating the Agent Intelligence plugin (com.glide.platform_ml), which includes the Agent Intelligence Reporting (com.glide.platform_ml_pa) plugin.

**Agent Intelligence classification framework**

**Note:** Artificial intelligence communities use the term *train* for machines in the same way we use it for humans and animals. For example, you can train horses to jump higher, and you can train systems to learn new ways to process data and solutions.

The Agent Intelligence classification framework enables you to use machine-learning algorithms to set field values during record creation, such as setting the incident category based on the short description. You can train predictive models so they act as an agent to automatically categorize and route work based on your past record-handling experience.

Enable Agent Intelligence to handle higher volumes of incoming requests at lower costs. Automate the categorization and assignment of requests to gain these benefits.
- Reduce task resolution times.
- Reduce the number of interactions required to resolve tasks.
• Reduce the error rates of categorizing and assigning work.

For information on how to use the classification framework, see Create and train a classification solution.

Agent Intelligence similarity framework

The Agent Intelligence similarity framework identifies existing records that have similar values to a new record. You use the framework to build a word corpus that functions as the vocabulary the system uses to compare your trained records based on their textual similarity. For example, you can train a subset of your incident records to recommend a resolution based on the information of a similar incident record. By reusing similar closed incidents that have a proven resolution, you can help agents and fulfillers quickly provide the best resolution for an incoming incident.

The similarity framework does not require an exact match of words for its text comparisons, as its algorithms identify similar words and synonyms based on similar contexts. For example, the phrases “printer not working” and “printer broken” are both captured in your word corpus. The framework also collects, learns and applies your industry-specific context. For example, the phrase “unable to join network” has a different context in a networking company than it does in a healthcare insurance company.

To keep your word corpus up to date, retrain your solution periodically and refresh your Similarity Window frequently. To see how the Similarity Template helps you to configure your solution using similarity windows, filters, and input fields, see Create and train a similarity solution.

Note: The similarity framework currently only supports the English language.

Training your machine-learning solutions

Agent intelligence enables you to train predictive models and machine-learning solutions that you can apply to your business processes, such as:

• **Incident categorization**: Predicts the incident category based on the short description. See Agent Intelligence for Incident Management.

• **CSM case assignment**: Predicts the case record assignment group based on the short description. See Agent Intelligence for Customer Service Management.

You can also extend Agent Intelligence to other processes by creating your own predictive models and training them on your past record data.

A predictive model consists of these components, some of which you must provide.

Solution definition

A data record you create and configure that specifies these values for training a predictive model.

• The records used to train the model. For example, only train on incidents that have been resolved or closed within the last 6 months.

• The input fields the model uses to make predictions. For example, use the incident short description to make a prediction.

• The output field whose value the model predicts. For example, set the incident category based on the short description.

• The frequency to retrain the model. For example, retrain the model every 30 days.
Solution

A Java object produced when you train a solution definition at a ServiceNow datacenter. Agent Intelligence uses this object to predict a target field value given one or more input field values. All solutions specify these values.

- The solution **precision** is the aggregate percentage of correct predictions. For example, a precision of 50 means that out of 100 predictions, half of them should have the correct value.
- The solution **coverage** is the aggregate percentage of records that receive a prediction. For example, a coverage of 50 means half of all eligible records actually receive a prediction.
- The solution **classes** are the output field values for which the model can make predictions. Each class is an output field value with a list of possible precision, coverage, and distribution metrics to choose from. For example, the Incident Categorization solution has a class for each category such as software, inquiry, and database.
- The class **distribution** is the percentage of records from the entire table that have this particular output field value. For example, a distribution of 50 for the inquiry class means that half of incidents have the inquiry category.

Business rule

A rule that calls the solution data set to generate a prediction when a new record is created.

Selecting data records for training your solution

A solution is only as good as the record data you use to train it. In general, a good training dataset has these characteristics.

- The solution definition input fields are available to users when creating records. To make predictions at record creation, the solution must have the input field values at record creation.
- The solution definition output field is a choice field. To make more accurate predictions, limit the output field to a finite set of possible values.
- The training records only contain correct values for the output field. To make more accurate predictions, filter out any records that have unreliable output field values. For example, if recently closed incidents are subject to review and change for a month, filter out any recently-closed incidents.
- The training records contain multiple examples of each output field value you want the solution to predict. To provide more record coverage, include multiple examples of each output field value.
- The training records include common variations of the input fields. To provide more record coverage, include multiple examples of input field values.
Exporting your solution for training

Training flow

To train a solution, you export its solution definition and associated records to the nearest training service at a ServiceNow datacenter. If you have data sovereignty requirements, training is not available. When training is complete, the training service exports the solution back to the instance and deletes all customer training data from the training service servers.

Note: All communications between the instance and the training service are over HTTPS.

Prediction business rules

By default, the system uses these business rules for Agent Intelligence.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Task Based Prediction</td>
<td>A business rule that runs before inserting new task records to make a field value prediction based on the solution definition output field and the solution dataset. Use this business rule as a template to create your own prediction logic. This business rule calls the Agent Intelligence API.</td>
</tr>
<tr>
<td>Update Prediction Results</td>
<td>A business rule that runs before closing task records to update the solution statistics with the actual precision and coverage results.</td>
</tr>
</tbody>
</table>

**Monitoring your predictive model coverage and precision**

You can track the coverage and precision of each predictive model using the Solution Statistics dashboard, which provides reporting on these prediction areas by default.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average Prediction Coverage (last 30 days)</td>
<td>Shows the average prediction coverage of a solution for the last 30 days. The value represents the percentage of predictions that yielded an outcome out of the total number of predictions attempted. Click the coverage score to see a breakdown by class.</td>
</tr>
<tr>
<td>Daily Prediction Coverage</td>
<td>Shows the daily prediction coverage of a solution. The value represents the percentage of records created on a given day where the solution was able to predict an outcome.</td>
</tr>
<tr>
<td>Average Prediction Precision (last 30 days)</td>
<td>Shows the average prediction precision of a solution for the last 30 days. The value represents the percentage of predictions where the predicted value was the same as the final value of the field when the record closed. Click the precision score to see a breakdown by class.</td>
</tr>
<tr>
<td>Daily Prediction Precision</td>
<td>Shows the daily prediction precision of a solution. The value represents the percentage of records closed on a given day where the predicted field value was the same as the final value.</td>
</tr>
</tbody>
</table>

For instructions on how to use the dashboard, see [Review classification solution statistics](#).

**Get started with Agent Intelligence**

Implement initial setup and configuration steps for Agent Intelligence to train a machine-learning (ML) algorithm to make predictions based on your past record data.

Role required: admin or ml_admin

The training process requires sending record data to a training service in the nearest data center and is therefore unavailable to customers who have data sovereignty requirements.

1. Activate Agent Intelligence on a non-production instance.
2. From your production instance, export the records that you want your Agent Intelligence solutions to process.
For example, export 12 months of incident records to a non-production instance.

3. On a non-production instance, import the records you exported.

4. On the non-production instance, review the default solution definition records to determine if the filter, input fields, and output field are sufficient to predict your incident or task records. If necessary, create a solution definition for each record set you want to predict.

5. On the non-production instance, train the solution definition records you want to test.

6. For classification solutions, on the non-production instance, enable the Default Task Based Prediction business rule. If you have created custom solution definition records, update the business rule with the solution definitions you want to enable.

7. Test the solution predictions by either creating test records or importing more records from production.

8. For classification solutions, review the prediction reports to determine the accuracy and coverage of your solution and individual classes.

9. For similarity solutions, review the similarity examples to update the similarity score threshold if needed.

10. If necessary, update the solution definition filter to include more or different training records.

11. Retrain and retest any updated solution definition records.

12. When you are satisfied with your solutions, activate Agent Intelligence on your production instance.

13. Recreate any custom solution definition records and train the solution, or import the solution from your non-production instance to your production instance.

**Activate Agent Intelligence**

Agent Intelligence is included in the following packages: ITSM Professional, CSM Professional, HR Professional, HR Enterprise, and Now Platform App Engine Professional. When you subscribe to any of these packages, you can activate Agent Intelligence on your production instance.

Role required: admin

If your current subscription does not include Agent Intelligence as provided in these packages, contact your ServiceNow account manager.

If you want to use Agent Intelligence outside of these applications, contact your account manager for licensing options.

1. Activate the Agent Intelligence plugin (com.glide.platform_ml) on your production instance. The Agent Intelligence plugin includes the dependent Agent Intelligence Reporting (com.glide.platform_ml_pa) plugin.

2. Confirm that the activation has successfully created a sharedservice.worker user. These plugins utilize this user for training your ML solutions.

**Agent Intelligence for Customer Service Management**

Use your instance records to build Customer Service Management-specific solutions.

**Solution definitions**

These solution definitions are available as templates on instances where both Agent Intelligence and Customer Service Management are active. Create your own solution definition records to customize the behavior.
Solution Definitions for Customer Service Management

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSM Case Assignment</td>
<td>Classification</td>
<td>Predicts the Assignment group field from the Short description.</td>
</tr>
<tr>
<td>CSM Case Categorization</td>
<td>Classification</td>
<td>Predicts the Category field from the Short description.</td>
</tr>
<tr>
<td>CSM Case Prioritization</td>
<td>Classification</td>
<td>Predicts the Priority field from the Short description.</td>
</tr>
<tr>
<td>All Similar Cases</td>
<td>Similarity</td>
<td>Recommends similar cases based on the Short description that can help customer service agents with case investigation and resolution processes.</td>
</tr>
<tr>
<td>Recommended Open Cases</td>
<td>Similarity</td>
<td>Recommends similar open cases based on the Short description.</td>
</tr>
<tr>
<td>Recommended Resolved Cases</td>
<td>Similarity</td>
<td>Recommends similar resolved cases based on the Short description.</td>
</tr>
<tr>
<td>Major Issue Detector</td>
<td>Similarity</td>
<td>Provides recommendations for major issues based on the Short description.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Recommends one or more major cases, if available.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Otherwise, recommends similar cases that are not linked as child cases to a major case.</td>
</tr>
</tbody>
</table>

Business rules for classification solutions

These business rules apply only to the CSM Case Assignment, CSM Case Categorization, and CSM Case Prioritization solution definitions and are available only on instances where both Agent Intelligence and Customer Service Management are active. Create your own business rules on the Case (sn_customerservice_case) table to customize prediction and reporting behaviors.

Business rules for Customer Service Management

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Case Based Prediction</td>
<td>Case (sn_customerservice_case)</td>
<td>Generates prediction results from the active Customer Service Management solutions. Runs when a case record is inserted.</td>
</tr>
<tr>
<td>Update Prediction Results</td>
<td>Case (sn_customerservice_case)</td>
<td>Updates the solution precision and coverage statistics. Runs when a case record is closed.</td>
</tr>
</tbody>
</table>

Upgrade Information

If your instance is running on the Kingston release and you are upgrading to the Madrid release:
• Use the Default Case Based Prediction business rule template to create a new business rule. This rule includes a Solution variable that gets all active solutions retrieved by the `findActiveSolution(solutionName)` method.

• In a global domain environment, use the solutionNames array variable which requires that you explicitly provide the solutions that are called by the business rule.

• In a domain-separated environment, such as an MSP environment, refer to the commented code in the business rule template for easy customization.

• The business rule template calls the `applyPredictionForSolution()` method to predict regardless of any changes to the default value.

**Maintaining prediction accuracy**

You can manage prediction drift by retraining, modifying, or creating new solutions to reflect changes in your business conditions. Test and modify your business rule over time to ensure it works as desired across multiple consumption points and user Personas.

**Agent Intelligence for Event Management**

Build Event Management-specific machine-learning solutions.

**Solution definition**

This solution definition is available as a template on instances where both Agent Intelligence and Event Management are active. Create your own solution definition records to customize the behavior.

**Solution Definition for Event Management**

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closed alert similarity</td>
<td>Recommends similar Alert records based on these fields: description, node, resource, ci type, source, and metric name from the Alert (em_alert) table. Results are visible to users on the Alert form and on the Similar Alerts tab in Workspace.</td>
</tr>
</tbody>
</table>

**Agent Intelligence for HR Service Delivery**

Use your instance records to build HR Service Delivery-specific solutions.

**Solution definitions**

This solution definition is available as a template on instances where both Agent Intelligence and HR Service Delivery are active. Create your own solution definition records to customize the behavior.

**Solution Definitions for HR Service Delivery**

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR Case Categorization</td>
<td>Predicts the HR service from the Short description and Description.</td>
</tr>
</tbody>
</table>
Business rules

This business rule is available on instances where both Agent Intelligence and HR Service Delivery are active. Create your own business rules on the HR Case (sn_hr_core_case) table to customize prediction and reporting behaviors.

**Business rules for HR Service Delivery**

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predict COE, Service after insert</td>
<td>HR Case (sn_hr_core_case)</td>
<td>Generates prediction results for active HR Service Delivery solutions. Runs before a new HR case record that is submitted by email is inserted.</td>
</tr>
</tbody>
</table>

Agent Intelligence for Incident Management

Use your instance records to build Incident Management-specific solutions.

Solution definitions

These solution definitions are available as templates on instances where both Agent Intelligence and Incident Management are active. Create your own solution definition records to customize the behavior.

**Solution Definitions for Incident Management**

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incident Assignment</td>
<td>Classification</td>
<td>Predicts the Assignment group field from the Short description.</td>
</tr>
<tr>
<td>Incident Categorization</td>
<td>Classification</td>
<td>Predicts the Category field from the Short description.</td>
</tr>
<tr>
<td>Major Incident Detection</td>
<td>Similarity</td>
<td>Recommends similar active major incidents which the current incident can be linked to.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Recommends similar incidents to propose a major incident.</td>
</tr>
<tr>
<td>Similar Incidents (Major Incident Workbench)</td>
<td>Similarity</td>
<td>Recommends similar incidents that are not linked as child incidents to a major incident.</td>
</tr>
<tr>
<td>Similar Incidents</td>
<td>Similarity</td>
<td>Recommends similar incidents to help with incident investigation and resolution processes.</td>
</tr>
<tr>
<td>Similar Open Incidents</td>
<td>Similarity</td>
<td>Recommends similar open incidents that the current incident can be linked to.</td>
</tr>
</tbody>
</table>
### Solution Definition

<table>
<thead>
<tr>
<th>Solution Definition</th>
<th>Solution Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar Resolved Incidents</td>
<td>Similarity</td>
<td>Recommends similar resolved incidents to help with incident investigation and resolution processes.</td>
</tr>
</tbody>
</table>

### Business rules for classification solutions

These business rules apply only to the Incident Assignment and Incident Categorization solution definitions and are available only on instances where both Agent Intelligence and Incident Management are active. Create your own business rules on the Incident table to customize prediction and reporting behaviors.

#### Business rules for Incident Management

<table>
<thead>
<tr>
<th>Business rule</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Incident Based Prediction</td>
<td>Incident</td>
<td>Generates prediction results for active Incident Management solutions. Shows prediction results in an information message to users with the ITIL role. Runs when an incident record is inserted. Only updates the output field with a predicted value if it has not been previously set to a value that is different from the default value.</td>
</tr>
<tr>
<td>Update Prediction Results</td>
<td>Incident</td>
<td>Updates the solution precision and coverage statistics. Runs when an incident record is closed.</td>
</tr>
</tbody>
</table>

### Upgrade Information

If your instance is running on the Kingston release and you are upgrading to the Madrid release:

- The Default Incident Based Prediction business rule is replaced with the read-only Incident Based Prediction (Template). Make a copy of this business rule and customize it to reflect the specifics of your implementation and activate it.
- In a global domain environment, use the new solutionNames array variable which requires that you explicitly provide the solutions that are called by the business rule.
- In a domain-separated environment, such as an MSP environment, refer to the commented code in the business rule template for easy customization.
- The business rule template now calls the applyPredictionForSolution() method to predict regardless of any changes to the default value.

### Maintaining prediction accuracy

You can manage prediction drift by retraining, modifying, or creating new solutions to reflect changes in your business conditions. Test and modify your business rule over time to ensure it works as desired across multiple consumption points and user Personas.
Create and train a classification solution

Specify the records used to train a classification solution, what fields trigger a prediction, and how often you want to retrain your solution.

Role required: admin or ml_admin

A predictive model is only as good as the data you use to train it. To select appropriate training records, familiarize yourself with the table database dictionary as well as the current quality of the record values that you want to use.

You must create a separate solution definition record for each predictive model you want to support. To expedite this process, you can copy a solution definition record and its configuration into a new form by clicking Copy Solution Definition from the context menu of the original record. You can use the new record to make further solution updates without reconfiguring the entire solution definition to change something minor.

Note:
- If your data is encrypted by FDE (Full Disc Encryption), you can train solutions.
- If the field you are using for training is encrypted using Platform Encryption, ensure that the sharedservice.worker user has the correct encryption context role that has been used for encryption.
- If you are using Edge Encryption, Agent Intelligence does not support training.

1. Navigate to Agent Intelligence > Classification > Solution Definitions.
2. On the ML Solution Definitions list, click New.
3. On the blank ML Solution Definition form, configure these field values per the following guidance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution Template</td>
<td>Select the Classification Template. By default, Agent Intelligence offers these solution templates, which have some field values pre-assigned.</td>
</tr>
<tr>
<td></td>
<td>Classification Template&lt;br&gt;Incident Assignment Template&lt;br&gt;Incident Category Template&lt;br&gt;Incident Priority Template</td>
</tr>
<tr>
<td></td>
<td>For example, the Incident Assignment Template selects the Incident table and creates a filter that selects resolved or closed incidents within the last 12 months.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This field cannot have a value of None.</td>
</tr>
<tr>
<td>Active</td>
<td>Select this check box so that the system uses your solution definition record to train your solutions. You can only train active solution definition records.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter a name for the solution record.</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The system generates the value of this read-only field based on the Label value that you entered.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table containing the target records that you want the system to predict.</td>
</tr>
</tbody>
</table>
| Output Field  | Select the field whose value you want the predictive model to set. The system provides a default output field when you select a Solution Template.  
    In general, a good output field has these characteristics.  
    - The field is a choice field or a string field with a finite set of possible values.  
    - The field has some causal connection to the input fields.  
    For example, the Incident Category Template selects the Category field. |
| Domain        | On instances where domain separation is active, select the domain whose target records you want to predict. Create a separate solution definition record for each domain whose field values you want to predict. |
| Input Fields  | Select the input fields you want the solution to use to generate a prediction. The system provides default input fields when you select a Solution Template.  
    In general, good input fields have these characteristics.  
    - The fields are available to users when creating records. Configure the form to show all input fields.  
    - The field data type can be string, reference, choice, or HTML. The more information a field provides, the more often a solution can make a prediction, and the more often predictions are accurate.  
    - The field has a default value. The field should not have a blank value.  
    For example, all default solution definitions use the Short description field as the input field. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Select the conditions you want to apply to the training records. To train a solution, the filter must return at least one record. If your filter returns no records, update it until it returns records for training.</td>
</tr>
</tbody>
</table>

**Note:** The recommended number of records for training a good solution is from 30,000 through 300,000. If you submit more than 300,000 records, the most recent 300,000 records are used to train the solution. Use only authentic records from the database.

The system provides a default filter when you select a Solution Template.

A solution is only as good as the data you use to train it. In general, a good filter has these characteristics.

- The training records are inactive and have task states that represent completing work within your standard process such as resolved or closed.
- The training records only contain correct values for the target field. Filter out records with unreliable target field values. For example, if you are predicting the assignment group/category and you have assignment groups/categories in your historic incident data that are no longer used, add a filter to remove such incident records from the training.
- The training records contain multiple examples of each target field value you want the solution to predict.
- The training records include common variations of the input fields.

For example, the Incident Category Template creates a filter with these conditions.

(Created)(on)(Last 12 months) AND (Active)(is)(false) AND (State)(is one of)(Resolved | Closed)

Do not use hard-coded dates as filters, as these filters are not updated when the solutions are retrained unless you update them manually before every retraining. Instead, use relative date filters, such as last 3 months, last 6 months, and last 12 months.
Field | Value
--- | ---
Processing Language | Select the dominant language of the dataset you are training on the solution definition. If the dataset language is English only, you can choose None, as English processing is applied to all datasets by default. For example, if you select Dutch, data is processed in both English and Dutch.

**Note:** The term “processing” indicates some of the language-specific steps used as part of training a solution. For example, tokenizing words, removing stop words, and stemming.

Training Frequency | Select how often the system regenerates the solution based on records matching the Filter. Options include:
- Run Once
- Every 30 days
- Every 60 days
- Every 90 days
- Every 120 days
- Every 180 days

By default, the system runs training once. This practice provides you time to review and update the solution definition as needed until it provides acceptable coverage and precision values.

When your solution definition is fairly stable, consider scheduled trainings, as data can age over time, thus degrading the accuracy of your prediction model.

4. Click the appropriate button for your solution definition.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Save your solution definition record so that you can return to it later.</td>
</tr>
<tr>
<td>Submit &amp; Train</td>
<td>Create your solution definition record and train it.</td>
</tr>
</tbody>
</table>

5. If you submitted the solution for training, click OK on the Training Activation window to confirm.

The system schedules the solution for training with the nearest training service. The system sends you a notification when the training completes, including any errors that may have occurred in the training. Any other users can subscribe to the Agent Intelligence Notifications category. When training is complete, the system uploads the solution as an Attachment record.

Review the trained solution precision and coverage statistics.
Exclude a class from prediction

Exclude a class from prediction if its precision or coverage statistics do not meet your threshold of usefulness. For example, exclude it if you do not want the model to predict a particular output field value.

- Train the solution definition whose output field values you want to exclude.
- Role required: admin or ml_admin

If your classification solution does not provide sufficient precision or coverage, you can exclude a particular incident category from prediction.

Excluding a class from prediction only lasts until the next time you train your solution. If a class still does not provide sufficient precision or coverage values, you may want to consider deactivating the solution until it provides better results.

Typically, you exclude a class from prediction if you only want a person to manually set the excluded class value. For example, exclude the class if the solution does not offer sufficient precision or coverage, or because the class triggers other business logic that requires review or approval.

1. Navigate to Agent Intelligence > Classification > Solutions.
2. In the ML Solutions list, select the solution whose classes you want to exclude.
   This solution must have a State of Solution Complete.
3. In the Class Confidence related list, select the class you want to exclude.
4. In the Class Confidence record, review the precision and coverage combinations available from the Precision Coverage Lookups embedded list.
5. Select the check box for the 100 precision and 0 coverage combination.
   You can only select one check box.
6. From the Actions on selected rows control, select Apply Values.
   The system shows a Precision / Coverage Setting confirmation window.
7. Click OK to confirm the change or Cancel to discard it.

The solution excludes the class from all predictions until the next training cycle.

If you conclude this class will never produce meaningful predictions, consider deactivating the solution or changing the solution definition.

Exclude a class from solution training

Exclude a class from solution training to prevent the model from ever making predictions for a particular output field class. For example, you can exclude a particular incident category from training if you plan to retire or change the category.

Role required: admin or ml_admin

Excluding a class from training does not prevent the solution from making predictions for records that use the excluded class. Solution training still uses the input and output field values as data and attempts to match input field values to a new output field class. This attempt may cause undesirable prediction results unless you have another suitable class to replace the excluded class value.

Typically, you only exclude a class from training if you change the list of valid output field values. For example, if you replaced one Incident category with another Incident category, you may exclude the old category from training so that the solution only uses the new category for predictions.

1. Navigate to Agent Intelligence > Solution Definitions.
The system shows the current list of solution definitions.

2. Select the solution definition you want to edit.
   For example, select **Incident Categorization** to exclude an incident category from training.

3. Edit the filter to exclude the class.
   You can use the **(is one of)** or **(is not one of)** operators to exclude a particular class.

4. Click **Update & Train**.
   The system schedules the solution for training with the nearest training service. When training is complete, the system uploads the solution as an Attachment record.

   The solution excludes the class from all predictions.
   Review the trained solution precision and coverage statistics.

**Tune a trained classification solution**

Tune the performance of a trained classification solution by configuring class level precision and coverage values.

- Train the solution definition whose output field values you want to configure.
- Role required: admin or ml_admin

The system creates a class record for each output field value that it can predict. Each class record includes a list of possible precision and coverage combinations to choose from. By default, solutions use the highest combination of precision and coverage available. You can select another combination to refine predictions based on acceptable precision and coverage values.

1. Navigate to **Agent Intelligence > Classification > Solutions**.
   The system shows the list of available solutions.

2. Select the solution whose classes you want to configure.
   This solution must have a **State** of **Solution Complete**.
   The system shows the Solution record.

3. From the **Class Confidence** related list, select the class you want to configure.
   The solution only lists output field values for which it can make predictions. If the output field value is missing from this list, update the solution definition filter to provide more data for this output field value, and retrain the solution.
   The system shows the Class Confidence record.

4. Review the precision and coverage combinations available from the **Precision Coverage Lookups** embedded list.

5. Select the check box for the precision and coverage combination you want to use to make predictions of this class.
   You can only select one check box. Some combinations produce special prediction results.

<table>
<thead>
<tr>
<th>Prediction result</th>
<th>Precision</th>
<th>Coverage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never include class in predictions</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Always include class in predictions</td>
<td>0</td>
<td>100</td>
</tr>
</tbody>
</table>

6. From the Actions on selected rows control, select **Apply Values**.
   The system shows a **Precision / Coverage Setting** confirmation window.

7. Click **OK** to confirm the change or **Cancel** to discard it.
Test predictions of this class to verify that the system produces acceptable results.

**Create and train a similarity solution**

Create and train a machine-learning solution to collect and compare your existing records to new similar records. For example, you can compare the text in an open Incident record to a resolved Incident record to reuse its resolution.

Role required: admin or ml_admin

Create a word corpus of text and context that functions as the vocabulary the system uses to compare your existing records based on their similarity. The system uses the corpus to recommend solution examples that you can review and reuse.

This feature currently only supports English language processing.

Agent Intelligence supports training solutions where the source data is protected by these types of encryption.

- FDE (Full Disc Encryption).
- Platform Encryption. When using Platform Encryption, ensure that the sharedservice.worker user has the correct encryption context role that has been used for encryption.

**Note:** Agent Intelligence does not support training solutions where the source data is encrypted by Edge Encryption.

1. Navigate to **Agent Intelligence > Similarity > Solution Definitions**.
2. On the **ML Solution Definitions** list, click **New**.
3. On the blank **ML Solution Definition** form, configure these field values per the following guidance.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution Template</td>
<td>Select the <strong>Similarity Template</strong> to define a word corpus.</td>
</tr>
<tr>
<td>Label</td>
<td>Enter a unique name for your similarity solution.</td>
</tr>
<tr>
<td>Name</td>
<td>When your solution is created, this field auto-populates with a system-assigned name that is similar to your label name.</td>
</tr>
<tr>
<td>Table</td>
<td>Select the table containing the records you want to use for your word corpus. For example, the Incident table or the Asset table. When you assign a table value, a link appears in the form that shows the number of records that match your current conditions.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Select the conditions that you want to apply to the training records. To train a solution, the filter must return at least one record. If your filter returns no records, update it until it returns records for training.</td>
</tr>
</tbody>
</table>

**Note:** The recommended number of records for training a good solution is from 30,000 to 300,000. If you submit more than 300,000 records, only the most recent 300,000 records are used to train the solution. Use only actual records cloned from a production instance.

You may want to ensure that the records you train are not too old or that are irrelevant to your business.

Do not use hard-coded dates to filter training records, as you must manually change the filter dates before every retraining. Instead, use relative date filters, such as last 3 months, last 6 months, and last 12 months.

<table>
<thead>
<tr>
<th>Input Fields</th>
<th>Select record fields that contain the text and context that you want to include in your word corpus.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The field data type can be string, reference, choice, or HTML, such as Short description and Description. Journal type is not a supported data type.</td>
</tr>
<tr>
<td></td>
<td>In general, good candidates for your input fields have text that is relevant to the solution. For example, if you are configuring a solution to find similar Incident records, you may want to select the Short Description, Description, Resolution notes, and Close notes fields.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Training Frequency</th>
<th>Select how often the system retrains your word corpus based on records matching your Table Filter conditions.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By default, the system runs training once. This practice provides you time to review and update your solution definition as needed until it provides an acceptable similarity solution.</td>
</tr>
<tr>
<td></td>
<td>When your solution definition is fairly stable, consider scheduled trainings, as your data can age over time, thus degrading the accuracy of your similarity recommendations.</td>
</tr>
<tr>
<td>Field</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain</td>
<td>On instances where domain separation is active, select the domain whose target records you want to use for your word corpus. Create a separate similarity solution definition record for each domain whose field values you want to use for your word corpus.</td>
</tr>
<tr>
<td>Similarity Fields</td>
<td>Select record fields that are likely to contain words and phrases that help the system identify similar records for your solution. Your similarity field selections should be a subset of your input field selections. For example, if you select fields from Incident records that are in Open state, do not select Close note as a similarity field, as open records do not include Close note fields, so the text is not similar. The fields are available to users when they create records. To change your Similarity Field choices, click the Lock icon to open it and make your updates. Click the icon again to close it, saving your updates.</td>
</tr>
<tr>
<td>Similarity Window</td>
<td>Select the number of days that you want to look back for similar records. If you have a smaller number of total incoming records, a larger window might be best. If the window is too small, you may not retrieve enough similar records. However, if the window is too large, you may retrieve records that are not as useful. This window defines the time slot in which your similarity results are determined. For example, if you are looking for similar Incident records that are open, you may want to select Last 1 day as this targets the most recent records, many of which may be open.</td>
</tr>
<tr>
<td>Similarity Window Filters</td>
<td>Add filter conditions to your Similarity Window. These filters define the dataset conditions under which your similarity results are determined. For example, if you are looking for similar Incident records that are open, you may want to further filter your search by creating these conditions: (Incident state) (is) (In progress) These filters are applied in addition to the Input Field filters that you specify.</td>
</tr>
</tbody>
</table>
### ServiceNow Analytics, Intelligence, and Reporting

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Refresh Frequency</td>
<td>Select how often you want to refresh your Similarity Window. For example, if your window contains Incident records that are open, you may want to select a refresh frequency of Every 15 minutes, as new Incidents typically occur frequently throughout the day. This frequency may increase the likelihood that newly opened records are included in the refresh. However, if your similarity window contains KB Knowledge article records, which are typically not created often, you may want to choose a larger refresh frequency such as Every 1 day.</td>
</tr>
</tbody>
</table>

4. Click the appropriate button for the solution definition.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td>Save your solution definition record so you can return to it later.</td>
</tr>
<tr>
<td>Submit &amp; Train</td>
<td>Create your solution definition record and train it.</td>
</tr>
</tbody>
</table>

5. If you submitted the solution for training, click OK on the Training Activation window to confirm.

- The system schedules the solution definition for processing with the nearest training service and sends you a notification when the training completes. The notification includes any errors that may have occurred during the training. Other users can subscribe to the Agent Intelligence Notifications category.
- The trained solution updates your ML Solution Definition form, where it delivers paired solution examples that are ranked by their degree of similarity.
- When training is complete, the system uploads the solution as an Attachment record.

Review the trained similarity solution examples on the Related Links section of your ML Solution Definition form. See Review solution similarity examples.

### Update your similarity score threshold

After you review the similarity examples provided by the system, update your solution similarity score threshold if you want the results returned by the solution to be more or less similar.

- Review the Similarity Score Threshold values for your similarity examples.
- Role required: admin or ml_admin

1. Navigate to Agent Intelligence > Similarity > Solutions.
2. In the ML Solutions list, locate your solution and click the Reference Lookup icon (!).
3. Click Open Record.
4. In the Solution Statistics section, enter a new numerical value that represents a percentage in the Similarity Score Threshold field.
   For example, imagine that the current score is 80. In your similarity example review you decided to increase the accuracy of your similarity recommendations at the cost of lowering the prediction coverage. So you update the field by entering the higher score of 90.
5. In the Context Menu, click Save.
Your solution uses the new threshold value that you assigned to it and returns similar results that have a score higher than 90. If you set the score to 90, the degree of similarity in your word corpus is accurate at least 91% of the time.

**View solution training progress**

You can view solution training progress or statistics to determine if a solution is available or how long the next training cycle might take to complete.

Role required: admin or ml_admin

Solution training involves these steps.

1. Fetching files for training. The system downloads the training records and sends them to the nearest training service.
2. Preparing the data. The system removes duplicate records from the training set.
3. Training the solution. The training service trains the solution.
4. Uploading the trained solution. The training service uploads the solution as attachment records.

1. Navigate to **Agent Intelligence > Classification > Solutions** or **Agent Intelligence > Similarity > Solutions**.
2. In the ML Solutions list, select the solution whose progress or statistics you want to view. For example, select **Incident Categorization** to see the training history.
3. In the **Related Links** section, click **Show training progress**.

Training times vary based on the number of records and classes within the training set. The more records and classes you use, the longer the training can take. For example, a data set containing 100,000 records and several hundred classes can take around five hours to complete.

The system shows a Training Progress pop-up window.
For classification solutions, see Review classification solution statistics.

For similarity solutions, see Review similarity solution examples and scores.

**Review classification solution statistics**

Use the Solution Statistics dashboard to determine if a classification solution has sufficient precision and coverage for each class. Identify classes that require configuration or retraining with a new solution definition filter.

- To ensure optimal dashboard display, enable responsive dashboards or change the default dashboard layout.
- Role required: admin, ml_admin, or ml_report_user

The Solution Statistics dashboard lists the precision, coverage, and distribution for each class of active solutions. The maximum number of classes you can predict is 50. The system uses the top 50 classes with the highest number of records when it builds a solution. Note that the number of classes predicted may be less than 50, and can skip a class if there is not enough historical data to build a solution that can predict the class confidently.

1. Navigate to **Agent Intelligence > Classification > Solution Statistics**. The system displays the Solution Statistics dashboard.
2. From **Filter by solution**, select the solution whose statistics you want to review.
3. From **Filter by version**, select the solution version whose statistics you want to review.

4. **Click Apply.**
   The system updates the dashboard based on the filters selected.

5. **Identify classes with unwanted combinations of precision, coverage, and distribution values.** For example, identify classes that have low precision or coverage but a high distribution.

6. **Identify any missing classes you want the model to include.** For example, identify any missing incident categories from the Incident classification solution.

If you are satisfied with the solution you have reviewed, it will already be active and ready to use if it is the latest version. If you are not satisfied, you can choose a different version of the solution and make it active. You could also tune the solution by configuring the class precision and coverage to use acceptable values.

**Review solution similarity examples**

Review the similarity examples and scores generated during solution training to determine if the similarity score threshold is sufficient.

- **Train a similarity solution in a ServiceNow datacenter.**
- **Role required:** admin or ml_admin
Solution training generates paired data record examples with a percentile score that represents the degree of similarity between the two records. The higher the score, the higher the similarity. A score of 100 indicates identical records and a score of 0 indicates dissimilar records.

The solution only returns similarity results that have a score that is higher than the threshold.

![Note: The similarity filters specified in the solution definition are not applied for similarity examples and are only applied during prediction.]

1. Navigate to **Agent Intelligence > Similarity > Solutions.**
2. In the ML Solutions list, locate your solution and click the Information icon (i).
3. Click **Open Record.**
4. In the Related Links section, click **Similarity Examples.**
5. Review the similarity examples and their threshold scores to determine the accuracy and coverage levels you want applied to your solution similarity results.
   - The higher the similarity score, the more precise it is and the less coverage it offers. The lower the similarity score, the more coverage it has and the less precision it offers.
6. Based on your review, determine whether to increase or decrease the similarity score threshold value for your similarity solution.

If you decide to adjust the score for your similarity solution, **update its similarity solution threshold.**

**Activate solution version**

The system activates the most recent version of the solution when it completes training a solution, and only allows one solution version to be active at a time. However, you can activate any previously trained solution version you want Agent Intelligence to use to make predictions.

- Manually train a solution multiple times or set a training schedule.
- Role required: admin or ml_admin

The system creates a solution version each time you train a solution definition. Typically, you only manually create a new solution version when you change the solution definition filter and want to test it. Otherwise, most solution versions are created during scheduled solution training.

1. Navigate to **Agent Intelligence > Classification > Solutions** or **Agent Intelligence > Similarity > Solutions.**
2. In the ML Solutions list, click the Information icon (i) for the trained solution that you want to activate.
3. Click **Open Record.**
4. In the solution record, click **Activate.**
   - The system activates this solution version and deactivates any other solution version.

For classification solutions, review the trained solution precision and coverage statistics. For similarity solutions, review the similarity examples.

**Export trained solutions to production**

You can refine and test your ML solutions iteratively on a non-production instance, and then use update sets to export the changes to your production instance. This practice mitigates the risk of retraining solutions on your live production instance.
Prior to testing on a test instance, ensure that the instance hosts recently cloned data from your production instance so that the solutions you train on test continue to be valid when you export them to production.

Role required: admin or ml_admin

Plan your changes carefully, and remember that update sets match records based on the system ID (sys-id), and not the version number. For more information on update sets, see System update sets.

1. Navigate to Agent Intelligence > Classification > Solution Definitions or Agent Intelligence > Similarity > Solution Definitions.
2. Click the name of your trained ML Solution Definition record to open it.
3. In the Related Links section, click Add solutions to the current update set.
4. Click Update.

Your trained ML solution artifacts, such as solution definitions, template records, and predictive model statistics, are added to the current update set.

Depending on where you are in your solution testing, schedule your update set for export to another non-production instance for further testing, or on to production.

**Note:** After you export a similarity solution, click Refresh similarity window (Required after Solution Import) in the Related Links section of the corresponding ML Solution Definition form.

### Review classification prediction results over time

Use the Prediction Results dashboard to determine if solution predictions are improving over time. Identify solutions that require filter changes or retraining.

- To ensure optimal dashboard display, enable responsive dashboards or change the default dashboard layout.
- Role required: admin, ml_admin, or ml_report_user

The Prediction Results dashboard lists classification solution precision and coverage over time.

1. Navigate to Agent Intelligence > Classification > Prediction Results Report.
2. In the Prediction Results dashboard Filter by solution prompt, select the solution whose statistics you want to review.
   - The system updates the dashboard based on the solution you selected.
3. Identify classes with anomalous precision or coverage values.
   - For example, identify solutions where the precision or coverage is decreasing over time.

Update the solution definition filter to include or exclude classes as needed.

### Test a classification solution prediction

Once your machine-learning (ML) solutions are trained, you can call on the Agent Intelligence API to make a solution prediction. In this example procedure, we use the REST API Explorer to test a classification solution prediction for incident categorization.

Train your ML solution prior to testing a prediction.

Role required: web_service_admin, rest_api_explorer, or admin or ml_admin
This procedure uses sample data to illustrate what you can do in your instance, and may not represent data or records that are actually in your instance.

This scenario illustrates a classification solution prediction. You can also use the REST API Explorer for a similarity solution prediction.

1. Write down and save the name of your ML solution definition.
   In this case, you would use the **Name** field value in your ML Solution Definition Incident Categorization record, as illustrated in the following example.

![Example ML Solution Definition Incident Categorization](image)

2. Write down and save the **Input Fields** type in your ML Solution Definition Incident Categorization record that you want the REST API Explorer to use in its call to the Agent Intelligence API.
   In this case, you would use the short _description field, as the prediction model has been trained to use this field to learn its category definition.
3. Navigate to **System Web Services > REST > REST API Explorer**.

4. Set these choice fields as follows.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namespace</td>
<td>now (leave as default)</td>
</tr>
<tr>
<td>API Name</td>
<td>Agent Intelligence</td>
</tr>
<tr>
<td>API Version</td>
<td>latest (leave as default)</td>
</tr>
</tbody>
</table>

The Agent Intelligence form appears. You use this form to prepare your call request to the Agent Intelligence API.

5. In the solution-name **Value** field, type `ml_incident_categorization`.

> **Note:** This is the Name value you captured in Step 1 of this procedure.

6. Click **Add query parameter**.
The Agent Intelligence form refreshes to show the **Query parameters** section.

7. **Type** `short_description` **in the first field.**

   ![Note:](image)
   This is the input field you captured in Step 2 of this procedure.

8. **Type a short description of an incident in the second field. For instance, type** `Unable to connect`.

9. **Click the Send button.**
   The REST API Explorer sends your request to the Agent Intelligence API.
   The system predicts the output value in the Response Body section of the API output. You can use other short descriptions to test what the solution is predicting.

10. Optional: Send a different request to the Agent Intelligence API so that you can test the prediction model again.
   a) **Return to the Query parameters section** of the Agent Intelligence form.
   b) **Type a short description that references a different kind of incident in the second field.** For example, type `Unable to connect to MSSQL`.
   c) **Click the Send button.**

   The Response Body section may refresh to show a different outcome than what you saw in Step 9, depending on which incident categories you configured in your solution definition setup. In other words, changing the short description text can recategorize the incident as a different kind of issue.

   You can also test the Agent Intelligence prediction model when you create a new incident record using the incident form.

   1. Navigate to **Incident > Create New.**
   2. In the new Incident form that loads, set the fields as follows.
      - **User:** Enter the Caller name.
      - **Category:** Leave as default.
      - **Short description:** Enter a short description that you want to test.
   3. Submit the incident form.

   Result: When the form refreshes, an information message appears with the incident category automatically set to a specific value.

   ![Note:](image)
   For some short descriptions, the prediction might not process because the solution does not have enough confidence in predicting the value for this input.

---

**Preserve ML solutions during a system clone**

Save your trained machine-learning (ML) solution data during a system clone.

Role required: clone_admin or admin

The system stores trained ML solutions as Attachment records. These records include your solution artifacts, such as solution definitions, template records, and predictive model statistics, all of which...
are required components of the Agent Intelligence prediction functionality. To preserve these records, follow the high-level steps below each time you run a system clone.

1. Enter `sys_properties.list` in the application navigator to access the System Properties list.
2. Ensure the `glide.platform_ml.clone_artifacts` system property is set to `True`.
3. If you want to preserve only the ML solution records and not the numerous other records in the `sys_attachments` table, exclude the `sys_attachments` table from your clone run.
4. Request a system clone.
   The system preserves your ML solution records during the system clone.

Domain separation and Agent Intelligence

This is an overview of domain separation and the Agent Intelligence application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 2

Agent Intelligence enables the creation of supervised machine learning solutions using historic datasets. A machine learning solution definition can be configured in Agent Intelligence per domain, which ensures that the data used by the solution is domain-specific data. After a solution is trained for a domain, the solution calls for a prediction to be made for resolution, depending on what that domain belongs to. For example, the solution might be an incident or case.

How domain separation works in Agent Intelligence

An instance owner can train a machine learning (ML) solution for each domain by creating a solution definition for each domain and training those solutions. In this way each solution uses data specific to the corresponding domain.

- Data can be domain separated
- Domain column is present for base system application tables
- Domain-specific configuration is managed by instance owner
- Tenant domains can manage their own application data
- Application properties are domain-aware when needed

Configuration tips for Agent Intelligence

If you encounter issues during your solution training and solution prediction, follow the suggested resolutions.
### Solution training

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution or suggested action</th>
</tr>
</thead>
</table>
| The solution training remains in Waiting for Training status for too long, as the scheduler job is using an incorrect glide callback instance URL. | Ensure the `glide.servlet.uri` property in the Glide instance is set to the correct instance URL. This issue can occur when:  
  * An instance is cloned from production, yet it still refers to the production URL for the `glide.servlet.uri` property.  
  * The glide instance is provisioned and runs the training for the first time. |
| New categories have been added and are not yet having an impact on training. | This is expected behavior, as the new categories need to bake until sufficient data exists for the new category and the solution is retrained. |
| The solution training fails.                                          | When the training fails, click the Show Training Progress related link on the solution screen to determine where the potential problem resides. |
| The solution training fails due to user authentication.              | Navigate to System Security > Users and ensure the sharedservice.worker role is set to Active. |
| The model training returns saying the model cannot be created. The training fails and shows the "Error while training solution" message. The training progress window shows this message: "Solution training failed as either the data used is not sufficient or the input field is not predictive of the output field". | This issue can occur when the data quantity or the distribution of field values is not sufficient for a model to build successfully. Follow these steps to troubleshoot:  
  1. Ensure the distribution of the output field is not skewed.  
  2. Retrain the model by changing the date filters to use a larger amount of data.  
  3. If the input fields are not fully populated, add a filter to remove null records. |
| The solution has data in multiple languages but the coverage and precision results are poor. | Use the following options to help improve your metrics.  
  **Option 1:** Update the processing language of the solution to the most prominent non-English language.  
  **Note:** English is applied by default for all datasets.  
  **Option 2:** If there is sufficient data for each language/region:  
  1. Add a filter criteria for a specific language/region where the primary language can be identified (Dutch, English, French, German, Japanese, or Spanish).  
  2. Generate a solution for each language/region and apply the proper processing language to each solution. |

© 2020 ServiceNow, Inc. All rights reserved.  
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
## Solution prediction

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution or suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The prediction fails and returns a Java exception where the cause is unknown.</td>
<td>1. Search for the exception in the Agent Intelligence Glide logs.</td>
</tr>
<tr>
<td></td>
<td>2. Submit an Incident record for Agent Intelligence including all relevant details, such as the exception, the impacted instance, the solution name, and the input string.</td>
</tr>
<tr>
<td>There is no prediction applied to the incident/case record but the prediction returns a value when tested in the Rest API Explorer.</td>
<td>This can occur when the confidence of the prediction is less than the threshold required to make a prediction. After your solution is trained, use the following steps to confirm if your solution settings need adjusting.</td>
</tr>
<tr>
<td></td>
<td>1. Navigate to System Web Services &gt; REST &gt; REST API Explorer to find the confidence level for the prediction. See Test a classification solution prediction.</td>
</tr>
<tr>
<td></td>
<td>2. On your ML Solution Definition record, check the threshold set for your outcome class that was returned in the prediction by clicking on the name of the class. The Class page appears.</td>
</tr>
<tr>
<td></td>
<td>3. Check the Estimated Precision and Estimated Coverage values. If the corresponding threshold is more than the prediction confidence of the outcome, this is the root cause for why you did not see any prediction.</td>
</tr>
<tr>
<td></td>
<td>4. Adjust the class precision and coverage values to increase coverage or precision. See Tune a trained classification solution.</td>
</tr>
</tbody>
</table>

## Instance cloning

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution or suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>After an instance is cloned, predictions for your existing solutions fail.</td>
<td>The ML solution artifacts in the (ml_artifacts) table are stored in the (sys_attachment table). If the (ml_artifacts) table is not included in the clone when you run it, the predictions fail. Ensure your clone includes the machine-learning artifacts, as these are critical components of your Agent Intelligence solution.</td>
</tr>
<tr>
<td>After an instance is cloned, the solution training fails.</td>
<td>As the cloning run proceeds, it is possible that the sharedservice.worker user has either been inactivated, locked out, or the user ID is not set. Resolve these problems so that the solution training succeeds.</td>
</tr>
</tbody>
</table>
Virtual Agent

ServiceNow® Virtual Agent is a conversational bot platform for providing user assistance through conversations within a messaging interface. Use ServiceNow® Virtual Agent to build bots and design bot conversations that help your users quickly obtain information, make decisions, and perform common work tasks.

Watch this eight-minute video for an introduction to the Virtual Agent platform.

Components

The Virtual Agent platform includes the following components:

**Virtual Agent conversational (client) interface**

With Virtual Agent, your users interact with a chatbot or live agent through various messaging services. Your users can use the web-based Virtual Agent interface available for Service Portal and Apple iOS and Google Android environments. They can use the Virtual Agent interface for third-party messaging applications through the ServiceNow integrations for Slack, Microsoft Teams, and Workplace by Facebook.

**Virtual Agent Designer**

Use Virtual Agent Designer to develop, test, and deploy bot conversations that assist your users with common issues or self-service tasks. Virtual Agent Designer is a graphic tool for building the dialog flows of bot conversations, called topics. A topic defines the dialog exchanged between a virtual agent and a user to accomplish a specific goal or resolve an issue.

Predefined topics are available for Customer Service Management (CSM), HR Service Delivery, and IT Service Management.

**Live agent handoff**

Give users the option to switch to a human agent for assistance during bot conversations. Virtual Agent is integrated with live chat to offer a seamless transfer from a bot conversation to a live agent. With live chat, you specify the agent chat queues to be used, including the chat interactions transferred from a virtual agent to a human agent. Your users can request a live agent transfer at any time during a chatbot conversation. You can also initiate a live agent transfer through custom conversation flows that you build.

**Benefits**

Implementing a virtual agent to handle common requests and tasks enables your users to get immediate help, day or night. Providing your virtual agent on channels familiar to your users, such as third-party messaging apps, offers a convenient way for them to get work done quickly. A virtual agent can also offer personalized customer experiences by applying and remembering user information during the conversation.

Typical Tier 2 support tasks that can be accomplished with virtual agents include:

- Answering FAQs
- Providing tutorial (“how to”) information
- Querying or updating records, for example to get status on cases or incidents
- Gathering data, such as attachments, for the live agent
- Performing diagnostics
- Resolving multi-step problems
Automating these support tasks with a virtual agent frees your support agents to focus on more complex user issues and enables you to scale your support organization accordingly.

**Conversational interface**

The Virtual Agent conversational interface captures an automated messaging session between the virtual agent and user. The interface uses the Service Portal web widget, which can be configured for custom service portals. The widget is available in the CSM, HR Service Delivery, and ITSM Service Portals.
A simple conversation typically includes the following elements:

- Default welcome message from the bot, followed by the first prompt for the conversation. The initial prompt asks the user to type a question, which generally includes a keyword to trigger the appropriate conversation or to choose from a list of available topics.
• User response to the first prompt. In this example, the user chooses the topic for opening an IT incident.
• Series of prompts, acknowledgements, and responses exchanged between the bot and the user until the user's goal is reached or task completed. Different rich controls can be used in bot prompts, for example, choice lists with buttons or a carousel of images to select an item.
• Closing message to end the conversation.

Conversation options

The conversational interface offers your users several options to manage the conversation. Users can leave the current conversation and start a new one, or contact support to get access to a live agent for immediate assistance.
Implementing Virtual Agent

To implement Virtual Agent, complete these initial configuration and setup steps.
Role required: admin or virtual_agent_admin

1. Activate Virtual Agent for your production and non-production instances.
Note: Use your non-production instance to develop and test your Virtual Agent conversations (topics). When your topics run as expected, export the topics to your production instance and publish them to make them available on your Virtual Agent clients.

2. Activate the plugins for predefined Virtual Agent conversations.
3. Set up the Virtual Agent clients.
   a) Add the Service Portal chat widget.
   b) Optional. Load the standalone Virtual Agent web client.
   c) Install the Virtual Agent integration app for Slack, Microsoft Teams, and Workplace.

4. Configure Virtual Agent branding.
   Customize Virtual Agent with your own company logo and avatar. Set the color schemes of UI elements and the support contact information displayed in the client interface.

5. Configure the basic conversation settings and customer support contacts.
   Use the Virtual Agent general settings to define the basic characteristics of a conversation, such as the welcome message and general error message displayed on all Virtual Agent clients.

   Specify the chat queues used by live agents for support.

Activate Virtual Agent

You can activate the Glide Virtual Agent plugin (com.glide.cs.chatbot) if you have the admin role.

Role required: admin

You must have a subscription for Virtual Agent before you can activate the Glide Virtual Agent plugin. This plugin automatically installs related plugins:

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Support</td>
<td>Enables chat in a support queue.</td>
</tr>
<tr>
<td>(com.glide.connect.support)</td>
<td></td>
</tr>
<tr>
<td>Glide Conversation Server</td>
<td>Enables the Virtual Agent web clients, Connect</td>
</tr>
<tr>
<td>(com.glide.cs)</td>
<td>Support, conversation branding settings, and Live</td>
</tr>
<tr>
<td></td>
<td>Agent conversation settings.</td>
</tr>
<tr>
<td>Glide Conversation Server Adapters</td>
<td>Activates Virtual Agent adapters for third-party</td>
</tr>
<tr>
<td>(com.glide.cs.adapter)</td>
<td>messaging applications.</td>
</tr>
<tr>
<td>Conversation General Settings</td>
<td>Enables Virtual Agent conversation general settings.</td>
</tr>
<tr>
<td>(com.glide.cs.settings)</td>
<td></td>
</tr>
<tr>
<td>Virtual Agent Service Portal Widgets</td>
<td>Activates the Service Portal as a Virtual Agent</td>
</tr>
<tr>
<td>(com.glide.va.sp_widgets)</td>
<td>web client.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Virtual Agent Designer

**Description**: Activates Virtual Agent Designer for building conversation flows.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent Designer &lt;br&gt;(com.snc.conversation_builder)</td>
<td>Activates Virtual Agent Designer for building conversation flows.</td>
</tr>
</tbody>
</table>

1. Navigate to **System Definition > Plugins**.
2. Find and click the Glide Virtual Agent plugin (com.glide.cs.chatbot).
3. On the System Plugin form, review the plugin details and then click the **Activate/Upgrade** related link.
4. On the Activate Plugin window for Glide Virtual Agent, click **Activate**.

Activate predefined Virtual Agent topics.

### Predefined Virtual Agent topics

Prebuilt bot conversations (topics) are available for Customer Service Management, HR Service Delivery, and IT Service Management. These topics are designed to help users with common self-service tasks in each business area, such as creating or updating incidents or providing answers to frequently asked questions.

### Plugins for predefined topics

Admins activate the predefined conversations for Virtual Agent through the following plugins:

- **Customer Service Virtual Agent conversations** (com.sn_csm.virtualagent)
  - For details on the Customer Service topics, see [Customer Service Virtual Agent conversations](#).
- **Human Resources Scoped App: Virtual Agent Conversations** (com.sn_hr_virtual_agent)
  - For details on the HR topics, see [HR Virtual Agent conversations](#).
- **ITSM Virtual Agent Conversations** (com.snc.itsm.virtualagent)
  - For details on the ITSM topics, see [ITSM Virtual Agent conversations](#).

Users with the virtual_agent_admin or admin roles can preview the predefined topics in Virtual Agent Designer and deploy the topics to users by **publishing** them.

<i>Note: You cannot modify predefined topics. To create a custom topic from a predefined one, duplicate and modify the topic.</i>

### Installed with Virtual Agent

Several types of components are installed with activation of the Glide Virtual Agent (com.glide.cs.chatbot) plugin, including tables and user roles.

<i>Note: To view all other components installed with this plugin or application, see the Application Files table. For instructions, see [Find components installed with an application](#).</i>
Roles installed

**Note:** The installed roles do not contain any roles.

<table>
<thead>
<tr>
<th>Role title (name)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent Administrator (virtual_agent_admin)</td>
<td>Users who can create and manage topics (bot conversations) using Virtual Agent Designer.</td>
</tr>
<tr>
<td>External App Install Admin (external_app_install_admin)</td>
<td>Users who can install external apps such as Slack, Microsoft Teams, and Workplace.</td>
</tr>
</tbody>
</table>

Tables installed

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter Configuration (sys_cs_adapter_configuration)</td>
<td>Stores records for default keywords, labels, and message values for third-party messaging applications.</td>
</tr>
</tbody>
</table>
| Adapter Configuration Page (sys_cs_adapter_configuration_page) | Stores adapter configuration for third-party messaging applications. This table is the root table for:  
  - sys_cs_adapter_configuration_page_slack  
  - sys_cs_adapter_configuration_page_teams  
  - sys_cs_adapter_configuration_page_workplace |
<p>| Adapter Message (sys_cs_adapter_message) | Stores adapter messages. |
| Client Adapter (sys_cs_client_adapter) | Stores each adapter state. |
| Consumer Channel (sys_cs_consumer_channel) | Stores consumer channel information. |
| Consumer Device Context (sys_cs_consumer_device_context) | Stores consumer device context information. |
| Conversation (sys_cs_conversation) | Stores a record for each conversation on the instance. |
| Conversation Consumer (sys_cs_consumer) | Stores a record representing the user in a conversation, and references the associated sys_user record for that user. |
| Conversation Media (sys_cs_media) | Media attached to conversations are stored in sys_attachment, and associated to this table. |
| Conversation Message (sys_cs_message) | Stores a record for each message in a conversation. |</p>
<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conversation Server Connect Hand-off (sys_cs_connect_handoff)</td>
<td>Stores mapping of Virtual Agent conversations and Connect/Workspace conversations.</td>
</tr>
<tr>
<td>Conversation Session (sys_cs_session)</td>
<td>Stores a record for each conversation.</td>
</tr>
<tr>
<td>Conversation Task (sys_cs_conversation_task)</td>
<td>Stores a record for each conversation task.</td>
</tr>
<tr>
<td>Conversation Task History (sys_cs_conversation_task_history)</td>
<td>Stores history of conversation task execution.</td>
</tr>
<tr>
<td>Conversation Vendor (sys_cs_vendor)</td>
<td>Stores vendor information.</td>
</tr>
<tr>
<td>CS Consumer Account (sys_cs_consumer_account)</td>
<td>Stores third-party user information.</td>
</tr>
<tr>
<td>Live Agent Setup (sys_cs_live_agent_setup)</td>
<td>Stores the Live Agent setup with queues information.</td>
</tr>
<tr>
<td>Live Agent Support Queue Cache (sys_cs_support_queue_cache)</td>
<td>The database cache used for support queue wait times.</td>
</tr>
<tr>
<td>Published Topic (sys_cb_design_topic)</td>
<td>Stores design topic definitions and references the runtime topic.</td>
</tr>
<tr>
<td>Session Binding (sys_cs_session_binding)</td>
<td>Stores session binding and AMB channel information.</td>
</tr>
<tr>
<td>Slack Adapter Configuration Page (sys_cs_adapter_configuration_page_slack)</td>
<td>Extends the sys_cs_adapter_configuration_page table. Stores the adapter configuration for the Slack messaging application.</td>
</tr>
<tr>
<td>Teams Adapter Configuration Page (sys_cs_adapter_configuration_page_teams)</td>
<td>Extends the sys_cs_adapter_configuration_page_table. Stores the adapter configuration for the Microsoft Teams messaging application.</td>
</tr>
<tr>
<td>Workplace Adapter Configuration Page (sys_cs_adapter_configuration_page_workplace)</td>
<td>Extends the sys_cs_adapter_configuration_page_table. Stores the adapter configuration for the Workplace messaging application.</td>
</tr>
<tr>
<td>Sys CS Vendor Client Adapter Configuration (sys_cs_vendor_client_adapter_configuration)</td>
<td>Stores the adapter configuration for third-party messaging applications.</td>
</tr>
<tr>
<td>Topic (sys_cb_topic)</td>
<td>Stores a record for each topic.</td>
</tr>
<tr>
<td>Topic (sys_cs_topic)</td>
<td>Stores an instance of a topic from sys_cb_topic at run time. Records on this table are cleaned every 12 hours.</td>
</tr>
<tr>
<td>Vendor Context Configuration (sys_cs_vendor_context_configuration)</td>
<td>Stores vendor-specific device context information.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>com.glide.cs.general.error_message</td>
<td>Generic error message</td>
</tr>
<tr>
<td>com.glide.cs.general.live_agent_handoff_error_message</td>
<td>Message when no live agent has been set up</td>
</tr>
<tr>
<td>com.glide.cs.general.live_agent_handoff_message</td>
<td>Message to display when handing over to a live agent</td>
</tr>
<tr>
<td>com.glide.cs.general.msg_delay</td>
<td>Minimum delay between bot messages</td>
</tr>
<tr>
<td>com.glide.cs.general.support_email</td>
<td>General support email</td>
</tr>
<tr>
<td>com.glide.cs.general.support_hours</td>
<td>General support hours</td>
</tr>
<tr>
<td>com.glide.cs.general.support_phone</td>
<td>General support phone</td>
</tr>
<tr>
<td>com.glide.cs.general.top_selection_message</td>
<td>Top selection message</td>
</tr>
<tr>
<td>com.glide.cs.general.type_presence_delay</td>
<td>Minimum delay before displaying typing animation</td>
</tr>
<tr>
<td>com.glide.cs.general.welcome_message</td>
<td>Welcome message</td>
</tr>
<tr>
<td>com.glide.cs.global_configuration</td>
<td>The sys_id of the default configuration page (sys_cs_configuration_page)</td>
</tr>
<tr>
<td>com.glide.cs.jsa.nareserved_words</td>
<td>Reserved words in JavaScript that should not be used as valinputs names or vaVars names</td>
</tr>
<tr>
<td>com.glide.cs.live_agent_queue</td>
<td>The chat queue that users transfer to when a conversation transitions from a virtual agent to a live agent. This default queue is used unless the topic specifies a specific queue to use.</td>
</tr>
<tr>
<td>com.glide.cs.suggest.minimum_characters</td>
<td>The minimum number of characters the user must enter in a keyword search before partial matching, phonetic matching, and spellcheck begin to function.</td>
</tr>
<tr>
<td>com.glide.cs.suggest.enable_partial_search</td>
<td>Enables partial matching searches on topic searches when set to true.</td>
</tr>
<tr>
<td>com.glide.cs.suggest.enable_phonetic_search</td>
<td>Enables phonetic searching on topic searches when set to true.</td>
</tr>
<tr>
<td>com.glide.cs.suggest.enable_spell_check</td>
<td>Enables alternate search spellings on topic searches when set to true.</td>
</tr>
</tbody>
</table>

**Domain separation and Virtual Agent**

Information related to domain separation and the Virtual Agent application. Domain separation enables you to separate data, processes, and administrative tasks into logical groupings called
domains. You can then control several aspects of this separation, including which users can see and access data.

Overview

Support: Level 1

Domain separation is supported in this application. Not all ServiceNow applications support domain separation; some include limitations on the data and administrative settings that can be domain separated. To learn more, see Application support for domain separation.

Domain separation is best for those customers who:

- Need to enforce absolute data segregation between business entities (data separation).
- Customize business process definitions and user interfaces for each domain (delegated administration).
- Maintain some global processes and global reporting in a single instance.
- Separate data between customers or sub-organizations.
- The session scope is set upon session establishment to the domain listed in the user’s user record. Users can manually change their session domain scope with the domain picker.
- The record scope uses the domain of the record and is active when viewing the form of any record.

By default, the record scope takes precedence over the session scope so that users in higher-level domains adhere to each record’s data and process constraints. However, these users can choose to expand or collapse the domain scope to show or hide data from other domains. For example, a user in the MSP global domain also has visibility into child domains such as the ACME domain. When looking at an incident record from the ACME domain, the user can choose to expand the domain scope to show values from the MSP domain or collapse the domain scope to show only record values that match the record’s ACME domain.

Note: Users always have access to data from domains that have been explicitly granted to them by domain visibility.

Users with the domain_expand_scope user role can select the domain scope from the Toggle Domain Scope UI action on the form. When record scope is in effect, clicking the UI action expands the session scope and displays all data available associated with the user’s domain and child domain.

Live Agent setup of Virtual Agent if using Connect Support

The Managed Service Provider (MSP) has one Live Agent setup record in the global domain when the instance is provisioned.

Roles required: ITIL, virtual_agent_admin, or admin

1. User in a subdomain logs in and navigates to Collaboration > Chat Setup.
2. When user logs in to each subdomain, a seeded Live Agent setup record is created.

Prerequisites

1. User logged in to the subdomain navigates to Connect > Queues.
   - Creates queues and assigns the queues to the assignment groups.
• Assigns users to the assignment groups.

2. The admin logged in to the subdomain navigates to **Collaboration > Chat Setup** and assigns the default queues and the Live Agent variables to be used by virtual agents.

3. The admin sets up the Transfer Message and the “No Agents Available” message.
Branding setup of Virtual Agent

The Managed Service Provider (MSP) has only one global branding setup per domain-separated instance for the Virtual Agent web- and portal-based clients.

Roles required: ITIL, virtual_agent_admin, or admin

1. The MSP searches for Branding Setup in the Navigator as the global domain. The user logs in as a global user in this domain.
2. The MSP assigns a logo and avatar that is the same for all subdomain Virtual Agent topics. All subdomains share the same branding.
3. The MSP applies the colors that are leveraged by all subdomains.
The ServiceNow Virtual Agent supports custom branding such as company logo, bot avatar and theme colors. For additional information, please see Virtual Agent Branding Setup.

**Branding**

Logo in Chat Header: To modify the bot avatar, please edit the bot user profile.

Virtual Agent Profile - Live Profile Reference

Chat Header:

Chat Header Background:

Chat Header Font:

Chat Background:
General settings setup of Virtual Agent

The MSP has only one general settings setup per domain-separated instance for all Virtual Agent clients.

Roles required: ITIL, virtual_agent_admin, or admin

1. The MSP searches for Virtual Agent > General Settings in the Navigator as the global domain. The MSP logs in as a global user in this domain.

2. The MSP assigns generic settings to be used by all virtual agents for all subdomains:
   - Welcome message
   - Topic selection message
   - Generic error message
   - Minimum delay before displaying typing animation
   - Minimum delay between bot messages
**Designer of Virtual Agent**

The MSP either logs in to one of the subdomains and creates and enables topics or allows subdomain admin users to create and deploy their own topics.

**Roles required:** ITIL, or virtual_agent_admin

1. The admin user logged in to the subdomain navigates to **Collaboration** > **Virtual Agent** > **Designer** to enable topics.

   This can be either a global domain user impersonating a user in a subdomain or an admin user logged in to the subdomain.

2. The admin creates topics and publishes them to the instance.

3. MSP admin only: The admin can also activate either the ITSM, HR, or CSM plugin to enable base system topics for the subdomain.
4. All topics available to web clients and messaging applications must be published.

5. The admin assigns roles on a particular subdomain if using roles to control which topics can be run by users.

---

**Virtual Agent setup of messaging apps integration**

The domain-separated instance has one setup record for Slack, Microsoft Teams, and Workplace. 

**Roles required:** admin, ITIL, or virtual_agent_admin

1. Customers on the subdomain license either Slack, Microsoft Teams, or Facebook Workplace independent of the ServiceNow instance.

2. The admin user in the subdomain logs in and navigates to Collaboration > Virtual Agent > Messaging Apps Integration.

3. The admin runs the installation and sets the appropriate credentials to access the Virtual Agent bot from the third-party client.
Configure the Service Portal widget for Virtual Agent

Add the Virtual Agent Service Portal widget to a Service Portal page to enable your user to run Virtual Agent within your service portal.

Role required: sp_admin or admin

1. Navigate to Service Portal > Service Portal Configuration in the navigation bar to open the Service Portal configuration page.
2. Click Designer to open the Service Portal Designer.
4. Use the Filter Widget text box in the navigator to filter the widget list for the term Virtual Agent.
5. Click and drag this widget to the bottom of the page.

The widget itself appears empty, however, you should see a floating blue chat widget icon at the bottom right of the page.
6. Optional: Change the color of the Virtual Agent chat icon using the widget instance parameters.
   a) Click the pencil icon in the upper right corner of the Virtual Agent widget.
b) In the **Floating Button Color** parameter field, enter a new color for the button.

c) Click **Save**.

7. Optional: Set a default topic for Virtual Agent using the widget instance parameters.

a) Click the edit icon in the upper right corner of the Virtual Agent widget.

b) In the **Virtual Agent Client URL Parameters** field, enter the text `sysparm_topic=<sys_id>`. Replace `<sys_id>` with the `sys_id` of the topic you want to use as the default.

c) Click **Save**.

---

**Embed the Virtual Agent web client in an external web page**

You can load the Virtual Agent web client interface in an external web page by using an inline frame element (iframe).

Role required: admin

Before you embed the Virtual Agent web client, set two system properties that control how browsers render and secure the HTML content (Virtual Agent and Live Agent chat) in an iframe.

**Note:** Virtual Agent is not supported in the ServiceNow Content Management System (CMS) application.

1. Set the values for the system properties that identify the HTTP header directives for securing the iframe contents.

   a) In the Navigation filter, enter `sys_properties.list`.

   b) In the System Property (sys_properties) table, locate these HTTP header response properties and specify their values:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.glide.cs.embed.csp_frame_ancestors</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Sets the source value of the HTTP header directive: <code>Content-Security-Policy:frame-ancestors &lt;source&gt;</code></td>
</tr>
<tr>
<td></td>
<td>Specify the value, where <code>source</code> is:</td>
</tr>
<tr>
<td></td>
<td>• Type: string</td>
</tr>
<tr>
<td></td>
<td>• Value:</td>
</tr>
<tr>
<td></td>
<td>• <code>host-source</code>: Internet host site by name, IP address, or optional URL and/or port number. Site address can start with a wildcard (asterisk character).</td>
</tr>
<tr>
<td></td>
<td>Example value: <code>http://*.example.com</code></td>
</tr>
<tr>
<td></td>
<td>• <code>scheme-source</code>: A schema.</td>
</tr>
<tr>
<td></td>
<td>Example value: <code>http:</code> or <code>https:</code></td>
</tr>
<tr>
<td></td>
<td>• <code>self</code>: Default value. Indicates that the origin is the same as the page being served.</td>
</tr>
<tr>
<td></td>
<td>• <code>none</code>: No matching URLs.</td>
</tr>
<tr>
<td></td>
<td>• Learn more: For details on <code>source</code> values that you can specify, see <a href="#">CSP:frame-ancestors</a>.</td>
</tr>
</tbody>
</table>

**com.glide.cs.embed.xframe_options**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Sets the value of the X-Frame-Options header directive.</td>
</tr>
<tr>
<td></td>
<td>Specify the directive value:</td>
</tr>
<tr>
<td></td>
<td>• Type: String</td>
</tr>
<tr>
<td></td>
<td>• Value:</td>
</tr>
<tr>
<td></td>
<td>• <code>sameorigin</code>: Default value. Display the page in a frame that has the same origin as the page itself.</td>
</tr>
<tr>
<td></td>
<td>Example value: <code>allow from https://example.com</code></td>
</tr>
<tr>
<td></td>
<td>• <code>deny</code>: Do not display the page in a frame.</td>
</tr>
<tr>
<td></td>
<td>• <code>allow-from uri</code>: Display the page only in a frame on the specified origin.</td>
</tr>
<tr>
<td></td>
<td>• Learn more: For details on the directive values that you can specify, see <a href="#">X-Frame-Options</a>.</td>
</tr>
</tbody>
</table>

2. Create the iframe element and specify the following URL with your instance name to embed the Virtual Agent client in the iframe: `https://<instance-name>.service-now.com/sn_va_web_client_app_embed.do`

```html
<iframe id="sn_va_web_client" 
title="ServiceNow Virtual Agent Client" 
width="600" 
height="900" 
src="https://your-instance.servicenow.com/sn_va_web_client_app_embed.do">
</iframe>
```

**Note:** Use the `?sysparm_skip_load_history=true` parameter at the end of the URL to load the interface without the conversation history.
Virtual Agent integration with messaging applications

Enable users to run Virtual Agent bot conversations in third-party messaging applications. Use the ServiceNow Virtual Agent integration app to configure the messaging apps for your instance.

Admin and user setup

Integrating Virtual Agent with third-party messaging apps involves installation and setup tasks that admins and users perform.

Admin setup

Use the Virtual Agent integration app to configure the messaging apps for your instance. As an administrator for your ServiceNow instance and the third-party application (or working with the admin for the third-party messaging app), perform these basic installation steps to set up the Virtual Agent bot.

1. Install the ServiceNow Virtual Agent integration app and associate the app with your instance. For details, see Install Virtual Agent integrations.
2. If needed, configure the messaging text displayed in the third-party app.
   You can customize the text users see in Virtual Agent conversations by using the Adapter configuration page for third-party messaging apps.

User setup

After admins set up the Virtual Agent bot for Slack, Microsoft Teams, or Workplace, users link their ServiceNow user account to their Slack, Microsoft Teams, or Workplace account. For details, see Link your ServiceNow user account to a messaging application for Virtual Agent conversations.

Linking accounts enables users to run Virtual Agent topics that use ServiceNow information and records. If users do not link their ServiceNow account, they can access and run only topics that have the public role.

Conversational interface in messaging integrations

The Virtual Agent interface for third-party messaging apps is similar to the web-based interface. However, there are differences in how certain options and interface controls are displayed in third-party messaging apps:

Requesting a live agent or starting a new conversation

Users type the keyword #1 to access options for transferring to a live agent or beginning a new conversation.

Rendering of input controls and bot responses in conversations

Input controls in Virtual Agent Designer, such as the Date Time picker, Image picker, and Carousel render differently in bot conversations in messaging applications than in the web-based interface. For example, the Date Time picker control presents buttons for users to select a date and time. Similarly, certain bot response controls, such as the Image response and Multi-flow Output, also render differently in third-party messaging apps. For details on these
differences, see the descriptions of the Virtual Agent Designer input controls, bot responses, and utilities.

**Install Virtual Agent integrations**

As an administrator for ServiceNow, install the ServiceNow Virtual Agent integration application and associate the app with your instance.

*Install the Virtual Agent integration with Microsoft Teams*

Install the Virtual Agent integration for Microsoft Teams on your instance.

Note the following important issues before installing:

- Installing the Virtual Agent integration with Microsoft Teams creates a one-to-one association between the ServiceNow instance you are installing from and the Microsoft Teams tenant in which the integration runs. Use a separate Microsoft Teams tenant for each instance you plan to install the integration in. If you plan to test with a non-production instance and clone the instance, be sure to run the installation steps again on the clone target to associate the bot to the new instance. Running the steps again disassociates the integration between the original non-production instance and the tenant.
- The Virtual Agent integration does not support the Microsoft Teams freemium account, which allows user email accounts other than Microsoft Office 365 accounts.

Roles required:

- virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

1. Navigate to Collaboration > Messaging Apps Integration.
2. Next to Microsoft Teams, click Install.
3. In the pop-up message for confirming redirection to Microsoft Teams to verify your identity, click OK.

![Entering a third-party site](image)

4. Log in to Microsoft Teams.
5. In the Now Virtual Agent screen, click Accept to accept the permissions for the app.
6. If the selected workspace has already been assigned to Virtual Agent, you are asked whether you want to override the previous assignment. Click Override to change the workspace, or Cancel to leave the current assignment in place.

After authentication, installation starts in the background. After installation completes, a message appears confirming the installation.
7. Make this package available for your Microsoft Teams users.
   a) Click the **app package** link to access the ServiceNow knowledge base article **KB0690098**, containing the application package for Microsoft Teams.
b) Follow the steps in the article to make this package available for your Microsoft Teams users.

The workspace appears below the Microsoft Teams heading on the Integration page.

8. After you see this confirmation, check for installation verification.

Notify your users that the Virtual Agent bot for Microsoft Teams is available for use. Your users must then link their ServiceNow account to the Microsoft Teams account to access non-public Virtual Agent topics (that use ServiceNow records). For more details, see [Link your ServiceNow user account to a messaging application for Virtual Agent conversations](#).

Roles required:
- virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

Review these guidelines for using Virtual Agent with Slack or with Slack Enterprise Grid.

- Slack – Installing Virtual Agent with Slack creates a one-to-one association between the ServiceNow instance you are installing from and the Slack workspace in which the integration runs.
  - Use a separate Slack workspace for each instance you plan to install the integration in.
  - If you use a non-production instance for testing, use a different workspace.

- Slack Enterprise Grid – If you have Slack Enterprise Grid workspaces, your end users can move between workspaces and use the Virtual Agent bot from any workspace.
  - If you use a non-production instance for testing, use a workspace in a different grid or use a non-grid workspace.
  - After upgrading to the Madrid release:
    - Your end users must relink their ServiceNow accounts to the Virtual Agent messaging integration for Slack.
    - If you upgrade to Slack Enterprise Grid after upgrading to the Madrid release, an upgrade script runs automatically to complete the upgrade for the Slack messaging integration.

**Note:** If you clone an instance for non-production testing, be sure to run the installation steps again on the clone target. Follow the guidelines above for testing with non-production instances.

1. Navigate to **Collaboration > Messaging Apps Integration.**
2. Next to Slack, click **Install.**
3. A pop-up message appears to confirm redirection to Slack to verify your identity. In the pop-up message, click **OK**.

![Entering a third-party site](image)

4. Log in to your Slack workspace.

5. A confirmation message appears to confirm your identity on a workspace. Change the workspace if needed by selecting another workspace using the list in the upper right corner.

![On SN, Now Virtual Agent - Test would like to](image)

6. Click **Authorize** to authorize the installation.

7. If the selected workspace has already been assigned to Virtual Agent, you are asked to confirm whether you want to override the previous assignment. Click **Override** to change the workspace or **Cancel** to leave the current assignment in place.

A confirmation message appears confirming the installation after it completes.
8. After you see this confirmation, verify the installation. The Slack workspace appears below the Slack heading on the Integration page.

Notify your users that the Virtual Agent bot for Slack is available for use. Your users can then link their ServiceNow account to the Slack account to access non-public Virtual Agent topics (that use ServiceNow records). For more details, see Link your ServiceNow user account to a messaging application for Virtual Agent conversations.

Install the Virtual Agent integration with Workplace
Install the Virtual Agent integration for Workplace and associate the app with your instance.

Roles required:

- virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

1. Navigate to Collaboration > Messaging Apps Integration.
2. Next to Workplace by Facebook, click Install.
3. A pop-up message appears to confirm redirection to Workplace to verify your identity. Click OK.

4. On the login screen for Workplace, enter your login credentials. If you have multiple accounts for Workplace, a menu displays each of the accounts that you can log in to. Select the account in which you want to install the app.

5. Upon successful login, a window appears requiring your authorization to install the integration. Click Add to Workplace.
If the selected workspace has already been integrated with Workplace, click **Save** or **Cancel** to leave the current assignment in place. To override the current assignment, **uninstall the app** and then start again from Step 1.
6. A confirmation message appears confirming the installation once it completes. After you see this confirmation, verify the installation. The workspace name appears below the Workplace heading on the Integration page.
Notify your users that the Virtual Agent bot for Workplace is available for use. Your users must then link their ServiceNow account to the Workplace account to access non-public Virtual Agent topics (that use ServiceNow records). For more details, see [Link your ServiceNow user account to a messaging application for Virtual Agent conversations](#).

### Uninstall the Virtual Agent integration from Workplace

Uninstall the Virtual Agent integration for Workplace and disassociate the app with your instance.

### Roles required:

- Virtual_agent_admin and external_app_install_admin or admin
- Administrator for third-party applications

1. Log in to Facebook Workplace.
2. Click **Admin Panel** in the upper, right-hand corner.
3. Click **Integrations**.
4. In the list of Facebook Workplace integrations, click **Now Virtual Agent**.
5. A window appears displaying settings for Now Virtual Agent. In the bottom, left-hand corner of the window, click **Uninstall**.
6. Another window appears requiring authorization to uninstall the app. Click **Uninstall**.

**Now Virtual Agent** no longer appears on the list of integrations in Facebook Workplace. The instance receives uninstall information from Facebook, and the app configuration and user information is deleted in no more than 15 days.
**Configure Virtual Agent messaging for messaging apps**

Modify messages in the adapter configuration pages for third-party apps to customize the text users see in Virtual Agent conversations.

Role required: virtual_agent_admin or admin

1. Navigate to Collaboration > Virtual Agent > Messaging Apps Integration.
2. In the Slack, Microsoft Teams, or Workplace section, click the down arrow to show a list of installed teams.

3. Click the name of one of the teams to go to the configuration page. The Adapter Configurations list shows a list of keywords, labels, and messages and the default values for each.
4. Double-click an attribute value to change that value.

   **Note:** For Slack integrations only, you can change the bot name and avatar in the Adapter Configuration page. The maximum bot name length is 80 characters.

5. Press Enter or click the green check icon to save your changes.

**Link your ServiceNow user account to a messaging application for Virtual Agent conversations**

Link your ServiceNow account to a third-party messaging application to access non-public Virtual Agent topics that use ServiceNow records.

Role required: user

1. Open the messaging application.
2. Find your Virtual Agent bot.
3. Start a conversation with your Virtual Agent bot.
   The bot then presents a link to authenticate.
Example authentication message

4. Click **Link to ServiceNow** to authenticate.
   Authentication directs you to your instance. If you are not already logged in to your instance, you are prompted to enter your login credentials.

5. A confirmation message appears, prompting you to Confirm or Deny linkage between your accounts. Click Confirm to allow the account link.

6. After confirmation, you are directed to the instance user record.
   A confirmation message is displayed at the top of the screen.
Unlink your ServiceNow user account from a messaging application for Virtual Agent conversations

If needed, you can unlink your ServiceNow user account from a messaging app used for the Now Virtual Agent.

Role required: user

Unlinking your account from a selected messaging app such as Slack, Microsoft Teams, or Workplace, deactivates the association between your ServiceNow account and the messaging app. After you unlink your account, you can no longer engage in Virtual Agent conversations that query or change records in the ServiceNow database. Note that you can still run public Virtual Agent conversations.

1. Navigate to **Self-Service > My Profile**.
2. Click the **View Linked Accounts** related link.
3. In the Linked Accounts page, select the check box for the messaging integration to be unlinked.
4. Select **Actions on selected rows**, then click **Unlink account**.

The link between your ServiceNow account and the Virtual Agent messaging integration becomes inactive.

**Note:** Even though you unlinked your account, you can still run public Virtual Agent conversations. To link your account again, repeat steps 1 through 3 for the associated messaging integration and in the **Actions on selected rows...**, click **Link account**.

Configure Virtual Agent branding

Customize the Virtual Agent bot with your own company logo and avatar. Set the color schemes of the UI elements and customer support contact information displayed in the web-based conversational interface. The branding configuration does not apply to the third-party messaging integrations for Virtual Agent.

Role required: virtual_agent_admin or admin

To prepare for configuration of the conversational interface, gather the following information:

- Your company logo and avatar for your virtual agent bot. The images must be in .jpg, .png, .bmp, .gif, .jpeg, .ico, or .svg file format. The images can be high resolution, but the image display is scaled based on the aspect ratio.
- The brand color hex or RGB numbers for your company. Use them to configure the colors for UI items such as font colors and background colors for chat bubbles or buttons displayed.
Chatbot branding and UI elements

- Contact information for your support organization, such as support call hours, call center support phone number, and support email address.
Each color selection option provides a color picker to select a color. Use the text box beside the color picker to enter the value of the color as any of the following CSS formats:

- Name: predefined color names, such as red, green, blue
- RGB decimal: RGB(102, 153, 204)
- RGB hex: #223344

For more information, see *HTML Color Names (W3CSchools)*.

1. Navigate to **Collaboration > Branding Setup.**
2. Change the branding settings to customize the chatbot and chat interface.

**Chatbot configuration properties**

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logo in chat header</td>
<td>Click + next to the ServiceNow logo and upload your logo.</td>
</tr>
<tr>
<td>(com.glide.cs.branding.va_logo)</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Modify the bot avatar (com.glide.cs.branding.va_profile) | Click **bot user profile** to change the bot avatar. In the Live Profile form:  
  - To upload an avatar image, locate the **Photo** field, click **Update**, choose the image file and click **OK**. Enter a short description of the avatar in the Live Profile form and click **Update**.  
  - To delete an avatar, locate the **Photo** field and click **Delete**. |
| Virtual Agent Profile — Live Profile Reference (com.glide.cs.branding.va_profile) | Reference ID of the bot. Do not change this value. |
| Chat Header (com.glide.cs.branding.header_label) | Text string that identifies your company or organization in the chat window. For example: Acme Support. |
| Chat Header Background (glide.sycom.glide.cs.branding.header_bg_color) | Background color of the chat header. |
| Chat Header Font (com.glide.cs.branding.header_font_color) | Font color of text in the chat header. |
| Chat Background (com.glide.cs.branding.bg_color) | Background color of the chat window. |
| User Bubble Background (com.glide.cs.branding.bubble_bg_color) | Background color of the user chat bubble. |
| User Bubble Font (com.glide.cs.branding.bubble_font_color) | Font color of text in the user chat bubble. |
| Category Background (com.glide.cs.branding.category_bg_color) | Background color of the heading above a list of topics. |
| Category Font (com.glide.cs.branding.category_font_color) | Font color of text in the category heading. |
| Bot Bubble Background (com.glide.cs.branding.bubble_bg_color) | Background color of the bot chat bubble. |
| Bot Bubble Font (com.glide.cs.branding.bubble_font_color) | Font color of text in the bot chat bubble. |
| Agent Bubble Background (com.glide.cs.branding.agent_bubble_bg_color) | Background color of the live agent chat bubble. |
| Agent Bubble Font (com.glide.cs.branding.agent_bubble_font_color) | Font color of text in the live agent chat bubble. |
| Input Background (com.glide.cs.branding.input_header_color) | Background color of the user input bar. |
### ServiceNow Madrid Analytics, Intelligence, and Reporting

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button Background</td>
<td>Background color of buttons used in the conversation.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.button_bg_color" /></td>
<td></td>
</tr>
<tr>
<td>Link</td>
<td>Color of links presented in the conversation.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.link_color" /></td>
<td></td>
</tr>
<tr>
<td>Disabled Link</td>
<td>Color of disabled links presented in the conversation.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.disabled_link_color" /></td>
<td></td>
</tr>
<tr>
<td>Menu Icon</td>
<td>Color of the menu icon in the web client interface, which provides user options for options to end a conversation or contact customer support.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.menu_icon_color" /></td>
<td></td>
</tr>
<tr>
<td>Timestamp</td>
<td>Color of the timestamp displayed when significant activity occurs during a conversation, such as a record being created.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.timestamp_color" /></td>
<td></td>
</tr>
<tr>
<td>System Message</td>
<td>Color of general system messages displayed in the conversation. Define these system messages in <a href="#">General Settings</a> for Virtual Agent conversations.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.system_message_color" /></td>
<td></td>
</tr>
<tr>
<td>Load Animation</td>
<td>Color of the animated dots that indicate the system is processing information.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.load_animation_color" /></td>
<td></td>
</tr>
<tr>
<td>Separator</td>
<td>Color of the dashed line that separates each conversation in the Preview window.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.separator_color" /></td>
<td></td>
</tr>
</tbody>
</table>

3. Enter the contact information for your support center.

**Agent contact properties**

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call</td>
<td>Informative text string. For example, a text string that indicates when phone support is available: Call Support (Daily 5 AM to 11 PM) Leave this value blank to hide the call option.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.support_phone_label" /></td>
<td></td>
</tr>
<tr>
<td>Phone Number</td>
<td>The phone number of your call support organization. The phone number must be a valid number.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.support_phone" /></td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>Text string that indicates email support is available. For example: Send Email to Customer Support. Leave this value blank to hide the email support option.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.support_email_label" /></td>
<td></td>
</tr>
<tr>
<td>Email Address</td>
<td>The email address of your support organization.</td>
</tr>
<tr>
<td><img src="image" alt="com.glide.cs.branding.support_email" /></td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Chat (glide.com.glide.cs.branding.support_hours_label)</td>
<td>A text string that indicates the option to chat with a live agent is available. For example: Contact Live Agent. This message is limited to 75 characters. Leave this value blank to hide the chat support option.</td>
</tr>
</tbody>
</table>

4. **Click Save.**
The changes are applied immediately to the Virtual Agent web-based clients and also the Preview window in Virtual Agent Designer.

### Configure Virtual Agent conversation settings

Use the Virtual Agent general settings to define the basic characteristics of a bot conversation such as the welcome message and generic error message displayed.

Role required: virtual_agent_admin or admin

**Note:** If you are using the Virtual Agent messaging integrations, you can also customize messages shown in Slack, Microsoft Teams, or Workplace through the integration configuration pages. For details, see *Configure Virtual Agent messaging for messaging apps*.

1. **Navigate to Collaboration > Virtual Agent > General Settings.**
2. **Change any of the following bot conversation settings:**

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome message (com.glide.cs.general.welcome_message)</td>
<td>The text string for the default conversation greeting.</td>
</tr>
<tr>
<td>Top selection message (com.glide.cs.general.top_selection_message)</td>
<td>The text string that specifies the next selection that the user can make in the conversation.</td>
</tr>
<tr>
<td>Generic error message (com.glide.cs.general.error_message)</td>
<td>The text string displayed when an unrecoverable error occurs during a bot conversation.</td>
</tr>
<tr>
<td>Minimum delay before displaying typing animation (com.glide.cs.general.type_presence_delay)</td>
<td>The delay, in milliseconds (ms), that occurs before showing the animation ellipsis indicating the bot is processing user input.</td>
</tr>
<tr>
<td>Minimum delay between bot messages (com.glide.cs.general.msg_delay)</td>
<td>The minimum delay, in milliseconds (ms), that occurs between bot responses.</td>
</tr>
</tbody>
</table>

3. **Click Save.**

### Transferring Virtual Agent conversations to a live agent

Manage live chat support, including the chat support interface used when a Virtual Agent conversation is transferred to a live agent.
The Glide Virtual Agent plugin (com.glide.cs.chatbot) automatically activates the Glide Conversation Server plugin (com.glide.cs) for chat support.

**When bot conversations are transferred to a live agent**

Conversations in Virtual Agent are transferred to a live agent in several ways. This transfer happens automatically when an unrecoverable error occurs, but it can also be triggered via a script in a topic or when manually selected by the user.

**Automatic transfer to a live agent when an error occurs**

When a conversation encounters an error, the conversation automatically transfers to a live agent.

![An unrecoverable error has occurred.]

![Please stand by while I connect you to a live agent.]

![Routing you to a live agent...](image)

**Note:** If you do not intend to use Live Agent, be sure to disable live agent transfers. For details on chat setup for Virtual Agent, see [Configure live agent chat](#).

**Automatic transfer to a live agent triggered by a script in a topic**

In situations where you want a support agent to handle the conversation, you can create a script in your topic that uses the `vaSystem.connectToAgent()` command. This command triggers a transfer to a live agent. This option can be useful for conversations involving negative customer sentiment, high priority requests, or requests outside the scope of your topic process. For example:

```javascript
(function execute() {
    if (vaInputs.urgency == 1 && vaInputs.impact == 3)
        if(vaSystem.isLiveAgentAvailable()) {
            vaSystem.connectToAgent()
        }
})()
```

This script action control transfers the conversation to a live agent based on the incident impact and urgency indicated by the user. The script uses the `vaSystem.isLiveAgentAvailable()` method to verify that Live Agent is available.

**Manual transfer to a live agent using the Contact Support option**

Users can choose the Contact Support option to transfer to a live agent.
Note: Users running a Virtual Agent messaging integration must type the keyword **Hi** to access the live agent transfer option. For details, see [Virtual Agent integration with messaging applications](#).

Next, they select the Contact Live Agent option to transfer the conversation to the live agent.

**How bot conversation transfers work**

For a user engaged in a bot conversation, the switch to a live agent is a seamless transfer. When a transfer is triggered, either automatically or manually by the user, the conversation
is automatically routed to the appropriate chat support interface, based on your chat setup configuration. If you are using Agent Workspace, the conversation is automatically routed and assigned to a qualified agent. If you are using Connect Support, the conversation is routed to the appropriate chat support queue.

Transfer to live agent in Agent Workspace

If you are using Agent Workspace, the bot conversation is automatically assigned to the most qualified available agent, based on the Chat service channel configuration in Advanced Work Assignment.

Example of live agent transfer and agent interaction in Agent Workspace

For the user, the conversation with the agent continues in the Virtual Agent (client) interface. In Agent Workspace, the chat assignment appears in the agent’s inbox. When an agent accepts the assignment, the agent joins the conversation and interacts with the user.

Transfer to live agent in Connect Support

If you are using Connect Support, the bot conversation is routed to the appropriate chat support queue. For the user, the conversation with the agent continues in the Virtual Agent (client)
interface. In Connect Support, the agent accepts the queue with the transferred user to join the conversation and interact with the user.

Example of live agent transfer and agent interaction in Connect Support

In **Chat Setup**, admins assign the default chat queues (for Customer Service Management, HR Service Delivery, and IT Service Management) or a global queue to which Virtual Agent conversations are automatically routed if default queues are not assigned. These queues, which you define in Connect Support, are stored in the Chat Queues (chat_queue) table.

In Chat Setup, admins also define the general messages that users see during live agent transfers.

**Configure live agent chat**

Specify the chat interface used for live chat support and the general support messages displayed during a transfer from a bot conversation to a live agent.
Role required: admin or virtual_agent_admin

- If your chat interface is Connect Support, use the Chat Setup form to specify the chat queues used for live agent transfers. For details on defining the chat queues in Connect Support, see *Administer Connect Support queues*.

- If you are using Agent Workspace, live agent transfers are assigned automatically to the appropriate agents through the Chat service channel in Advanced Work Assignment. Use the Chat Setup form to specify Agent Workspace as the fulfiller UI for CSM or ITSM. You do not need to specify a queue in the CSM Queue or ITSM Queue fields.

Use the Context related list to specify the Live Agent variables that can be used in Virtual Agent topic scripts. Use Live Agent variables to pass certain information from the topic to share with the live agent or control how bot conversations are routed to live agents. For details on using Live Agent variables, see *Virtual Agent scripts*.

**Note:** All contexts are accessible via script, but only the queue context can be modified by a script.

1. Navigate to **Collaboration > Chat Setup**.
2. Complete the Chat Setup form.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The Live Agent setup configuration.</td>
</tr>
<tr>
<td>Live Chat Enabled</td>
<td>Check box indicating that live chat is activated. If you do not want live agent transfers, clear this box.</td>
</tr>
<tr>
<td>CSM Fulfiller UI</td>
<td>The chat support interface for CSM. The default is Connect Support.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>To use Agent Chat as the chat interface for CSM, select Agent Workspace.</td>
</tr>
<tr>
<td>CSM Queue</td>
<td>The Live Agent chat queue used for Customer Service Management if not specified through the chat interface or changed by a topic. If you are using Agent Workspace, you do not need to specify a CSM queue.</td>
</tr>
<tr>
<td>HR Fulfiller UI</td>
<td>The chat support interface for HR. The default is Connect Support.</td>
</tr>
<tr>
<td>HR Queue</td>
<td>The Live Agent chat queue to be used for Human Resources if not specified through the chat interface or changed by a topic.</td>
</tr>
<tr>
<td>ITSM Fulfiller UI</td>
<td>The chat support interface for ITSM. The default is Connect Support.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>To use Agent Chat as the chat interface for ITSM, select Agent Workspace.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ITSM Queue</td>
<td>The Live Agent chat support queue used for IT Service Management if not specified through the chat interface or specified by a topic. If you are using Agent Workspace, you do not need to specify an ITSM queue.</td>
</tr>
<tr>
<td>Global Fulfiller UI</td>
<td>The chat support interface for the platform. The default is Connect Support. Note: To use Agent Chat as the chat interface, select Agent Workspace.</td>
</tr>
<tr>
<td>Global Queue</td>
<td>The queue used if Virtual Agent does not have context to the queue through the chat interface or topic. If you are using Agent Workspace, you do not need to specify a global queue.</td>
</tr>
<tr>
<td>Transfer Message</td>
<td>The message that users see when they are transferred to a live agent or another queue. For example: “Please stand by while I connect you to a live agent.” Note: You can define only one transfer message, which is displayed for all the queues in your instance.</td>
</tr>
<tr>
<td>No Agents Available Message</td>
<td>Message that users see when a live agent is not available. For example: “No agents are available at the moment. Please try again later.” Note: You can define only one agent availability message, which is displayed for all the queues in your instance.</td>
</tr>
</tbody>
</table>

3. If you want to store GlideRecord attributes in a Virtual Agent topic, select the variables in the **Context** related list.
   
   You can use these variables to pass specific information from the conversation to a live agent.

4. Click **Update**.

**Disable Chat transfers from Virtual Agent**

Use chat settings to disable the ability to transfer from virtual agent to a live agent.

Role required: virtual_agent_admin or admin

1. Navigate to **Collaboration > Chat Setup**.
2. Clear the **Live Chat Enabled** check box.

   **Note:** Clearing this option hides the **Fulfiller UI** and **Queue** fields on the form.
3. Enter a value in the No Agents Available Message.
Users who experience an error or exception while using Virtual Agent will be shown this message rather than automatically being transferred to a live agent.

4. Click Update to save your changes.

The Contact Support option in the Virtual Agent menu will show as disabled.

Note: Scripted transfers to a live agent using the vaSystem.connectToAgent() method will also be disabled. To prevent an error, always use vaSystem.isLiveAgentAvailable() in your scripts to ensure that a live agent is available before transferring.

Virtual Agent Designer

The Virtual Agent Designer is a graphical tool for creating and managing topics, which are blueprints for conversations between a virtual agent and user. You can design topics that help your users resolve common work issues or guide them through self-service tasks.

Supported browsers for Virtual Agent Designer

Use Virtual Agent Designer on modern browsers such as Chrome or Edge. Virtual Agent Designer is not supported on Safari and older versions of Internet Explorer (such as IE11) browsers.

Developing topics

Topic development by an admin or virtual_agent_admin involves these basic steps:

Identify the use case for an automated conversation

Determine the users of your topic and the use case or goal, for example solving a user problem or assisting with a self-service task.

As you gather key requirements for your topic, identify the information that you need from the user to complete the goal.

Determine the general structure of the conversation

Identify the conversation "happy" path, and the alternate paths where the conversation might branch depending on the information supplied by the user. Consider how to handle each branch and whether users loop back to an earlier point in the conversation.

Build the topic using Virtual Agent Designer

Follow these steps:

1. Define the topic properties.
Name the topic and set the keywords for triggering the conversation. You can also specify a condition for running the topic and the roles of users who can run that topic.

2. Build the conversation flow.
Use the palette of user inputs, bot responses, and utilities to create the conversation flow.

3. Preview the topic as you build it.
Use the Preview feature to run the topic in its current state.

4. Publish the topic.
Publishing the topic automatically activates the topic and deploys it to the Virtual Agent client.

Managing topics

Use the Topics page to manage your topics. You can search, sort, create, and run active topics through this page. The Topics page lists the active (published) and inactive topics (in development) in your instance.

- **Run Active Topics** — Opens a window for running topics in the Virtual Agent web client. Use this feature to test your keywords and verify that your published topics work as intended.
- **Add a Topic** — Opens the Topic Properties page to start the topic creation process and define the topic-level properties. For details, see [Create a Virtual Agent topic](#).
Defining topic properties

Topic properties identify a topic and how it is accessed, including who can use the topic and any conditions that affect when it is run. These properties include:

**Keywords**
Keywords are words or phrases that users enter to trigger a particular conversation in the client interface.

**Condition**
A JavaScript script that defines the condition for running the topic. The script returns a value of true or false. A returned value of false means that the topic does not appear in the client. If the return value is false, the control is not used.

**Roles**
The roles of users required to run the topic. Assigning the public role to a topic makes the topic a public topic. Public topics are accessible to unauthenticated users, such as guest users.

**Live Agent variables**
Live Agent variables that are available to the topic. The selected variables are accessible to scripts within the topic to provide dynamic information when transferring a virtual agent conversation to a live agent.
Building topics with the Virtual Agent Designer page

Use the Virtual Agent Designer page to build a topic flow using the controls for user inputs, bot responses, and utilities.

1. **Palette region**
   List of controls that you can drag onto the canvas to build a conversation:
   
   **User Input**
   Controls used to prompt and capture information from the user in a conversation.

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Bot Response**
Controls for displaying bot responses in a conversation.

**Utilities**
Controls for performing actions within a topic, such as running a script or adding different conversation paths (branches) in a topic.

**2. Canvas**
Area that graphically displays the conversation flow. As you drag a control onto the canvas, that control becomes a node in the conversation flow. Includes an associated property sheet that opens in the right pane. Each flow has a Start and End node. The layout of controls on the canvas is organized automatically as controls are added and removed.

**3. Property sheet**
Properties specific to the selected node on the canvas. Each node has its own set of properties that you can define, which can include scripts that control the behavior or processing performed in the node.

**4. Data pill picker**
A picker is used to select data pills from input variables or script variables to use in the property field. Click the data pill picker to select from the existing variables accessible in the topic. Data pills can also be dragged directly into property fields.

**5. Script editor**
A tool for adding or editing JavaScript scripts used in a property. Provides scripting assistance, including a list of valid elements at the insertion point, such as function name, object names, and variable names available for the topic. For more information, see the Syntax editor.

**6. Script variables**
Section for declaring variables used within the topic (conversation session) to store values outside the control variables, to help with more complex scripting scenarios. Includes a switch that enables the use of Live Agent variables to provide information from the virtual agent session to the live agent.

**Virtual Agent controls**
A Virtual Agent topic consists of a collection of controls within a topic flow. Use these controls to collect, process, and present information to your users. Controls can also read, create, and update records on your instance.

**Note:** For controls that have prompts, messages, default values, or confirmation messages, you can enter any of the following input values:
- Text strings
- Data pills
- Strings with embedded data pills
- Scripts that return strings

Controls are separated into categories based on their use.
Control types

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bot Response</td>
<td>Bot responses provide controls for displaying bot responses in a conversation.</td>
</tr>
<tr>
<td>Start Segment</td>
<td>This control appears automatically in a topic flow and cannot be added to or removed from a conversation. It can be configured with a greeting response that appears when a conversation begins.</td>
</tr>
<tr>
<td>End Segment</td>
<td>This control appears automatically in a topic flow and cannot be added to or removed from a conversation. It can be configured with a final confirmation message before the end of a conversation. Ensure that all branches of your topic eventually connect to this control</td>
</tr>
<tr>
<td>User Input</td>
<td>User inputs provide controls that prompt and capture information from the user in a conversation.</td>
</tr>
<tr>
<td>Utilities</td>
<td>Utilities provide controls that control actions and logic within a topic, such as running a script or adding different conversation paths (branches) in a topic.</td>
</tr>
</tbody>
</table>

Data pills

Use data pills to quickly and easily add dynamic information to your controls without using script.

Click the data pill button ( рядом с Бот) to open the data pill picker interface. In this interface you can select data from script variables, and input variables set by your User Input controls.
Data pill and scripted responses

<table>
<thead>
<tr>
<th>Method</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data pill</td>
<td></td>
</tr>
</tbody>
</table>
This example uses a text bot response which includes the name of the customer, handled both as a data pill and a script. The data pill example uses the data pill selector to choose **Get Name**, an input variable that contains the name of the customer. The second example accomplishes the same thing using a script. The script example also uses `gs.getMessage` to handle translating the message. Using data pills allows you to quickly access and easily access the data in your variables, while scripting allows for more complex options, like handling translation.

### Condition property

All controls, except the Decision utility and the Start and End nodes, have a condition property. Use this property to determine whether that control is used in a conversation. To always use the control, leave the condition field blank. To determine conditions under which the control is used, provide a script for the condition property that returns a value of true or false. If the return value is false, the control is not used and the conversation will continue to the next control along that branch of the topic. You can also create a condition using the condition builder interface. Data pills can be added to conditions built using this interface. Use conditions to make your conversations more dynamic based on context, data, or scripted logic.
In this example, a condition script returns a value of true if the current user is able to create incident records. This condition prevents a utilities control from creating an incident when the user does not have permission to do so.

**Designing a Virtual Agent topic**

Walk through the design of an example Virtual Agent topic that enables users to view incidents they submitted. The example highlights various design controls that can be used to build the conversation flow.

**Plan the structure of a conversation**

The first step in implementing a Virtual Agent topic is to decide what the topic covers. Consider the intended audience and what you want the audience to accomplish when using the conversation. For this example, the goal of this example topic is to create a flow that enables end users to see the status of incidents they submitted. The topic includes an option for the user to add a comment to the incident.

With this goal in mind, the topic needs the following elements:

- A prompt for the user to select an incident
- An output showing the status of the incident
- A prompt to ask if the user wants to leave a comment
- A utility control to branch the conversation on that answer
- A prompt for the user to enter a comment
- A utility control to add the user input as a comment in the incident

**Build the conversation flow with Virtual Agent controls**

The conversation will look similar to the following dialogue flow.
your topic frequently. Make sure to consider both functionality and user experience in your testing.
Configure controls within the conversation

This example begins with defining the conversation flow in Virtual Agent Designer, after the topic properties have been set. The conversation begins with a Start node and finishes with an End node.

1. In Virtual Agent Designer, add a Reference Choice control to the conversation flow. This control is used to select the incident.
   a. Enter Choose an incident for the Name property. The variable name choose_an_incident is automatically generated for the control.
   b. In the Prompt property, enter the text the user sees before selecting an incident.
   c. Leave the Default Value property blank.
   d. In the Reference Type property, select Record.
   e. In the Table property, select incident.
   f. In the Choice Value Expression property, select the Condition Builder option, and create a condition as shown in this screen shot:
2. Add a **Card** control to the flow. This control shows information from the record selected by the **Reference Choice** in the previous step.
   a. Enter **Status Card** for the **Name** property.
   b. In the **Reference Type** property, select **Record**.
   c. In the **Record** property, select **Choose an Incident**. This choice refers to the Reference Choice control created in the previous step, so the data displayed comes from the record chosen there.
   d. In the **Fields** control, select a field. The choices available are the available fields on the chosen record. In this case, you can see the fields on the incident table.
   e. After a field has been selected, click the Add Field option to add additional fields to the card. To delete fields from the card, click the delete icon to the right of the field.

3. Add a **Boolean** control to the flow. This control is used to prompt the customer with a yes/no question. In this case, the control checks whether the user wants to leave a comment on the selected incident record.
a. Enter Leave Comment? for the Name property. The variable name `leave_comment_` is automatically generated for the control.

b. In the Prompt property, enter the text the user sees before the prompt. In this case, ask users whether they want to leave a comment on the incident.

c. Optionally, you can enter a value in the Acknowledge Message property. This value appears after the user chooses yes or no.

4. Add a Decision control to the flow. This control branches the conversation into two possible paths. The path the conversation follows depends on the choice the user made in the previous step.

a. There are no properties on the decision control; however, there are properties on the branches below the decision. By default, there is a single branch labeled Always. Click the blue plus icon at the bottom of the decision control. A second branch appears labeled Never.

b. Click the Always branch of the decision to access the properties for this branch.

c. Change the name to Leave Comment.

d. In the condition property, select the Condition option and click the Add Condition button. Use the condition builder to create a condition as shown in this screen shot.

If the value of the Leave Comment? is true, this condition is met. This variable is the variable from the Boolean control in the previous step. If the user chose Yes at that prompt, the conversation follows this branch.

e. Click the Never branch of the decision to access the properties for this branch.

f. Change the name to No Comment.

g. In the condition property, select the Condition option and click the Add Condition button. Use the condition builder to create a condition as shown in this screen shot.
If the value of the Leave Comment? is false, this condition is met. This variable is the variable from the Boolean control in the previous step. If the user chose No at that prompt, the conversation follows this branch.

h. One of the two branches you have created points to the End node of the conversation. The second branch should also lead to this node. Click the arrow at the bottom of that branch and drag it to the End node.

5. Add a Text Input control to the Leave Comment branch of the conversation. This control is used to request text input from the user.
   a. Enter Get Comment for the Name property. The variable name get_comment is automatically generated for the control.
   b. In the Prompt property, enter the text the user sees before the prompt. In this case, ask the user for the text of the comment.
   c. Optionally, you can enter a value in the Acknowledge Message property. This value appears after the user enters a comment.

6. Add an Action control to the conversation below the Get Comment control. This control is used to add the text entered into the previous control as a comment on the selected incident.
   a. Enter Update Incident for the Name property.
   b. In the Action Type property, select Update a Record.
   c. In the Record property, select Choose an Incident. This choice refers to the Reference Choice control created in the previous step, so the record chosen there is the one that this Action control updates.
   d. In the Field property, click Add Field. You can select and give values to fields from this record in the a pop-up window that appears.
e. Select the Additional Comments field from the list.

f. Click the (.DOUBLE_QUOTE button to the right of the field to select a value from one of the controls in this conversation.

g. Click the Get Comment option from the list. This option refers to the value entered by the user in the Text Input control from the previous steps.

h. Click the Save button at the bottom of the pop-up window.

Test the conversation

Use the Preview button to test the flow of the conversation. Preview topics often throughout the design process to find errors or unexpected behavior quickly. For further information on identifying and resolving issues with topics, see Debug a Virtual Agent topic.

Create a Virtual Agent topic

Use Virtual Agent Designer to create and modify chatbot topics (conversations). Build your topic to meet a specific objective or goal, such as fulfilling a user’s request or helping a user complete a task.

Role required: virtual_agent_admin or admin

To create a topic, you should have a basic knowledge of the ServiceNow platform and application table structures, scripting (JavaScript), HTML, and REST integrations.

Define the flow of user inputs, bot responses, and actions performed in a chatbot conversation. The main steps in topic creation are:

1. Define the topic-level properties.
2. Build the topic flow with user inputs, bot responses, and utilities. For each control, specify the properties that determine how the control functions in the conversation. Save the topic frequently as you build the flow.

3. Preview and test the topic as you build it.

4. Save the topic flow.

**Note:** When you create a topic, the topic is in the inactive state until you publish it. Publishing a topic changes the topic state to Active and automatically deploys the topic to your Virtual Agent clients.

1. Navigate to **Collaboration > Virtual Agent > Designer**, and in the Topics page, click **+ Add a topic**.

2. In the Topic properties page, enter the topic properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the topic that reflects its business purpose.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the topic.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of key phrases or terms that users enter to initiate the conversation with the chatbot. Press Enter after each phrase.</td>
</tr>
<tr>
<td>Condition</td>
<td>Expression logic that uses one or more conditions to control who sees a topic in the Virtual Agent client. If left blank, the expression is true.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles that an end user must have to view and run the topic. If a topic is public (available to users, including guest users, who are not authenticated in ServiceNow), select only the Public role.</td>
</tr>
<tr>
<td>Live Agent variables</td>
<td>The Live Agent variables defined in Live Agent setup. Select the variables that provide dynamic context (information from the Virtual Agent chat) transferred from the topic to a live agent.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Edit Topic flow**.

The Virtual Agent Designer page opens.

5. To add a user input, bot response, or utility:
   a) Drag the input, bot response, or utility control from the Designer palette and drop it in the canvas. The item becomes a node in the conversation flow.
   b) Complete the properties for the node. For details on each control and the corresponding properties that you define, see **User inputs**, **Bot responses**, and **Utilities**.
   c) Click **Save**.
   d) To see how the topic runs in the Preview window, click **Preview**.

To see details on how each node in the flow is processed, click **Show Log** in the Preview window. For more information on using the Preview logs, see **Debug a Virtual Agent topic**.
e) Repeat adding the various controls, previewing, and saving until the conversation flow is complete.

To move a node, click the node and then drag it to the new location and click **Save**.

6. To delete a user input, bot response, or utility:
   a) Click the X in the upper right corner of the node.
   b) Confirm that you want to delete the node.
   c) Click **Save**.

**Note:** You cannot delete a node that has a script variable used by subsequent JavaScript expressions in the flow. Also, a decision node can be deleted only when it has a single leaf branch.

**Publish** the topic to deploy it to your Virtual Agent clients.

**Publish a Virtual Agent topic**

Deploy an inactive topic to the Virtual Agent client.

Role required: virtual_agent_admin or admin

1. Navigate to **Collaboration > Designer**.
2. In the Topics page, select the inactive topic to be published.
3. In the Topic Properties page for the topic, click **Publish**.
   The topic state changes to Active.
4. Verify that your keywords for the topic work as expected.
   a) Return to the Topics page and click **Run Active Topics**.
   b) In the conversation window, test each topic keyword to verify that the corresponding conversation opens.
   For example, in the predefined Virtual Agent topics, the bot returns a list of topics that might match the keyword entered.

**Duplicate a Virtual Agent topic**

To easily create a new topic, you can copy an existing Virtual Agent topic and customize it.

Role required: virtual_agent_admin or admin

Consider duplicating topics:
- To use an existing topic, such as a predefined topic, as the basis for a new topic.
- When you want to modify an active topic but also preserve the original topic for reference purposes or as a backup.

1. Navigate to **Collaboration > Virtual Agent > Designer**, and in the Topics page, click the topic to be copied.
2. In the Topic Properties page, change the topic properties as needed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the new topic.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the topic.</td>
</tr>
<tr>
<td>Keywords</td>
<td>A list of key phrases or terms that users enter to initiate the conversation with the chatbot.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that defines the conditions that must be met for running this topic. The regular expression must evaluate to true.</td>
</tr>
<tr>
<td>Roles</td>
<td>The roles that an end user must have to view and run the topic. Select from the available roles in the Roles list.</td>
</tr>
<tr>
<td>Live Agent variables</td>
<td>The Live Agent variables defined in Live Agent setup. Select the variables that provide dynamic context (information from the Virtual Agent chat) transferred to a live agent.</td>
</tr>
</tbody>
</table>

3. Click **Save**.

4. Click **Edit Topic flow**.

   The Virtual Agent Designer canvas is displayed.

5. To add a user input, bot response, or utility:
   a) Complete the properties for the node. For details on each control and the corresponding properties that you define, see User inputs, Bot responses, and Utilities.
   b) Click **Save**.
   c) To review the topic in the Preview window, click Preview.

6. To delete a user input, bot response, or utility:
   a) Click the X in the upper right corner of the node.
   b) Confirm that you want to delete the node.
   c) Click **Save**.

   **Note:** You cannot delete a node that has a variable used by subsequent JavaScript expressions in the flow. A decision node can be deleted only when it has a single leaf branch.

Publish the topic to deploy it to your Virtual Agent clients.

**Delete a Virtual Agent topic**

Delete a Virtual Agent topic that is no longer needed.
Role required: virtual_agent_admin

If you want to remove a topic from your Virtual Agent clients but do not want to delete it, consider making the topic inactive instead.

1. If you are not already displaying the Topics page, navigate to Collaboration > Virtual Agent > Designer to display it.
2. Select the topic and in the Topic Property page, click Delete.

The topic is immediately removed from Virtual Agent clients and is no longer listed on the Topics page.

Debug a Virtual Agent topic

Use the following information to investigate and resolve unexpected behavior in your custom Virtual Agent topics.

Duplicate topics when possible

Make changes in the duplicate of a topic rather than updating a live topic. The unmodified original topic can serve as both a reference and a backup, and retaining the original enables you to quickly restore the topic. Remember to deactivate the original topic before publishing the duplicate.

Preview your conversations often

As you create or update your topic, use the Preview button to test a conversation. The preview pop-up window shows the conversation as it appears within Service Portal. Elements in your conversation might appear differently in third-party messaging applications. Test your conversations in any third-party applications where you intend to deploy Virtual Agent.
Use the conversation preview logs to view errors and messages logged while previewing a topic. The following steps describe how to access the conversation preview logs. Use `gs.log`, `gs.print`, and `gs.warn` statements in your scripts to output information in this log.

1. In Virtual Agent Designer, click **Preview** to begin previewing a topic.
2. In the topic preview window, select the **Show Logs** check box.

**Note:** Information is not recorded in the logs until after the **Show Logs** check box is selected. Therefore, select this option immediately after the topic preview loads to ensure that all logging information is available.
Watch for warnings on controls within your topic

Controls that are missing necessary information show a red icon in the upper left corner of the control. The icon shows a number indicating the number of issues in that control. Point to this icon to see a list of the issues in the control.

Another icon appears in the upper left corner of the designer to indicate the number of issues within the entire topic.

Check for errors when a topic preview does not run
Additional information appears under the Virtual Agent Designer canvas when an error prevents the topic from running. Use the information provided to correct any errors in your conversation.

**Common Virtual Agent issues**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Possible resolution</th>
</tr>
</thead>
</table>
| Cannot see module designer under collaboration  | · User might not have the virtual_agent_admin role.  
|                                                 | · Virtual Agent plugin might not be activated.         |
| Cannot edit a topic                             | Logged-in user must be in the same application scope as the topic. |
| Cannot preview topic                            | · Make sure all required fields are filled in on the node properties.  
|                                                 | · Ensure that your browser is configured to permit pop-ups from your instance. |
| Web client stuck at Connecting...               | One or more of your topics might be missing. Check the Topics page to ensure that topics are present on the instance and in the Active state. |

**Virtual Agent Designer user input controls**

Use the collection of input controls provided by Virtual Agent Designer to prompt and capture information from the user in a conversation.

**Common input properties**

Each input control has the following common properties:

**Variable for the user response**

Each control stores the user response in a variable that is accessible from other controls within the same topic using the `getValue()` and `getDisplayValue()` methods. The variable name is based on the name that you assign to the input control. For example, if you assign the name `First prompt` to an input control, the variable name is `first_prompt` (lowercase, with an underscore character instead of a space). For more information on these methods, see Virtual Agent scripts.

**Default value**

An input prompt can have a preset value that you define. This value can be either a string or a script that returns a string.

**Confirmation message**

If your input control provides users with a single-choice or default value selection, the selection that the user makes is automatically displayed in the conversation. For example, if you present a Boolean prompt, the user’s selection (either yes or no) is automatically displayed. This message can be either a text string or a script that returns a text string.

**Condition**

You can determine whether a control is used by defining an expression that evaluates to true or false. Use either the no-code condition builder or a low-code script that contains a condition.
statement. If the condition evaluates to true, the control is used. For example, you can specify a condition that enables only certain users to see a particular input prompt while hiding the prompt from other users. If no script is used in the condition, the condition always evaluates to true and the control is always used.

**Text user input control**

The Text user input control in a Virtual Agent topic prompts the user for a text string.
**Example Text user input control**

<table>
<thead>
<tr>
<th>Response properties</th>
<th>Input prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td><img src="https://via.placeholder.com/150" alt="User Input Properties UI" /></td>
</tr>
<tr>
<td><strong>String Basic Info</strong></td>
<td><img src="https://via.placeholder.com/150" alt="String Basic Info UI" /></td>
</tr>
<tr>
<td>* Name</td>
<td>Text Input</td>
</tr>
<tr>
<td>* Variable Name</td>
<td>text_input</td>
</tr>
<tr>
<td>* Prompt</td>
<td>Enter Some Text</td>
</tr>
<tr>
<td><strong>Acknowledge Message</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Acknowledge Message UI" /></td>
</tr>
<tr>
<td>Thank you!</td>
<td><img src="https://via.placeholder.com/150" alt="Thank you!" /></td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Default Value" /></td>
</tr>
<tr>
<td><strong>Confirmation Message</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Confirmation Message" /></td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td><img src="https://via.placeholder.com/150" alt="Condition" /></td>
</tr>
</tbody>
</table>
## Text user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Text user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>The name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>The predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>The message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Condition</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this prompt in the conversation. The condition must evaluate to true.</td>
</tr>
</tbody>
</table>

**Note:** Slack users can edit text previously entered in a conversation. However, because Virtual Agent processes messages as they are first entered, if a Slack user edits text input, such as a comment to update a case, Virtual Agent does not evaluate the edited update.

### Static Choice user input control

Use the Static Choice user input control in a Virtual Agent topic to list predefined choices available to the user. A user can select only one item from a choice list.
### Example Static Choice user input control

<table>
<thead>
<tr>
<th>Input properties</th>
<th>List prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong> 🔄</td>
<td>Test Choice</td>
</tr>
<tr>
<td><strong>Variable Name</strong> 🔄</td>
<td>test_choice</td>
</tr>
<tr>
<td><strong>Prompt</strong> 🔄</td>
<td>Choose an option</td>
</tr>
<tr>
<td><strong>Acknowledge Message</strong> 🔄</td>
<td>Thank you for choosing</td>
</tr>
<tr>
<td><strong>Default Value</strong> 🔄</td>
<td></td>
</tr>
<tr>
<td><strong>Confirmation Message</strong> 🔄</td>
<td></td>
</tr>
<tr>
<td><strong>Condition</strong> 🔄</td>
<td>Condition</td>
</tr>
<tr>
<td><strong>Add Condition</strong></td>
<td></td>
</tr>
<tr>
<td><strong>List prompt</strong></td>
<td>OK, what's the urgency of your issue?</td>
</tr>
</tbody>
</table>
Static Choice user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Static Choice user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable name</td>
<td>The name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default value</td>
<td>The predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>The message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Condition</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this prompt in the conversation. The condition must evaluate to true.</td>
</tr>
<tr>
<td>Choice List Setting</td>
<td>For each choice, enter a Label and a Value. The Label is the text that appears to the user for that choice. The Value is a string that is stored in the variable when that choice is selected. Use short phrases in your choice lists. - Slack has a limit of 30 characters for choice list labels. - Workplace has a limit of 20 characters for choice list labels.</td>
</tr>
</tbody>
</table>

Reference Choice user input control

Use the Reference Choice user input control in a Virtual Agent topic to dynamically create a list of available choices for your users. Create these choices by querying a table or by using a script to dynamically create them.
Example Reference Choice user input

<table>
<thead>
<tr>
<th>Input properties</th>
<th>List prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reference Choice List Basic Info</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>INC0010082: Image processing software not working</td>
</tr>
<tr>
<td></td>
<td>INC0010076: Mobile login didn't work</td>
</tr>
<tr>
<td></td>
<td>INC0010077: Forgot my password</td>
</tr>
<tr>
<td></td>
<td>INC0010080: I got email spams</td>
</tr>
<tr>
<td></td>
<td>INC0010067: network is very slow</td>
</tr>
<tr>
<td><strong>Variable Name</strong></td>
<td>pick_an_incident</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>Please select an incident:</td>
</tr>
<tr>
<td><strong>Acknowledge Message</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Confirmation Message</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Add Condition</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Choice List Setting</strong></td>
<td>When defining your enumeration list in javascript ensure that you assign keys of Name and Value.</td>
</tr>
<tr>
<td><strong>Reference Type</strong></td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
### Reference Choice user input control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name that identifies this Reference Choice user control node in the topic flow.</td>
</tr>
<tr>
<td><strong>Variable Name</strong></td>
<td>The name of the variable that stores the user response to this prompt. The variable name is automatically created from the <strong>Name</strong> property.</td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td>The prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td><strong>Acknowledge Message</strong></td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td>The predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td><strong>Confirmation Message</strong></td>
<td>The message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this prompt in the conversation. The condition must evaluate to true.</td>
</tr>
<tr>
<td><strong>Choice List Setting</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reference Type</strong></td>
<td>The type of reference variable to be used. Select one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Record — Returns records from the table selected. The values for these options are GlideRecord objects.</td>
</tr>
<tr>
<td></td>
<td>• Script — The expression that returns an array of options.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>If you selected Record as the <strong>Reference Type</strong>, select the table to be searched.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Choice Value Expression</td>
<td>Select either Condition Builder or Script. Select Condition Builder to create a filter used to select a subset of records from the table. Select Script to enter a script that defines the enumeration list for the options (choice list) to be displayed. The name value pair is stored as a string object.</td>
</tr>
<tr>
<td>No records response message</td>
<td>The message displayed to the user when the table search does not return any records. The message can be either a text string or a script that returns text.</td>
</tr>
</tbody>
</table>

**Example Reference Choice list value expression**

```javascript
(function execute(table) {
    var options = [];
    var gr = new GlideRecord(table);
    gr.addEncodedQuery('active=true');
    gr.setLimit(10);
    gr.query();
    while(gr.next()) {
        options.push({ 'value': gr.getUniqueValue(), 'label': gr.getValue('short_description') });
    }
    return options;
})(table)
```

The script in the Choice Value Expression property defines and returns an array of choices. In the example, the script creates an array called `options`, and adds each record found in a GlideRecord query to this array. Each element in the array is given a value in the `value` and `label` keys using data from that GlideRecord. The Table property of the control defines the table used by the script. This example script uses `gr.setLimit(10)` to limit the number of records returned to 10. Using this method prevents returned records from creating an overly large choice list.

**Reference Choice control Value Expression keys**

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>value</td>
<td>The value for the choice. When a user selects a choice from the control, this value is stored in the variable named in the Variable name property.</td>
</tr>
<tr>
<td>label</td>
<td>The label that appears for this choice in the choice list.</td>
</tr>
</tbody>
</table>

**Boolean user input control**

Use the Boolean user input control in a Virtual Agent topic to present a Yes/No prompt to the user.
### Example Boolean user input control

<table>
<thead>
<tr>
<th>Input properties</th>
<th>Input prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Boolean Basic Info</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td></td>
</tr>
<tr>
<td>Boolean Test</td>
<td></td>
</tr>
<tr>
<td><strong>Variable Name</strong></td>
<td></td>
</tr>
<tr>
<td>boolean_test</td>
<td></td>
</tr>
<tr>
<td><strong>Prompt</strong></td>
<td></td>
</tr>
<tr>
<td>Choose a response</td>
<td></td>
</tr>
<tr>
<td><strong>Acknowledge Message</strong></td>
<td></td>
</tr>
<tr>
<td>Thank you</td>
<td></td>
</tr>
<tr>
<td><strong>Default Value</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Confirmation Message</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Condition</strong></td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved. ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Boolean user input control properties**

Boolean user input controls prompt the user to answer a Yes/No question, and store the response as a string with a value of true or false. Use this value in topic utilities, such as the Decision utility, to branch the topic flow based on the answer.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Boolean user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable name</td>
<td>The variable that stores the choice selected by the user. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>The predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>The message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Condition</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this prompt in the conversation. The condition must evaluate to true.</td>
</tr>
</tbody>
</table>

**Date Time user input control**

Use the Date Time user input control in a Virtual Agent topic to enable the user to select a calendar date, time (hours and minutes), or both.
Example Date Time user input control

<table>
<thead>
<tr>
<th>Input properties</th>
<th>Date Time prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td><strong>When do you need this done by?</strong></td>
</tr>
<tr>
<td><strong>Date Time Basic Info</strong></td>
<td>Yearly View</td>
</tr>
<tr>
<td>* Name</td>
<td>When Done</td>
</tr>
<tr>
<td>* Variable Name</td>
<td>when_done</td>
</tr>
<tr>
<td>* Prompt</td>
<td>When do you need this done by?</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td></td>
</tr>
<tr>
<td>Default Value</td>
<td></td>
</tr>
<tr>
<td>Confirmation Message</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>Condition</td>
</tr>
<tr>
<td>Format</td>
<td>virtualagent APP 12:43 PM When do you need this done by?</td>
</tr>
</tbody>
</table>
### Input properties

<table>
<thead>
<tr>
<th>Date Time prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which pay date is this about?</td>
</tr>
<tr>
<td>To confirm, click Submit. You can also enter the date in the format of MM/DD/YYYY.</td>
</tr>
<tr>
<td>Microsoft Teams Date Time prompt</td>
</tr>
<tr>
<td>Please verify the date/time. To confirm or change, click any field. You can also enter the date/time in the format of MM/DD/YYYY.</td>
</tr>
<tr>
<td>Workplace Date Time prompt</td>
</tr>
</tbody>
</table>

### Date and time selection for the Slack and Workplace interfaces

The Slack and Workplace interfaces do not natively support a date selection widget. Date and time selection is instead done with the buttons that are supported in these interfaces.
The Date Time user input control prompts the user for a date, showing the current date and time. The user clicks the month, day, year, or time button to modify that value. The time and day fields prompt the user to type in a new value. The month and year fields show a set of buttons with the current and upcoming months or years. Select one of these buttons or type in a value to set the time or year.

<table>
<thead>
<tr>
<th>Date Time property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Date Time user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable name</td>
<td>The name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt or question to the user. The prompt can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>The predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>The message that verifies the default or single-choice selection made by the user. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td><strong>Date Time property</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Condition</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this prompt in the conversation. The condition must evaluate to true.</td>
</tr>
</tbody>
</table>
| Format                 | The type of Date Time user input control to be displayed. Select one of the following formats:  
  - **DateTime** — Shows both a monthly calendar and time picker.  
  - **Time** — Shows only the time picker for the user to select the time (hours and minutes). |

**Image picker user input control**

Use the Image picker user input control in a Virtual Agent topic to prompt a user to upload an image. After the user uploads the image file, the image appears immediately in the Virtual Agent client.
Example Image picker user input control

<table>
<thead>
<tr>
<th>Image properties</th>
<th>Image picker prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Input Properties</td>
<td></td>
</tr>
<tr>
<td>Image Basic Info</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Image Upload Test</td>
</tr>
<tr>
<td>Variable Name</td>
<td>image_upload_test</td>
</tr>
<tr>
<td>Prompt</td>
<td>Please upload an image</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>Microsoft Teams Image picker prompt</td>
<td></td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
**Image picker user input control properties**

The image that can be uploaded must be in .jpg, .png, .bmp, .gif, .jpeg, or .ico file format. Although the image can be high resolution, the image displayed in the Virtual Agent client is scaled based on the aspect ratio. Images scale to fit within the chat window.

**Image picker properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Image picker user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable name</td>
<td>The name of the variable that stores the user response to this prompt. The variable name is automatically created from the Name property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt to the user asking them to upload an image. The prompt can be a text string that includes variables or a script that returns text.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Condition</td>
<td>A no-code condition statement or low-code script that specifies a condition for using the Image picker user input control.</td>
</tr>
</tbody>
</table>

**Using the Image picker control in different client interfaces**

The process to select an image differs based on the Virtual Agent client interface. Use the following steps to select an image in the client interface of your choice.
### Image picker control in different client interfaces

<table>
<thead>
<tr>
<th>Platform</th>
<th>Steps to select an image</th>
</tr>
</thead>
</table>
| **Web UI**     | 1. Click [Click here to upload a file](#).  
                  2. Choose an image file from your local computer. |
| **Slack**      | 1. Click the Green + icon.  
                  2. Select *Your computer*.  
                  3. Choose an image file from your local computer. |
| **Microsoft Teams** | 1. On your local computer, copy an image file.  
                  2. Paste the image file into the text input field in Microsoft Teams. |
| **Workplace**  | 1. Click the image icon ![Image](#).  
                  2. Choose an image file from your local computer. |

### Carousel user input control

Use the Carousel user input control in a Virtual Agent topic to present a prompt and a horizontal series of labeled images. The user can select a single item from the carousel.
Example of a Carousel user input control

<table>
<thead>
<tr>
<th>Carousel properties</th>
<th>Carousel prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>User Input Properties</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Carousel Basic Info</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Name</strong> 1</td>
<td>Test Carousel</td>
</tr>
<tr>
<td><strong>Variable Name</strong> 1</td>
<td>test_carousel</td>
</tr>
<tr>
<td><strong>Prompt</strong> 1</td>
<td>Here's what we have available</td>
</tr>
<tr>
<td><strong>Acknowledgement Message</strong> 1</td>
<td></td>
</tr>
<tr>
<td><strong>Default Value</strong> 1</td>
<td></td>
</tr>
<tr>
<td><strong>Confirmation Message</strong> 1</td>
<td></td>
</tr>
<tr>
<td><strong>Condition</strong> 1</td>
<td></td>
</tr>
<tr>
<td>Condition</td>
<td>Script</td>
</tr>
<tr>
<td>Add Condition</td>
<td></td>
</tr>
</tbody>
</table>

**Carousel Item Setting**

When defining your enumeration list in JSON, ensure that you assign keys of Name, Value, Body. Other logic in the topic can then retrieve values from the keys.
<table>
<thead>
<tr>
<th>Carousel properties</th>
<th>Carousel prompt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>![Image of Slack carousel options with 7 or more items]</td>
</tr>
<tr>
<td>Slack prompt for carousel with 7 or more items</td>
<td></td>
</tr>
</tbody>
</table>

|                     | ![Image of Microsoft Teams carousel prompt] |
| Microsoft Teams Carousel prompt |
### Carousel properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Carousel user input control node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>The name of the variable that stores the selection made by the user. The variable name is automatically created from the <strong>Name</strong> property.</td>
</tr>
<tr>
<td>Prompt</td>
<td>The prompt to the user. The prompt can be a text string or a script that returns the prompt string.</td>
</tr>
<tr>
<td>Acknowledge Message</td>
<td>The message that verifies the user selection. The message can be either a text string or a script that returns text.</td>
</tr>
<tr>
<td>Default Value</td>
<td>The predefined value for the user response to the question or prompt. The value can be either a text string or a script that returns text. The user is prompted with a Yes/No prompt to accept this value. If the user selects No at this prompt, no value is used.</td>
</tr>
<tr>
<td>Confirmation Message</td>
<td>The message that appears when the carousel has a default value or only a single choice is available. The user is prompted with a Yes/No prompt to accept this value.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Condition</td>
<td>A no-code condition statement or low-code script that specifies a condition for presenting this prompt in the conversation. The condition must evaluate to true.</td>
</tr>
<tr>
<td>Carousel Item Expression</td>
<td>Use a script to create items for selection in your carousel. The script should return an array containing one or more items.</td>
</tr>
<tr>
<td>No records response message</td>
<td>The message indicating that no records were found. The message can be either a text string or a script that returns text.</td>
</tr>
</tbody>
</table>

**Example carousel item expression**

```javascript
var options = [];
options.push(
  {
    'Name': 'Item 1,
    'Value': 'item_1',
    'Body': 'https://images.pexels.com/photos/688666/pexels-photo-688666.jpeg'
  });
options.push(
  {
    'Name': 'Item 2,
    'Value': 'item_2',
    'Body': 'https://images.pexels.com/photos/916472/pexels-photo-916472.jpeg'
  });
return options;
```

Script in the Carousel Item Expression property defines and returns an array containing the items that appear in your carousel. The elements of this array must contain **Name**, **Value**, and **Body** keys. In the example, the script creates an array called `options`, and adds two elements, each with the required keys. The images here are hard-coded as an example.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the carousel item. This name is shown below the image on the carousel.</td>
</tr>
<tr>
<td>Value</td>
<td>The value for the item. When a user selects a carousel item, this value is stored in the variable named in the Variable name property.</td>
</tr>
<tr>
<td>Body</td>
<td>The image used in the carousel item. The value is a URL for an image file.</td>
</tr>
</tbody>
</table>

**Virtual Agent Designer bot responses**

Virtual Agent Designer offers various controls for displaying bot responses in a conversation. Because the bot responses occur in third-party platforms, the format for each output may vary.
Text bot response control

Use the Text bot response control in a Virtual Agent topic to display a text bot response.

Example Text bot response control

<table>
<thead>
<tr>
<th>Response properties</th>
<th>Text bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><img src="now" alt="Hello!" /></td>
</tr>
<tr>
<td>Response Message</td>
<td>Hello!</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition</td>
</tr>
</tbody>
</table>

Text bot response properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Text bot response node in the topic flow.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Response message</td>
<td>The Text bot response to the user, either a text string or a script that returns a text string. The script can include Glide record variables or script variables.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for presenting this response in the conversation. The condition must return a value of true to display the text.</td>
</tr>
</tbody>
</table>

**Example Text bot response script**

```javascript
(function execute() {
    return 'Hello ' + gs.getUser().getFirstName();
})()
```

In this example, the script returns a string that greets the user. The `gs.getUser().getFirstName()` property is used to append the current user’s first name.

**Image Output bot response control**

Use the Image Output bot response control in a Virtual Agent topic to display an image from a URL link. The image aspect ratio determines how the image is sized in the bot chat bubble.
Example Image Output bot response control

<table>
<thead>
<tr>
<th>Response properties</th>
<th>Image Output bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><img src="https://images.pexels.com/photos/109371/pexels-photo-109371.jpeg" alt="Image Output Test" /></td>
</tr>
<tr>
<td>Image URL Link</td>
<td><img src="https://images.pexels.com/photos/109371/pexels-photo-109371.jpeg" alt="Image URL Link" /></td>
</tr>
<tr>
<td>Condition</td>
<td><img src="https://images.pexels.com/photos/109371/pexels-photo-109371.jpeg" alt="Add Condition" /></td>
</tr>
</tbody>
</table>

Microsoft Teams Image Output bot response output
### Image Output bot response control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required. The name that identifies the Image Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Image URL Link</td>
<td>The URL link to an image file.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for presenting this image in the conversation. The condition must return a value of true to display the image.</td>
</tr>
</tbody>
</table>

**Note:** Third-party messaging applications might place restrictions on the maximum size of an image displayed within a conversation. For details on the maximum image size allowed, check the documentation for the messaging application. For example, Microsoft Teams supports a maximum image size of 1024 x 1024 pixels and 1 MB file size for PNG, JPEG, and GIF files. For more information, see the [Microsoft Teams Developer documentation](https://docs.microsoft.com/en-us/microsoftteams/platform/conversational-bots/bot-basics) on conversations. Note also that sometimes in Microsoft Teams bot conversations, images might not fully render and appear cropped. The user has to scroll up and down in the messaging window to view the image.

### Link bot response control

Use the Link bot response control in a Virtual Agent topic to present a bot response that contains a header prompt and a single URL link to an item. For example, you can provide a link to a website page or to a particular record, such as an incident.
**Example Link bot response control**

<table>
<thead>
<tr>
<th>Link bot response properties</th>
<th>Link bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Response Properties" /></td>
<td><img src="image" alt="Now Support" /></td>
</tr>
</tbody>
</table>

**Response Properties**

- **Link Output Basic Info**
  - **Name**: Test Link
  - **Header**: Here is a link
  - **Label**: Click here
  - **URL**: https://www.servicenow.com

**Condition**

- **Condition**: [Add Condition]

**Workplace Link bot response output**
Link bot response control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Text bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Header</td>
<td>The text prompt displayed above the URL link.</td>
</tr>
<tr>
<td>Label</td>
<td>The text string that identifies the link in the bot bubble.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL link to an item, such as a website page or a particular record. Enter the complete URL, for example <a href="https://servicenow.com">https://servicenow.com</a>. This property can also be a script that returns a valid URL as a string.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for displaying the link.</td>
</tr>
</tbody>
</table>

HTML bot response control

Use the HTML bot response control to display static HTML text in the Virtual Agent bot response.

**Note:** If you created conversations in the London release that use this bot response control to generate card layouts, consider updating your conversations to use the Card bot response control. The Card displays information from a record in your instance and contains a link to that related record.

Example HTML bot response output

The HTML bot response shows a static HTML as a chat response. This example includes an image, headings, and paragraph text. The web UI presents this content as HTML. The Slack, Microsoft Teams, and Workplace user interfaces display the same content as a PNG image. URL links within the HTML are extracted and displayed below the image.
<table>
<thead>
<tr>
<th>HTML bot response properties</th>
<th>HTML bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Response Properties</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Html Basic Info</strong></td>
<td></td>
</tr>
<tr>
<td>* Name</td>
<td>HTML Use Case Demo</td>
</tr>
<tr>
<td>* HTML Message</td>
<td>&lt;html&gt; &lt;body&gt; &lt;center&gt;&lt;h1&gt;Welcome&lt;/h1&gt; &lt;/center&gt; &lt;/body&gt;</td>
</tr>
<tr>
<td>Height (Pixel)</td>
<td>0</td>
</tr>
<tr>
<td>Width (Pixel)</td>
<td>0</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition</td>
</tr>
<tr>
<td></td>
<td>Add Condition</td>
</tr>
</tbody>
</table>

Welcome to Company Chat

Legal Disclaimer

<table>
<thead>
<tr>
<th>HTML bot response properties</th>
<th>HTML bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1" alt="Microsoft Teams HTML output" /></td>
</tr>
<tr>
<td></td>
<td><img src="image2" alt="Workplace HTML output" /></td>
</tr>
</tbody>
</table>
HTML bot response control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the HTML bot response control node in the topic flow.</td>
</tr>
<tr>
<td>HTML Message</td>
<td>The HTML output to be displayed. Click the Edit icon to open the HTML editor.</td>
</tr>
<tr>
<td>Height (Pixel)</td>
<td>The maximum height of the area for displaying HTML output in third-party messaging applications.</td>
</tr>
<tr>
<td>Width (Pixel)</td>
<td>The maximum width of the bot bubble for displaying HTML output in third-party messaging applications.</td>
</tr>
</tbody>
</table>

**Note:** As shown in the examples, HTML output can vary in third-party messaging applications. Determine an appropriate Height and Width area by setting initial values, previewing the HTML output in the messaging applications you intend to use, and then adjusting the height and width values.

**Multi-flow Output bot response control**

Use the Multi-flow Output bot response control in a Virtual Agent topic to sequentially display two or more outputs (text, image, link, or HTML). Users can move from one output to the next through a provided navigation button.
Example Multi-flow Output bot response control

<table>
<thead>
<tr>
<th>Output properties</th>
<th>Multi-flow Output bot response output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Response Properties</td>
<td></td>
</tr>
<tr>
<td>Multi-flow Output Basic Info</td>
<td>Now Support</td>
</tr>
<tr>
<td>Name</td>
<td>Test Flow</td>
</tr>
<tr>
<td>Condition</td>
<td>Condition, Script</td>
</tr>
<tr>
<td>Add Condition</td>
<td></td>
</tr>
<tr>
<td>Response Messages</td>
<td>Click for More</td>
</tr>
<tr>
<td>Navigation Label</td>
<td>Click for More</td>
</tr>
<tr>
<td>Add a Response</td>
<td></td>
</tr>
<tr>
<td>Response Type</td>
<td>Value</td>
</tr>
<tr>
<td>Text</td>
<td>Test</td>
</tr>
<tr>
<td>Link</td>
<td><a href="https://www">https://www</a></td>
</tr>
</tbody>
</table>

Slack Multi-flow Output bot response output
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies this Multi-flow Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for presenting this output in the conversation. The condition must return a value of true to display the output.</td>
</tr>
<tr>
<td>Response messages</td>
<td></td>
</tr>
<tr>
<td>Navigation Label</td>
<td>The label for the button displayed below the output. The button enables the user to move to the next output in the flow.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add a response</td>
<td>For each output type, click + Add a Response to specify the output and define the output properties.</td>
</tr>
<tr>
<td></td>
<td>1. In the Add a Response dialog box, select the Type, and specify the associated values:</td>
</tr>
<tr>
<td></td>
<td>• Text — Enter the text to be displayed in the response.</td>
</tr>
<tr>
<td></td>
<td>• Image — Enter the Header, Prompt (label for the link), and the URL link to the image.</td>
</tr>
<tr>
<td></td>
<td>• Link — Enter the Header, Prompt (label for the link), and the URL link.</td>
</tr>
<tr>
<td></td>
<td>• HTML — Enter the Height and Width, in pixels, to set the dimensions of the HTML block. In the HTML editor, enter the HTML markup to be displayed.</td>
</tr>
<tr>
<td></td>
<td>2. Click Save.</td>
</tr>
</tbody>
</table>

**Script Output bot response control**

Use Script Output bot response control in a Virtual Agent topic to run a script that returns a single response or a multi-part response.

**Example Script Output bot response control**

Use the Script Output bot response control when creating a more complex response that relies on scripted calculations or requires a multi-part response. Scripted output can include text, image, cards, links, and HTML to create a versatile response.
### Script Output properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Script Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Script Output Type</td>
<td>The type of output returned by the script: single-part or multi-part.</td>
</tr>
</tbody>
</table>

---

### Script Output bot response control properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Script Output bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Script Output Type</td>
<td>The type of output returned by the script: single-part or multi-part.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Script Response Message</td>
<td>The script that generates the selected output type (single or multi-part).</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for presenting this output in the conversation. The condition must return a value of true to display the output.</td>
</tr>
</tbody>
</table>

**Example script**

```javascript
(function execute() {
  var gdt = new GlideDateTime();
  var gt = new GlideTime();
  gdt.addSeconds(7200);
  gt = gdt.getTime();
  var multiOutMsg = new sn_cs.MultipartOutMsg();
  multiOutMsg.addPlainTextPart('Thank you for submitting an incident.');
  multiOutMsg.addPlainTextPart('You should receive a response from a technician by ' + gt.getByFormat('HH:mm'));
  return multiOutMsg;
})()
```

In this example, the script calculates the time two hours from the current time and outputs a multi-part message that includes this information.

**Card bot response control**

Use the Card bot response control in a Virtual Agent topic to display selected information from a record on your instance, such as an incident.

ℹ️ **Note:** If you created conversations in the London release that use the HTML bot response control to generate card layouts, consider updating your conversations to use the Card bot response control. The Card displays information from a record in your instance and contains a link to that related record.

**Example Card bot response output**

The Card response shows content from a record in a compact format designed for readability within the chat window. The record content includes the display field for the table at the top of the card followed by any other fields specified by the properties of the bot response.
Response properties | Card output
--- | ---

**Response Properties**

**Card Basic Info**

- **Name**
  - Status Card Test

- **Reference Type**
  - Record

- **Record**
  - Incident

- **Fields**
  - Number
  - Category
  - Short description
  - State

**Condition**

- **Condition**
  - Inquiry / Help

**Incident**

- **Category**
  - Inquiry / Help

- **State**
  - New

- **Number**
  - C0010061

- **Description**
  - from domain "getyour"
Card bot response control properties

The contents of the card must come from a single record on your instance. This record can be referenced from variables in the flow or queried using a script that returns a single Glide record from a selected table. Use the Card control properties to define which record is used and the fields that are displayed from that record.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Card bot response control node in the topic flow.</td>
</tr>
<tr>
<td>Reference Type</td>
<td>The reference to a specific record in a table. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Record — Data for the card comes from a record referenced in a variable from another node in the flow, for example, a Choice List or Glide Action.</td>
</tr>
<tr>
<td></td>
<td>• Script — Data for the card comes from a script that returns a single Glide record from a specified table.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Record</td>
<td>When the <strong>Reference Type</strong> property is set to Record, this property appears as a list. Use this list to select a variable from the current flow that contains a record object. Information from this record is shown in the card. When the <strong>Reference Type</strong> field is set to script, use this field to input a script that returns the record. Information from this record is shown in the card.</td>
</tr>
<tr>
<td>Table</td>
<td>If the <strong>Reference Type</strong> is Script, select the table containing the record.</td>
</tr>
<tr>
<td>Fields</td>
<td>The fields from the ServiceNow record to be displayed in the card. Click <strong>+Add Field</strong> to specify each field. <strong>Note</strong>: If you are using Workplace, a maximum of four fields is rendered on the card. If you have more than four fields, the remaining fields are displayed on a subsequent card (up to four fields per card).</td>
</tr>
<tr>
<td>Condition</td>
<td>A condition statement or script that specifies a condition for presenting this card in the conversation. The condition must return a value of true to display the card.</td>
</tr>
</tbody>
</table>

**Example Glide record query**

```javascript
(function execute(table) {
    /* Write a glide record query, and return the glide record. For example:
    var gr = new GlideRecord(table);
    gr.addEncodedQuery('active=true^number=INC0010099');
    gr.query();
    if(gr.next()) {
        return gr;
    }
    */
}(table))
```

In this example, the script creates a GlideRecord object, populates this object using a query that should return a single result, then returns the object. The **Table** property defines the table used in this query.

**Virtual Agent Designer utilities**

You can control interactions within a topic by using utilities in Virtual Agent Designer that perform various actions such as running a script or adding different conversation paths (branches) in a topic. Utilities are represented as nodes in a conversation flow but do not display anything to the user.
Lookup utility

Use the Lookup utility in a Virtual Agent topic to return a ServiceNow record query.

Example Lookup utility

![Diagram of Lookup utility properties]

Lookup utility properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Lookup utility node in the topic flow.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Variable Name</td>
<td>The variable that stores the record returned by the script.</td>
</tr>
<tr>
<td>Condition</td>
<td>A query condition or script that specifies a condition for presenting the prompt in the conversation. The condition must evaluate to true so that the node is displayed during the conversation. By default the condition is set to true.</td>
</tr>
</tbody>
</table>

**Reference Settings**

<table>
<thead>
<tr>
<th>Table</th>
<th>The table used for the query.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td>The query to retrieve the record. Use the condition builder or a script to specify a query condition.</td>
</tr>
</tbody>
</table>

**Example Lookup script**

```javascript
(function execute(table) {
    var gr = new GlideRecord(table);
    gr.addEncodedQuery('active=true');
    gr.setLimit(1);
    gr.query();
    if(gr.next()) {
        return gr;
    }
})(table)
```

In this example, a table is queried the first active. The table to be queried is defined in the **Table** property found in the lookup utility control. The `setLimit()` method ensures that only a single record is returned from the database. If a record is found, it is returned. For more information on GlideRecord queries, see [Using GlideRecord to query tables](#).

**Script Action utility**

Use a Script Action in a Virtual Agent topic to run a script.
Example Script Action utility

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Script Action node in the topic flow.</td>
</tr>
<tr>
<td>Action Expression</td>
<td>The script that performs an action.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for executing this script action. The condition must return a value of true for the script action to execute.</td>
</tr>
</tbody>
</table>

Example script action

```javascript
(function execute() {
    var list = [];
    if (vaInputs.case_number != "") {
        var gr = new GlideRecord("sn_customerservice_case");
        gr.addQuery("number", "CONTAINS", vaInputs.case_number);
        gr.addQuery("active", "true");
        gr.orderBy("number");
        gr.query();
        while (gr.hasNext()) {
            gr.next();
            list.push(gr.getUniqueValue().toString());
        }
    }
})
```
vaVars.case_list = list;
}}();

This example performs a search on the sn_customerservice_case table for a specific case number based on the input from another control called case_number. The script then places the results in an array and stores them in the case_list variable, which is accessible by other nodes in the same topic. Because vaVars only supports string, number, and Boolean values, the script uses toString() to store these values as strings. The code is contained in an if statement, so it only executes if the case_number variable has a value. This if statement prevents the code from running if the user has not entered a number.

**Action utility**

Use the Action utility in a Virtual Agent topic to create or update a ServiceNow record.
Example Action utility

Prompt Properties

- **Name**: Glide Action
- **Variable Name**: glide_action
- **Condition**: 

Action Setting

- **Action Type**: Create a Record
- **Table**: Incident [incident]
- **Field**
  - Field: short_description
  - Value: Test Incident
  - active: true

**Add Field**
**Action utility properties**

Specify the table for which the record is to be created. To update a record, specify the fields in the record to be modified.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that identifies the Action utility node in the topic flow.</td>
</tr>
<tr>
<td>Variable Name</td>
<td>The name of the Glide variable that is automatically created from the Name field.</td>
</tr>
<tr>
<td>Condition</td>
<td>A script that specifies a condition for executing this action. The condition must return a value of true for the action to execute.</td>
</tr>
</tbody>
</table>

**Action Setting**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Type</td>
<td>The Action to be performed in the instance. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• Create a Record</td>
</tr>
<tr>
<td></td>
<td>• Update a record</td>
</tr>
<tr>
<td>Table</td>
<td>If the Action Type is Create a Record, select the ServiceNow table in which the record is to be added.</td>
</tr>
<tr>
<td>Record</td>
<td>If the Action Type is Update a Record, select the variable for the GlideRecord. The available variables are referenced from another node in the flow, such as a choice list.</td>
</tr>
</tbody>
</table>
### Property | Description
--- | ---
Field | The fields from the table to be operated on:
1. Click + Add Field to specify the field and field values.
2. In the Field Values form, enter the value. This value can be added in one of two ways.
   - Enter a static value into the text field.
   - Use a value stored in a variable. Access the available variables by pressing Control + Space or clicking the Insert Reference button.
3. Click Save.
4. Repeat steps 1 through 3 for each field to be added.

**Decision utility**

Use the Decision utility in a Virtual Agent topic to add two or more branches that represent different paths in a conversation.
Example Decision utility node with branches

In this example, a static choice control prompts the user to select from three available colors, and the selection is stored in a variable. The Decision utility control is configured with a branch for each possible selection. Each branch contains a script in the **Condition** property that returns true when a specific color is selected. In the example, the script returns true when the choice is "Blue."
Add a Decision utility with branches

1. Drag the Decision utility onto the canvas.
   The Decision utility node added to the canvas has a single branch named Always by default.
2. Click the plus sign (+) under the node.
   A second branch named Never is added below the Decision utility node.
3. To add additional branches, click the plus sign (+).
4. For each branch, specify the branch properties: Name for the name of the branch and Condition for the condition that determines whether that branch is displayed.

Use scripts or variable conditions to set decision branches

Each branch below a Decision utility node has a condition property. You can define the condition using the condition builder or a script that returns a value of true or false. A branch that returns a value of true is followed, while a branch returning a value of false is not. When creating these scripts or conditions, ensure that only one branch in each Decision utility node evaluates to true.

Virtual Agent conversation states

Virtual Agent conversations move through different states.

<table>
<thead>
<tr>
<th>State</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Conversation starts when user:</td>
</tr>
<tr>
<td></td>
<td>· Selects a topic or enters a request.</td>
</tr>
<tr>
<td></td>
<td>· Requests a transfer to a live agent (begins live chat).</td>
</tr>
<tr>
<td></td>
<td>· Begins a new conversation after ending a conversation.</td>
</tr>
<tr>
<td>Canceled</td>
<td>Ongoing conversation stopped when user chooses to end the conversation.</td>
</tr>
<tr>
<td>Completed</td>
<td>Conversation ends after user runs the entire topic and finishes the conversation with the virtual agent.</td>
</tr>
<tr>
<td>Faulted</td>
<td>· Conversation times out when user abandons a conversation with the virtual agent.</td>
</tr>
<tr>
<td></td>
<td>· Conversation errors out due to an unrecoverable system error and the virtual agent cannot transfer the conversation to a live agent.</td>
</tr>
<tr>
<td>Chat In Progress</td>
<td>Conversation with a live agent is in progress (user was transferred to a live agent).</td>
</tr>
</tbody>
</table>
Virtual Agent scripts

Admins and users with the virtual_agent_admin role can use scripts to customize the behavior of Virtual Agent topics.

Virtual Agent scripts can provide context for topics, such as retaining information about a user or a user's input. You can use this information to personalize a conversation, for example, to present a scripted greeting or confirmation. Scripts can also specify certain actions to be performed on information obtained during a conversation, such as creating or updating ServiceNow records.

Scripts run on the server in the scope in which a topic is defined. All scope protections apply. If you are developing a conversation for a scoped application, you must use the scoped API. You can use most APIs that run in server scripts.

User input and ServiceNow record variables

In Virtual Agent, the following variables are available for use in scripts that you create for a topic.

User input variables

When you add an input control to a topic, the system automatically creates a variable to store the user input (string object). The syntax is `vaInputs.myvar` where `myvar` is the name you assigned to the input node.

For example, a text input prompt with the name `First prompt` has a system-defined variable called `vaInputs.first_prompt`. Spaces in the name are replaced with an underscore character and uppercase characters are changed to lowercase.

ServiceNow record variables

If you create a script for a topic that queries a ServiceNow table, the record object (GlideRecord) returned is automatically available for use in the topic. The variable syntax is `vaInputs.myvar` where `myvar` is the record object. For details on querying ServiceNow tables to return a record object, see `Using GlideRecord to query tables`.

Use dot-walking in variables that contain a ServiceNow record to specify a particular field in the table. The syntax is `vaInputs.myvar.field`. For details on dot-walking within a script, see `Dot-walking examples`.

Accessing user input and ServiceNow record variables

Use `vaInputs` object, for example `vaInputs.myvar == "expected value"` to access ServiceNow record variables in scripts. To access values from user inputs that are not records, use `vaInputs.myvar.getValue()`.

The following methods are available.

- `vaInputs.myvar == "expected value"` evaluates whether `myvar` matches an expected value.

  **Note:** Values for user input variables are assigned using user input controls. These values cannot be changed in your scripts.

- If `myvar` is a GlideDateTime variable, the date and time value is formatted as a string, for example, `2018-12-11 17:45:23`

- By default, the user variable is available and is a reference to the sys_user record for the user.

- `vaInputs.myvar.getValue();` returns the value.
• `vaInputs.myvar.getDisplayValue();`: If the stored value is not a ServiceNow record, this method returns the display value. For variables that contain ServiceNow records, this method returns the display value, as defined by the display field for that table.

This example shows the label and choice values for a user input. In this case, `myVar.getValue()` would return a value of 10, 20, or 30, while `myVar.getDisplayValue()` would return Apple, Orange, or Pear.

• `vaInputs.myvar.getDefaultValue();`: returns the default value in a confirmation message.
• `vaInputs.myvar.getDefaultDisplayValue();`: returns the display value for the default value in a confirmation message.

**Script variables**

You can define script variables for information that is not stored in ServiceNow tables but can be used to share that information elsewhere in a topic. Script variables are similar to workflow scratchpad variables that store primitives such as integers, Boolean values, or strings. A string value can be either a static or dynamic scripted value. Create these variables using the Script Variables sidebar in the Virtual Agent Designer page.
Script Variables sidebar

Note: Script variables are intended for use by topic authors with advanced scripting skills.

The variable syntax is `vaVars.myvar`, where `myvar` is the name you assign to the variable. For example, you can assign a value to the variable using `vaVars.myvar = value;`. Unlike user input variables, script variables can be assigned values in a script.

To define a script variable:

1. In the Virtual Agent Designer page, click the `+` plus sign for Script Variables.
2. In the Add Script Variable window, define the variable:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable name</td>
<td>Name of the variable. The name is case sensitive. Spaces in the name are replaced with an underscore character.</td>
</tr>
<tr>
<td>Default value</td>
<td>Either a static value or a script that specifies a dynamic value for this variable.</td>
</tr>
</tbody>
</table>

3. Click Save.

Live Agent variables

The following Live Agent variables are available for use in topic scripts:

- `application`
- `queue`
• short_description

For example, you can use the queue variable to control the chat queues used in a topic.

The variable syntax is `vaVars.LiveAgent_myvar`, where `myvar` is one of the available Live Agent variables specified in Live Agent setup. Access the variable using `vaVars.LiveAgent_myvar = value`.

To use Live Agent variables in topic scripts, enable the Live Agent toggle switch (under Script Variables) in the Virtual Agent Designer page.

**Context variables**

You can use variables in system parameters within the web client URL. These variables can be used anywhere in the conversation using the `vaContext` object. Use these options to create links to Virtual Agent with predefined variables.

```
```

The example link contains a parameter, `sysparm_city=rome`. In addition to opening a Virtual Agent conversation, using this link creates a variable called `city` with a value of `rome`. This variable can be accessed in a script using `vaContext.city`.

**vaSystem methods**

Use methods in the `vaSystem` object to attach images to records, access the search string used to find the current topic or transfer the user to a live agent queue.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vaSystem.attachToRecord(String mediaId, String tableName, String sysId)</td>
<td>This method attaches an image to a record. The method uses three parameters:</td>
</tr>
<tr>
<td></td>
<td>• mediaId: The path for the image to be attached. Use <code>getValue()</code> on an image input variable to use an image entered by the customer. For example, <code>vaInputs.image_input.getValue()</code>.</td>
</tr>
<tr>
<td></td>
<td>• tableName: A string containing the name of the table.</td>
</tr>
<tr>
<td></td>
<td>• sysId: The sys_id of the record.</td>
</tr>
<tr>
<td>vaSystem.getSearchText()</td>
<td>This method returns the search string used to find the current topic.</td>
</tr>
<tr>
<td>vaSystem.connectToAgent()</td>
<td>This method ends the current conversation and connects the customer to a live agent queue. For more information on this method, see <a href="#">Transferring Virtual Agent conversations to a live agent</a>.</td>
</tr>
</tbody>
</table>

**Virtual Agent localization**

Use the Message (sys_ui_message) table to provide translations for Virtual Agent topics and accommodate users who speak different languages.
Using localization for Virtual Agent

If you use multiple languages on your instance or plan to do so, use localization methods in your Virtual Agent scripts to ensure that the content can be translated. Localization methods are designed to show the original text when no translation is found. These methods can be applied to your code before you have created translations.

Use the Message table to store translation text

The Message (sys_ui_message) table stores translations for informational messages, and is used to store translations for elements in your topic. Predefined topics have already been translated, but you must provide translations for any content you create for your instance. For more information on the Message table, see Message table

Use the gs.getMessage function to access stored translations

The gs.getMessage method checks the Message table for the translated version of the text in the language selected for the current user.

Example of localization in a script

(function execute() {
    return 'Hi there ' + vaInputs.first_name;
})()

This code provides a greeting that dynamically adds the value of the first_name variable. The following examples shows that same code rewritten for localization.

(function execute() {
    return gs.getMessage('Hi there {0}', [vaInputs.first_name]);
})()

The example uses the gs.getMessage method. The text is the same as the previous example but the format is changed. The number in brackets acts as a placeholder for the variable, which is then listed in an array after the comma. The gs.getMessage method searches for a record on the Message table with a key value matching Hi there {0} and a language value matching the current language. The method returns the translated version of the text, which is stored in the message field of the record.
Out-of-the-box Performance Analytics Solutions for Virtual Agent

Out-of-the-box Performance Analytics Solutions contain preconfigured dashboards. These dashboards contain actionable data visualizations that help you improve your business processes and practices.

Enabling Performance Analytics Solutions

Use the Performance Analytics widgets on the dashboard to visualize data over time, analyze your business processes, and identify areas of improvement. With solutions, you can get value from Performance Analytics for your application with minimal setup.

Important: Set up and test Out-of-the-box Performance Analytics Solutions on a sub-production instance before enabling them in production. You can set up and test Performance Analytics on a sub-production instance without a subscription.

Note:
- Solutions include some dashboards that are inactive by default. You can activate these dashboards to make them visible to end users according to your business needs.
- Out-of-the-box solutions and in-form analytics provide all the configuration records required to analyze default applications. Customize these records for use in your production environment.

To enable the solution for Virtual Agent, an admin activates the Virtual Agent Analytics Dashboard plugin (com.glide.cs.pa).
Virtual Agent analytics dashboard

With the Virtual Agent (VA) analytics dashboard, VA administrators can monitor user engagement with the Virtual Agent to understand topic and conversation metrics. For example, use the dashboard information to identify topics that might need improvement and determine whether your topics are effective in reducing live agent workload.

Overview tab
End user and role

<table>
<thead>
<tr>
<th>End user and goal</th>
<th>Required role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Agent Administrator: Monitors topic and conversation metrics</td>
<td>virtual_agent_admin</td>
</tr>
</tbody>
</table>

Indicators

**Daily new conversations**
A daily indicator the total number of virtual agent conversations initiated or created.

**Conversations completed today**
A daily indicator of the total number of conversations completed.

**Daily faulted conversations**
A daily indicator of the total number of conversations failed or marked as faulted. Includes conversations that either timed out (user abandoned the conversation) or failed due to an unrecoverable system error (could not be transferred to a live agent).

**Conversations completed without agent**
A daily indicator of the total number of conversations completed without help from an agent.

**Conversation duration with live agent**
A daily indicator of the average time spent completing conversations with help from a live agent.

**Conversation duration without agent**
A daily indicator of the average time spent completing conversations without transferring to a live agent.

Breakdowns

- Topic
- Channel
- Conversation State
## Reports

<table>
<thead>
<tr>
<th>Title</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Conversations by Topic vs. Channel</td>
<td>Stacked bar chart</td>
<td>All open conversation topics, stacked according to the channel in which they are open.</td>
</tr>
<tr>
<td>Number of unique users</td>
<td>Multiple lines</td>
<td>The number of users who engage with the virtual agent on a daily, weekly, and monthly basis.</td>
</tr>
<tr>
<td>Weekly conversations by channel</td>
<td>Bar chart</td>
<td>The number of conversations created within each channel over the course of a given week.</td>
</tr>
<tr>
<td>Weekly conversations by Topic</td>
<td>Scorecard</td>
<td>The number of conversations created for each topic over the course of a given week.</td>
</tr>
<tr>
<td>Title</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Daily completed vs. duration</td>
<td>Multiple lines</td>
<td>The total number of completed conversations compared against the average time spent completing conversations.</td>
</tr>
</tbody>
</table>
Index

A
access controls
- breakdown 292
ACL rules
- report, creating 717
adding scores
- manually 303
Advanced Reporting
- remove a published report 424
- schedule reports 420
automated indicators 214

B
basic reporting
- create area charts 434
- create area reports 436, 442
- create bubble reports 476
- create column charts 484, 486, 492
- create dials and speedometers 507, 509, 512
- create donut charts 516, 518, 523
- create funnel charts 529, 534
- create funnel reports 527
- create pyramid charts 529, 534
- create pyramid reports 527
- create spline charts 434
- create spline reports 436, 442
- Pareto charts 612
Basic Reporting
- create bar charts 450, 457
- create bar reports 448
- create box reports 467
- create pareto charts 618
- Pareto charts 614
- pie charts 621
- box charts 461, 463
breakdown
- assigning to indicator 219, 282
- creating 258, 270, 282
Breakdown
- Interactive filter 785
- breakdown access controls 292
- breakdown dashboards 158
- breakdown source
  - defining 260
Bubble charts
- create 472
- bucket group
  - create 267
- bucket groups 264

C
Calendars
- creating 480
Cascading filters
- create a cascading filter 778
chart colors
- report data categories, defining 712
collecting data
- indicators 298
- performance analytics 298
- scores 298
column visualization
- in time series widget 78
control charts
- creating 498
Control Reports
- creating 497
- create 150
- create area and spline reports
  - area 442
  - area report 436
  - report style options 442
  - spline 442
Create Bar Charts
- chart style options 457
- create a bar chart report 450
Create Box reports
- report style options 467
create bubble charts
- chart style options 476
create column charts
- report 486, 492
create donut charts
- chart style options 523
- report 518
Create funnel and pyramid charts
- report 529
- style options 534
Create Pareto Charts
- chart style options 618
- create a report 614
Creating Histograms 548, 548
creating thresholds 297, 297, 297
customizing calendar reports
- configure calendar attribute 740
- highlight a calendar entry 744
- set calendar record limit 744

D
dashboard 5
Dashboard
- Add a filter 784, 785
- Interactive Filter 770
DashboardMessageHandler
- API 793
- DashboardMessageHandler(String id) 793
- publishFilter(String table, String encodedQuery) 794
- removeFilter() 794
dashboards
- add a widget 828
- breakdown dashboards 160
- change tab layout 827
<table>
<thead>
<tr>
<th>Destination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>copying</td>
<td>828</td>
</tr>
<tr>
<td>create</td>
<td>796, 825</td>
</tr>
<tr>
<td>create tabs</td>
<td>826</td>
</tr>
<tr>
<td>deleting</td>
<td>828</td>
</tr>
<tr>
<td>edit tabs</td>
<td>826</td>
</tr>
<tr>
<td>modifying</td>
<td>828</td>
</tr>
<tr>
<td>data</td>
<td></td>
</tr>
<tr>
<td>collection</td>
<td></td>
</tr>
<tr>
<td>job log</td>
<td>304</td>
</tr>
<tr>
<td>data</td>
<td></td>
</tr>
<tr>
<td>collection job</td>
<td></td>
</tr>
<tr>
<td>creating</td>
<td>299</td>
</tr>
<tr>
<td>Data Collector</td>
<td>5</td>
</tr>
<tr>
<td>date and time user input</td>
<td>978</td>
</tr>
<tr>
<td>dials and speedometers</td>
<td></td>
</tr>
<tr>
<td>chart style options</td>
<td>512</td>
</tr>
<tr>
<td>report</td>
<td>509</td>
</tr>
<tr>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Element filter</td>
<td></td>
</tr>
<tr>
<td>create</td>
<td>283</td>
</tr>
<tr>
<td>elements</td>
<td></td>
</tr>
<tr>
<td>security</td>
<td></td>
</tr>
<tr>
<td>list</td>
<td>293</td>
</tr>
<tr>
<td>email summaries</td>
<td>256</td>
</tr>
<tr>
<td>Embed reports</td>
<td>695</td>
</tr>
<tr>
<td>export to PDF</td>
<td></td>
</tr>
<tr>
<td>dashboard</td>
<td>821, 830</td>
</tr>
<tr>
<td>homepage</td>
<td>821, 830</td>
</tr>
<tr>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Formula indicator</td>
<td></td>
</tr>
<tr>
<td>Rounding</td>
<td>255</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
<tr>
<td>heatmap</td>
<td></td>
</tr>
<tr>
<td>style options</td>
<td>544</td>
</tr>
<tr>
<td>heatmap</td>
<td></td>
</tr>
<tr>
<td>charts</td>
<td>538</td>
</tr>
<tr>
<td>heatmap</td>
<td></td>
</tr>
<tr>
<td>report</td>
<td>539</td>
</tr>
<tr>
<td>Homepage</td>
<td></td>
</tr>
<tr>
<td>Add an interactive filter</td>
<td>784</td>
</tr>
<tr>
<td>Interactive Filter</td>
<td>770</td>
</tr>
<tr>
<td>Homepage publishers</td>
<td></td>
</tr>
<tr>
<td>API</td>
<td>793</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>indicator</td>
<td></td>
</tr>
<tr>
<td>assigning to breakdown</td>
<td>282</td>
</tr>
<tr>
<td>indicator groups</td>
<td>creating 250</td>
</tr>
<tr>
<td>Indicators</td>
<td></td>
</tr>
<tr>
<td>widget indicators</td>
<td>151</td>
</tr>
<tr>
<td>Interactive filter</td>
<td></td>
</tr>
<tr>
<td>Add to dashboard</td>
<td>784, 785</td>
</tr>
<tr>
<td>available UI control types</td>
<td>783</td>
</tr>
<tr>
<td>boolean</td>
<td>775, 777</td>
</tr>
<tr>
<td>breakdown</td>
<td>785</td>
</tr>
<tr>
<td>Choice list</td>
<td>771</td>
</tr>
<tr>
<td>Date field</td>
<td>774</td>
</tr>
<tr>
<td>Group</td>
<td>776</td>
</tr>
<tr>
<td>J</td>
<td></td>
</tr>
<tr>
<td>job event</td>
<td></td>
</tr>
<tr>
<td>viewing</td>
<td>304</td>
</tr>
<tr>
<td>K</td>
<td></td>
</tr>
<tr>
<td>KPI</td>
<td>5</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>line charts</td>
<td></td>
</tr>
<tr>
<td>creating reports</td>
<td>551, 646</td>
</tr>
<tr>
<td>Line Charts</td>
<td></td>
</tr>
<tr>
<td>creating</td>
<td>550</td>
</tr>
<tr>
<td>line visualization</td>
<td>76</td>
</tr>
<tr>
<td>list reports</td>
<td></td>
</tr>
<tr>
<td>create</td>
<td>565, 581</td>
</tr>
<tr>
<td>export to excel</td>
<td>583</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>MetricBase</td>
<td>689</td>
</tr>
<tr>
<td>multilevel pivot</td>
<td></td>
</tr>
<tr>
<td>create</td>
<td>595</td>
</tr>
<tr>
<td>Multilevel pivot</td>
<td></td>
</tr>
<tr>
<td>coloring rule</td>
<td>735</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>PADomainUtils</td>
<td></td>
</tr>
<tr>
<td>copy</td>
<td>(String runAs) 325</td>
</tr>
<tr>
<td>copyDashboard</td>
<td>(String dashboardId, String runAs) 326</td>
</tr>
<tr>
<td>copyJob</td>
<td>(String pJob, String runAs) 326</td>
</tr>
<tr>
<td>isWritable</td>
<td>(String table, String id) 327</td>
</tr>
<tr>
<td>move</td>
<td>(String runAs) 327</td>
</tr>
<tr>
<td>PADomainUtils()</td>
<td>323</td>
</tr>
<tr>
<td>PADomainUtils(String domainFrom)</td>
<td>323</td>
</tr>
<tr>
<td>setFoundation</td>
<td>(boolean foundation) 324</td>
</tr>
<tr>
<td>setOverrideres(Boolean overrides) 325</td>
<td></td>
</tr>
<tr>
<td>PAFormulaUtil</td>
<td></td>
</tr>
<tr>
<td>getChange</td>
<td>(String indicator, Object fromDate, Object toDate) 242</td>
</tr>
<tr>
<td>getChangePercentage</td>
<td>(String indicator, Object fromDate, Object toDate) 243</td>
</tr>
<tr>
<td>getCurrentAggregateID()</td>
<td>243</td>
</tr>
<tr>
<td>getCurrentBreakdownID()</td>
<td>244</td>
</tr>
</tbody>
</table>

© 2020 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
getCurrentBreakdownLevel2ID() 245
getCurrentElementID() 245
getCurrentElementLevel2ID() 246
gap(String indicator, Object onDate) 247
gGetGlobalTarget(String indicator, Object onDate) 247
getPersonalTarget(String indicator, Object onDate) 248
gScore(String indicator, Object onDate) 248

PAFormulaUtils 242
PAScorecard
addParam(String parameter, String value) 331
query() 333
result() 334

PASnapshot
getCompareIDs(String sys_id, Number date1, Number date2, String type) 335
getCompareQuery(String sys_id, number date1, number date2, String type) 336
getIDs(String sys_id, Number date) 334
getQuery(String sys_id, number date) 336

PDF page header footer templates
create template 429

Performance analytics
breakdown 5
collecting data 298
dashboard 5
data collector 5
indicator 5
KPI 5
scorecard 5
widget 5

Performance analytics access controls 292
breakdown relations on widgets 164
breakdowns
mapping 219, 270
Configure LinkedIn integration 372
Configure Twitter integration 373
create a breakdown relation 287
Create a chart color scheme 154
create an indicator and related records 212
dashboard
duplicate 820
url 822, 829
dashboard access controls 816, 828
Dashboard url format 822, 829
domain separation 316
Indicator access controls 256
indicators
select breakdowns 219
LinkedIn example integration 372
Map a breakdown 219, 270
Move a dashboard with an update set 841
Real-time data 157
Twitter example integration 373
units 256

Performance Analytics
Activate the configuration generator 314
Add in-form analytics 172
analytics hub 50
API 344, 344
automated indicators 214
Available solutions 13
breakdown dashboards 158
breakdown wizard 259
Clean PA collections 307
clean up properties 337
Cleanup 307
collect historical data 298
Collection cleanup properties 337
Configuration generator 314
creating a target 294
e-mail summaries 256
Excluding time series 256
for incident management
setting up 9
Forecasting data 168
indicator overview 51
indicators
widget options 213
Interacting with widgets 111
Interactive widgets 111
Limiting breakdowns in formulas 230
Linking to a scorecard 865
manual indicators 225
premium 9, 11
REST API examples 352
Schema maps 315
script variables 330
set up indicators 208, 208, 208, 208, 212, 219, 224, 227
supported browsers 35
targets
add target for each element 295
Widget
Statistics 154
Widget statistics 154
Widget statistics properties 155
Widgets
Statistics properties 155
Performance Analytics and Reporting 4
performance analytics collection
clean up 307
Performance Analytics content packs activate 14
Performance analytics data collector properties 337
Performance Analytics mobile app 375
Performance Analytics solutions 12
Performance Analytics target creating 294
Pie Charts
creating 622
pivot tables
create 632
style options 544
process widget 148, 150
properties
data collector 337
Report

- administering 748
- fields 748
- security 748

Report Interactive Filter 770
- report output formats 422
- report types 430

report administration
- ACL 717
- creation 717
- customize calendar reports 739
- customizing calendar reports 740, 744, 744
- restricting 717
- rules 717

Report Administration
- report ranges 721, 722, 723, 725

Report drilldown
- define 683

report options 409

report security 748

report sources 720, 720

report statistics 718

Reporting
- add a dataset 685
- Add to dashboard or homepage 424
- embedded report parameters 697
- multiple datasets 684
- publish a report 423
- report 422, 430
- Scoped reports 715

reports
- creating 408
- domain separation 738
- generate 412
- generating 408
- run 408, 408
- view 414

REST API
- Performance Analytics 344, 344
- Performance analytics examples 352

S

scorecard 5

scores
- adding manually 303

Service Portal Performance Analytics widget 177

Service Portal Report widget 426

set up indicators
- automated indicator 222, 224, 227
- breakdown matrix 222
- define an indicator source 208, 208
- edit job 224
- exclude breakdown 222
- formula indicator 227
- manual indicator 225

Set Up Indicators
- database view 212

sharing reports 419

single score chart
- create 638

Single score chart 637

Solutions 1021

spline visualization 84

stacked column
- in time series widget 89

Step Reports
- creating 644
- step visualization 87

system colors
- defining 714

system tables
- report on 727

T

targets
- creating 295

thresholds
- creating 296

topic 961

Trendbox Charts
- creating 670

Style options 675

Trendbox Reports
- creating 668

V

virtual agent
- branding 934

Virtual Agent
- predefined topics 904

Virtual Agent designer 946

Virtual Agent Designer
- user inputs 968

W

widget
- workbench process 148

Widget
- Interactive Filter 770

widgets
- time series
  - column 78
  - line 76
  - spline 84
  - stacked column 89
  - step 87

widget indicators 151

workbench process widget
- create 150